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Preface 

If you're reading this, you've probably decided to write a Python script to run an FEA 
analysis in Abaqus. But you' re not sure where to begin, you've never written a working 
script for Abaqus, and you've never worked with the programming language Python 
either. The good news is you've found the right book to deal with the situation. Through 
the course of this text you 're going to learn the basics of writing scripts for Abaqus and 
understand the working of the Abaqus Scripting Interface. At the same time you're going 
to learn what you need to know of the Python programming language itself. You're going 
to receive the stable foundation you need so that you spend more time focusing on your 
research and less time debugging code. 

The aim of this book is not to teach you every single built-in scripting method offered by 
Abaqus. There are literally hundreds of these, and chances are you will only use a few of 
them for your own simulations. We'll focus on these, and put you in a position where you 
can branch out on your own. For the record all the keywords and methods of the Abaqus 
Scripting Interface are listed in the Abaqus Scripting Reference Manual. The 
documentation also consists of a manual called the Abaqus Scripting User' s Manual 
which provides helpful advice on different scripting topics. You could potentially learn to 
write Abaqus scripts in Python from the documentation itself, as many people (such as 
me) have had to do in the past. But as a beginner you will likely find yourself 
overwhelmed by the sheer quantity of information provided there. You will spend a Jot of 
time making avoidable mistakes and discovering for yourself, after hours (or days or 
months) of trial and error, the correct method to accomplish a given task through a script. 
This book gives you the guidance you need to start writing complex scripts right off the 
bat. Once you've read through all the pages you will have the knowledge and the 
confidence to write your own scripts for finite element simulations in Abaqus, and will 
then be able to refer to the Abaqus documentation for more information specific to your 
research task. 

Why write scripts? 

If you plan to learn scripting in Abaqus chances are you already know why it is useful 
and intend to use it to accomplish some task for your analyses. But for the sake of 
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completeness (and for those of you who are reading because your professor/boss forced 
you to), a few uses shall be mentioned. 

Let's assume you regularly use a few materials in all your simulations. Every time you 
start a new simulation in the GUT mode (Abaqus/CAE) you need to open up the materials 
editor and enter in material properties such as the Density, Young's Modulus, and 
Poisson's Ratio and so on for each of these materials. You could instead put all of these 
materials in a script. Then all you would need to do is go to File > Run Script ... and your 
material database would be populated with these materials in a couple of seconds. 
Basically you would be using the script to perform a repetitive task to save time. That is 
the one use of a script, to perform the same task the same way multiple times with 
minimal effort. We will in fact look at this example of creating materials with a script in 
the first chapter. 

A more complex use of a script is if you have a certain part on which you plan to apply 
loads and boundary conditions, and you wish to change the loads, constraints, or the 
geometry of the part itself and rerun the simulation numerous times to optimize the 
design. Let's assume for example you apply a load on a horizontal cantilevered beam and 
you want to know how much the beam bends as you increase its length. One way to do 
this would be to recreate the beam part 7 or 8 times. If your simulation has complex 
parameters you might have to apply sections, loads and constraints to it every time. A 
more sophisticated and efficient way to accomplish the same task is to write a script with 
the length of the beam assigned to a variable. You could then change the value of this 
variable and rerun the script in a loop as many times as you need to. The script would 
redraw the beam to the new length and apply the loads and BCs in the correct regions 
(accounting for the change in location of loads and BCs with the geometry). While this 
may sound like too much work for a simple beam simulation, if you have a more 
complex part with multiple dimensions that are all related to each other then remodeling 
it several times wiiJ prove to be very time consuming and a script will be the wise choice. 

An added advantage of a script is that you have your entire simulation setup saved in the 
form of a small readable text file only a few kilobytes in size. You can then email this 
text file to your coworker and a11 he would need to do is run this script in Abaqus. It 
would redraw the part, apply the materials, loads, boundary conditions, create the steps, 
and even create and run the job if programmed to do so. This also has the advantage of 
readability. If a coworker takes over your project, he does not need to navigate through 
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the model tree to figure out how you created the complex geometry of your part file, or 
what points and edges you applied each load or boundary condition on. He only needs to 
open up the script file and it's aiJ clearly spelled out. And you can put comments all over 
the script to explain why you did what you did. It keeps things compact and easy to 
follow. 

What you need ... 

This book assumes that you have some previous experience with running simulations in 
Abaqus in the GUI (Abaqus/CAE). This means you know how to set up a basic 
simulation, create parts, enter material properties, assign sections, apply forces and 
boundary conditions, create interactions, mesh parts and run jobs by using the tool bars or 
menus in Abaqus/CAE. When we start learning to write scripts you will essentially be 
perfonning all ofthese same procedures, except in the form of Python code. 

However you do not need to be an expert at these tasks. For every example we work on, 
we first look at the procedure to be carried out in the Abaqus/CAE. This procedure has 
been spelled out in the text, and is also demonstrated as silent video screencasts where 
you can watch me perform the analysis step by step. This is to ensure that you know how 
to perfonn the task in the GUI itself, before trying to write a script. These screencasts 
have been posted on the book website www.abaguspython.com (and hosted on YouTube) 
where I've found they are also being used by beginners trying to teach themselves 
Abaqus. Following the creation of these videos, I was employed by Dassault Systemes 
Simulia Corp. to create an Abaqus tutorial series on their new 'SIMULIA Learning 
Community'. I have recorded audio narration with detailed explanation over all of these, 
and other newer tutorials as well. These are currently displayed (free) at 
www.simulia.com/leaming. If you wish to brush up on your Abaqus skills you may 
watch these. Refer to the book website for up-to-date information and links. 

The book assumes that you have some basic knowledge of programming. This includes 
understanding concepts like variables, loops (for, while) and if-then statements. You are 
all set if you have experience with languages such as C, C++, Java, VB, BASIC etc. Or 
you might have picked up these concepts from programmed engineering software such as 
MA TLAB or Mathematica. 

In order to run the example scripts on your own computer you will need to have Abaqus 
installed on it. Abaqus is the flagship product of SIMULIA, a brand of Dassault 
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Systemes. If you have Abaqus (research or commercial editions) installed on the 

computers at your workplace you can probably learn and practice on those. However not 

everyone has access to such facilities, and even if you do you might prefer to have 

Abaqus on your personal computer so you can fiddle around with it at home. The good 

news is that the folks at SIMULIA have generously agreed to provide readers of this 

book with Abaqus Student Edition version 6.10 (or latest available) for free. It can be 

downloaded off the book website. This version of Abaqus can be installed on your 

personal computer and used for as long as you need to learn the software. There are a few 

minor restrictions on the student edition, such as a limitation on the number of nodes 

(which means we will not be able to create fine meshes), but for the most part these will 

not hinder the learning experience. For our purposes Abaqus SE is identical to the 

research and commercial editions. The only difference that will affect us is the lack of 

replay files but I'll explain what those are and how to use them so you won't have any 

trouble using them on a commercial version. Abaqus SE version 6.9 and version 6.10 

were used to develop and test all the examples in this book. The Abaqus Scripting 

Interface in future versions of Abaqus should not change significantly so feel free to use 

the latest version available to you when you read this. 

How this book is arranged ..• 

The first one-third of this book is introductory in nature and is meant to whet your 

appetite, build up a foundation, and send you in the right direction. You will learn the 

basics of Python, and get a feel for scripting. You'll also learn essential stuff like how to 

run a script from the command line and what a replay file is. 

The second part of the book helps you 'Learn by Example'. It walks you through a few 

scripting examples which accomplish the same task as the silent screencasts on the book 

website but using only Python scripts. Effort has been taken to ensure each 

example/script touches on different aspects of using Abaqus. All of these scripts create a 

model from start to finish, including geometry creation, material and section assignments, 

assembling, assigning loads, boundary conditions and constraints, meshing, running a 

job, and post processing. These scripts can later be used by you as a reference when · . 

writing your own scripts, and the code is easily reusable for your own projects. Aside 

from demonstrating how to set up a model through a script, the later chapters also 

demonstrate how to run optimization and parametric studies placing your scripts inside 
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loops and varying parameters. You also get an in-depth look into extracting information 
from output databases, and job monitoring. 

The last part of the book deals with GUI Customization - modifying the Abaqus/CAE 
interface for process automation and creating vertical applications. It is assumed that you 
have no previous knowledge of GUI programming in general, and none at all with the 
Abaqus GUI Toolkit. GUI Customization is a topic usually of interest only to large 
companies looking to create vertical applications that perfonn repetitive tasks while 
prompting the user for input and at the same time hiding unnecessary and complex 
features of the Abaqus interface. Chances are most readers will not be interested in GUI 
Customization but it has been included for the sake of completeness and because there is 
no other learning resource available on this topic. 
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PART 1- GETTING STARTED 

The chapters in Part I are introductory in nature. They help you understand how Python 
scripting fits into the Abaqus workflow, and explain to you the benefits and limitations of 
a script. You will learn the syntax of the Python programming language, which is a 
prerequisite for writing Abaqus scripts. You will also learn how to run a script, both from 
within Abaqus/CAE and from the command line. We'll introduce you to replay files and 
macros, and help you decide on a code editor. 

It is strongly recommended that you read all of these chapters, and do so in the order 
presented. This will enhance your understanding of the scripting process, and ensure you 
are on the right track before moving on to the examples of Part 2. 





1 -

A Taste of Scripting 

-
The aim of this chapter is to give you a feel for scripting in Abaqus. It will show you the 
bigger picture and introduce you to idea of how a script can replace actions you would 
otherwise perform in graphical user interface (GUl) Abaqus/CAE. It will also 
demonstrate to you the ability of Python scripts to perform just about any task you can 
perform manually in the GUI. 

When running simulations specific to your field of study you may find yourself reusing 
the same set of materials on a regular basis. For instance, if you analyze and simulate 
mostly products made by your own company, and these contain a number of steel 
components, you will need to define the material steel and along with its properties using 
the materials editor every time you begin a new simulation. One way to save yourself the 
trouble of defining material properties every time is to write a script that will accomplish 
this task. The Example 1.1 demonstrates this process. 

Example 2.1 -Defining materials and properties 

Let's assume you often use Titanium, AISI 1005 Steel and Gold in your product. The 
density, Young's Modulus and Poisson's Ratio of each of these materials is listed the 
following tables. 
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Properties of Titanium 

Property Metric English 

Density 4.50 g/cc 0.163 lb/in3 

Modulus of Elasticity 116 GPa 16800 ksi 

Poisson' s Ratio 0.34 0.34 

Properties of AISI I 005 Steel 

Property Metric English 

Density 7.872 g/cc 0.2844 lb/in3 

Modulus of Elasticity 200GPa 29000 ksi 

Poisson' s Ratio 0.29 0.29 

Properties of Gold 

Property Metric English 

Density 19.32 gjcc 0.6980 lb/in3 

Modulus of Elasticity 77.2 GPa 11200 ksi 

Poisson's Ratio 0.42 0.42 

Let' s run through how you would usually define these materials in Abaqus CAE. 

1. Startup Abaqus/CAE 

2. If you aren' t already in a new file click File > New Model Database > With 

Standard/Explicit Model 

3. You see the model tree in the left pane with a default model called Model-1. There is 

no '+' sign next to the Materials item indicating that it is empty. 
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4. Double click the Materials item. You see the Edit material dialog box. 

.. ..... -
._.,,.r ,; ...... , .... ' 
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5. Name the material Titanium 
6. Click General> Density. 

Qcnstty 

Oepyor 

Begularization 
!,lser Mat~ri~l 

Usec Defined f ield 
User Qutput Vari~bf~ 

7. Let' s use SI units with MKS (m, kg, s). We write the density of 4.50 glee as 4500 
kg/m3

• Type this in as shown in the figure. 

--~-~-~-•_I __ M __ «_h_in_i_ca_l __ !h __ ~_m_•_l __ ~ __ ~ ________________________ ~l lo~8el 
Density ·-- -----·--·- ---

IEJ Use t«npttature·dependent dna 

Numbtt of fitld variables: l 0 ~~ 
, Data ·-· ----------·-- ·- -· 

8. Then click Mechanical> Elasticity> Elastic 

~eneral I Mechanical !henna! Qther 

- Density 

!!::! Usettt 

Numbeto 

Data 

i ( I-,._. 

iJ.. 
1 

e.hsstk ity ~ 

Damag~ for D!,Lctile Metals .. 
Oamag,e for Traction Separation laws .. 
Damage for Fi,bet-Reinforced Composites .. 

Damage for Elastomers 

DeformBtion Plasticity 

~am ping 
~ansion 

irittle Cracking 

Eos 

Pastic 

J::typerela_stic 
Hypel{oam 

,Low Density Foam 

HypQelostic 
eorous'8astic 

~scoelastic 

I 
! [P~~~ 
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9. Type in the modulus of elasticity and Poisson's ratio. The Young's modulus of 116 

GPa needs to be written as 116E9 Pa (or 116E9 N/m2
) to keep the units consistent. 

The Poisson's ratio of0.34 remains unchanged. 

Elostic ... ·•· · 

Typco juottopic 

IEJ ll•• temporotur .. dep.,.dtnt dou 

Number of fitld varitbl"" L~ 

Moduli timt$Uie (for viscot:lnticity): 'lfi-ng-·ttnn-~ 
El No compreuion 

la No ttn<ion 

( D11J ·-·-··- ---· --·-·-····--·-.. ·--·--------·-··- -----

i Voung"s Po!ssoa's 
I : Modulll:s . ~io 
1 )_ -·---- 116£9 --1034·-.--:1 

I 

1-t o.K.£,1 Lc&nal,j .......... _, __________ · ····- .•. -. ....... .... ................. _, 

10. Click OK. The material is created and the model tree on the left indicates the 
presence of I material with the number 1 in parenthesis. Clicking the '+' symbol 
next to it reveals the name of the material Titanium, and double clicking it will 
reopen the Edit material window. 

I €a Model Oataba~ kiJ : ltJ 

il ~ Model$ (1) 

El Model·l 

t HI!• Parts 
1 t~ ~erTals(ij 
ll : ~ Sections 

i-. Profiles 
$ ii Assembly 

! $A Steps (1) 

t\ ·'tJ 
l "' 
lP 

~ 
~ 
~ 
~ 

! ~ ~ Field Output Requests 

I t re History Output Requests ~ 
1 b Time Points 1 

11. Repeat the process for the other 2 materials, AISI 1005 Steel and Gold. Remember 
to keep the units consistent with those used for Titanium. 
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12. When you're done the model tree should appear as it does in the figure with the 3 
materials displayed. 

Model I Rtsuttsj Material library J 
l€9 Model Database 1~1 ! rtl ~ ~ 
-l ~ Models (1) ~ • 

8 Modtl·l '1 
I· I!, Parts ,'i I 
j
. ~ Matetials (3) . 

lt- ~1005~~1 ~ 
Gold "' 

·· Titanium 

~ fl• Sections 

t· ~ Profiles 

That wasn't too hard. You defined 3 materials and you can now use these for the rest of 
your analysis. The problem is that you will need to define these materials in this manner 
all over again whenever you open a new file in Abaqus CAE to start a new study on your 
products. This is a tedious process, particularly if you have a lot of materials and you 
define a large number of their properties. Aside from consuming time there is also the 
chance of typing in a. number wrong and introducing an error into your simulations, 
which will later be very hard to spot. 

One way to fix this situation is to add your materials to the materials library. Then you 
could import the materials every time you created a new Abaqus file. Another way to do 
this would be in the form of -a script. You type out the script once and place if in a file 
with the extension .py and every time you need these materials you go to File > Run 
Script ... 

Let's put a script together. Start by opening up a simple text editor. My personal favorite 
is Notepad++. his free and it has got a clean interface. It also displays line numbers next 
to your code (making it easier to spot debugging errors) and can color code your script by 
auto-d~tecting Python from the file extension. On the other hand you may wish to use one 
of the Python editors from Python.org such as Python Win. The idea is to create a simple 
text 'file, and then save it with a .py extension. 
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Open a new document in Notepad. Type in the following statements: 

Save the file as 'chlexl.py' . Now open a new file in Abaqus CAE using File> New. 
Click on File > Run Script ... The script will run, probably so fast you won't notice 
anything at first. But if you look closely at the Materials item in the model tree you will 
see the number 3 in parenthesis next to it indicating there are 3 defined materials. If you 

click the '+' sign you will see our 3 materials. 

lia Model Database 1~1 ! ffJ ~ ~ 
·== 9J ~-odeJJ_g)j l _. 

I ' 
l 8 Model·l 

! ~ IJ. Parts l El C!i Materials (3) 

l
l f AISI 1005 Steel 

r Gold I j L Titanium 

J

ll r· ~ Sections r-• Profit~ 
In fact if you double click on any of the materials, the Edit Material window will open 
showing you that the density and elastic material behaviors have been defined. 

The script file has perfonned all the actions you usually execute manually in the GUI. lt's 

created the 3 materials in turn and defined their densities, moduli of elasticity and 

Poisson's ratios. You could open a new Abaqus/CAE model and repeat the process of 
running the script and it would take about a second to create all 3 materials again; 
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If by chance you tried to decipher the script you just typed you may be a little lost. You 
see the words 'density' and 'elastic' as well as the names of materials buried within the 
code, so you can get a general idea of what the script is doing. But the rest of the syntax 
isn't too clear just yet. Don't worry, we'll get into the details in subsequent chapters. 

Is writing a script better than simply storing the materials in the materials library? Well 
for one, it a1lows you to view all the materials and their properties in a text file rather 
than browsing through the materials in the GUI and opening multiple windows to view 
each property. Secondly you can make two or three script files, one for each type of 
simulation your routinely perform, and importing all the required materials will be as 
easy as File > Run Script. On the other hand if you store the materials in a material 
library you will need to search through it and pick out the materials you wish to use for 
that simulation each time. 

At the end of the day it is a judgment call, and for an application as simple as this either 
· method works just fine. But the purpose of this Example 1.1 was to demonstrate the 

power of scripting, and give you a feel for what is possible. Once you've read through the 
rest of the book . and are good at scripting, you can make your own decision about 
whether a simulation should be performed with the help of a script or not. 

. You've seen how a script can accomplish a simple task such as defining material 
properties. A script however is not limited to perfonning single actions, you can in fact 
run your entire analysis using a script without having to open up Abaqus/CAE and see 
the GUl at all. This means you have the ability to create parts, apply materia] properties, 
assign sections, apply loads and constraints, define sets and surfaces, define interactions 
and constraints, mesh and run the simulations, and also process the results, all through a 
script. In the next example you will write a script that can do all of these things. 

Example 2.2 - Loaded cantilever beam 

Just as in the previous example, we will once again begin with demonstrating the process 
in Abaqus/CAE and .then perform Jhe same tasks with a script. .We're going to create a 

simple.:..canti.J.eV.eL·heam· 5 .. .meters··long ~~~-~~'Cr{}SS' .section ef side 0.2 m made of 
-'·- NISI ·J OO'S"Steet/ Being a cantilever this beam ·WiU-.be -clamped at one end. That means 

· that"it can neither translate along the X, Y or Z axes, nor can it rotate about them at that 
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fixed end. This is also known as an encastre condition. A: .. pr.essure· load of I 0 Pa will 
cause the beam to bend downwards with the maximum deflection experienced the free 
end. 

Field output and history output data will be collected. Field output data provides 
information on the state of the overall system during the load step, such as the stresses 
and strains. Instead of using the defaults, we wi.ll instruct Abaqus to track the stress 
components and invariants, total stTain components, plastic strain magnitude, translations 
and rotations, reaction forces and moments, and concentrated forces and moments. 
History output data provides information on the state of a smaller section such as a node 
at frequent intervals. For this we will allow Abaqus to track the default variables for 
history output. 

We will mesh the beam using an 8-node linear brick, reduced --integration element 
(C3D8R) with a mesh size of0.2. We"..wi41"e-reate.a.job, submit it, and inspect the results. 

Let's start by performing these tasks in the GUI mode using Abaqus CAE. 

I. Startup A baqus/CA E 
2. If you aren't already in a new file click File> New 
3. In the Model Database panel right click Model-1 and choose Rename •... 

11· Models (l~ eT.u; ._c.m... c...,.." 
-l!i t. Copy Model ... 
)t S £dlt Attributts-

. • p Edit !Ce:ywords ... 

ji.A Ret~ame ... 

A S Delete.... Od 

• ~ F Set·AsRoot 
·!it 1- Expand. All Under 
bT 
• Arnt'lml'rlll'!"mRn:::mml'llrm:--r'fi 

'f1 lntereaions 

4. Type in Cantilever Beam. Model-:-1 will change to Cantilever Beam in the tree. 
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5. Double click on the Parts item. The Create Part dialog is displayed. Name the part 
Beam. In the Modeling Space section, choose 3D. For the Type choose 
Deformable. For Base Feature choose Solid as the shape and Extrusion as the 
type. Set the Approximate Size to 5. Press Continue .. 

N•m~ IBNm 'I 
I Modding Space 

~~ ~[) ? 20 Pf1n1r (1) ~m~~ _I 

Type - • · · 1 r Options . ......... ~,. l ! : 

I @ De!ormable ! : 
f """ o· . 'd ll ~ I v •scren ng• I 

I None available 
<0 An11ytit1J rigicl I I 

L~-~u~an _ll__ --- --
(" Base feature · - - -· ---. 

r Shape ·-- I Type ··- - . ! 

I @ Solid . !l 
i i 1 Revolution 11 'I (O Shdl L O Wire jl ~ I; 
!L~~~-----. !:; 
'--~·--·~ ..... 
Approximate. siz.e: rs= ~ ~ 

I Continue-.) j.,.,YI)~d~j l 

6. You find yourself in the Sketcher window. Select the rectangle tool from the 
tooJbar. For the first point click on (0.1 , 0.1 ). For the second point click on (0.3, -
0.1 ). A rectangle is drawn with these two points as the vertices. 
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rvr; 
~ r·n~Hr~,-,_~--~-+--+-~--b--r-TI--,_~--+--+--r; 

. ,.". ~t · 
~~ JJU 

l·l p~ H--1---+--+---+--+--t--i--i!---i--+--+---+---+---+---H ri.'· ::: 
H--JI-,_-+---+ 

n A nev acxlel database has been ereat.od 
~ The oaodcl "llodol - 1" bo" bee~ cr""Lod . 

\-=, A n"v llcxlcl da tGbolse nas been C%106tod . 
~ :The acxlcl "llodel-1" has been e1-eal ed . 

7. Click the red X button at the bottom of the window indicating End procedure and 
then click Done. 

8. In the Edit Base Extrusion window set Depth to 5. 

r End Condition 

1 Type: Blind 

11 Depth: [5"-J 
I '·. --··· ---- ····-- ----· 
If' Options ·······-- ._, · ,. · ··· -- 1 I j Note: Twist and draft cannot be specified together. ; 

l1 !El Include twist,. pitch: · '· (Dist/Rev) I • 

I LIE!_ I_n~lucfe ~~ft. ~n~le: ......_.......,..~ {Degrees) 
I ---' 

I 

9. Click OK. You will see a 3D rendering of the part Beam you just made. The Parts 
item in the model tree now has a sub-item called Beam. 
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i€11 Modd O•tot..sfl : GJ ~ 
~~McxfdsOl 

~ ~ s;:&mm 
! r~ Motorial• 

,, ~::::: 
' e jl Assembly 

! I toe. Strps (1) 

I I · !:r Field Output Roqu-

' j · f£ Histoty Output Rtque>ts 
l b TimePoinb 

1 ll;p AU A<bptive Mod> Con! 

1 • U lnter1ctions 
j !fl lntttaction Proptrties 

I tf Contact Contsols 

1 -ia Conact lniti11iali<H1s .-. ~-

~El 
· I ~.ih. 
: 12ii. U!J! 
: ~-

. : .!!,_ 8-q 
: g 

n A nev •txiol do.t<>bMe ho:s been creo.ted . 
~ The aodel • Hodel-1' hu been c rttated . 

, A nev .ooeJ da.tab<t.se ha.s been ONO&ted , 
~ The •odel "llodel - 1' ho.:s been c re4ted . 

V 

~ 
l~> 

1 0. Now would be a good time to save your file. Choose File > Save. Select the 
directory you save your files · in and name this file 'cantilever beam.cae' (or 
something more creative ifyou prefer) 

file Name: ~'dll=eq=============;;;;~JL. SJK I 
file Filttr. I Modtl Dltlbne r.cn"J G k C..nctl ' I 

11. Double click the Materials item in the model tree. Name it AISI 1005 Steel. Set 
General > Density to 7872 kg/m3

• Set Mechanical > Elasticity > Elastic to a 
Young's Modulus of200E9 N/m2 and a Poisson's Ratio of0.29. 
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1Nl, :i t
:~:;l6ch~~· . . -j ·i 
:~~-... -------~~. 11~_1 1 

El•>~k- 1 

Type: jlswopic c:J I• ~ion>! f 

El u~ ltmp.m...r .. dtpend..-1 dol• 

Nvmt>t<olfotldvarilblts:~ 
Modulttimt f.alot (fot viscodasticit)')l r-1 Lon- g-.1.,---rt:J'"'I. 

0: No comptession 

f:J Norension 

o.c. -
v.....,·. ro~uon·. -- -200E9 ·f· 

GBJ -----·-l.~e·~:L __ _ 

12. Click OK. The material is added to the model tree. 
13. Double clicluluthe·Sectimas item .. Tile Create Section window is displayed. Name 

it Beam SedMm. '-Set the Category to ·Solid and the Type to Homogeneous · if this 
isn' t already the default. 

; Nam~~_Se_ct_io_n __________ ~ 
~ Category Typ~ 

;, @S I'd I .:, 0 01 : 

~l ~ (!:) Shell , Generalized plane strJin 

Homogeneous 

j · If-."\ B 1· Eulerian ,· , v eam . 
·. ' ,. . 1 Composite 
·' l ~ f'luld ,. .. I :i·, 

1 i. ~ Other I: .__ ______ __. 

I 

14. Click Continue. The Edit Section window is displayed with the Name set to Beam 
Section and Type set to Solid, Homogeneous. Under the Material drop down menu 
choose AISI 1005 Steel which is the material you created a moment ago. 
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Name: Beam Section 

Type: Solid. Homogeneous 

Material; j AIS11005 Steel 

[El Plane stress/strain thickness: 

15. Click OK. You will notice that the Sections item in the model tree now has a sub
item called Beam Section. 

16. Next we need to assign this section to the part Beam. Expand the Parts (1) item by 
clicking the + symbol next to it to reveal the Beam item. Expand that too to reveal a 
number of sub-items such as Features, Sets, Surfaces and so on. 

Model L Results !·Material Libral)' ,I 

leJ Model Oat~ base 

~ ~. Models (1) _ 
! El [Cantilever Beaiij ' . i t:llb Palts (1) 

:

:,1 IS Beam . 
e'3 J! Features (1) 

i . ..b Sets 

j ~Surfaces 
1 ~ Slcins 
1 0 Stringers 
I [ Z· Section Assignments 

:

!.; 

1 
.. Composite L.ayups 

Gl ~ Enginwing Features 
I 

!.' j t. !b. Mesh (Empty) 

1 ~ ~ Materiel5 (1) 

I $ ~ Sections (1) 

j I L Beam Std:ion 
! ~ • Profiles 

~ 
j 
I 

17. Double click the sub-1t~in Section Assignments: You wi11 see the hint Select tbe 
regions to be assigned a section below the viewport. Hover your mouse over the 
beam in the viewport and when all its edges light up click to select it. 
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. ~ ------------------==~------------------===-·~~~ , • [B~ Stlt<tthcregionotobunigntdose<tion @3 !s.ts...l ~uu.o 
11 nev •odel datob<ose has beeo crea~ed. 
Tbe •odel ·llodel-1· bu been created . 
A ncv aodol do.tobo:sc bo~ been croot.ecl. 

~ The •odel "llodet-1· has been ~eel. 

18. Cl.ick Done. You see the .Edit Section Assignment window. Set the Section to 
Beam Section which is the section you created in steps 13-15. 

Rtgion 

Region: (Picked) 

. Section 

I; Section: rB_ea_m_ St!_ct_io_n __ ....,@l ~~~~~ .. ! 

l ' Not!!: list conuins only ~ctions 
· applicabletothesel~ed regions. i Type Solid, Homogentous 

l l.Ma_:e"al: _ Al~.l005 St~ 

~ L§!J!!ceiJ 

19. Click OK. The Section Assignments item now has 1 ·sub-item Beam Section 
(Solid, Homogeneous). The part in the viewport changes color (to green on my 
system) indicating it has been assigned a section. ~ 

20. Let's import the part into an assem,bly. Click the + symbol next to ' the· Assembly ,.. 
item in the model tree and double-click the Instances sub-item. You see the Create 
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Instance window. For Parts, Beam is the only option available and it is selected by 
default. For the Instance Type choose Dependent (mesh on part). 

- Jn!bnaTypo-----·--

@\ Oop011dt111 (l'>esl\010 pori) 

el lndes><ndent (met. on insblncd 

Not~ Todunge-aGtp~inuance's 

21. Click OK. The Instances sub-item of the Assembly item now has a sub-item of its 
own called Beam-1. You can right-click on it and choose Rename •... Change the 
name to Beam Instance. 

22. Next we create a step in which to apply the load. Notice that Jhe Steps item in the 
model tree already has the Initial step. Double-click the ,Steps item. The Create 

/ ' / 

Step window is displayed. Name the step Apply Loa~- :F{)r ~.nsert new step after 
the only option is Initial and it is selected by detall.k. -s,t the Procedure type to 
General from the drop down menu. In the list scroll down till you see Static, 
General and select it. 
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>1-.... .1::!&- • 

il!:J ·~re~te, 

Name: [AP;i;'L;;;;d 
Insert new step after 

Initial · 

Procedure type: I General BJ 
Dynamic. Explicit 
Dynamic, T emp-disp, Explicit 

Geostatic 
Heat transfer 
Mass diffusion 

23. Click Continue .... You see the Edit Step window. For the description type in Load 
is applied during this step. Leave everything else set to the defaults. 

24. Click OK. You'll notice that the Steps item in the Model Database now has 2 steps, 
Initial and Apply Load. 

25. Let's now create the field output requests. Right click4Re ~Field Output Requests 
item in the model tree and choose Manager. You see the Field Output Requests 
Manager window with an output request F-Output-1 created in the Apply Load 
step. 

Variabl6: Prestltcted dtfaults 

I Activ•te I 
~vat•) 

' s,tahl$: Cruted in this step 
, ~------------~----------------------
. L0~.~··Jl I €opx;··d l~!l!11.m~l I Qt1~~-~l L!>jsmiss I 

:.:.;,c 
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Click the Edit button. You notice a number of output variables selected by default. 
On top of the list of available output variables you see a comma separated listing of 
the ones selected which by default reads CDISP, CF, CSTRESS, LE, PE, PEEQ, 
PEMAG, RF, S, U,. 

26. From the Strains remove PE, Plastic strain components, PEEQ, Equivalent 
plastic strain and LE, Logarithmic strain components. Add E, Total strain 
components. Remove Contact entirely. The variables you are left with are 
displayed above as S,E,PEMAG,U,RF,CF 

i' Output V1riJ~ ·-- · ·~ · ·-·--·· --- ···--···-· ·· ·---· 

(t) Sdt<tftom liv bdcw e Pt.,dtcttdddauhs e;l All 0 £dhariablt< 

lS.EPEMAG.U.Rf,O: ____] :. 

I, ~ .Sit..... ·:l . 
. ~!: .. , _ -~ - • .SV .. ins ., , 

fll E. Tot.tl Jbain components , / 
~ Vf. Vis.cou~ .s.t,.in •n the elntit•Yiscou1 nttwotk' ! 
~ Pf. Pf•~tic st111n <ompontnts 
1r:J VEEQ.. t.qu~lftmYiKOU!t Jt,.in in tht. tt•'Stic·'lliuout ndwotlr 
1EJ PE£Q. Equivolcnt plutic stt1io 

; l!l PEEQT. (qulvilcntpfutic sttfln ~UOI'\: CIJt'iron 1od concJtt.'t) 1 I!·, [ ~p~~:"m~m~tpladicwaln _ •• , .' ~ 1 
: ~ Nd:« Enor JndiUCOIJ art not w•i.l•blt wtltn OomMn i$ \Vhoje Modd otltmildi~n. 

Out,>ut at.,..._ t...n\ 1r1d lqatd •«tit>n pGinb: 

' *U.edd....., 0 Spt<ify. Cc: •:i. ;)tj 
fl)ltttk.d'e-loal cootdinate.dile«ions -..men tv-1ilabt~ 

27. Click OK. Then click Dismiss ... to close the Field Output Request Manager 
window. In the model tree right click the F-Output-1 sub-item of Field Output 
Requests and rename it Selected Field Outputs. 

28. Let' s move on to history output requests. Rig~t cHck History Output Requests in 
the model tree and choose Manager. You see the History Output Requests 
Manager window. It is very similar to the Field Output Requests Manager 
window. 
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Step procedure: Static. General 
Variables: Prese!ected defaults 
Status: Created in thi~ step 

L ~~py ... I 

/ 

I Delete. •• I 
;r 

I Edit... I 
I Move Left I 
!Move. Righrj 

I Activat! j 
I Oe.activ~te I 

I Di_!miss I 

29. [fyou click Edit you can see the variables selected by default. We're going to leave 
the default variables selected so Cancel out of the Edit History Output Requests 
window. In the model tree right click the H-Output-1 sub-item of History Output 
Requests and rename it Default History Outputs. 

30. lt's time to apply loads to the beam. In the model tree double click-the Loads item. 
You see the Create Load window·. Name the load Uniform Applied Pressure. For 
the step select Apply Load. Under Category choose Mechanical. And from the 
Types for Selected Step 1 ist choose Pressure. 

f D €rtate LoacJ 

Name 'lu-n·-,ro-rm--Ap_p_lied--P-res-su_r_e ________ , 

. Step: [ A~~ly load Ell 
: Procedure: Static, Gl!neral 

. <" Cat~O'Y --.. ·-·--1 ( Types for St!ected Stq> 
' I, r---------- -, 
i @ Mechanical j 1 C~ncentrated force 

() Thermal j Moment 

• 
1 
() Acoustic ' 

1 Shell edge load 
l Surface. traction 

0 Electrital l Pipe pressure 
I , : v Mm diffu~ioo ! I Body force 

,:;. Fluid 

. I e Other ll l ine loa cl 
i Gravity 

~~ Bolt loJd 
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31 . Click Continue .... The viewport displays a hint at the bottom Select surfaces for 
the load. Hover your mouse over the top surface of the beam till its edges light up. 
Click to select. 

Modd ··Res..lts Module: 
~==~~~==~~~==~--------~----~ 

!E'1Mode1Dol1bos<@; G;J ~ '9 ~U!I 
1 l!f History Output Request• (l) • 

f
' e Default Hl<tory Output• ' 
·b Time Points 

f 
~ ALE Ad1ptiva t.Aeoh Con.U.ints 
'i:l lntetJdions 

Q lnteroction Properties ~ 

I, I{ Conlllct Conttols 
· Q:: Contact lnitialiutions 

t ~ Constraint< 
1-· Connedor~ons 
Y Fields 

1-~ Ampliwd .. 

~· !!:!.lm 

1!:. Ptedefined Fields t
J;\;. BCs 

I ~. Rtmeshin9Rules • ~rvl 
u.:':__,.~~:~~--":,;.:;' ;.;;'"~~!!...___;:._] !EIIf8 Selertsulfacestolthelood ~~~ 

32. Click Done. You see the Edit Load window. For Distribution choose Uniform 
from the drop down list. For Magnitude enter a value of 10 Pa (just type in 10 
without units). 

1:•- Editl~~ . 1 

l Name: Uniform Applied Pressur! 
l 
! Type: Pressure 
I . ! Step: Apply Load (Static, Gmeral) 

! Region: (Picked) 

I Distribution: I Uniform _8 [§f~~.,l 
I Magnitude: E I 
l Amplitude: I (Ramp) liiJ [&r~te. .. l 

I 
l 
i--~====~----~====~--i 1~&;,.9$\ lt...~,J 

33. Click OK. The viewport updates to show the pressure being applied on the top 
surface with the arrows representing the direction. Also the Loads item in the Model 
Database tree now has a sub-item called Uniform Applied Pressure. 
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34. The n~t step is to apply the boundary conditions or constraints. Double click on the 
. BCs item in the Model Database tree. You see the Create Boundary Condition 
window. Name it Encastre one end. Change Step to Initial. Under Category 
choose Mechanical. From the available options for Types for Selected Step choose 
Symmetry/Antisymmetry/Encastre. 

I 

I 
I 
I 

Name: I (ncastre one end 

Step: I Initial liJl 
~ - Procedure: 

h Category · · 
1
. Types for Selected Step · 

i 'l ; fl 
!1! @ Mechankal ·j ' Symmelty/Antisyrnmdry/Entd~trc 
I 1 0 Fluid Displacement/Rotation 

j ·l IF~ Other V~ocity/Angular velocity 
! i v 'I Accel~tion/An9ular acc~~ation 
l
1
j . I , Connector displacement 

! l I i Connector velocity 
! ~ ' 

'1! hi 
111 !-

\-' --

: Connector acceh!:ration 

I Gontjnue... I 
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35. Click Continue .... The viewport displays a hint at the bottom Select regions for the 
boundary condition. Hover your mouse over the surface at one end of the beam till 
its edges light up. Click to select it. 

36. Click Done. You see the Edit Boundary Condition window. Choose ENCASTRE 
(Ul = U2 = UJ = URl = UR2 = UR3 =0). This will clamp the beam at this end. 

~~~~a"ft~""~':'f:!·r~·~~11~~il1 

Nam~ Encastre one end 

Type: Symme:tty/Antisymmetry/Encastre 

Step: Initial 

Region: (Pidced) 

(5) XSYMM (Ul = UR2 = UR3 = 0) 

® YSVMM (U2 = URl = UR3 = 0) 

0 ZSVMM (U3 = URl :: UR2 :: 0) 

(f) XASYMM (Ul = U3 = URl :: 0; Abaqus/Standard only) 

® YASYMM (U1 = U3 = UR2 :: 0; Abaqus/Standard only) 

® ZASYMM (Ul = U2. :: UR3 = 0; Abaqus/Stand11rd only} 

® PINNED (Ul : U2. = U3 : 0) 

@ ENCASTRE (Ul = U2 = U3 = URl "' UR2 = UR3 = 0) 

37. The viewport will update to show the end of the beam being clamped. Also the BCs 
item now has a sub-item called Encastre one end. 
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38. If you haven't been saving your work all along now would be a good time to do it. 
We're going to mesh the part and then run the simulation. 

39. [n the model tree expand the Parts item again, and then the Beam sub-item. You see 
. .;~·~Mesli" (Empty) sub-item. at-the bottom. Double-click it. You are now in mesh 

mode and yq,u .notice;the toolbar next to the viewport changes to provide you with 
mesh tools. 

40. Using the menu bar go to Me~h > ~lement Typ_e. The Element Type window is 
displayed. For Element 'Library choose' Stamtarif!, for- Geometric Order choose 
Linear, and for Family choose 3D Stress from the list. Leave everything else at the 
defaults. You will notice the description C3D8R: An 8-node linear brick, reduced 
integration, hourglass control near the bottom of the window. 
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Element libwy - - i, r:Family __ 

@ Standard () Explicit i 
_ . _ _ .. J Acoustic 

Goomt«ic Order ~~- ·, Cohesive 
_., o: a. Q d ~: 1 Continuum Shell 
\~ unNr v ua roue 1 '-------"'·----

~---------------~ 

@ 

... ;-:.-::::;.---:::::::---R-

H~ I•Wedge--1 fttcj 

!El Hybrid formulation 0 Reduced integration IEJ lncompatible mod~ 

r- Element Controls --·--· ·----·-·· .. ----·-·--· - ···· ........ · ......... · ...... - ... ----·-·--·--------·----...... _.. 

HourgiiSs stiffness: @ Ust dtfault 0 Specify L:. _ J 
Viscosity. @ Uoe dthult 0 Specify D 

r 
i~ . 
L 

Kinemotic split @ Av~•9• strain E5 Orthogonal (5 Controid 

Second·otder accuracy. E5 V eo @ No 

Oistoltion control: @ Use default ID Yes 0 No 

--- .... -· 
C308R: An8-nodt ijnear bricl(. reduced integratiol\ hourglus cortrol. 

Note: To soled an olement.hapt for mtshing. 
soled "Meoh·>Controls"from the main mtnu b11. 

41. Click OK. ruM~-!. 

42. Then use the menu bar to navigate to Seed > l!al:i. The Global Seeds window is 
displayed. Change the Approximate global size to 0.2, which is the width of our 
beam. Set the Maximum deviation factor to 0.1 . 

: Sizing Controls 
. ; 

~ Approximate global siz~ I Ol 
'--------' 

l 

' ~ Curvature control 

Maximum deviation factor (0.0 < h/L < l.o): ":lo.,....l ___ _,j • 
(Approximate numb~ of elements pet cird~ 8) 

Minimum sizdactor (as a fraction of global sizf): 

@ Use default (Ol) <Cl Sp~ify (0.0 < min < 1.0) ~ 

43. The beam in the viewport updates to show where the nodes have been applied. 
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. ~~ 
44. Then from the menu bar go to Mesh > l!aJ:t. You see the question OK to mesh the 

part? at the bottom of the viewport window. Click on Yes. The part is meshed. The 
Mesh item in the model tree no longer has the words (Empty) next to it. 

45. Now it is time to create the analysis job. 
46. All the way at the bottom of the model tree you see Analysis with the sub-item Jobs. 

Double-click on it. The Create Job window is displayed. Name it 
CantileverBeamJob. Notice that there are no spaces in the name. Putting a space in 
the job name can cause problems because Abaqus uses the job name as part of the 
name of some of the output files such as the output database (.odb) file. Source is set 
to Mo~el and the only model you can select from the list is Cantilever Beam. 
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!;! Create Job 

Name: j CantileverBeamJob I 
Source: j Model li1J 
Cantilever Beam 

I Continue. .. 11 . Cans el J 

47. Click Continue .... You see the Edit Job window. In the Description textbox type 
in Job simulates a loaded cantilever beam. Set the Job Type to Full Analysis. 
Leave the other settings to default. Notice that in the Memory tab there is an option 
for Memory allocation units. On my system the option selected is Percent of 
physical memory, and for the Maximum preprocessor and analysis memory my 
system defaults to 50°/o. You might wish to play with these numbers if your 
computer has insufficient resources. 

Name: CantileverlleamJob 

Model: Cantilever Beam 

Analysis product Abaqus,IStandard 

Description: !Job simulates a loaded cantilever beam 

. 
Job Type 

' @ Full analysis 

I 
! £C) Recover (&plicit) 

: 0 Restart 
----· --- ............ ---·-' 

Run Mode ~--·-·- -...•. -·-----·----. 
B :: ·: JE)Ho!tnarnt"; :@Background ei Queue:a: • :v,~·:,Y ~Type: 

I 

' - ..... - - ~-----·--~· __ __ .... -·-· ........ - ... ·---·---..... ..... .... -~·-·--------- J 

, .. Submit Time · -- •· 

® Immediately 
1 
() Wait~hrs.~min. 
0 At; L; ' ;.<Cf~.. . llr.p, .. j f!·s __ ,_- .1._~_:_,. *-

- . -- -· .. -
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48. Notice that the Jobs item in the model tree now has CantileverBeamJob listed (you 
might have to hit the'+' symbol to see it). Right-click on it and choose Submit. 

49. The job starts running. You see the words (Submitted) appear next to its name in 
parentheses, then a few seconds later you see (Running) and when the simulation is 
complete you see (Completed). 

50. Right click on CantileverBeamJob (Completed) and choose Results. You see the 
undeformed shape. 

.~. . ...... liiiU.4. ~C..•I~' bt•OIII ooe v,.w .... aw..u.DM• MtH..Wfw..._ .. ~., I!C~4· t..ID-·l S.l J.• u 16.~1& t..c•• O.,Jt•l ,...,. tDi l 
~-.:a..., ...... LoH4I ~ ....... , ....... lf1••-· 
t"'N'"M"I 1! ;..,t:... • •. 000 

WD~~--------------------------~~~~==~--~.-~ {tj[gj OragtMmouseinniowpartt<uototetileviow Routian<tnlitf: [ Sd«t... llu..:omubl ils -··- -------' 
SlloflltM 

51. Click the Plot Deformed Shape button in the tool bar to the left of the viewport. You 
will see your deformed beam. Of course the deformation has been exaggerated by 
Abaqus. You can change that if you wish by going to Options > Common ••. if you 
wish. 
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You have created and run a complete simulation in Abaqus/CAE. It was a very basic 
setup, but it covered all the essentials from creating a part and assigning sections and 

material properties to applying loads and constraints and meshing. Now we're going to 
watch a script perform all the same actions that we just did. 

Open up a Jext editor such as Notepad++ and type in the following script. 
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Typing out the above code might be a real pain and you'll likely mistype a few variable 
names or make other syntax errors creating a lot of bugs. It might be a better idea just to 
use the source code provided with the book- cantilever_beam.py. 

Open a new Abaqus model. Then go to File > Run Script. The script will recreate 
everything you did manually in Abaqus/CAE. It will also create and submit the job so 
you will probably notice the analysis running for a few seconds after you run the script. 
You can then right click on the 'CantileverBeamJob' item in the model tree and choose 
Results to see the output. It will be identical to what you got when performing the 
simulation in the GUI. 

In the example we did not use the script to accomplish anything that could not be done in 
Abaqus/CAE. In fact we first performed the procedure in Abaqus/CAE before writing our 
script. But I wanted to drive home an important point: You can do just about anything in 
a script that you can do in the GUI. Once you're able to script a basic simulation, you'll 
be able to move on to more complex tasks that would really only be feasible with a script 
such as making automated decisions when creating the simulation or performing 
repetitive actions within the study. 

As for the script from this example, we're going to take a closer at it in Chapter 4. Before 
we can do this you' re going to have to learn a little Python syntax in Chapter 3. But first 
let's take a look at the different ways of running a script in Chapter 2. 
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Running a Script 

This chapter will help you understand how Python scripting fits into Abaqus, and also 
point out some of the different ways a script can be run. While you may choose to use 
only one of the methods available, it is handy to know your options. 

A few years ago Abaqus existed purely as a finite element solver. It had no preprocessor 
or postprocessor. You created text based input files (.inp), submitted them to the solver 
using the command line, and got text based output files. Today it has a preprocessor 
which generates the input file for you - Abaqus/CAE (CAE stands for Complete Abaqus 
Environment), and a postprocessor that helps you visualize the results from the output 
database - AbaqusNiewer. When you use Abaqus/CAE, the actions you perfonn in the 
GUI (graphical user interface) generate commands in Python, and these Python 
commands are interpreted by the Python Interpreter and sent to the Abaqus/CAE kernel 
which executes them. For example when you create a new material in Abaqus/CAE, you 
type in a material name and specify a number of material behaviors in the ' Edit Material' 
dialog box using the available menus and options. When you click OK after this, 
Abaqus/CAE generates a command or a number of commands based on what you have 
entered and sends it to the kernel. They may look something like: 

beamMaterial = beamModel.Material(name='AISI 1ees Steel') 
beamMaterial.Density(table=((7872, ), )) 
beamMaterial . Elastic(table=((2eeE9, e .29), )) 

In short, the Abaqus/CAE GUI is the easy-to-use interface between you, the user, and the 
kernel, and the GUI and kernel communicate using Python commands. 
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Abaqus/CAE Python Python Abaqus/CAE 
GUI commands Interpreter Kernel 

The Abaqus Scripting Interface is an alternative to using the Abaqus/CAE GUI. It allows 
you to write a Python script in a .py file and submit that to the Abaqus/CAE Kernel. 

Abaqus Scripting Interlace Python Python Abaqus/CAE 
(Python Script) commands Interpreter Kernel 

A third option is to type scripts into the kernel command line interface (CLJ) at the 
bottom of the Abaqus/CAE window. 

Abaqus CLI Pvthon Python Abaqus/CAE 
(Command Line Interface) commands Interpreter Kernel 

The Abaqus/CAE kernel understands the model and creates an input file that can be 
submitted to the solver. The solver accepts this input file, runs the simulation, and writes 
its output to an output database (.odb) file. 

Abaqus/CAE Input File 
Abaqus Solver 

~ 
Output Database 

Kernel (Standard/Explicit/CFD) (.odb) 

You have_ the option of running a script from with in Abaqus/CAE using the File > Run 
Script ... menu option. You can do this if your script irrespective of whether your script 
only performs a single task or runs the entire simulation. 
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v~.l ·. Qunnin.! .a·scriH't in GUI to ei"ecute a ,single or multiple tasks -- ~~= ..... . ~~· ~~:..10.~· • 

If you have a script that performs a single independent task or mu1tiple tasks assuming 
some amount of model setup has already been completed or will be performed later, you 
need to run that script in Abaqus/CAE. For instance, in Example 1.1 of Chapter 1, we 
wrote a script which only creates materials. On its own this script cannot run a 
simulation, it does not create a part, assembly, steps, loads and boundary conditions and 
so on. However it can be run within Abaqus/CAE to accomplish a specific task. When we 
ran the script using File > Run Script ••• you noticed the model tree get populated with 
new materials. You could then continue working on the model after that. 

Such scripts will not run as standalone from the command line, or at least they won' t 
accomplish anything. 

~ ' ~ "~~~ ~ ~ · ·~ -.-. 23.2. ··· ·Running a sc~~t in G"UJ":to e;X.ecute an entire simulation 
If you have a script that can run the entire simulation, from creating the part and materials 
to applying loads and constraints to meshing and running the job, one way to run it is 
through the GUI using File > Run ... This was demonstrated in Example 1.2 of Chapter I. 
However such a script can also be run directly from the command line. 

Path 

The path is a list of directories which the command interpreter searches for an executable 
file that matches the command you have given it. It is one of the environment variables 
on a Windows machine. 

The directory you need to add to your path is the 44Commands" directory of your Abaqus 
installation. · By default Abaqus Student Edition v6.1 0 installs itself to directory 
'

4C:\SIMULIA\Abaqus,. It likely did the same on your computer unless you chose to 
. install it to a different location during the installation procedure. One of the sub

directories of 44C:\SIMULIA\Abaqus, is "Commands", so its location is 
"C:\SIMULIA\Abaqus\Commands". This location needs to be added to the system path. 
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Check if Abaqus is already in the path 

The first thing to do is to check if this location has already been added to your path as 
part of the installation. You can do this by opening a command prompt. To access the 
command prompt in Windows Vista or Windows 7, click the Start button at the lower left 
corner of your screen, and in the ' Start search' bar that appears right above it type ' cmd' 
(without the quotes) and hit enter. In Windows XP you click the Start button, click ' Run', 
and type in ' cmd' and click OK. You will see your blinking cursor. Type the word 'path' 
(without the quotes). You wil'l see a list of directories separated by semicolons that are in 
the system path. If Abaqus has been add to the path, you will see 
"C:\SIMULIA\Abaqus\Commands" (or wherever your Commands folder is) listed among 
the directories. If not, you need to add it manually to the path. 

Add Abaqus to the Path 

Adding a directory to the path differs slightly for each version of Windows. There are 
many resources on the internet that instruct you on how to add a variable to the path and a 
quick Google search will reveal these. As an example, this is how you add Abaqus to the 
path in Windows Vista and Windows 7. 

I. Right click My Computer and choose Properties 
2. Click Advanced System Settings in the menu on the left. 
3. In the System Properties window that opens, go to the Advanced tab. At the 

bottom of the window you see a button labeled Environment Variables ... Click 
it. 

4. The environment variables window opens. In the System variables list, scroll 
down till you see the Path variable. Click it, then click the Edit button. You see 
the Edit System Variable window. 

5. The variable name shall be left at its default of Path. The variable value needs to 
be modified. It contains a number of directories, each separated by a semi colon. 
It may look something like 
C:\Windows\System32\;C:\ Windows\;C:\ Windows\System32\ Wbem. At the 
end of it, add another semi colon, and then type . in 
C:\SIMULIA\Abaqus\Commands. So it should now look something like 
C:\Windows\System32\;C:\Wiodows\;C:\Wiodows\System32\Wbem;C:\SIM 
ULIA\Abaqus\Commaods. C lick OK to close the window, and click OK to 
close the Environment Variables window. 
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6. Now if you go back to the command prompt and type path, you see the path has 
been updated to include Abaqus 

Running the script from the command line 

Now that Abaqus is in the system path, you can run your scripts from the command line. 

First you navigate to the folder containing your script files using DOS commands such 
as cd (change directory) command. For example, when you start the command prompt, if 
your cursor looks something like C:\Users\Gautam>, and your script is located in the 
folder C:\Users\Gautam \Desktop\Abaqus Book, then type in 

cd C:\Users\Gautam \Desktop\Abaqus Book 

and press Enter. Your cursor will now change to C:\Users\Gautam\Desktop\Abaqus 
Book> 

You are now in a position to run the script with or without the Abaqus/CAE GUI being 
displayed. 

2.4~.1 : Run .tlie~ript from the command line without the GUI 
~----~~-------Type the command to run the script without the Abaqus/CAE GUI. The exact command 

varies depending on the version of Abaqus. 

In the commercial version of Abaqus you would type 

abaqus cae noGUI= "cantilever_beam.py" 

In the student edition (SE) version 6.9-2 you would type 

abq692se cae noGUI="cantilever_beam.py" 

In the student edition (SE) version 6.10-2 you would type 

abq6102se cae noGUI="cantilever_beam.py" 

Notice the difference in the first word of all these statements. If you are not using either 
of these versions the command you use will be different as well. To figure out exactly 
what it is, go to the 'Commands' folder in the installation directory and look for a file 
with the extension '.bat'. In the commercial version of Abaqus this file is called 
'abaqus.bat', hence in the commercial version you use the command 'abaqus cae 



38 Running a Script 

noGUI="cantilever beam.py". In Abaqus 6.10-2 student edition, the file is called 

'abq6102se.bat' which is why the command 'abq6102se cae 

noGUI="cantilever_beam.py" has been used. Depending on the name of your file, change 

the first word in the statement. 

When you run your scripts in this manner, you will not see the GUI at all. While the 
script is running, you will notice that the cursor is busy and you cannot type in any 

other commands at the prompt. This is because we have used the built in method 

waitForComp]etion() in the script which prevents the user from executing other DOS 

commands while the simulation is running. We will take a look at this statement 

again a little later, just be aware that if we did not include the waitForCompletion() 

command in the script, the prompt would continue to remain active even while the 

simulation is being run. And if you find yourself running batch files, or linking your 

simulations with optimization software such as !Sight or Mode1Center, this 

knowledge will come in handy. 

abq6182se cae script="cantilever_beam.py" 
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When you run your scripts in this manner, Abaqus/CAE will open up and the script is 
run within it. In addition the cursor will remain busy (as seen in the figure), and will 
only be released once you close that instance of Abaqus/CAE. 

1>. '#!. ; "' .f ':' ' • , ',.; ~ I "c: ... '!-. :• · t '\, 

2~5 Runn~g a scriJ>l!!om tb~ c-ommand Ji:Oe interface (c;LI) 
The kernel command line interface is the area below the viewport in Abaqus/CAE. 
Chances are the message area is currently displayed here. If you click the box with '>>>' 
on it you will be able to type in commands. We will use this to test a few different Python 
commands in the next chapter. For now l wish to make you aware that it is possible to 
run a script from here using the execfile() command. 

Type in 

Execfile('cantilever_beam . py') 

The file you've passed as an argument to execfile() needs to be present in the current 
work directory for Abaqus, otherwise you need to spell out the full path such as: 

Execfile('C;\Users\Gautam\Desktop\ Book\cantilever_beam.py') 

By default the work directory is C:\Temp although you can change it using File > Set 
Work Directory .. 

If the file is not in the current work directory and you did not specify the full path, 
Abaqus will not find the script and will display an IOError. 

IOError : (2, 'No such file or dir ectory' , ' cantilever_beam.py)) 
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>>> execfile('cantilever_beaa .py') 
IOError : (2 . 'No such file or di~tory' . 'cantilever_beaa .py') 

I ,L.---11 > » I 

If the file is present in the work directory, or you specifY the full path, the script executes 
successfully. 

>» . 
>>> execfile('eantilever_beaa .py') 
Global seeds have been assigned. 
200 eleaemts have been gemerated on part. : Beaa 
Job BeaaDeflectionJob: Analysis Input File Processor ooapleted successfully . 
Job BeaaDeflectionJob: Abaqus/Standard COilpleted successfully . 
Job BeaaDeflectionJob coapleted successfully . 

>» l ·-------··-----

' "..........._.,~1 
This chapter has presented to you some ofthe various ways in which scripts can be run. 
You may choose the appropriate method based on the task at hand, or feel free to go with 
personal preference. 
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In the cantilever beam example of Chapter 1, we began by creating the entire model in 
Abaqus/CAE. We then opened up a new file and ran a script which accomplished the 
exact same task. How exactly did the script work and what did all those code statements 
mean? Before we can start to analyze this, it is necessary to le~m some basic Python 
syntax.lfyou have any programming experience at all, this chapter should be a breeze . 

. 
Python is written in the form of code statements as are other languages. However you do 
not need to put a semi-colon at the end of each statement. What the Python interpreter 
looks for are carriage returns (that's when you press the ENTER key on the keyboard). 
As long as you hit ENTER after each statement so that the next one is on a new line, the 
Python interpreter can tell where one statement ends and the other begins. 

In addition statements within a code block need to be indented, such as statements inside 
a FOR loop. In languages such as C++ Y9ll use curly braces to signal the beginning and 
end of blocks of code whereas in Python_:you indent the code. Python is very serious 
about this, if you don't indent code which is nested inside of somethi~g ·eJse (such as 
statements in a function definition or a loop) you will receive a lot of error messages. 

Within a statement you can decid~ how ~uch whitespace you wish to leave. So a=b+c 
can be written as a = b + c (notice the spaces between each character) 

In some programming languages such as C++ and Java, variables are strongly typed. This 
means that you don' tjust name a variable; you also declare a type for the variable. So for 



42 Python 101 

example if you were to create an integer variable 'x' in C++ and assign it a value of 5, 
your code would look something like the following: 

int x; 
X=5; 

However Python is n~t strongly typed. This means you don't state what type of data the 
variable holds, you simply give it a name. It could be an integer, a float or a String, but 
you wouldn't tell Python, it would figure it out on its own. So if you were to create an 
integer variable x in Python and assign it a value of 5 you would simply write: 

X=5 

In addition Python doesn 't mind ifyou try to do things like multiplying a whole number 
with a float. Some languages object to this type of mixing and require an explicit cast. 
Python is also able to recognize String variables, and concatenates them if you add them. 
So a statement like 

greeting = 'h' + 'ello' 

stores the value 'hello' in the variable 'greeting'. 

Let's work through an example to understand some of these concepts. 

Example 4.1- Variables 

Open up Abaqus CAE. In the lower half of the window below the viewport you see the 
message area. If you look to the left of the message area you see two tabs, one for 
"Message area" and the other for "Kemal Command Line Interface". 

l 
r·l!::. l'rodefinal Fields 
1-'ll Remtsh"'g fWios 
Le. Sketch .. 

1 ~ Annoutions 

all An•tysis 
[-.!.Jobs 

Click the second one. You see the kernel command prompt which is a ">>>" symbol. 

Type the following lines, hitting the ENTER key on your keyboard after each. 
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The number 40 is displayed. Since we set length to I 0 and width to 4, the area being the 
product of the two is 40. ~~-:pr.Htt.:sta.tement displays the-value stored in the area 
variable. The follo~ing image.d-ispl~ys what you should ·s~e on your own screen. 

I 
r ~ Remeshing Rules 
l.. C. Slcttches 

· ~ Annotations 
etl Analysis 

·A Job$ 

> » length • 10 
> » width • 4 
>> > area • length * vidth 
» > print are" 
40 

. . 
' ' . 

,)'.;l i-.~~.; ~ .. >: ~c .. ·._ .... , ... ... . .. . . ..: ~··.-:.,· ~· .. -,: ..,: ... 
t!!.~if::i~;~;;@,t~~::: ·:·i~~·, -'ll~P~~·"'i~tE~~i~··f .. ~ fr.'i<f-~.YS~;.$~'S.;~•r.;.,!:·~;. ~,~~..2~~Jf'i:~;~~~. 

So you see the Python interpreter realized that the variables 'length' and 'width' store 
integers without you needing to specify what type of variables they are. In addition when 
assigning their product to the variable 'area', it decided for itself that 'area' was also an 
integer. 

What if you had combined integers and floats? Add on the following statements: 

The output is 140.0 . Note the ".0" at the end. Since your height variable was a float 
(number with decimal point in layman terms), the volume variable is also a float, even 
though two of its factors 'length' and 'width' are integers. 

r::1 > > > length • 10 
~-1 >>> vidt:h • 4 

,__...., • ...,: 1 >» area • length • vidth 
~ >» print o~ 
t=J 40 

........._..... >>>- depth a 3 . 5 
>>> volu•e • length * vidth * depth 
>>> print volu•e 
140 . 0 . 
>»I 
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Lefs experiment with Strings. Add the following lines 

The output is "GautamPuri". Notice that we did not tell Python that ' first_name' and 
'last_name' are String variables, it figured it out on its own. Also when we added them 
together, Python concatenated them together. 

n »> 
~ >» first_na•e • "Go-uta•• 

>>> last naae • •Puri• 
~>~ >>> na.e-· first_na•e + last_na•e 

'----.I >» print naae 
GautaaPuri 

I >» 

As you can tell from this example, not having to· define variable types makes it a lot less 
painful to type code in Python than in a language such as C++. This also saves a lot of 
heartache when dealing with instances of classes so that you don' t have to define each 
variable as being an object of a class. If you don't know what classes, instances and 
objects are, you will find out in the section on "Classes" a few pages down the line. But 
first Jet's talk about lists and dictionaries. 

Arrays are a common collection data type in just about every high level programming 
language so [expect you've dealt with them before and know why they're useful. You 
aren't required to use them to write Abaqus scripts, but chances are you will want to store 
information in similar collections in your scripts. Let's explore a collection type in 
Python known as a List. 

·1.n a, list y.ou..stor.e. multiple .elements or ~a~'.:\ vatues ~nd can refer to them with the name of 
· ... ~ the list vru:ia,bfe-~followed by an index. in square 'brackets []. T_be lowest index is 0. Note 

that you ·can store all kinds of data:types, such as · integers~ float~, Strings, all in the same 
list. This is different from languages such as C, C++ and Java where all array members , 
must be of the same data type. Lists have many built-in functions, some of which are: 

• I en() - returns the number of elements in the list 
• append(x)- adds x to the end of the list making it the last element 
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• remove(y) - removes the first occurrence of y in the list 
• pop(i) - removes the element at index [i] in the list, also returns it as the return 

value 

Let's work through an example . 

.F,:xample 4.2 - Lists 

In the ' Kernel Command Line Interface' tab ofthe lower panel of the window, type in the 
following statements hitting ENTER after each. 

Your output will be as displayed the following figure. Note that the lowest index is 0, not 
1, which is why random_ stuftiO] refers to the first element 'car'. The I en() function 
returns the number of elements in the list. The append() function adds on whatever is 
passed to it as an argument to the end of the list. The remove() function removes the 
element that matches the argument you pass it. And the pop() function removes the 
element at the index position you pass it as an argument. 
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I' ' 

>>> randoM_stuff • ['car' . 24 . 'bird' . 7S . S. 44, 'golf ' ) » > print rando,._stuff ( 0) 
car 
>>> print randoa_stuff(l) 
24 

..._--..~-<> » print rando•_stuf f 
['car'. 24 . 'bird' . 78 . 5 , 44 , 'golf') 
>>> print len(randoa_stuff) 
6 
>>> rando•_stuff . insert(2. 'ooaputer') 
>> >print len(randoa_stuff) 
7 
>>> print randoa_stuf£ 
[ ' car' . 24 . 'ooaputer' , 'bird'. 78 .5 . 44 . 'golf'] 
>» randoa_stuf .f . append(29) 
>» print len(rando!ll_stuff) 

>> > print randoa_stuff 
['car ' . 24. 'coaputer' , 'bird '. 78 . 5. u . 'golf'. 29) 
» > print randoJLstuff . inclex( 'qolf'} 
6 
>>> randoM_stuff .-reaove(24) 
>>> print randoJLstuff 
['car' . 'coaputer' , 'bird' . 78 . 5. 44 . 'golf • . 29] 
>>> reaoveQ_var • randoa_stuff .pop(2) 
>>> print reaoved_var 
bird 
>>> print randoa_stuff 
['car' . 'coaputer' . 78 . 5. 44 . 'golf ' . 29) 
>» I 

. 
Dictionaries are a collection type, just as lists are, but with a slightly different feel and 
syntax. You do not really need to create your own dictionaries in order to write scripts in 
Abaqus, you can accomplish most tasks with a list, but y~u never know when you might 
prefer to use a dictionary. More importantly though, Abaqus stores a number of its own 
constructs in the form of dictionaries, and you will be accessing these regularly, hence 
knowing what dictionaries are will give you a better understanding of scripting. 

Dictionaries-are-sets of.key;~alue .pairs. To access a value, you use the key for that value. 
This i$ analogous to using an index position to access the data within a list. The 
difference is that keeping track of the key to access a value may be easier in a certain 
situation than remembering the index 1ocation of a value in a Jist. Since there are no index 
positions, dictionaries are lillorder~d. 

-:To remove a: key:vatue pair, you '.!Se the del:.~ommciD.<L~rremoye ·a1Hfie key:value pairs, 
you use the clear command. 
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Aside: If you've worked with the programming language PERL, dictionaries are very 
similar to the hash collections. If you're coming from a Java environment, 
dictionaries are similar to the Hashtable class. 

An example should make things clear. 

Example 4.3 - Dictionaries 

In the 'Kernel Command Line Interface', type in the following statements hitting ENTER 
after each. You will see an output after each print statement. 

Here names_and_ages is your dictionary variable. l_~)t you .store 3 .keys, ' John', ' Rahul' 
and 'Lisa'. You store their ages as the values. This-way if you wish to access Lisa's age, 
you would write names_and_ages[' Lisa']. . . . 

The del command removes the key:value pair 'John' :23, leaving only Rahul and Lisa. 
The clear command removes all the key value pairs leaving you with an empty dictionary 
{}. 

Note that since the dictionary is unordered, the first statement could instead have been 
written as 

>>> names_and_ages = {'Rahul': l5, 'Lisa•:ss, 'John':23} 

and it would have made no difference since your values (ages) are still bound to the 
correct keys (names). 

The following image displays what you should see. 
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J 
>» !!I >» 

t--__. » > 
I))J 23 
~ >» 

L-----,115 

naaes_~nd_ages • {'Jphn' : 23 . 'Rahul ' :15. 
print naaes_and~ages( ' John') 

print naaes_and_ages['Rahul'] 

>>> print naaes_and_ages 
{ ' Lisa' : 55 , 'John' : 23 , 'Rahul ' : 15} 
> » del naaes_and_ages{ • John' ) 
>>> print naaes_and_ages 
{'Lisa' : 55 , 'Rahul ': 15} 
>>> naaes_and_ages .clear() 
>>> print naaes_and_ages 
{} 
»> 

So bow does Abaqus use dictionaries? 

'Lisa' : 55} 

You're probably wondering when you would actually use dictionaries. You will be using 
them all the time, and already did so more than once in the cantilever beam example of 
Chapter 1 (Example 1.2), except you didn't know it at the time. Here' s a block of code 
from the example. 

1
···#--::-::-::-===~~~~-~---~ ---- -------- ~ --------- ---_·-_ -- ---- ·-····-·-·--··------·-·· ... ······-· 

# Create the model 

mdb . models.c~angeKey{fromName='Model-1', toName='Cantilever Beam') 
beamModel = mdb . models['Cantilever Beam'] 

~::..:-..::..:::..::..:: . .::: ----------------------------------------- -- -:_.:::.._ ______ _ 
Look closely at the statement 

beamModel = mdb .models('Cantilever Beam'] 

Here you s~e.the model.database· 'm~b'. h~:a:-propercy-calle~ ' models' . This property is a 
diCtionary object contajning:..a,key;:valoe pair for each model you create. The model name 
itself is the 'key', and the value is an i{lstance ofthe model object. 

You know that the syntax to access a value in a dictionary is dictionary_name['key'}. So 
when you want the script to refer to the cantilever beam model you say 
models['Cantilever Beam'}. 

To be a little more precise, .models in not exactly a dictionary object but a subclass of a 
dictionary object. What does that mean? Well, to put it simply, it means that the 
programmers at Abaqus created a new class that has the same properties and methods as 
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dictionary, but also has one or more new properties and methods that they defined. For 
example the changeKey()_· m.e~hod tha~ changes the name of the key from 'Model- I' to 
'Cantilever Beam' is not native to Python dictionaries, it has been created tiy 
·programmers at Abaqus. You don't have to worry about how they did it unless you are a 
computer science buff, in which case google 'subclassing in Python •. As far as a 
user/scripter is concerned, the ' models' object works similar to a dictionary object with a 
few enhancements. Also in Abaqus these enhanced dictionaries are referred to as 
'repositories'. You will hear me use this word a lot when we start dissecting scripts. 

Let's look at another block of code from Example 1.2. 

I
# -------------------- -------------- - ----------- ------ ---
# Create the history output request 

I 
# we try a slightly different method from that used in field output request 
#create a new history output request called 'Default History Outputs' and assign 
both the step and the variables 
beamMod~l.HistoryOutputRequest(name='Default History Outputs', createStepName='Apply 
Load.~ , ?variables=PRESELE_CT) 

#now delete the original history output request 'H-Output-1' 
del beamModel.historyOutputRequests('H-Output-1'] 

# ---- -------------- --------- --- ---- -------------- -- -----

Look closely at the statement . 

del beamModel . historyOutputRequests['H-Output-1~] 

Notice that your model beamModel has a dictionary or ' repository' (subclass of a 
dictionary) .c.a_lled. historyQutputRequests. One of the key:value pairs has a key ' H
Output-1 ', and is referred io as historyOutputRequests['H-Output-11. In the Abaqus 
Scripting Interface you will often find aspects of your model stored in repositories. For 
the record, in this statement the 'H-Output-1' key:value pair in the repository is being 
deleted using the del command. 

We've covered lists and dictionaries so far. Tuples are a third type of collection tool in 
Python. They are similar to lists, except once a tuple is created it cannot be edited. You 
cannot add on elements: commands such as append() do not work on it. And you cannot 
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delete elements either using the del command. To access the elements of a tuple you use 
the same index notation as you do for lists. Let's work an example. 

Example 4.4 - Tu pies 

Jn the 'Kernel Command Li.ne Interface' type in the following statements hitting ENTER 
after each. You will see an output after each print statement. 

A tuple called random_items is created which contains integers, floats and Strings. Note 
that you use arcs for parentheses, whereas if random_items was a list you would instead 
use square brackets as: 

random_items = [ ' Mercedes', 'airplane' , 5, 17 .6, 'hi'] 

The following image displays the outputs of the above statements: 

/ /; 

>>> rando-_ite•s• ('Keroedes' . 'airplane' . 5 . 17 . 6. ' hi ') 
,~---...::....~ 1 > > > print randoa_i teas( 0 l 

Kercedes 
>>> print rando•_ite•s£21 
5 
>» print randoJa_iteas 
('Mercedes' . ' airplane' . 5. 17 . 6 . 'hi') 
>» 

So how does Abaqus use tuples? 

Well just as in the case of dictionaries, you have actualJy already used tuples in the 
cantilever beam example of Chapter 1, you just didn't know it. Let's look at a block of 
code from that example. 

·-··;---~=-~-~-.:-=-=---~==-=-=-===-==-=-=-===---=-::~-=-=-:~-=---=-=-.:---------------·---·-----,1 
# Apply pressure load to top surface 

I 
# First we need to locate and select the top surface '! 

# We place a point somewhere on the top surface based on our knowledge of the 1 

geometry I 
1 top_face_pt_x = 8.2 I 

I 
top_face_pt_y = 8.1 

1 
1 top face_pt z = 2. 5 l 
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Here you create 3 variables top_face_pt_x, top_face_pt_y and top_face_pt_z, and then 
store them in a tuple called top_face_pt. At this point you do not need to understand why 
the above statements were used, we will examine these statements in subsequent 
chapters. I only wish to point out what tuples are and the fact that you will be using them 
regularly when writing scripts. 

classes. You often create an "instance" of a. class and then~aooe&S· the built-in .metheds 
which belong to the class or assign properties using'it. So it's important for you to have 
an understanding of how this all works. 

Python is an object oriented language. If you've programmed in C++ or Java you know 
what object oriented programming (OOP) is all about and can breeze through this section. 
On the other hand if you're used to procedural languages such as Cor MATLAB you've 
probably never worked with objects before and the concept will be a little hard to grasp at 
first. (Actually MA TLAB v2008 and above supports OOP but it's not a feature known by 
the majority of its users). 

For the uninitiated, a class is a sort of container. You define properties (variables) and 
methods (functions) for this class, and the class itself becomes a sort of data type, just 
Jike integer and String are data types. When you create a variable whose data type is the 
class you've defined, you end up creating what is called an object or an ins~ce of the 
class. The best way to understan~ this.iS:thr.ough.an-examp!e-... 

Example 4.5- 'Person~ class 

In the following example, assume we have ·a class called .~.Person.': Tiiis class has sorrw 
. properties, such as . 'weight', 'heigh(, 'hair' . color and so on. This class also has some 

·. methods such· as ·'exercise()' and · 'dyeHair()' which cause the person to lose weight or 
change hair color. 

Once we have this basic framework of properties and methods (called the class 
definition), we can assign./8?_actual-·person to this cJ~~· We can say Gary is a 'Person'. 
This mean&·GaJ¥;:has:properties such-as height, weight and hair color .. We can set Gary's 
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height by using a · statement such as Gary.height = 68 inches. We can also make Gary 
exercise by saying Gary.exerciseO which would cause Gary.weight to reduce.~ is~ 
object of type Persol.!)or Gn instance of the Person clasP 

Open up notepad and type out the following script 

tllass Person: 
height = 69 
weight =· 160 ... 
hair_color = "black~ 

def exercise(self): 
self.weigHt = self.weight - s 

def dyeHair(self .. new_hair_color): 
self.hair_color = new_hair_color 

, print ·~ake 'Gary' an instance of the class 'Person!~ 
Gary = Person() 

: pr.int "Print Gary's height .. 
1 pr:l!nt Gary.height . 

·pr:l!nt Gary.weight 
l print Gary.hair_color 

---·---··:---·-.. --.................. _ ... ,,.. ........... , 
4 • J 

. 

. :.· ·1 .. 

. ~ i 
i 

. j 

·-I 
J 
., 

I 
print "Change Gary' s height to 66 fnches by· setting the height _e;roperty to 66" · 
Gary.height = 66 · 

. I 
.I 

print "Make Gary exercise so he loses 5 lbs by calling the-. exercise() method" ., 
Gary.exercise() · · · 

print "Make Gary dye his .hair blue by calling the dyeaair· method and passing blu~ as ll 

an vumenr 
Gary.dyeHair('blue') 

j' 
. I 
I 

~ s: I 

Open a new file in Abaqus CAE (File > New Model Database > With 
Standard/Explicit Model). In the lower half of the window, make sure you are in the 
" Message Area" tab, not the "Kernel Command Line Interface" tab. The print statements 
in our script·will display here in the "message area" that' s why you want it to be visible. 
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Run the script you just typed out (File > Run Script .•. ). Your output will be as displayed 
in the following figure. 

The Jtodel "·Model-1" has been created . 
Define the cl~ss ca.lled 'Person' 
M~ke 'Gary' e.n in$t.&nce of the cl~ss 'Person' 
Print Gary's height . veight and he.ir eolor 
60 
160 
bl&.ek 
Che.nge Gary's height to 66 i nches by settin9 the height property to 66 
Make Gary exercise so lle loses S lbs by calling the exercise( ) ~aethod 
Make Gary dye h is hair blul{ by calling the dyeHair •ethod and passing blue as an argUllent 
Once again print Gary ' s hei ght . veight. and hair col or 
66 
155 
blue 

Let's analyze the script in detail. The first statement is 

---------------
1 print "Define the class called 'Person'" ~---------··-.. ·····-----... .. --- - ·--··-----·-----·-----·---------

_ _____ ] 
This basically prints "Define the class called 'Person"' in the message window using the 
'print' command. Hence that is the first message displayed. The following statements 
define the class: 

,-------~RMo~O~ ... OH __ , __ ,,.,. __ H_ 
I class Persorl': . I height = 60 
1 weight = 160 
·I hair _color = '!black" 

I def exercise(s~.!!) :· . . 
5 ILl self . we~ght = _.self . we1ght 

def dyeHair(self, new_hair_color): 
- ~eif. h~ir:=:~~_!?._r = new hair colo.:. ............ --................... . 

A class named 'Person' has been created. lt has been given the•properties (variables) 
'height\ 'width' and 'hair col or', which have been assigned initial values of 60 inches, 
160 lbs, and the color black. 

In addition two methods (functions) have been defmed, 'exercise()' and 'dyeHair()' . The 
'exercise()' method causes the weight of the person to decrease by 5 lbs. The ' dyeHairQ' 
function causes 'hair_ color' to change to whatever col or is passed to that function as the 
argument 'new-hair- color'. 

What's with the word ' self'? In Python, every method in a class receives ' self as the first 
argument, that's a rule. The word 'se'if' refers to the instance of th~ class which will be 
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created later. In our case this will be 'Gary'. When we create 'Gary' as an instance of the 
'Person' class, self.weight translates to Gary.weight and self.hair_co/or translates to 
Gary.hair _color. In object oriented languages like C++ and Java you do not pass self as 
an argument, this is a feature unique to tlre Pythons syntax and might even be a little 
annoying at first. 

r--:------::----:---:--------------------------- - ----., 
Print "Make 'Gary • an instance of the class 'Person'" 1 

! G~~-~-Person(.:....)----------- __________________ __j 

These statements define Gary as an instance of the Person class, and also print a comment 
to the message area indicating this fact. 

print "Print Gary's height, weight and hair color" 
print Gary.height 
print Gary.weight 
print Gary.hair color 

We then display Gary's height, weight and hair_color which are currently default values. 
Notice how we refer to each variable with the --in~tance name followed by a dot " ." 
symbol followed by the variable name. The form~t is l~sJanceName.PropertyName. 

These statements make the following lines appear on the screen: 

Print Gary ' s height, weight and hair co lor'~ 

60 
160 

black 

r print· "Change Gary • s height to 66 inches by setting the height property to 66" 
Gary.height = 6{? l 
We now change Gary's height to 66 inches by using an assignment statement on the 
'Gary.height' property. We print a comment regarding this to the message area. 

print "Make Gary exercise so he loses 5 lbs by calling the exercise() method" 
Gary.exercise() 

These lines call the exercise function and display a comment in the message area. Notice 
that you use the format JnstanceName.MethodNameO. Although we don't appear to pass 
any arguments to the function (there's nothing in the parenthesis), internally the Python · 
interpreter is passing the instance 'Gary' as an argument. This is why in the function 
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definition we had the word 'self' listed as an argument. Why does the interpreter pass 
'Gary' as an argument? Because you could potentially define a number of instances of 
the Person class in addition to Gary, such as 'Tom', 'Jill ', 'Mr. T', and they will all have 
the same 'exercise()' method. So then if you were to call Tom.exerciseO, it would be 
Tom's weight that would reduce while Gary' s would remain unaffected. 

If you look once again at the definition of the 'exercise()' method in the Person class, 
you'll notice that it decreases the weight of the instance by 5 lbs. So Gary's weight 
should now be 155 lbs, down 5 lbs from before. 

---------·--------------- -----, I print "Make Gary dye his hair blue by calling the dyeHair method and pass ing blue as i l an argument" I 
-~~.t:!!Ye!!~~_:.f_~-~-~~-: .. 2.-.. ···---·····-·······-····-···-·--------------·-·--··-···--·-····---·--·-··-·--·-··---------··--·-··-----------·-··-------·-----··--·-----·--·---·· 
These lines call the 'dyeHair()' function and display a comment in the message area. The 
difference you notice between the 'exercise()' and 'dyeHair()' functions is that you pass a 
hard argument to 'dieHair()' telling it exactly what color you wish to dye the individuals 
hair. Internally an argument of 'self' is also passed. 

Take another look at the definition of the 'dyeHair()' method in the ' Person' class. You' ll 
notice that the variable being passed as an argument is assigned to the 'hair_color' . So 
Gary's hair color should now have changed from black to blue. 

I print "Once again print Gary' s height, weight and hair color" 
print Gary.height 
print Gary.weight 
print Gary.hair_color 

We print out Gary's height, weight and hair color again to notice the changes. The 
'Gary.height' statement was used to reset his height to 66 inches, the 'exercise()' method 
was used to reduce his weight to 155 Jbs, and the 'dyeHair('blue')' method should have 
changed his hair color to blue. These print statements display the property values in the 
message area. The output is what you expect: 

Once again print Gary's height, weight and hair col or 
66 
155 

blue 
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Hopefully this example has made the concept of classes and instances clear to .you. 
There's a lot more to OOP than this, we've only touched the surface, but that's because 
you only need a basic understanding of OOP to write Abaqus scripts. In none of our 
examples will you actually define a new class of your own. 

So why learn about cla'sses, objects and instances? 

Now that you've understood classes you're probably wondering why I bothered telling 
you about them. Well you won't need to define your own classes, but understanding what 
they are will help you understand the Abaqus Scripting Interface. lfyou look back at the 
cantilever beam script (Example 1.2) of Chapter 1, you'll notice many spots where 
instances of a class are created and properties/methods-of the class are.accessed using the 

. dot operator '.' 

For instance, look at the following chunk of code of Example I .2 

import part l 
# -------------------------- -- ---------- ----- ----------
# Create the part 

;~ .... /_, ·# .a) Sketch the beam cross sec;;tion us:i.ng·\ rectahgl~ 'tool 
· beamProfileSk~t~h = beallt!ledel'. Constr~i,_r)edSk.etch( name= ' Beam CS Profile', sheetSize=S) 
,beamProfileSketch.recta~(pointl~(e.~.e. l), . point2=(0.3,-0.1)) 

~r4he-:statement 
' 

·beamPrdfileSketch = beamModeL~i"aihedSketch( ... some parameters_.) 

lt creates a new instance ~f th-~Jass,:~ ~'beam_ProfileSketch'. 
This is similar to our example where w~ created an instance called 'Gary' of the 'Person' 
class using the statement Gary = PersonO. 

Consider the next statement: 

beamProfileSketch.rectangle() 

It calls the 'rectangle()' method of.th~ 'ConstrainedSketch()' .class. This--is similar to our .. 
example · where we called the 'exercise()' method of our instance· 'Gary' using 
'Gary.exercise()'. 
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So you see a basic understanding of classes and OOP helps you understand the script 
better. All of Abaqus' s scripting libraries have been programmed in the form of classes 
with properties and methods.!So when you want to create something like a sketch, you 
need to create an instance of the 'ConstrainedSketch()' object. And when you wish to use 
the built in functions such as 'rectangle()'. you need to reference them from an instance 
of a class that defines the method. All this makes a lot more sense now that you 
understand OOP. 

Aside: If you were looking closely at the code statements we just discussed, you might 
have noticed that there was a slight difference in syntax between the cantilever 
beam example and the 'person class' example. It is a little more complicated; 
notice we do not say beamProfi/eSketch = ConstrainedSketchO, instead we say 
beamProfileSketch = beamModel.ConstrainedSketchO. So what is going on 
here? Well, 'beamModel' is an·instance ofthe ·~models~ . class. And the ' models' 
class has a member caned ' sketches' which is a repository of 
'ConstrainedSketch()' objects. And it's one of those 'ConstrainedSketch()' 
classes that you· are making an instance of. Hence you refer to it with 
beamModel.ConstrainedSketchO. I guess one way of thinking of this is that you 
have classes nested within classes. 

If this sounds too confusing don't wony about it. As I said l 've only provided 
you with a basic overview of the OOP concept. enough to gain a basic 
understanding and get the job done. If you want to better understand how Abaqus 
classes have been programmed by SIMULIA then you might wish to learn more 
about the ins and outs of OOP with a book on programming or some internet 
resources. But if all you' re trying to do is write scripts for your Abaqus 
simulations you don't need to spend time asking questions like why you create a 
constrained sketch using mode/s.ConstrainedSketchO as opposed to just 
ConstrainedSketchO. The fact is you do, that's how Abaqus's libraries have been 
coded, and it's ok to just accept it. Just as you accept that the print command 
always prints to the message area even though you don't know how Abaqus does 
it. 

If for the sake of personal satisfaction you wish to dig deeper into OOP, one way 
to learn it is the way most of us did - by learning the standard fare object 
oriented language like C++ or Java. Then again with the popularity and support 



58 Python 101 

Python enjoys today, you could instead read a book or an online tutorial on full
fledged Python programming that covers OOP in detail. 

Abstraction in OOP 

One final concept I wish to point out about OOP is the concept of abstraction. In our 
example with the 'Person' class, you noticed that when we wanted 'Gary' to lose 5 lbs 
we used the statement Gary.exerciseO. And then the 'exercise()' method was defined in 
such a way that it decreased Gary.weight by 5. Why did we bother calling 
Gary. exerciseO when we could instead have written Gary. weight = Gary. weight - 5 ? 

Well it's because it was the better, or safer, way to do it. We defined an exercise method 
to do the job, hence it made sense to use it. In the programming world often a class is 
written by one programmer and stored in a library and the instance of the class is created 
and used by another programmer. If there was no method defined in the class to perform 
a task such as losing weight, the second programmer would have to read through the code 
of the class and figure out which variable to change. If on the other hand the programmer 
who made the original class defined a method that does what the second programmer 
needs, then programmer number 2 does not have to go through all the code of the class, 
all he needs to know is what functions/methods are available to him. In fact it is possible 
for the coder of the original class to make some of the variables private, meaning that 
they can only be changed by calling a method. This is known as "abstraction'\ or 
basically hiding the internal workings of the class. 

We're not going to go into further details of how this works, mostly because knowing 
that probably wouldn't help you write better scripts. The programmers at SIMULIA who 
wrote the classes and libraries for the Abaqus Scripting Interface decided what variables 
are public and which ones are only accessible through a built in function. As a user of the 
software you only need to know when you can access a variable or when to use the 
function. The way to find out is by looking up the members and methods of the class you 
are working with in the Abaqus documentation. Whatever you can access will be listed 
there. All this will become clearer with examples, and quite frankly you won't even be 
thinking about abstraction and how it works, you'll just write code the way you know it 
works in Abaqus. 
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In this chapter you learned : 

• how to define variables and write code statements, 

• how to create collection types- lists, dictionaries, and tuples, 

• object oriented programming (OOP) concepts - classes, instances, data 
abstraction 

You also referred to code snippets from the cantilever beam example from Chapter 1 to 
see the syntax in action. 

You now understand some of the Python syntax behind much of Example 1.2. However 
you still don't understand the Abaqus specific commands and methods that were used. In 
the next chapter we're going to take a closer look at the cantilever beam example and try 

to make sense of it all. 



4 -
The Basics of Scripting - Cantilever 

Beam Example 

~.1 Introduction 
----------~--------------~ Now that you have the required understanding of Python syntax, we can plunge into 

scripting. Every script you write will perform a different task and no two scripts will be 
alike. However they all follow the same basic methodology. The best way to understand 
this is to go through the cantilever beam script in detail. 

A basic script 
--=---------~-------------------------Since we already have the cantilever beam example from Chapter 2 we shall work our 

way through it, statement by statement. Not only will you understand exactly what is 
going on in the script, you will also learn some of the most important methods that you 
will likely use in every script you write. 

Example 4.1- Cantilever Beam 

For your convenience a copy of the code from Chapter 2 has been listed here. 

from a~aqus import * 
from a~aqusConstants import * 
impqrt "r,egionToolset 
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~ ~-------~---- --- - --~--~--------------------
# Create tfie step 

import step 
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imeort job 

# Do not return cont~l till job is finished running 
mdb.jobs['CantileverBeamJob'].waitForCompletion() . 

# Post ~rocessing ... 
import visualization 

The script executes from top to bottom in Python. I have included comments all over the 
script to explain what's going on. Lines that start with the hash (#) symbol are treated as 
comments by the interpreter. Make it a point to comment your code so you know what it 
means when you look at it after a few months or another member of your team has to 
continue what you started. 

Observe the layout of the script. I have divided it into blocks or chunks of code clearly 
demarcated by: 

#--- -------------------------------------------- -----------
# comment describing the block of code 

Try reading these comments. You will realize that the script follows these steps: 
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1. Initialization (import required modules) 
2. Create the model 
3. Create the part 
4. Define the materials 
5. Create solid sections and make section assignments 
6. Create an assembly 
7. Create steps 
8. Create and define field output requests 
9. Create and define history output requests 
10. Apply loads 
11. Apply boundary conditions 
12. Meshing 
13. Create and run the job 
14. Post processing 

Let's explore each code chunk one at a time. 

The code block dealing with this step is listed below: 

~~1~~: -·:~:~~~c!~~~~~:~--~~~·:·:~--~-----------------·------------ J 
. import regionToolset 

I session.viewports['Viewport: l'].setValues(displayedObject=None) 
-~~-~----~-----·------

We begin the script using a couple of 'from-import' statement. 

The first import statement: 

from abaqus import * 

imports the abaqus module and creates references to aB puhlic~oots . ..defined by that 
module. Thus it makes the basic Abaqus objects accessible to the script. One of the things 
it provides access to is a default model database which is referred to by the variable mdb. 

You use this variable mdb in the next block of code which is the 'cre~te th~ m~del' 
block. You need to insert this import statement in every Abaqus script you write. 

The second import statement: 
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from abaqusConstants import * 

is for making t~e symbolic constants defined by the Abaqus Scripting Interface available 
to the script. What are symbolic constants? They are variables with a constant value 
(hence the term constant) that have been given a nanie that makes more sense to a user 
(hence the term symbolic) but have some meaning to Abaqus. Internally they Il)ight be 
integer or float variables. But for the sake of clarity of code they are displayed as a word . 
in the English language. Since they are constants they cannot be modified 

We use symbolic constants in the sc'ript. Look at the relevant lines in the script where the 
part is created. Notice the statement: 

beamPart=beamModel.Part(name='Beam', dimensionality=THREE_O, · 
type=OEFORMABLE_BODV) . 

Both THREE_D and DEFORMABLE_BODY are symbolic constants defmed in the 
abaqusConstants module. So if we did not import this module into our script we would 
get an error as the interpreter would not recognize these symbolic constants. So place this 
import statement in every script you write. 

The third import statement: 

import regionToolset 

imports th,e _regionToolset module so you can access its methods through the script. If 
you look at the 'create the loads' block, y.ou will notice the statement: . . ' 

top_face_region~~gi~nTool~er.~~gion~~ide1Faces=top_Plate) 

We are using the RegionO method defined in the regionToolset module. Hence the 
module needs to be imported otherwise you will receive an error. I tend to place this 
import statement in every script I write, whether or not the RegionO method is used, just 
to be on the safe side. 

Basically every script should have these 3 import statements placed in it at the top. You 
may not always need them, but by including them you spend less time thinking about 
whether or not you need them and more time writing useful code. 

The fourth statement: 

session.viewports[rviewport:~'].setValues(displayedObject=None) 
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blanks out the viewport. The'viewport is the window in the Abaqus/CAE that displays the 
part you are working on. lt allows Abaqus to display information to you visually . . The 
viewport object is the object where the information about 'the viewport is stored ·such as 
what to display and how to do so. 

The default name for the viewport is 'Viewport: 1 '.This is not only the name displayed to 
the user, it is the key for that viewport in.the viewports dictionary/repository. Hence we 
refer to the viewport with the viewports['Viewport:l'] notation. The method · 
setValuesO is a method of the viewport object that can be used to modify the viewport. 

· It accepts two parameters, the displayedObject which defines what is displayed, and the 
displayMode which defines the layers (more about that later). When we set the 
.displayedObject to None, that causes an empty viewport to be displayed. 

The following block creates the model 

I # -- ----- ------ - -- -- --------------------------------- - --- - ---- ------ --- ---
~ # create the model 
1
1 ·mdb~models.changeKey(fromName= 'Model-1', toName='Cantilever Beam') 

beamModel = mdb.models['Cantilever Beam'] 

As stated before,, the variable mdb pr<?vides access to a default model database. This 
variable is made available to the script thanks to the 

from abaqus import * 

import statement we used earlier, hence you don't define it yourself. 

The default model 1n Abaqus is always naf!led 'Model- I ', which is why when you open a 
new file you always see 'Model-1' in the model database tree on the left in the GUI. 

The first statement: 

mdb.models.changeKey(fromName='Model-1', toName='Cantilever Beam') 

changes the name of the model from the default of 'Model-}' to 'Cantilever Beam'. 
c_hangeKeyO is a method of models which is in the model database, hence we refer to it 
usihg mdb.models.changeKeyO. 
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If you recall from Chapter 3, the models repository is a subclass of a dictionary object 
which keeps track of model objects. As explained before, a subclass means that it has the 
same properties and methods of the dictionary object along with a few more properties 
and methods, such as cbaogeKeyQ, that developers at SIMULIA decided to add in. The 
model name 'Model- I' is the key, while the value is a model object. The changeKeyO 
method which is not native to Python essentially allows us to change the key to 
'Cantilever Beam' while referring to the same model object. 

The second statement: 

beamModel = mdb.models['Cantilever Beam') 

assigns our model, to the beamMOdel-variable. This is so that in future we do not have to 
keep referring to it as mdb.models('Cantilever Beam') but can instead just call it 
beamModel. Look at the 'create the part' block and notice the statement 

beamProfileSketch = beamModel .ConstrainedSketch(name='Beam CS Profile', 
sheetSize=S) 

Don' t worry about what it means just yet, I only want to point out that if we did not 
define the variable beamModel, then the same statement would have to be written as: 

beamProfileSketch = mdb.models(ccantilever Beam']. 
ConstrainedSketch (name='Beam CS Profile, sheetSize=S) 

which is a little bit longer. This type of syntax wi11 get longer as we refer to properties 
and objects nested further down. 

Of course you could choose to write things the long way, or you could do it my way. 

Create the part · 
The following block of code creates the part 

# -- - - ---- ----- ----------- -- - --- -- - --------- ------ - -- -- ----- - --- --- --- ----
# Create the part 

import sketch 
import part 

# a) Sketch the beam cross section using rectangle tool 
beamProfileSketch = beamModel.ConstrainedSketch(name='Beam CS Profile', 

sheetSize=S) 
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!t;~~r;~~t=ii;sk·;1:c:-h-:·~~·c:t~·~iii~(p~i;ii~-<-a·:··i~a-:1)-~-·--;;~i'~1i-:(e-:-3·: -=-e·:·1>-) ------------·------------·i 
I I I # b) Create a 3D deformable part named "Beam" by extruding the sketch ! 1· 

i beamPart=beamModel.Part(name='Beam', dimensionality=THREE_D, 
I type=DEFORMABLE_BODY) j' 
i beamPart.BaseSolidExtrude(sketch=beamProfileSketch, depth=S) 
~-------~-···-M-0MoRMO--MOO .. OOOM00M_ M _ 0""''""" ........... -h0o0H M-M-0doo0MH .. M000M00MM0 .... -------··-·-----· - · ··-----·----" .. _____ _ 

The first two statements 

import sketch 
import part 

import the sketch and part modules ·into the script, thus providing access to the objects 
related · to sketches and parts. As such you shouldn't be able to create a sketch or a part 
without these import statements but honestly if you leave them out in most cases Abaqus 
figures out what you are trying to do and appears to import these modules automatically 
without complaining. It is however recommended that you stay in the habit of including 
them because it's good programming practice and because you never know if an older or 
newer version of Abaqus will throw an error. 

The statement 

beamProfileSketch = beamModel.ConstrainedSketch(name='Beam CS Profile'~ 
sheetSize=S) 

creates a constrained sketch object by calling the ConstrainedSketch() method of t,he 
Model object. The sketch module defines ConstrainedSketch objects. The first argument 
is the name you wish to give the sketch, we're calling it 'Beam CS Profile' . This is used 
as the repository key given to our ConstrainedSketch object, just as 'Cantilever Beam' 
is the key for our model object. The second argument is the default sbeetsize, which is a 
property you defined when manually performing the cantilever beam simulation in 
Abaqus/CAE. It sets the approximate size of the sheet, and therefore the grid you see 
when you are in the sketcher. Of course when you're working in a script the sheetsize 
isn't really important, that only helps you see things better when working in the GUI, but 
it's a required paramenter to the ConstrainedSketchQ method hence you must give it a 
value. Note that the statement can be written without the words 'name' and ' sheetSize' 
as: 

beamProfileSketch = beamModel.ConstrainedSketch('Beam CS Profile', 5) 
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lt means the same thing to the interpreter; it just isn ' t as clear to someone reading your 
script. Also you' ll have to make sure the arguments are passed in the correct order as is 
required by the method as stated in the documentation. 

The statement 

beamProfileSketch.rectangle(point1=(8.1,8.1), point2=(8.3J-8.1)) 

uses the rcctangleO method of the ConstrainedSketcb object to draw a rectangle on the 
sketch plane. The two parameters are the coordinates of the top left and bottom right 
corners of the rectangle. Note that the statement can also be written without the words 
pointl and poiot2 as: 

beamProfileSketch . rectangle((8.1,8. 1), (8.3J-8.1)) 

The statement 

beamPart=beamHodel.Part(name='Beam', dimensionality=THREE_D, 
type=DEFORMABLE_BODY) 

uses the PartO method to create a Part object and place it in the parts repository. The 
first parameter 'Beam' is its name and its key in the repository. The second parameter, 
dimensionality, is set to a symbolic constant THREE_D which defines it to be a 3D 
part. It is defined to be of the type deformable body using the DEFORMABLE BODY 
symbolic constant. In subsequent chapters you will define different parameters in place of . 
these depending on the simulation. The created part instance is stored in the beamPart 
variable. If you haven' t already guessed, the statement can also be written without the 
words name, dimensionality, and type as 

beamPart=beamModel.Part('Beam', THREE_D, DEFORMABLE_BODY) 

The statement 

beamPart.BaseSolidExtrude{sketch:beamProfileSketch, depth=S) 

creates a Feature object by calling the BaseSolidExtrudeQ method. What is a Feature 
object? Well, Abaqus is a feature based modeling system. The Feature object contains 
the parameters specified by the user, as well as the modifications made to the model by 
Abaqus based on those parameters. The Feature object is defined in the Part module 
hence you do not use an 'import feature' statement. The BaseSolidExtrudeQ method is 
used to create extrusions. The first parameter passed to it is our ConstrainedSketcb 
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object beamProfileSketch. Note that this must be a closed profile. The second parameter 
is the depth to which we wish to extrude our profile sketch. The statement can be written 
without the keywords sketch and depth as: 

beamPart.BaseSolidExtrude(beamProfileSketch, 5) 

i # --------- - ----- -- -- --- ---- ------ --------------------------- -- -- -- -------! # Create material 
I 
! import material 

I # Create material AISI tees Steel by assigning mass density, youngs I # modulus and poissons ratio 

I 
beamMaterial = beamModel.Material(name='AISI tees Steel') 
beamMaterial.Density(table=((7872, ), )) 

l_E_ea'!!:l~te~-~~-l_: .. ~.~~~!..~.~J!.~.~!.~~-~.(~-~~-~~.!. .... ~-:.~~.l! ..... ?L ....... ---·····-···-·-------------------
import material 

This statement imports the material module into the script providing access to objects 
and methods related to materials. 

beamMaterial = beamModel.Material(name='AISI 1995 Steel') 

This statement creates a Material object using the MateriaiO method and places it in the 
materials repository. The parameter passed to the MateriaiO method is the name given 
to the material, and the key used to refer to it in the materials repository. The Material 
object is assigned to the variable beamMaterial. 

beamMaterial.Density{table={(7872, ), )) 

This statement creates a Density object which specifies the density of the material by 
using the DensityO method. The Density object is defined in the material module, hence 
you do not use an 'import density' statement The argument passed to the Density 
method is supposed to be a table. Why a table? Well you might have a density that 
depends on temperature. In which case you would have a table in the form ((density/, 
temperature]), (density2,temperature2), (density3,temperature3)) and so on ... 
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In our case we have one density which is not temperature dependent, but we must use the 
same format. So we can't say table=7872, we need to write table=((7872, ) , ) where we 
leave a space after the first comma for temperature 1 (or rather the lack of it), and a space 
after the second comma for (denstiy2, temperature2).This probably looks a little strange, 
and you will often generate a lot of syntax errors typing the wrong number of commas or 
parenthesis, so be aware of that. For the record, we can leave out the word ' table', but all 
the parentheses and commas in the statement will remain as they are: 

beamMaterial.Density(((7872J )J )) 

The statement: 

beaNMaterial.Elastic(table=((280E9, 0.29), )) 

creates an Elastic object which specifies the elasticity of the material by using the 
ElasticO method. The Elastic object is defined in the material module, hence you do not 
use an import elastic statement. The argument passed to the ElasticO method must be a 
table just like the argument to the DensityQ method. The table must be of the form 
((YMJ, PRJ), (YM2, PR2), (YMJ, PRJ)) and so on where YMis Young's modulus and PR 
is Poisson's ratio. For our material we have only one Young's modulus and one Poisson's 
ratio so we write table=((200E9, 0.29), ) leaving a second comma there to indicate the 
spot for (YM2, PR2). The statement can be written without the keyword 'table' as: 

beamMaterial.Elastic(((20eE9, e.29), )) 

4.3.5 Create solid ~tions and make section assignmen~ 
The following code block creates the sections and makes assignments 

# --------- -- - ---- - -- ------------- - --- - -- - -- -- ---- - --------- ------ -- ---- --
# Create solid section and assign the beam to it 

import section 

# create a section to assign to the beam 
beamSection = beamModel .HomogeneousSolidSection(name='Beam Section', 

material='AISI 1ees Steel') 

# Assign the beam to this section 
beam_region = (beamPart.cells,) 
beamPart.SectionAssignment(region=beam region, sectionName='Beam Section ' ) 

import section 
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This statement imports the section module making its properties and methods accessible 
to the script. 

beamSection = beamModel.H~ogeneousSolidSection(name='Beam Section', 
material='AISI 1995 Steel') 

This statement creates a HomogeneousSolidSection object using the 
HomogeneousSolidSectionO method. These are defi.ned in the section module. The first 
parameter given to the method is name, which is used as the repository key. The second 
parameter is material, which has been defined in the 'define the materials' code block. 
Note that this material parameter must be a String, it cannot be a Material object. That 
means we cannot say material=beamMaterial even though we had defined the 
beamMaterial variable to point to our beam material, because beamMaterial is a 
Material object. 'AISI I 005 Steel ' on the other hand is a String, and it is the key assigned 
to that material in the materials repository. -
The statement 

beam_region = (beamPart.cells,) 

is used to find the cells of the beam. The cell object defines the volumetric regions of a 
geometry. Part objects have cells. beamPart.cells refers to the Cell object that contains 
the information about the cells of the beam. 

Notice however that there is a comma after beamPart.cells. This is because we are trying 
to create a variable which is a Region object. A Region object is a type of object on 
which .you can apply an attribute.lYou can use a Region object to define the geometry for 
a section assignment, or a load, or a boundary condition, or a mesh, basically it forms a 
link between the geometry and the applied attribute. A Region object can be a sequence 
of Cell objects. In fact it can be a sequence of quite a few other objects, including Node 
objects, Vertex objects, Edge objects and Face objects. In our script we are assigning a 
Cell object to it. But si.nce it needs to be a sequence of Cell objects, not just one Cell 
object that we are providing, we stick the comma at the end to make it a sequence. fWe 
then assign it to the variable beam_region. 

Why exactly are we creating a Region object? Because we need it for the next statement 
where we use the Sectiom\ssignment() method..1 

beamPart. SectionAssignme"nt( region=beam_region, sectionName=' Beam Section') 
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This statement creates a SectionAssignment object, which is an object that is used to 
assign sections to a part, an assembly or an instance. This is done using the 
SectionAssignmentQ method. Its first parameter is a region, in this case the region is the 

•J • 

entire part. We have already created a region in the previous statement called 
beam_region using all the ce11s of the part, and we now this region as our first parameter. 
The second argument is the name we wish to give the section, which is also the key it 
will be assigned in the sections repository. This argument must be a String, therefore we 
cannot use the variable beamSection which is a Section object, but rather its name/key. 
The statement can be written without the keywords region and sectionName as: 

beamPart .SectionAssignment(beam_region, ' Beam Section' ) 

4.3.6 Create an assembly 
The following block creates the assembly. 

# --------------------------- --- -------------------------
# Create the assembly 

import assembly 

# Create the part instance 
beamAssembly = beamModel . rootAssembly 
beaminstance = beamAssembly.Instance(name= ' Beam Instance', part=beamPart, 

dependent=ON) 

import assembly 

This statement imports the assembly module giving the script access to its methods and 
properties. 

beamAssembly = beamModel.rootAssembly 

This statement assigns _th~ rootAssembly .to- the variable beam.Assembly. The 
rootAssembly is an Assembly object. 1t is a member of the Model object. However you 
do not need to create it using any method, it is created by default when the Model object 
is created. Hence we simply refer to it without creating it. 

The statement 

beamlnstance = beamAssembly.Instance(name='Beam Instance', part=beamPart, 
dependent =ON) 
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creates an Partlnstance object which is the instance of a part in the assembly. To do this 
it uses the InstanceO method which creates a Partlnstance·object and places it in the 
instances repository.jlt has 2 mandatory parameters, followed by optional ones. The first 

mandatory parameter required by the InstanceO method is a name· for the instance which 
will be used as its key in the instances repository. The second mandatory para m enter is a 
Part object. Note that this is not a String that is the name/key for the part, therefore we 
cannot use the name 'Beam' which we gave to our part instance. Instead we use the 
variable that identifies it, beam Part. 'The third parameter used here is an optional one 
which decides whether the part instance is dependent or independent. By default it is set 
to OFF. The statement can be written without the keywords name, part and dependent 
as 

beamrnstance = beamAssembly.Instance(name='Beam Instance', part=beamPart, 
dependent=ON) 

The following block creates the steps. 

# ---------------- - --------- ----------- ------ - -- -- --------------- -- - - -- - - -
# Create the step 

import step 

# Create a static general step 
beamModel.StaticStep(name='Apply Load', previous= ' Initial', 

description='Load is applied during this step') 

import step 

The statement imports the step module so the script can access its methods and 
properties. 

-beamModel.StaticStep(name='Apply Load', previous='Initial', 
description='Load is ·applied during this step') 

The statement creates an analysis step by creating a StaticStep object using the 
StaticStepQ method. The StaticStep object is derived fro~ the AnalysisStep object ' 
which in turn is derived from ~he StepO obj_ect. The StaticStep object is used specifically 
for a static load step. Other types of Step objects are used for other kinds of loading steps 
which you will encounter in subsequent examples. 
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The StaticStepO method has 2 mandatory arguments, and a few optional ones in 
addition. The first mandatory parameter is the name you wish to give the analysis step, 
which is also the key in the repository. The second mandatory parameter is the previous 
step. This must be a String, not a step object. We want our loading step to occur after the 
default 'Initial' step, hence we use its key 'Initial' as the parameter. Among the optional 
arguments is description which is exactly what its name suggests. This doesn't have any 
bearing on the simulation of course, it is for the benefit of the next person who goes 
through your simulation. The statement can be written without the name, previous and 
description keywords as: 

beamModel.StaticStep('Apply Load', 'Initial', 'Load is applied during this step ' ) 

I • -------------------------------------------------------------------- ----
# Create the field output request 

#Change the name of field output request 'F-Output-1' to 'Selected Field Outputs' 
beamModel.fieldOutputRequests.changeKey(fromName='F-Output-1', 

toName='Selected Field Outputs') 

# Since F-Output-1 is applied at the 'Apply Load' step by default, 'Selected Field 
#Outputs' will be too 
# We only need to set the required variables 
beamModel.fieldOutputRequests['Selected Field Outputs'].setValues(variables=('S', 

'E', 'PEMAG', 'U', 'RF' , 'CF')) 

beamModel.fieldOutputRequests.changeKey(fromName='F-Output-1', 
toName='Selected Field Outputs') 

The statement changes the name of the preexisting FieldOutputRequest object. The 
model has a FieldOutputRequest object created by default whose name is 'F-Output-] ' . 
This is also its key in the fieldOutputRequests repository.fWe use the changeKeyQ 
method to change its name from 'F-Output-1' to 'Selected Field Outputs' by providing 
these two Strings as arguments. The FieldOutputRequest object is defined in the step 
module hence you do not use an import fieldOutputRequest statement. 

beamModel.fieldOutputRequests['Selected Field outputs'].setValues(variables=('S', 
'E', 'PEMAG', 'U', 'RF', 'CF')) 
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This statement tells Abaqus what properties you wish to include in your field output 
request. Notice how we use the key to access our FieldOutputRequest object using the 
fieldOutputRequests['Selected Field Outputs 1 notation. We use the setValuesO method 
to instruct Abaqus which variables are desired by passing these as a sequence of Strings. 
If we wish to leave these at the defaults, we can use the symbolic constant PRESELECT 
in the form variables=PRESELECT and rewrite the statement as 

beamModel.fieldOutputRequests['Selected Field Outputs']. 
setValues{variables=PRESELECT) 

I # ---- - --- - ---- ------------ - - ~-------------- - -- -- ------------- - ---- ---- -- -
# Create the history output request 

I # We try a slightly different method from that used in field output request 
#Create a new history output request called 'Default History Outputs' and assign 
# both the step and the variables 
beamModel .HistoryOutputRequest(name= ' Default History Outputs', 

createStepName=' Apply Load ' , variables=PRESELECT) 

#Now delete the original history output request 'H-Output-1' 
del beamModel . historyOutputRequests['H-Output-1'] 

The history output request block could have been written in a manner similar to the field 
output request i.e., rename H-Output-1 using the changeKeyO method. This is how you 
might have expected it to look: 

#-------- ---------- ------------------ -------------------------
#Create the history output request 

#change the name of history output request 'H-Output-1' to ' Selected History 
#Outputs ' 
beamModel.historyOutputRequests.changeKey(fromName='H-Output-1', 

toName='Selected History Outputs') 
# since H-Output-1 is applied at the ~Apply Load' step by default, 'Selected 
# History Outputs' will be too 
# we leave the variables at defaults 
beamModel .historyOutputRequests['Selected History Outputs']. 

setValues(variables=PRESELECT) 

This is absolutely correct. However we've used a different method just to demonstrate 
another way to do this. Instead of renaming the history output, we create a new one and 
delete the default one. 
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beamModel.HistoryOutputRequest(name='Default History Outputs', 
createStepName='Apply Load', variables•PRESELECT) 

This statement . creates a new HistoryOutputRequest object using the 
HistoryOutputRequest method. The first argument is the name of the object, which is 
its key in the historyOutputRequests repository. The second argument, 
createStepName, is the name of the step in which it is created, which is the String 
' Apply Load'. The third argument specifies the variables you desire, which in this case 
has been set to defaults using the PRESELECT symbolic constant. 

del beamModel.historyOutputRequests['H-Output-1'] 

This statement then deletes the preexisting HistoryOutputRequest object named ' H
Output-1 ' which is created by default. 

Which of the two methods is better? It's a personal choice, feel free to use the one you 
prefer. 

4.3~10 Apply loads ------
The following block applies the loads: 

I # - - ---- -- - -- - - - ----------- ------- --- ---- ------ -------------------- - --- ---
# Apply pressure load to top surface 

I 

# First we need to locate and select the top surface 
# We place a point somewhere on the top surface based on our knowledge of the 
# geometry 
top_face_pt_x = 0.2 
top_face_pt_y = 0.1 
top_face_pt_z = 2. 5 
top_face_pt = (top_face_pt_x.top_face_pt_y,top_face_pt_z) 

# The face on which that point lies is the face we are looking for 
top_face = beamlnstance.faces.findAt((top_face_pt,)) 

# We extract the region of the face choosing which direction its normal points in 
top_face_region=regionToolset.Region(sidelFaces=top_face) 

#Apply the pressure load on this region in the 'Apply Load' step 
beamModel.Pressure(name='Uniform Applied Pressure', createStepName='Apply Load', 

top_face_pt_x = 8.2 

region=top_face_region, distributionType=UNIFORM, 
magnitude=le. amplitude=UNSET) 

___ _J 
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top_face_pt_y = 9.1 
top_face_pt_z ~ 2.5 

These state~ents assign the X, Y ~d Z coordinates .of a. wjnt on.the-:top·surface of the 
beam to variables. In fact they··are·the exact center of the top surface of the beam. Why do 
we need these coordinates? Well in order to select a. surface. in .a .script, you tell Abaqus 
the coordinates of a point that is on that surface, and using that information Abaqus 
figures out which surface you are talking about. 

·How would you know where the center of the top surface of the beam is? By trying to 
visualize the geometry you've created. In the part creation step we explicitly set the 
coordinates of the rectangle while sketching out the profile. This profile was then 
extruded. So you basically know exactly where the beam is in space. The top left corner 
of the rectangle in the sketch was at X = 0.1 , Y = 0.1. Since the sketch was made on the 
XY plane, Z = 0. The bottom right corner of the rectangle in the sketch was X= 0.3, Y = 
-0.1 , and again Z = 0. The sketch was then extruded S m, therefore the extrusion was 
from Z = 0 to Z = S. Try to visualize the beam in your head or scribble it on a piece of 
paper. Your rough sketch might look something like the following figure. 

(0.1, 0.1, 5) 

(0.3, -0.1, 5) 

(0.1, 0.1, 0) 

y 

(0.3, -0.1, 0) ~X 
Once you visualize it in this manner, it is pretty easy to figure out the coordinates of the 
center of the top surface are (0.2, 0.1, 2.5). 

top_face_pt = (top_face_pt_x,top_face_pt_y,top_face_pt_z) 
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This statement assigns the X, Y iMd Z coordinates of the point to a variable called 
top_face_pt. ' From the syntax you should realize that this is a tuple which you learnt 
about in Chapter 3. To refresh your memory, they're like lists, except that you cannot 
change the elements once you create them. Also you define them using semi-circular 
parentheses as opposed to square brackets . 

. . -· 
top_face = beaminstance.faces.findAt((top_face_pt~)) 

This statement uses the findAtO method to find any face that is: at that point or at a . 
distance of less than I E-:6 from it. For, the record, the point should riot be shared by more 
than one face because then the method will return whichever face it first encounters and 
there is no way of knowing which one it will be. As an argument we pass the coordinates 
of the point, and the method returns a Face object. Notice that we have muJtiple 
parenthesis and we put a comma after top_face_pt. You might have expected to write 
findAt(top_face_pt). However findAtO can accept a sequence of points and normals as 
arguments and return a sequence of face objects, in which case you are required to use 
the syntaxfindAt(((xl,yl,zl), ),{(x2,y2,z2}, ), ((x3,y3,z3),)). In our case we wish to supply 
just one point, but we need to follow syntax requirements. Hence we can write 
findAt(((top_face_pt_x, top_face_pt__y, top_face_pt_z},}). Since we have already 
defined top_face_pt = (top_face_pt_x, top_face_pt_y, top_face_pt_z) we instead write 
findAt((top_face_pt,}}. Notice this has only 2 parentheses as opposed to 3. -top_face_region=regionToolset.Region(sidelFaces=top_face) 

This statement creates a region using the Face object we have just created. [t uses the 
RegionO method to create a Region object. To complicate things the RegionO method 
works a little differently depending on the kind of arguments you give it. It can accept a 
number of arguments, such as faces, edges, vertices and so on. If you do not use the name 
argument it will use these to create a set-like region (this is done in the next section when 
applying constraints). On the other hand if you use the name argument it will create a 
surface-like region. We want a surface-like region so that we can apply the pressure load 
on it. The name argument also specifies the direction we want the nonnal to the region to 
point. When the face we pass as a parameter is set equal to sidelFaces which is the name 
argument, the normal of the region is the same as the normal of the face. Jf instead we 
had written side2Faces=top_face, the normal to our region would have pointed into the 
beam rather than out of it. The Region object is defined in the regionToolset module, 

• . 
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which is why we used the import regionToolset statement in the initialization section of 
our script. 

beamModel.Pressure(name='Uniform Applied Pressure·~ createStepName='Apply Load', 
region=top_face_region, distributionType=UNIFORM, 
magnitude=18, amplitude=UNSET) 

This statement applies the pressure load to the top surface. It uses the PressureO method 
to create a Pressure object. The PressureQ method requires you to specify the name or 
repository key, for which we pass the String 'Uniform Applied Pressure' . It requires the 
name or key of the step, createStepName. We pass the String 'Apply Load' which is the 
name we gave our step in the 'create step' code block. We must tell the method which 
region to apply the pressure to by giving it a Region object. This is why we created the 
Region object top_face_region in the previous statement. The pressure magnitude is also 
required, which is pretty self-explanatory. The distribution Type and amplitude 
parameters are optional. We set the distribution type to uniform using the symbolic 
constant UNIFORM to tell Abaqus our pressure is uniformly distributed. UNIFORM is 
the default value so we did not need to specifically set it. For the amplitude, you would 
provide an amplitude object if you had created one. Jn our case we do not have any 
varying amplitude, and have not created an amplitude object, hence we use the symbolic 
constant UNSET to indicate this. If we did not include the amplitude parameter, this 

· would have been set to UNSET by default. Hence our statement could have been written 
without distribution Type and amplitude as: 

beamModel.Pressure(name='Uniform Applied Pressure', createStepName='Apply Load', 
region=top_face_region, magnitude=18) 

I 
# ---------- ------ ---- --------- ----------------------- ----- -- - - - ---- ---- --
# Apply encastre (fixed) boundary condition to one end to make it cantilever 

I 

I # First we need to locate and select the top surface 
# We place a point somewhere on the top surface based on our knowledge of the 
# geometry 
fixed_end_face_pt_x = e.2 
fixed_end_face_pt_y = e 

I 
fixed_end_face_pt_z = e 

I fixed_end_face_pt = (fixed_end_face_pt_x,fixed_end_face_pt_y,fixed_end_face_pt_z) 

~The face on which that point lies is the face we are looking for 
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I fixed_end_face = beaminstance.faces . findAt((fixed_end_face_pt,)) 

I # we extract the region of the face choosing which direction its normal points in 
fixed_end_face_region=regionToolset.Region(faces=fixed_end_face) 

beamModel.EncastreBC(name='Encaster one end', createStepName='Initial', 
region=fixed end face region) 

fixed_end_face_pt_x = 9.2 
fixed_end_face_pt_y = 9 
fixed_end_face_pt_z = e 

These statements assign the X, Y and Z coordinates of a point on the surface of the fixed 
end of the beam to variables. This point is the exact center of the clamped surface of the 
beam. We are going to use this point to find the surface in a manner similar to the one 
used in the 'apply loads' step. Once we tell Abaqus the coordinates of the point, it will be 
able to figure out which surface we are talking about. 

How did we get these coordinates? Once again visualize the geometry you've created. In 
the part creation step we explicitly set the coordinates of the rectangle while sketching 
out the profile. This profile was then extruded. So you know the beams location in space. 
The top left corner of the rectangle in the sketch was at X = 0.1 , Y = 0.1. Since the sketch 
was made on the XY plane, Z = 0. The bottom right corner of the rectangle in the sketch 
was X = 0.3, Y = -0.1, and again Z = 0. Since our point is at the center of this face, 
X=(0.3-0.l)/2 = 0.2, Y=(O.I-(-0.1))/2 = 0, and Z of course is 0. 

fixed_end_face_pt = (fixed_end_face_pt_x,fixed_end_face_pt_y,fixed_end_face_pt_z) 

This statement assigns the X, Y and Z coordinates of the point to a variable called 
fixcd_end_face_pt, using the same method used in the 'apply load' code block. Once 
again from the syntax you realize that this is a tuple. 

fixed_end_face = beaminstance.faces.findAt((fixed_end_face_pt,)) 

This statement uses the findAtO method to find any face that is at that point or at a 
distance of less than I E-6 from it. As was described in the previous section, the method 
findAtO returns the Face object on which the point is located. 

fixed_end_face_region=regionToolset.Region(faces=fixed_end_face) 
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This statement selects a region using the Face object we have just created. ft uses the 
RegionO method to create a Region object. This is the same method used to create a 
region in the previous section ( 'apply load' section) so you already know how it works. 

The one difference in the syntax from the 'apply load' code block is that the name of the 
parameter sidelfaces has been replaced with faces. Remember the RegionO method 
returns a set-like region or a surface-like region depending on the parameters as 
explained in the 'apply load' section. In this case we apply the encastre constraint on the 
returned Region object. Since encastre is performed on the set of points and not just the 
surface, we need RegionO to return a set-like region. Hence we use faces instead of 
side I Faces. In fact ifyou were to replace this statement with 

fixed_end_face_region=regionToolset.Region(sidelFaces=fixed_end_face) 

you would get the following error: "TypeError: region, found Region, expecting Set". 

beamModel.EncastreBC(name='Encaster one end'~ createStepName='Initial'~ 
region=fixed_end_face_region) 

This statement applies the encastre constraint to the end of the beam. 1t uses the 
EncastreBCO method to create a TypeBC object, which is an object that stores data on 
several types of predefined boundary conditions commonly used in stress/displacement 
analysis. This TypeBC object is derived from the BoundaryCondition object. The 
EncastreBCO method requires you to specify the name or repository key for the 
boundary condition, for which we pass the String ' Encastre one end'. It requires the name 
or key of the step. We pass the String 'Initial' which is the name that was given by 
default to the first step. We must tell the method which region to apply the pressure to by 
giving it a set-like Region object. This is why we created the Region object 
fixed_end_face_region in the previous statement. 

The folJowing block creates the mesh: 

~~------ - ------ ~ ----- - -~~~~~~~--- ---- --- - --- : ____ _________ _____ _ 
1 # Create the mesh 
I 
, import mesh 
I 

# First we need to locate and select a point inside the solid 
# We place a point somewhere inside it based Cin our knowledge of the geometry 
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beam_inside_xcoord=e.2 
beam_inside_ycoord=9 
beam_inside_zcoord=2.5 

elemlypel = mesh.ElemType(elemCode=C3D8R, elemLibrary=STANDARD, 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=DEFAULT, distortionControl=DEFAULT) 

beamCells=beamPart.cells 
selectedBeamCells=beamCells.findAt((beam_inside_xcoord,beam_inside_ycoord, 

beam_inside_zcoord),) 
beamMeshRegion=(selectedBeamCells,) 
beamPart.setElementType(regions=beamMeshRegion, elemTypes=(elemTypel,)) 

I beamPart . seedPart(size=e.l, deviationFactor=e.l) 

beamPart.generateMesh() 

import mesh 

This statement makes the methods and attributes of the mesh module available to our 
script. 

beam_inside_xcoord=9.2 
beam_inside_ycoord=9 
beam_inside_zcoord=2.5 

These statements assign the X, Y and Z coordinates of a point inside the beam to 
variables. In fact they are the exact center of the beam. ~Why do we need these 
coordinates? iWell, in order to mesh the beam we need to assign t,he c~lls in the interior of 

• the beam to, the mesh. To i~entify these we need to firsf find a point inside the beam. 

The center of the beam is once again found using basic geometry. You can visualize it 
mentally or sketch it. This is displayed in the following figure. Once you've· sketched it 
out its pretty easy to see that the coordinates of the center of the beam are (0.2, 0, 2.5). 
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elemlypel = mesh.Elemlype(elemcode=C3D8R~ elemlibrary=STANDARD~ 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=DEFAULT, distortionControl=DEFAULT) 

creates an ElementType object using the ElemTypeQ method. ~The ElementType object 
can later be us.ed as an argument to the setEiemen~TypeQ method to set the element type 
of the part mesh, and this is done a few· statements later. The object and the m.ethod are 
defined in the mesh module which is why we use the import mesh statement. , The only 
required argument for the ElemTypeO method is elemCode which is a 
SymbolicConstant in Abaqus that specifies the element code. These are the same codes 
you see in Abaqus/CAE in _the Element Type window when you go to Mesh> Element 
Type ... . The other parametet:s are optionat.jThe elemLibrary parameter specifies which 
element library to use. The options are STANDARD and EXPLICIT, both of which are 
symbolic constants~' The default value is STANDARD, and since this is what we wanted I 

anyway we could' have just left the argument out. jThe kinematicSplit parameter refers to 
kinematic split control. lt accepts a few SymbolicConstants, which are defined in the 
documentation. The one used here is A VERAGE_STRAIN which is the default hence it 
could have been left out altogether. The secondOrderAccuracy parameter specifies, as 
its name suggests, whether second order accuracy is used. lt accepts the 
SymbolicConstants ON and OFF, of which the latter is the default value (hence we could 
have left it out and it would have defaulted to OFF). The 11onrglassControl . accepts a 
few SymbolicConstants as values. The reduced integration numerical procedure · 
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sometimes faces a problem where there is no stTaining at the integration points. This 
results in a phenomenon called~ "hourglassing". Hourglass aontrol associates a small 
stiffness with these zero-energy modes, to counter the issue. We set it to DEFAULT. 
Sfuce the defuu'it vatae ·i~·-mi:E\"NCED; w~: could have set it to this instead for the same 
result. Or we could have just left it out and Abaqus would have assigned the default to it 
anyway. The last optional argument used· is distortionControl. This can be used to 
prevent excessive deformation where the elemel\t volumes become negative. We have set 
it t<YDEFAULT. Since the default is OFF we could have set it to OFF instead. Or we 
could have left it out altogether and it would default to OFF on its own. Hence the 
statement could have been written as: 

elemTypel = mesh.ElemType(elemCode=C3D8R, elemlibrary=STANDARD, 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=ENHANCED) 

In fact since we accepted all the defaults for the optional arguments we could have 
written: 

elemTypel = mesh.ElemType(elemCode=C3D8R) -The statement 

beamCells=beamPart.cells 

assigns the cells of the part to a variable called beam Cells. You saw the cells object used 
in the ' create section' code block, where beamPart.cells were required to create the 
region of the section assignment. If you recall, the cell object defines the volumetric 
regions of a geometry. Part objects have cells. beamPart.cells refers to the Cell object 
that contains the information about the cells of the beam. 

Notice however that this time there is no comma after beamPart.cells. This is because 
we only want a Cell object to use in the next statement, not a sequence of Cell objects 
(which would give us a Region object). 

~electedBeamCells=beamCells.findAt((beam_inside_xcoord,beam_inside_ycoord, 
beam_inside_zcoord),) 

This statement uses the findAtO method to· select the internal cells of the beam. You've 
seen the findAtO method in-the 'apply load' and 'apply constraint' sections, the syntax is 
the same. The resulting variable selectedBeamCells is a_ Region object~ 
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beamMeshRegion=(selectedBeamCells,) 

This statement converts the Region object into a sequence of regions be~ause a comma 
has been placed at the end of selectedBeamCells-~-Yoo· .. can. then· use· this ·sequence of 
regions in the setEiementType command. · 

beamPart.setElementType(regions=beamMeshRegion, elemTypes=(elemTypel,)) 

This statement uses the setEiementTypeQ .method to set the element type of the mesh. It 
requires you to provide the regions to mesh as a sequence ofRegion objects as one of the 
parameters. We have this stored in the beamMeshRegion variable. The second required 
parameter is a sequence of ElementType objects which tell Abaqus what element types 
to use on the regions we wish to mesh. 

Note that we could have left out the statement 

beamMeshRegion =(selectedBeamCells,) 

entirely, and then rewritten the last statement as 

beamPart.setElementType(regions=(selectedBeamCells,), elemTypes=(elemTypel,)) 

So which way is better? Either works fine, just remember there' s more than one way to 
do things and often readability of the code can be an important factor in deciding which 
one to go w•th. 

beamPart.seedPart(size=B.l, deviationFactor=B.l) 

This statement assigns the globaLse~ds to the part. The ~iie·-'is-a-requit:eP.argument; which 
• defines the global size for the edges. fh'e .deviatio~aCtQf ·lS aD.optional argument which 

is the ratio of the chordal deviation to the element length. The seedPartO method is 
defined in the mesh module which we imported. 

beamPart.generateMesh() 

This statement uses the generateMeshO method to generate the mesh on our part. The 
generateMeshO method is defined in the mesh module which we have imported. 
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4.3.13 Create and run tbe job 
The following block runs the job 

# ---- -- - --- - - ---- ------ - ------------ --- ----- - -------- - ------------ - ---- --
# Create and run the job 

import job 

# Create the job 
mdb.Job(name='CantileverBeamJob', model='Cantilever Beam', type=ANALYSIS, 

explicitPrecision=SINGLE, nodalOutputPrecision=SINGLE, 
description='Job simulates a loaded cantilever beam', 
parallelizationMethodExplicit=DOMAIN, multiprocessingMode=DEFAULT, 
numDomains=l, userSubroutine=' ', numCpus=l, memory=Se, 
memoryUnits=PERCENTAGE, scratch='', echoPrint=OFF, modelPrint=OFF, 
contactPrint=OFF, historyPrint=OFF) 

# Run the job 
mdb.jobs['CantileverBeamJob').submit(consistencyChecking=OFF) 

# Do not return control till job is finished running 
mdb.jobs('CantileverBeamJob'].waitForCompletion() 

# End of run job 

import job 

This statement imports the job module allowing the script to access its methods. 

mdb.Job(name='CantileverBeamJob', model='Cantilever Beam', type=ANALYSIS, 
explicitPrecision=SINGLE, nodalOutputPrecision=SINGLE, 
description='lob simulates a loaded cantilever beam', 
parallelizationMethodExplicit=DOMAIN, multiprocessingMode=DEFAULT, 
numoomains=l, usersubroutine=··, numCpus=l, memory=58, 
memoryUnits=PERCENTAGE, scratch='', echoPrint=OFF, modelPrint=OFF, 
contactPrint=OFF, historyPrint=OFF) 

This statement creates the job. The JobO method creates .. a. Job object for the model. It. is 
a method of the ModeiJob. o6ject ~hich is derived from the Job object: lt has two 
required arguments. The first is ··nam~ which is the repository key. We have called it 
"CantileverBeamJob'. Note that·there ~-re no spaces in the ·name, ,this is required. The 
second argument is~·.narnelkey of the model, wljich fn~our case is the String 'Cantilever 
Beam'. There are a number of optional argumcmts. One of them is description, in whkh 
you 'can provide a String description of the job. The other optional arguments are defined 
in the documentation. Some of these such as memory may be worth altering if your 
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computer has trouble handling the simulations. The JobO· metho·d is defined in the job 
module which is why we imported it with the statement 'import job. -· 

mdb.jobs['CantileverBeamJob'] . submit(consistencyChecking=OFF) 

Th.is s~tement submi~s the job for analysis. Th.e submitQ method is~ method of the Job 
object. It has no reqmred arguments although 1t does have a few optional ones. · Here we 
have ~u·sed the consistencyChecking argument which performs a consistency check for 
the simulation setup. The submitQ method is defined in the job module which has been 
imported. 

mdb.jobs['CantileverBeamJob'].waitForCompletion() 

This statement makes sure the control lies with the script till the analysis finishes 
executing. The waitForCompletionO method is a method of the Job object. 
waitForCompletionO is defined in the job module which has been imported. Why is that 
important? It is particularly useful when running scripts from the command line because 
the blinking .cursor prompt gets disabled (busy) until the script finishes running. You 
might be running your scripts through an optimization tool such as ISight or 
ModeiCenter, and often the only way for an external software to know that one analysis 
job is completed is to have Abaqus return control only after it has finished running. 

The following code perfonns some post processing tasks: 

# -------- ---- ------------------------------------- - ---- - -----------------
# Post processing 

import visualization 

beam_viewport = session.Viewport(name='Beam Results Viewport') 
beam_Odb_Path = 'CantileverBeamJob.odb' 
an_odb_object = session.openOdb(name=beam_Odb_Path) 
beam_viewport.setValues(displayedObject=an_odo_object) 
beam_viewport.odbDisplay.display.setValues(plotState=(DEFORMED, )) 

import visualization 

This statement imports the visualization module. This allows the script to access 
methods that replicate the functionality of the visualization module of Abaqus/CAE. 

beam_viewport = session.Viewport(name= ' Beam Results Viewport') 
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This statement uses the ViewportO method to create a Viewport object. The only 
required argument is name which is a String specifYing the repository key. In this case 
we name it 'Beam Results Viewport' . 

beam_Odb_Path = 'CantileverBeamJob.odb' 

This statement assigns the name of the output database file to a variable for later use. 

an_odb_object = session.openOdb(name=beam_Odb_Path) 

This statement creates an Odb object by opening the output database whose path is 
provided as an argument, and assigns it to the variable an_odb_object. Note that we have 
not provided a complete path, only the file name, hence it will search for the file in the 
default Abaqus working directory. You may provide an absolute path if you are working 
with an output database file saved elsewhere on the hard drive. 

beam_viewport.setValues(displayedObject=an_odb_object) 

The statement uses the setValuesQ method to set the display to the selected output 
database. Jf you recall, this same method was used in the ' initialization block' (Section 
4.3 .I) of the script with displayedObject=none to blank the viewport. Just so you know, 
the above statement could have been written instead as 

session.viewports['Beam Results Viewport'] 
.setValues{displayedObject=an_odb_object) 

The statement 

beam_viewport.odbDisplay.display.setValues(plotState=(DEFORMED, )) 

This statement changes the viewport display to the deformed beam by using the 
setVaJuesQ method and setting the plot state to the symbolic constant DEFORMED. For 
the record, the above statement could also have been written as 

session.viewports['Beam Results Viewport'].odbDisplay 
.display.setValues(plotState=(DEFORMED, )) 

4.4 What's Next? -----In this chapter you worked through all the steps in the creation and setup of a finite 
element simulation in Abaqus using a Python script. Not only did you see the bigger 
picture, but you also examined individual statements and learnt of a number of new 
objects and methods that you will regularly encounter when scripting. In subsequent 
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chapters we are going to look at many more examples, each of which we will perform 
tasks that weren't demonstrated in this one. But first, let's learn a little more Python 
syntax. 

_,1 ,. 
I" 
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Python 102 

5.1 Introduction 
In Python l 0 I , we covered many aspects of Python syntax. We spent a great deal of time 
understanding important concepts such as lists and tuples, and object oriented 
programming. That knowledge helped you understand the cantilever beam script. The 
example did not however use any conditional statements or any iterative loops. 
If . .. else .. . statements and for-loops are usually a major element in any sort of program 
you write, and you will need to use them in more complicated Python scripts as well. 
We'll cover them in this chapter. 

This book assumes that you are familiar with at least one programming language, 
whether it be a ful1-fledged language like C++ or Java, or an engineering tool such as 
MA TLAB. Hence the concepts of conditional statements and loops should not be new to 
you. This chapter aims only to familiarize you with the syntax of these constructs in 
Python. 

If ••• elif ••• else statements 
The if-statement in Python is very similar to that used in other programming languages. It 
tests if a certain condition is true. lf it is then it executes a statement or block of code. 

If it is not true, Python checks to see if an else-if or e) se block is present. Else-if is written 
as elif in Python. Elif tests another condition whereas else does not test for any condition. 

The syntax is a little different in Python. You do not put the if and else blocks of code 
within curly braces as you do in many other languages. In Python you indent the block 
instead. Also the colon ':' symbol is used. To indent the block is analogous to using 



5.1 Introduction 93 

braces in other languages~ if you don't do it you will get an error. The syntax looks 
something like this. 

Example 

if a_certain_condition_is_true : 
do this 
and this 

elif another_ condition _is _true: 
do this 
and this 

else: 

do this 

Open up Abaqus CAE. In the lower half of the window you see the message area. If you 
look to the left of the message area you see two tabs, one for Message area and the other 
for Kernal Command Line Interface. 

~ 
t 1:6 P<odttintd f ield! 

rl/8 Rtmeshing Rult> 
~C; Sl<ttch .. 

A AMotttions 

I Anoly>is 

r.!. Jobs 

Click the second one. You see the kernel command prompt w·hich is a">>>" symbol. 

Type the following lines, hitting the ENTER key on your keyboard after each. 

Here is what you see 
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>» X • 10 
»> if X > 0 : 

print 'x is positive' 
elif x < 0 : 

print 'x is negative ' 
else : 

S.l.l 

print 'x is o· 
x is positive 
»> 

The for loop in Python is conceptually similar to that in other languages - it provides the 
ability to loop or iterate over a certain set of data. However its implementation is a little 
different in Python. 

In C, C++, Java or MATLAB, you find yourself iterating either a fixed number of times 
by incrementing a variable every loop till it reaches a certain value, or until a condition is 
satisfied. In Python on the other hand, you create a sequence (a list or a string), and the 
for loop iterates over the items in that list (or characters in a string). 

Example 

Type the following statements in the Abaqus kernel command interface prompt 

fruitbasket c [rapples', _ 'oranges', 'bananas', 
for' fruit in fruitbasket 

· print fruit 

Here is what you see: 

>>> fruitbasket • ['apples' . 
>>> for fruit in fruitbasket 

:print fr\lit 

apples 
'----,1 oranges 

bananas 
Jle.l.ons 
>» 

'bananas' . 'aelons• ] 

In the above example, fruitbasket is a list consisting of a sequence of strings. With each 
iteration, the for loop takes an element (in this case a string) out of the list and assigns it 
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to the variable fruit. The print statement then prints it out on screen. Basically our for 
loop iterates 4 times. 

Example 

Type the following in the Abaqus kernel command interface prompt 

for letter in cpython' 
print letter 

Here is what you see: 

~; 
---.l t 

h 
0 
n 

for letter in 'Python ' : 
print letter 

>»I 

In the above example, 'Python' is a string, essentially a sequence of characters. With 
each iteration, the for loop takes an element (in this case a character) out of the StTing 
and assigns it to the variable letter. The print statement then prints it out on screen. So 
this for loop iterates 6 times. 

This type of for loop is great for iterating through the elements of a list and performing 
an action on each one. Abaqus stores its repository keys in lists, hence it is easy to iterate 
through them using a for loop. This wil1 be demonstrated in Chapter 8 while performing 
a dynamic, explicit truss analysis. 

Sometimes you may wish to use a for loop to iterate a certain number of times, rather 
than loop through each element of a preexisting list. However the for loop can only 
operate on a sequence. A workaround is to generate a list for the task using the rangeO 
function. 

The rangeQ function generates a list which consists of arithmetic progressions. It can 
take one, two or three arguments. If one argument is provided, a list is generated starting 
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at 0, and ending at one integer less than the argument provided. It will naturally have the 
same number of elements as the value of the integer argument. 

range(S} returns[O, 1,2,3,4] 

If two arguments are provided, the first one is treated as the beginning of the list, and the 
end of the list is one less than the second argument. 

range(5,9) returns (5, 6, 7, 8] 

If three arguments are provided, the first one is treated as the beginning of the list, and 
the end of the list is one less than the second one. However all elements in the list must 
be multiples of the third argument. 

range(2, 19, 3) returns [3, 6, 9) 

Using the rangcO function, you can specify a for loop to iterate a certain number of 
times. 

Example 

j for x in range(S) 
print x 

Here is what you see: 

>>> for x in range(S) 
print x 

~~ 
---,12 

3 
4 
»> 

The above for loop iterates 5 times. The range(S) statement returns a list [0, I, 2, 3, 4] 
and the for loop iterates for each element (integer) in this list, assigning it to the variable 
x. The print statement prints this variable to the screen. 
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The while loop executes as long as a certain condition or expression returns true. It is 
similar to the while loop in other languages. The syntax is 

while condition: 
do this 
and this 

Example 

)( = X-t:l 

Here is what you see 

J1 
§B 

>» x•O 
>» while x <S : 

print x 
x • x+l 

0 
1 
2 
3 
4 
>» 

When the while loop is first encountered, x = 0, and the x < 5 condition is satisfied and 
the loop is executed. In each iteration the value of xis incremented by I. When x = 5, the 
x<S condition is no longer satisfied and control breaks out of the loop. 

The break statement allows program control to break out of a for loop or a while loop. 

Example 

Here is what you see: 
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for letter in 'galaxy' 
if letter • • 'x ' : 

break 
print letter 

-------·--~-

Each of the letters in the word galaxy are printed out turn by turn until the letter 'x' is 
reached. Since the if condition returns true, the break statement is encountered, and the 
program breaks out of the loop. 

The continue statement on the other hand ends the current iteration without executing the 
remaining statements and begins the next iteration 

Example 

Here is what you see: 

>>> for letter in 'galaxy' 
if letter • • 'x' : 

con.tinue 

'-----.l g 
4 

1 
a 
y 
})) 

print letter 

Once again, each of the letters in the word galaxy are printed out turn by turn until the 
letter x is reached. Since the if-condition returns true, the continue statement is 
encountered. The current iteration is terminated before the print statement is executed, 
and the next iteration begins. 
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,~2 ' ' 
llla<.OW ~ r • 

You now possess enough basic knowledge of Python syntax to proceed with scripting for 
Abaqus. The Python documentation, as well as a number of tutorials, are available at 
www.python.org ifyou wish to study the language further. 

Before we start working with more examples, let's introduce you to some other important 
topics such as macros and replay files. Please proceed to the next chapter. 



6 -
Replay files, Macros and IDEs 

6.1 Introduction 
~ 

The Abaqus Scripting Interface consists of thousands of commands and attributes 
separated into various Abaqus modules. It would be impossible for you to memorize all 
of these. Fortunately there is an easier way- replay files. In this chapter we' ll talk about 
how you can use these. We' ll also look at ~ac~9~a feature provided by Abaqus, that 
makes it easy to create simple scripts without requiring any actual coding. And we'll get 
you hooked up with a good text editor to type your scripts through the rest of the book. 

[6j · . Replay Files._· ··..,.ii!· . ·~
In Chapter 2, Section 2.2 (page 33), we talked about how Python fits into the bigger 
scheme of things. To summarize, when the user performs actions in the GUI 
(Abaqus/CAE), Python commands are generated which pass through the interpreter and 
are sent to the kernel. Fortunately for us, Abaqus keeps a rec9rd_ of these commands in 
the form of a replay file with. the. extension.' .. rpy ' . 

Abaqus/CAE Pvthon Python Abaqus/CAE 
GUI commands Interpreter Kernel 

Replay File 
(.rpy) 
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The replay file is written in the currentwork directory. The work directory is C:\Temp by 
default, and you can chan·g~ j{ using Fil~ ;-S~fWork.Dire~tory.. · - ~ 

The easiest way to look up the necessary commands is to perform an action in 
Abaqus/CAE and then open up this replay file. If it is currently in use Abaqus may not let 
you open it;. in this case right click on it and choose copy to create a copy of it in 
Windows Explorer that you can open. 

NOTE: Abaqus Student Edition (current version at time of writing is 6.10-2) does not 
write replay files. This is one of its limitations. You need to be using the commercial or 
research editions of Abaqus for replay files to be written to the working directory. 
However if all you have is the student version, you can achieve the same thing with 
Macros. We will speak about these shortly. However I recommend you read the next 
section since everything with replay scripts applies to macros as well. 

You will find that sometimes the replay file alone is exactly what you need for creating a 
script with minimal effort. For example if you open up a new moit in Abaqus/CAE, do a 
bunch of stuff, create parts, materials etc, you could copy all the statements from the 
replay file and save them in a .py file and use this in future to get back to the same point 
starting from a new model. It would be sort of like saving the .cae, except python scripts 
take up a lot less space and you can email them to people as text. 

However if you are looking to work with the script, modifY it, add iterative methods, or 
parametrize it, the form of the script in the replay file will most likely not be ideal. I'll 
demonstrate this with an example. 

a. Start up Abaqus/CAE. If Abaqus is already open close it and reopen it as you 
start out with a blank replay file when you start a new Abaqus session. 

b. Right click on Model-1 in the model tree and choose Rename. Name it Block 
Model. 

c. Double click on Parts in the model tree. You see the Create Part window. 
d. Set the Name to Block, modeling space to 3D, type to Deformable,base 

feature shape to Solid,base feature type to Extrusion and approximate size to 
200. Click Continue. You see the sketcher. 

e. Choose the Create Lines: Rectangle tool. Click on the origin of the graph and 
then click anywhere in the top right quadrant to complete the rectangle. 
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f. Use the Add Dimension tool to give it a width of25 and a height of 15. 
g. Click the red X to close the Add Dimension tool and then Done to exit the 

sketcher. You see the Edit Base Extrusion dialog box 
h. Give the extrusion a depth of20. Click OK. You see the block in the viewport. 
1. Choose the Create Round or Fillet tool. Click on the top left edge of the block 

to select it and choose Done 
J · Give it a radius ofl. 
k. Click the red X to exit the Create Round or Fillet tool. 

Now look in the Abaqus work directory which is C:\Temp by default or whatever you've 
set it to be.J Open it in a text editor such as WordPad which comes with windows. 
(Notepad will not be good to view the replay file as a lot of the carriage returns are 
removed). 

Here is what you will see (FYJ I have modified the information in the top 3 lines): 

# Abaqus/CAE Release 6.10-1 replay file 
# Internal Version: xxxxxxxxxxxxxxxxx 
# Run by xxxxxx on Sat MonthDayxx:xx:xx 2911 
# 

# from driverUtils import executeOnCaeGraphicsStartup 
# executeOnCaeGraphicsStartup() 
# : Executing "onCaeGraphicsStartup()" in the site directory 
from abaqus import * 
from abaqusConstants import * 
session.Viewport(name='Viewport: 1' , origin=(e.e~ e.e), width=411.136439899262, 

height=212.919445240498) 
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session.viewports['Viewport: l'].makeCurrent() 
session.viewports['Viewport: 1'].maximize() 
from caeModules import * 
from driverUtils import executeOnCaeStartup 
executeoncaeStartup() 
session.viewports['Viewport: l'] . partDisplay .geometryOptions.setValues( 

referenceRepresentation=ON) 
mdb.models .changeKey(fromName='Model-1', toName='Block Model') 
session.viewports['Viewport: l'].setValues(displayedObject=None) 
s = mdb.models['Block Model'] .ConstrainedSketch(name=' __ profile __ ', 

sheetSize=288.8) 
g, v, dJ c = s.geometry, s.vertices, s.dimensions, s.constraints 
s.setPrimaryObject(option=STANDALONE) 
s.rectangle(pointl=(e.e, e.e), point2=(22.5, 12.5)) 
s.ObliqueDimension(vertexl=v[3]J vertex2=v[a], textPoint=(6.54132556915283, 

-6 . 48623704910278), value=25.9) 
s.ObliqueDimension(vertexl=v(e], vertex2=v[1], textPoint=(-8.33698463439941, 

4.81651592254639), value=lS .e) 
p = mdb.model s ['Block Model'].Part(name='Part-1', dimensionality=THREE_D, 

type=DEFORMABLE_BODY) 
p = mdb .models['Block Model'].parts['Part-1'] 
p.BaseSolidExtrude(sketch=s, depth=28.0) 
s.unsetPrimaryObject() 
p = mdb.models['Block Model'] . parts['Part-1'] 
session.viewports[ 'Viewport: l'].setValues(displayedObject=p) 
del mdb.models['Block Model'].sketches[' __ profile __ '] 
p = mdb.models ['Block Model'].parts['Part-1'] 

e = p.edges 
p.Round(radius=1.e, edgelist=(e[4) , )) 

As you can see, Abaqus has been recording everything you did in CAE in the replay file 
from the moment the software started up. 

You see some statements that you would nonnally include in all scripts such as 

from abaqus import * 
from abaqusconstants import * 

But you would be unlikely to write statements such as 

session.viewport(name='Viewport: 1', origin=(e.e, e.e), width=411 .136439809262, 
height=212.819445240498) 

session.viewports{'Viewport: l'].makeCurrent() 
session.viewports['Viewport: l'] . maximize() 
from caeModules import * 
from driverUtils import executeOnCaeStartup 
executeOnCaeStartup() 



1 04 Replay files, Macros and IDEs 

in your script since you probably don't want your script to change the stze of the 
viewport that it is run in, nor are you likely to want to run a startup script. 

The remaining statements are the meat of the script. They rename the model, draw the 
sketch and create the part, and fillet it. However they are written in a very literal sense. 
For example, the Ob~q.ueDimeosions.O. command_ is use~ to.-dimension the edges of the 
rectangle. When you are using ·.-a script you are more likely to enter in the exact 
coordinates in the rectaogleO method as pointl and poiot2 as we did in the cantilever 
beam example. 

In addition the statements dealing with the edge round 

e = p.edges 
p.Round(radius=l.e, edgeList=(e[4], )) 

appear to assign all the edges of the block to a variable 'e', and then Abaqus refers to the 
desired edge as e[4] which makes sense to it internally as it stores each of the Edge 
objects in a certain order; but this does not make any sense to a human. 

Here is what this same script would look like ifl wrote it. 
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The first thing you notice is how much more readable this script is. Secondly (and more 
importantly), we do not refer to internal edge or vertex lists. The statements for rounding 
the edge are 

edge_for_round = blockPart.edges.findAt((12.5, 15.9, 29.9)J ) 
blockPart.Round(radius=l.e, edgelist=(edge_for_round, )) 

The find~tQ meili,od re_fers to coordinates that we can visualize by scribbling the block 
on · a piece of paper. If you decided you wanted to round another edge in a second 
iteration of the analysis, you could change the coordinates right here and rerun the script. 
The replay file script on the other hand cannot be modified, since you wouldn't know 
what to change e[4] to since we do not know the sequence of Abaqus's internal edge list. 

So you see that the replay file is useful only 'if you want to exactly replay what was done 
in Abaqus. However it requires some . work to modify it for any other use. As it gets 
longer it will require too many major changes to be worth the effort. 

However having a replay file helps you write your own script. You can see that the major 
methods used were the same in the replay script and the one I wrote. These include 
changeKeyQ, ConstrainedSketchO, rectangleO, BaseSolidExtrudeQ and RoundQ. By 
performing a task in Abaqus/CAE and looking at the replay file we very quickly know 
the names of the methods that need to be used and what arguments they require. While it 
is easy to remember a name like RoundO, you are unlikely to remember the names of the 
thousands of other methods available through the Abaqus Scripting Interface. The replay 
file will tell you at a glance the names of the methods you need, and you can then look 
these up in the Abaqus Scripting Reference Manual to understand and use them. 
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Note also that my code is very similar to that used in the Cantilever Beam example. I 
have infact copied and pasted that code here, and modified it using some help from the 
replay file. The fastest way to write Python scripts is to reuse code where possible, 
modifY it suitably, and find out what new methods are required by performing the 
required task in Abaqus/CAE and reading the replay file. The only place you can' t really 
do this is when dealing with output databases, but we' ll get to ODB object model 
interrogation (after a few hundred pages) and teach you what you need to know then. 

.... :s;,;*;;.;),: ~n 
Macros are similar to r_e_p_l~x_ _fit~~:-The difference between them is that the replay file 
starts at the beginning of your Aba(jus session and is continuously updated until you close 
Abaqus/CAE. In addition it can only be saved by making a copy of the .rpy file in 
Windows Explorer otherwise it will get overwritten during your next session. Macros on 
the other hand allow you to define at what point the replay data should start getting 
logged, and when it should stop. ln addition you can give the replay data a name and call 
it later from within Abaqus. The statements in it will be the same as those in the .rpy file, 
except you won't have to search through hundreds of lines of other replay statements to 
find the few you need. 

Macros are stored_~"-a fil~_called 'abaqusMacros.py~ Abaqus stores each macro within a 
function wifh the name you assign.to·me'macro·. 

Let's demonstrate this: 

Start Abaqus/CAE (or open a new model in Abaqus/CAE). Go to File >_ ~_!le~ 
Manager. 

J ~!.----··--------~~-- I 



You see the Macro Manager dialog box as shown in the figure. 

Click on Create. You see the Create Macro dialog box. 

Directory: ® Home @ Work 

( Continue.. • . J I" ~n~el. _ I 
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Type in a name for the macro such as Block.Macro. It needs to be one word as you 
cannot have a space in a macro name. This is because the name of the macro wi 11 be the 
name of the function in the abaqusMacros.py file and function names cannot have spaces. 
Change the directory to Work so that the macro is saved in the Abaqus work directory. 
Click Continue. 

Recording Macro: •Bio<:kMacro• 

j Stop R~ording J 

Abaqus begins recording the macro. 

Repeat all the steps described in the previous section to rename the model, create the part 
'Block' and round the edge. Then click Stop Recording. 

You see Block.Macro appear in the list in the Macro Manager. As you create more macros 
they will appear here. 

Open 'abaqusMacros.py' in the work directory. Here's what the contents will look like: 

# Oo not delete the following import lines 
from abaqus import * 
from abaqusConstants import * 
import _main_ 

def BlockMacro(): 
import section 
import regionToolset 
import displayGroupMdbToolset as dgm 
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import part 
import material 
import assembly 
import step 
import interaction 
import load 
import mesh 
import job 
import sketch 
import visualization 
import xyPlot 
import displayGroupOdbToolset as dgo 
import connectorBehavior 
mdb . models.changeKey(fromName='Model-1', toName='Block Model') 
session.viewports['Viewport: 1']. setValues{displayedObject=None) 
s1 = mdb. models['Block Model'].ConstrainedSketch{name=' __ profile __ ', 

sheet5ize=200.0) 
g, v, d, c = s1.geometry, sl.vertices, s1 .dimensions, sl.constraints 
s1.setPrimaryObject(option=STANDALONE) 
sl. rectangle(point1=(0. e, e.e), point2=(22.5, 13 . 75)) 
sl.ObliqueDimension(vertexl=v[3], vertex2=v[0], textPoint={16.4174423217773, 

-4.17431116104126), value=25.0) 
s1.0bliqueDimension(vertex1=v[0], vertex2=v[1), textPoint=(-5.90002059936523, 

7.25688123703003), value=15.0) 
p = mdb.models['Block Model'].Part(name= 'Block', dimensionality=THREE_D, 

type=DEFORMABLE_BODY) 
p = mdb.models('Block Model'].parts['Block'] 
p.BaseSolidExtrude(sketch=sl, depth=20.0) 
sl.unsetPrimaryObject() 
p = mdb.models['Block Model'] . parts['Block'] 
session.viewports['Viewport: l ' ].setValues(displayedObject=p) 
del mdb.models['Block Model'].sketches[' __ profile __ '] 
p = mdb . models['Block Model'] , parts ['Block'] 
e1 = p.edges 
p. Round(radius=l.e, edgelist=(e1[4], )) 

You notice that the name of our macro ' BiockMacro' is the name of the function 
(indicated by the def keyword). In addition there are a number of import statements to 
import all modules that might be required by almost any script. Other than that the 
statements are the same as the ones in the replay file. Essentially what Abaqus has done 
is given you the statements of the replay file that were written while the macro was 
recording. 

You can run an existing macro from the Macro Manager by choosing it from the list and 
clicking Run. Jn our case this will only work in a new model because we rename ' Model-
1' to ' Block Model'. (If no 'Model-] ' is present then you will get an error.) If you'd used 
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the macro to do something like create a material, you could then run the macro inside any 
instance of Abaqus and it would create that material for you again. 

You can see how macros help you perform a repetitive task without actually writing a 
single Python statement yourself. The added advantage is that users of Abaqus Student 
Edition can use this in place of the replay file which they do not have access to. ln fact 
even if you're using the Research or Commercial editions of Abaqus, you may prefer to 
create a macro of a task you are trying to script in order to see which commands 
Abaqus/CAE uses as opposed to reading the replay file which will include everything 
from the moment your Abaqus session began. 

6. • 'Es and. ~e:tri.liiditfirs . 1 -·v ,. · ,.. ""-· · " !lF"!,i.,~· ·· -· . a~ ~.o!l'IGi.......,...,..~ 
Python scripts are basically text files with a .py extension. This means you can write 
them in the most basic of text editors - Notepad - which ships with every version of 
Windows. However you. are unlikely to enjoy this experience too much, especially since 
Python code needs to be indented. In addition notepad displays everything in one font 
color, including things like comments, function names and import statements. This makes 
everything harder to read, and also harder to debug. You might enjoy scripting with 
something a little more sophisticated. 

IDLE is an IDE (integrated deveJo,P.Jiltmt..e.JWirorunent) that is installed by default with 
any Python instali~tion. Chances ~e· it is already installed on your system if you look in 
the 'Start' menu in the Python application. 

If you were programming in pure Python you could run your scripts directly from IDLE. 
However since you will be writing scripts for Abaqus, they would need to be run from 
within Abaqus/CAE (File > Run Script) or from the command line. You will essentially 
use IDLE as a text editor. 

Notepad++ is a free code editor. It is like an enhanced version ofNotepad that is great for 
writing code. It has syntax highlighting and also displays line numbers next to statements 
which helps with debugging code. In addition you can have multiple files open in 
multiple tabs and switch between them easily. It supports a number of popular languages, 
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including Python, and will choose the appropriate language and coloring based on the file 
extension. 

IJ' C:\Uscrs\GI The Great\Oeslctop\Abaqus Boolc St tf\cantik!ver beam.py Notepad+ ry u - - + ., 
•, 

Filt Edit S8rch View Encodin9 language Sd:tin~s Macro · Run Te:xtFX .Piugins Window ? X 
~ t~ 8 (;) ~ f~ !f!o ~ h4' CO liJ I·., c I e ~ I ...:t ~ 1 ea~ 1 =:7 11 aE]IJll f!l oo m )) 

s -~_beln~ la~'Ml 
l ~roa _a.baqu:s iiiPOTt * • 
2 rro• a.baqusConstants illlJ)Ort • 8 s t•port regionToolset 
'I 
s session. viewports [ • V!.ew-po:::-t: l' ).setValues(displayedObject-None) 
6. 
7 

· S t ----------------------------------------------------
9 t Create the model (or more accurately, renall'.e the existi nq one) 

10 
11 

12 mdb.models.c:hang:eKey(~romName• 'Hodel-1', toName• 'Cantilever Beam•) 
l3 beamHodel • mdb .models['Cantilever Beam'] 
14 

15 t -----------------------------------------------------
lEi t Create the part 
17 
lS iiiPOrt slcetcll. 
19 iJII)Ort part 
20 t 21 I al Sketch the beam cross section ~sino rectanqle tool. I 
22 beamProtileSketch • beamHodel.ConstrainedSketch(name••Beam CS Prof ile', t ... 

• t! i~ = ~ •t. :r .. ~-· t ' ::1:! .0.: - ot.~~_ .. :s:; ••• ,>&; .. -:'"·¥---=.:;;~i"": ~.,::.& ... < ... -::. .:-~~ <••IJ· r- ~ -·-· • ' 

length : 7054 lines:l83 l ln:l Col : l Sei:O 1 Dos\Windo~ AN SI JINS i •.. 

All of the scripts for this book were written in Notepad++, it is my personal favorite. The 
website for Notepad++ (at the time ~f publication) is http://notepad-plus-plus.org/ 

Abaqus Python. Devel0pment~nviranment·{PDE) is an application that comes bundled . '. ,;' .. . . . . 
with Abaqus. It allows you to create and edit scripts, run then, and offers debugging 
features. 

You can start Abaqus PDE from within Abaqus/CAE by going to File ?'. Ab_aq~~ _!~DE~~~ . 
Alternatively you can start it by going to the system command prompt and typing (in 
Abaqus Student Edition version 6.1 0-2) 
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abq61e2se -pde 

You will need to change the 'abq61 02se' to the command required to run your version of 
Abaqus (refer to Chapter 2 for details). 

If you start Abaqus PDE from within Abaqus/CAE, it will. be connected.to.CAE,-as . 
' . . ' indicated by the words "Connected to CAE" dis'played in the top left ofthe Abaqus PDE 

window (see figure). This means you will be using your Abaqus license tokens. If you 
run it from the comm;md line..however, Abaq!:Js PDE will not b.e .. ~onnected to CAE. 

Abaqus PDE gives you the option to run the script in 3 modes - 'GUJ ', ' Kernel' and 
'Local' in the toolbar (see figure). You choose the correct one depending on whether the 
sccipts--sheuld run .in Abaqus/CAE GUI., .the ~baqp~/CAE kem,el or locally. By default 
.guiLog scripts ~un in GUT, and .py scripts run in the kemei. - · ·· .. - · --

What are .guiLog scripts? These are similar to macros, in the sense that you can perform 
some tasks in the GUI and a Python script will be written recording this. However 
.guiLog scripts describe the activity of the user in the GUI, which buttons were clicked 
and so on, whereas .py scripts record the Python commands called. So for example, when 
you close a dialog box, a .guiLog script records the fact that you clicked on a certain 
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button, whereas a .py script records which function was called depending on the options .· 
you checked off in the dialog box. 

This may be better understood with a demonstration. Open a new file in Abaqu.s PDE 
(File > New Model Database > With Standard/Explicit Model). Click the Start 
Recording button in the toolbar which appears as a red circle. Repeat all the steps from 
the previous section to rename the model, create a block and round an edge. Then click 
the Stop Program button represented by the solid square. 

from abaqusTester import * 
import abaqusGui 
selectTreeListitem('Model Tree', ('Model Database', 'Models', 'Model-1'), e) 
showTreeListContextMenu('Model Tree') 
selectMenuitem('Model Tree Menu+ Rename') 
setTextFieldValue('Rename Model+ Rename To', 'Block Model') 
pressButton('Rename Model+ Ok') 
selectTreeListitem('Model Tree', ('Model Database', 'Models', 'Block Model', 'Parts'), 
e) 
doubleClickTreelistitem('Model Tree', ('Model Database', 'Models', 'Block 
Model', 'Parts'), 0) 
setTextFieldValue( ' prtG_PartCreateDB +Create', 'Block Part') 
pressButton('prtG_PartCreateDB +Continue ' ) 
pressButton('Sketcher GeomToolbox +Rectangle') 
clickinViewport('Viewport: 1', (9.256754, -9.321101), 0.728166, LEFT_BUTTON) 
clickinViewport('Viewport: 1', (27.216, 17.1468), 0.728166, LEFT_BUTTON) 
pressButton('Sketcher ConsToolbox +Add Dimension') 
clickinViewport('Viewport: 1', (5.08671, -0.8642202), 8.728166, LEFT_BUTTON) 
clickinViewport('Viewport: 1', (8.21614, -8 . 15596), 0.728166, LEFT_BUTTON) 
commitTextFieldValue('skcK_DimensionProcedure +New Dimension', '25') 
clickinViewport('Viewport: 1', (-0.513509, 4.55963), 0.728166, LEFT_BUTTON) 
clickinViewport( 'Viewport: 1', (-6.54723, 4.55963), 0.728166, LEFT_BUTTON) 
commitTextFieldValue{'skcK_DimensionProcedure +New Dimension', ' 15') 
pressButton('Procedure +Cancel') 
pressButton('prtK_NewPartProc +Done') 
pressButton{'prtG_ExtrudeFeatureDB + Ok') 
pressFlyoutitem('Create Blend Flyout +Round/Fillet') 
clickinViewport('Viewport: 1 ' , ( -0.112969, 0.8541739), 0.0044191, .LEFT_BUTTON) 
pressButton('prtK_BlendRoundProc +Done') 
commitTextFieldValue('prtK_BlendRoundProc +Radius', '1.0') 
pressButton('Procedure +Cancel') 

You will notice that as you were working in the GUI, the .guiLog was storing a log of 
everything you did in the GUI. It is evident that this log is of a different nature compared 
to a script. It records infonnation such as which button you clicked, where in the 
viewport you clicked, and even trivial things Jike c1icking the 'cance) procedure' red X. 
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Let's see how this guiLog can be used. Create a new model in Abaqus by going to File> 
New Model Database> With Standard/Explicit Model. Leave the .guiLog file open in 
Abaqus PDE 

Click the 'Play' button represented by the solid triangle. You will see that each of the 
lines in the .guiLog is highlighted one by one. At the same time, in the Abaqus/CAE 
window, you see the corresponding task being performed. It is almost like you are 
watching the person who created the guiLog at work except that you do not see their 
mouse cursor moving about. You may find it useful to pass a .guiLog file along to 
coworkers to demonstrate how you performed a task in the GUI. 

At the bottom of the Abaqus PDE window, you see a message area and a command line 
interface similar to the one you see in Abaqus/CAE. The difference is that this is a GUI 
Command Line Interface whereas the one in Abaqus/CAE is a Kernel Command Line 
Interface. You will understand the difference between the two when we cover GUI 
customization in the last few chapters of the book. For now just know that a GUI API can 
be called from here, so you could for instance check the functionality of a dialog box. 

Abaqus PDE has a number of debugging features. You can use the 'Set/Clear. 
Breakpoint ~t cursor l~ca~~~· tool to set a breakpoint at any statement (does not 
include comments or empty lines) and the statements before that point wil1 be executed. 
You can then choose to contine after a breakpoi~~ if you wis~. 

You can access the Abaqus PDE debugger using Window> Debugger. The debugger is 
displayed between the Abaqus PDE main window and the message area. You can display 
the watch list by clicking on 'show watch ' . This allows you to watch the value of 
variables as the script executes. To add a variable to the watch list right click on it in the 
main window and select Add Watch: (variable name). This could be very useful for 
debugging purposes. Then again in Python it is quite common to debug code using ' Print' 
statements so go w!th your preference. 

A free IDE popular in the Python world is Python Win. Some individuals prefer this to 
IDLE. Another popular text editor is TextPad, which is quite similar to Notepad++. 
However this is not currently free but I believe you can try a fully functional evaluation 
version. A Google search will reveal many more options. 
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. 
6.6 

. . 
You wi1l be relying heavily on replay files or macros when writing scripts, and you now 
understand how these work. Hopefully you've also decided on an IDE or text editor to 
use for subsequent examples. 

You now have a basic knowledge of the Python programming language and an 
understanding of how to write scripts for Abaqus. You also know about replay files and 
macros. lt is time to proceed to Part 2 of this book. 



PART 2- LEARN BY 
EXAMPLE 

We shall now begin scripting in earnest. Every chapter in Part 2 is made up of one 
example. Each example introduces new topics and concepts. The first few 
examples/chapters create simple single run simulations. Subsequent chapters delve into 
topics of optimization, parameterization, output database processing and job monitoring. 

For each example, the steps to perform the study in Abaqus/CAE are described. This is to 
ensure that you know how to run the simulation in the GUJ before you script it. Instead of 
reading the procedure you may watch the videos on the book website. Following the 
CAE procedure is the corresponding script, and line-by-line explanation. 

You don't necessarily need to read all of these chapters. However each of them 
demonstrates different tasks and if something is repeated the previous occurrence will be 
referenced. It might help to skim through each example and form a general idea of what 
each script does, so that you know where to find reusable code when writing your own 
scripts. 
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Static Analysis of a Loaded Truss 

~f, ·· iDrt-oailction"'"!'i}~~7'' '~:~--:· 
' . .. . ......,.__ ----

In this chapter we will write a script to perform a sgttic analysis on a truss. The problem 
is displayed in the· figure. One end of the truss is fixed to a wall while the other end is 
free. Concentrated forces of 3000 N, 5000 Nand 6000 N are applied to the nodes of the 
truss in the - Y direction. 

3000 N 5000 N 6000 N 

(o, o) (2, o) l (4, o) l (6. o)l 
~~~------~~--------~--------~ 

(0, -1.5) (2, -1.5) (4, -1.5) 

2.0 2.0 2.0 

1.5 

(Dimensions are in meters) 
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In this example the following tasks will be demonstrated first using Abaqus/CAE, and 
then using a Python script. 

• Create a part 

• Assign materials 

• Assign sections 

• Create an Assembly 

• Create a static, general step 
• Request field outputs 

• Assign loads 
• Assign boundary conditions 

• Create a mesh 

• Create and submit a job 

• Plot overlaid deformed and undeformed results and display node 
numbers on plot 

• Plot field outputs 

The new topics covered are: 

• Model I Preprocessing 
o Work in 20 
o Create wire features 

o Create sections of type 'truss' and specify cross sectional areas 
o Use truss elements (with pin joints) 
o Use concentrated force loads 

• Results I Post-processing 
o Allow multiple plot states (both deformed and undeformed plots 

overlaid) 
o Use Common Plot Options -> Show Node Labels 
o Display field output as col or contours 

You can perform the simulation in AbaqusiCAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. 
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1. Rename Model-1 to Truss Structure 
a. Right-click on Model- I in Model Database 
b. Choose Rename .. 
c. Change name to Truss Structure 

2. Create the part 
a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Truss 
c. Set Modeling Space to 2D Planar 
d. Set Type to Deformable 
e. Set Base Feature to Wire 
f. Set Approximate Size to 10 
g. Click OK. You will enter Sketcher mode. 

3. Sketch the truss 
a. Use the Create Lines:Connectedtool to draw the profile of the truss 
b. Split the lines using the Split tool 
c. Use Add Constraints> Equal Length tool to set the lengths of the required 

truss elements to be equal 
d. Use the Add Dimension tool to set the length of the horizontal elements to 2 

m and the length of the vertical elements to 1.5 m. 
e. Click Done to exit the sketcher. 

4. Create the material 
a. Double-click on Materials in the Model Database. Edit Material window is 

displayed 
b. Set Name to AISI 1005 Steel 
c. Select General> Density. Set Mass Density to 7872 (which is 7.872 glee) 
d. Select Mechanical >Elasticity> Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 
5. Assign sections 

a. Double-click on Sections in the Model Database. Create Section window is 
displayed 

b. Set Name to Truss Section 
c. Set Category to Beam 
d. Set Type to Truss 
e. Click Continue •.• The Edit Section window is displayed. 
f. In the Basic tab, set Material to the AISI 1005 Steel which was defined in 

the create material step. 
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g. Set Cross-sectional Area to 3.14E-4 
h. ClickOK. 

6. Assign the section to the truss 
a. Expand the Parts container in the Model Database. Expand the part Truss. 
b. Double-click on Section Assignments 
c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire truss. 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Truss Section. 
g. ClickOK. 
h. Click Done. 

7. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 
b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 
d. Set Parts to Truss 
e. Set Instance Type to Dependent (mesh on part) 
f . ClickOK. 

8. Create Steps 
a. Double-click on Steps in the Model Database. The Create Step window is 

displayed. 
b. Set Name to Loading Step 
c. Set Insert New Step After to Initial 
d. Set Procedure Type to General > Static, General 
e. Click Continue •. The Edit Step window is displayed 
f. In the Basic tab, set Description to Loads are applied to the truss in this 

step. 
g. ClickOK. 

9. Request Field Outputs 
a. Expand the Field Output Requests container in the Model Database. 
b. Right-click on F-Output-1 and choose Rename ... 
c. Change the name to Selected Field Outputs 
d. Double-click on Selected Field Outputs in the Model Database. The Edit 

Field Output Request window is displayed. 
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e. Select the desired variables by checking them off in the Output Variables 
list. The variables we want are S (stress components and invariants), U 
(translations and rotations), RF (reaction forces and moments), and CF 
(concentrated forces and moments). Uncheck the rest. You wil1 notice that 
the text box above the output variable list displays S,U,RF,CF 

f. Click OK. 
10. Assign Loads 

a. Double-click on Loads in the Model Database. The Create Load window is 
displayed 

b. Set Name to Forcel 
c. Set Step to Loading Step 
d. Set Category to Mechanical 
e. Set Type for Selected Step to Concentrated Force 
f. Click Continue .•• 
g. You see the message Select points for the load displayed below the 

view port 
h. Select the upper left node by clicking on it 
1. Click Done. The Edit Load window is displayed 
J· Set CF2 to -3000 to apply a 3000 N force m downward (negative Y) 

direction 
k. Click OK 
I. You will see the force displayed with an arrow in the viewport on the 

selected node 
m. Repeat steps a-1 two more times, once each for the upper middle and upper 

right node. Name the forces Force2 and Force3, and set them to -5000 and -
6000 respectively. 

11. Apply boundary conditions 
a. Double-click on BCs m the Model Database. The Create Boundary 

Condition window is displayed 
b. Set Name to Pint 
c. Set Step to Initial 
d. Set Category to Mechanical 
e. Set Types for Selected Step to Displacement/Rotation 
f. Click Continue ... 
g. You see the message Select regions for tbe boundary condition displayed 

below the viewport 
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h. Select the two nodes on the extreme left. You can press the "Shift" key on 

your keyboard to select both at the same time. 
1. Click Done. The Edit Boundary Condition window is displayed. 

1· Check off Ul and U2. This will create a pin joint which does not allow 
translation but permits rotation. 

k. Click OK. 

12. Create the mesh 
a. Expand the Parts container in the Model Database. 
b. Expand Truss 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 

d. Using the menu bar click on Mesh> Element Type ••• 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select the entire truss. 
g. Click Done. The Element Type window is displayed. 

h. Set Element Library to Standard 

1. Set Geometric Order to Linear 

J. Set Family to Truss 
k. You will notice the message T2D2: A 2-node linear 2-D truss 

I. Click OK 
m. Click Done 

n. Using the menu bar lick on Seed> Edge by Number 

o. You see the message Select the regions to be assigned local seeds displayed 
below the viewport 

p. Click and drag using your mouse to select the entire truss 

q. Click Done. 
r. You see the prompt Number of elements along the edges displayed below 

the viewport. 
s. Set it to 1 and press the "Enter" key on your keyboard 

t. Click Done 

u. Using the menu bar click on Mesh > Part 
v. You see the prompt OK to mesh the part? displayed below the viewport 

w. Click Yes 
13. Create and submit the job 
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a. Double-click on Jobs in the Model Database. The Create Job window is 
displayed 

b. Set Name to TrussAnalysisJob 
c. Set Source to Model 
d. Select Truss Structure (it is the only option displayed) 
e. Click Continue .• The Edit Job window is displayed 
f. Set Description to Analysis of truss under concentrated loads 
g. Set Job Type to Full Analysis. 
h. Leave all other options at defaults 
t. Click OK 
j. Expand theJobs container in the Model Database 
k. Right-click on TrussAnalysisJob and choose Submit. This will run the 

simulation. You will see the following messages in the message window: 
The job input file "TrussAnalysisJob.inp" has been submitted for 
analysis. 

Job TrussAnalysisJob: Analysis Input File Processor completed 
successfully 
Job TrussAnalysisJob: Abaqus/Standard completed successfully 
Job TrussAnalysisJob completed successfully 

14. Plot results deformed and undeforrned 
a. Right-click on TrussAnalysisJob (Completed) m the Model Database. 

Choose Results. The viewport changes to the Visualization module. 
b. In the toolbar click the Plot Undeformed Shape tool. The truss is displayed 

in its undeforrned state. 

c. In the toolbar click the Plot Deformed Shape tool. The truss is displayed in 
its deformed state. 

d. In the toolbar click the Allow Multiple Plot States tool. Then click the Plot 
Undeformed Shape tool. Both undeformed and deformed shapes are now 
visible superimposed on one another. 

e. Click again on the Allow Multiple Plot States tool to disallow this feature. 

Click on Plot Deformed Shape to have the deformed state displayed once 
again in the viewport. 

f. In the toolbar click the Common Options tool. The Common Plot Options 
window is displayed. 

g. In the Labels tab check Show node labels 
h. Click OK. The nodes are now numbered on the truss in the viewport. 
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15. Plot Field Outputs 
a. Using the menu bar click on Result > Field Output •.. The Field Output 

window is displayed. 
b. In the Output Variable list select U which has the description Spatial 

displacement at nodes. ln the Invariant list Magnitude is displayed. In the 
Components list Ul and U2 are displayed 

c. In the Invariant list select Magnitude. Click Apply. You might see the 
Select Plot State window with the message The field output variable has 
been set, but it will not affect the current Display Group instance unless 
a different plot state is selected below. For the Plot state select Contour 
and click OK. 

d. Click OK to close the Field Output window. You notice in the viewport a 
color contour has been applied on the truss with a legend indicating the U 
magnitude. 

e. Once again, using the menu bar click on Result > Field Output. •. The Field 
Output window is displayed. 

f. In the Output Variable list select U which has the description Spatial 
displacement at nodes. 

g. In the Component list select Ul. 
h. Click OK. The visualization updates to display Ul which is displacement in 

the X direction. 

--·~-· ... thD;n $·crj t -. · , ~ ....,. . 
The following Python script replicates the above procedure for the static analysis of the 
truss. You can find it in the source code accompanying the book in truss.py. You can run 
it by opening a new model in Abaqus/CAE (File > New Model database > With 
Standard/Explicit Model) and running it with File > Run Script ••• 
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vif~o,ort:= s·essiop \ . "'' , .. 
'Truss Displacements .at Nodes (Magnitude)') 
• setValues ( d i .spl.ayed@bject=odb_ object) 

!JO~~Y-1~wpor.t . odbDi:splay, \' · 
.setPI'i'lmaryVar'hble(va.ria6lel.abel='U', 

. . . ~:- .ou~I)Utl?osition:;:NOOAL, 
ffQ~ment=(INVARlANT, 

'Magnitude')) 
r. . 

iSI)la:c~nel1tt~;.._l)lL~~!ei,jport"' session \ 
'liruss Di:splacements at Nodes {U1 Component') 

1s~•~a~c:emen1ts .JU13:.\'i.~~pQrt •. setva lues·( dlsplayedOtij e€t:,odb _object) 
"'"''"""'~ ~ odbDisplay \ ' 

Let's go through the entire script, statement by statement, and understand how it works. 

~abaqus i mport * 
I ~rom abaqusconstants import * 
! import regionToolset 

I session. viewports [ ~Viewport :_ __ ~]_· setvalues ( displayedObject=None) 
_] 

These statements are identical to those used in the Cantilever Beam example and were 
explained in section 4.3 .1 on page65 
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' Create tbe mci(lel ':·~: .. ~ ,.._ . ... ...... ~ 
The following code block creates the model 

! # -------- --------------- --- ----- --- - ------- - - - ------------- - -- - ----------
' # create the model 

mdb.models.changeKey(fromName='Model-1', toName='Truss Structure') I trussModel = mdb.models['Truss Structure'] 

These statements rename the model from 'Model- I ' to ' Truss Structure'. They are almost 
identical to those used in the Cantilever Beam example and were explained in section 
4.3.2 on page 67. 

i7~~~ --~reate the ()ilrt 
The following block creates the part 

# - ------ - -------------- ---- --- - -------- ------- - ------------------- -- -- - --
# Create the part 

import sketch 
import part 

trussSketch = trussModel.ConstrainedSketch(name='2D Truss Sketch', sheetSize=19.e) 
trussSketch.Line(pointl=(e, e), point2=(2, e)) 
trussSketch.Line(point1=(2, e), point2=(4, e)) 
trussSketch.Line(point1=(4, e), point2=(6, e)) 
trussSketch.Line(pointl=(e, -1.5}, point2=(2,-1. 5)) 
trussSketch.Line(point1=(2, -1.5), point2=(4, -1.5)) 
trussSketch.Line(pointl=(e, -1.5), point2=(2, e)) 
trussSketch.Line(point1=(2, e), point2=(4, -1.5)) I trussSketch . Line(point1=(4, -1.5), point2=(6, e)) 

· trussSketch.Line(point1=(2, e), point2=(2, -1.5)) I trussSketch . Line(pointl=(4, e), point2=(4, -1. 5)) 

l
l trussPart = trussModel.Part(name='Truss', dimensionality=TWO_D_PLANAR, 

type=DEFORMABLE_BODY) 
l_!~us_~-~rt. Ba~eW!re ( s~~-!~~~!!:.~-~-~~~-~!~~L---·-······-······----.. ·-·-·- -···--· ............. - .................... - --·---.. ·--·-······-----

import sketch 
import part 

These statements import the sketch and part modules into the script, thus providing 
access to the objects related to sketches and parts. They were explained in section 4.3.3 
on page69. 

trussSketch = trussModel.ConstrainedSketch{name='2D Truss Sketch', sheetSize=l9.9) 
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This statement creates a constrained sketch object by calling the ConstrainedSketchO 
method of the Model object. This was explained in section 4.3.3 on page 69. 

trussSketch.Line(pointl=(e, e), point2=(2, e)) 
trussSketch.Line(point1=(2, e), point2=(4, e)) 
trussSketch.Line(point1=(4, 9), point2=(6, 9)) 
trussSketch.Line(point1=(0, -1.5), point2=(2,-1.5)) 
trussSketch.Line(point1=(2, -1.5), point2=(4,-l.S)) 
trussSketch.Line(point1=(e, -1.5), point2=(2, 9)) 
trussSketch.Line(point1={2, 9), point2=(4, -1.5)) 
trussSketch.Line(point1=(4, -1.5), point2=(6, 9)) 
trussSketch.Line(pointl=(2, e), point2=(2, -1.5)) 
trussSketch . Line(pointl=(4, e), point2=(4, -1.5)) 

The statements use the LineO method of the ConstrainedSketchGeometry object. The 
ConstrainedSketchGeometry object stores the geometry of a sketch, such as lines, 
circles, arcs, and construction lines. The sketch module defines 
ConstrainedSketchGeometry objects. The first parameter pointl is a pair of floats 
specifying the coordinates of the first endpoint of the line. The second parameter point2 
is a pair of floats specifying the coordinates of the second end point. 

trussPart = trussModel . Part(name='Truss', dimensionality=TWO_D_PLANAR, 
type=DEFORMABLE_BODY) 

This statement creates a Part object and places it in the parts repository. The name of the 
part (its key in the repository) is set to 'Truss' and its dimensionality is set to a 
SymbolicConstant TWO_D_PLANAR which defines it to be a 2D part. It is defined to 
be of the type deformable body using the DEFORMABLE_BODY SymbolicConstant. 

trussPart.BaseWire(sketch=trussSketch) 

This statement calls the BaseWireO method which creates a Feature object by creating a 
planar wire from the ConstrainedSketch object trussSketch which is passed to it as an 
argument. Feature objects were explained in section 4.3.3 on page 70. 

The following block of code creates the material for the simulation 

r;-~~ -----------------------------:~---------------------------------------

1 

# Create material 

. import material 

---·---1 
I 
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l# Create material AISI 1905 Steel by assigning -mass density, youngs modulus 

I' # and poissons ratio 

I 
trussMaterial = trussModel.Material(name='AISI 1ees St eel') 
trussMaterial.Density(table=((7872, ), )) : 

L.!!:.~-~-~-~-~.! .. ~.~~-~-:-~!-~~-!~~i!_a._~-~-~-~.t.(~~~~-~-!. ...... ~. : .. ~?J.~ .. J..>. _________________________________________________________________________________________ ________ I 

The statements are almost identical to those used in the Cantilever Beam example and 
were explained in section 4.3.4 on page 71. 

----- -------------------------------------- ----------------------------
reate a section and assign the truss to it 
ort section 

I 
1 trussSection = trussModel .TrussSection(name='Truss Section', 

I material= • AISI 1005 Steel', 

I 

I 

area .. 3.14E-4) 

edges_for_section_assignment = trussPart.edges. findAt( ( (1.e, e.e, e.e), ), 
((3.a, e.e, a.e) , ), 
((s.a, e.e, e.e), ), 
((l.e, -1.5, 0.a)~ ), 
((3.e, -1.5, e.e), ), 
((Le, -e. 75, e.e), ), 
((3 .e, -e. 75~ e.e). ), 
((5.e, -e. 75, e .e). ), 
((2.e, -e. 75, e.e), }, 
((4.0, -0.75, 0.0), )) 

I truss_region = regionToolset.Region{edges=edges_for_section_assignment) I trussPart.SectionAssi~nment(region=t~uss region, sectionNa~e='!russ Secti?n') _____ _j 
import section 

This statement imports the section module making its properties and methods accessible 
to the script. 

trussSection = trussModel.TrussSection(name='Truss section·~ 
material='AISI 1995 Steel', 
area=3.14E-4) 

This statement creates a TrussSection object using the TrussSectionO method. The 
TrussSection object is derived from the Section object which is defined in the section 
module. The first parameter given to the method is a String for the name, which is used 
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as the repository key. The second parameter is the material, which has been defined. Note 
that this material parameter must be a String, it cannot be a material object. That means 
we cannot say material=trussMaterial even though we had defined the trussMaterial 
variable earlier. 'AISII005 Steel' on the other hand is a String, and it is the key assigned 
to that material in the materials repository. The third argument, area, is an optional one. 
It is a Float specifYing the cross-sectional area of the truss members. Since our truss 
members have a radius of 1 cm (or 0.01 m), their cross-sectional area is 0.0003 I 4m2

• 

edges_for_section_assignment = trussPart.edges.findAt(({1.9, 0.9, 9.0), ), 
((3.9, 9.9, 9.9), ), 
((5.9, 0.0, 0.e), ), 
({1.9, -1.5, e.e), ), 
((3 .e, -1.5, e.e), ), 
((1.9, -9.75, e.e), ), 
{{3.9, -9.75, e.e), ), 
{{5.e, -9.75, e.e), ), 
((2.e, -9.75, e.e), ), 
((4.9, -9.75, e.e), )) 

This statement uses the tindAtO method to find any objects in the EdgeArray (basica11y 
edges) at the specified points or at a distance of less than I E-6 from them. trussPart is 
the part, trussPart.edges exposes the EdgeArray, and trussPart.edges.findAt() finds 
the edge in the EdgeArray. 

The coordinates used were obtained by drawing a rough sketch and determining the 
midpoints of each ofthe truss members. They are displayed in the figure below. Note that 
the Z coordinate was added when using the findAtO method. Being a 20 object the Z 
coordinate is 0.0 for all points. 

3000 N 5000 N 6000 N 

(0, 0) (2, 0) ! (4, 0) 1 (6, 0) 1 
[>LS.--11.o)~.o1 <s.o7 

(1, -0.75) (2, .Q.75) (3, -0.75) {4, -0.75) (5, -0.75) 

~~.-1.5) I (3.1~ 
(0, ·1.5) {2, -1.5) (4, -1.5) 
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truss_region ; regionToolset.Region(edges=edges_for_section_assignment) 

This statement creates a Region object using the RegionO method. The RegionO method 
has no required arguments, only optional ones such as elements, nodes, vertices, edges, 
faces, cells and a few more listed in the documentation. We use the edges argument, and 
assign it the edges obtained in the previous statement, which are the member elements of 
the truss. 

The Region object itself was discussed in section 4.3.5 of the Cantilever Beam example 
on page 73. Note how the method used to create the region in this example is different 
from that used in the Cantilever Beam example. With the beam, a 30 object, we created 
beam_region with the statement beam_region=(beamPart.ce/ls,) With the truss, a 20 
planar object, we instead use the RegionO method and passing the edges as arguments. 

trussPart.SectionAssignment(region=truss_region~ sectionName='Truss Section') 

This statement creates a SectionAssignment object using the SectionAssignmentO 
method. It is almost identical to the one used in the Cantilever Beam example, section 
4.3.5 on page 73.The first parameter is the Region object created in the previous 
statement, and the second parameter is the name we wish to give the section, which is 
also its key in the sections repository. 

I# --- --- ------ -------- -- -~ - ~ ----------------- ~-=-=·:::-:--=-::-:.~~=-=~---- -- -- --= -- --I # Create the assembly 
I I import assembly 

j # create the part instance 
1 trussAssembly = trussModel.rootAssembly 
i trusslnstance = trussAssembly.Instance(name='Truss Instance', part=trussPart, I dependent=ON) 

These statements are almost identical to the ones used in the CantiJever Beam example. If 
you wish to refer back, they are explained in section 4.3.6 on page 74. 

. '"1 
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The following block creates the steps 

lr-#-~~-~-:_--:_··~-~.::-=-=-::-~-:.-=-~~~-=-=-~-~-~-=~-::-~·==-~-=-~-=-~··~-==·=-~-==·=-=-=-~-=-==-==-~-::--:.-:.~=-~--=-::.-:.-:=-.:-~=-~-=-=-----·-------·-·--1 
, I 
j # Create the step I 
i import step 1

1 

I # Create a static general step 
11 j trussModel.StaticStep(name='Loading Step', previous='Initial', 

'--·--------·--·-·----·----·-----~esc r~_e_!_~~!::~.:..':~.~~~~.re aP_pl_ie~~~ th~ tr~:;~ in _.!~~--~!_~p_'_) ___ _I 

These statements are also the same as the ones used in the Cantilever Beam example. 
You may refer back to them in section 4.3.7 on page 75. 

The fol1owing block creates the field output requests 

ro--···-····--······--·····--·----·--- --·-··-······--··--.... --······--···--· .. ····--···-····-···--------··-------·-·--··--·-----·--·····-··~--·····-··--···----·----····-·--·-·-··--·------------·-·--·-·-···--·---, 

i # -------------------------- ----- - ---- ----------------- - ----------- - ---- - -

1 

# Create the field output request 

I
# Change the name of field output request 'F-Output-1' to 'Selected Field outputs' 
trussModel.fieldoutputRequests . changeKey(fromName='F-Output-1', 

, toName='Selected Field outputs') 

I #Since F-Output-1 is applied at the 'Loading Step' step by default, 
i # 'Selected Field Outputs' will be too 
I # We only need to set the required variables 
I trussModel.fieldOutputRequests['Selected Field Outputs' ].setValues(variables=('S', 1 

i 'U' , 'RF', 'CF')) '- -- ------ ---··----------- -""''"" ________ , __ , ______ , _____ ,., ......... , .. _______ ,,_,, ... ,.,_,, __ ,,,,,., ___ , _________ ,, .................... ------ ---------------·-·--·-·J 

You have seen these commands in the Cantilever Beam example> section 4.3.8 on page 
76 .. 

No history output requests were defined in this simulation 

I # ----------------------------------------------------------------------- - 'I 

! # Create the history output request _j 
I # We want the defaults so we'll leave this section bla._n_k _____ _______ _ 
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7 .4.10 Apply loads . 
. ~ w-:e.., 

The following block applies the loads 

# ------------------- - --- - - - ----- - ------------ - --- ------------- - --- - --- - --
# Apply loads 

# Concentrated load of 3009 N on first node 
... 1 vertex_coords_for_first_force = (2.9, 0.0, e.e) 

vertex_for_first_force = trussinstance.vertices \ 

I 
.findAt((vertex_coords_for_first_force,)) 

trussModel.ConcentratedForce(name='Forcel', createStepName='Loading Step', 
, region=(vertex_for_first_force,), cf2=-3000.0, 
I distributionType=UNIFORM) 

~ Concentrated load of seee N on second node 
ertex_coords_for_second_force = (4.0, e.e, 0.9) 
ertex_for_second_force = trussinstance.vertices \ 

.findAt((vertex_coords_for_second_force,)) 
1 trussModel .ConcentratedForce(name='Force2', createStepName='Loading Step', 

region=(vertex_for_second_force,), cf2=-5909.e, 
distributionType=UNIFORM) 

# Concentrated load of 6909 N on third node 
vertex_for_third_force = trussinstance.vertices .findAt(((6.0, 0.0, 0.0),)) 

I 
trussModel.ConcentratedForce(name='Force3', createStepName='loading Step', 

region=(vertex_for_third_force,), cf2=-6009.0, 
I distributionType=UNIFORM) 

vertex_coords_for_first_force = (2.8, e.e, e.e) 

This statement assigns to a variable the coordinates of the node on which the 3000 N 
force is applied. 

vertex for first force = trussinstance.vertices \ 
- - - .findAt((vertex_coords_for_first_force,)) 

This statement uses the findAtO method to find any Vertex object that is at the specified 
coordinates or at a distance of less than I E-6 from them. trusslnstance is the part 
instance in the assembly, trusslnstance.vertices exposes the VertexArray, and 
trusslnstance.vertices.findAtO finds the vertex in the VertexArray. 

trussModel.ConcentratedForce(name='Forcel', createStepName='Loading Step', 
region=(vertex_for_first_force,), cf2=-3889.8, 
distributionType=UNIFORM) 

This statement applies a concentrated force on the selected node. It uses the 
ConcentratedForceO method to create a ConcentratedForce object, which is derived 
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from the Load object. The first argument is the name or repository key for which the 
String ' Force I' is given. The second argument is the name/key of the step in which the 
concentrated force will be applied. The third argument is required to be a Region object. 
However vertex_for_first_force is a Vertex object. So we put it in parenthesis and add a 
comma indicating a sequence, and it becomes a Region object. Hence 
region=(vertexJor _firstJorce,). The forth argument cf2 is the Y-component of the 
force. (cfl is X-component, and cf3 is Z-component). It is set to -3000 with the negative 
sign indicating the force is downward (since +ve y is up). The fifth argument sets the 
distribution type to uniform using the SymbolicConstant UNIFORM. 

The statements 

# Concentrated load of 5999 N on second node 
vertex_coords_for_second_force = (4.9, e.e, e.e) 
vertex_for_second_force = trussinstance.vertices \ 

.findAt((vertex_coords_for_second_force,)) 
trussModel.ConcentratedForce(name='Force2', createStepName•'Loading Step', 

region=(vertex_for_second_force,), cf2=-Seee.e, 
distributionType=UNIFORM) 

# Concentrated load of 6998 N on third node 
vertex_for_third_force = trussinstance.vertices.findAt(((6.9, 9.9, 9.9),)) 
trussModel.ConcentratedForce(name='Force3' , createStepName='Loading Step', 

region=(vertex_for_third_force,), cf2=-6999.9, 
distributionType=UNIFORM) 

are similar to the previous ones. They apply the 5000 N and 6000 N forces on the 
corresponding vertices. 

# ------- -- - - ----------------------------------- --- ------- --------------- -
# Apply boundary conditions 

# Pin left end of upper member 
vertex_coords_for_first_pin = (e.e, e.e, e.e) 
vertex_for_first_pin = trussinstance.vertices \ 

.findAt((vertex_coords_for_first_pin,)) 
trussModel.DisplacementBC(name='Pinl', createStepName='Initial', 

region=(vertex_for_first_pin~>~ 
ul=SET, u2=SET~ ur3=UNSET, 
amplitude=UNSET, distributionType=UNIFORM) 
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I # Pin left end of lower member 

1

1 vertex_coords_for_second_pin = (e.e. -1.5, e.e) 
vertex_for_second_pin = trusslnstance. vertices \ 

.findAt((vertex_coords_for_second_pin,)) 
I trussModel.DisplacementBC(name='Pin2', createStepName='Initial', 

region=(vertex_for_second_pin,). 
ul=SET~ u2=SET, ur3=UNSET, 

·--·----·--·-···----·-·-------------~~!'.!_~!~.9.~':'-~~~~!. ... ~-~~!~~~-u-~~~-~2_~~-=~~I F~~-~_L··---·-·---·---·---·-----__1 
vertex_coords_for_first_pin = (9.9, 9.9, e.e) 

This statement assigns the coordinates of the first node to be pinned to a variable. 

vertex_for_first_pin = trusslnstance.vertices \ 
.findAt((vertex_coords_for_first_pin,)) 

This statement uses the findAtO method to find the Vertex object and assign it to a 
variable. 

trussModel.DisplacementBC{name='Pinl', createStepName='Initial', 
region=(vertex_for_first_pin,), 
ul=SET, u2=SET, ur3=UNSET, 
amplitude=UNSET, distributionType=UNIFORM) 

This statement creates a DisplacementBC object which stores the data for a 
displacement/rotation. The DisplacementBC object is derived from the 
BoundaryCondition object. The first required argument is a String for the name. The 
second is the name/key of the step in which the boundary condition is to be applied. In 
this case we apply it to the ' Initial' step. The third argument must be a Region object. 
Once again we convert the Vertex object vertex_for_first_pin into a Region object by 
adding the parenthesis and a comma. The remaining arguments are optional. Note 
however that even though ul, u2, uJ, url, ur2 and urJ are optional arguments, at least 
one of them must be specified. For ul and u2 we use the SymbolicConstant SET thus 
preventing translation in the 1 and 2 directions (a.k.a. X and Y directions). For uJ we use 
the SymbolicConstant UNSET which is self-explanatory, and is the default value. url, 
ur2 and urJ are not specified, and will default to UNSET. Since no amplitude is used, it 
is set to UNSET and the distributionType is once again set to UNIFORM ensuring a 
uniform special distribution of the boundary condition in the applied region. 

vertex_coords_for_second_pin = (9.9, -1.5, 9.9) 
vertex_for_second_pin = trusslnstance.vertices \ 

.findAt((vertex_coords_for_second_pin,)) 
trussModel.DisplacementBC(name='Pin2', createStepName='Initial', 

region=(vertex_for_second_pin,), 
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ul=SET, u2=SET, ur3=UNSET, 
amplitude=UNSET, distributionType=UNIFORM) 

These statements repeat the process to pin the second node. 

Instead of using two sets of statements to create two boundary conditions, we could 
instead have combined them as 

vertex_coords_for_first_pin = (e.e~ e.e, e.e) 
vertex_coords_for_second_pin = (e .e, -1.5, e.e) 
vertices_for_pins = trussinstance.vertices.findAt((vertex~coords_for_first_pin,), 

(vertex_coords_for_second_pin,)) trussModel.DisplacementBC(name='Pins', createStepName='Initial', 
region=(vertices_for_pins,), 
ul=SET, u2=5ET, ur3=UNSET, amplitude=UNSET, 
distributionType=UNIFORM) 

Which method you choose is a matter of personal preference. 

The following block creates the mesh 

-------------------------------------------, # - ------ --------- -- --- -- --- -- --- - - - ---- - ----------------------- -- --- -- ---# Create the mesh 

I import mesh 

truss_mesh_region = truss_region 
edges_for_meshing = edges_for_section_assignment 

mesh_element_type=mesh.ElemType(elemCode=T2D2, elemlibrary=STANDARD) 
trussPart.setElementType(regions=truss_mesh_region, 

elemTypes=(mesh_element_type, )) 
trussPart.seedEdgeByNumber(edges=edges_for_meshing, number=!) 
trussPart.generateMesh( ) ___;_; __ ----·--- -------
import mesh 

This statement makes the methods and attributes of the mesh module available to the 
script. 

truss_mesh_region = truss_region 

We have already created a Region object of the truss earlier in our script. It is stored in 
the variable truss_region. We are storing a copy of it in a new variable 
truss_mesb_region which will be used in a subsequent statement. 
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edges_for_meshing = edges_for_section_assignment 

We have also already identified and stored the edges (members) of the truss earlier in our 
script in the cdges_for_sectioo_assigoment variable. We are now storing a copy of it in 
a new variable edges_for_mesbiog which will be used in a subsequent statement. 

mesh_element_type=mesh.ElemType(elemCode=T2D2, elemlibrary=STANDARD) 

This statement creates an ElernentType object using the ElemTypeO method. This 
method was described in the Cantilever Beam example, section 4.3 .12, page 85. 

trussPart.setElementType(regions=truss_mesh_region, 
elemTypes=(mesh_element_type, )) 

This statement uses the setEiementTypeO method to set the element type of the mesh. It 
requires the regions to mesh to be provided as one of the parameters. The 
truss_mesb_region variable is used here. In addition it requires a sequence of Elem 
Type objects, hence we use mesb_elemeot_type, and use parenthesis and a comma to 
convert it to a sequence. 

trussPart.seedEdgeByNumber(edges=edges_for_meshing, number=l) 

This statement uses the seedEdgeByNumberO method to seed the given edges uniformly 
based on the number of elements along the edges. The first parameter required is a 
sequence of Edge objects, which we have stored in the edges_for_meshiog variable. The 
second required parameter is an integer specifYing the number of elements along each 
edge. We set this to I. Of course this is a very coarse mesh and therefore not a very 
accurate simulation, but this example is for demonstration purposes. Feel free to refine 
the mesh as an exercise. 

trussPart.generateMesh() 

This statement uses the generateMeshO method to generate the mesh on the truss. The 
generateMesbO method is defined in the mesb module which has been imported. 
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r-----------·----·-·--------------- -----. I # - - ------ - - -- -- - ---- - -- --- -- - - ----- - --- --------- -------- - -------- - - - - ----
1 # Create and run the job 

I import job 
I 
I # Create the job 
I mdb.Job(name='TrussAnalysisJob', model='Truss Structure', type=ANALYSIS, 1 

explicitPrecision=SINGLE, nodalOutputPrecision=SI NGLE, 
description='Analysis of truss under concentrated loads', 
parallelizationMethodExplicit=DOMAIN, multiprocessingMode=DEFAULT, 
numDomains=l, userSubroutine=' ', numCpus=l, memory=50, 
memoryUnits=PERCENTAGE, scratch='' , echoPrint=OFF, modelPrint=OFF, 
contactPrint=OFF, historyPrint=OFF) 

# Run the job 

I 

mdb. jobs('TrussAnalysisJob') . submit(cons istencyChecking=OFF ) I 
1 # Do not return control till job is finished running I 
I mdb.jobs['TrussAnalysisJob'].waitForCompletion() 

l.!-~-~~---~f.JU~-_j_~~·-·--···----·-···········--··-···· --------··-···--·····-· ···· ·-----------·--·-----······-·-··· ···--···--------·--------·---------------·--------_..l 
All of this should look familiar to you from the Cantilever Beam example. You may refer 
back to section 4.3. J 3, page 88 for a refresher on these job commands. 

1#=-=-~-=-=-=-·=-~-=-=-=-=-=-=-~-=-=-=-=~-=-~-=·==-=-=~--=-·~=-.:-::-·==-==-=-=-=-=-===-=-=-=·=-~-:-==-=-~--=-=-=---·---~ I # Post processing 

import visualization 

I 1 truss_Odb_Path = 'Tr ussAnalysisJob.odb' 
1 odb_object = session.openOdb(name=truss_Odb_Path) 
I 

session.viewports['Viewport : l'] . setValues(displaye~bject=odb_object) 
session. viewports['Vi ewport: l'].odbDisplay .display~ 

.setValues(plotState={OEFORMED, )) 

You have seen these statements used in the Cantilever Beam example. To refresh your 
memory refer back to section 4.3. 14 on page 89. 
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17.4.15 Plot the deformed state and· modify common OJltions _, ,, - - - --The following post processing block plots the deformed state of the truss and enables 
node and element labels through the common options 

I # Plot the deformed state of the truss 
1 truss_deformed_viewport = session.Viewport(name='Truss in Deformed State') 
I truss_deformed_viewport . setValues(displayedObject=odb_object) 
1 truss_deformed_viewport.odbDisplay.display.setValues(plotState={UNDEFORMED, 
I DEFORMED, )) I 

I truss_deformed_viewport.odbDisplay. commonOptions.setValues(nodelabels=ON) I 
truss_deformed_viewport.odbDisplay.commonOptions.setValues(elemLabels=ON) i truss_deformed_viewport.setValues(origin=(e.e, e.e), width=250, height=160) I 

...._--~---------· -- . - ---·-------------·---------------------
truss_deformed_viewport = session.Viewport(name='Truss in Deformed State') 
truss_deformed_viewport.setValues(displayedObject=odb_object) 

These 2 statements should look familiar to you. The first one creates a new Viewport 
object (a new window on your screen) called 'Truss in Deformed State'. The second 
statement assigns the output database of the simulation to the viewport. 

truss_deformed_viewport.odbDisplay.display.setValues(plotState=(UNDEFORMED, 
DEFORMED, )) 

You have seen the setValuesO method used in the Cantilever Beam example. The 
difference here is that two symbolic keywords UNDEFORMED and DEFORMED have 
been used together. This causes both to be displayed overlaid on one another in the 
viewport window. 

truss_deformed_viewport.odbDisplay.commonoptions.setValues(nodelabels=ON) 

This statement is the equivalent of clicking on the Common Options tool in the viewport 
and checking off ' show node labels'. Notice how we have again used the setValuesO 
method, just as in the last statement, but the arguments supplied to it are very different. 
The parameters of the setValuesO method depend on the context you are using it in. 

truss_deformed_viewport.odbDisplay.commonOptions.setValues(elemlabels=ON) 

This statement is the equivalent of clicking on the Common Options tool in the viewport 
and checking off 'show element labels'. 

truss_deformed_viewport.setValues(origin=(9.9, 0.9), width=259, height=169) 
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Once again we use the setValuesO method on the Viewport object. This time we provide 
3 optional arguments, the origin of the new viewport window, its width and its height. 

j#Plot····th~--~~tpu-t--~~-~'i'~b"i~--u·--( .~p~ti~i·-di~pi~~~;;;~~t·;--·;t·-~~de~-)~·s its Magni t ud~-------l 
! # invariant 
I # This is the equivalent of going to Report > Field Output and choosing to 
i # output U with Invariant: Magnitude 
j truss_displacements_magnitude_viewport= session \ I .Viewport(name='Truss Displacements at Nodes (Magnitude)') 
1 truss_displacements_magnitude_viewport.setValues(displayedObject=odb_object) 
'!' truss_displacements_magnitude_viewport .odbDisplay \ 

.setPrimaryVariable(variableLabel='U ' , i outputPosition=NODAL~ I refinement=(INVARIANT, ; 'Magnitude')) I truss_displacements_magnitude_viewport.odbDisplay.display \ I .setValues(plotState=(CONTOURS_ON_DEF~ )) 
· truss_displacements_magnitude_viewport.setValues(width=250, height=168) 

truss_displacements_magnitude_viewport.offset(20,-10) 

# Plot the output variable u (spatial displacements at nodes) as its Ul component 
# This is the equivalent of going to Report > Field Output and choosing to output 
# U with Component: Ul 
truss_displacements_Ul_viewport= session \ 

.Viewport(name='Truss Displacements at Nodes (Ul Component') 
i truss_displacements_Ul_viewport.setValues(displayedObject=odb_object) 

I truss_displacements_Ul_viewport.odbDisplay \ 
.setPrimaryVariable(variableLabel='U'~ ! outputPosition=NODAL, I refinement=(COMPONENT~ 'Ul')) 

I' truss_displacements_Ul_viewport.odbDisplay.display \ 
, . setValues(plotState=(CONTOURS_ON_DEF, )) I truss_displacements_Ul_viewport.setValues(width=250, height=168) 
! truss_displacements_Ul_viewport.offset(40, -20) 

session.viewports['Viewport: l'].sendToBack() 
----~~------------------------------~ 

truss_displacements_magnitude_viewport= session \ 
.Viewport(name='Truss Displacements at Nodes (Magnitude)') 

truss_displacements_magnitude_viewport.setValues(displayedObject=odb_object) 

You are very familiar by now with the above 2 statements. We are creating a new 
viewport window called 'Truss Displacements at Nodes (Magnitude)' and setting it to 
draw its data from the output database file. 
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truss_displacements_magnitude_viewport.odbDisplay \ 
.setPrimaryVariable(variablelabel='U', 

outputPosition=NODAL, 
refinement=(INVARIANT, 

'Magnitude')) 

The setPrimaryVariableO method is used, which specifies the field output variable for 
which to obtain results from the output database. The first required argument 
variableLabel is a String specifying the field output variable we wish to plot. The second 
required argument, outputPosition requires a SymbolicConstant specifYing the position 
from which to obtain data. One of the possible values is NODAL, which indicates we are 
drawing the data from a node. The documentation lists other possible values. The third 
argument is an optional one called refinement. It is only required if a refinement is 
available for the specified variableLabel, which is the case here. It must be a sequence 
of a SymbolicConstant and a String. We set the SymbolicConstant to INVARIANT and 
the String to 'Magnitude'. 

truss_displacements_magnitude_viewport.odbDisplay.display \ 
.setValues(plotState=(CONTOURS_ON_DEF, )) 

You once again see the setValuesO method being used on the Display object. Previously 
we set the plotState variable to the SymbolicConstants DEFORMED or 
UNDEFORMED (or both). In this situation we are setting the plot state to 
CONTOURS_ON_DEF which tells Abaqus to display the defonned state with a color 
contour of the specified variable/quantity (ie, U) displayed on it. 

truss_displacements_magnitude_viewport.setValues(width=258, height=168) · 

Once again we use the setValuesO method on the viewport and provide the optional 
width and height arguments to set the dimensions of the window. 

truss_displacements_magnitude_viewport.offset(291 -18) 

The offsetO method is used on the viewport to offset the location of this viewport 
window from its current location by the specified X and Y coordinates. The offsets are 
floats specified in millimeters. This is done so that our windows are not one on top of 
another. It is not necessary to do this, it's only done here for aesthetic purposes and to 
demonstrate the offsetO method to you. 

truss_displacements_Ul_viewport= session \ 
.viewport(name='Truss Displacements at Nodes (Ul Component') 

truss_displacements_Ul_viewport.setValues(displayedObject=odb_object) 
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truss_displacements_U1_viewport.odbDisplay \ 
. setPrimaryVariable(variablelabel='U', 

outputPosition=NODAL, 
refinement=(COMPONENT, 'Ul')) 

truss_displacements_U1_viewport.odboisplay.display \ 
.setValues(plotState=(CONTOURS_ON_DEF, )) 

truss_displacements_Ul_viewport.setValues(width=259, height=169) 
truss_displacements_Ul_viewport.offset(49,-29) 

These statements repeat the process except this time the SymbolicConstant is set to 
COMPONENT and the String to ' U 1' in order to display the X component of the 
displacement. Also the window has been offset by a different amount in order to reveal 
the previous two underlying windows. 

session.viewports('Viewport: 1'].sendToBack() 

This statement uses the sendToBackO method to ensure that the default viewport 
window Viewport: J, which is the biggest window since we have not resized it, is behind 
all the newly created ones. In Abaqus 6.10 it is not really necessary since the newer 
windows automatically appear over the older ones but it might be helpful in older or 
newer versions of the software. 

You just performed a 20 static truss analysis using a script. You are now familiar with 
the scripting commands most commonly used with such a simulation. Many of these 
commands will be used again in subsequent examples, just as ones from the Cantilever 
Beam example have been used here. There is no need to memorize these, you can always 
refer back to the examples in this book and copy and paste code suitably modifying it to 
fit your needs. Or you can use the replay file to assist you as well. 
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Loaded Truss 

' U 
In this chapter we will perform a explicit analysis on a truss under dynamic loading. The 
problem is displayed in the figure. It is similar to the static general truss analysis of the 
previous chapter except that there is only one concentrated force and it is applied for 0.0 I 
seconds. 

6000N 

l 
~~.----------~----------~--------~ 

In this exercise the following tasks will be demonstrated, first using the Abaqus/CAE, 
and then using a Python script. 

• Create a part 

• Assign materials 

• Assign sections 

• Create an Assembly 

• IdentifY sets 
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• Create a dynamic, explicit step 

• Request history outputs 

• Assign loads 

• Assign boundary conditions 

• Create a mesh 

• Create and submit a job 

• Retrieve history outputs 

The new topics covered are: 

• Model I Preprocessing 
o Create sets in the assembly 
o Change step time period and tell Abaqus to include non-linear geometry 

effects 
o Use history output requests specifYing the domain and frequency of 

history outputs 
o SpecifY point of application of loads using sets 

• Results I Post-processing 
o Plot history outputs 
-o Save XY data of history output plots 
o Write XY data to a report 
o Display Field Output as color contours 

You can perform the simulation in AbaqusiCAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. Note that much of the procedure is identical to that used to perfonn the static 
analysis of the truss in the previous example. 

I. Rename Model-1 to Truss Structure 
a. Right-click on Model-1 in Model Database 
b. Choose Rename .. 
c. Change name to Truss Structure 

2. Create the part 
a . Double-click on Parts in Model Database. Create Part window is displayed. 



148 Explicit Analysis of a Dynamically Loaded Truss 

b. Set Name to Truss 
c. Set Modeling Space to 2D Planar 
d. Set Type to Deformable 
e. Set Base Feature to Wire 
f. Set Approximate Size to 10 
g. Click OK. You will enter Sketcher mode. 

3. Sketch the truss 
a. Use the Create Lines: Connected tool to draw the profile of the truss 
b. Split the lines using the Split tool 
c. Use Add Constraints> Equal Length tool to set the lengths of the required 

truss elements to be equal 
d. Use the Add Dimension tool to set the length of the horizontal elements to 2 

m and the length of the vertical elements to 1.5 m. 
e. Click Done to exit the sketcher. 

4. Create the material 
a. Double-click on Materials in the Model Database. Edit Material window is 

displayed 
b. Set Name to AISI 1005 Steel 
c. Select General> Density. Set Mass Density to 7872 (which is 7.872 glee) 
d. Select Mechanical> Elasticity> Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 
5. Assign sections 

a. Double-click on Sections in the Model Database. Create Section window is 
displayed 

b. Set Name to Truss Section 
c. Set Category to Beam 
d. Set Type to Truss 
e. Click Continue ••. The Edit Section window is displayed. 
f. In the Basic tab, set Material to the AISI 1005 Steel which was defined in 

the material creation step. 
g. Set Cross-sectional Area to 3.14E-4 
h. Click OK. 

6. Assign the section to the truss 
a. Expand the Parts container in the Model Database. Expand the part Truss. 
b. Double-click on Section Assignments 
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c. You see the message Select the regions to be assigned a section displayed 
below the viewport 

d. Click and drag with the mouse to select the entire truss. 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Truss Section. 
g. Click OK. 
h. Click Done. 

7. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 
b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 
d. Set Parts to Truss 
e. Set Instance Type to Dependent (mesh on part) 
f. Click OK. 

8. Identify Sets 
a. Expand the Assembly container in the Model Database. 
b. Double-click on Sets. The Create Set window is displayed. 
c. Set Name to force point set 
d. Click Continue ... 
e. You see the message Select the geometry for the set displayed below the 

viewport 
f. Select the node on which the force will be applied by clicking on it 
g. Click Done. 
h. Once again double-click on Sets. The Create Set window is displayed. 
1. Set Name to end point set 
J. Click Continue ••• 
k. You see the message Select the geometry for the set displayed below the 

viewport 
1. Select the node on the extreme right 
m. Click Done 

9. Create Steps 
a. Double-click on Steps in the Model Database. The Create Step window is 

displayed. 
b. Set Name to Loading Step 
c. Set Insert New Step After to Initial 
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d. Set Procedure Type to General >Dynamic, Explicit 
e. Click Continue .. The Edit Step window is displayed 
f. In the Basic tab, set Description to Loads are applied to the trussfor O.Ols 

in this step. 
g. Set Time period to 0.01 
h. Click OK. 

I 0. Request History Outputs 
a. Expand the History Output Requests container in the Model Database 
b. Right-click on H-Output-1 and choose Rename ... 
c. Change the name to Force Point Output 
d. Double-click on Force Point Output in the Model Database. The Edit 

History Output Request window is displayed 
e. Set Domain to Set. A new dropdown list appears next to it. 
f. Choose force point set from this list 
g. Set Frequency to Every n time increments. 
h. Set n: to 1 
1. Select the desired variables by checking them off in the Output Variables 

list. The variable we want is UT (translations) from the 
Displacement/Velocity/Acceleration group. Uncheck the rest. You will 
notice that the text box above the output variable list displays UT 

J. Click OK 
k. We need to create the second history output request. Double-click on 

I. 

History Output Requests in the Model Database. The Create History 
window is displayed 
Set Name to End Point Output 

m. Set Step to Loading Step 
n. Click Continue ••. The Edit History Output Request window is displayed 
o. Set Domain to Set. A new dropdown list appears next to it. 
p. Choose end point set from this list. 
q. Set Frequency to Every n time increments 
r. Set n: to 1 
s. Select the desired variables by checking them off in the Output Variables 

list. The variable we want is UT (translations) from the 
Displacement/Velocity/Acceleration group. Uncheck the rest. You will 
notice that the text box above the output variable list displays UT 

t. Click OK 
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11. Assign Loads 
a. Double-click on Loads in the Model Database. The Create Load window is 

displayed 
b. Set Name to ForcePulse 
c. Set Step to Loading Step 
d. Set Category to Mechanical 
e. Set Type for Selected Step to Concentrated Force 
f. Click Continue .•. 
g. You see the message Select points for the load displayed below the 

viewport 
h. We could select the required node by clicking on it. However we have 

already created a set for it. So click on the button Sets at the bottom of the 
viewport. The Region Selection window is displayed 

1. Choose force point set from the list. You may check off Highlight 
selections in viewport if you wish to see the selected node light up 

J. Click Continue •.. The Edit Load window is displayed 
k. Set CF2 to -6000 to apply a 6000 N force in downward (negative Y) 

direction. Notice that Amplitude is set to (Instantaneous) although you 
cannot change it here. 

I. Click OK 
m. You will see the force displayed with an arrow in the viewport on the 

selected node 
12. Apply boundary conditions 

a. Double-click on BCs m the Model Database. The Create Boundary 
Condition window is displayed 

b. Set Name to Pin 
c. Set Step to Initial 
d. Set Category to Mechanical 
e. Set Types for Selected Step to Displacement/Rotation 
f. Click Continue ... 
g. Since you earlier selected vertices in the viewport by clicking the Sets 

button, you will now see the Region Selection window asking you to choose 
the set on which to apply boundary conditions. You also see the message 
Select a region from the dialog at the bottom of the viewport. However we 
do not wish to apply it on either force point set or end point set. Notice also 
the button Select in Viewport at the bottom right of the viewport. Click it. 
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You now see the message Select regions for the boundary condition 
displayed below the viewport 

h. Select the two nodes on the extreme left. You can press the 'Shift' key on 
your keyboard to select both at the same time. 

1. Click Done. The Edit Boundary Condition window is displayed. 
J. Check off Ul and U2. This will create a pin joint which does not allow 

translation but permits rotation. 
k. Click OK. 

13. Create the mesh 
a. Expand the Parts container in the Model Database. 
b. Expand Truss 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 
d. Using the menu bar click on Mesh> Element Type ••• 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select the entire truss. 
g. Click Done. The Element Type window is displayed. 
h. Set Element Library to Standard 
1. Set Geometric Order to Linear 
j. Set Family to Truss 
k. You will notice the message T2D2: A 2-node linear 2-D truss 
I. Click OK 
m. Click Done 
n. Using the menu bar lick on Seed> Edge by Number 
o. You see the message Select the regions to be assigned local seeds displayed 

below the viewport 
p. Click and drag using your mouse to select the entire truss 
q. Click Done. 
r. You see the prompt Number of elements along the edges displayed below 

the viewport. 
s. Set it to 1 and press the 'Enter' key on your keyboard 
t. Click Done 
u. Using the menu bar lick on Mesh >Part 
v. You see the prompt OK to mesh the part? displayed below the viewport 
w. Click Yes 
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14. Create and submit the job 

a. Double-click on Jobs in the Model Database. The Create Job window is 
displayed 

b. Set Name to TrussExplicitAnalysisJob 
c. Set Source to Model 
d. Select Truss Structure (it is the only option displayed) 
e. Click Continue .. The Edit .Job window is displayed 
f . Set Description to Analysis of truss under a pulse load 
g. Set Job Type to Full Analysis. 
h. Leave all other options at defaults 
t. Click OK 

J. Expand the Jobs container in the Model Database 
k. Right-click on TrussExplicitAnalysisJob and choose Submit. This will run 

the simulation. You will see the following messages in the message window: 
The job input file "TrussExplicitAnalysisJob.inp" has been submitted 

for analysis. 
Job TrussExplicitAnalysisJob: Analysis Input File Processor completed 
successfully 
Job TrussExplicitAnalysis.Job: Abaqus/Standard completed successfully 

Job TrussExplicitAnalysis.Job completed successfully 
15. Plot History Outputs 

a. Using the menu bar click on Result >History Output ••. The History Output 
window is displayed. 

b. In the Output Variable list select Spatial displacement: U2 at Node 4 in 
NSET END POINT SET 

c. Click the Plot button. A plot of the vertical displacement of the node at the 
extreme right ofthe truss is displayed in the viewport. 

d. Click the Save As ••• button. The Save XY Data As window is displayed. 
e. Set Name to Data for end point 

f. Click OK 

g. In the Output Variable list select Spatial displacement: U2 at Node 4 in 
NSET FORCE POINT SET 

h. Click the Plot button. A plot of the vertical displacement of the node at 
which the force was applied is displayed in the viewport. 

1. Click the Save As .•• button. The Save XY Data As window is displayed. 
J. Set Name to Data for force point 
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k. Click the Dismiss button 
I. Using the menu bar click on Report>XY ••. The Report XY Data window is 

displayed 
m. In the XY Data tab, make sure Select from: is set to All XY data. Data for 

end point and Data for force point should be displayed in the list. However 
sometimes due to a bug in Abaqus the list may appear empty and needs to be 
refreshed. To remedy this change Select from: to XY plot in current view 
and then back to AU XY data. You should now see our XY data sets in the 
list. 

n. Click Data for end point to make sure it is selected. 
o. Click on the Setup tab. 
p. In the File section, set Name to end_point_xydata_output.txt. 
q. Uncheck Append to file. 
r. In the Data section, for Write: check XY data, Columns totals and 

Column min/max 
s. Switch back to XY Data tab 
t. Make sure Data for end point is selected. 
u. Click Apply. The file end_point_xydata_output.txt will be written to your 

Abaqus working directory. 
v. Click Data for force point to make sure it is selected. 
w. Click on the Setup tab. 
x. In the File section, set Name to force_point_xydata_output.txt. 
y. Uncheck Append to file. 
z. In the Data section, for Write: check XY data, Columns totals and 

Column min/max 
aa. Switch back to XY Data tab 
bb. Make sure Data for end point is selected. 
cc. Click Apply. The file force_point_xydata_output.txt will be written to 

your Abaqus working directory. 
dd. Click Cancel to close the Report XY Data window. 

The following Python script replicates the above procedure for the dynamic explicit 
analysis of the truss. You can find it in the source code accompanying the book in 
truss_dynamic.py. You can run it by opening a new model in Abaqus/CAE (File> New 



8.3 Python Script 155 

Model Database > With Standard/Explicit Model) and running it with File > Run 
Script ... 
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the material, 
explanation. 
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Creati!_(~e 
The new stuff begins in the block for creating sets. 

1::
~-~~~:- - - ------ - - - - -~--------- - ----- ----- - ------------- - - ------ - -
eate sets 

# Create set for load point 
vertex_coords_for_force = (4.0, e.a, e.a) 
vertex_for_force = trusslnstance.vertices . findAt((vertex_coords_for_force,)) 
trussAssembly.Set(vertices=vertex_for_force, name= ' force point set') 

# Create set for end point 
vertex_coords_for_end = trussrnstance.vertices.findAt (((6.e, a.a, e.e),)) 
trussAssembly.Set(vertices=vertex coords for_end, name='end point set') 

The above block creates two sets- one for the node on which the load will be applied, 
and the other for the node furthest away from the wall. 

vertex_coords_for_force = (4 .0, 0.0, 0.9) 

This statement assigns the coordinates of the node on which the force is to be applied to a 
variable for later use 

vertex_for_force = trussinstance.vertices.findAt((vertex_coords_for_force,)) 

This statement uses the findAtO method to find the vertex at the given coordinates (or 
one within IE-6 of it). The Vertex object is then stored in a variable vertex_for_force to 
be used later. 

trussAssembly.Set(vertices=vertex_for_force, name='force point set') 

This statement uses the SetO method to create a Set object in the assembly. Its first 
argument, vertices, is an optional argument. In place of vertices you might have used 
nodes, elements, edges, faces, cells, among other possible arguments (all of which are 
listed in the Abaqus documentation). Since we are using vertices, we provide a Vertex 
object vertex_for_force. The second argument, name, is a required parameter. It is a 
String which is the name of the set and its key in the repository. 

vertex_coords_for_end = trussinstance.vertices.findAt(((6.0, 0.0, 0.0),)) 
trussAssembly.Set(vertices=vertex_coords_for_end, name='end point set') 

These two statements repeat the process for the end point. However a slight change has 
been made to demonstrate another correct form of syntax. Notice that the coordinates are 
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not first assigned to a variable, instead they are typed in directly as arguments to the 
findAtO method. Parenthesis must be included with the coordinates. 

The following block creates the step 

I# ------------------------ -- ----- ------ =~-::.-::-::-::-=-:::.--::-::-:::=~-~-- ------- ------------- -----, I 
I I # Create the step i 

I import step I 
# Create a dynamic explicit step 
trussModel.ExplicitDynamicsStep(name= ' Loading Step', previous='lnitial', 

description='Loads are applied to the truss for e .els in this step', 11 

!.________ timePeriod=e.el) -----------------

import step 

This statement imports the step module so the script can access its methods and 
properties 

trussModel.ExplicitDynamicsStep(name='Loading Step', previous='Initial', 
description='Loads are applied to the truss for e.els in this step', 
timePeriod=e.el) 

This statement creates a dynamic analysis step by creating a ExplicitDynamicsStep 
object using the ExplicitDynamicsStepQ method. The ExplicitDynamicsStep object is 
derived from the AnalysisStep object which in turn is derived from the StepO object. 

The first argument, name, is a required argument. It is a String specifying the repository 
key. The second argument, previous, is also a required parameter. It is a String 
specifying the name of the previous step. The third argument, description, is an optional 
one. It is a String describing what the step does or some other comments the author of the 
script wishes to type in. The fourth argument, timePeriod, is optional. It is a Float 
specifYing the total time period of the step. We set it to 0.01 because we are applying the 
concentrated force in this step, and we only wish it to be applied for 0.01 seconds as a 
pulse. 
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The following code block creates the history output requests 

r--#·-~-= .. =·=-~ .. =·=·-=-:-=·==~=·=-==-=----==--~-==·=-=-=-----~-===·=-=-==·= =··=-==-===-==·=-= ==·=-=-== =-=-=-=-==-=-=-=-=-==-=·=-:-~-~----· .. ···-·-.. ·------------... 1 

I # Create the history output request \ I I 

j force_point_region = trussAssembly.sets['force point set'] I 
I trussModel.historyOutputRequests.changeKey(fromName='H-Output-1', 1 

I toName='Force point output') ! 
i trussModel.historyOutputRequests['Force point output'] \ · 
i .setValues(variables=('UT',), frequency=!, 
I region=force_point_region, sectionPoints=DEFAULT, 
! rebar=EXCLUDE) 

I end_point_region = trussAssembly.sets['end point set'] 

I
' trussModel.HistoryOutputRequest(name='End point output', 

createStepName='Loading Step', 
i variables=('UT',), frequency=l, 
I region=end_point_region, sectionPoints=DEFAULT, 
1_, -----· rebar=EXCLUDE) 

force_point_region = trussAssembly.sets[ ' force point set'] 

This statement assigns the set 'force point set' created previously to a variable. Note that 
this Set object is interchangeable with a Region object. Hence the variable has been 
named force_point_region and it wiJJ be used a few statements later as an argument 
where a Region object is expeccted. 

trussModel.historyOutputRequests.changeKey(fromName='H-Output-1', 
toName='Force point output') 

You've seen the changeKeyO method used previously. Since the default history output 
request is 'H-Output-1 ',we rename it 'Force point output'. 

trussModel.historyOutputRequests['Force point output'] \ 
.setValues(variables=('UT',), frequency=l~ 
region=force_point_region, sectionPoints=DEFAULT, 
rebar=EXCLUDE) 

The setValuesO method is used to tell Abaqus what data is desired in the history output. 
The first argument, variables, is a sequence of Strings indicating which quantities should 
be included in the history output (or the SymbolicConstants PRESELECT or ALL). The 
second argument, frequency, is an integer specifying the output frequency in increments. 
The default is 1. The third argument, region, is a Region object specifying the region 
from which output is requested. The fourth argument sectionPoints is a sequence of 



164 Explicit Analysis of a Dynamically Loaded Truss 

integers specifYing the section points for which output is requested (the default is 
DEFAULT). The fifth argument, rebar, is a SymbolicConstant specifying whether 
output is requested for rebar. The default value is EXCLUDE. 

end_point_region = trussAssembly.sets['end point set'] 
trussModel.HistoryOutputRequest(name='End point output', 

createStepName='Loading Step', 
variables=('UT',), frequency=!, 
region=end_point_region, sectionPoints=DEFAULT, 
rebar=EXCLUDE) 

These statements repeat the process for the end point. 

8.3.5 A~ply loads 
The following block applies the loads 

I # ---------------------------------------------- - - - --- --- --- - - -- - - --------
# Apply loads 

I # Concentrated load of 6eee N on second node 
l 
I # We aleady have the vertex for force from the assembly step so we use that 

trussModel.ConcentratedForce(name='ForcePulse', createStepName='Loading Step', 
region=(vertex_for_force,), cf2=-6eee.e, 
distributionlype=UNIFORM, field='·, localCsys=None) 

trussModel.ConcentratedForce(name='ForcePulse', createStepName='Loading Step', 
region=(vertex_for_~orce,), cf2=-6eee.e, 
distributionType=UNIFORM, field='·, localCsys=None) 

The ConcentratedForce() method is used to apply a force. The syntax is identical to that 
used in the static truss analysis example, which was described in section 7.4.1 0 on page 
136. 

8.3.6 Bound3ry conditious, mesh, niDning the.job •nd -initial ~f;~ roc~~g;...;.:_ 
The blocks dealing with assigning boundary conditions, creating the mesh and creating 
and running the job are the same as those used in the previous example, hence they are 
not reexamined here again. The same is true for the initial post processing operation of 
plotting the deformed state of the truss. 
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The following block generates XY plots ofU2 (displacement in y direction) for the force 
application point and the end point of the truss . 

. 1!···-#·-~··==~-===~-=·=·=·=-~-= ==·= ·=·=·=·=··=·=··=·=·=··=·~·=·-~··=·=·=·=·=·=·=·=··=··~-·~-=·=·=·=··=·-~··= ·=·=-~ -~··=··=··~-·=-~-~··=·=-~-=-==·~-=~·=-~-=·=·=-------·--- - --··-
# Make XV plots of U2 displacement for force point and end point 

i 
I # We need to find the variable names for the history variables 
i # Abaqus tends to give them names like "Spatial displacement: U2 at Node 2 in 
I # NSET FORCE POINT SET" 
: #So basically we will just search for variables with the letters 'U2' in them 
j # and save the variable names in an array called theoutputvariablename to use later 

i 
1 keyarray=session.odbData['TrussExplicitAnalysisJob.odb ' ) . historyvariables.keys() 
I 
I h . [ t eoutputvar1ablename=[] 
J for x in keyarray: 
I if (x.find('U2')>-1): 

theoutputvariablename.append(x) 

# ----------- - ---- ---- -------------
# a) XV plot and data output of U2 displacement for force point 

xydata_force_pt=session.XYDataFromHistory(name = 'Data for force point', 
odb=odb_object, 
outputVariableName=theoutputvariablename[e], 
steps=('Loading Step', ), ) 

curve_force_pt = session.Curve(xyData=xydata_force_pt) 

# Before plotting we make sure the name 'Plot of forcepoint' i s not already in 

I 
I 

# use, and delete it if it is, because Abaqus does not allow overwriting of plots 
if 'Plot of forcepoint' in session.xyPlots.keys(): 

del session.xyPlots['Plot of forcepoint'] 

1 xyplot_force_pt = sess ion . XYPlot('Plot of forcepoint') 
chartName = xyplot_force_pt.charts.keys()[0) 
chart = xyplot_force_pt.charts[chartName] 
chart.set Values(curvesToPlot=(curve_force_pt, ), ) 
xyplot_force_pt_viewport = session \ 

.viewport(name='Displacement U2 plot of force 
xyplot_force_pt_viewport.setValues(displayedObject=xyplot_force_pt) 

, # output the xy data as a txt file 
l xydataobject_force_point = session.xyDataObjects['Data for force point'] 
I session.xyReportOptions.setValues(totals=ON, minMax=ON) 

session.writeXYReport(fileName='force_point _xydat a_output.txt' J 
xyData=(xydataobject_force_pointJ ),appendMode=OFF) 

l 
l # ----- - - -------- - - ----------------
~ XV plot of U2 displacement for end point 

point') 
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xydata_end_pt=session.XYDataFromHistory(name = 'Data for end point'~ 
odb=odb_object, 
outputVariableName=theoutputvariablename[l), 
steps=('Loading Step·~ )~ ) 

curve_end_pt = session.Curve(xyData=xydata_end_pt) 

#Before plotting we make sure the name 'Plot of endpoint' is not already in use, 
# and delete it if it is, because Abaqus does not allow overwriting of plots 
if 'Plot of endpoint' in session.xyPlots.keys(): ' 

del session.xyPlots['Plot of endpoint'] I 
xyplot_end_pt = session.XYPlot('Plot of endpoint') li 

chartName = xyplot_end_pt .charts.keys()[e] ... I chart = xyplot_end_pt.charts[chartName) 
chart.setValues(curvesToPlot=(curve_end_pt, ), ) 
xyplot_end_pt_viewport = session .Viewport(name='Displacement U2 plot of end point') 
xyplot_end_pt_viewport.setValues(displayedObject: xyplot_end_pt) I 
# Output the xy data as a txt file 

1

1 

xydataobject_end_point = session.xyDataObjects['Data for end point'] 
session.xyReportOptions.setvalues(totals=ON, minMax=ON) I 
session.writeXYReport(fileName='end_point_xydata_output.txt', 

ll 

·--------- xyData=(xydataobject_end po~nt, )..!....~ppendMode=OFF) __________ _ 

In our history output requests, we have asked Abaqus to store U2 (displacement in 2-
direction or y-direction) data. Abaqus tends to store all such data in dictionaries. From 
Python I 01, you know that dictionaries are made up of key- value pairs. We will need to 
access the data from the output database, but in order to access the values we need to 
know the keys. The problem is we do not know the name of the keys off hand, so we 
must attempt to determine them. 

keyarray=session.odbData['TrussExplicitAnalysisJob.odb'].historyVariables.keys() 

This first statement accesses the names of all the keys and puts them in a variable 
keyarray which is automatically turned into a list variable. 

theoutputvariablename=[] 

Since we have two history output requests, we can the keys for both of them in an array. 
We therefore initialize the Jist variable tbeoutputvariablename. We could of course 
have created two variables instead, but this technique can also be used if you wished to 
plot multiple history output data, hence it is one you can reuse in your own scripts. 

for x in keyarray: 
if (x.find( ' U2')>-1): 
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theoutputvariablename.append(x) 

When storing the history variables in its repository, Abaqus tends to give them names 
such as "Spatial displacement: U2 at Node 2 in NSET FORCE POINT SET". The node 
number will change with each point (it is 2 in this case), and so will the name of the set. 
Hence instead of trying to determine the entire text of the key, it makes sense to just 
search for keys with "U2" in them. 

We iterate through all the keys which we have stored in the keyarray variable using a 
for-loop. We then use an if-statement to test for the presence ofU2 in the key. For this we 
use the findO method. The findO method operates on Strings. It accepts a subString 
(basically a String) as an argument, and returns the lowest index at which that String is 
found within the original String. If it is not found, it returns -1. Hence our if condition 
tests to see if findO returns anything greater than -1, which would indicate the presence 
of U2 in the key. 

If U2 is present in the key, we store the entire key m the variable 
theoutputvariablename by using the appendO method which adds its argument to the 
end of the list it is operating on. The appendO method was discussed in section 3.4 on 
page 44. 

xydata_force_pt=session.XVDataFromHistory(name = 'Data for force point' , 
odb=odb_object, 
outputVariableName=theoutputvariablename[e], 
steps={'Loading Step', ), ) 

The XYDataFromHistoryQ method creates an XYData object by reading history data 
from an Odb object. The first argument supplied here, name, is optional. It is the 
repository key which will be associated with this XYData object. The second argument, 
odb, is required. lt is an Odb object specifYing the output database from which data will 
be read. The third argument, outputVariableName is a required parameter. It is a Stri.ng, 
and it is the repository key of the output variable from which the X-Y data will be read. 
This is why we had to earlier find the keys of the output variables. Here we use the first 
one, hence the [0]. The fourth argument, steps, is also required. lt is a sequence of Strings 
specifying the names of the steps from which data will be extracted. Since it is a 
sequence, we do not just write ' Loading Step' but instead (' Loading Step',) with 
parenthesis and a comma. 

curve_force_pt = session.Curve(xyData=xydata_force_pt) 
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The CurveO method creates an XYCurve object from an XYData object. We created the 
XYData object in the previous statement, and we now need to make an XYCurve object 
from it which will soon be plotted on a chart. 

if 'Plot of forcepoint' in session .xyPlots.keys() : 
del session.xyPlots['Plot of forcepoint'] 

Our next step is to create an XY Plot. However Abaqus does not allow multiple plots to 
exist with the same name. If the user runs this script twice, one of these may exist from a 
previous run of this simulation. Hence an if-statement is used to check for this. The 
keysO method is used to obtain the keys of plots currently in the session repository with 
the statement session.xyPiots.keysQ. We then search for our plot ' Plot of forcepoint' 
among these keys. Notice the keyword 'in'. This is interesting Python syntax that has 
endeared the language to some programmers. 1t does exactly what the code reads as: look 
to see if' Plot of forcepoint' is among the xyplot keys in the current session. 

If the condition returns true, the xyPiot is promptly deleted using the del keyword. Notice 
the syntax, we refer to the xyplot with session.xyPiots['Plot offorcepoint'] 

xyplot_force_pt = session.XYPlot('Plot of forcepoint') 

The XYPiotO method creates an XYPiot object. The argument is a String specifying the 
name (repository key) of the new XYPlot object. The plot itself is currently blank. 

chartName = xyplot_force_pt.charts.keys()[e] 
chart = xyplot_force_pt.charts[chartName] 

An XYPiot object can consist of multiple charts. Each of these charts will have a name or 
repository key with which one can refer to it through a script. The first one, by default, 
should be 'Chart- I ' . However it is safest to obtain the name programmatically. We use 
the keysQ method to obtain a list of the keys, and since we should only have one chart by 
default we refer to it with the index [0]. Hence the statement 
xyplot_force_pt.cbarts.keysQ[O]. The key is assigned to the chartName variable. This 
variable is then used to assign the chart object to a variable 'chart'. 

chart.setValues(curvesToPlot=(curve_force_pt1 ) 1 ) 

The setValuesO method, when used with the chart object can be used to plot the chart. 
The curvesToPiot argument refers to the curve_force_pt, the curve we had created 
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earlier using the CurveO method. However the argument must be a sequence, hence the 
syntax (curve_force_pt,) 

xyplot_force_pt_viewport = session \ 
.Viewport(name= ' Displacement U2 plot of force point') 

xyplot_force_pt_viewport.setValues(displayedObject=xyplot_force_pt) 

We display the plot in the viewport using the now familiar methods ViewportO and 
setValuesQ. 

We also wish to output the XY data as a text file 

xydataobject_force_point = session.xyDataObjects['Data for force point') 

We earlier created an XYData object with the name 'Data for force point' using the 
XYDataFromHistoryO method. We now assign that object to another variable to make 
our code easier to read. 

session.xyReportOptions.setValues(totals=ON, minMax=ON) 
session.writeXVReport(fileName= ' force_point_xydata_output.txt', 

xyData=(xydataobject_force_point, ),appendMode=OFF) 

An XYReportOptions object stores the setting used by writeXYReportO method. The 
XYReportOptions object did not need to be created by us because Abaqus creates it the 

moment the visualization module is imported. 

The setValuesO method ofthe XYReportOptions object has no required arguments, but 

many options ones. The ones we use are totals, which specifies whether or not column 
totals are output, and minMax, which specifies whether the maximum and minimum 

values are output. Both are set using the boolean ON. The default value for both is OFF. 

The writeXYReportO method writes an XYData object to an ASCII file. The first 
argument, filename, is required. It is a String specifYing the name of the file to which the 
XY data will be written. The second argument, xyData, is also required. It is a sequence 
of XYData objects to be written to the output file. The third argument, appendMode, is 
optional. It accepts a Boolean value, and specifies whether or not the XY data will be 

appended to an existing file or placed in a new file. 
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The entire process is then repeated for the other node of the truss marked as 'end point'. 

xydata_end_pt=session.XYDataFromHistory(name = 'Data for end point'J 
odb=odb_objectJ 
outputVariableName=theoutputvariablename[l], 
steps=('Loading Step', ), ) 

curve_end_pt = session.Curve(xyoata=xydata_end_pt) 

# Before plotting we make sure the name 'Plot of endpoint' is not already in use, 
# and delete it if it isJ because Abaqus does not allow overwriting of plots 
if 'Plot of endpoint' in session.xyPlots.keys(): 

del session.xyPlots['Plot of endpoint'] 

xyplot_end_pt = session.XYPlot('Plot of endpoint') 
chartName = xyplot_end_pt.charts.keys()[8] 
chart = xyplot_end_pt.charts[chartName] 
chart.setValues(curvesToPlot=(curve_end_ptJ ), ) 
xyplot_end_pt_viewport = session.Viewport(name='Displacement U2 plot of end point') 
xyplot_end_pt_viewport.setValues(displayedObject=xyplot_end_pt) 

# Output the xy data as a txt file 
xydataobject_end_point = session.xyDataObjects['Data for end point'] 
session.xyReportOptions.setValues(totals=ON, minMax=DN) 
session.writeXYReport(fileName='end_point_xydata_output.txt'J 

xyoata=(xydataobject_end_point, ),appendMode=OFF) 

Summary 
A few more concepts were covered in this chapter among which are creating sets, and 
post processing methods such as plotting XY data on a chart, and reporting it to an output 
file. We used some interesting tactics to discover the keys of the XY Data and latch onto 
it. These methods will likely be used by you in many scripts in the future. 
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Analysis of a Frame of I-Beams 

In this chapter we will perform an analysis on a frame made up of 1-beams. The structure 
is displayed in the figure. 

The dimensions of the beam frame are displayed in the following figure. All dimensions 

are in meters. In addition the distance between the two frames (ie, the length of the cross 
members) is 1.5 m. 

5.0 s.o 

3.0 

2.0 z.o 
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The beam profile dimensions are displayed in the figure. 

l f.- b2 

+z 
I 

•I 

------rl-.· 
Dimension Frame member Crossbracing member r 1: 0.075 0.06 

h: 0.15 0.12 t2 
bl: 0.12 0.11 

t3 b2: 0.12 0.08 

u tl: 0.02 0.01 t1 
t2: 0.02 0.01 l t3: 0.04 0.02 

lj. bl ., 
We will use both join connectors and constrain equations to create the pin joints between 
the frames and cross members in order to demonstrate how you can use both methods. 

Join 
Connector 

Join 
Connector 

Join 

Connector 

The loads and boundary conditions are displayed in the figure. 

Join 

Conn.ctor 
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In this exercise the following tasks will be performed first using Abaqus/CAE, and then 

using a Python script. 

• Create a part 

• Create and offset datum points and datum planes 

• Assign materials 

• Create profiles 

• Assign sections 

• Set orientation 

• Create an Assembly 

• Create connector sections 

• Perform connector assignments 

• Identify sets 

• Assign constraints with constraint equations 

• Create a step 

• Assign loads 

• Assign boundary conditions 

• Create a mesh 

• Create and submit a job 
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The following new topics are covered in this example: 

• Model I Preprocessing 
o Create a part starting with a reference point 
o Create datum planes and datum lines 
o Create beam elements in 3D using the 'Create Lines: Connected' and 

'Create Wire: Point to Point' tools 
o Create beam sections and define beam profile geometry 
o Orient beams and render the orientations in the viewport 
o Use connectors (wire features+ connector sections) to create joints 
o Use constraint equations to simulate joints 
o Use line loads 

9.2 ProceduO' in Gl:JJ 
------~------·----------=- ' You can perform the simulation in Abaqus/CAE by following the steps listed below. You 

can either read through these, or watch the video demonstrating the process on the book 
website. 

I . Rename Model-1 to Beam Frame 
a. Right-click on Model- I in Model Database 
b. Choose Rename .. 
c. Change name to Beam Frame 

2. Create the frame part 
a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Frame 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature to Point 
f. Set Type to Coordinates 
g. Set Approximate Size to 20 
h. Click Continue •. You see the message Enter the coordinates of the point 

displayed below the viewport 
1. Type in 0.0,0.0,0.0 and hit the "Enter" key on your keyboard. A reference 

point marked with an X and the letters RP appears in the viewport. 
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J. Click on the Create Datum Point: Offset From Point tool in the toolbar. 
You see the message Select a point from which to offset displayed below 
the viewport. 

k. Click on the reference point. You see Offset (X, Y, Z) displayed below the 
viewport. Type in 13.0,0.0,0.0 and hit the "Enter" key on your keyboard. 

l. Click on Auto fit view on the View Manipulation tool bar to see the point 
m. You again see the message Select a point from which to offset displayed 

below the viewport.Again click on the reference point. 
n. You see Offset (X, Y, Z) displayed below the viewport. Type in 4.0,-3.0,0.0 

and hit the "Enter" key on your keyboard. 
o. You again see the message Select a point from which to offset displayed 

below the viewport.Again click on the reference point. 
p. You see Offset (X, Y, Z) displayed below the viewport. Type in 1.0,0.0,0.0 

and hit the "Enter" key on your keyboard. 
q. Click on the Create Datum Plane: 3 Points tool in the toolbar. You see the 

message Select the first point in the datum plane displayed below the 
viewport 

r. Click on the point on the left. You see the message Select the second point 
in the datum plane displayed below the viewport. 

s. Click on the point in the middle which is lower than the other two. You see 
the message Select the third point in the datum plane displayed below the 
viewport. 

t. Click on the point on the right. 
u. Click on Autofit view on the View Manipulation toolbar to see the plane. 
v. Click on the Create Datum Axis: Principal Axis tool in the toolbar. 
w. From the Principal axis choice buttons at the bottom of the viewport cJick on 

Y -Axis. The Y -axis is displayed in the viewport 
x. Click on the Create Wire: Planar tool in the tool bar. You see the message 

Select a plane for the planar wire displayed below the viewport 
y. Click on the edge of the plane in the viewport. You see the message Select 

an edge or axis that will appear vertical and on the right displayed below 
the viewport. 

z. Change the selection in the dropdown list to vertical and on the left 
aa. Click on the datum axis (the Y -axis) in the viewport. You enter the sketcher. 
bb. Use the Create Lines:Connected tool to draw the profile of one frame 
cc. Split the lines using the Split tool 
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dd. Use the Add Dimension tool to set the required dimensions 
ee. Click Done to exit the sketcher 
ff. Click on the Create Datum Plane: Offset from Plane tool in the toolbar. 

You see the message Select a plane from which to offset displayed below 
the viewport 

gg. Click on the plane.You see the message How do you want to specify the 
offset? displayed below the viewport. 

hh. Click on Enter Value 
ii. You see the message Arrow shows the offset direction displayed below the 

viewport. You may wish to use the Rotate View tool from the View 
Manipulation toolbar to rotate the view so you can better see which way the 
arrow is pointed. It should be pointed along the positive Z axis (out of the 
screen, towards you) 

.U· Click OK 
kk. For Offset type in 1.5 and hit the "Enter" key on your keyboard. A second 

plane appears 1.5 m in front of the original. We can now draw the second 
frame on this. 

11. Click on the Create Datum Point: Enter Coordinates tool in the toolbar. 
You see the prompt Coordinates for datum point (X, Y, Z) displayed 
below the viewport 

mm. Type in 1.0,0.0, 1.5 and hit the "Enter" key on your keyboard 
nn. Then type in 13 .0,0.0, 1.5 and hit the "Enter" key on your keyboard 
oo. Then type in 4.0,-3.0, 1.5 and hit the "Enter" key on your keyboard 
pp. Click on the Create Wire: Planar tool in the toolbar. You see the message 

Select a plane for the planar view displayed below the viewport 
qq. Click on the new plane. You see the message Select an edge or axis that 

will appear vertical and on the right displayed below the viewport 
rr. Change the selection in the dropdown I ist to vertical and on the left 
ss. Once again click on the datum axis (the Y-axis) in the viewport. You enter 

the sketcher 
tt. Use the Create Lines:Conoected tool to draw the profile of the second 

frame 
uu. Split the lines using the Split tool 
vv. Use the Add Dimension tool to set the required dimensions 
ww. Click Done to exit the sketcher 

3. Create the cross bracing 
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a. Double-click on Parts in Model Database. Create Part window is displayed 
b. Set Name to CrossBracing 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature to Point 
f. Set Type to Coordinates 
g. Set Approximate Size to 20 
h. Click Continue .. You see the message Enter the coordinates of the point 

displayed below the viewport 
1. Type in 0.0,0.0,0.0 and hit the "Enter" key on your keyboard. A reference 

point marked with an X and the letters RP appears in the viewport 
J. Click on the Create Datum Point: Enter Coordinates tool in the toolbar. 

You see the prompt Coordinates for datum point (X, Y, Z) displayed 
below the viewport 

k. Type in 1.0,0.0,0.0 and hit the "Enter" key on your keyboard 
I. Then type in 1.0,0.0,1.5 and hit the "Enter" key on your keyboard 
m. Repeat for 1.0,0.0,0.0, 1.0,0.0,1.5, 4.0,-3.0,0.0, 4.0,-3.0,1.5, 6.0,0.0,0.0, 

6.0,0.0,1.5, 6.0,-3.0,0.0, 6.0,-3.0,1.5, 8.0,0.0,0.0, 8.0,0.0,1.5, 8.0,-3.0,0.0, 
8.0,-3.0,1.5, 10.0,-3.0,0.0, 10.0,-3.0,1.5, 13.0,0.0,0.0, 13.0,0.0,1.5 

n. Click on the Create Wire: Point to Point tool in the toolbar. TheCreate 
Wire Feature window is displayed 

o. Set Add method to Disjoint wires 
p. Click the Add button 
q. You see the prompt Select the first point displayed below the viewport. You 

can either type in l.O,O.O,O.Oor click on it with the mouse. 
r. You see the prompt Select the second point displayed below the viewport. 

You can either type in 1.0,0.0,1.5 or click on it with the mouse. A line is 
drawn connecting the two points. You are once again prompted to Select the 
first point 

s. Repeat the process till all the cross braces have been drawn 
t. Click Done. All the datum points selected are filled into the table in the 

Create Wire Feature window. 
u. Check Create set of wires 
v. ClickOK. 

4. Create the material 
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a. Double-click on Materials in the Model Database. Edit Material window is 
displayed 

b. Set Name to AISI 1005 Steel 
c. Select General> Density. Set Mass Density to 7872 (which is 7.872 glee) 
d. Select Mechanical > Elasticity > Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 
5. Assign Profiles 

6. 

a. Double-click on Profiles in the Model Database. Create Profile window is 
displayed 

b. Set Name to FrameProfile 
c. Set Shape to I 
d. Click Continue .. 
e. The EditProfile window is displayed 
f. Set I to 0.075 
g. Set h to 0.15 
h. Set b1 to 0.12 
I. Set b2 to 0.12 

J. Set tl to 0.02 
k. Set t2 to 0.02 
I. Set t3 to 0.04 
m. Click OK 

n. Double-click on Profiles in the Model Database. Create Profile window is 
displayed 

o. Set Name to CrossProfile 
p. Set Shape to I 
q. Click Continue •• 
r. The EditProfile window is displayed 
s. Set I to 0.06 

t. Set h to 0.12 

u. Set b1 to 0.11 

V. Set b2 to 0.08 

w. Set t1 to 0.01 

X. Set t2 to 0.01 

y. Set t3 to 0.02 

z. Click OK 
Assign sections 
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a. Double-click on Sections in the Model Database. Create Section window is 
displayed 

b. Set Name to Frame Section 
c. Set Category to Beam 
d. Set Type to Beam 
e. Click Continue ... The Edit Section window is displayed. 
f. Set Section Integration to During Analysis 
g. Set Profile name to FrameProfile which we created earlier 
h. In the Basic tab, set Material to AISI 1005 Steel which was defined in the 

create material step. 
1. LeaveSection Poisson's ratio atthe default ofO 
J. ClickOK. 
k. Again double-click on Sections in the Model Database. Create Section 

window is displayed 
I. Set Name to Cross Section 

· m. Set Category to Beam 
n. Set Type to Beam 
o. Click Continue ..• The Edit Section window is displayed. 
p. Set Section Integration to During Analysis 
q. Set Profile name to CrossProfile which we created earlier 
r. In the Basic tab, set Material to AISI 1005 Steel which was defined in the 

create material step. 
s. Leave Section Poisson's ratio at the default ofO 
t. Click OK 

7. Assign the sections to the frame and cross bracing 
a. Expand the Parts container in the Model Database. Expand the part Frame. 
b. Double-click on Section Assignments 
c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire frame (both sides). 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Frame Section. 
g. ClickOK. 
h. Click Done. 
1. Expand the Parts container m the Model Database. Expand the part 

CrossBracing. 
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J· Double-click on Section Assignments 
k. You see the message Select the regions to be assigned a section displayed 

below the viewport 
I. Click and drag with the mouse to select the entire frame (both sides). 
m. Click Done. The Edit Section Assignment window is displayed. 
n. Set Section to Cross Section. 
o. Click OK. 
p. Click Done. 

8. Define Beam Orientations 
a. Change the Module (displayed above viewport) to Property if it isn't 

already the case using the dropdown menu. 
b. Using the menu bar click on Assign>Beam Section Orientation ..• 
c. You see the message Select the regions to be assigned a beam section 

orientation displayed below the viewport 
d. Click and drag with the mouse to select the entire crossbracing 
e. Click Done. You see the prompt Enter an approximate nl direction 

(tangent vectors are shown) displayed below the viewport. 
f. Type in 1.0,0.0,0.0 and hit the "Enter" key on your keyboard. You notice 

orientation arrows have been displayed in the viewport. You see the prompt 
Click OK to confirm input displayed below the viwport. 

g. Click OK. 
h. By default you may not be able to see how the beams are oriented in the 

viewport. Using the menu bar click on View>Part Display Options. The 
Part Display Options window is displayed. 

1. In the General tab, in the ldealizations section, check Render beam 
profiles. 

j. Click OK. You now see the cross beam profiles rendered in the viewport. 
k. At the top of the viewport, ensure the Module is still set to Property and 

change the Part to Frame . 
I. Using the menu bar click on Assign> Beam Section Orientation .•• 
m. You see the message Select the regions to be assigned a beam section 

orientation displayed below the viewport 
n. Click and drag with the mouse to select the entire frame (both sides) 
o. Click Done. You see the prompt Enter an approximate nl direction 

(tangent vectors are shown) displayed below the viewport. 
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p. Type in 0.0,0.0, 1.0 and hit the "Enter" key on your keyboard. You notice 
orientation arrows have been displayed in the viewport. You see the prompt 
Click OK to confirm input displayed below the viwport. 

q. Click OK 
r. You now see the cross beam profiles rendered in the viewport. You can now 

disable rendering of beam profiles. Using the menu bar click on View>Part 
Display Options. The Part Display Options window is displayed. In the 
General tab, in the ldealizations section, uncheck Render beam profiles. 
Click OK. 

9. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 
b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 
d. Set Parts to Frame 
e. Set Instance Type to Dependent (mesh on part) 
f. Click Apply. The Frame is displayed in the viewport. 
g. Set Parts to CrossBracing 
h. Set Instance Type to Dependent (mesh on part) 
i. Click OK. Now both Frame and CrossBracing are displayed in the viewport. 

Note that they are not actually connected together but only look that way 
since we created the parts in the correct locations. 

J. If you wish to see the rendered beam profiles, using the menu bar click on 
View>Assembly Display Options. The Assembly Display Options window 
is displayed. In the General tab, in the ldealizations section, check Render 
beam profiles. Click OK. Disable the beam profile rendering by repeating 
the process and unchecking Render beam profiles. 

10. Create the connector wires 
a. Change the Module (displayed above viewport) to Interaction if it isn't 

already the case using the dropdown menu 
b. Click on the Create Wire Feature tool in the toolbar. The Create Wire 

Feature window is displayed 
c. Set Add Method to Disjoint wires 
d. Click the Add... button. You see the message Select the first point 

displayed below the viewport. 
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e. Click on the first point. You see the message Select the second point 
displayed below the viewport 

f. Click on the same point again. You again see the message Select the first 
point displayed below the viewport 

g. Repeat the procedure ti11 12 of the 16 nodes are selected. Do not select the 4 
nodes of the second loop as we will demonstrate a different method for these. 

h. Click Done. All the selected points are displayed in the list. 
i. Ensure that Create set of wires is checked 

J. Click OK. 
k. Expand the Assembly container in the Model Database. Expand the Sets 

container. You see Wire-1-Set-1. This is the set of connector wires we have 
just created. Right-mouse-click on it and choose Rename. The Rename Set 
window is displayed 

I. Set the name to Set of connector wires 
m. ClickOK 

I I. Create connector sections 
a. Double-click on Connector Sections in the Model Database. The Create 

Connector Section window is displayed 
b. Set Name to FrameCrossConnSect 
c. Set Connection Category to Basic 
d. For Connection Type set Translation type to Join and leave Rotational 

type at the default of None. You will see Constrained CORM: Ul, U2, U3 
e. Click Continue ••• The Edit Connector Section window is displayed 
f. Leave everything as it is and click OK. 

12. Assign connectors 
a. Expand the Assembly container in the Model Database. Double-click 

Connector Assignment. You see the message Select wires or attachment 
lines to be assigned a section displayed below the viewport 

b. At the right of the message is a button Sets ... Since we earlier assigned the 
connector wires to a set during their creation, we can use this. Click it. The 
Region Selection window is displayed 

c. Choose Set of connector wires from the list. 
d. Click Continue •.• The Edit Connector Section Assignment window 1s 

displayed 
e. Set Section to FrameCrossConnSect 
f. Click OK 
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1 3. Identify Sets for remaining 4 nodes 
a. Expand the Assembly container m the Model Database. Expand the 

Instances container. 
b. Right-click on Frame-1 and choose Suppress. Frame-1 becomes invisible. 
c. Double-click on Sets. The Create Set window is displayed. 
d. Set Name to crossnode1 
e. Click Continue ••• You see the message Select the geometry for the set 

displayed below the viewport 
f. Select one of the upper nodes of the crossbracing which was not used as a 

connector. 
g. Click Done. 
h. Once again double-click on Sets. The Create Set window is displayed. 
1. Set Name to crossnode2 
J· Click Continue ... 
k. Yousee the message Select the geometry for the set displayed below the 

viewport 
I. Select the other upper node of the crossbracing 
m. Click Done 
n. Right-click on Frame-1 and choose Resume. Frame-1 becomes visible 

again 
o. Right-click on CrossBracing-1 and choose Suppress. CrossBracing-1 

becomes invisible 
p. Double-click on Sets. The Create Set window is displayed. 
q. Set Name to framenode1 
r. Click Continue ..• You see the message Select the geometry for the set 

displayed below the viewport 
s. Select the node on the frame which corresponds to crossbracingl 
t. Click Done. 
u. Once again double-cli.ck on Sets. The Create Set window is displayed. 
v. Set Name to framenode2 
w. Click Continue ••• 
x. You see the message Select the geometry for the set displayed below the 

viewport 
y. Select the node on the frame which corresponds to crossbracing2 
z. Click Done 
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aa. Right-click on CrossBracing-1 and choose Resume. CrossBracing-1 
becomes visible again 

14. Create constraints for the 4 nodes 
a. Double-click on Constraints in the Model Database. The Create Constraint 

window is displayed 
b. Set Name to JoinConstraintl 
c. Set Type to Equation 
d. Click Continue ... 
e. The Edit Constraint window is displayed 
f. Set the following values in the table 

Coefficient Set Name DOF CSYS ID 
1 I Crossnodel 1 (global) 
2 -1 Framenodel 1 (global) 

g. Click OK. 
h. Repeat the process to create JoinConstraint2, JoinConstraint3, 

JoinConstraint4, JoinConstraintS and JoinConstraint6 with the following 
values in the respective tables 
JoinConstraint 2 

Coefficient Set Name DOF CSYSID 
1 1 Crossnodel 2 (global) 
2 -1 Framenodel 2 (global) 

JomConstramt3 

Coefficient Set Name DOF CSYS ID 
1 1 Crossnodel 3 (global) 
2 -1 Framenodel 3 (global) 

JoinConstraint4 
Coefficient Set Name DOF CSYS ID 

1 1 Crossnode2 1 (global) 
2 -1 Framenode2 1 (global) 

JoinConstraint5 

Coefficient Set Name DOF CSYSID 
1 1 Crossnode2 2 (global) 
2 -1 Framenode2 2 (global) 

JoinConstraint6 
Coefficient Set Name DOF CSYSID 

1 1 Crossnode2 3 (global) 
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2 -1 Framenode2 3 (global) 

15. Create Steps 

1. Double-click on Steps in the Model Database. The Create Step window is 
displayed. 

J. Set Name to Apply Loads 
k. Set Insert New Step After to Initial 

l. Set Procedure Type to General >Static, General 
m. Click Continue .. The Edit Step window is displayed 
n. In the Basic tab, set Description to Loads are applied in tbis step. 

o. Click OK. 
16. Assign Loads 

a . Double-click on Loads in the Model Database. The Create Load window is 

displayed 

b. Set Name to CrossLoadl 

c. Set Step to Apply Loads 

d. Set Category to Mechanical 

e. Set Type for Selected Step to Line load 

f. Click Continue ••• 
g. The Region Selection window is displayed. You see the message Select a 

region from the dialog displayed below the viewport. However we wish to 
select the elements by clicking in the viewport. Click on Select in Viewport 

h. You see the message Select bodies for tbe load displayed below the 

viewport. Select the crossbar by clicking on it. 
1. Click Done. The EditLoad window is displayed 

J. Set Component 2 to -1000. 
k. ClickOK. 

I. You will see the force displayed with arrows in the viewport on the selected 

cross brace 

m. Repeat the process to create a line load on the adjacent cross bracing. Name 

the load CrossLoad2. 

n. Repeat the process to create a line load on the frontal frame element. Name 
the load FrameLoadl. Set Component 2 to -1500 

o. Repeat the process to create a line load on the frame element diagonally 

across from this one. Name the load FrameLoad2.Set Component 2 to -500 

17. Apply boundary conditions 
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a. Double-click on BCs in the Model Database. The Create Boundary 
Condition window is displayed 

b. Set Name to FixBottom 
c. Set Step to Initial 
d. Set Category to Mechanical 
e. Set Types for Selected Step to Displacement/Rotation 
f Click Continue ... 
g. You see the message Select regions for the boundary condition at the 

bottom of the viewport. Click while pressing the "Shift" key on your 
keyboard to select all the elements (beams) at the base of the structure. 

h. Click Done. The Edit Boundary Condition window is displayed. 
1. Check offUl, U2 and U3. This will pin these beams allowing them to rotate 

but preventing any translational motion. 
J. Click OK. 

18. Create the mesh 

a. Expand the Parts container in the Model Database. 
b. Expand CrossBracing 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 
d. Using the menu bar click on Mesh> Element Type ... 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select all the crossbraces. 
g. Click Done. The Element Type window is displayed. 
h. Set Element Library to Standard 

Set Geometric Order to Linear 
Set Family to Beam 

I. 

J. 
k. You will notice the message B31: A 2-node linear beam in space 
I. Click OK 

m. Click Done 
n. Using the menu bar lick on Seed> Edge by Number 
o. You see the message Select the regions to be assigned local seeds displayed 

below the viewport 
p. Click and drag using your mouse to select all the cross braces 

q. Click Done. 
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r. You see the prompt Number of elements along the edges displayed below 

the viewport. 

s. Set it to 4 and press the "Enter" key on your keyboard 
t. Click Done 
u. Using the menu bar lick on Mesh> Part 
v. You see the prompt OK to mesh the part? displayed below the viewport 
w. Click Yes 
x. Repeat the above process to mesh the frame as well. 

19. Create and submit the job 
a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 

b. Set Name to BeamFrameAnalysisJob 
c. Set Source to Model 
d. Select BeamFrame (it is the only option displayed) 

e. Click Continue •• The Edit Job window is displayed 

f. Set Description to Analysis of loaded beam frame 
g. Set Job Type to Full Analysis. 
h. Leave all other options at defaults 

t. Click OK 
J. Expand the Jobs container in the Model Database 
k. Right-click on BeamFrameAnalysisJob and choose Submit. 
I. It is quite possible that you will get an error message stating that connector 

assignments reference regions are empty or have been deleted or suppressed. 
Click Dismiss 

y. Expand the Assembly container in the model tree. Expand the Features 
container. You will find that Wire-1 has been crossed off. Right click on it 

and select Resume. 
m. Try running the simulation again. This time it will run. You will see the 

following messages in the message window: 

The job input file "BeamFrameAnalysisJob.inp" has been submitted for 
analysis. 
Job BeamFrameAnalysisJob: Analysis Input File Processor completed 
successfully 
Job BeamFrameAnalysisJob: Abaqus/Standard completed successfully 
Job BeamFrameAnalysisJob completed successfully 
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9il 
The following Python script replicates the above procedure for the analysis of the beam 
frame. You can find it in the source code accompanying the book in beamframe.py. You 
can run it by opening a new model in Abaqus (File > New Model Database > With 
Standard/Explicit Model) and running it with File >Run Script ... 

r~· f.f\'om aba-qus' imppf't • ., ~ 
f~om abaqus~onstants ~ort * 

- import regionToolset · 

' . 
# There are 3 items in the datums rePQsitory# the 3 datum· pp~nts that have been 
#created. Extract the keys ,of the datums reposftory# these will be used. to get 
4t· the datum points. The keys will. be .nu~rs b~ might. be_' in~ ~anda· ?"'d~; as · . 
# ~tctio~aries are un~rde~d. · SC?M: ~nem 'to: get "t~~ in asGep~lng ord~'::~t Abaqus~ 
#assigns keys in ascendi~g order ·as a datum pqinf ·is created. once tHe· points ·· 

.# are available a datum plane. 1s created using the 3 points 
framePart_datums_keys = framePart.datums.keys() · 
framePart~4atums_keys. sort.() 
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framePart. DatumPointByCootdtnate ( coords= ( 1. e~ 0. e "· 1.5)) :. 
fra~~~ePart. DatumPointB)'Coo:rdinate ("coords= ( 13. 8, 0:. 0, 1. 5 }-) 
framePart. DatumPointB}ieoor:-dinate ( coords= ( 4. e, -3 .• e, 1. 5 )") . 

framePart.D~tumAxisByTwoPoint(pointl~(e.e,e.e,l.S), 

fr~mePart_skef€h2.Line(po~nti:(1 ·8,e.e), poin~2=(4.9,-3.8) 
. ~ . . ,. -~~ 

. framePart_sketch2.Line(point1=(4.8, -3.9), point2={6.9, -3.0)). ·" 
fraJDePart_sketch2. L1ne(pQ,i:nt1=('6.8,-3 .e), potntz~cs.e; -3·.en · _ 
fraasePart ·sketch2.Line(pointl=(8.0, -3.9), point2:;(l:8.0;;-3.9)} 
framePart:sketch2.Une(pdint1~19.8,-3.8), point2 .. (l3.9:,8.0)). 
framePart_sketchl.L1ne(point1•(la.e,e.e), point2s(S.e,e.0)) · 
f'amePart_sketch2.Line(~int1•(8.0,0.8); point2=(6.0,e.e)) 
framePart_sketch2.L1ne'po~nt~=(6.e,e.e), point2=C1.e,e.e)) 
fr.~art_sketch2.Line(point1=(6.e,0.e), point2=~6.e, -3.0)·) 



9.3 Python Script 191 



192 Analysis of a Frame of 1-Beams 

crossPart. (4.01 

~rossPa~t.DatumPointBycoordiriate(coords=(4.e~ 
crossPart.DatumPointByCoor~inate(coords=(6.0, 
crossPart.DatumPointByC~rdinate(coords=(6.e. 

crossPart_datums_keys = crossPart.datums.keys{) 
crossPart_datums_keys •. sor:t () 

w Create profiles 
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# ----------- - --------------- ----------------- - - -- -- - -- --- --- -- -------~---' # Assign beam orientations · 

framePart.assignBea.SectionOrientation(regi on=frame_region, method=Nl_COSINES~ 
· ' n1=(9.0, 0. 0, 1.0)) 

crossPart.assignBeamSectionOrientation~region=cross_region, method=Nl~COSINES~ 

# 
# Create the assembly 

i mpor t assembly 

J # create the part instance 
··6eamAssemblJy, = beamModel. rootAssembty 

framernstance • beamAssembly.Instance(name='Frame Instance· ~ 

crossinstance = beaiiiAssead>ly. Instance(name='Cross Instance', 

n1=(1.0, 0.0, 8.0)) 

part=fr.amePart, 
dependent=ON) 
part=crossPart, -
depench!nt=ON) 

# --- ------------- ----------- ~ ----------- -- -- -------- - - -- ------ - ----------# Cre~te the wire features 

vertices_for_fra.e_side_l ~ irameinstance.vertices.findAt(((1.0, e.e, e .e),), 
{(4.0, -3~9 .. 9.9),), 
~(6.9, -3.9, 0.0),}, 
~(10.0, -3.~, 9.9),), 
((13.9, 0.0, 9.9),), 
((6.e, 0.0, 9.9),),) 
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# ___ .:, ____ ....., _ ---- - -'- ------------~ - - - - - -·- ~- -- ·-- -- --------~ --- .;: __ ---~------ - - -
# Assign this connector section to the wire features using t~e set ·created earlier · 
conn_wire_reg~on .. beamASsembly. sets [I Set of connector wi.res'] 
bea~sembly.-sectio""ss:ignment(sectionName='FranieCrossconnSect' 1 

region=conn_wire_region) 

# -- -- -- -- ------------------~------------------------- - ----~--- - - ------ - --# Use constraint equations on the ot her t wo nodes. 

# we did not apply the JOIN condi~ion to four of the nodes 
# We will instead use an equation constraint to achieve the same effect on t~~ 
#top two . 
# Ho~ver. we won't use the equatfon constraint on the lowef twa he~ause we are- -
# going to f i x that edge anyway and having an equation constraint as well as a 
# fixed boundary condition might give an error 

#f Filrst we neec.t to assign the nodes, both ·ori the frame par;-t and on t'he crossb~rs, 
# to sets 

vertex_for_framenode_l = framelnstance. vertices.fi ndAt(((s .e, 0.0~ 0.0),),) 
· beamAssembly. set( verti'cl:es•vertex_ for-_ fFamenode_il., n:ame= I ff'amenoi:le!t!-' ) · 
vertex_for_fraaenode_2 • fraaeinstance.vertices.findAt(((S.BJ e.e, 1.5),),) 
beamAssembly.Set(vertices=vertex_for~framenode_2, name=1 framenode2 1

) 

'vertex_for_crossnode_l = c:rossin~tance.vertices.f.tndAt(((B'.e, 8.0,. e.e),),) .. 
bealllAssembly .Set(vertices•ver.teX>:..for _crossnode_l_, name=' erossnodel! I). 
ver.tex_for_crossnode_2 • crossinstance.vertices ~findAt(((8.0, 8.0, 1 5),),) 
beamAssembly.Set(vertices=Verte~~for_crossnode_2, nane='cro~snode2') 

# Create the equation tonstralnt s 
beaiiiMGd.el.Equation(natae• 'Joinconstraint1', terms=((l.0, 'crossnode1', 1), 

(-1.0, 1 fFamenodel ' J 1))) 
beamModel.Equation(n~=~JoinConst~aint2', terms=~(1.0, lcrossnodel·~ 2), 
. , .f-~.9,. 1-ffr.~node:t' :, 2))~ 
6eaiMOdel.Equat1on(name=IJo1nConstralnt3', terms=((1.8, 'crossnOdel ' , 3)~ 

. ( --1.e, lfr:ailenodel'~ 3))) 
beamModeii:.Equat1on(naae='Joi.nConstraint4', .terms={(l.e, 'cr:ossnode'2', 1)1 . . · ~--:l:.e, 1 framenode2', 1.))) 
beamMOdel. Equation(na~~e• 'lointonstFaintS I, te""s"'e(l .B, •·crossnode2' , 2)', 

(-1.0, 'framenode2~~ 2))) 
bea.todel.Equation(n~"' ' Join£onstraint6', terms={(l.B, •crossnode2'·• 3}', '' 

· , :E- l: .• ~, , 'fF'iimenode2'j 3))) · 

# 
# Creat-e ~he step 

iliPOrt step 
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amplitude=UNSET, distributi9nType=UNIFORM, 
fieldName.=' ', local(sys=Nor1e) 

impol?t mesh 

fraM_mesti_region = frame_ region . . . . .. - .. . . · _· ,, . . . . .·, . 
frame_edges_for _meshing = edges .:_for _frame_sechon_ass~gnment. . 
frame_mesh_element_type=mesh.ElemType{elemCode=B31, elemlibrary=STANDARD) 
framePart. setElementType { regions=frame_mesh_region, · · 

e!l!emTypes=(-t:rame_._me-sh_element_typ~ .. ) ) · 
framePart.seedEdgeByNunbe~(edges=frame~edges_for_meshing, riUmbe~) · 
framePart.generateMesh{) -

cross_mesH_region = cross_region 
cross_edges_for_meshing a edges_for_Gross_section_assignment . 
crqss_mesh_element_type=-esh.ElemType(elemCode=B31~ elemLibrary=~fJNDAR~~ 
crossPart.setElementType(regions=cross_mesh_region, 

. elemTypes=(cross_mesh_element_type, )) 
crossPart.seedEdgeByNumber(edges-cross_edges~for_meshing,. number=4) 
c rossPaFt. generateMesh {) · .. · 

import job 

# create ~he job 
mdb.Job{naMe•'BeamframeAnalysisJob', modelz 'Beam frame', 
explicitPrecision=SINGLE . 

nodalOutputPrecision=SINGLE, ·description='' Bending of lo.aded beam frame', 
parallelizationMethodExpllcit~N, multiproeessingMOde=DEFAULT, . 
numDomains~1,· userSubroutine='', numCpus~l, memor-y=~~, memoryunits=PERCENr.AGE~ se Patch=' ' , · · · . . 
echoPrint=oFF, modelPrint=OFF, contactPrint=OFF, historyPrint=6fF) 

# Run the job · ·' 
mdb.jobs['~eamFrameAnalysisJob'].submit{consiste~cyCnecking~FF) 

# · Do r:1at return control till! .jol::iT is 'finished runn:ling . 
mdb.jobs['Bea.FrameAnalysislob']~waitForcompletion() 

# end of run job 
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,.-:--·--······--··----·--··---·--·--····-"-"'"'' __________________ ,,,,,, __________________ ,, .. ,, ... , .. ___ , _______________________________________ ,, ____________ , __ 

.

1 

from abaqus import * 
from abaqusconstants import * 

I import regionToolset 

I session . viewports [ · Viewport: _1' ] • setValues ( displayedObject=None) 

These statements are identical to those used in the Cantilever Beam example and were 

explained in section 4.3.1 on page 65 

The following code block creates the model 

# - -- --------- -- ------------------------- - --- - --- ---- --- ------- --- --------
# Create the model 

mdb.models.changeKey{fromName='Model -1', toName='Beam Frame') 
beamModel = md~_model_~j_~~~-~~fra~_j_ ____ _ 

These statements rename the model from 'Model-1' to 'Beam Frame'. They are almost 

identical to those used in the Cantilever Beam example and were explained in section 

4.3 .2 on page 67. 

~~·~--------~ The following block begins the part creation process. (The majority of the code has been 

removed to save space, only a few comments are included) 

------------·----------------·-·----·----.. ·------·--------------
# --- ----- --- -- --------------------- - --------------------- --------------- -
# Create the parts 

import sketch 
import part 

# - -------- ----------------------- ------ ----------------------------------
# Create the frame 

# -- ----- - - - -------- - - --- - ---- ---------- ---------



200 Analysis of a Frame of 1-Beams 

# a) Create one side of the frame 

# --- - -- --- ---- ---- - -- --- - - ----- ----- - - ------- -- -
# b) Create other side of the frame 

# Make the sketch 

I # use the sketch to create a wire 

l # -- ----- ----- - - --- -- ----- - ---------------------- -- --- -

Let's examine the statements. 

import sketch 
import part 

These statements import the sketch and part modules into the script, thus providing 
access to the objects related to sketches and parts. They were explained in section 4.3.3 
on page 69. 

framePart = beamModel.Part(name='Frame', dimensionality=THREE_D, 
type=DEFORMABLE_BODV) 

This statement creates a Part object and places it in the parts repository. The name of 
the part (its key in the repository) is set to ' Frame' and its dimensionality is set to a 
SymbolicConstant THREE_D which defines it to be a 30 part. 1t is defmed to be of the 
type deformable body using the DEFORMABLE_BODY SymbolicConstant. 

framePart.ReferencePoint(point=(9.9, 9.9, 9.9)) 

The ReferencePointO method creates a ReferencePoint object, which is a Feature 
object, at the specified location. The argument point is a required argument. Here we 
specify it using a sequence of three Floats representing the X, Y and Z coordinates. 

the_reference_point = framePart.referencePoints[l) 

The created reference point is automatically assigned the key 'I ' since it is the first point. 
We therefore refer to it using framePartreferencePoints[l) and assign it to the variable 
the_ reference _point for later use. 

framePart.DatumPointByOffset(point=the_reference_point, vector=(13.e,e.e,e.e)) 
framePart.DatumPointByOffset(point=the_reference_point, vector=(4.0,-3.9,0.0)) 
framePart.DatumPointByOffset(point=the_reference_point, vector=(l.e,e.e,e.e)) 
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The DatumPointByOffsetiO method creates DatumPoint objects which are offset from 
the original point (specified by the point argument) by a vector (specified by the vector 
argument). 

framePart_datums_keys = framePart.datums.keys() 
framePart_datums_keys.sort() 
frame_datum_point_l = framePart.datums[framePart_datums_keys[2]] 
frame_datum_point_2 = framePart .datums[framePart_datums_keys[l]] 
frame_datum_point_3 = framePart.datums[framePart_datums_keys[e]] 
framePart.DatumPlaneByThreePoints(pointl=frame_datum_point_l. 

point2=frame_datum_point_2. 
point3=frame_datum_point_3) 

We now wish to assign the 3 DatumPoint objects to variables. All three datum points 
have repository keys which can be used to refer to them. However we do not know what 
key Abaqus has assigned to them. We can access the keys using 
framePart.datums.keysQ. Since dictionaries are stored in any random order, we use the 
sortO command to place them in ascending order. This is possible because Abaqus 
assigns the keys in ascending order as they are created. Once this has been done we can 
refer to the keys using the regular list notation such as framePart_datums_keys[2) . And 
we can use each key to refer to the corresponding datum point such as 
framePart.datums[framePart_datums_keys[2]). Finally we use the 
DatumPlaneByThreePointsQ methods to create a DatumPlane object (which, by the 
way, is a Feature object). Three points are passed as arguments to this method. 

framePart.DatumAxisByPrincipalAxis(principalAxis=YAXIS) 

The DatumAxisByPrincipalAxisQ method creates a DatumAxis object (a Feature 
object) along one of the principal axes. We use the principalAxis argument to specifY 
which axis using XAXIS, YAXIS or ZAXIS SymbolicConstants. 

framePart_datums_keys = framePart.datums.keys() 
framePart_datums_keys.sort() 
index_of_plane = (len(framePart_datums_keys) - 2) 
index_of_axis = (len(framePart_datums_keys) - 1) 
frame_datum_plane = framePart.datums[framePart_datums_keys[index_of_plane]] 
frame_datum_axis = framePart.datums[framePart_datums_keys[index_of_axis]] 

We need to assign the datum plane and the datum axis to variables so that they can be 
used later. Once again we will extract these variables from the datums list using their 
corresponding keys. Since we do not know the keys, we will have to figure them out. We 
sort them in order using the sortO method as done before. Since the datum axis was the 
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last object to be created, its key will be one less than the length of the datums array. And 
the datum plane being the second to last datum object created, its key will be two less 
than the length of the datums array. We use the Python lenQ command to obtain the 
length of a list. 

sketch_transforml = framePart.MakeSketchTransfoNn(sketchPlane=frame_datum_plane, 
sketchUpEdge=frame_datum_axis, sketchPlaneSide=SIDEl, sketchOrientation=LEFT, 

origin=(9.9, 9.9, 9.9)) 

This statement identifies the datum plane we have created as the plane on which the 
frame will be sketched. The MakeSketchTransformO method creates a Transform 
object, which basically represents the transformation from sketch coordinates to part 
coordinates. sketchPiaoe is a required argument, and it specifies a datum plane or planar 
face object which will be the sketch plane. sketchUpEdge is an optional argument, an 
Edge or DatumAxis object, which specifies the orientation of the sketch. 
sketchPiaoeSide, an optional parameter, specifies which side of sketchPiaoe the sketch 
will be positioned. This can either be SIDEl or SIDE2. sketchOrieotation, another 
optional parameter, specifies the orientation of sketchUpEdge on the sketch. Possible 
SymbolicConstant values are TOP, BOTTOM, LEFf and RIGHT. origin is also an 
optional argument. lt is a sequence of floats specifYing the coordinates of the point that 
will be the origin of the sketch. 

framePart_sketch = mdb.models['Beam Frame'] \ 
.ConstrainedSketch(name='frame sketch 1', 

sheetSize=29, 
gridSpacing=l, 
transform=sketch_transforml) 

This statement creates a CoostrainedSketch object by ca11ing the ConstrainedSketchQ 
method of the Model object. This was explained in section 4.3.3on page 69. 

framePart_sketch.Line(pointl=(l.e,e.e), point2=(4.9,-3.9)) 
framePart_sketch.line(point1=(4.9,-3.8), point2=(6.9,-3.8)) 
framePart_sketch.Line(point1=(6.9,-3.9), point2=(8.0,-3.8)) 
framePart_sketch.Line(point1=(8.8,-3.8), point2={18.9,-3.9)) 
framePart_sketch.Line(point1=(18.9,-3.9), point2=(13.8,9.9)) 
framePart_sketch.Line(point1=(13.8,9.e), point2=(8.0,9.8)) 
framePart_sketch.Line(point1=(8.9,8.9), point2=(6.8,8.9)) 
framePart sketch.Line(point1=(6.9,8.9), point2=(1.e,e.9)) 
framePart=sketch.Line(point1=(6.9,e.e), point2=(6.8,-3.9)) 
framePart_sketch.Line(point1=(8.9,8.9), point2=(B.9,-3.8)) 
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The statements use the LineO method of the ConstrainedSketchGeometry object. The 
ConstrainedSketchGeometry object stores the geometl)' of a sketch, such as lines, 
circles, arcs, and construction lines. The sketch module defines 
ConstrainedSketchGeometry objects. The first parameter pointl is a pair of floats 
specifYing the coordinates of the first endpoint of the line. The second parameter point2 
is a pair of floats specifYing the coordinates of the second endpoint. 

framePart.Wire{sketchPlane=frame_datum_plane3 sketchUpEdge=frame_datum_axis, 
sketchPlaneSide=SIDEl, sketchOrientation=LEFT, 
sketch=framePart_sketch) 

The WireO method creates a Feature object, a planar wire, using a given 
ConstrainedSketch object. There are 4 required arguments. sketchPiane is a datum 
plane object or a face object which specifies the plane on which to sketch. In our case it is 
frame_datum_plane. sketchUpEdge is an Edge object or a DatumAxis object which 
specifies the direction. sketchPianeSide specifies the direction of the feature creation, 
and it can be either SIDEl or SIDE2. sketch is the ConstrainedSketch object. An 
optional argument ts sketcbOrientation which specifies the orientation of 
sketcbUpEdge on the sketch, and it can be TOP, BOTTOM, LEFf or RIGHT. 

# -- - --- - --------- - -- - ---------- - ----------------
# b) Create other side of the frame 

# create a datum plane by offsetting from existing one 
framePart.DatumPlaneByOffset{plane=frame_datum_plane, flip=SIDEl, offset=1.5) 

framePart_datums_keys = framePart . datums.keys() 
framePart_datums_keys.sort() 
index_of_plane2 = (len(framePart_datums_keys) - 1) 
frame_datum_plane2=framePart.datums[framePart_datums_keys[index_of_plane2]] 

framePart.DatumPointByCoordinate(coords=(1 .9, 9.9, 1.5)) 
framePart.DatumPointByCoordinate(coords=(13.9, e.e, 1.5)) 
framePart.DatumPointByCoordinate(coords=(4.9, -3.9, 1.5)) 

framePart.DatumAxisByTwoPoint(pointl=(e.e,e .e,l.S), point2=(9.e,s.eJ1. S)) 

framePart_datums_keys = framePart.datums.keys() 
framePart_datums_keys.sort() 
index_of_axis2 = (len(framePart_datums_keys) -1) 
frame_datum_axis2 = framePart.datums[framePart_datums_keys[index_of_axis2]] 

# Make the sektch 
sketch_transform2 = framePart.MakeSketchTransform(sketchPlane=frame_datum_plane2> 

.. 
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sketchUpEdge=frame_datum_axis2, 
sketchPlaneSide=SIDEl, 
sketchOrientation=LEFT, 
origin=(9.9, 9.9, 1 .5)) 

# ~e could also have used frame_datum_axi s instead of frame_datum_axis2 
# sketch_transform2 = framePart \ 
# .MakeSketchTransform(sketchPlane=frame_datum_plane2, 
# sketchUpEdge=frame_datum_axis2, 
# sketchPlaneSide=SIDEl, 
# sketchOrientation=LEFT, 
# origin=(9.9, 9.9, 1 .5)) 
framePart_sketch2 = mdb.models('Beam Frame ' ] \ 

.ConstrainedSketch(name='frame sketch 2' , 
sheetSize=29, 
gridSpacing=l, 
transform=sketch_transform2) 

framePart_sketch2.Line(pointl=(1.9,9.9), point2={4 .9, -3.9)) 
framePart_sketch2.Line(point1=(4.9,-3.9), point2=(6.9, -3.9)) 
framePart_sketch2 . Li ne(point1=(6.9,-3.9), point2=(8.9, -3.9)) 
framePart_sketch2.Line(point1={8.9,-3.9), point2=(19.9,-3.9)) 
framePart_sketch2.Line(pointl=(19.9,-3.9) , point2=(13.9,9.9)} 
framePart_sketch2.Line(pointl=(13.9,9.9), point2=(8.9,9.9)) 
framePart_sketch2.Line(point1=(8.9,9.9), point2=(6.8,8.8)) 
framePart_sketch2.Line(point1=(6.9,9.9), point2=(1.8,8.9)) 
framePart_sketch2.Line(point1=(6.9,9.9), point2=(6.8,-3.9)) 
framePart_sketch2 . Line(point1=(8.9,8.9), point2=(8.8, -3.8)) 

# Use the sketch to create a wire 
framePart.~ire(sketchPlane=frame_datum_plane2, sketchUpEdge=frame_datum_axis2, 

sketchPlaneSide=SIDE1, sketchOrientation=LEFT, 
sketch=framePart_sketch2) 

The above lines repeat the process in order to create the other frame. Other than the 
location ofthe points there is nothing new in them. 

# -- - ------- --- ------------------------------------------------------ - ----
# Create the cross bracing 

# Start with a 3D Point Deformable Body 
crossPart = beamModel.Part(name='CrossBracing', dimensionality=THREE_D, 

type=DEFORMASLE_BODY) 
crossPart .ReferencePoint(point=(8.9, 8.9, 9.9)) 
Once again the Part() and ReferencePoint() methods are used as was done for the 
frame. 
crossPart .DatumPoi ntByCoordinate(coords=(1.9, 9.9, 9.8)) 
crossPart .DatumPointByCoordinate(coords=(1.8, 8 . 8, 1. 5)) 
crossPart .DatumPointByCoordinate(coords=(4.9, -3.9, 9.8)) 
crossPart .DatumPointByCoordinate(coords=(4.9, -3.9, 1.5)) 
crossPart.DatumPointByCoordinate(coords=(6.8, 8.9, 9.8)} 
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crossPart.DatumPointByCoordinate(coords=(6 .9~ 9.9~ 1.5)) 
crossPart. DatumPointByCoordinate ( coords=( 6. 9 ~ -3·. 9 ~ 9. 9)) 
crossPart.DatumPointByCoordinate(coords=(6.9~ -3.9, 1.5)) 
crossPart.DatumPointByCoordinate(coords=(8.9, 9.9~ 9.9)) 
crossPart.DatumPointByCoordinate(coords=(8.0~ 9.9~ 1.5)) 
crossPart.DatumPointByCoordinate(coords=(8.0~ -3.9, 9.9)) 
crossPart.DatumPointByCoordinate(coords=(8.0~ -3.9~ 1.5)) 
crossPart.DatumPointByCoordinate(coords=(10.0~ -3.9~ 0.9)) 
crossPart.DatumPointByCoordinate(coords=(19.0~ -3.0~ 1.5)) 
crossPart.DatumPointByCoordinate(coords=(13.0~ 0.e~ 9.0)) 

crossPart.DatumPointByCoordinate(coords=(13.0~ e.0~ 1.5)) 

The DatumPointByCoordinateO method creates a DatumPoint object (a Feature 
object) at the coordinates specified by the required coords argument, which is a sequence 
of three Floats specifying the X, Y and Z coordinates. 

crossPart_datums_keys = crossPart.datums.keys() 
crossPart_datums_keys.sort() 

The keys of the datum points are obtained using the keysQ method and assigned to a 
variable. They are then sorted using the sortO method. 

datum_points = crossPart.datums 

The datum points of the cross bracing are all assigned to a variable which can be used in 
the next statement. 

crossPart.WirePolyline(points=((datum_points[crossPart_datums_keys[9]], 
datum_points[crossPart_datums_keys[1]]), 

(datum_points[crossPart_datums_keys[2]], 
datum_points[crossPart_datums_keys[3]]), 
(datum_points[crossPart_datums_keys[4]]~ 
datum_points[crossPart_datums_keys[S]]), 

(datum_points[crossPart_datums_keys[6]], 
datum_points[crossPart_datums_keys[7]]), 
(datum_points[crossPart_datums_keys(B]]~ 
datum_points[crossPart_datums_keys[9]]), 

(datum_points[crossPart_datums_keys[19]], 
datum_points[crossPart_datums_keys[ll]]), 

(datum_points[crossPart_datums_keys[12]], 
datum_points[crossPart_datums_keys[13]]), 

(datum_points[crossPart_datums_keys[14]], 
datum_points[crossPart_datums_keys[15]]))~ 
mergeWire=OFF, meshable=ON) 

The WirePolyLineO method creates a Feature object consisting of wires. The points are 
provided using the points parameter and they are joined together in pairs. When this 
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function is used at the Part level, as is the case here, each point can be a datum point, a 
reference point, a vertex or coordinates of a point. 

9.4.4 Define the materials 
The following block of code creates the material for the simulation 

fit=" . ·------
1 # Cr~~~~-;~~~~~~~--------------------- - ----- ---- -------------------------- I 
I - t t · 1 I 1mpor ma er1a j 

# Create material AISI 1005 Steel by assigning mass density, 
# and poissons ratio 
beamMaterial = beamModel.Material(name='AISI 1005 Steel') 
beamMaterial.Density(table=((7872, ), )) 
beamMaterial . Elastic(table=((200E9, 0 . 29), )) 

youngs modulus 

The statements are identical to those used in the Cantilever Beam example and were 
explained in section 4.3.4 on page 7l. 

The following block creates the beam profiles 

# -- - --- ----- -------- ------------------ -- ---- ------------------------ -----
# Create profiles 

beamModel.IProfile(name='FrameProfile', 1=0.075, h=0.15, b1=0.12, b2=0.12, 
tl=0 .02, t2=0.02, t3=0.94) 

beamModel . IProfile(name='CrossProfile', 1=0.06, h=0.12, b1=0.ll, b2=0.08, 
tl=0.01, t2=0.01, t3=0.02) 

The IProfileO method is used to specify that we have an 1-beam, and to define its 
dimensions. The name parameter gives each profile a key for the repository, and I, h, bl, 
b2, tl, t2 and t3 correspond to the dimensions displayed in the GUl. 

I 



9.4 Examining the Script 207 

Name: Profile-1 

Shape: I 

1: [o.o( I 
h: !o.12 I 
bl: !o.u I 
bl:l£~ 
U: 10.01 ] 

t2: !o.o1 I 
t3: !o.o2 I 

.. PK .I I Ca!J.f.el J 

import section 

frameSection = beamModel.BeamSection(name='Frame Section', profile='FrameProfile', 
integration; DURING_ANALYSIS, 
material='AISI 1005 Steel') 

crossSection = beamModel.BeamSection(name= ' Cross Section', profile='CrossProfile', 
integration; DURING_ANALYSIS, 
material='AISI 1005 Steel') 

edges_for_frame_section_assignment = framePart.edges . findAt(({3 .5, 0.9, 0.0), ), 
({7.0, e.e, e.e), ), 
((10.5, e.e, e.e), ), 
((2.5, -1.s, e . 0), ), 
((5.9, -3 . 0, e .0), ), 
((7 .0, -3.0, e.0), ), 
((9.0, -3 .e, e.0), ), 

I 
{(11.5, -1.5, e.e), }, 

L 
((6.0, -1 . 5, 0.e), ), 
((8.0, -1.5, 0.e), ), 
((3.5, e.e, 1.5), ), 
((7.e, e.e, 1.5), ), 
((10.5, 0.0, L5), ). 
((2.s, -1 . 5, 1.5), L 
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I ((s .e, -3.8, 1.5L L 
1 cc1.0, - 3.0, 1.5), ), 
1 ((9 .8, - 3.0, 1 . 5), ), 

I 

{(11.5, -1.5, 1.5), ). 
((6.0, -1.5, 1.5), ), 
((8 . 0, -1 .5, 1.5), ),) 

j frame_region = regionToolset . Region(edges=edges_for_frame_section_assignment) 
1 framePart.SectionAssignment(region=frame_region, sectionName='Frame Section') 

edges_for_cross_section_assignment = crossPart.edges.findAt(((1.8, 0.0, 0.75}, ), 
{{6.0, 0.e, 0.75), }, 
((8 .0, 0.0, 0.75}, ), 
((13.8, 0 .e, e.7s), ), 
((4.0, - 3.0, 0.75), ), 
((6.0, -3 .0, 0.75), ), 
( ( 8. 0 , -3.0, a. 75), ) , 
((10, -3.0, 0.75), ),) 

I cross_region = regionToolset.Region(edges=edges_for_cross_section_assignment) 
crossPart.SectionAssignment(region=cross_region, sectionName='Cross Section') 

import section 

This statement imports the section module making its properties and methods accessible 
to the script. 

frameSection = beamModel.BeamSection(name='Frame Section', profile='FrameProfile', 
integration=DURING_ANALYSIS, 
material='AISI 1995 Steel') 

crossSection = beamModel .BeamSection(name='Cross Section', profile='CrossProfile', 
integration=DURING_ANALYSIS, 
material='AISI 1995 Steel ' ) 

These statements create BeamSedion objects using the BeamSectionO method. 
BeamSection objects are derived from the Section object which is defined in the section 
module. The first required parameter is name, a String which specifies the repository 
key. The second is profile, which is the name of an already defined beam profile. The 
third is integration which specifies the integration method for the section. The possible 
values are SymbolicConstants DURING_ANALYSIS and BEFORE_ANALYSIS. An 
optional parameter material specifies the name of the material being used. 

edges_for_frame_section_assignment = framePart.edges.findAt{((3.5, 8.0, 0.8), ), 
((7 .0, e.0, 0.e), }, 
((10.5, 0.0, 0.0), ), 
((2.5, -1.s, e.e), ), 
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((s.e~ -3.e, e.e), >~ 
((7.0, -3.0, 0.0), >~ 
((9.9, -3.0, 0.0), ), 
((11.5, -1.5, e.e), ), 
((6.9, -1.s, e.e), ), 
((8.0, -1.s, e.e), ), 
((3.5, e.e, 1.5), ), 
((7.9, 0.0, 1.5), ), 
((19.5, 9.9, 1.5), ), 
((2.5, -1. 5, 1.5), ), 
({5.9, -3.e, 1.5), }, 
{(7.9, -3.9, 1.5), ), 
{(9.8, -3.0, 1.5), ), 
{(11.5, -1.5, 1.5}, ), 
{(6 , 9, -1.5, 1.5), ), 
{{8.0, -1.5, 1.5), ),) 

This statement uses the findAtO method to find any objects in the EdgeArray (basically 
edges) at the specified points or at a distance of less than 1 E-6 from them. framePart is 
the part, framePart.edges exposes the EdgeArray, and framePart.edges.findAtQ finds 
the edge in the EdgeArray. The coordinates used were obtained by drawing a rough 
sketch and determining the midpoints of each ofthe frame members. 

frame_region = regionToolset.Region(edges=edges_for_frame_section_assignment) 

This creates a Region object using the RegionO method. The RegionO method has no 
required arguments, but only optional ones such as elements, nodes, vertices, edges, 
faces, cells and a few more listed in the documentation. We use the edges argument, and 
assign it the edges obtained in the previous statement, which are the member elements of 
the frame. The Region object itself was discussed in section 4.3.5 of the Cantilever Beam 
example on page 73. 

framePart.SectionAssignment(region=frame_region, sectionName='Frame Section') 

This creates a SectionAssignment object using the SectionAssignmentO method. It is 
almost identical to the one used in the Cantilever Beam example, Section 4.3.5 on page 
73. The first parameter is the Region object created in the previous statement, and the 
second parameter is the name we wish to give the section, which is also its key in the 
sections repository. 

edges_for_cross_section_assignment = crossPart.edges.findAt(({1 .0, 9.9, 9.75), ), 
((6.0, 0.0, 9.75), ), 
{(8.0, e.0, 9.75), ), 
((13.9, e.e, e.7s), ), 
((4.9, -3.9, 9 . 75), ), 
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((6.9, -3.9, 9 . 75), ), 
((8.9, -3.9, 9.75), ), 
((19, -3.9, 9.75}, ),) 

cross_region = regionToolset.Region(edges=edges_for_cross_section_assignment) 
crossPart .SectionAssignment(region=cross_region, sectionName= ' Cross Section') 

The process of assigning sections is repeated for the cross bracing. 

9.4. 7 Assign section orientations 
The following block assigns the orientation to the beam sections 

# --------------- - ------- -------------- ---- -------------------- -- ---------
# Assign beam orientations 

framePart.assignBeamSectionOrientation(region=frame_region, method=Nl_COSINES, 
nl=(e. e, e.e, l.e) ) 

crossPart.assignBeamSectionOrientation(region=cross_region, method=Nl_COSINES, 
nl=(l.e, e.e, e.e)) 

The assignBeamSectionOrientationO method assigns a beam section orientation to a 
region of a part. The required argument region specifies the Edge objects. The variable 
frame_region was defined earlier when creating sections. The second required argument 
is method. This specifies the assignment method, and as of this writing the only value 
supported is the SymbolicConstant Nl_COSINES. The third required argument is nl, 
which defines the local n 1 direction of the beam profile using a sequence of three Floats. 

Create an assembly 
The following code block creates the assembly 

r# ------------------------------------------------------------------------
# Create the assembly 

import assembly 

# Create the part instance 
beamAssembly = beamModel.rootAssembly 

frameinstance = beamAssembly.Instance(name= 'Frame Instance' , part~framePart, 
dependent=ON) 

crossinstance = beamAssembly.Instance(name='Cross Instance', part~crossPart, 
dependent=ON) 
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These statements are almost identical to the ones used in the Cantilever Beam example. If 
you wish to refer back to them they are explained in Section 4.3.6 on page 74. 

~~= -=-~--=---=· ~~-~-~-~·=-~·-::~ .~ .. ~-~-= ~·-~ ·=-~~-=·~ ---=·=-~-~-~-= =-·~·-_-::--::-~-= .. ~-~-=-=-~-.:-: -~-=-: -:.-=-=~-=-=-=·~-=-::-:..-=-:.------·-·------· 

I 
# Create the wire features 

vertices_for_frame_side_l = frameinstance.vertices .findAt(((1.8, 8.0, 0.8),) 1 

((4 .0, - 3.0, 0.e),), 
((6 .0, - 3.0, 0.0),), 
((10.0, -3.0, 0.0),). 
((13.e, 0.0, 0.0),). 
((6.0, 0.0, e .a) , ), ) 

vertices_for_frame_side_2 frameinstance.vertices. f indAt(((1.0, 0.0, 1. 5),), 
((4. 0, -3.0, 1.5),), 
((6.0, -3.0, 1.5),) , 
((10.0, -3.0, 1. 5},), 
((13.0, e.e, 1.5),), 
((6.0, 0.a, 1.5},),) 

vertices_for_crossbars_side_1 = crossinstance.vertices . findAt(((1.0, 0.0, 0.0),), 
((4.0, -3.0, e.0),), 
((6 . e, - 3 .. 0, e.e) , ) , 
((10.0, -3.0, 0.0),). 
((13.0, a.0, 0.0),), 
((6.0, 0.0, 0.0) , ),) 

vertices_for_crossbars_side_2 = crossinstance .vertices.findAt(((l . 0, 0 .0, 1.5),), 
((4 .0, - 3.0, 1. 5),). 
((6.0, - 3.0, 1.5),), 
((10.0, - 3.0, 1.5),), 
((13.e, 0.0, 1.s) , ), 
((6 .0, 0 .0, 1.5) , ),) 

# We need to create the connectors using these points 
# The format of the WirePolyLine function is WirePolyLine(points=((v1[1] , v2[1]), 
# (v1[2], v2[2]), mergeWire=OFF, meshable=OFF) 
# Notice that the points argument is a tuple of point pairs, in other words a 
# tuple of tuples 
# we first create the tuples of the point pairs specifying the individual 
# connections such as (v1[1], v2[1]) and put them in a list and then create 
# a tuple of those tuples from that list using the "tuple()" function 

list_of_point_tuples = [] 
for i in range(len(vertices_for_frame_side_l)): 

list of point tuples . append((vertices_ for frame side=1_[:....i....:]c.:..'------------' 
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vertices_for_crossbars_side_l[i])) 
list_of_point_tuples.append((vertices_for_frame_side_2(i], 

vertices_for_crossbars_side_2[i])) 

tuple_of_point_tuples tuple(list_of_point_tuples) 

I beamAssembly.WirePolyline(points=tuple_of_point_tuples, mergeWire=OFF, I meshable=OFF) 

I # ------------------ --- - - -- --- ---------- ------- - - ------ - -- - --------- - -----
~ # Assign these wire features/connectors to a set that can be used later 
I # This is the equivalent of checking off the "Create set of wires" checkbox in 
I # the "Create Wire Feature" window 
I 
I # This of course requires that we first find the edges that are the wire 
I # connectors 
I 
I edges_for_connector_set = beamAssembly.edges.findAt(((1.0, 0.0, 0.0),), 

((4.0, -3 .0, 0.0),), 
((6.0, -3.0, e.e),), 
((10.0, -3.0, 0.0),), 
((13.0, e.e, a.a),), 
((6.9, 9.9, 0.0),), 
((1.9, e.e, 1. 5),), 
((4.9, -3.9, 1.5),), 
((6.0, - 3.9, 1.5),), 
((10.e, -3.e, 1.5),), 
((13.e, e.e, 1.5),), 
((6 .0, 0.0, 1.5),),) 

I # Now assign them to a set I beamAssembly.Set(edges=edges_for_connector_set, name='Set of connector wires') 

! # -------------- - - - - --------------------- - ----------- - -- - -------- --- ------
1 # Create a connector section 

I beamModel.ConnectorSection(name='FrameCrossConnSect', translationalType=JOIN) : 

: ~~~~;~-~~~~-~~~~~~~~~-~~~~i~~-~~-~~~-~~~~-;~~~~~~~ -~~i~;-~~~-~~~-~~~~~~~ earlier ! 
conn_wire_region = beamAssembly.sets['Set of connector wires'] I 
beamAssembly.SectionAssignment(sectionName='FrameCrossConnSect', i 

1 region=conn_wire_region) J 
~~------~H•·----------------------~---------------------------------------------------

vertices_for_frame_side_l = frameinstance.vertices.findAt(((1.9, 9.9, 9.9),), 
((4.9, -3.9, 0.0),), 
((6.9, -3.9, 9.9),), 
((19.9, -3.9, 9.9),), 
((13.9, e.0, e.0),), 
((6.0, 9.0, 9.0),),) 
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The vertices for the wire features need to be found and stored so that they can be used to 
create the wire features. We need the vertices on both the frames, and both sides of the 
cross bracing where it meets each frame. We start by storing the vertices of one frame in 
the variable vertices_for_frame_side_l. The syntax framelnstance.vertices exposes the 
vertices array for framelnstance, and findAtO is used to find the vertices supplied as 
arguments, which are the coordinates for the nodes of the frame. 

vertices_for_frame_side_2 = frameinstance.vertices.findAt(((1 .8, 8.8, 1.5),), 
((4.8, -3.9, 1.5),), 
((6.8, -3.0, 1.5),), 
((19.9, -3.8, 1.5),), 
((13.8, 8.9, 1.5),), 
((6.8, 0.0, 1.5),),) 

vertices_for_crossbars_side_1 = crossinstance.vertices.findAt(((1.9, 9.9, 9.9),}, 
((4.8, -3.9, 9.9),), 
((6.8, -3.9, 9.9),), 
((19.9, -3.9, 8.8),), 
((13.9, 9.9, 9.9),), 
((6.8, 9.9, 9.8),),) 

vertices_for_crossbars_side_2 = crossinstance.vertices.findAt(((1.8, 9.9, 1.5),), 
((4.8, -3.9, 1.5),). 
((6.9, -3.9, 1.5),), 
((18.8, -3.9, 1.5),), 
((13.8, 9.8, 1.5),), 
((6.9, 9.9, 1.5),),) 

Similarly the nodes of the other frame, and those on both sides of the cross bracing are 
found. 

list_of_point_tuples = [] 
fori in range(len(vertices_for_frame_side_1)}: 

list_of_point_tuples.append((vertices_for_frame_side_l[i], 
vertices_for_crossbars_side_1[i])) 

list_of_point_tuples.append((vertices_for_frame_side_2[i], 
vertices_for_crossbars_side_2[i])) 

tuple_of_point_tuples = tuple(list_of_point_tuples) 

beamAssembly.WirePolyline(points=tuple_of_point_tuples, mergeWire=OFF, 
meshable=OFF) 

These statements are best explained together. We are trying to create the tuple which will 
later be passed to the WirePolyLineO function to create the wire features. The 
WirePolyLineQ method expects the argument to be in the format: 



214 Analysis of a Frame of 1-Beams 

WirePolyLine(points=((vl[l], v2[1]), (v1[2], v2[2]), mergeWire=OFF, meshable=OFF) 

Here vi [I] is the first point (a tuple ofx, y, z coordinate for one point). (vI [1 ], v2[1]) is a 
tup1e of two such tuples- the two points which will have a wire feature between them. 
And ((v 1 [1], v2[1 ]),(vi [2], v2[2]))is a tuple of these tuples. So we need to put our points 

in this format. 

The for-loop allows us to do this. It loops from 0 to one less than the number of 
coordinates which .is obtained using the lenO function. In each iteration it appends to a 
list called list_of_point_tuples a new tuple consisting of start and end coordinates of a 
wire feature. In fact it does this twice at each iteration, one for each side of the cross 
bracing. 

Once this list has been created, it is converted into a tuple using Python's tupleO function 
which can take a sequence or list and convert it into a tuple. 

This tuple can then be used as the points argument for the WirePolyLineO method. The 
WirePolyLineO method creates Feature objects by creating a series of wires joining 

points provided in pairs. When this method is used at the Assembly level, the points 
provided must be vertices, reference points or ophan mesh nodes. We have provided 
vertices in our script. The only required argument is points, which as stated before is a 
tuple of point pairs, where each pair is a tuple. The other 2 arguments supplied are 
optional. merge Wire specifies whether to merge the wire with existing geometry such as 
faces and solid regions, and the default is ON. We do not wish for the connecting wires to 
be merged into the parts hence we set it to OFF. meshable specifies whether the wire can 
be selected in meshing operations and the default value is ON. If we set it to OFF, as we 

have done here, the wire can be used for connector section assignment which is exactly 

what we intend to do with it. 

# --------------------------------------------------------- - --------------
# Assign these wire features/connectors to a set that can be used later 

edges_for_connector_set = beamAssembly.edges.findAt(((1.9, 9.9, 9.9),), 
((4.9, -3.9, 9.9),), 
((6.9, -3.9, 9.9),), 
{(19.9, -3.9, 9.9),), 
((13.9, e.e, e.9),), 
((6.9, 0.0, 9.9),), 
((1.9, 0.e, 1.5),), 
((4.9, -3.9, 1.5),), 
((6.91 -3.9, 1.5)1), 
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((10.9, -3.0, 1.5),), 
({13.9, 9.9, 1.5),), 
((6.9, e.0, 1.5),),) 

beamAssembly.Set(edges=edges_for_connector_set, name='Set of connector wires') 

When creating wire features in Abaqus/CAE, you check off the Create set of wires 

option in the Create Wire Feature window. In the above lines we try to replicate this 

through the script by finding all the edges/wires we just created using 

beamAssembly.edges.findAtQ. We then assign them to a set using the SetO method. 

You have already encountered the SetO method used in section 8.3.2 on page 161. The 

difference in that example was that the Set was created using vertices whereas here it is 

created using edges. To refresh your memory, the SetO method creates a Set object in the 

assembly. Its first argument, edges, is an optional argument. In place of edges you might 

have used nodes, elements, vertices, faces, cells, among other possible arguments (all of 

which are listed in the documentation). Since we are using edges, we provide a list of 

edges stored previously in edges_for_connector_set. The second argument, name, is a 

required parameter. It is a String which is the name of the set and its key in the 

repository. 

# ------------------------------------------------------------------------
# Create a connector section 

beamModel.ConnectorSection(name='FrameCrossConnSect', translationalType=JOIN) 

The ConnectorSectionO method is used to create a ConnectorSection object. A 

ConnectorSection object is derived from the Section object and describes the connection 

type and behavior of a connector. The ConnedorSectionO method has a required 

method, name, which is a String speciiying the repository key. There are a number of 

optional arguments such as assembledType, rotationalType, translationalType, and so 

on which are described in the documentation, but at least one of these 3 must be 

specified. The one used here is translationalType with which you specifY the 

translational connection type. The possible values are all SymbolicConstants, and there 

are number of them listed in the documentation. The one used here is JOIN which 

constrains the translation along aB 3 axes to be equal for both nodes connected by the 

connector section. 

# ----------------------------- -------------------------------------------
# Assign this connector section to the wire features using the set created earlier 
conn_wire_region = beamAssembly.sets['Set of connector wires'] 
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beamAssembly.SectionAssignment(sectionName='FrameCrossConnSect', 
region=conn_wire_region) 

We first assign the set 'Set of connector wires' to a variable conn_wire_region. A set of 
edges can be used as a Region object which we will need in for the SectionAssignmentO 
method, hence I've put the word region in the name of the variable to make things clear. 
You have seen the SectionAssignmentO method used in section 4.3.5 on page 72. To 
refresh your memory, the SectionAssignmentO method creates a SectionAssignment 
object, which is an object that is used to assign sections to a part, an assembly or an 
instance. Its first parameter is a region, in this case the region is conn_wire_region. The 
second argument sectionName is the name we wish to give the section, which is also the 
key in the of the sections dictionary/repository. This argument must be a String. 

# ----- ---------------------------- -- ------------ - - -- -------------- - - -----
# use constraint equations on the other two nodes 

# We did not apply the JOIN condition to four of the nodes 
# We will instead use an equation constraint to achieve the same effect on the 
# top two 
# However we won't use the equation constraint on the lower two because we are 
# going to fix that edge anyway and having an equation constraint as well as a 
# fixed boundary condition might give an error 

# First we need to assign the nodes, both on the frame part and on the crossbars, 
# to sets 

vertex_for_framenode_l ; frameinstance.vertices.findAt(((S.e, e.e, e . e),),) 
beamAssembly .Set(vertices=vertex_for_framenode_l, name='framenodel') 
vertex_for_framenode_2 = frameinstance.vertices.findAt(((s.e, e.e, 1. 5),),) 
beamAssembly.Set(vertices=vertex_for_framenode_2, name='framenode2') 
vertex_for_crossnode_l = crossinstance.vertices.findAt(((s.e, e.e, e.e),),) 
beamAssembly.Set(vertices=vertex_for_crossnode_l, name='crossnodel') 
vertex_for_crossnode_2 = crossinstance.vertices.findAt(((s.e, e.e, 1.5},),) 
beamAssembly.Set(vertices=vertex_for_crossnode_2, name='crossnode2') 

# Create the equation constraints 
beamModel.Equation(name='JoinConstraintl', 

beamModel.Equation(name='JoinConstraint2', 

beamModel.Equation(name='JoinConstraint3', 

beamModel.Equation(name='JoinConstraint4', 

terms=( (1.9, 
(-1.8, 

terms=( (1.8, 
(-1.8, 

terms=((l.e, 
( -1.8, 

terms=( (1.8, 

'crossnodel', 
'framenodel', 
'crossnodel', 
'framenodel', 
'crossnodel', 
'framenodel', 
'crossnode2', 

1), 
1))) 
2), 
2))) 
3), 
3))) 
1), 
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r----·-----·--------·--------------- ---·--·---, 

I
, (-1.0, 'framenode2', 1))) 1 

beamModel.Equation(name='JoinConstraintS' , terms=((l.e, 'crossnode2', 2), I 

t (-1.0, 'framenode2', 2))) I 
beamModel. Equation(name=' JoinConstraint6', terms=( (1_._0..::.., _ ·_ c_r_o_s_sn_o_d_e_2-.:' ,:._3..::..).:..., :....._ ____ ! 
___ ·-------- ( =._1.0, 'framenode2', 3))) 

# First we need to assign the nodes, both on the frame part and on the crossbars, 
# to sets 

vertex_for_framenode_l = frameinstance.vertices.findAt(((8.9, 9.9, 9.9),),) 
beamAssembly.Set(vertices=vertex_for_framenode_l, name='framenodel') 
vertex_for_framenode_2 = frameinstance.vertices.findAt(((B.0, 0.0, 1.5),),) 
beamAssembly.Set(vertices=vertex_for_framenode_2, name='framenode2') 
vertex_for_crossnode_1 = crossinstance.vertices.findAt(((B.0, 0.0, 9.0),),) 
beamAssembly.Set(vertices=vertex_for_crossnode_l, name='crossnodel') 
vertex_for_crossnode_2 = crosslnstance.vertices.findAt(((B.0, 0.0, 1.5),),) 
beamAssembly.set(vertices=vertex_for_crossnode_2, name='crossnode2') 

Sets must be created to represent the nodes so that they can be used as parameters for the 

EquationO method. The findAtO method is used to find the vertices on their respective 

part instances as [partlnstance).vertices.findAtO. These are then assigned to sets using 

the SetO method which was explained in the previous section. 

# Create the equation constraints 
beamModel.Equation(name='JoinConstraintl', terms=((1.9, 'crossnodel', 1), 

(-1.9, 'framenodel ' , 1))) 
beamModel.Equation(name='Joinconstraint2', terms=((1.0, 'crossnode1', 2), 

(-1.9, 'framenode1', 2)}) 
beamModel.Equation(name='JoinConstraint3', terms=({1.9, 'crossnode1', 3), 

(-1.9, 'framenodel', 3))) 
beamModel.Equation(name='JoinConstraint4', terms=((1.9, 'crossnode2', 1), 

(-1.0, 'framenode2', 1))) 
beamModel.Equation(name='JoinConstraintS', terms=({1.0, 'crossnode2', 2), 

(-1.0, 'framenode2', 2))) 
beamModel.Equation(name='JoinConstraint6', terms=((l.0, 'crossnode2', 3), 

( -1.0, 'framenode2', 3})) 

The EquationO method creates an Equation object, which is derived from the 

Constraint object. The Equation object defines a linear multi-point constraint between a 

set of degrees of freedom. Tt has 2 required arguments. The first is name which is a 

String specifying the repository key of the constraint. The second is terms, which is a 

sequence of Float, String, Int and lnt specifying a coefficient, a set name, a degree of 

freedom and a coordinate system ID. The last one is optional and has not been used here. 

The actual numbers are the ones you would type into the Edit Constraint window in 

Abaqus/CAE. 



218 Analysis of a Frame of 1-Beams 

9.4.11 Create step!f. 
-~"--"--~~-

The following code block creates the steps 

# ------- -- - -- ------- ------- --- ------- - ----- ------------------------------
# Create the step 

import step 

# Create a static general step 
I beamModel.StaticStep(name="Apply Loads', previous='Initial', 

. _____________ d_e_s_c_r~...:· p_t_i_on~ ' Loads are applied in this step') 

These statements are the same as the ones used in the Cantilever Beam example hence 
require no explanation. You may refer to in Section 4.3.7 on page 75. 

No field output requests were defined in this simulation 

# -- -- ------------ --- ----------- - ---- --- ------- --- ------------ - ----- ---- - -
# Field output requests 

# Leave at defaults 

9.4.13 CFeate and define history ou!)Jut ~uests 
No history output requests were defined in this simulation 

# ---- -------- -------- - ------------------------------ ---------------------
# History output request 

# Leave at defaults 

ly loads 
The following block applies loads 

~~;d;----------- -- --------- -------------------------------- ------ -

I 

I 
! 

_j 

edge_for_crossloadl = crosslnstance.edges.findAt(((G.e, e.e, 8.75), ),) 
region_for_crossloadl = regionToolset.Region(edges=edge_for_crossloadl) I 
edge_for_crossload2 = crossinstance.edges.findAt(((S.e, e .0, 9. 75), ),) 
region_for_crossload2 = regionToolset.Region{edges=edge_for_crossload2) _j' 
edge_for_frameloadl = frameinstance.edges. findAt(((3.5, e.e, e.e), ),) 
region_for_frameloadl = regionToolset.Region(edges=edge_for_frameloadl) 
edge for frameload2 = framelnstance .edges.findAt(((19.5, e.e, 1.5), ),) 
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~----·-··-·--··· ···------·--····-·-----·· ··· ·····----.... -·-··--········· .. ··· .. ·-···-·-····---··-·········--·······--···---··-·········-· ············-·······-···-···--····-·······------·---········-·-··-···········-····-······--····-·-········-··········---·-· ····-------------···---······--········----------i 
j region_for_frameload2 = regionToolset.Region(edges=edge_for_frameload2) 
I 

j beamModel.LineLoad(name=' CrossLoadl', createStepName='Apply Loads ' , 
1 region=region_for_crossloadl, comp2=-1eee.e) 
I beamModel.Lineload(name='CrossLoad2', createStepName='Apply Loads', 
! region=region_for_crossload2~ comp2=-1eee.e) 
I beamModel.LineLoad(name='FrameLoadl', createStepName='Apply Loads', 
I region=region_for_frameloadl~ comp2=-15ee.e) 
! beamModel.LineLoad(name='FrameLoad2', createStepName='Apply Loads', 

! ····-----··--- ·-----re~~-~~~_r:~~-~~.,t~=fram~~oad2.:!._ comp2~-=-?._~~ . e) -·--·-------·-----·-·--·-_.! 

edge_for_crossloadl = crossinstance.edges.findAt({{G.e, e.e, 9.75), ),) 

The edges on which the line load will be applied are selected using the findAtO method 
as [partlnstance].edges.findAtO and assigned to variables such as 
edge_ for_ crossloadl. 

region_for_crossloadl = regionToolset.Region(edges=edge_for_crossloadl) 

This selects a region using the Edge object we have just created. It uses the RegionO 
method to create a Region object. You have seen the RegionO method previously in 
Sections 4.3.10 and 4.3.11. To refresh your memory, the RegionO method works a little 
differently depending on the kind of arguments you give it. In Section 4.3.1 0 we saw it 
return a surface like region and in Section 4.3.11 it returned a set-like region. Since a 
line-load is applied on the set of points and not a surface, we need RegionO to return a 
set-like region. Hence the argument we use is edges, which requires a sequence of Edge 
objects. Remember that findAtO will return an Edge object or a sequence of Edge 
objects, hence edge_for_crossloadl is valid argument here even though you might have 
thought of it as an Edge object as opposed to a sequence of Edge objects. The Region 
object is defined in the regionToolset module, which is why we used the 'import 
region Too/set' statement in the initialization section of our script. 

beamModel.lineload(name='Crossloadl', createStepName= ' Apply Loads', 
region=region_for_crossloadl, comp2=-1000.e) 

The LineLoadO method is used to create a LineLoad object. The LineLoad object, 
which is derived from the Load object, stores the data of an applied line load. It has 3 
required arguments. The first is name, which is a String specifYing the load repository 
key. We have named it 'CrossLoadl '.The second is createStepName, which is a String 
specifYing the name of the step in which the load is to be created. We want our load to be 
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created in the 'Apply Loads' step which was defined previously. The third is region 

which is a Region object specifying the region on which the load is applied. We supply 

region_for_crossloadl which was created in the previous statement. One of the optional 

arguments is distributionType, whose possible values are the SymbolicConstants 

UNIFORM, USER_DEFINED and FIELD. It specifies how the load is distributed 

spatially. Since we have not defined it, it defaults to UNIFORM. Some other optional 

arguments are compl, comp2 and comp3. We have defined comp3, which is a Float 

specifYing the component of the load in the global 3-direction. Even though compl, 

comp2 and comp3 are optional arguments, at least one of them must be nonzero unless 

distributionType is set to USER_DEFINED. Other optional arguments are listed in the 

documentation. 

# ---- -- - ------------- --- - - ---------------------- - - ----------- - ---- - - - - - --
# Apply boundary conditions 

frame_edges_for_bc = framelnstance.edges.findAt(((5.9,-3.9,9.9),), 
((7.9,-3 .9,9.9),), 
((9 .9, -3.9,9.9),), 
((5.9,-3.9,1.5),), 
((7.9,-3.9,1.5),), 
((9.9, -3.9,1.5),),) 

cross_edges_for_bc crosslnstance.edges . findAt(((4.9,-3.9,9.75),), 
((6.9, -3.9,9.75),), 
((8.9,-3.9,9.75) , ), 
((1e.e,-3.e,e.75),),) 

edges_for_bc = frame_edges_for_bc + cross_edges_for_bc 
bc_region = regionToolset.Region(edges=edges_for_bc) 

beamModel.DisplacementBC(name='FixBottom', createStepName='Initial', 
region=bc_region, Ul=SET, U2=SET, u3=SET, 
ur1=UNSET, ur2= UNSET, ur3=UNSET, 
amplitude=UNSET, distributionType=UNIFORM, 
fieldName='', localCsys=None) 

frame_edges_for_bc = frameinstance.edges.findAt(((S.e,-3.e,e.e),), 
((7.9,-3.e,e.e),), 
((9.9, -3.8,8.8),), 
((5.9,-3.8,1.5),), 
((7.9,-3.8,1.5),), 
((9.9,-3.8,1.5),),) 



9.4 Examining the Script 221 

This statement uses the findAtQ method to locate all the edges of the frame instance 

which we will constrain. 

cross_edges_for_bc = crossinstance. edges.findAt(({4.9,-3.9,9.75),), 
((6.9,-3.9,9.75),), 
((8.9,-3.9,9.75),), 
((19.9,-3.9,9.75),),) 

This statement uses the findAtO method to locate all the edges of the cross bracing 

instance which we will constrain. 

edges_for_bc = frame_edges_for_bc + cross_edges_for_bc 

We then combine all the edges and place them in one variable by using the addition + 

sign. This syntax may come as a surprise to you, but it is perfectly legal and works very 

well in Abaqus. The findAtQ methods of the two previous statements returned sequences 

of Edge objects, and this statement adds both sequences together to create another 

sequence ofEdge objects. 

bc_region = regionToolset.Region(edges=edges_for_bc) 

We once again use the RegionO method in the same manner as in the previous section to 

create a Region object using the edges. This Region object can then be used in the 

DisplacementBCO method. 

beamModel.DisplacementBC(name='FixBottom', createStepName='Initial', 
region=bc_region, ul=SET, u2=SET, u3=SET, 
url=UNSET, ur2= UNSET, ur3=UNSET, 
amplitude=UNSET, distributionType=UNIFORM, 
fieldName=· · , localCsys=None) 

This statement creates a DisplacementBC object which you encountered earlier in 

section 7.4.11 . To jog your memory, it stores the data for a displacement/rotation. The 

DisplacementBC object is derived from the BoundaryCondition object. The first 

required argument is a String for the name. The second is the name/key of the step in 

which the boundary condition is to be applied. ln this case we apply it to the 'Initial' step. 

The third argument must be a Region object. The remaining arguments are optional. Note 

however that even though ul, u2, u3, url, ur2 and ur3 are optional arguments, at least 

one of them must be specified. For ul, u2 and u3 we use the SymbolicConstant SET thus 

preventing translation in the 1, 2 and 3 directions (a.k.a. x, y and z directions). Url, ur2 

and ur3 are not specified, and will default to UNSET thus allowing rotation along all 3 
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axes. Since no amplitude is used, it is set to UNSET and the distributionType is set to 
UNIFORM ensuring a uniform special distribution of the boundary condition in the 
applied region. 

9.4.16 Mesh. 
The following code block creates the mesh 

I • ----------------------- ---------------------------------------------- ---
# Create the mesh 

import mesh 

frame_mesh_region = frame_region 
frame_edges_for_meshing = edges_for_frame_section_assignment 
frame_mesh_element_type=mesh.ElemType(elemCode=B31J elemlibrary=STANDARD) 
framePart . setElementType(regions=frame_mesh_regionJ 

elemTypes=(frame_mesh_element_type, )) 
framePart.seedEdgeByNumber(edges=frame_edges_for_meshing, number=4) 
framePart.generateMesh() 

cross_mesh_region = cross_region 
cross_edges_for_meshing = edges_for_cross_section_assignment 
cross_mesh_element_type=mesh.ElemType(elemcode=B31, elemlibrary=STANDARD) 
crossPart.setElementType(regions=cross_mesh_region, 

elemTypes=(cross_mesh_element_typeJ )) 
crossPart.seedEdgeByNumber(edges=cross_edges_for_meshingJ number=4) 
crossPart.generateMesh() 

All of these statements are similar to the ones used in section 7.4.12 on page 139. Refer 
back to that section to refresh your memory as the methods used are identical. The only 
differences are in the element type used and the number of seeds per edge. Also since we 
have 2 part instances in this example, they have both been meshed separately. 

The following code runs the job 

# - ----- - ------------------- - ---- - - - ----- -- ----- - - - -------------------- - - -
# Create and run the job 

import job 

# Create the job 
mdb.Job(name='BeamFrameAnalysisJob', model='Beam Frame', type=ANALYSIS, 
explicitPrecision=SINGLEJ 

nodalOutputPrecision=SINGLE, descr i ption='Bending of loaded beam frame', 
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I pa-;.aueii;-ationMethodExplicit=DDMArN-:--;~iti.process-ing~de=DEFAUL T, 

I 
numDomains=l, usersubroutine='', numcpus=l, memory=se, memoryunits=PERCENTAGE, 

scratch='', 
I echoPrint=OFF, modelPrint=OFF, contactPrint=OFF, historyPrint=OFF} 

I 
# Run the job 
·mdb.jobs['BeamFrameAnalysisJob') . submit(consistencychecking=OFF} 

I 

I # Do not return control till job is finished running i 
I mdb.jobs['BeamFrameAnalysisJob'].waitForCompletion() j 

# End of run job ~-------·----·--·-----·--------·-----·-----------·-·---··--"'"--··--·-··------------------------
All of this should look familiar to you from the Cantilever Beam example. You may refer 

back to section 4.3.13, page 88 for a refresher on these job commands 

9~5 . ·Summary . - : · ~;:. • _ ~ '."'"''-'. 

Some of the new topics covered in this chapter included creating datum planes and datum 

lines using a script. We also created connectors and constraint equations to simulate 

joints. You created a line load by using the RegionO method a little differently to return a 

set-based region as opposed to a surface based one. These build on your knowledge of 

Python scripting in Abaqus. 
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Bending of a Planar Shell (Plate) 

[n this chapter we will perform a static analysis on a plate being bent by a concentrated 
force. The problem is displayed in the figure. 

Boundary Condition Partition Lines 

Ul = U2 = U3 = UR1 = UR2 = UR3 = 0 

7000 N 

7000N 

loads 

The dimensions are displayed in the following figure. All lengths are in meters and the 
shell thickness is 0.1 m. 
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1---------; ---------1 

3 

In this example the following tasks will be demonstrated first using Abaqus/CAE, and 

then using a Python script 

• Create a part 

• Assign materials 

• Assign sections 

• Create an Assembly 

• Create a static, general step 

• Request field outputs 

• Delete history outputs 

• Create datum points and partition faces 

• Assign loads 

• Assign boundary conditions 

• Create a mesh 

• Create and submit a job 

• Report field outputs to an external file 

The following new topics are covered in this example: 

• Model I Preprocessing 
o Work in 3D with a planar shell 
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o Create sections of type 'shell', specify section integration properties and 
assign shell thickness 

o Define shell offset when assigning sections 
o Turn NLGEOM (non-linear geometry) option on/off as required 
o Delete history outputs 
o Create partitions for the purpose of generating selectable nodess 

• Results I Post-processing 
o Show element labels on meshed model 
o Change the sort variable and sort order in the report profile 
o View/Change the work directory 

You can perform the simulation in Abaqus/CAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. 

I . Rename Model-1 to Plate Bending Model 
a. Right-click on Model-1 in the Mode.l Database 
b. Choose Rename .• 
c. Change name to Blate Bending Model 

2. Create the part 

a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Plate 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Shell 
f. Set Base Feature Type to Planar 
g. Set Approximate Size to 20 
h. Click OK. You will enter Sketcher mode. 

3. Sketch the plate 
a. Use the Create Lines:Rectangle (4 lines) tool to draw the profile of the 

plate. Start at the origin and drag to the top and left so that the rectangle has 
positive X and Y coordinates. 

b. Use the Add Dimension tool to set the length of the horizontal elements to S 
m and the length of the vertical elements to 3 m. 
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c. Click Done to exit the sketcher. 

4. Create the material 

a. Double-click on Materials in the Model Database. Edit Material window is 

displayed 
b. Set Name to AISI 1005 Steel 

c. Select General> Density. Set Mass Density to 7872 (which is 7.872 g/cc} 

d. Select Mechanical> Elasticity> Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 

5. Create sections 

a. Double-click on Sections in the Model Database. Create Section window is 

displayed 
b. Set Name to Plate Section 
c. Set Category to Shell 

d. Set Type to Homogeneous 
e. Click Continue ... The Edit Section window is displayed. 

f. In the Basic tab , set Section integration to During Analysis 

g. Set Shell thickness Value to 0.1 

h. Set Material to the AISI 1005 Steel which was defined in the material 

creation step. 
t. Set Thickness integration rule to Simpson 

J. Click OK. 
6. Assign the section to the plate 

a. Expand the Parts container in the Model Database. Expand the part Plate. 

b. Double-click on Section Assignments 

c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire plate. 

e. Click Done. The Edit Section Assignment window is displayed. 

f. Set Section to Plate Section. 
g. Set Shell Offset Definition to Middle surface. 

h. ClickOK. 

7. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 

b. Expand the Assembly container. 

c. Double-click on Instances. The Create Instance window is displayed. 
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d. Set Parts to Plate 
e. Set Instance Type to Dependent (mesh on part) 
f. Click OK. 

8. Create Steps 

a. Double-click on Steps in the Model Database. The Create Step window is 
displayed. 

b. Set Name to Load Step 
c. Set Insert New Step After to Initial 
d. Set Procedure Type to General> Static, General 
e. Click Continue •• The Edit Step window is displayed 
f. In the Basic tab, set Description to Apply concentrated forces in this step. 
g. Set Time period to 1 
h. Set Nlgeom to On 
t. ClickOK. 

9. Request Field Outputs 
a. Expand the Field Output Requests container in the Model Database. 
b. Right-click on F-Output-1 and choose Rename .•• 
c. Change the name to Output Stresses and Displacements 
d. Double-click on Output Stresses and Displacements m the Model 

Database. The .Edit Field Output Request window is displayed. 
e. Select the desired variables by checking them off in the Output Variables 

list. The variables we want are S (stress components and invariants) and U 
(translations and rotations). Uncheck the rest. You will notice that the text 
box above the output variable list displays S,U 

f. Click OK. 
10. Delete History Outputs 

a. Expand the History Output Requests container in the Model Database. 
b. Right-click on H-Output-1 and choose Delete ••• 
c. You see a prompt OK to delete "H-Output-1"? Click Yes. 

11. Apply boundary conditions 
a. Double-click on BCs in the Model Database. The Create Boundary 

Condition window is displayed 

b. Set Name to Fix Edge 

c. Set Step to Initial 
d. Set Category to Mechanical 
e. Set Types for Selected Step to Displacement/Rotation 
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f. Click Continue ... 

g. You see the message Select regions for the boundary condition displayed 

below the viewport 

h. Select the left edge of the plate. 

1. Click Done. The Edit Boundary Condition window is displayed. 

J. Check off Ul, U2, U3, URl, UR2 and UR3. This will fix the edge and not 

allow translation or rotation. 

k. Click OK. 

12. Partition the plate to create points for the concentrated loads 

a. Expand the Parts container in the model tree. 

b. Double-click the part Plate. The viewport changes to the Part module and 

plate part. 

c. Click the Create Datum Point: Enter coordinates tool. You see the prompt 

Coordinates for datum point (X, Y, Z): below the viewport 

d. Type in the coordinates 0.0, 2.0, 0.0 and press the "Enter" key on your 

keyboard. You see a datum point appear on the left edge of the plate in the 

viewport. You again see the prompt Coordinates for datum point (X, Y, 

Z): below the viewport 

e. Type in the coordinates 0.0, 1.0, 0.0 and press the "Enter" key on your 

keyboard .. You see another datum point appear on the left edge of the plate 

in the viewport. 

f. Similarly proceed to enter in the coordinates of the next 2 datum points 

which are 5.0, 2.0, 0.0 and 5.0, l.O, 0.0 respectively. There are now 4 datum 

points, 2 on the left edge and 2 on the right edge of the plate. 

g. Click the Partition Face: Use Shortest Path Between 2 Points tool. You 

see the message Select a start point below the viewport 

h. Click on the top left datum point (whose coordinates are 0.0, 2.0, 0.0). You 

see the message Select an end point below the viewport. 

i. Click on the top right datum point (whose coordinates are 5.0, 2.0, 0.0). You 

see the message Partition definition complete below the viewport 

J· Click on the Create Partition button. The partition is displayed in the 

viewport. 

k. You see the prompt Select the faces to partition below the viewport. Use 

the drop down to set it to individually. 

I. Hover the mouse over the lower half of the plate (below the partition line). It 

will light up as you are hoving over it. Click it to select it. 
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m. Click Done. You see the message Select a start point below the viewport 
n. Click on the bottom left datum point (whose coordinates are 0.0, 1.0, 0.0). 

You see the message Select an end point below the viewport 
o. Click on the bottom right datum point (whose coordinates are 5.0, 1.0, 0.0). 

You see the message Partition definition complete below the viewport 
p. Click on the Create Partition button. The second partition is displayed in 

the viewport and the plate now consists of 3 different partitions. 
q. Click Done 

13 . Assign Loads 
a. Double-click on Loads in the Model Database. The Create Load window is 

displayed 
b. Set Name to Concentrated Forces 
c. Set Step to Load Step 
d. Set Category to Mechanical 
e. Set Type for Selected Step to Concentrated force 
f. Click Continue •.• 
g. You see the message Select points for the loaddisplayed below the viewport 
h. Select the two points on the right edge where the partition line meets the 

edge. The reason for creating the partitions was to be able to select these two 
points. Hold the "Shift" key on your keyboard to select both points. 

1. Click Done. The Edit Load window is displayed 
J. Set CF3 to -7000.0 to apply a 7000 N force in downward (negative Y) 

direction 
k. ClickOK 
I. You will see the forces displayed with an arrows in the viewport on the 

selected points although you may need to rotate the view to see them clearly 
14. Create the mesh 

a. Expand the Parts container in the Model Database. 
b. Expand Plate 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 
d. Using the menu bar click on Mesh> Element Type .•• 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select the entire plate. 
g. Click Done. The Element Type window is displayed. 
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1. Set Geometric Order to Quadratic 

J. Set Family to Shell 
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k. You will notice the message S8R: An 8-node doubly curved thick shell, 

reduced integration 
I. Click OK 

m. Click Done 
n. Using the menu bar lick on Seed> Edge by Number 

o. You see the message Select the regions to be assigned local seeds displayed 

below the viewport 

p. Click on the 6 vertical edges (3 on left edge and 3 on right edge). You will 

need to press the 'Shift' key on your keyboard to select all 6 of them 

q. Click Done. You see the prompt Number of elements along the edges 

displayed below the viewport 
r. Set it to 3 and press the "Enter" key on your keyboard. 

s. Again you see the message Select the regions to be assigned local seeds 

displayed below the viewport 
t. Click on the 4 horizontal edges (top edge, bottom edge and 2 partition lines). 

You will need to press the 'Shift' key on your keyboard to select all 4 of 

them 
u. Click Done. You see the prompt Number of elements along the edges 

displayed below the viewport 

v. Set it to 10 and press the 'Enter' key on your keyboard 

w. Click Done 
x. Using the menu bar click on Mesh > Part 

y. You see the prompt OK to mesh the part? displayed below the viewport 

z. Click Yes. The meshed plate appears in the viewport. 

15. Create and submit the job 

a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 
b. Set Name to PlateJob 
c. Set Source to Model 

d. Select Plate Bending Model (it is the only option displayed) 

e. Click Continue •• The Edit Job window is displayed 

f. Set Description to Job simulates the bending of a plate 

g. Set Job Type to Full Analysis. 
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h. Leave all other options at defaults 
1. Click OK 
J. Expand the Jobs container in the Model Database 
k. Right-click on PlateJob and choose Submit. 
I. You will see a popup saying History output is not requested in the 

following steps: Load Step. OK to continue with job submission? Click 
Yes. 

m. This will run the simulation. You will see the following messages in the 
message window: 

The job input file "PiateJob.inp" has been submitted for analysis. 
Job PlateJob: Analysis Input File Processor completed successfully 
Job PlateJob: Abaqus/Standard completed successfuiJy 
Job PlateJob completed successfully 

16. Show element labels and plot contours 
a. Right-click on PlateJob (Completed) in the Model Database. Choose 

Results. The viewport changes to the Visualization module. 
b. In the toolbar click the Plot Undeformed Shape tool. The plate is displayed 

in its undeformed state. 

c. ln the toolbar click the Common Options tool. The Common Plot Options 
window is displayed. 

d. In the Labels tab check Show element labels 
e. Click OK. The elements are now numbered on the truss in the viewport. 
f. In the toolbar click the Plot Contours on Deformed Shape tool. A color 

contour ofS. Mises stresses is plotted over the plate 
17. Report Field Outputs 

a. Using the menu bar click on Report> Field Output ... The Report Field 
Output window is displayed. 

b. In the Variable tab, set the Output Variables Position to Integration 
Point. 

c. In the list you seeS: Stress components. CJick the arrow next to it to expand 
the list. Select Mises by checking it off 

d. In the Setup tab, set the File Name to platestresses.rpt. 
e. Uncheck the Append to file option 
f. Set Sort by to S.Mises using the dropdown 

g. Set it to Descending 
h. For Write check Field output, Column totals and column min/max. 
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1. Click OK to close the Field Output window. Ln the message area you see 

The field output report was appended to file "platestresses.rpt". 

J. You can now use windows explorer to navigate to the Abaqus temporary 

files directory. Open platestresses.rpt using WordPad. You will find that the 

stresses have been tabulated with element labels. In addition the maximum 

and minimum stresses are displayed at the bottom of the report. 

The following Python script replicates the above procedure for the analysis of the planar 

shell. You can find it in the source code accompanying the book in plate_bending.py. 

You can run it by opening a new model in Abaqus (File > New Model Database> With 

Standard/Explicit Model) and running it with File> Run Script .•• 
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# Create material AISI 3.985 Steel by assigni ng mass density·., Y,o'ungs modulus- ana 
# poissons ratio · · 
plateMaterial ~ plateModel.Haterial(name='AISI 1005 Steel') _ 
plateMaterial.Density(table=((7872, )J )) 
plateMaterial.Elastic(table=((299E9, 9.29), )) 

impo~ section 

#assign the plate to this section 
plate_face_point • (2. 5, 1.5, e.e) 
plate_face • platePart.faces.findAt((plate_face_point,)) 
plate_region = (plate_face,) 

illport assembly 

import step 

#Create a static general. step· ~ 
plateModel.StattcStep(name•'Load Step', previousa•Xnitial~ , • 

descriptlon='Apply confentrated forces in this step', 
nlgeoii=ON) 
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partition_face_pt = (2.s. 1.s~ e.e) 
partition_face = platePart.faces.findAt({partition_face_pt.)) 
platePart.PartitionFac~ByShortestPath(pointl=plate_datum~int_l, 

point2=plate_datum~oint_3. 
faces=parti tien_ face~- · 

I ' 
# Now two faces exist~ select ~he one that needs to be _pant~t1oned 
partition_face~t = (2.5, 2.9, e.e) · · 
partition_fate = platePart.f.aces.fin~t((partition~face~t.~) , 
platePart.PartitionFaceByShorte~tPath(point1=plate_~atum~oint_2, 

point2=plate_datu~int~4.. 
faces=partition_T.ate) 

# -------------------------- - ----------------------------: ----.----------- -
# Apply concentrated farces 

import mesh 

# set el~t type 
plate_.esh_region = plate_region 

elemTypel • mesh.Ele.Type(ele.fode•SSR~ 

mesh.:_edges_horizontal = platePart.edges.findAt(((2: s, 
. ( (2.5, 

( (2.5, 
((2. 5, 
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# it will ·be stored in the default abaqus temporary dire'eter.y · 
report_name_and_path='PlateStresses .rpt' 

# You may enter an entir.e path if you wish to have the 
# particular location. 
# One way to do it is using the following syntax. 
# repprt_name='PlateReport' 
# report~ath='C:/HyNewFolder/' 
# re)?Ort_name_and_path = report_path + report_name + ' • l>'pt' 
# Alternatively you could have used 1 statement instead of these 3 
# report_name_and_path='C:/HyNewfolder/PlateReport.rpt' 

# Note however that the folder 'HyNewFolder' must exist etherwise you will 
# get the following error 
# "IOError:C/MyNewF.older: Directory rot founij.~ : 
# You must either create the folder io Win~ews tJefore' runnirig the script 
# Or if you wish to create it using Pytnon tommands you must use the os.makedir() 
# or os.makedirs() function 
# os.makedirs() is preferable because you can create multiple nested directories 
# in one statent if you wish 
# Note that this function returns an exception 
# hence it is a good idea to use a try block 

#try: 
# os.makedirs(report_path) 

. #except: 
# print "Directory exists 
# 

# Mere it. is 
""" " 

· report..,name=' PlateS tresses' 
report_path='C:/MyNewFolder/' 
report_name_and_path = report_path + report_na.e + 
try: 

os.makedirs(report_path) 
except: 

print "Directory exists hence 

" "" 

# Write the f,ield repoFt outputting the Hises stFesses 
session.writeFieldReport(fileName=report_na~_and~athJ appendCOFF~ 

sorti.tem= 'S.Mises ', odb=an_odb_abject1 st.ep=B~ fr~=l, . 
outp~Position=INlEGRA~~ON_PO[N~~ 
variab~e=(('S' 1 INTEGRATION_POINT, ((INVARrANT1 'Hises'), 
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Let's examine the script statement by statement. 

The block dealing with this initialization is 

1:~~:~~:!~~~-i~:::--~------- ------- ------------------1 
~~~ .. import regionToolset 

1 
session.viewports['Viewport: l'].setValues(displayedObject=None) 

----------·-·-~-··---------------

These statements are identical to those used in the Cantilever Beam example and were 
explained in section 4.3 . I on page 65 

The following block creates the model 

~=-=~.:-::-=.-~~-~~-=-=-=-=-=-~=-=-=-=-=-=-==-=-=·=-:~-=-=-~~-=-=-=-=~=~-=~~=-===-=-=-=~~-:::-::.-=-=-----·----
1 # Create the model 
I 

b.models . changeKey{fromName='Model-1', toName='Plate Bending Model') 
ateModel = mdb.models['Plate Bending Model') 
--------·-------·--·--··· .. ·---·-.. ·-·~·~··""'''''~-·-----·-···-····-··-·-·-·--··-·---------·--·--··------------·-----------

These statements rename the model from 'Model-1' to ' Plate Bending Model' . They are 

almost identical to those used in the Cantilever Beam example which were explained in 
section 4.3.2 on page 67. 

The following block of code creates the part 

j # ------- - - ----------------------- - ------------------------- - - - - ----- - - ---
1 # Create the part 

I import sketch 
I import part 

1 # a) Sketch the plate using the rectangle tool 
I plateProfileSketch = plateModel.ConstrainedSketch(name='Plate Sketch', 
! sheetSize=28) 
i plateProfileSketch . rectangle(pointl=(e.e,e.e), point2=(5.9,3.e)) 
I L. _ ___ _ ______ _j 
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# b) Create a shell named "Plate" using the sketch 
platePart=plateModel . Part(name='Plate', dimensionality=THREE_D, 

type=DEFORMABLE_BODY) 
platePart.BaseShell(sketch=plateProfileSketch) 

All the statements except the last one are very similar to the ones used in the Cantilever 
Beam example. To refresh your memory on the ConstrainedSketcbQ, rectangleO and 
PartQ methods, refer back to section 4.3.3. 

platePart .BaseShell(sketch=plateProfileSketch) 

This creates a Feature object by calling the BaseSbeiiO method. Feature objects were 
explained in section 4.3.3. To jog your memory, Feature objects contain parameters 
specified by the user as well as modifications made to the model by Abaqus based on 
those parameters. BaseSheiiO creates a planar shell from the given CoostrainedSketch 
object which is passed to it as its one required argument. BaseSheiiO has no optional 
arguments. Notice that no depth/thickness is specified in the BaseSheiiO method unlike 
the BaseSolidExtrudeO method used in the Cantilever Beam example. 

The following block of code creates the material for the simulation 

# ---------------- -------------- -- --- ------- -- - ------------------- - -------
# Create material 

I 
import material I 
# Create material AISI tees Steel by assigning mass density, youngs modulus and ! 

# poissons ratio J 
plateMaterial = plateModel.Material(name= 'AISI 1005 Steel') 
plateMaterial.Density(table=((7872, ), )) 

j~ate~-~erial . Ela~tic(_!:_able= ( (200E9,_~.:!.9),_lL __________________________________ _ 

The statements are almost identical to those used in the Cantilever Beam example which 
were explained in section 4.3.4 on page 71 . 

The following block creates the sections and makes assignments 

# -- - - -- ----------- ---- ------- -- - - ----------- ----------------------- - -----
# create homogeneous shell section of thickness e.tm and assign the plate to it 
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---------------------------------- ---------------·--·-----·---·1 
. import section j 

I # Create a section to assign to the plate ' 

I
, plateSection = plateModel.HomogeneousShellSection(name='Plate Section', 

material='AISI tees Steel', 

I 
thicknessType=UNIFORM, 
thickness=e. l) 

I 
I #assign the plate to this section 
~, plate_face_point = (2.5, 1.5, e.e) 

plate_face = platePart.faces.findAt((plate_face_point,)) 
plate_region = (plate_face,) 

I platePart .SectionAssignment(region=plate_region, sectionName='Plate Section', 
L offset=e.e, offset!ype=MIDDLE_SURFACE, offsetField=' ') 

The statement 

import section 

imports the section module making its properties available to the script. 

plateSection = plateModel.HomogeneousShellSection(name='Plate Section', 
material='AISI 1995 Steel', 
thicknessType=UNIFORM, 
thickness=9.1) 

This statement creates a HomogeneousShellSection object using the 
BomogeneousSheiiSectionO method. The HomogeneousSheliSection object defines the 
properties of a shell section. The first parameter, name, given to the method is the name 
which is used as the repository key. The second parameter, material, is the repository 
key of the material (a String), which has been defined before. The third parameter, an 
optional one called thicknessType, is a Syrnbol.icConstant which identifies the type of 
distribution which is used for defining the thickness of the elements. We have assigned it 
the value UNIFORM, The fourth parameter is an optional one called thickness, which is 
a Float specifying the thickness of the section. It is only applicable when thicknessType 
has been set to UNIFORM. 

plate_face_point = (2.5, 1. 5, 9.9) 
plate_face = platePart.faces.findAt((plate_face_point,)) 
plate_region = (plate_face,) 

The faces.findAtO method returns the face (Face object) at the specified coordinates. 
The next statement turns it into a sequence of Face objects by using a comma, giving us a 
Region object (remember a Region is a sequence of other objects such as Face objects). 
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platePart.SectionAssignment(region=plate_region. sectionName='Plate Section', 
offset=e.e. offsetType=MIDOLE_SURFACE, offsetfield=' ') 

The SectionAssignmentO method is used to create a SectionAssignment object, which 
as mentioned in section 4.3.5 on page 72 is an object that is used to assign sections to a 
part, an assembly or an instance. The first parameter is a region, in this case the region is 
the entire part. The second argument, sectionNarne, is the repository key we give to the 
section. The third argument, offset, is an optional one. It is a Float specifying the offset 
with a default value of 0.0. The fourth argument, offsetType, is also optional. rt is a 
SymbolicConstant specifying the method used to define the shell offset. We have used 
MIDDLE_SURFACE. The last argument is an optional one called offsetField which is 
a String specifying the name of the field specifying the offset. We set it to". 

1~0.4.6 Create an assembly 
The following code block creates the assembly. 

# - - - ---- ------ -- --- ----- ------ ----- - - -------- - - - ---- --- --------- -------- -
# Create the assembly 

import assembly 

# Create the part instance 
plateAssembly = pl ateModel . rootAssembly 
plateinstance = plateAssembly.Instance(name=' Plate Instance', part=platePart, 

dependent=ON) 

These statements are almost identical to the ones used in the Cantilever Beam example in 
section 4.3.6 on page 74. 

10.4.7 Create st~ 
The following code block creates the steps. 

# ---- -- --- - ------------------- - - - ----- ------------ -----------------------
# Create the step 

import step 

# Create a static general step 
plateModel.StaticStep(name='Load Step', previous='Initial ' , 

description='Apply concentrated forces in this step'. 
nlgeom=ON) 
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The statements are almost identical to the ones used in the Cantilever Beam example in 

section 4.3.7 on page 75. The one big difference is the use of the nlgeom parameter. This 

is an optional argument which specifies whether Abaqus should account for geometric 

nonlinearity during the analysis. It accepts a Boolean value (ON or OFF) with default 

being OFF. 

I # - --- ------------ --- ---------------------- - -- - ----- - -- - - - - --- - -- ---------

# Create the field output request 
I 

I# change the name of field output request 'F-Output-1' to 'Output Stresses and 
# Displacements' 
plateModel.fieldOutputRequests.changeKey(fromName='F-Output-1', 

toName='Output Stresses and Displacements') 

# since F-Output-1 is applied at the 'Apply Load' step by default, 'Selected 
#Field Outputs' will be too 
# we only need to set the required variables 
plateModel.fieldOutputRequests['Output Stresses and Displacements'] \ 

.setValues(var iables=( ' S', 'UT')) 

The statements are similar to ones used in the Cantilever Beam example in section 4.3 .8 

on page 76. 

The following code block defines the history output requests: 

~--- --------- ----~---- -- - -- - ------------------- ~-~-:..-==-=-=---==-=--=---------_-_- -- --, 
1 # Create the history output request 

I
# We don't want any history outputs so lets delete the existing one 'H-Output-1' J 
del plateModel. history9~~putRequests [ ~~-~~.:~pu~-=~--·----· --·--

We do not want any history outputs in this example so we shall delete the existing default 

'H-Output-1' using the Python del command. 
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10.4.10 Apply bouDdary conditions ---The following block of code applies the boundary condition: 

# -------------------------------- ------- ----- - ---- -- - - -------------------
# Apply boundary conditions - fix one edge 

fixed_edge = plateinstance.edges.findAt(((e.e, 1. 5, 8.0), )) 
fixed_edge_region=regionToolset.Region(edges=fixed_edge) 

plateModel.DisplacementBC(name~'FixEdge' , createStepName='Initial', 
region=fixed_edge_region. ul=SET, u2=SET, u3=SET. 
url=SET, ur2=SET, ur3=SET, 
amplitude=UNSET, distributionType=UNIFORM, 
fieldName=' ·, localCsys=None) 

# Instead of using the displacements/rotations boundary condition and setting all 

I # six DOF to zero 
# We could have just used the Encastre condition with the following statement 

I
# plateModel.EncastreBC(name='Encaster edge', createStepName='Initial', 
# region=fixed_edge_region) _j 
--~~--------------------·---·------------·----------------···---

fixed_edge = plateinstance.edges.findAt(((9.9, 1.5, 9.9), )) 

uses the findAtO method to find the edge to be fixed using the coordinates of its center 
(midpoint). 

fixed_edge_region=regionToolset.Region(edges=fixed_edge) 

uses the RegionO method to create a Region object out of the edge. This Region object 
can then be used in the DisplacementBCO method. The Region object was discussed in 
Section 4.3.5 of the Cantilever Beam example on page 72. 

plateModel.DisplacementBC(name='FixEdge', createStepName='Initial', 
region~fixed_edge_region, ul=SET, u2=SET, u3=SET, 
ur1=SET, ur2=SET, ur3~SET, 

amplitude=UNSET, distributionType=UNIFORM, 
fieldName=' ', localCsys=None) 

This statement creates a DisplacementBC object which you encountered earlier in 
section 7.4.11. To jog your memory, it stores the data for a displacement/rotation. The 
DisplacementBC object is derived from the BoundaryCondition object. The first 
required argument is a String for the name. The second is the name/key of the step in 
which the boundary condition is to be applied. In this case we apply it to the 'Initial' step. 
The third argument must be a region object. The remaining arguments are optional. Note 
however that even though ul, u2, u3, url, ur2 and ur3 are optional arguments, at least 
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one of them must be specified. For ul, u2 and u3 we use the SymbolicConstant SET thus 

preventing translation in the 1, 2 and 3 directions (a.k.a. X, Y and Z directions). url, ur2 

and ur3 are not specified, and will default to UNSET thus allowing rotation along all 3 

axes. Since no amplitude is used, it is set to UNSET and the distributionType is set to 

UNIFORM ensuring a uniform special distribution of the boundary condition in the 

applied region. 

Note: Instead of using the displacements/rotations boundary condition and setting all six 

DOF to zero, we could have just used the Encastre condition with the following 

statement. 

plateModel.EncastreBC(name='Encaster edge', createStepName='Initial', 
region=fixed_edge_region} 

Here the EncastreBCO method is used to create a TypeBC object, which is an object 

that stores data on several types of predefined boundary conditions commonly used in 

stress/displacement analysis. The EncastreBCO method was previously discussed in 

section 4.3.11 of the Cantilever Beam example. 

I # - - ---- - ---- -- -- --- ---- -- ----------~~~~~---------------------- -------
·---1 

! # Create vertices on which to apply concentrated forces by partitioning part 

! # Create the datum points 
I platePart.DatumPointByCoordinate(coords=(e.e, 1.0, 0.0)) 

platePart.DatumPointBycoordinate(coords=(e.e, 2.0, e.e)) 
platePart.DatumPointByCoordinate(coords=(S.e, 1.0, 9.9)) 
platePart.DatumPointByCoordinate(coords=(S.e, 2.0, 9.9)) 

# Assign the datum points to variables 
# Abaqus stores the 4 datum points in platePart.datums 
# Since their keys may or may not start at zero, put the keys in an array sorted 

# in ascending order 
platePart_datums_keys = platePart.datums.keys() 
platePart_datums_keys .sort() 
plate_datum_point_l = platePart.datums[platePart_datums_keys[e]] 

I 

plate_datum_point_2 = platePart.datums[platePart_datums_keys[l]] 
plate_datum_point_3 = platePart .datums[platePart_datums_keys[2]] 
plate_datum_point_4 = platePart .datums[platePart_datums_keys[3]] 

# Select the entire face and partition it using two points 
partition face pt = (2.5, 1.5, e.e) ,_.;...__ __ _ ____ __I 
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I 
partition_face = platePart.faces.findAt((partition_face_pt,)) 
platePart.PartitionFaceByShortestPath(pointl=plate_datum_point_l, 

I 
point2=plate_datum_point_3, 
faces=partition_face) 

# Now two faces exist, select the one that needs to be partitioned 
partition_face_pt = (2.5, 2.0, 0.0) 
partition_face = platePart.faces.findAt((partition_face_pt,)) 
platePart.PartitionFaceByShortestPath(pointl=plate_datum_point_2, 

point2=plate_datum_point_4, 
faces=partition_face) 

# Since the partitions have been created, vertices can be extracted 
vertices_for_concentrated_force = platelnstance.vertices.findAt(((s.e, 1 .0, e.e) , ), 

((s .e, 2. 0, e.e),),) 

platePart.DatumPointByCoordinate(coords=(9.9, 1.9, 9.9)) 
platePart.DatumPointByCoordinate(coords=(e.e, 2.9, 9.9)) 
platePart.DatumPointByCoordinate(coords=(5.9, 1.9, 9.9)) 
platePart.DatumPointByCoordinate(coords=(5.9, 2.9, 9.9)) 

These statements use the DatumPointByCoordinateO method to create datum points on 
the part. The DatumPointByCoordinateO method creates a Feature object and a 
DatumPoint object at the point specified in the coordinates. coords is a sequence of 
three Floats specifying X, Y and Z coordinates of the datum point and is a required 
argument. 

platePart_datums_keys = platePart.datums.keys() 
platePart_datums_keys.sort() 
plate_datum_point_l = platePart.datums[platePart_datums_keys[9]] 
plate_datum_point_2 = platePart.datums[platePart_datums_keys[1]] 
plate_datum_point_3 = platePart.datums[platePart_datums_keys[2]] 
plate_datum_point_4 = platePart.datums[platePart_datums_keys[3]] 

We need to assign each of the 4 datum points we have created to variables so that we can 
use them with the PartitionFaceBySbortestPathO method in subsequent statements. 
Abaqus stores all the datum points in platePart.datums. We need to extract these and 
assign them to variables. 

We get the keys, or repository names, of each of them by using the keysO method as 
platePart.datums.keysO and assign them to the variable platePart_datums_keys. The 
next statement uses the sortO method to sort these keys in ascending order and places 
them back in the variable platePart_datums_keys. We can then refer to each of the keys 
using index notation, such as platePart_datums_keys[O) for the first one. And we can 
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refer to the corresponding DatumPoint object usmg these keys as 
platePart.datums[platePart_ datums _keys[O] ). 

partition_face_pt = (2.5, 1.5, 8.8) 
partition_face = platePart.faces.findAt((partition_face_pt,)) 

These statements locate the face to be partitioned using the findAtO method and place it 
in a variable. 

platePart.PartitionFaceByShortestPath(point1=plate_datum_point_l, 
point2=plate_datum_point_3, 
faces=partition_face) 

The PartitionFaceByShortestPathO method can be used to partition one or more faces 
using the shortest path between two given points (a straight line). It has 3 required 
arguments. pointl and point2 can both be a Vertex object, an InterestingPoint object, 
or a DatumPoint object. In our case we have used DatumPoint objects which we 
obtained using the previous statements. The third required argument faces is a sequence 
of Face objects specifying the faces to partition. 

# Now two faces exist, select the one that needs to be partitioned 
partition_face_pt = (2.5, 2.8, 9.9) 
partition_face = platePart.faces.findAt((partition_face_pt,)) 
platePart.PartitionFaceByShortestPath(pointl=plate_datum_point_2, 

point2=plate_datum_point_4, 
faces=partition_face) 

These statements are similar to the previous 3 and are used to create the second partition. 
Note that since the original face has been partitioned, it is necessary to use findAtO again 
to choose one of the 2 new faces which we wish to partition. 

vertices_for_concentrated_force = plateinstance.vertices.findAt(((5.8, 1.8, 9.9),), 
((5.9, 2.0J 8.9),),) 

Now that the faces have been partitioned, vertices have been created as part of the 
partitioning where the partition lines intersect with the edges of the plate. Abaqus can 
now be instructed to extract these vertices using vertices.findAtO. 
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'10.4.12 Apply loads 
The following block applies the loads: 

1 : ~~~~;-~~~~~~~~~~~d-f~~~~~- ----------- - ---- - -- - ----- -- -- - ------ ------ -- --
plateModel.ConcentratedForce(name=·concentrated Forces ' , 

createStepName='Load Step', 
region=(vertices_for_concentrated_force,), 

i cf3=-7Bee.e, distributionType=UNIFORM) L--------------------------------~~--------~~------~------------

The ConcentratedForce{) method creates a ConcentratedForce object, which is 
derived from the Load object. The first argument is the name or repository key for which 
the String 'Concentrated Forces' is given. The second argument is the name/key of the 
step in which the concentrated force will be applied. The third argument is required to be 
a Region object. However vertices_for_concentrated_force is a GeomSequence. A 
GeomSequence is a sequence of Geometry objects, such as Vertices or Edges. We put 
it in parenthesis and add a comma to make it a Region object. Hence 
region=(verticesJor _concentratedJorce,). The forth argument cf3 is the Z-component 
of the force. (cfl is X-component, and ell is Y-component). It is set to -7000.0 with the 
negative sign indicating the force is pointing toward the plane (since +ve Z is out from 
the plane). The fifth argument sets the distributionType to uniform using the 
SymbolicConstant UNJFORM. 

The following block creates the mesh 

I : ~~~~~~-~~~-~~~~- - - - ----------------------------- - - --- -- -- - -- -- - -- --- - - - -
1 

import mesh 

# set element type 
plate_mesh_region = plate_region 

elemTypel = mesh.ElemType(elemCode=S8R, elemLibrary=STANDARD) 

platePart.setElementType(regions=plate_mesh_region, elemTypes=(elemTypel,)) 

# seed edges by number ! 
I mesh_edges_vertical = platePart.edges.findAt(((e.e, e.s, e.e) , ), 

((e.e, 1.s. e.e). ). 
((e.e, 2.s, e.e). ). :.__ __________ , -·~' 
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i __ ....._. _____________________________ ,.., _______________________________________________________________________________________ ·····-············-···-.. ·····- ···------·····--------------------------··-----~----·-----------·--·-········-----···---··· 

i ((s.e~ e.s, e.e), ), 
((5.0, 1.5, e.e). ). 
((5.0, 2.5, 0 .e). )) 

i 

I mesh_edges_horizontal = platePart.edges.findAt(((2.5, 0.0, e.e), ), 
i ((2. 5, 1.0, e.e), ) • 
I ((2.5, 2.e, e .e), ). 
i ((2 . 5, 3.0, e.e). )) 
! 

platePart.seedEdgeByNumber(edges=mesh_edges_vertical, number = 3) 
platePart.seedEdgeByNumber(edges=mesh_edges_horizontal, number=10) 

l£_1atePart. ge_~era!_~~~-~~-0 _______________ _ 

plate_mesh_region = plate_region 
elemType1 = mesh.ElemType(elemCode=SSR, elemlibrary=STANDARD) 
platePart.setElementType(regions=plate_mesh_region, elemTypes=(elemTypel,)) 

These statements are similar to the ones you have used previously, refer to section 7.4.12 
on page 139 to refresh your memory on the ElemTypeQ and setEiementTypeQ 
methods. 

mesh_edges_vertical = platePart.edges.findAt(((8.8, e.s, 8.9), ), 
((e.e~ 1.5, e.e), ), 
((9.8, 2.5, 0.e), ), 
((5.9, e.5, e.e), ), 
((5.9, 1.5, e .e), ), 
((5.9, 2.5, e.e), )) 

mesh_edges_horizontal = platePart.edges.findAt(((2.5, e.e, 9.9), ), 
((2.5, 1.9, 9.9), ), 
((2.5, 2.9, 9.9), ), 
((2.5, 3.9, 9.8), )) 

We wish to specify how many seeds are on each edge. However we have partitioned the 

plate so we now have 6 edges along one axis, and 4 along the other. The above 

statements identify these edges using the findAtO method and their midpoints. The edges 
along X and Y axes have been collected into two separate variables mesh_ edges_ vertical 

and mesh_ edges_ horizontal. 

platePart.seedEdgeByNumber(edges=mesh_edges_vertical, number = 3) 
platePart.seedEdgeByNumber(edges=mesh_edges_horizontal, number=19) 
platePart.generateMesh() 

You have seen the seedEdgeByNumberO and generateMeshQ methods used before, 

refer to section 7.4.12 on page 139. 
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I
~ _____ ___ __ _____ ___ ___________________________ _________ : _____ ~ --- - -- --- - -

# Create and run the job 

I import job 

I # create the job 

mdb.Job(name='PlateJob' 1 model='Plate Bending Model'J type=ANALVSIS, 
description='Job simulates the bending of a plate') 

# run the job 
mdb . jobs['PlateJob'] .submit{consistencyChecking=OFF) 

# do not return control till job is finished running 
mdb. jobs [ ' PlateJob'] .waitForCompletion{) 

These statements are similar to ones used previously. You may refer to Section 4.3.13 on 
page 88. 

10.4.15 DisplaY' deformed state with contours ___ ...__ __ 
The following code displays the deformed state of the plate 

~---- --- --- ---- --- - ------ ---- ---- --- --- ----- -------- ---- -- ----- -- ----- --
# Display deformed state with contours 

import visualization 

plate_viewport = session.Viewport{name='Plate Results Viewport') 
plate_Odb_Path = 'PlateJob.odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport.setValues{displayedObject=an_odb_object) 
plate viewport.odbDisplay.display.setValues(plotState={CONTOURS ON_DEF, )) 

These statements are almost identical to the ones used in the Cantilever Beam example. 
Refer to section 4.3.14 on page 89 to review the ViewportO, openOdbO and setValuesO 
methods.. The only difference here is that plotState has been set to a different 
SymbolicConstant CONTOURS_ON_DEF instead of DEFORMED to plot a color 
contour. 
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The following statements create a new file and then write the field output report to it. 

,;--~-~-~-~- :-=-~-~--=~-~·=··=·=-=-~-:=·=-~-=-~--=--~ =-=·~·=·== ·=··==·====·=-=-=-=-= =-~-=-=-=·=-=··=-=·=-=-=·=-=-=-==··:::-~-=-=·=-=-=-=-=-===·----·-- ·------------,, 
! # Report stresses in descending order 
I , 
' import odbAccess I 
I # The main session viewport must be set to the odb object using the following line. 1 
' # If not you might receive an error message that states I 

#"There are no active entities. No report has been generated." I 
session.viewports[ 'Viewport: l'].setValues(displayedObject=an_odb_object) I 
# Set the option to display the reported quantity (in our case the stresses) in 
# descending order 

! session.fieldReportOptions . setvalues(sort=DESCENDING) 
I 
i # Name the report and give it a path . If you do not assign a path (as is done here) 
I # it will be stored in the default abaqus temporary directory 
I l report_name_and_path='PlateStresses.rpt' 
I 
l 

! # Write the field report outputting the Mises stresses 
I session.writeFieldReport(fileName=report_name_and_path, append=OFF, 
.

1

' sortitem='S.Mises', odb=an_odb_object, step=e, frame=l, 
outputPosition=INTEGRATION_POINT, 

I variable=(('S', INTEGRATION_POINT, ((INVARIANT, 'Mises'), )), )) 
--·~-~~-~------...... ~~---.. -·--··---·----··-----·----·-·--·-··-----·-·------------··----·-··-··-·-------··-·-·----------------·-~·------···--J 

import odbAccess 

This makes the Odb objects, methods and members available to the script. 

session.viewports['Viewport: l'].setValues(displayedObject=an_odb_object) 

You've seen the setValuesO method used in the Cantilever Beam example in both the 
initialization block as well as the post processing. To refresh your memory, setValuesO 
sets the display to the selected output database. 

If we leave out this line, Abaqus will give us an error message in subsequent statements 
when we try to generate the report saying "There are no active entities. No report has 
been generated." 

report_name_and_path='PlateStresses.rpt ' 

session.writeFieldReport(fileName=report_name_and_path1 append=OFF1 

sortltem='S.Mises' 1 odb=an_odb_object, step~e, frame=l, 
outputPosition=INTEGRATION_POINT, variable=(('S', INTEGRATION_POINT, 

((INVARIANT1 'Mises'), ))~ )) 
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The writeFieldReportQ method writes a FieldOutput object to an ASCII file. It has a 
number of required arguments. fdename is a String specirying the name of the file to 
which the output will be written. append is a Boolean which specifies whether or not to 
append field output to an existing fi le. sortltem specifies the item or column by which 
the tabulated values are sorted, we are sorting with respect to Mises stress. odb is the 
output database. Step can be either an lnt or an OdbStep object (we have used lnt) 
specifYing which step the output values should be obtained from. frame can be an Int or 
an OdbFrame object specifYing which frame to obtain the field output values from. 
outputPosition is a SymbolicConstant which specifies the position from which to obtain 
data, we set it to INTEGRATION_POINT. variable is a sequence of variable 
descriptions specifYing one or more field output variables for which to obtain data. Each 
variable description must have a String specirying the name of the variable (in our case 
'S'), a SymbolicConstant specifYing the output position at which to report the data, and a 
sequence of tuples each consisting of a SymbolicConstant specifYing refinement 
(COMPONENT or INVARIANT) followed by a String with the name of the component 
or invariant. 

10.5 Sommanr 
In this chapter we partitioned faces, displayed contours on a defonned plot, and reported 
field output to an external file. These are tasks you will undoubtedly script again in 
future. 
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Heat Transfer Analysis 

In this chapter we will perform a heat transfer analysis on a rectangular block. The 
problem is displayed in the figure. 

Constant Temperature 
4oo ·c 

(boundary condition) 

L 
(~ck !~eel 

! Heat Flux 
SOOOW/m2 

(load) 

Radiation into vacuum in sight 
of a cooler body at 320 ·c with 
emissivity of 0.78 
{interaction - surface radiation) 

Convection to air at 200 •c 
Film coeff = 13W/m2/'C 
(interaction - surface film 
condition) 

Constant Temperature 
350"C 

The dimensions and material properties are displayed in the following figure. The unit of 

length is meters. 
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t----------6.0 ------------f 

D T 
1.0 

1 
Material : Copper 
Thermal Conductivity: 401 W/m/"C 

~1.o--t 

In this exercise the following tasks will be performed first using the Abaqus GUI, and 
then using a Python script. 

• Create a part 

• Assign materials 

• Assign sections 

• Create an Assembly 

• Create a datum plane and partition a part 

• Create a heat transfer step 

• Assign boundary conditions 

• Assign loads 

• Create a mesh 

• Create and submit a job 

• Plot contours 

• Change view orientation 

The following new topics are covered in this example: 

• Model I Preprocessing 
o Create a steady state or transient heat transfer step 
o Assign heat flux loads and constant temperature boundary conditions 
o Use interactions to define convection and radiation heat loss mechanisms 
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o ModifY model attributes to define the Stefan-Boltzmann constant and 
absolute zero oftemperature scale 

• Results I Post-processing 
o Display nodal temperatures as a color contour 
o Orient the viewport display and save custom views 

" You can perform the simulation in Abaqus/CAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. 

l. Rename Model-1 to Heat Transfer 
a. Right-click on Model- I in Model Database 
b. Choose Rename •. 
c. Change name to Heat Transfer 

2. Create the part 
a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Block 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 5 
h. Click OK. You wiiJ enter Sketcher mode. 

3. Sketch the profile 
a. Use the Create Lines:Rectangle (4 lines) tool to draw the square profile of 

the block 
b. Use the Add Dimension tool to set the length of the horizontal and vertical 

elements to 1 m. 
c. Click Done to exit the sketcher. The Edit Base Extrusion window is 

displayed. 
d. . Set Depth to 6.0 
e. Click OK. The extruded block js displayed. 

4. Create the material 
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a. Double-click on Materials in the Model Database. Edit Material window is 
displayed 

b. Set Name to Copper 
c. Select Thermai>Conductivity. Set Conductivity to 400 (which IS 400 

W/mK) 

d. Click OK 
5. Assign sections 

a. Double-click on Sections in the Model Database. Create Section window is 
displayed 

b. Set Name to Block Section 
c. Set Category to Solid 
d. Set Type to Homogeneous 
e. Click Continue ••. The Edit Section window is displayed. 
f. In the Basic tab, set Material to Copper which was defined in the create 

material step. 

g. ClickOK. 
6. Assign the section to the block 

a. Expand the Parts container in the Model Database. Expand the part Block. 
b. Double-click on Section Assignments 
c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire block. 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Block Section. 
g. ClickOK. 

7. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 

b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 
d. Set Parts to Block 
e. Set Instance Type to Dependent (mesh on part) 

f. Click OK. 
8. Partition the block 

a. At the top of the viewport, change Module to Part using the dropdown 
menu. 
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b. Click the Create Datum Plane: Midway between 2 points tool. You see the 
message Select the first point to create datum plane displayed below the 

viewport. 
c. Click on a corner (such as O.O,O.O,O.O).You see the message Select the 

second point to create datum plane displayed below the viewport. 
d. Click on the same corner on the opposite face (such as 0.0,0.0,6.0). You may 

need to use the Rotate View tool in order to be able to see that corner. The 
datum plane is displayed in the viewport in the middle of the block 

e. Click the Partition cell: Use datum plane tooL You see the message Select 

a datum plane displayed below the viewport 
f. Click on the datum plane to select it. 
g. Click the Create Partition button below the viewport. The block ts 

partitioned in two. 

h. Click Done. 
9. Create Steps 

a. Double-click on Steps in the Model Database. The Create Step window is 
displayed. 

b. Set Name to Heating Step 
c. Set Insert New Step After to Initial 
d. Set Procedure Type to General >Heat transfer 
e. Click Continue .. The Edit Step window is displayed 

f. In the Basic tab, set Description to Apply heat in this step. 
g. Set Response to Transient. 
h. You may see a message Default load variation with time has been 

changed to Ramp linearly over step. Click Dismiss. 

t. Click OK. 
I 0. Leave Field Outputs at default 
11. No History Outputs. 
12. Apply boundary conditions 

a. Double-click on BCs m the Model Database. The Create Boundary 

Condition window is displayed 
b. Set Name to Const Temp Surf 1 

c. Set Step to Heating Step 
d. Set Category to Other 
e. Set Types for Selected Step to Temperature 
f. Click Continue ••. 
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g. You see the message Select regions for the boundary condition displayed 
below the viewport 

h. Select one end face of the block by clicking on it. 
1. Click Done. The Edit Boundary Condition window is displayed. 
J. Set Distribution to Uniform. 
k. Set Magnitude to 400. 
I. Click OK. 
m. In the same manner create another boundary condition Const Temp Surf 2 

for the opposite face of the block setting the magnitude to 350. 
13. Assign Loads 

a. Double-click on Loads in the Model Database. The Create Load window is 
displayed 

b. Set Name to Heat Flux 
c. Set Step to Heating Step 
d. Set Category to Thermal 
e. Set Type for Selected Step to Surface heat flux 
f. Click Continue ••. You see the message Select surfaces for the load 

displayed below the viewport 
g. Set it to individually from the drop down list 
h. Click on the top surface of the block, on the side of the partition closer to the 

400 K constant temperature surface 
1. Click Done. The Edit Load window is displayed 
n. Set Distribution to Uniform. 
J. Set Magnitude to 5000 
k. ClickOK 
I. You will see the flux displayed with an arrows in the viewport on the 

selected top face 

14. Assign fnteractions 
a. Double-click on Interactions in the Model Database. The Create 

Interaction window is displayed. 
b. Set Name to Convection 
c. Set Step to Heating Step 
d. Set Types for Selected Step to Surface film condition 

e. Click Continue •.• 
f. You see the message Select the surface displayed below the viewport 
g. Select the face which will lose heat by convection by clicking on it. 
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h. Click Done. The Edit Interaction window is displayed 
1. Set Definition to Embedded Coefficient 
J. Set Film coefficient to 13 
k. Set Film coefficient amplitude to Instantaneous. 
I. Set Sink temperature to 200 
m. Set Sink amplitude to Ramp 
n. Click OK 
o. Double-click on Interactions m the Model Database. The Create 

Interaction window is displayed. 
p. Set Name to Radiation 
q. Set Step to Heating Step 
r. Set Types for Selected Step to Surface radiation 
s. Click Continue •.. 
t. You see the message Select the surface displayed below the viewport 
u. Select the face which will Jose heat by radiation by clicking on it. 
v. Click Done. The Edit Interaction window is displayed 
w. Set Emissivity distribution to Uniform 
x. Set Emissivity to 0. 78 
y. Set Ambient temperature to 320 
z. Set Ambient temperature amplitude to Ramp 
aa. Click OK 

15. Create the mesh 
a. Expand theParts container in the Model Database. 
b. Expand Block 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 
d. Using the menu bar click on Mesh > Element Type .•• 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select the entire block. 
g. Click Done. The Element Type window is displayed. 
h. Set Element Library to Standard 
1. Set Geometric Order to Linear 
J. Set Family to Heat Transfer 
k. You will notice the message DC3D8: An8-node linear heat transfer block 
I. Click OK 
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m. Click Done 
n. Using the menu bar lick on Seed >Part ... The Global Seeds window is 

displayed 
o. Set Approximate global size to 0.5. Leave everything else at default values. 
p. Click OK. 
q. You see the message Seeding definition complete displayed below the 

viewport. Click Done. 
r. Using the menu bar click on Mesh> Part 
s. You see the prompt OK to mesh the part? displayed below the viewport 
t. Click Yes 

16. Create and submit the job 

a. Double-click on Jobs in the Model Database. The Create Job window is 
displayed 

b. Set Name to BeatTransferJob 
c. Set Source to Model 
d. Select Heat Transfer (it is the only option displayed) 
e. Click Continue .. The Edit Job window is displayed 
f. Set Description to Job simulates heat conduction through block 
g. Set Job Type to Full Analysis. Leave all other options at defaults 
h. Click OK 
1. Expand theJobs container in the Model Database 
J. Right-click on HeatTransferJob and choose Submit. 
k. You will see a popup saying History output is not requested in the 

following steps: Heating Step. OK to continue with job submission? 
Click Yes. 

J. This will run the simulation. You will see the following messages in the 
message window: 
The job input file "HeatTransferJob.inp" has been submitted for 
analysis. 
Job HeatTransferJob: Analysis Input File Processor completed 
successfully 
Job BeatTransferJob: Abaqus/Standard completed successfully 
Job HeatTransferJob completed successfully 

17. Plot heat contour 
a. Right-click on HeatTransferJob (Completed) in the Model Database. 

Choose Results.The viewport changes to the Visualization module. 
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b. Using the menu bar click on Result> Field Output ... The Field Output 

window is displayed. 

c. In the Primary Variable tab, set the Output Variable to NTll which has the 

description Nodal temperature at nodes. 

d. Click OK 

e. You see the Select Plot State window. Set Plot state to Contour. Click OK. 

18. Change view to left view 

a. Expose the Views toolbar by using the menu bar and clicking on 

Views>Toolbars >Views. 

b. Click the Apply left view button on the Views toolbar. 

The following Python script replicates the above procedure for the heat transfer analysis 

problem. You can find it in the source code accompanying the book in heat_transfer.py. 

You can run it by opening a new model in Abaqus (File> New Model Database> With 

Standard/Explicit Model) and running it with File > Run Script •.. 
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beamPart=heatMoael.Part(name~'Beam ' , dimensionaliti~THREE_~, type=DEFO~LE_B9DY) 
beamPart.BaseSolidExtrude(sketcb=beamProfileSk~tcll, ·depth:::(!) , · ·. . . · · · . .. ... - :'i..l'. • • •· /;; • • -· • 

import material 

. import section 

# Create a section to assign to the beam , . 
beamSection • heatHodel.HonogeneousSolldSection(name='Beam Section', 

~assign the beam to this section 
beam_region • (bea~art.cells,) 
beamPart.SectionAssig~nt(region=beam_Fegion, 

# Create the assembly 

import assembly 

material= ',c;;oppel"' ) 

# .--- - - -------------------------- -------------------- -- ----~------- --- - - -# Cr.eate the datUIII plane and partition, the par,t 

vertex_at_one_end_coords. = (8J8, 8.8, 8.8)' . 
vertex_at_one~end • beaminstance.vertices.findAt((vertex_at_one_egd_coo~s~)) .. 
verte~...,.at_other_end_coords • (8~8., 8.8, 6.8) . 

. vertex_at_other_end = beaminstance.vertices.findAt((v~rtex~t.other~end_coords,)) 
. ' ' beaaiPar.t.DatUIIIPlaneByTwoPoint(pointl=vertex_at_one.:,.end_coords, 

beam_inside_xcoo~d=e.s 
· beam_inside_ycoord-e. 5 

l)eam.inside zcoord=3.8 - -beamCells=beBIP~~ ~~eils 

point2=~ertex_at_other_end_coords) 
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# c~eate the mesh 

import mesh 

# other side of partition 
beam_other._half_inside_xcQOrda&~5 
beam_other_half_inside_ycoord~.s 
bea,_other_half_inside_zcoord~.s 
selectedBeamcells_other_hal~beamcells.findAt((beam_ot"er_~alf_inside_xcoordj 

· beam~other.~half~inside_y€OO~d, . 
bea._othe~~alf~insi~e_zcoord)1 ) 

'Cbmbtne ·both partitions ~nto one region 
bea-sh~egion=( selecteifBeaJICellfs_on~;_t'tailf, se:t_t:etrtedBeamc:ells_other _!Jalf~ 

• set the eiement type 
beamPart.setElementType{regions=tiea.MeshRegion, 

# Seed t .he part · 
. beaii!Part. ~eedPart (size~. 25, deviationFactor~ .1) . 

# Generate the mesh 
beaiiiP~rt.generateMesh() 
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11.4 Examining the Scn_,'p,_t __ 
Let's examine the script line by line. 

"!1 
.~:...;;:.::...;.~~~.::::..;~.;~~.~ 

11.4.1 Initialization, creation of the mod~l, part, materialS, sec_tions and assembly 
Most of these statements are practically identical to those used in the Cantilever Beam 
example. The code has essentially been copied and pasted here with few modifications to 
the variable names. The one change however is with the material. This time 'Copper' is 
used. We do not specifY the density, Young's modulus or Poisson's ratio, instead we 
specify the conductivity. 

beamMaterial.Conductivity(table=((400.e, ), )) 

The ConductivityO method creates a Conductivity object, which is an object that 
specifies thermal conductivity. It has one required argument table which is a sequence of 
sequences of Floats. The data expected here depends on the type of conductivity. If one 
uses the optional argument type, one can specifY ISOTROPIC, ORTHOTROPIC and 
ANISOTROPIC. In our case we do not specifY the type hence it defaults to 
ISOTROPIC. For this type of conductivity, the table argument expects temperature 
dependent conductivity data. In our case we only specify one conductivity, but since 
table needs to be a sequence of sequences we write it as (( 400.0, ), ). 

1 .4.2 Create a datum plane and partition the 
The following block creates the assembly. 

! # ------------ - - - --- -- --- ---------- - ---- - --- ----- - - ----- --- --- -- ---------# Create the datum plane and partition the part 

vertex_at_one_end_coords = (e.e, e.e, e.e) 
ver tex_at_one_end = beamrnstance.vertices.findAt((vertex_at_one_end_coords,)) 

vertex_at_other_end_coords = (e.e, e.e, G.e) 
vertex_at_other_end = beamlnstance.vertices.findAt((vertex_at_other_end_coords,)) 

beamPart.DatumPlaneByTwoPoint(pointl=vertex_at_one_end_coords, 
point2=vertex_at_other_end_coords) 

beam_inside_xcoord=e. s 
beam_inside_ycoord=e.s 
beam_inside_zcoord=3.e 
beamCells=beamPart.cells 
selectedBeamCells=beamCells.findAt((beam_inside_xcoord,beam_inside_ycoord, 

beam inside zcoord),) 
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r-·-·······--·----------·--·- -------······--.... ·--·-···-·--........ -................ ________ .. _____________________ ., _______________________________________ _______ 1 

'I! beamPart.PartitionCellByDatumPlane(datumPlane=beamPart . datums[3], I 
_ ____ cells=selectedBeamCells) 1 

vertex_at_one_end_coords = (9.9, 0.9, 9.9) 
vertex_at_one_end = beaminstance.vertices.findAt((vertex_at_one_end_coords,)) 

These two statements use the findAtO method to find a vertex at one end of the beam. 

vertex_at_other_end_coords = {9.9, 9.9, 6.9) 
vertex_at_other_end = beamlnstance.vertices. findAt((vertex_at_other_end_coords,)) 

These statements find the corresponding point at the other end of the beam. 

beamPart.DatumPlaneByTwoPoint(pointl=vertex_at_one_end_coords, 
point2=vertex_at_other_end_coords) 

This statement uses the DatumPianeByTwoPointO method to create a Feature object 

and DatumPiane object. (A DatumPlane object has no direct constructor and is created 

when a Feature object is created). Two points are required as arguments and these can be 

vertices, meshnodes, datum objects or InterestingPoints (such as midpoint of an edge). 

The datum plane is created midway between the two points and normal to the line 

connecting them. 

beam_inside_xcoord=B.S 
beam_inside_ycoord=9.5 
beam_inside_zcoord=3.B 
beamCells=beamPart.cells 
selectedBeamCells=beamCells.findAt((beam_inside_xcoord,beam_inside_ycoord, 

beam_inside_zcoord),) 

In order to partition the beam using the datum plane we just created, we need to first 

select a11 its cells. We refer to all the cells in the part file as beamPart.cells. We then 

pick a point (0.5, 0.5, 3.0) which is right in the middle of the beam and use the findAtQ 

method to select the cells of the beam. 

beamPart.PartitionCellByDatumPlane(datumPlane=beamPart .datums[3], 
cells=selectedBeamCells) 

The PartitionCeiiByDatumPianeO method partitions cells using a datum plane. The 

cells and the datum plane are provided as arguments to the method. 
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U.4.3 Create ste~ ,._ __ _ 
The following block creates the step. 

r;-__________ ___ _____ __ ____ ___ _____ __ __ __ ___ __ _______ ____ ____ ____ _____ ____ _ 
I # Create the step 
I 
I import st ep 
I 

1

1 # Create a heat transfer step 
heatModel.HeatTransferStep(name= ' Heati ng Step ' , previous=' Initial', 

description='Apply heat in this step', 
response=STEADY STATE, amplitude=RAMP) 

The HeatTransferStepO method creates a HeatTransferStep object which can control 
uncoupled heat transfer for either transient or steady-state response (which is what we are 
simulating). The required arguments are name, which is a String specifying the 
repository key you wish to assign the step, and previous which is the repository key of 
the step which occurs before it. description is an optional String argument. 

11.4.4 Ap I)' constraints/boundary conditions 
The following block applies the constraints: 

# - ------ -- ------------------ -------- ----- - ------------- ---------- --- -----
# Apply boundary conditions 

end_face_l_pt = (e . s, e.s, e.e) 
end_f ace_l = beamlnstance .faces.findAt((end_face_l_pt,)) 
end_face_l_region=regionToolset .Region(faces=end_face_l) 

1 heatModel .TemperatureBC(name='Const Temp Surf 1', createStepName='Heating Step', 
region=end_face_l_region, dist ributionType=UNIFORM, 
fieldName=' ', magnitude=488.e, amplitude=UNSET) 

I 
end_face_2_pt = (e.s, 9 .5, 6.9) 
end_face_2 = beaminstance.faces.findAt((end_face_2_pt,)) 

t
_face_2_region=regionToolset.Region(faces=end_face_2) 

atModel.TemperatureBC(name='Const Temp Surf 2', createStepName='Heating Step' , 
region=end_face_2_region, distributionType=UNIFORM, 
fieldName=' ', magnitude=3Se.e, amplitude=UNSET) 

Much of this should look similar to the boundary condition code in the previous chapters. 
You can refer back to section 4.3 .11 on page 81 of the Cantilever Beam example where 
faces.findAtO and regionToolset.RegionO were used. The only new method here is the 
TemperatureBCO method. 

heatModel .TemperatureBC(name='Const Temp Surf 1 ' , createStepName='Heating Step', 
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region=end_face_l_region, distributionType=UNIFORM, 
fieldName='', magnitude=499.9, amplitude=UNSET) 

This statement creates a TemperatureBC object. name, createStcpName and region 

are required arguments. name is a String specifYing the repository key for the boundary 

condition. createStepName is a String which specifies the name of the step in which the 

boundary condition must be created. region refers to the region on which the boundary 

condition is applied - it must be a Region object. The other arguments used here are 

optional ones. magnitude is a Float specifYing the temperature magnitude. 

distributionType is a SymbolicConstant specifying the spatial distribution of the 

boundary condition. We set it to the default of UNIFORM. Other possible values are 

USER_DEFINED and FIELD. If we were to use FIELD, fieldName would be a String 

referring to the AnalyticaiField object. amplitude can be either a String specifying the 

name of the amplitude reference, or the SymbolicConstant UNSET. 

The following block applies the loads: 

r;-=-=-=--=-=-.:-=~-=·-~~-=-~---=--=-=-==-=-=-~-=-=-=-=-.:-~-=-=-::-::=--~~=··~--=-=-.:-:::-~ ------------------------
I # Apply loads 
! 

I 
flux_face_pt = (e. s, 1.e, 1.5) 
flux_face = beaminstance.faces.findAt((flux_face_pt,)) 

I 
flux_face_region=regionToolset.Region(sidelFaces=flux_face) 
heatModel.SurfaceHeatFlux(name='Heat Flux', createStepName='Heating Step', 

l region=flux face region, magnitude=seee.e) 

flux_face_pt = (9.5, 1.9, 1.5) 
flux_face = beaminstance.faces.findAt((flux_face_pt,)) 
flux_face_region=regionToolset.Region(sidelFaces=flux_face) 

In order to apply the heat flux on the surface of the beam we need to first assign that 

surface to a region. Since the beam has been partitioned, we need to make sure the 

coordinates we supply to the findAtO method lie on the correct side of the partition or we 

will select the wrong surface. The RegionO method then creates a Region object out of 

this surface which can then be used in the next statement. 

heatModel.SurfaceHeatFlux(name='Heat Flux', createStepName='Heating Step', 
region=flux_face_region, magnitude=5999.9) 

The SurfaceHeatFluxO method creates a SurfaceHeatFiux object which describes the 

surface heat flux into or out of a region. The SurfaceHeatFiux object is derived from the 
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Load object. The four arguments that have been passed to the SurfaceHeatFiuxO 
method are required arguments. name is a String specifYing the load repository key. 
creatcStepName is a String specifYing which step the load must be applied in. region is 
a Region object which specifies the region on which the load must be applied. We 
created flux_face_region in the previous statement to use here. magnitude is a Float 
specifYing the heat flux magnitude. If however the optional distributionType argument 
is used to specifY how the spatial distribution of the surface heat flux then magnitude is 
no longer a required argument. The Abaqus Scripting Reference describes other optional 
arguments. 

The following block applies the loads: 

# --- ------ ---- ---- ----- - - ------ - - - ------------- - - ----------- -- ---- -- - - ---
# Create interactions (convection and radiation) 

# Convection 
convection_face_pt = (0.5, 1.0, 4.5) 
convection_face = beamlnstance.faces.findAt((convection_face_pt,)) 
convection_face_region=regionToolset.Region(sidelFaces=convection_face) 
heatModel.FilmCondition(name='Convection', createStepName='Heating Step', 

# Radiation 

surface=convection_face_region, definition=EMBEDDED_COEFF, 
filmCoeff=13.e, filmCoeffAmplitude=' ·, 
sinkTemperature=200. e, sinkAmplitude=' ') 

radiation_face_pt = (e.e, 0.5, 4.5) 
radiation_face = beaminstance. faces.findAt((radiation_face_pt,)) 
radiation_face_region=regionToolset.Region(sidelFaces=radiation_face) 
heatModel.RadiationToAmbient(name='Radiation·, createStepName='Heating Step', 

surface=radiation_face_region, radiationType=AMBIENT, 
distributionType=UNIFORM, field='', 
emissivity=0.78, ambientTemperature=32e .e, 
ambientTemperatureAmp='') 

# set absolute zero and Stefan-Boltzmann constant in model attributes (these must be 
set for problems involving radiation) 
heatModel.setValues{absoluteZero=-273 .15, stefanBoltzmann=5.67E-8) 

Many of the statements are similar to those used to apply the heat flux. 

convection_face_pt = (9.5, 1.9, 4.5) 
convection face = beaminstance.faces.findAt{{convection_face_pt,)) 
convection:face_region=regionToolset.Region(sidelFaces=convection_face) 
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To define convection on one of the surfaces of the beam, we first assign that surface to a 

region. Keeping in mind the presence of a partition, the coordinates to get the correct 

surface are supplied to the findAtO method. The RegionO method then creates a Region 

object out of this surface which can then be used in the FilmConditionO method. 

heatHodel . FilmCondition(name='Convection ' J createStepName='Heating Step', 
surface=convection_face_region, definition=EMBEDDED_COEFF, 
filmCoeff=l3 .9, filmCoeffAmplitude='', 
sinkTe~perature=288.9, sinkAmplitude='') 

The FilmConditionO method creates a FilmCondition object which defines the film 

coefficients and sink temperatures in an analysis. The FilmCondition object is derived 

from the Interaction object. The four required arguments are name, createStepName, 

surface and definition. name is a String used as the repository key, createStepName is 

a String identifying the name of the step in which the Film Condition object should be 

created, surface is a Region object indicating which surface the film condition 

interaction should be applied to, and definition is a SymbolicConstant specifying how it 

will be defined with possible values of EMBEDDED_COEFF, PROPERTY_REF, 

USER_SUB, and FIELD. filmCoeff, filmCoetTAmplitude, sinkTemperature and 

sinkAmplitude are optional arguments. filmCoeff is a Float specifYing the convection 

coefficient, its default value is 0.0. filmCoefTAmplitude is a String specifying the name 

of the Amplitude object (if any) for the variation of film coefficient with time. The 

default value is an empty String. sinkTemperature is a Float specifying the reference 

ambient temperature, it defaults to 0.0. sinkAmplitude is a String specifying the name of 

the Amplitude object (if any) for the variation of sink temperature with time. The default 

is an empty String. The Abaqus Scripting Reference describes other optional arguments. 

radiation_face_pt = (9.9, e.s, 4.5) 
radiation_face = beaminstance.faces .findAt((radiation_face_pt,)) 
radiation_face_region=regionToolset.Region(sidelFaces=radiation_face) 

Similar to convection, to define radiation from/to part of the beam, we first assign that 

surface to a region. Accounting for the presence of a partition, the coordinates to get the 

correct surface are supplied to the findAtO method. The RegionO method then creates a 

Region object out of this surface which can then be used in the RadiationToAmbientO 

method. 

heatModel.RadiationToAmbient(name='Radiation', createStepName='Heating Step'J 
surface=radiation_face_region, radiationType=AMBIENTJ 
distributionlype=UNIFORMJ field='', 
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emissivity=e.78, ambientTemperature=3le.e, 
ambientTemperatureAmp='') 

The RadiationToAmbientO method creates a RadiationToAmbient object which 
defines the heat transfer between a surface and its environment. The 
RadiationToAmbient object is derived from the Interaction object. The four required 
arguments are name, createStepName, surface and emissivity. name is a String used as 
the repository key, createStepName is a String identifying the name of the step in which 
the RadiationToAmbient object should be created, surface is a Region object indicating 
which surface the radiation interaction should be applied to, and emissivity is a Float 
specifying the emissivity. radiation Type, distribution Type, field, 
ambientTemperature and ambientTemperatureAmp are optional arguments. 
radiationType is a SymbolicConstant specifying whether Abaqus should use surface 
radiation behavior (AMBIENT) or cavity radiation approximation (CAVITY). 
distributionType is a SymbolicConstant specifying the radiation distribution when 
radiationType is set to AMBIENT. The possible values are UNIFORM (the default) 
and ANALYTICAL_FIELD. field is a String specifying the name of the 
AnalyticaiField object and when distributionType = ANALYTICAL_FIELD. The 
default is an empty String. ambientTemperature is a Float which sets the reference 
ambient temperature (default is 0.0) when radiationType = AMBIENT. 
ambientTemperatureAmp is a String indicating the name of the Amplitude object 
which defines the variation of temperature with time. The Abaqus Scripting Reference 
describes other optional arguments. 

heatModel.setValues{absolutezero=-273.15, stefanBoltzmann=5.67E-8) 

The [model].setValueO method is used to modify a Model object. It has no required 
arguments and a number of optional ones spelled out in the Abaqus Scripting Reference 
Manual. The ones we have used are absoluteZero and stefanBoltzmann. absoluteZero 
is a Float specifying the value of absolute zero on the temperature scale being used. Since 
we are using Celsius as the unit of temperature throughout the analysis, we set 
absoluteZero to -273.15 ·c. stefanBoltzmann is a Float speci-fying the Stefan-BoJtzmann 
constant. To remain consistent with the rest of the model which is in SI units we give it a 
value of 5.67E-8 J/s/m2/ .C4 
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tt.4.7 Mesh -- . 
The following block creates the mesh 

~~~--- - - ----- - - --- ------:~~~~~~~~~~~~~~----------------------- -----
1 # Create the mesh 
I 
i import mesh 

I ! mesh_element_type = mesh.ElemType(elemCode=DC308, elemlibrary=STANDARD) 
' 

# One side of partition 
beam_one_half_inside_xcoord=9.5 
beam_one_half_inside_ycoord=0.5 
beam_one_half_inside_zcoord=l.S 
selectedBeamCells_one_half=beamCells.findAt((beam_one_half_inside_xcoord, 

1 beam_one_half_inside_ycoord, 
I beam_one_half_inside_zcoord),) 

I # Other side of partition 
1 beam_other_half_inside_xcoord=9.5 
; beam_other_half_inside_ycoord=9.5 
! beam other half inside zcoord=4.5 
I selectedBeamCells_other_half=beamCells.findAt( (beam_other_half_inside_xcoord, 
! beam_other_half_inside_ycoord, 
I beam_other_half_inside_zcoord),) 

I # Combine both partitions into one region 
j beamMeshRegion=(selectedBeamCells_one_half,selectedBeamCells_other_half) 
i I # Set the element type 
j beamPart.setElementType(regions=beamMeshRegion, elemTypes=(mesh_element_type,)) 

i I # Seed the part 
! beamPart.seedPart(size=9.25, deviationFactor=0.1} 

I 
I # Generate the mesh 
I beamPart .generateMesh() 

mesh_element_type = mesh.ElemType(elemCode=DC3D8, elemlibrary=STANDARD) 

You have seen the ElemTypeQ method in previous examples such as section 4.3.12 on 

page 83 of the Cantilever Beam example. To jog your memory, the ElemTypeQ method 

creates an ElementType object which can later be used as an argument to the 

setElementTypeQ method. The only required argument is elemCode which is a 

symbolic constant in Abaqus that specifies the element code. We use DC3D8 which is an 

8-node I in ear brick heat transfer element. 
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# One side of partition 
beam_one_half_inside_xcoord=9.5 
beam_one_half_inside_ycoord=e.s 
beam_one_half_inside_zcoord=l.S 
selectedBeamCells_one_half=beamCells.findAt((beam_one_half_inside_xcoord, 

beam_one_half_inside_ycoord, 
beam_one_half_inside_zcoord),) 

Remember that we have partitioned the beam. In order to mesh it we will need to select 
the cells on both sides of the partition. The above statements select the cells on one side 
of the partition. The coordinates supplied to the findAtO method are (0.5,0.5, 1.5) which 
is the center of this side of the partition. The variable selectedBeamCells_one_balf 
refers to the cells on this side of the partition. 

# other side of partition 
beam_other_half_inside_xcoord=9.5 
beam_other_half_inside_ycoord=9.5 
beam other half inside zcoord=4.5 
sele;tedBeimeells_othe~_half=beamCells.findAt((beam_other_half_inside_xcoord, 

beam_other_half_inside_ycoord, 
beam_other_half_inside_zcoord),) 

These statements repeat the procedure for the other side of the partition. The variable 
selectedBeamCells other balf refers to the cells on this other side. 

# Combine both partitions into one region 
beamMeshRegion=(selectedBeamCells_one_half,selectedBeamCells_other_half) 

Now that we have the cells on both sides of the partition stored in two variables 
selectedBeamCells_one_balf and selectedBeamCells_otber_balf, we can create a 
Region object which consists of all the cells by separating them with a comma and 
putting parentheses around them. 

# Set the element type 
beamPart.setElementType(regions=beamMeshRegion, elemlypes=(mesh_element_type,)) 

# Seed the part 
beamPart.seedPart(size=9.25, deviationFactor=9.1) 

# Generate the mesh 
beamPart.generateMesh() 

You have seen the setEiementTypeO, seedPartO and generateMesbO methods in 
previous examples and can refer to section 4.3.12 on page 83 of the Cantilever Beam 
example for an explanation. 
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The following code runs the job 

r-;--=-·=-=-~-~·=·~-~~-=-·=-=-~-=-:.-=-=-·=-::-::-=·~·=-=·=-·=-~·==-=-~-~-=··=·=··=·-=-~-=··=-=·-=-·=-~-=-.:-=-=---~~-=-~-~-==-=-=-=-=-=-=-=-=~-~-~-=--=-----·---·----·· 
I 

i # Create and run the job 
I 
i import job 
! 
I i # Create the job 

i mdb.Job(name='HeatTransferJob', model='Heat Transfer', type=ANALYSIS, 
I description='Job simulates heat conduction through beam') 
i 
I # Run the job 
I mdb.jobs['HeatTransferJob'].submit(consistencyChecking=OFF) 

I # Do not return control till job is finished running 
I mdb.jobs['HeatTransferJob').waitForCompletion() 

I # End of run job 

These statements are similar to ones used previously. You may refer back to Section 

4.3.13,on page 88. 

The following code displays the nodal temperatures as a contour plot. It also changes the 

camera angle to view the beam from the left. 

I # ---- -- - - ---- -------=-=-=-- ------ --------- -- -------- - -- -~ -------- ---- --- -- --' I # Post processing 

i import visualization 
! 

i 

I 

heattransfer_viewport = session.Viewport(name='Beam Results Viewport') 
heattransfer_Odb_Path = 'HeatTransferJob.odb' 
an_odb_object = session.openOdb(name=heattransfer_Odb_Path) 
heattransfer_viewport.setValues(displayedObject=an_odb_object) 

i # display nodal temperatures i heattransfer_viewport.odbDisplay.setPrimaryVariable(variableLabel='NTll', l outputPosition=NODAL) 

1 # plot these nodal temperatures as contours 
i heattransfer_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEF, )) I 
I # Move camera angle to adjust view I 
i #Possible values are 'Front', 'Back', 'Top', 'Bottom', 'Left', ' Right', 'Iso', 
L-----oNMN~~N-•• ----•-Noooo•ooo••• ''"OONN-••-----·-H ...... _ ,_ '"'" '""' " . ............ ... -------- --·- - · ,,_ ............. , _ _ , , , ,.,_ .. " 0 _,._,.,,_, - ~ --------·---____ ,_., ___ , .. _,_~ON .. O __ ,. ___ -·-·------·-·-
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! # 'User -1', 'User-2', 'User-3', and 'User-4'. 
j heattransfer_viewport.view.setValues(session.views['Top']) 
i heattransfer_viewport.view.setValues (session.views['Right']) 

# Save a view as user-1 
session.View(name='User-1', nearPlane=9.8695, farPlane=15.588, width=5.116, 

height=3.8197, projection=PERSPECTIVE, 

I 
I 
I 
! 

cameraPosition=(7.258, 6.2162, 11 . 582) , 
cameraUpVector=( -8.29634, 8.88595, -0.35675), 
cameraTarget=(0.5, 0.5, 3), viewOffsetX=0, vieWOffsetY=0, autoFit=OFF) ! 

·-·---1 

heattransfer_viewport = session.Viewport(name='Beam Results Viewport') 
heattransfer_Odb_Path = 'HeatTransferJob.odb' 
an_odb_object = session.openOdb(name=heattransfer_Odb_Path) 
heattransfer_viewport.setValues(displayedObject=an_odb_object) 

These statements are almost identical to the ones used in the Cantilever Beam example. 
Refer back to section 4.3.14 on page 89 to review the ViewportO, openOdbO and 
viewpo rt.set VaJuesO methods. 

heattransfer_viewport.odbDisplay.setPrimaryVariable(variableLabel='NTll', 
outputPosition=NODAL) 

The setPrimaryVariableO method tells Abaqus which of the field output variables you 
wish to explore. In the next statement when we use display.setValuesO to plot a contour 
plot Abaqus will plot the primary variable. variableLabel, field, and outputPosition are 
required arguments. variableLabel is a String referring to the field output variable 
whereas field is a String specifying the FieldOutput object. You must use either 
variableLabel or field but not both together. outputPosition specifies what position to 
obtain the data from using a SymbolicConstant such as NODAL or ELEMENT FACE, 
see the Abaqus Scripting Reference for other options. 

You are probably wondering how we knew the variable label is called 'NT11 ' . Abaqus 
uses the nodal variable NTxx. For continuum elements there is only one temperature 
value per node hence only NTII is applicable. For shells and beams a temperature 
gradient can exist through the shell thickness or beam cross-section hence other variables 
such as NT12 and NT13 specify the gradients in the local 1- and 2-directions and so on. 
However the easiest way to figure out the variable label is the run the simulation once in 
CAE, and in the Visualization mode go to Result > Field Output. The output variable 
names for the simulation such as NT11, RFL 11 etc are listed here in the first column of 
the Field Output table. 
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heattransfer_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEFJ )) 

The display.setValuesO method was also used in the Cantilever Beam example. Refer 

back to section 4.3.14 on page 89 to review it. The only difference here is that plotStatc 

has been set to a different SymbolicConstant CONTOURS_ON_DEF instead of 

DEFORM in order to plot a calor contour ofNTl 1. 

heattransfer_viewport.view.setValues(session.views('Top']) 
heattransfer_viewport.view.setValues(session.views['Right']) 

(viewport).view.setValuesO allows you to set the camera angle for viewing the model in 

the visualization viewport. Here we set it to top view using sessions.views('Top'] and to 

right view using sessions.views['Right']. The possible values are Front, Back, Top, 

Bottom, Left, Right, Iso, User-1, User-2, User-3 and User-4. One way to see the list of 

sessions.views available is to go to the Kemal Command Line Interface (below your 

viewport in Abaqus) and type 'print session. views'. Here is what you see: 

>>>print session. views 

{'Front': 'SavedView object', 'Back': 'SavedView object', 'Top': 'SavedView object', 

'Bottom': 'SavedView object', 'Left': 'SavedView object', 'Right': 'SavedView 

object', 'lso': 'SavedView object', 'User-1': 'SavedView object', 'User-2': 

'SavedView object', 'User-3': 'SavedView object', 'User-4': 'SavedView object'} 

Needless to say, since we asked Abaqus to display a 'Righf view immediately after the 

'Top' view, we will never actually see the top view. Since the GUI (Abaqus/CAE) 

procedure involved displaying both views, the equivalent code for both has been used in 

the script to maintain consistency. 

For your information, the statements could also have been written as 

session.viewports['Beam Results Viewport'].view.setvalues(session.views['Top']) 
session.viewports['Beam Results Viewport'].view.setValues(session.views('Right']) 

if you didn' t already have the viewport assigned to the variable heattransfer_viewport. 

session.View(name='User-1', nearPlane=9.9695, farPlane=15.588, width=5.116J 
height=3.9197, projection=PERSPECTIVE, 
cameraPosition=(7.258, 6.2162, 11.582)J 
cameraUpVector=(-9.29634, 9.88595J -9.35675), 
cameraTarget=(9.5, 9.5, 3)J viewOffsetX=9, vieWOffsetV=9, autoFit=OFF) 
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The ViewO method is used to save a certain view orientation to the ' User- I' button. It 
creates a new View object. All the arguments passed to the method here are required 
arguments. name is a String that names the view. nearPiane is a Float that sets the 
distance from the camera to the clipping plane and must be> 0.0. farPiane is a Float that 
sets the distance from the camera to the far clipping plane when farPianeMode is set to 
SPECIFY. It is required that farPiane > nearPiane. width and height are Floats 
specifying the width and height of the front clipping plane and must be > 0.0. projection 
is a SymbolicConstant defining the projection mode - either PERSPECTIVE or 
PARALLEL. cameraPosition is a sequence of 3 Floats which specify the position of the 
camera using the global coordinate system. cameraUpVector is a sequence of 3 Floats 
specifYing the positive Y -axis of the camera body, it allows you to partially orient the 
camera. cameraTarget is a sequence of 3 Floats which specifY what point the camera 
must look at. So cameraPosition, cameraUpVector and cameraTarget together specifY 
the position and orientation of the camera. viewOffsetX and viewOffsetY are Floats 
which specify the amount to pan the model in the screen X- and Y -directions as a fraction 
of the viewport width and height respectively. Since the camera orientation and target 
have been set, the viewOffsetX and viewOffsetY are actually panning the display, hence 
no rotation is produced in the view. Positive values are up in theY-direction and right in 
the X-direction. 

ll~S -Summary 
-=----"~----

In this chapter we scripted a steady state heat transfer model. This included applying heat 
flux loads and constant temperature boundary conditions. You also learnt to change the 
primary variable in Abaqus/Viewer to plot a color contour and to change the camera 
angle. The heat transfer example used here was a very simple one, the aim was to 
introduce you to a few of the commands you are likely to use in a Python script. The 
Abaqus Scripting Reference explains in detail all of the options available to you for heat 
transfer analyses. 
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In this chapter we will perform a contact analysis. The problem is displayed in the figure. 

We will use the contact pairs method (as opposed to the general contact method). 

Rectangular Block 

Curved Block 

4x10"N 

We use frictional properties for the contact interaction between the rectangular block and 

the plank, and frictionless contact between the plank and the curved block. 
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No friction between 
plank and curved block 

Friction between rectangular 
block and plank with friction 
coefficient= 0.1 

The dimensions the parts are displayed in the figure. All dimensions are in SI with length 
in meters. 

Curved Block 

Rectangular Block 

80 
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In this example the following tasks will be performed first using Abaqus/CAE, and then 
using a Python script. 

• Create a part 

• Assign materials 

• Assign sections 

• Create an Assembly using face to face constraints 

• Create multiple steps 

• Assign boundary conditions 
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• Assign loads 

• Identify surfaces 

• Assign interaction properties 

• Create interactions 

• Create a mesh 

• Create and sub m it a job 

The following new topics a.re covered in this example: 

• Model/ Preprocessing 
o Define surfaces in the assembly 
o Create interaction properties (specifically contact with and without 

friction) 

o Specify interaction pairs (contact surfaces) 

• Results I Post-processing 
o Plot contact pressures to identifY contact 

You can perform the simulation in Abaqus/CAE by following the steps listed below. You 

can either read through these. or watch the video demonstrating the process on the book 

website. 

1. Rename Model-I to Contact Simulation 
a. Right-click on Model- I in Model Database 

b. Choose Rename .. 
c. Change name to Contact Simulation 

2. Create the Plank 
a. Double-click on Parts in Model Database. Create Part window is displayed. 

b. Set Name to Plank 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 20 
h. Click OK. You will enter Sketcher mode. 
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1. Use the Create Lines: Rectangle (4 lines) tool to draw the profile of the 
plank 

J. Use the Add Dimension tool to set the width to 20 m and the thickness to 2 
m. 

k. Click Done to exit the sketcher. The Edit Base Extrusion window is 
displayed. 

I. Set Depth to 80.0 
m. ClickOK. 

3. Create the Curved Block 
a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Curved Block 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 20 
h. Click OK. You will enter Sketcher mode. 
1. Use the Create Circle: Center and Perimeter tool to draw a circle 
J. Use the Add Dimension tool to set the radius to 10 m. 
k. Use the Create Lines: Rectangle (41ines) tool to draw a rectangle 
I. Use the Add Dimension tool to set the height to 15 m 
m. Use the Auto Trim tool to trim out parts of the circle and the rectangle to 

create the desired profile 
n. Click Done to exit the sketcher. The Edit Base Extrusion window is 

displayed. 
o. Set Depth to 20.0 
p. Click OK. 

4. Create the Rectangular Block 
a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Rectangular Block 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 20 
h. Click OK. You will enter Sketcher mode. 
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1. Use the Create Lines: Rectangle (4 lines) tool to draw the profile of the 

plank 

J. Use the Add Dimension tool to set the width to 20 m and the height to 10 m. 

k. Click Done to exit the sketcher. The Edit Base Extrusion window is 

displayed. 

I. Set Depth to 35.0 

m. Click OK. 

5. Create the 2 materials 

a. Double-click on Materials in the Model Database. Edit Material window is 

displayed 

b. Set Name to AISI 1005 Steel 

c. Select General> Density. Set Mass Density to 7800 (which is 7.800 glee) 

d. Select Mechanical > Elasticity> Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 

e. Again double-click on Materials in the Model Database. Edit Material 

window is displayed 

f. Set Name to Aluminum 2024-T3 

g. Select General> Density. Set Mass Density to 2770 (which is 2.770 glee) 

h. Select Mechanical> Elasticity> Elastic. Set Young's Modulus to 73.1E9 

(which is 73.1 GPa) and Poisson's Ratio to 0.33. 

6. Assign sections 

a. Double-click on Sections in the Model Database. Create Section window is 

displayed 

b. Set Name to Steel Section 

c. Set Category to Solid 

d. Set Type to Homogeneous 

e. Click Continue .•. The Edit Section window is displayed. 

f. In the Basic tab, set Material to the AISI l 005 Steel which was defined in 

the create material step. 

g. Click OK. 

h. Again double-click on Sections m the Model Database. Create Section 

window is displayed 

1. Set Name to Aluminum Section 

J· Set Category to Solid 

k. Set Type to Homogeneous 

I. Click Continue ... The Edit Section window is displayed. 
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m. In the Basic tab, set Material to the Alumioum 2024 - T3 which was 
defined in the material creation step. 

n. Click OK. 
7. Assign the sections to the parts 

a. Expand the Parts container in the Model Database. Expand the part Plank. 
b. Double-click on Section Assignments 
c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire plank. 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Aluminum Section. 
g. Click OK. 
h. Similarly assign Steel Section to the curved block and the rectangular block. 

8. Create the Assembly 
a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 
b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 
d. Set Parts to Plank 
e. Set Instance Type to Dependent (mesh on part) 
f. Click OK. The plank is instanced in the assembly. 
g. Again double-click on Instances. The Create Instance window is displayed. 
h. Set Parts to Cun'ed block 
1. Set Instance Type to Dependent (mesh on part) 
J. Check Auto-offset from other instances 
k. Click OK. The curved block is instanced in the assembly. 
I. Click the Create Constraint: Face to Face tool. You see the message Select 

a planar face or datum plane of the movable instance below the viewport. 
m. Click the bottom face of the curved block. You see the message Select a 

planar face or datum plane of the fixed instance below the vieport 
n. Click the bottom face of the plank. Arrows appear on the faces and you see 

the message The instance will be moved so that the arrows point in the 
same direction below the viewport. 

o. Click OK or Flip as required to have the arrows pointing in the same 
direction. You see the prompt Distance from the fixed plane along its 
normal below the viewport. 
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p. Set it to 25.0 
q. Similarly use face to face constraints on the other two surfaces to align the 

parts as displayed in the figure. 

r. Again double-click on Instances. The Create Instance window is displayed. 

s. Set Parts to Rectangular block 

t. Set Instance Type to Dependent (mesh on part) 

u. Check Auto-offset from other instances 

v. Click OK. The rectangular block is instanced in the assembly. 

w. Use the Create Constraint: Face to Face tool 3 more times to align the 

parts as shown in the figure. 

9. Create Steps 

a. Double-click on Steps in the Model Database. The Create Step window is 

displayed. 

b. Set Name to Make Contact 

c. Set Insert New Step After to Initial 

d. Set Procedure Type to General> Static, General 

e. Click Continue •. The Edit Step window is displayed 

f. In the Basic tab, set Description to Push parts together to avoid chatter. 

g. ClickOK. 

h. Once again double-click on Steps in the Model Database. The Create Step 

window is displayed. 

1. Set Name to Apply Force 

J. Set Insert New Step After to Initial 

k. Set Procedure Type to General> Static, General 

I. Click Continue •. The Edit Step window is displayed 

m. In the Basic tab, set Description to Apply force on one end of the plank. 

n. Click OK. 

10. Leave Field Output Requests at defaults 

11 . Leave History Output Requests at defaults 

12. Apply boundary conditions 

a. Double-click on BCs in the Model Database. The Create Boundary 

Condition window is displayed 

b. Set Name to Fix Plank End 

c. Set Step to Make Contact 

d . Set Category to Mechanical 

e. Set Types for Selected Step to Symmetry/Antisymmetry!Encastre 



286 Contact Analysis (Contact Pairs Method) 

f. Click Continue ••• 
g. You see the message Select regions for the boundary condition displayed 

below the viewport 
h. Select the end face of the shaft. 
1. Click Done. The Edit Boundary Condition window is displayed. 
J. Choose ENCASTRE (Ul=U2=U3=UR1=UR2=UR3=0). 
k. ClickOK. 
I. Similarly create a second boundary condition called Fix Curved Block, 

applied during the Make Contact step with ENCASTRE. This is applied to 
the bottom of the curved block. 

m. Create a third boundary condition called Fix Rectangular Block, applied 
during the Make Contact step with ENCASTRE. This is applied to the end 
face of the rectangular block. 

n. Create a forth boundary condition called Press Plank Curved, applied 
during the Make Contact step. Set Type for Selected Step to 
Displacement/Rotation. Select the top surface of the plank to apply the 
boundary condition. When the Edit Boundary Condition window is 
displayed, set U2 to -lE-8 and Ul=U3=UR1=UR2=UR3=0. Click OK 

o. Create a fifth boundary condition called .Press Rect Plank, applied during 
the Make Contact step. Set Type for Selected Step to 
Displaccement/Rotation. Select the top surface of the rectangular block to 
apply the boundary condition. When the Edit Boundary Condition window 
is displayed, set U2 to -lE-8 and Ul=U3=URl=UR2=UR3=0. Click OK 

p. Right click on BCs in the Model Database. Choose Manager.. . The 
Boundary Condition Manager window is displayed 

q. For the boundary conditions Press Plank Curved and Press Rect Plank, 
deactivate both in the Apply Force step using the Deactivate button. For the 
boundary condition Fix Curved Block use the Move Left button to activate 
it in the Initial step. For the boundary conditions Fix Plank End and Fix 
Rectangular Block use the Move Right button to activate them in the 
Apply Force step. The table should look as follows: 

Name Initial Make Contact Apply Force 
Fix Curved Block Created Propagated Propagated 
Fix Plank End Created 
Fix Rectangular Block Created 
Press Plank Curved Created Inactive 
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I Press Rect Plank I Created I Inactive 

r. Click Dismiss 

13. Assign Loads 

a. Double-click on Loads in the Model Database. The Create Load window is 

displayed 

b. Set Name to Concentrated forces at corners 

c. Set Step to Apply Force 

d. Set Category to Mechanical 

e. Set Type for Selected Step to Concentrated Force 

f. Click Continue ..• 

g. You see the message Select points for the load displayed below the 

viewport 

h. Select the two corners of the plank by clicking on them. You will need to use 

the "Shift" key on the keyboard to select both of them. 

1. Click Done. The Edit Load window is displayed 

J. Set CF2 to -4E6to apply a 4000000 N force in downward (negative Y) 

direction 
k. Click OK 

I. You will see the forces displayed with arrows in the viewport on the selected 

nodes 

14. Assign surfaces 

a. Expand the Assembly container in the Model Database. 

b. Double-click on Surfaces. The Create Surface window is displayed 

c. Set Name to rect block bottom 

d. Click Continue .. . You see the message Select the regions for the surface 

displayed below the viewport 

e. Set it to individually with the dropdown menu 

f. Select the bottom surface of the rectangular block. You might need to 

suppress the face to face relationship between the rectangular block and the 

plank in order to make the bottom surface visible. Then resume the 

relationship. 

g. Similarly assign the surface curved block top to the top surface of the 

curved block 

h. Similarly assign the surface plank bottom to the bottom surface of the plank 

i. Similarly assign the surface plank top to the top surface of the plank 

15. Assign interaction properties 
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a. Double click Interaction Properties in the Model Database 
b. Set Name to Frictionless 
c. Set Type to Contact 
d. Click Continue ••. The Edit Contact Property window is displayed 
e. Select Mechanical > Tangential Bebavior. lt is added to the Contact 

Property Options list. 
f. Set Frictional formulation to Frictionless 
g. Once again double click Interaction Properties in the Model Database 
h. Set Name to Frictional 
1. Set Type to Contact 
J. Click Continue ... The Edit Contact Property window is displayed 
k. Select Mechanical > Tangential Bebavior. It is added to the Contact 

Property Options list. 
I. Set Frictional formulation to Penalty 
m. Set Friction Coeffto 0.1 
n. ClickOK 

16. Create interactions 
a. Double click Interactionsin the Model Database 
b. Set Name to Curved Plank Interaction 
c. Set Step to Apply Force 
d. Click Continue ... 
e. You see the message Select the master surface displayed below the 

viewport 
f. Set it to individually 
g. Click the Surfaces .•. button. The Region Selection window is displayed. 
h. Choose curved block top 
1. Click Continue ••• 
J. You see the prompt Select the slave type displayed below the viewport 
k. Click Surface. The Region Selection window is displayed 
1. Choose plank bottom 
m. Click Continue ••• The Edit Interaction window is displayed 
n. Set Contact interaction property to Frictionless. Leave all other options at 

default. 
o. ClickOK 
p. Double click Interactionsin the Model Database 
q. Set Name to Rectangular Plank Interaction 
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r. Set Step to Apply Force 

s. Click Continue ... 

t. You see the message Select the master surface from the dialog displayed 

below the viewport. The Region Selection window is displayed. 

u. Choose rectangular block bottom 

v. Click Continue ... 

w. You see the prompt Select the slave type displayed below the viewport 

x. Click Surface. The Region Selection window is displayed 

y. Choose plank top 

z. Click Continue ... The Edit Interaction window is displayed 

aa. Set Contact interaction property to Frictional. Leave all other options at 

default. 

bb. Click OK 

17. Create the mesh 

a. Expand theParts container in the Model Database. 

b. Expand Plank 

c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 

d. Using the menu bar click on Mesh> Element Type •.• 

e. You see the message Select the regions to be assigned element types 

displayed below the viewport 

f. Click and drag using your mouse to select the entire plank. 

g. Click Done. The Element Type window is displayed. 

h. Set Element Library to Standard 

1. Set Geometric Order to Linear 

J. Set Family to 3D Stress 

k. Check Reduced Integration 

I. You will notice the message C3D8R: An 8-node linear brick, reduced 

integration, hourglass control 

m. ClickOK 

u. Using the menu bar lick on Seed >Part ••• The Global Seeds window ts 

displayed 

v. Set Approximate global size to 4. Leave everything else at default values. 

w. ClickOK. 

x. You see the message Seeding definition complete displayed below the 

viewport. Click Done. 
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y. Using the menu bar click on Mesh> Part 
z. You see the prompt OK to mesh the part? displayed below the viewport 
n. Click Yes 
o. Repeat the same process for Curved Block and Rectangular Block 

18. Create and submit the job 
a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 
b. Set Name to ContactSimulationJob 
c. Set Source to Model 
d. Select Contact Simulation (it is the only option displayed) 
e. Click Continue .• The Edit Job window is displayed 
f. Set Description to Run tbe contact simulation 
g. Set Job Type to Full Analysis. 
h. Leave all other options at defaults 
1. Click OK 
J. Expand theJobs container in the Model Database 
k. Right-click on ContactSimulationJob and choose Submit. This will run the 

simulation. You will see the following messages in the message window: 
Tbe job input file "ContactSimulationJob.inp" bas been submitted for 
analysis. 
Job ContactSimulationJob: Analysis Input File Processor completed 
successfully 
Job ContactSimulationJob: Abaqus/Standard completed successfully 
Job ContactSimulationJobcompleted successfully 

19. Plot mises stress and contact pressures 
a. Right-click on ContactSimulationJob (Completed) in the Model Database. 

Choose Results. The viewport changes to the Visualization module. 
b. In the tool bar click the Plot Contours on Deformed Shape tool. The M ises 

stresses are displayed on the deformed plank and on the rectangular and 
curved blocks. 

c. Using the Field Output toolbar change Primary to CPRESS. The contact 
pressures are displayed on the parts. 

d. Click the Frame Selector tool and use the slider to observe contact pressures 
over a few frames 

e. In the Display Group toolbar click the Replace Selected tool 
f. You see the message Select entities to replace displayed below the viewport 
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g. Set it to Part instances with the dropdown 

h. Click the curved block in the viewport 

1. Click Done. The view of the assembly in the viewport has been replaced 

with the curved block. 

J. Use the slider of the Frame Selector tool to go to frame 6 (last frame) of the 

Make Contact step. You see contact pressures displayed on the curved block 

indicating that contact was established in this frame. 

k. In the Display Group toolbar click the Replace All tool to bring back the 

view of the assembly in the viewport 

IZ'~3_:lython ~cript · ( 
The following Python script replicates the above procedure for the contact simulations. 

You can find it in the source code accompanying the book in contact.py. You can run it 

by opening a new model in Abaqus/CAE (File > New Model Database > With 

Standard/Explicit Model) and running it with File > Run Script ... 
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I from abaqus import • I I from abaqusConstants import * 
1 I import regionToolset 1 

L_se~-~~~~-:~~~wpo_:~ s [ 'View~or~.:.--~~tV~!~~~S-~..!~.P..~~!.:~~Obj e~.!-~~~~~2-------·-----· _______ ..! 

These statements are identical to those used in the Cantilever Beam example and were 
explained in section 4.3.1 on page 65 

The following block creates the model 

r···#·~-~-~-~~-=-~~-=-=-=·=-~-.:-~·-.:~-~-=-~ .. ~-=-~-=-~-~-=-=-~-~-=-~-= .. ~-=-~-=-~-~·=·= .. =-~-=-=~ .. = .. ~-=-~---=·=-.:-~--=-~·=-.:--·~-~=-~-~-~-~-~-~~-~-=-······-·--··· .. -·. I # Creat e the model 

G
, mdb.models.changeKey(f romName='Model-1', toName='Contact Simulation') 

contactModel = mdb .models['Contact Simulation') 
----- . -----------.. -··------·- ---·---.. -1 

These statements rename the model from 'Model-1' to 'Contact Simulation' . They are 
almost identical to those used in the Cantilever Beam examp]e and were explained in 
section 4.3.2 on page 67. 
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···----····----·-········---·-···--···--·--------------····----···········-········-·······--·····- ····-·-·---·-·······- ·······-·-··-··--········---····-···-·······-······-······--· ·-·- ····- ···-··--·----·-·-····---··--··--·--····-·-··· •• 1 

# --------- -- ----------------- ---- ------ - --- -- ----- - ------------ ----------
# Create the parts 

I 
import sketch 
import part 

I 
! # a) Plank 
! 
I # i) Sketch the plank cross section using rectangle tool 
I plankProfileSketch = contactModel.ConstrainedSketch(name='Plank Sketch', 

sheetSize=40) 
plankProfileSketch.rectangle(pointl=(-10.0,0.0), point2={10.0,2 .8)) 

# ii) Create a 30 deformable part named "Plank" by extruding the sketch 
plankPart=contactModel.Part(name='Plank', dimensionality=THREE_D, 

type=DEFORMABLE_BODY) 
I plankPart.BaseSolidExtrude(sketch=plankProfileSketch, depth=80.0) 
I 

# b) Curved block 

# i) Sketch the plank cross section using rectangle tool 
curvedBlockProfileSketch = contactModel \ 

.ConstrainedSketch(name='Curved Block Sketch', sheetSize=40) 

curvedBlockProfileSketch.Arc3Points(point1={-10.0, e.e), point2=(10.8, 0.8), 
point3=(0.8, 18.0)) 

curvedBlockProfileSketch.Line(pointl=(-10.0, 8.0), point2=(-10.0, -15.8)) 
curvedBlockProfileSketch.Line(pointl=(-10.8, -15.0), point2=(1e.e, -15.8)) 
curvedBlockProfileSketch.Line(pointl=(le.e, -15.0), point2=(10.0, 0.8)) 

# ii) Create a 3D deformable part named "Curved Block" by extruding the sketch 
curvedBlockPart=contactModel.Part(name='Curved Block', dimensionality=THREE_D, 

type=DEFORMABLE_BODY) 
1 curvedBlockPart.BaseSolidExtrude(sketch=curvedBlockProfileSketch, depth=20.0) 

I 
1 # c) Rectangular block 
! 
i 

l 
# i) Sketch the plank cross section using rectangle tool 
rectangularBlockProfileSketch = contactModel \ 

I 
.ConstrainedSketch(name='Rectangular Block Sketch', sheet5ize=48) 

rectangularBlockProfileSketch.rectangle(point1=(e.e,e.e), point2=(20.0,19.0)) 

# ii) Create a 3D deformable part named "Rectangular Block" by extruding the sketch 
rectangularBlockPart=contactModel.Part(name='Rectangular Block', 

I dimensionality=THREE_D, type=DEFORMABLE_BODY) 

I 
rectangularBlockPart.BaseSolidExtrude(sketch=rectangularBlockProfileSketch, 

L---- - -- ______ ..::.:..de::!:pth=35.e) 

' 

I 
i 
I 

I __ i 
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This block of code creates the 3 parts - a rectangular plank, a block with a curved top, 
and a block. Aside from the ArcJPointsO method, everything else here should look 
familiar to you. The ConstrainedSketchQ, rectangleQ, PartO and BaseSolidExtrudeO 
methods were explained in section 4.3.3 on page 68 of the Cantilever Beam example. 

curvedBlockProfileSketch.Arc3Points(point1=(-10.0, 0.0) 1 point2=(10.0, 0.0) 1 

point3=(0.0, 10.0)) 

The ArcJPointsO method of the ConstrainedSketchGeometry object is used to draw an 
arc using two endpoints (pointl and point2) and a third point that lies somewhere on the 
arc (point3). It returns a ConstrainedSketchGeometry object, or None if the arc cannot 
be created. The ConstrainedSketchGeometry object is an object that stores the 
geometry of a sketch such as arcs and lines. 

curvedBlockProfileSketch.Line(pointl=(-10.01 0.0), point2=(-10.0, -15.0)) 
curvedBlockProfileSketch.Line(pointl=(-10.0, -15.0), point2=(10.0, -15.0)) 
curvedBlockProfileSketch.Line(point1=(10.9, -15.0), point2=(10.9, 9.0)) 

The LineO method of the ConstrainedSketchGeometry has been used earlier in the 
truss example, section 7.4.3 on page 130. To refresh your memory, it draws a line using 
two points supplied as arguments. lt returns a ConstrainedSketchGeometry object, or 
None if the line cannot be created. 

All the statements except the last one are very similar to the ones used in the Cantilever 
Beam example. To refresh your memory on the ConstrainedSketchQ, rectangleO and 
PartO methods, refer back to section 4.3.3. 

--- ~ ~~~ 

The following block creates the material for the simulation 

I # ----- ------------------------------------------- ---- ------ --------------
1 # Create materials 

import material 

# create material AISI 1ees Steel by assigning mass density, youngs modulus and 
# poissons ratio 
steelMaterial = contactModel.Material(name='AISI 1ees Steel') 
stee1Material.Density(table=((7872, ), )) 
stee1Material.Elastic(table=((209E9, e.29), )) 

I# Create material Aluminum 2e24-T3 by assigning mass density, youngs modulus and 
I # poissons ratio -·---- ·-------------·-·----
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,------------- --·---------------------·----------·--------------, 
i aluminumMaterial = contactModel.Material(name='Aluminum 2824-T3') 1 

I aluminumMaterial.Density(table=((2770, ), )) 1 

~luminumMaterial.Elastic(table=((73.1E9, 0.33), )) J 
------- _., __ ,. ·------- ----- - --- ------ -

The statements are similar to those used in the Cantilever Beam example and were 

explained in section 4.3 .4 on page 71. 

~~=··::-::-:·=-~-=-:~-.:-~:·::-:.-~-=-~-_:-~--~-=-=-=-~-~-=-:~-=-=-=-=---.:-=·::-_-_-::-·=·::-:.-::-=-::-=-=-~-=··:::-::-:·:::-::-:-·::-.:-~-=-- _-__ -__ -__ -__ -__ -·---····--------· 
I # Create solid sections and assign the parts to them 

import section 

# Create a section to assign to the beam 
steelSection = contactModel.HomogeneousSolidSection(name='Steel Section·, 

material='AISI 1995 Steel') 
aluminumSection = contactModel.HomogeneousSolidSection(name='Aluminum Section', 

material='Aluminum 2024-T3') 

# Assign aluminum section to plank 
plank_region = (plankPart.cells,) 
plankPart.SectionAssignment(region=plank_region, sectionName='Aluminum Section') 

! # Assign steel section to curved block 
j curved_block_region = (curvedBlockPart.cells,) 
1 curvedBlockPart .SectionAssignment(region=curved_block_region, 
1 sectionName='Steel Section') 
I 
I # Assign steel section to rectangular block 
1 rectangular_block_region = (rectangularBlockPart.cells,) 
j rectangularBlockPart.SectionAssignment(region=rectangular_block_region, 
!~----- sectionName='Steel Section'..:.) ___ _ J 

The procedure followed here is similar to that in section 4.3.5 of the Cantilever Beam 

example on page 72. The HomogcneousSolidSectionO and SectionAssignmentO 

methods are used as before. Two sections 'steelSection' and 'aluminumSection' are 

created, which are then assigned to the appropriate parts. 
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1---;~-=-==-=-::-:.~~ ----------- -- -- -- --·.:-~==·=-=-.:-=-=-=·=-:~-=-~-=-=----=--:=---~-=-=-=---------------·-··1 
# Create the assembly 

I import assembly 

# Create the part instances 
contactAssembly = contactModel. rootAssembly 
planklnstance = contactAssembly.Instance(name='Plank Instance', part=plankPart, 

dependent=ON) 
curvedBlockinstance = contactAssembly.Instance(name='Curved Block Instance', 

part=curvedBlockPart, dependent=ON) 
rectangularBlocklnstance = contactAssembly \ 

.Instance(name='Rectangular Block Instance', 
part=rectangularBlockPart, 
dependent=ON) 

# +++++++++++++++++++++++++++++++++++++++++++++++ 
# Identify all the faces used to constrain the assembly 

I # plank front face 

I plank_constraint_face_l_point = (1e.e, 1.e,0.0) 
plank_constraint_face_l = planklnstance.faces \ 

/ .findAt(plank_constraint_face_l_point,) 

I # plank bottom face 
plank_constraint_face_2_point (0.0,0.0,30.0) 

l
l plank_constraint_face_2 = planklnstance.faces \ 

.findAt{plank_constraint_face_2_point,) 

I # plank side face I plank_constraint_face_3_point = {-10. 0,1.0,30.0) 
I plank_constraint_face_3 = plankinstance.faces \ I .findAt(plank_constraint_face_3_point,} I 

# curved block front face 
curvedBlock_constraint_face_1_point = (-10.0,-7.5,10.0) 
curvedBlock constraint face 1 = curvedBlockinstance.faces \ 

- - - .findAt(curvedBlock_constraint_face_l_point,) 

# curved block bottom face 
curvedBlock constraint face 2_point = (0 .0, -15.0,10.0) 
curvedBlock-constraint- face- 2 = curvedBlocklnstance.faces \ 

- - - .findAt(curvedBlock_constraint_face_2_point,) 

# curved block side face 
curvedBlock constraint face 3 point = (0.0, -7.5,0.0) 
curved8lock-constraint- face_3_= curvedBlocklnstance.faces \ 
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# rectangular block front face 
rectangularBlock_constraint_face_1_point = (10.8,5.8,0.0) 
rectangularBlock_constraint_face_1 = rectangularBlockinstance.faces \ 

.findAt(rectangularBlock_constraint_face_l_point,) 

# rectangular block bottom face 
rectangularBlock_constraint_face_2_point = (1B.e,e.a,17.5) 
rectangularBlock_constraint_face_2 = rectangularBlockinstance.faces \ 

.findAt{rectangularBlock_constraint_face_2_point,) 

# rectangular block side face 
rectangularBlock_constraint_face_3_point = (0.0,5.0,17.5) 
rectangularBlock_constraint_face_3 = rectangularBlockinstance.faces \ 

.findAt(rectangularBlock_constraint_face_3_point,) 

# +++++++++++++++++++++++++++++++++++++++++++++++ 
# Identify all the faces used for boundary conditions 

# plank front face, will be fixed 
plank_encastre_face_point = (10.0,1.0,0.0) 
plank_encastre_face = plankinstance.faces.findAt((plank_encastre_face_point,)) 
plank_encastre_region=regionToolset.Region(faces=(plank_encastre_face)) 

# curved block bottom face, will be fixed 
curvedBlock_encastre_face_point = (0.0,-15.0,10.0) 
curvedBlock_encastre_face = curvedBlockinstance.faces \ 

.findAt((curvedBlock_encastre_face_point,)) 
curvedBlock_encastre_region regionToolset \ 

.Region(faces=(curvedBlock_encastre_face)) 

j # rectangular block front face, will be fixed 

I 
rectangularBlock_encastre_face_point = (10.0,5.0,0.0) 
rectangularBlock_encastre_face = rectangularBlockinstance.faces \ 

.f.indAt((rectangularBlock_encastre_face_point,)) 
· rectangularBlock_encastre_region regionToolset \ 

.Region(faces=(rectangularBlock_encastre_face)) 

# plank top face, will be pushed down 
plank_displacement_face_point = (0.0,2.0,30. 0) 
plank_displacement_face = plankinstance.faces \ 

i 

I 
Ill 

# rectangular block top face, will be pushed down 
I 

.findAt((plank_displacement_face_point,)) 
plank_displacement_region=regionToolset.Region(faces=(plank_displacement_face)) 

rectangularBlock_displacement_face_point = (10.0,10.0,17.5) : 
rectangularBlock_displacement_face = rectangularBlockinstance.faces \ 1 

.findAt((rectangularBlock_displacement_face_point,)) · 
rectangularBlock_displacement_region=regionToolset \ I 

-·-----·--··-~--~---~------------------·-····----·-···---·--·----··----·-·---------·---··----------------·------·-·----·----..: 
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# +++++++++++++++++++++++++++++++++++++++++++++++ 
# Identify vertices used for loads 

vertices_for_force plankinstance .vertices.findAt(({-10.0, 0.0, 80.0),), 
({10.0, 0.0, 80.0),), ) 

# +++++++++++++++++++++++++++++++++++++++++++++++ 

# Identify faces used to define Surfaces in the assembly. These will later be used 
# for contact interactions. 

# rectangular block bottom surface 
rectangularBlock_bottom_surface_point = {10.0,0.0,17.5) 
rectangularBlock_bottom_surface = rectangularBlockinstance . faces \ 

.findAt((rectangularBlock_bottom_surface_point,)) 

# curved block top surface 
curvedBlock_top_surface_point {0.0,10.0,10.0) 
curvedBlock_top_surface = curvedBlockinstance.faces \ 

. findAt((curvedBlock_top_surface_point,)) 

# plank bottom surface 
plank_bottom_surface_point = {0.0,0.0,30.0) 
plank_bottom_surface = plankinstance.faces.findAt((plank_bottom_surface_point,)) 

# plank top surface 
plank_top_surface_point = (0.0,2.0,30.0) 
plank_top_surface = plankinstance.faces.findAt((plank_top_surface_point,)) 

# +++++++++++++++++++++++++++++++++++++++++++++++ 
# assemble the parts using face to face relationships 

# establish face to face relationships between plank and curved block 
contactAssembly.FaceToFace(movablePlane=curvedBlock_constraint_face_l, 

fixedPlane=plank_constraint_face_l, 
flip=OFF, clearance=-30.0) 

contactAssembly . FaceToFace(movablePlane=curvedBlock_constraint_face_2, 
fixedPlane=plank_constraint_face_2, 
flip=OFF, clearance=25.0) 

contactAssembly.FaceToFace(movablePlane=curvedBlock_constraint_face_3, 
fixedPlane=plank_constraint_face_3, 
flip=ON, clearance=-20.0) 

# establish face to face relationships between plank and rectangular block 
contactAssembly. FaceToFace(movablePlane=rectangularBlock_constraint_face_l, 

fixedPlane=plank_constraint_face_l, 
flip=OFF, clearance=e.e) 

contactAssembly.FaceToFace(movablePlane=rectangularBlock_constraint_face_2, 
fixedPlane=plank_constraint_face_2, 
flip=OFF, clearante=- 2.0) 
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----~~-------·------------~------··-----------------------------·---------·--·--··----·---
-·---... 

I
. contactAssembly .FaceToFace(movablePlane=rectangularBlock_constraint_face_3, ; 

fixedPlane=plank_constraint_ face_3, _1,

11 flip=OFF, clearance=0.0) 

# Create the part instances 
contactAssembly = contactModel . rootAssembly 
plankinstance = contactAssembly.Instance(name='Plank Instance· , part=plankPart, 

dependent=ON) 

curvedBlockinstance = contactAssembly.Instance(name='Curved Block Instance', 
part=curvedBlockPart, dependent=ON) 

rectangularBlockinstance = contactAssembly \ 
. Instance(name='Rectangular Block Instance', 

part=rectangularBlockPart, 
dependent=ON) 

The procedure followed in these statements is identical to that of the Cantilever Beam 

example, section 4.3.6 on page 74. The InstanceO method is used 3 times to create the 3 

part instances. 

# +++++++++++++++++++++++++++++++++++++++++++++++ 

# Identify all the faces used to constrain the assembly 

# plank front face 
plank_constraint_face_l_point = (19.9,1.9,9.9) 
plank_constraint_face_l = plankinstance.faces \ 

.findAt(plank_constraint_face_l_point,) ... 

(and so on) 

The faces.findAtO method is used to select the front face of the instance of the plank and 

assign it to the variable 'plank_constraint_face_ l ' .The coordinates (10.0, 1.0, 0.0) are 

based on the fact that all the parts are instanced at the same coordinates in the assembly 

as they were created in the part module (even if this means they overlap in the assembly) 

and also based on your knowledge of the part geometry/dimensions. 

The reason we are identifYing the faces and storing them in variables is that the part 

instances will later be assembled together using face-to-face position constraints, and we 

will need to pass the constraint faces to the FaceToFaccO method. Therefore the front, 

bottom and side faces of all 3 part instances are found and assigned to variables. 

# +++++++++++++++++++++++++++++++++++++++++++++++ 

# Identify all the faces used for boundary conditions 

# plank front face, will be fixed 
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plank_encastre_face_point = (19.9,1.9,9.9) 
plank_encastre_face • plankrnstance.faces.findAt((plank_encastre_face_point,)) 
plank_encastre_region=regionToolset.Region(faces=(plank_encastre_face)) 

(and so on) 

The front face of the plank is found using the faces.findAtO method. lt is then assigned 
to a region using the regionToolset.RegionO method when can later be used when 
assigning boundary conditions with the EncastreBCO method. In a similar manner, 4 
other faces are also found, which will be used with either the EncastreBCO or 
DisplacementBCO methods when assigning boundary conditions. 

#+++++++++Ill I ••++++++++++++++++++++++++++++++++ 
# Identify vertices used for loads 

vertices_for_force = planklnstance.vertices.findAt(((-19.9, 9.9, 89.9),), 
((19.9, 9.9, 89.9),),) 

The vertices.findAtO method is used to identify the two vertices on the instance of the 
plank where the loads will later be applied. 

# I I I I I I I I I I I I I I I I I I I I I I I I I I I I I I+++++++++++++++++ 

# Identify faces used to define Surfaces in the assembly. These will later be used 
# for contact interactions. 

# rectangular block bottom surface 
rectangularBlock_bottom_surface_point =· (19.9,9.9,17.5) 
rectangularBlock_bottom_surface = rectangularBlockinstance.faces \ 

.findAt((rectangularBlock_bottom_surface_point,)) 

~and so on) 

The faces.findAtO method is once again used to pick a face of the block part instance 
and assign it to a variable rectangularBiock_bottom_surface. This face however will 
not be used for boundary conditions but rather as a surface when defining the surface 
contact interactions. Similarly a few other surfaces are identified that will later be used to 
define the contact interactions. 

# ++flllllllllf++++++++++++++++++++++++++++++++++ 
# Assemble the parts using face to face relationships 
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# establish face to face relationships between ~lank and curved block 
contactAssembly.FaceToFace(movablePlane=curvedBlock_constraint_face_l, 

fixedPlane=plank_constraint_face_l, 
flip;OFF, clearance=-39.9) 

contactAssembly.FaceToFace(movablePlane=curvedBlock_constraint_face_2, 
fixedPlane=plank_constraint_face_2, 
flip=OFF, clearance=25.9) 

contactAssembly.FaceToFace(movablePlane=curvedBlock_constraint_face_3, 
fixedPlane=plank_constraint_face_3, 
flip=ON, clearance=-29.9) 

# establish face to face relationships between plank and rectangular block 
contactAssembly.FaceToFace(movablePlane=rectangularBlock_constraint_face_l, 

fixedPlane=plank_constraint_face_l, 
flip=OFF, clearance=9.9) 

contactAssembly.FaceToFace(movablePlane=rectangularBlock_constraint_face_2, 
fixedPlane=plank_constraint_face_2, 
flip=OFF, clearance=-2.9) 

contactAssembly.FaceToFace(movablePlane=rectangularBlock_constraint_face_3, 
fixedPlane=plank_constraint_face_3, 
flip=OFF, clearance=9.9) 

The FaceToFaceO method is used 6 times to create 6 face-to-face assembly constraints. 

The FaceToFaceO method moves an instance (movable instance) so that its face is 

coincident with another instance (fixed instance). The face on the movable instance is the 

movablePiane and the face on the fixed instance is the fixedPiane. These must be passed 

as arguments to the FaceToFaceO method. The other two required arguments are flip, a 

Boolean which specifies if the normal to the faces are in the same direction (OFF) or 

opposite direction (ON), and clearance, a Float which specifies the distance between the 

two faces once they have been aligned together. 

,.----·---------·----~---------------

: # ---------------------------- -- ---------- - -- - --------------------------- -
i i # Create the steps 

I import step 
I 
.

1

. # Create a step in which the parts will be pushed together to avoid chatter 
contactModel .• StaticStep( name=' Make Contact', previous=' Initial', 

description='Push parts together to avoid chatter', 
l nlgeom=ON, initiallnc=0.1) 

I 
U~ ..... ~!.:~.~.!.: ___ ~~!.:.E_,_~-~·--~-~.~~~·-.. ~-~.~-·!.?..~~~.~-.-~.~]:_1. ...... ~-: .. __ ~PP!_~~.~--·--·--.. -.. -·----·------·-------.. ·····--.. --.. -... --·---.. , .. ________ ,,_ 
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l
l contactModel .StaticStep(name='Apply Force ', previous;'Make Contact', , 

description='Apply force on one end of the plank' , J 
ini tiallnc=0.1) --------------------'------------------ --------

The statements are similar to the ones used in the Cantilever Beam example in section 
4.3.7 on page 75 with a few minor differences. Non-linear geometry has been turned on 
using nlgeom, the initial increment has been set to 0.1 using initiallnc, and there are two 

steps as opposed to one. 

The first step, 'Make Contact', will be used to push the parts together to establish contact 
between them. This helps since contact is a severe discontinuity and this makes helps 
Abaqus/Standard make the transition as smoothly as possible. The second step 'Apply 
Force' is the one in which the forces will be applied. 

The following block creates the field output requests. 

'"#-:-:::.---------------- ~-=-=-=-=-=-=-~-=-:.-=-=-=-=-=-:=-=-=-=-..:--~-=.-::-:-:..:-·::~=-=-~-=--=·-----
# Create the field output request 
# Leave at defaults 

No field output requests are created (or deleted), therefore field output variables are left 
at the defaults. 

. ~.ou~ut .rr~uests ............... ,:.._.........,... 

The following block defines the history output requests: 

# ----- -- ----------------------------------------------- ------------------
# Create the history output request 
# Leave at defaults 1.-------------------- . 

-, 
·-- ·------------' 

No history output requests are created (or deleted), therefore history output variables are 
left at the defaults. 

I # - --- --- -- - -- --- -- - --- ----------- ------------------- -- -- ~-::::-_--::-:-::-~-=-::-::-:-::~-------~ 
I # Ap~~y boundary conditions _ _ __ j 
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,--···------------- ---------------------------.. ------ -- ---------------, 
: contactModel.EncastreBC(name='Fix Plank End', createStepName='Apply Force', i 

I region:plank encastre region) ' 
I - -
! contactModel.EncastreBC(name='Fix Curved Block', createStepName='lnitial', 

I region=curvedBlock_encastre_region) 

· .• 1,. contactModel.EncastreBC(name='Fix Rectangular Block', 
. createstepName='Apply Force', 
' region=rectangularBlock_encastre_region) 

contactModel.DisplacementBC(name='Press Plank Curved', 
createStepName:'Make Contact', 
region=plank_displacement_region, 
u1=9.e, u2=-9.2, u3=0.0, ur1=9.e, ur2=9.e, ur3=9.9) 

contactModel.DisplacementBC (name='Press Rectangular Plank', 
createStepName='Make Contact', 
region=rectangularBlock_displacement_region, 
u1=0.e, u2=-0.21, u3=9.e, url=B.e, ur2=9. 0, ur3=9 .9) 

# Boundary conditions will be propagated from one step to the other by default 

#We want this to happen for 'Fix Curved Block' 
, #However we want to remove the BC for 'Press Plank Curved' and 'Press Rectangular 

j # Plank' 
: contactModel.boundaryConditions('Press Plank curved'].deactivate('Apply Force') 

I contactModel.boundaryConditions('P_r_e_s_s __ Re_c_t_a_ng_u_lar Plank'] \ 
.deactivate('Apply Force") 

----------~~~~----~----· 

You've seen the EncastreBCO method used in the Cantilever Beam example, section 

4.3 .11 on page 81. You've also seen the DisplacementBCO method used in the Beam 

Frame Analysis example, section 9.4.15 on page 220. These EncastreBCO method is 

used here to fix the end of the plank, the block and the bottom of the curved block. The 

DisplacementBCQ condition is used to move, and therefore press, the plank against the 

curved block and the block against the plank. 

contactModel.boundaryConditions['Press Plank Curved'].deactivate('Apply Force') 

contactModel.boundaryConditions['Press Rectangular Plank'] \ 
.deactivate('Apply Force') 

The deactivateO method of the BoundaryCondition object deactivates a boundary 

condition in a step, and the boundary condition remains deactivated in subsequent steps. 

The one required argument is stepName which is a String indicating the name of the step 

in which to deactivate the boundary condition. 
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12.4.11 Apply loads 
The following block applies the concentrated forces 

# ---------- -- - -- -- -------------- -- - - - - -- --- - --- - - - - ------ - -- - ----- --- --- -
# Apply concentrated forces 

contactModel.ConcentratedForce(name='Concentrated forces at corners', 
createStepName='Apply Force', 
region=(vertices_for_force,), 
cf2=-4E+6, distributionType=UNIFORM) 

The ConcentratedForceO method was explained in the plate bending example, section 
I 0.4.12 on page 248. Here it is used to apply a force in the negative Y direction 
(downward) of 400,000 Non the region vertices_for_force which was created earlier in 
the assembly module for this purpose using the vertices.findAtO method. 

The foJJowing block identifies and stores the surfaces which wiJJ later be used to define 
interactions 

# -- - --------- - ----- - - ------------------------ - ------------ - ------ ----- -- -
# Define surfaces to use in contact interactions ---1 
contactAssembly .Surface(sidelFaces=rectangularBlock_bottom_surface, 

name='Rect Block Bottom') 
contactAssembly.Surface(sidelFaces=curvedBlock_top_surface, 

name='Curved Block Top') 
contactAssembly.Surface(sidelFaces=plank_bottom_surface, name='Plank Bottom') 
contactAssembly.Surface(sidelFaces=plank_top_surface, name='Plank Top') 

The SurfaceO method creates a surface object, which stores surfaces identified in an 
assembly. The surface refers to the side that was specified in the possible required 
arguments, which for a 30 solid face are sidelFaces or side2Faces. By using sidelFaces 
we are telling Abaqus that the nonnal of our newly created Surface object is in the same 
direction as the nonnal of the face passed as the argument. Basically we are selecting the 
outer surface. The other required argument is name, which as you might have guessed is 
a String specifying the repository key. 

Four surfaces are created, and these wiJJ be used to define the contact interactions. 

I 
I 
I 
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l2.4.i3 ~reate interaC'tion Properti~~ . _ - . ~ , 
~~ ~ --.;.,~~ ~~~·"' CL' ...... ~;l~"WM.;- ~~ ' . . .. -~ ~ - -

The following block defines the interaction properties which will later be assigned to 

interactions 

l"#'"""~'~-=-=~-=~-==-=·= =··=·== ·=·=·=·=·=··=·=-=-=·=·=·=·~· = =·=·=·=··===·=· =·=··=··=·===·-~·=-=·-==·=-~=-=·=·=·=·=·= = .. =-=~-=·=-= .. =~·=-~-=~·=·----.. --···---····--------·--·--1 
I # Create interaction properties I 
I # Create a frictionless property 

1 

I 
frictionless_interaction = contactModel.ContactProperty('Frictionless') 

frictionless_interaction . TangentialBehavior(formulation=FRICTIONLESS) 

# Create a frictional property 
friction_interaction = contactModel.ContactProperty('Frictional') 
friction_interaction.TangentialBehavior(formulation=PENALTY, table=((e.l,) , ), 

fraction=e.ees) 

frictionless_interaction = contactModel.ContactProperty( ' Frictionless') 

The ContactPropertyO method is used to create a ContactProperty object. A 

ContactProperty object, which is derived from the InteractionProperty object, defines 

the contact interaction property. The only required argument for the ContactPropertyO 

method is name which is a String specifying the repository key for the interaction 

property. We name it 'Friction less' . The CootactPropertyO method returns a 

CootactProperty object, which we store in a variable frictiooless_interaction. 

friction_interaction = contactModel.ContactProperty('Frictional') 

This is similar to the previous statement. 

frictionless_interaction.TangentialBehavior(formulation=FRICTIONLESS) 

Here the TangentiaiBehaviorO method is used to create a ContactTangentiaffiehavior 

object. The TangentialBehaviorO method has no required arguments, the optional one 

used here is formulation. The default is FRICTIONLESS, other possible values are 

PENALTY, EXPONENTIAL_DECAY, ROUGH, LAGRANGE, and 

USER DEFINED. We use a FRICTIONLESS formulation 

friction_interaction.TangentialBehavior(formulation=PENALTY, table=((9.1,),), 
fraction=9.995) 

Here the TangentialBehaviorO method is used to create a ContactTangentiaffiehavior 

object. The TangentiaffiehaviorQ method has no required arguments, the optional ones 

used here are formulation, table and fraction. formulation is a SymbolicConstant 
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which specifies the friction formulation. The default is FRICTIONLESS, other possible 
values are PENALTY, EXPONENTIAL_DECAY, ROUGH, LAGRANGE, and 
USER_DEFINED. We use a PENALTY formulation. table is a sequence of sequences 
of Floats which specifY the tangential behavior. The table data specifies a number of 
values which are defined in the Abaqus Scripting Reference Manual, and these depend on 
the type of formulation. For a PENALTY or LAGRANGE formulation, the first value is 
friction coefficient in the first slip direction, which we specifY to be 0.1. fraction is a 
Float specifying the fraction of a characteristic surface dimension for maximum elastic 
slip. We specify 0.005. 

Just so you know, the last two statements can be combined and rewritten as: 

contactModel.interactionProperties('Frictional'] 1 
.TangentialBehavior(formulation=PENALTV, table=((e. l,),), fraction=e.ees) 

The following block creates the interactions 

-·#·---:_-~~~~-- -- - -- ---- --- -- - ·~-=-~-:~-~-.:-=·=-=-:·~·-::-:·:-=-=-~-:=-=-=-~-=-~-~··=·=-~-=·=·=·=-=-=-=-=-=-=---==-=-----------···-------·-··1 

:r::::::l::::::::::::urf ace _region " cont actAssembly. surfaces [ 'Curved Block Top' ] I! 

frictionless_slave_surface_region = contactAssembly.surfaces('Plank Bottom'] 

contactModel.SurfaceToSurfaceContactStd(name='Curved Plank Interaction', 
createStepName='Make Contact', 
master=frictionless_master_surface_region, 
slave=frictionless_slave_surface_region, 
sliding=FINITE, 
interactionProperty='Frictionless') 

frictional_master_surface_region = contactAssembly.surfaces['Rect Block Bottom'] 
frictional_slave_surface_region = contactAssembly.surfaces['Plank Top'] 

contactModel.SurfaceToSurfaceContactStd(name='Rect Plank Interaction', 
createStepName='Make Contact', 
master=frictional_master_surface_region, 
slave=frictional_slave_surface_region, 
sliding=FINITE, 
interactionProperty='Frictional') 

frictionless_master_surface_region = contactAssembly.surfaces['Curved Block Top'J 
frictionless_slave_surface_region = contactAssembly.surfaces['Plank Bottom'] 
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The surfaces 'Curved Block Top' and 'Plank Bottom' are assigned to the variables 

frictionless_master_surface_region and frictionless_slave_surface_region. The word 

' region' is used in the variable names to point out that these variables will subsequently 

be passed to the SurfaceToSurfaceCootactStdO method which requires Region objects 

as arguments. This is possible because a Region object is a link between a Set or a 

Surface object and its attributes. Here Abaqus will implicitly create Region objects 

associated with these surfaces. 

contactModel.SurfaceToSurfaceContactStd(name='Curved Plank Interaction', 
createStepName='Make Contact', 
master=frictionless_master_surface_region, 
slave=frictionless_slave_surface_region, 
sliding=FINITE, 
interactionProperty='Frictionless') 

This statement creates the interaction between the curved block and the plank. The 

SurfaceToSurfaceContactStdO method creates a SurfaceToSurfaceContactStd object 

which is derived from the Interaction object and defines surface-to-surface contact in an 

Abaqus/Standard analysis. All the arguments supplied here are required arguments. name 

is a String specifYing the repository key of the SurfaceToSurfaceContactStd object. 

createStepName is a String specifYing the name of the step in which the object is to be 

created. master and slave are Region objects specifYing the master and slave surfaces for 

the contact interaction. It was for this purpose that the variables 

friction less_ master_ surface_ region and frictionless _slave_ surface_ region were 

created in the previous statements. sliding is a SymbolicConstant - either FINITE or 

SMALL -which specifies the contact formulation. interactionProperty is the String 

specifYing the repository key of the ContactProperty object to associate with this 

interaction. We had named our interaction property ' Frictionless' and are now assigning 

that interaction property to this interaction. 

frictional_master_surface_region = contactAssembly.surfaces['Rect Block Bottom'] 

frictional_slave_surface_region = contactAssembly.surfaces['Plank Top'] 

contactModel.SurfaceToSurfaceContactStd(name='Rect Plank Interaction', 
createStepName='Make Contact', 
master=frictional_master_surface_region, 
slave=frictional_slave_surface_region, 
sliding=FINITE, 
interactionProperty='Frictional') 

The same procedure is repeated for the interaction between the plank and the rectangular 

block, except this time the interaction property 'Frictional' is assigned to the interaction. 
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# - ------------ --- ------- ----------------------- --- - ------------ ----------
# Create the mesh 

import mesh 

# +++++++++++++++++++++++++++++++++++++++++++++++ 
# Mesh the plank 
# We place a point somewhere inside it based on our knowledge of the geometry 
plank_inside_coord=(e.e,l.e,4e.e) 

elemTypel = mesh.ElemType(elemCode=C3D8R, elemlibrary=STANDARD, 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=DEFAULT, distortioncontrol=DEFAULT) 

plankCells=plankPart.cells 
selectedPlankCells=plankCells .findAt(plank_inside_coord,) 
plankMeshRegion=(selectedPlankCells,) 
plankPart.setElementType(regions=plankHeshRegion, elemTypes=(elemTypel,)) 

plankPart.seedPart(size=4, deviationFactor=0.1) 

plankPart.generateMesh() 

# +++I I I I I I I I I+++++++++++++++++++++++++++++++++++ 
# Mesh the curved block 
curvedBlock_inside_coord=(e.e,-s .e,le.e) 

elemTypel = mesh.ElemType(elemCode=C3DSR, elemlibrary=STANDARD, 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=DEFAULT, distortionControl=DEFAULT) 

curvedBlockCells=curvedBlockPart.cells 
selectedCurvedBlockCells=curvedBlockCells.findAt(curvedBlock_inside_coord,) 
curvedBlockMeshRegion=(selectedCurvedBlockCells,) 
curvedBlockPart .setElementType(regions=curvedBlockMeshRegion, 

elemTypes=(elemTypel,)) 

curvedBlockPart.seedPart(size=4, deviationFactor=9.1) 

curvedBlockPart.generateMesh() 

# +++++++++Ill I I I I 1+11 I I I I I I I I I I+++++++++ I Ill I I I I 
# Mesh the rectangular block 
rectangularBlock_inside_coord=(le.e,s.e,17.5) 

elemTypel = mesh .ElemType(elemCode=C3D8R, elemlibrary=STANDARD, 
kinematicSplit=AVERAGE_STRAIN, secondOrderAccuracy=OFF, 
hourglassControl=DEFAULT, distortionControl=DEFAULT) 
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,-·------·-·--··----···---·------·----····-··--··········---···-·-·--···-·····---··---··-····--·----·---·······-·············-··--·-····------··-· .. -·--·-·······-----·-·----------·---·------~ 

l rectangularBlockCells=rectangularBlockPart. cells I 
I selectedRectangularBlockCells=rectangularBlockCells \ I 
l .findAt(rectangularBlock_inside_coord,) I 

rectangularBlockMeshRegion=(selectedRectangularBlockCells,) i 
rectangularBlockPart.setElementType(regions=rectangularBlockMeshRegion, 1 

elemTypes=(elemTypel,)) I 
I 
i rectangularBlockPart.seedPart(size=4, deviationFactor=0.1) ! 

I - '~: 
~ngularBlockPart_. generateMesh() ___j 

There is nothing new for you to see here, the same meshing procedure has been followed 

in previous examples. The only difference is that there are 3 part objects in this model, 

hence the meshing script has been split into 3 blocks. 

2.4:i6:Cre~UaJ1d run.the job~~\· 
The following code runs the job 

I # -- - - -- - - - - - - - - - -- - ----------- ---- - - -------------- - -- - -------- - - ------- --

' # Create and run the job 

I import job 

# Create the job 
mdb.Job(name='ContactSimulationJob ' , model='Contact Simulation', 

type=ANALYSIS, explicitPrecision=SINGLE, 
nodalOUtputPrecision=SINGLE, description= ' Run the contact s imulation', 
parallelizationMethodExplicit=DOMAIN, multiprocessingMode=DEFAULT, 
numDomains=l, userSubroutine=' ', numCpus=l, memory=50, 
memoryUnits=PERCENTAGE, scratch='', echoPrint=OFF, modelPrint=OFF, 

I contactPrint=OFF, historyPrint=OFF) 

I # Run the job 
mdb . jobs['ContactSimulationJob'].submit(consistencyChecking=OFF) 

# Do not return cont rol till job i s finished running 
mdb.jobs['ContactSimulationJob'].waitForCompletion() 

_ _j 
These statements are similar to ones used previously. You may refer to Section 4.3 .13, on 

page 88. 
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r::::::t::::::::::~::essio~.Vi .. po~t(na~~-~~nt~ct-Si~~l~~:~~-~~~ults-:iew~ort•) 
contact_Odb_Path = ' ContactSimulationJob.odb' 
an_odb_object = session.openOdb(name=contact_Odb_Path) 
contact_viewport.setValues(displayedObject=an_odb_object) 
contact viewport.odbDisplay.display.setValues(plotState=(DEFORMED, )) 

These statements are similar to ones used in previous examples. You can refer to the 
Cantilever Beam example, section 4.3.14 on page 89. 

In this chapter you worked with contact, created interactions and assigned interaction 
properties. Contact is commonly encountered both in real life and in simulations that you 
will be creating in Abaqus. 

"' At this point we've worked through a number of model setups. Everything we've done so 
far could also have been implemented in Abaqus/CAE so you haven' t really harnessed 
the power of scripting yet. In subsequent chapters we will reuse some of the scripts you 
have created here to demonstrate important concepts such as optimization and 
parameterization. 
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We've looked at a number of scripting examples over the last few chapters. In each of 

these examples we ran not just one aspect of a simulation, but rather the entire simulation 

from model setup to job execution to post processing using Python scripts. The benefit of 

having an entire simulation in the form of a script is that you now have the power to 

programmatically control it, parameterize it, add conditions and loops, and easily alter it 

for different scenarios. One of the primary uses of scripting is optimization. 

In this chapter we shall look at an example of optimization using the planar shell (plate) 

bending model from Chapter 10. Let's assume you have a large supply of these plates and 

you'll be using them for construction or in a manufacturing project. It has been decided 

(for whatever reason) that you can save on material and component costs by maximizing 

the load borne by each plate. The materials expert has told you that the maximum 

allowable Mises stress in these plates is 35 MPa. You now need to figure out the 

maximum load these plates can withstand in bending while experiencing a stress less than 

35 MPa in order to optimize your design. Since you aren't really modifYing the plate 

based on the analysis, you aren't optimizing the design of the plate itself, however you 

will be optimizing your use of resources by loading each of the plates to their maximum 

capacity -and it is that maximum that you are tasked to find in this example. 

We wrote a script in Chapter 10 to run the plate bending simulation. We can modifY this 

same script to run our optimization procedure. The majority of the script will remain the 

same. This includes the blocks that deal with model, part, material, section, assembly, 
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step, field output request, history output request (we didn't have any), boundary 
condition, partition and mesh creation. This means over 90% of the script remains 
unchanged. 

The part of the script that needs modification is the application of the load. Since we are 
using the same concentrated forces and applying them at the same nodes, most of these 
statements will remain the same too. However we will put them inside a loop. At each 
iteration of the loop we will increase the magnitude of the concentrated forces. The block 
that creates and runs the job, as well as the post processing code, will need to be included 
inside of this loop so that the simulation can be rerun at each iteration of the loop and the 
results compared to our max stress criteria. 

We will need to specifY an initial force to use. We shall go with 5N. We will also need to 
specifY how much to increase the force for the next iteration. We can go with a 5N 
increase at each iteration, so in the next iteration a I ON force will be applied, then 15N 
and so on. Each analysis job will be given a new name which states the amount of force 
applied such as PlateJob5N, PlateJob I ON and so on. This way all the jobs will be listed in 
the model tree and output database list as they are created and run, and the user will be 
able to view the results of any of them if necessary. The results of each analysis will also 
be displayed in a new viewport which will pop-up over the previous one. 

In the plate bending simulation a field output report file was written at the end. In this 
optimization we will continue to write this field output report file at every iteration. We 
will then read from this report, and extract the maximum stress from it. We will record 
this maximum stress by storing it in a file called ' iterative_analysis.txt' in a folder called 
'Simulation results' so at the end of all the iterations we will have a table of force vs 
maximum stress. We will also compare this maximum stress to our maximum allowable 
stress of35 MPa and if it has been exceeded we will break out of the loop. 

At the end of the analysis we will highlight the elements of the plate which exceeded the 
maximum allowable stress and display the plate in the viewport so we can see at a glance 
where the stresses were too high. This gives me a chance to demonstrate how to change 
an element color within the visualization module. 
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13.3 . -~yt~on Scr~t ~ ···~" , 
The following is the completed Python script to accomplish this task. You can find it in 

the source code accompanying the book in plate_bending_optimization.py. You can run 

it by opening a new model in Abaqus/CAE (File > New Model Database > With 

Standard/Explicit Model) and running it with File > Run Script ... 

[ !fr:-cim : aba~us impqrt ' *. ~*~~ ... >)C: .· 
r f~om abaqusConstants import * . 
I import . regionTool.set · · .· ~ 
j ~iflport ~ dfs~J:ayG'~oupOdbT~olset>)s dgo:·',''' 

1
'. 

. . -' ' - . . . . . . '. . ; . . . . .. ~ 

sessic;m. v.iewports [ 'Viewport: ~' ] . setValues( aisplayedObject=None) 
. - ' . . . '~ ~- . ~ 

, ' . .., • '": ' , ~ :A,.:. . ~ . 

mCib.models. changet<ey(fromName= 'Model,-1', itoName·=' Plate Bending Model') 

plateMode'l .. mdb,. models[' Plate Bending M()del'] 
!' 
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import section 

# Assign the plate to this section 
plate_face_point • (2.5) 1.5~ 9.9) .. 
plate_ face • p!l.atePart. faces. findl\t({pilate_:.fac::e:,Poiirit,)) 
plate_region = (~late_face,) _' ~ 

j,mport assellbly 

cr.eate· the step 

import step 
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import mesh 

.1 Set elelllent type 
p~ate_mesh_region = plate_region 

piatePart.generateMesh()' 
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plate_viewport = session ' 
.Viewport(nane=' Plate Results Viewport for force of ' + \ 
repr(concentrated_force) + 'N') 

plate_Odb_Path = job_name + • .odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport.setValues(displayedObject•an_odb_object) 
plate_viewport.odboisplay.display.setValues(plotstate=(CONTOURS_ON_D~f, 

# ---------------------------------------------- --- ------ - --------# Report stresses in descending order 

t.port odbAccess 

# The main session viewport must be set to the odb object using the 
# following line. If not you aight receive an error message that states 
# •rhere are no act:l:ve entities. No report has been generated. '" 
session.viewports['Viewport: l'].setValues(displa~edObject~an_odb_object) 

# Set the option to display the reported quantity (in our case the 
# stresses) in descending order 
session.fieldReportOptions.setValues(sort~DESCENDING) 

# Na.e the report and give it a path. If you do not assign a path (as is 
# done here) it will be stored in the default abaqus temporary directory 
report_name_and_path•'PlateReport'+repr(concentrated_force)+'N.Ii'pt' 

I ••••••• • •••••• •• •••••••••• • •••••••••••· ·~ ···················· · ·· 
# You .ay enter an entire path if you wish to have the report stored in a 
• particular location. 
# One way to do it is using the following syntax. 
# report_na.e•'PlateReport' 
# report_path•'C:/~folder/' 
# report_nillle_and_path • report__path + report_name + • • rpt' 
# Alternatively you could have used 1 statement instead of these 3 
# report_na.e_and_path= 'C:/~FolderlPlateReport. rpt' 

I' Note however:- that the folder 'MyNewFolder' .,st exist otherwise you will 
# likely get the following error 
I' •Ioerror:C/~Folder: Directory not found• 
# You 11.1st either create the folder i n Windows before running the script 
# Or if you wish to create it using Python comman~s you must use tHe 
# os • .akedir() or o·s .aked:l:rs() function · 
# os • .akedirs() is preferable because you can create .ultiple nested 
• directories in one statent if you wish 
# Note that this function returns an exception if the directory already 
• exists hence it is a good idea to use a try block 

#try: 
# . os.~~akedirs(report_path) 
#eXcept: 

· # print •otrectory exists hence no need to recreate it. Move on to nett 
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try: 
os.makedirs('C:/SimulationResults/') 

except: 
print •t S0111ething went wrong •. 111aybe this directory already exists?" 

g • open('C:/SimulationResults/iterative_analysis.txt','w') 
g.write('Force \t Max Stress \n') 

for i in range(len(force_list)): 
g.write(repr(force_list[i]) + '\t' + stress_list[i] 

g.write( '\n\n') 
g.write('The force that will cause the maximum allowable stress of • + \ 

repr(max_acceptable_stress) + 'N is between ' + \ 
repr(force_list[len(force_list)-2]) + 'N and ' + \ 
repr(force_list[len(force_list)-1]) +'N.') 

g. close() 

ITERATIVE ANALYSIS ENDS HERE 
•••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••••• 
#IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIiiiiiiiiiiiiii 

# Dete~ine which elements exceed the maximum allowable stress 

highlight_element_list • [] 

h • open(report_na.e_and_path) 

#In the report file, the table begins after a line full of '-' characters. 
# Extract lines one by one until this line is reached. 
for line in h: 

str•line 
if '----------------------------------' in str: 

break 

# Read in lines one at a t~ ·fro. the table 
for line in h: 

str • line 
# Test if a blank line has occurred as this will signal the end of the table 
if not line.strip(): 

break 
str_list a str.split() 
if float(str _list[3]) > max_acceptable_stress: 

highlight_element_list.append(str_list[e]) 

h.close() 

• Convert list to tuple 
highlight_ele.ent_tuple = tuple(highlight_ele.ent_list) 
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print i . 

..4 Examining:tlle.S:crint'' ;; ~-.. _ _. ........ __ .....,.......,__ ...... ' ' .--. ...................... _.......,..;....;._ 
Let's understand how this script works. The majority of the script is the same as the one 

in the Planar Shell bending example of Chapter 10 so we'll only examine the new parts. 

statement) and should require no explanation. The new import statement is discussed in 

section 13.4.6 on page 345. 

The following block initializes the variables for the loop. 

#IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII IIIIIIIIIIIIIIIIII IIIIIIIIIIIIIIII 
#************************************************************************* 
# ITERATIVE ANALYSIS BEGINS HERE 

# Make changes here 
concentrated_force_initial_guess = 5 
concentrated_force_guess_increment_size = 5 
max_acceptable_stress = 35E+3 

max_stress = e 
concentrated_force = concentrated_force_initial_guess 
force_list= [] 
stress list=[] -=-----
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We store our initial force guess of 5N m a variable called 
concentrated_force_initial_guess. The amount by which to increment the force for the 
next iteration (5N) is assigned to the variable 
concentrated_force_guess_increment_size. And our maximum allowable stress 
criterion of35MPa (or 35000 Pa) is assigned to max_acceptable_stress. 

At the end of each iteration, the maximum stress will be extracted from the report file and 
stored in the variable max_stress. The value in this variable will be tested at the 
beginning of each iteration to make sure it is less than 35 MPa. We set it to 0 Pa for the 
first iteration to ensure that this condition is satisfied and the loop executes at least once. 

We will use the variable concentrated_force to store the magnitude of the force being 
used in each iteration. For the first iteration we will assign it the value stored in 
concentrated_force_initial_guess. You might ask why we do not just write 

concentrated_force = 5 

This is because it is better to have all the variables that can be changed by a user listed in 
one spot. Hence concentrated_force_initial_guess, 
concentrated_force_guess_increment_size and max_acceptable_stress are all listed 
one after another so any changes that need to be made can be made in one spot. In fact it 
might be an even better idea to put these variables all the way at the top of your script. 

13.4.3 Modify and run the an~is at each iteration 
--------~-----------At each iteration the following lines test to see if the criterion has been met, and then 

modify and run the analysis. 

while float(max_stress) < max_acceptable_stress 

# ----- -- -- - ---------------- -- --------------- ------------- ----- -- -
# Apply concentrated forces 

plateMOdel.ConcentratedForce (name= 'Concentrated Forces', 
createStepName= ' Load Step', 
region=(vertices_for_concentrated_force,), 
cf3=-concentrated_force, 
distributionType=UNIFORM) 

# - --------- - - - - ----- - --------- ------ ------ ---------- ---- ---------
# Create and run the job 

import job J 
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1-. -------------·--------------------------------------, 

I 

# Create the job 

job_name='PlateJob'+repr(concentrated_force)+'N' 

mdb.Job(name=job_name, model='Plate Bending Model', type=ANALYSIS, 
description='Job simulates the bending of a plate') 

# Run the job 
mdb.jobs[job_name].submit(consistencyChecking=OFF) 

# Do not return control till job is finished running 
mdb.jobs[job_name].waitForCompletion() 

################################################################## 

#--------------------------------------- --------------------------
#Post Processing 
#-----------------------------------------------------------------
################################################################## 

# -------------- --- - ---------------- ------------ -------
# Display deformed state 

import visualization 

plate_viewport = session \ 
.Viewport(name=' Plate Results Viewport for force of ' + \ 
repr(concentrated_force) + 'N') 

plate_Odb_Path = job_name + ' . odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport.setValues(displayedObject=an_odb_object) 
plate_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEF, )) 

# ------------------------------- ---- -----------------------------
# Report stresses in descending order 

import odbAccess 

# The main session viewport must be set to the odb object using the 
# following line. If not you might receive an error message that states 
#"There are no active entities. No report has been generated." 
session.viewports['Viewport: l'] .setValues(displayedObject=an_odb_object) 

# Set the option to display the reported quantity (in our case the 
# stresses) in descending order 
session.fieldReportOptions.setValues(sort=DESCENDING) 

Name the report and give it a path. If you do not assign a path (as is 
done here) it will be stored in the default abaqus temporary directory 
port_name_and_path='PlateReport'+repr(concentrated_force)+'N. rpt' 
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# Write the field report outputting the Mises stresses 
session.writeFieldReport(fileName=report_name_and_path, append=OFF, 

sortitem='S.Mises', odb=an_odb_object, step=e, 
frame=l, outputPosition=INTEGRATION_POINT, 
variable=(('S', INTEGRATION_POINT, ((INVARIANT, 'Mises'), )), )) 

# ---------------------------------------------------------- - -----
# Read the maximum stress from the report 

extracted_line='' 

f=open(report_name_and_path) 
for line in f: 

str=line 
if 'Maximum' in str: 
# or you can use the statement 
#if str.find('Maximum') != -1 

extracted_line = str 
break 

extracted_list = extracted_line.split() 
max_stress = extracted_list[2] 

f . close() 

# Place the force and corresponding stress in a list 
force_list.append(concentrated_force) 
stress_list.append{max_stress) 

# Increase the concentrated force by the defined step size for the next 
# iteration 
concentrated_force = concentrated_force + \ 

concentrated force_guess increment size 

while float(max_stress) < max_acceptable_stress : 

This is the condition of the while loop. It tests to see if the maximum stress recorded at 
the previous iteration (max_stress) is less than the maximum allowable stress 
(max_acceptable_stress). If this condition is true, the contents of the while loop will be 

executed. If not, Abaqus will break out of the while loop and control will be passed to the 
parts of the script after it. 

The floatO method is used here is a built-in function of the Python language. It is used to 
convert arguments passed to it into a Float data type. For example, an integer 435 can be 
converted to a float as 

float_var = float(435) 
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ftoat_var now contains the value 435.0 (notice the .0 which makes it a float as opposed 
to an integer). 

Similarly a String can be converted into a float. 

String_var = "435.0" 
float_var = float(String_var) 

Ooat_var now contatins the value 435.0. 

The reason the floatO method is used here is because max_stress, which is extracted 

from the report file at the end of each iteration, wiiJ be of type String. This is because text 

extracted from a file will always be treated by Python as a String, even if it appears to 

you as a number. It is not really possible to compare a string to a float. Python will not 

give you an error, it will just return FALSE for the condition. For example, 

while "S" == 5 : 

would return false even though it is actually true, because Python sees a String on one 

side and a float on the other. Hence we must use the floatO method to convert 

max stress to a float. 

# ----------------------------------------------------------------
# Apply concentrated forces 

plateModel.ConcentratedForce(name='Concentrated Forces·~ 
createStepName='Load Step·~ 
region=(vertices_for_concentrated_force~>~ 
cf3=-concentrated_force~ 

distributionType=UNIFORM) 

This statement is a modified version of the one used in the Planar Shell Bending example, 

section 10.4.12 on page 248. The only difference is that the force in the 3-direction has 

been replaced with the variable concentrated_force so that it changes to the value of the 

force guess at each iteration. 

# --------------------------------- -------------------------------
# Create and run the job 

import job 

# Create the job 

job_name=' PlateJob'+repr(concentrated_force)+'N' 
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mdb.Job(name=job_name, model='Plate Bending Model', type=ANALYSIS, 
description='Job simulates the bending of a plate') 

# Run the job 
mdb.jobs[job_name].submit(consistencychecking=OFF) 

# Do not return control till job is finished running 
mdb.jobs[job_name].waitForCompletion() 

Few modifications have been made to these statements from section 10.4.14 on page 250 
of the Planar Shell Bending example. The only new statement here is the first one which 
assigns the name of the job to the variable 'job_ name' . We give each job a different name 
so that the the output databases have different names and each job and output database is 
listed in the model tree. This way the results for any of the iterations can be visualized 
later if required. 

The reprO command used is a built-in function of Python that returns a String containing 
a printable representation of an object. Since job_name will be assigned to the name 
argument of the JobO method, it needs to be a String. Earlier we used the floatO function 
to convert a String to a Float, here we use the reprO function to convert an integer to a 
String. So if concentrated_force = 5, then the statement will evaluate to job_ name = 

'Piaie.Job5N'. 

####################1111111111#############111111~11~111111111111111111111111111###### 

#-----------------------------------------------------------------
tPost Processing 
·-----------------------------------------------------------------
######I######IIIIIIIIII##IIII#####I#########IIIIIIIIIIIII~IIIIIIIIIHIIHHHIHIIIIIIII 

' -----------------------------------------------------
' Display deformed state 

import visualization 

plate_viewport = session \ 
.Viewport(name='Plate Results Viewport for force of ' + \ 
repr(concentrated_force) + 'N') 

plate_Odb_Path = job_name + '.odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport . setValues(displayedObject=an_odb_object) 
plate_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEF~ )) 

' ----------------------------------------------------------------
# Report stresses in descending order 

import odbAccess 
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# The main session viewport must be set to the odb object using the 
# following line. If not you might receive an error message that states 
#"There are no active entities. No report has been generated." 
session.viewports('Viewport: l'],setValues(displayedObject=an_odb_object) 

# Set the option to display the reported quantity (in our case the 
# stresses) in descending order 
session.fieldReportOptions.setValues(sort=DESCENDING) 

# Name the report and give it a path. If you do not assign a path (as is 
# done here) it will be stored in the default abaqus temporary directory 
report_name_and_path='PlateReport'+repr(concentrated_force)+'N.rpt ' 

A few modifications have been made to this code from the Planar Shell Bending 

example, section 10.4.14 on page 250, to include the new analysis job naming 

convention. This is seen in the third, fourth and last lines of the snippet above. 

The name of the viewport is the string "Plate Results Viewport for force of' concatenated 

with the force magnitude and the unit ''N". So for example if the concentrated force is 

SN, our viewport wiJJ have the name 'Plate Results Viewport for force of 5N'. 

The name of the job is stored in the job_name variable, and that is concatenated with the 

String '.odb' and assigned to the variable plate_Odb_Path. So if the job_name variable 

holds "PlateJobSN", the variable plate_Odb_Path is now "PiateJob5N.odb". Similarly 

report_ name_ and _path will be assigned "PiateReportSN .rpt". 

# Write the field report outputting the Mises stresses 
session.writeFieldReport(fileName=report_name_and_path, append=OFF, 

sortltem='S.Mises', odb=an_odb_object, step=e, 
frame=l, outputPosition=INTEGRATION_POINT, 
variable=(('S', !NTEGRATION_POINT, ((INVARIANT, ' Mises'), )), )) 

This writeFieldReportO command has been copied from the Planar Shell Bending 

example, section 10.4.16 on page 251 . 

# ----------------------------------------------------------------
# Read the maximum stress from the report 

extracted_line='' 

f=open(report_name_and_path) 
for line in f: 

str=line 
if 'Maximum' in str: 
# or you can use the statement 
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#if str.find('Maximum') != -1 
extracted_line = str 
break 

extracted_list = extracted_line.split() 
max_stress = extracted_list[2) 

f . close() 

This code extracts the maximum value of the Mises stress from the report. If you examine 
the report, the bottom halflooks something like: 

10 4 940.912 940.912 
71 1 867.384 867.384 
30 1 798.683 798.683 
30 3 665.845 665.845 
81 1 492.472 492.472 
20 4 474.511 474.511 
30 2 314 . 078 314.078 
30 4 152.557 152.557 

Minimum 152.557 152 . 557 
At Element 30 30 

rnt Pt 4 4 

Maximum 9.27365E+03 9.27365E+03 
At Element 50 50 

rnt Pt 1 1 

Total 881.550E+03 881.550E.._03 

We open this file using the openO command, where you provide the filename as an 
argument, and assign it to the variable f which becomes a file object, that you can think 
of as a file handle. The file can then be accessed in subsequent parts of the script using 
this handle f. 

Aside from the mandatory filename argument, there are other optional ones such as the 
mode. The commonly used modes are r for read, w for write (which will delete the file if 
it already exists), and a for append (which wi11 add on to an existing file, or create a new 
one if it doesn't already exist). The default is r which suits our purposes since we wish to 
read from this file. The Python documentation lists other modes and optional arguments 

for the openO function. 
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When Python sees the statement for line inf, it begins a for loop, and at each iteration it 

extracts one line from the file. It will sequentially move down the report file extracting 

one line at each iteration and storing it in the variable line. 

We assign the String in line to another variable str for convenience. 

We are trying to find the line in the file that looks something like (refer to image): 

"Maxium 9.27365E+03 9.27365E+93" 

The way to check if the variable str contains this line of output is to look for the word 

'Maximum' in it since this word will only occur in that one line of our report file. The 

statement if 'Maximum' in str: is an if statement which checks to see if the String value 

in variable str contains the String 'Maximum' . If this condition is true, the statements 

within the if block will be executed. 

This could also have been accomplished using the Python built-in function 

(String).findO as 

if str.find('Maximum') != -1 : 

where the findO function returns the lowest index in the String where the argument is 

found, or - 1 if it is not found. 

Once found, the contents of the line are assigned to the variable extracted_lioe. A break 

statement then moves control out of the loop. 

Right now the value of the extracted line variable looks something like this: 

"Maxi urn 9.27365E+93 9.27365E+83" 

We need to somehow extract the first number 9.27365E+03 from it. We can use the 

Python (String).splitO command. splitO does not have any required arguments, and 

when no arguments are passed it will split up the String wherever it encounters a space, 

and return a list of the words. What we will end up with here is extracted_list{O] = 

'Maximum ', extracted_list[J] = '9.27365E+0.3' and extracted_list{2] = '9.2736£+03 '. 

(Note that the each list item is a String even if these look like floats, because Python 

reads in a line from a file as a String). 

As an aside, FYI, the splitO function can be told to split a line at a character other than a 

space; for this you would need to specify that character as an argument. For example, 
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slr.splil('9 ') would split up our line wherever the letter/number 9 appears. You can also 
specify, as a second argument, the maximum number of times a String can be split, thus 
limiting the number of elements in your list. Refer to the Python documentation for more 
on the splitO function. 

Once the line has been split up into a list of 3 elements in our case, the second one will 
refer to the maximum Mises stress. We can refer to it using index notation as 
extracted_list[2]. 

The file is then closed using f.closeQ. The built-in Python (file).closeO command closes a 
file and frees up the system resources taken up by it while it is open. Also the file object f 
can no longer be used to access the file after this. 

# Place the force and corresponding stress in a list 
force_list.append(concentrated_force) 
stress_list . append(max_stress) 

At the end of the simulation our plan is to print out a table of the magnitude of the 
concentrated force and the corresponding maximum stress. For this reason we use the 
built-in Python function appendO to add concentrated_force and max_stress for the 
current analysis to the list variables force_list and stress_list respectively. The 
(list).appendO function, which was mentioned in section 3.4 "Lists" on page 44, adds the 
argument provided to it to the end of a list making it the last element. 

# Increase the concentrated force by the defined step size for the next 
# iteration 
concentrated_force = concentrated_force + \ 

concentrated_force_guess_increment_size 

The concentrated force is then incremented for the next iteration of the optimization 
process. 

The force and resultant maximum stress for each analysis is tabulated. 

# Output a table of force and stress to specified location 

try : 
os.makedirs('C:/SimulationResults/') 

except: 
print "I Something went wrong . . maybe this directory already exists?" I 

J 
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, -----·---··--·--··-------·-·---·--··-··-···-·---·-·-·--···-····-·-··-·----···-·------·-·--·-·······-····-·······-·············-···-·-·····-··-···--··----·----····-·-·----·-·--·-----·-·--·--··----··-····-·····----······--·····"·1 
1 g = open( 'C:/SimulationResults/iterative_analysis.txt', 'w') 

g.write('Force \t Max Stress \n') 

fori in range(len(force_list )): 
g.write(repr(force_list[i)) + '\t' + stress_list[i] + '\n' ) 

g .write(' \n\n') 
g.write('The force that will cause the maximum allowable stress of ' + \ 

repr(max_acceptable_stress) + 'N is between ' + \ 
repr(force_list[len(force_list)-2]) + 'N and ' + \ 
repr(force_list[len(force_list)-1]) +'N.') I 

1 g.close() ·------

In Python, exceptions are errors which occur during program execution. They are not 

syntax errors and it is possible for a program to continue after this if you catch them. This 

is done using a try-except block. You place the statements that might generate an 

exception inside the try block and if an exception does occur the contents of the except 

block will be executed. 

try: 
os.makedirs('C:/SimulationResults/') 

except: 
print "! Something went wrong •• maybe this directory already exists?" 

Here we use try-except when creating a new directory for our simulation results. It is 

possible that the script will be unable to create the new folder because it already exists, or 

because your Windows account doesn't have the necessary permissions, or some other 

unforeseeable reason. You can use an except block to deal with the situation. In this 

example we don't actually implement any additional code to deal with the problem, 

however having the try-except in place will prevent a known error from occurring (as we 

will see in a moment). Good programming practice of course would involve having some 

code to actually deal with the cause ofthe exception but I' m only trying to demonstrate 

the use of try-except in this example. 

Also note the use of the exclamation point '!' in the print statement. This tells Abaqus to 

print this statement in red color font in the message area, and you might even hear a beep 

when it is printed. Just a cool feature I thought you'd want to know about. 

If you wish to see it in action, run the script in Abaqus, then open a new model database 

and run the script again. Since the directory 'C:/SimulationResults' will be created the 

first time you run the script, the second time you will get an exception when trying to 

make the folder because one with the same name already exists. In this case you will see 
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a message in the message area at the bottom of the window saying "Something is wrong .. 
maybe this directory already exists?" And Abaqus then proceeds to the next statement in 
the except block, or if there isn' t any (as in this example) it then moves on to the next 
statement in the script. 

If we did not have the try-except code in place, we would have got a Windows error here 
and the script would have terminated at that point. The presence of the try-except 
statements makes Python ignore the exception and it assumes you will do something to 
fix it in the except-block. In our example everything works out once the exception occurs 
because the directory we need does already exist and subsequent statements are therefore 
not affected. If on the other hand the directory did not exist, and our exception was raised 
for some other reason such as insufficient user privileges associated with the Windows 
account, our script would still continue on assuming we've dealt with the problem and 
we'd see some other errors further down the line since the directory to which we output 
the file will not exist. 

As for the os.makedirsO, this is a built-in Python function which creates directories. The 
directory path must be provided as an argument. For your information, Python also has a 
mkdirO function. The different between mkdirO and makedirsO is that makedirsO 
allows you to create a whole path- such as a new directory within another new directory 
-using one command- whereas with mkdirQ you'd have to create each nested directory 
in turn. 

g = open('C:/SimulationResults/iterative_analysis.txt','w') 

We use the built-in Python openO function which you have seen in the previous section. 
This time, aside from the required filename/path argument, we also provide an optional 
mode argument w. This opens the :file in write mode. If a tile with this name already 
exists it will be replaced. 

g.write('Force \t Max Stress \n') 

The built-in Python writeO function is used to write the first line of the fi1e, which will 
form the heading of the table. The \t translates into a tab space, while the \n is a newline 
(or carriage return) character; so the next time the writeQ function js used the text will be 

written on a new line. 

for i in range(len(force_list)): 
g.write(repr(force_list[i]) + '\t' + stress_list[i] + '\n') 
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A for loop was used to iterate as many times as there are elements in force _list. The 

writeO function is then used to write the forces and stresses. Remember that the elements 

offorce_list are integers, hence the reprO function is used to convert them to Strings that 

can be printed into a file. The variables in stress_list on the other hand already Strings 

since they were read in from the report files for each analysis. 

g. write(' \n\n ' ) 
g.write('The force that will cause the maximum allowable stress of ' + \ 

repr(max_acceptable_stress) + 'N is between ' + \ 
repr(force_list[len(force_list)-2]) + 'N and ' + \ 
repr(force_list[len(force_list)-1]) + 'N.') 

g.close() 

# ITERATIVE ANALYSIS ENDS HERE 
#************************************************************************* 
#IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII 

These lines add the finishing touches to our output file by stating that the magnitude of 

the force that causes the maximum allowable stress lies somewhere between the last two 

force attempts. We refer to them within the force list using index notation as 

[/en (force _list)-2] and {len(jorce _list)-1]. 

That brings us to the end ofthe iterative analysis procedure. 

------------------------------- -----· 
# Determine which elements exceed the maximum allowable stress 

highlight_element_list = [] 

h = open(report_name_and_path) 

# In the report file, the table begins after a line full of ' ' characters. 
# Extract lines one by one until this line is reached. 
for line in h: 

str=line 
if ' ------ - ---- --------------------- -- in str: 

break 

# Read in lines one at a time from the table 
for line in h: 

str = line 
# Test if a blank line has occurred as this will signal the end of the table 
if not line. strip(): ·--'-=-------
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break 
str_list = str.split() 
if float(str_list(3]) > max_acceptable_stress : 

highlight_element_list.append(str_list[e]) 

h.close() 

# Convert list to tuple 
highlight element tuple = tuple(highlight_element_list) 

We now read the last report fiJe to determine which ofthe elements experienced a stress 
larger than the maximum allowable pressure. We will later highlight these elements in the 
viewport. 

highlight_element_list = [] 

This variable is a placeholder for the list of elements with a stress exceeding the critical 
stress. 

h = open(report_name_and_path) 

The buiJt-in Python function openO is used again here to open the last report file . The 
variable report_name_and_path still holds the path ofthe last report file from the final 
iteration. 

The report file will look something like this: 
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wwwwww•-*•••••••••~•***••••w••••~·~~·•••••••r•w••••••••••••****** 

*'**""""w••••••••• 
Field Output Report, written sun Mar 06 21:2~:45 2011 

Source 1 

ODB: C:/AbaqusTemp/PlateJob20N.odb 
Step: Load Step 
Frame: Increment l: Step Time 1.000 

I.oc 1 : Integr~tion point values 
S section points > from source 1 
Loc 2 : Integr~tion point value:s 
5 section points > from source 1 

at .shell -< "'AISI: 1005 STEEL" > < 
: SNEG, (fraction = -1.0) 
at .shell -< ~AISI 1005 STEEL" > -< 

SPOS, (fraction = 1.0) 

Output sorted by column "S .Misea". 

Field Output reported at integration points for part: PLATE 
INSTANCE 

Element 
Label 

Minimum 

50 
60 

1 
70 
40 
1 

21 
11 

1 
89 
22 
80 
11 
22 
21 

81 
20 
30 
30 

At Element 
:Int Pt 

Maximum 
At Element 

Int Pt 

Total. 

Int 
Pt 

1 
1 

3 
1 
l 
1 
4 
1 
2 
1 
3 
1 
3 
1 
2 

S.Mil!lel!l 
@Loc 1 

37.0946E+03 
37.0573E+03 
36.5112E+03 
36.3201E+03 
36.2958E+03 
36.1592E+03 
3 6. 0272E+03 
35.9607E+03 
35.3670E+03 
35.0950E+03 
34.5809E+03 
34 .3091E+03 
34.1773E+03 
33.7113E+03 
33.56i5E+03 

(Many rowsn;movw) 

1 1. 96989E+03 
4 1.89805!:+03 
2 1. 256311!!:+03 
4 610 ~ 226 

610.226 
30 

4 

37.0946E+03 
50 

1 

3.52620E+06 

S.Mises 
@Loc 2 

37.0946E+03 
37.0573E+03 
36.5112E+03 
36.3201E+03 
36.2958E+03 
36.1592E+03 
36. 0272E.+03 
35. 9607E+03 
35.3670E+03 
35.0950E+03 
34 . 5809E+03 
34.3091£+03 
34.1773E+03 
33 . 7113E+03 
33.5645E+03 

1. 9 6 98 9E+03 
1.89805E+03 
1.25631E+03 

610 . 226 

610.226 
30 

4 

37.0946E+03 
50 

1 

3.52620!:+06 
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We need to determine where the line of'-' characters appears and the data table begins 
after it. 

# In the report fileJ the table begins after a line full of ' ' characters. 
# Extract lines one by one until this line is reached. 
for line in h: 

str=line 
if ·----------------------------------· in str: 

break 

The for loop reads in lines from the file one by one checking to see if a large number of 
'-' characters appear in sequence. When this happens, the program control breaks out of 
the loop. 

# Read in lines one at a time from the table 
for line in h: 

str = line 
# Test if a blank line has occurred as this will signal the end of the table 
if not line.strip(): 

break 
str_list = str.split() 
if float(str_list[3]) > max_acceptable_stress: 

highlight_element_list.append(str_list[OJ) 

The next for loop continues to read in lines. Note that it does not start reading lines from 
the top of the report file. Instead it continues to read from where it left off in the previous 
for loop, since the file was not closed after that. This is Python behavior that you should 
be aware of. 

We now check to see if a blank line appears, since the line after the table is followed by 
two blank lines in the report file. The line.stripO method is used. stripO is a built-in 
Python function that strips off leading and trailing characters in a String. The character 
(or multiple characters) needs to be specified as an argument, or stripO defaults to a 
whitespace character, which is what happens in this case. The stripO function is good for 
removing leading or trailing whitespaces in a String. ln our case however, since the entire 
line is made up of whitespaces, stripQ returns ". This is basically a false condition. This 
is because values such as 0, None and " are treated as 'false' in a Boolean sense. Hence 
the if condition returns true (since a ' not' is used), and the break statement removes 
program control from the loop. 
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You might be interested to know that Python also has 2 built-in functions called lstripO 

and rstripQ which function similar to stripQ. lstripO removes leading characters, 

whereas rstripO removes trailing characters. 

The Python splitO function is used once again to split each line of the table into list 

elements where the whitespaces occur. In this case we should get 4 elements since there 
are 4 columns. The subsequent if statement compares the value of the 4th (since indices 

begin at 0) element of the new list, which is the stress on the top surface of the shell 

elements, with the maximum acceptable stress. If the critical stress is exceeded, the 

element label (which is the first column or list index 0) is added to 

highlight_element_list with the appendO function. 

h.close() 

The closeO function closes the file and frees up any resources it was using while open. 

# convert list to tuple 
highlight_element_tuple = tuple(highlight_element_list) 

The built-in Python function tupleO is used to convert the list to a tuple. This is because a 

tuple is required by the LeafFrommModelEiemLabelsO method which we will be using 

shortly. 

13.4.6 Light u .eleme i~ ttii'vie'WJ)qri wher.e niJll. st~~ ~exceeded _,__ 
The following code lights up in red the elements in the viewport where the stress exceeds 

the maximum allowable stress. The rest of the elements are colored yellow. 

# Change the color of elements in the viewport where the stress exceeded the 
# maximum acceptable stress 
plate_viewport.setColor(initialColor='#FFFFee·, translucency=8.4) 
leaf= dgo.LeafFromModelElemLabels(elementLabels=(('PLATE INSTANCE', 

highlight_element_tuple), )) 
plate_viewport.odbDisplay.display.setValues(plotState=(DEFORMED, )) 
plate"" viewp~rt · .~_!Colo~i_lea!_~_l_eaf, _ _!!:_~~Colo~= ·-~~-~-:_L. _ _ _ 

There are 3 different setColorO methods available. 2 of them have been used here. 

plate_viewport.setColor{initia1Color='#FFFF99', trans1ucency=8.4) 

The setColorOmethod used in the first line assigns an initial color and translucency to the 

elements of the plate before we highlight the ones that have exceeded critical stress. This 
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setColorO method has one required argument, initialColor, which is a String specifying 
the initial color of the objects. It also has an optional argument translucency which 
specifies how translucent the object drawn with initiaiColor wi 11 be. It must be a float 
between 0.0 and 1.0. We do not use this optional argument here. 

Note that we specified initiaiColor using the hexadecimal #FFFFOO. Common colors can 
also be represented by their names, in this case 'Yellow'. Hence the statement could have 
been written as: 

plate_viewport.setColor(initialColor='Yellow') 

The next statement 

leaf= dgo.LeafFromModelElemlabels(elementlabels=(('PLATE INSTANCE' , 
highlight_element_tuple), )) 

creates a Leaf object. Leaf objects are used for items in a display group. They are 
temporary objects and they are created to use in DisplayGroup commands such as 
setColorQ. The LeafFromModeiEiemLabelsO method creates a 
LeafFromModeiEiemLabels object, which is derived from the Leaf object and can 
therefore be used in place of a Leaf object in DisplayGroup commands. 
LeafFromModelElemLabelsO has one required argument, elementLabels, which is a 
sequence of Strings denoting part instances in the model and a sequence of the labels of 
the desired elements in that part instance. Hence it should be of the fonn 

(('part_instance_l', (~elem_label_l', 'elem_label_2', 'elem_label_3'),), 
('part_instance_2', ('elem_label_l', 'elem_label_2', 'elem_label_3'),)). 

We already have ('elem_Iabel_l ', 'elem_labe1_2', 'elem_label_3') in the form of a 
tuple/sequence bigbligbt_element_tuple created earlier specifically for this purpose. 

The dgo refers to the displayGroupOdbToolset which was imported using an import 
statement at the start of the script: 

import displayGroupOdbToolset as dgo 

The displayGroupOdbToolset defines Leaf objects. Hence we must use 
dgo.LeafFromModeiEiemLabelsO to refer to it. 

plate_viewport.odbDisplay.display.setValues(plotState=(DEFORMED, )) 
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This statement changes the displayed view in the viewport to a deformed view. You have 

seen this method used in many previous examples. The reason we are using it is because 

the display is currently a color contour of the stresses, and it will not be possible to 

highlight elements if a calor contour is currently displayed on them. By changing it to 

deformed view it will be deformed but will not have a stress contour displayed on it. 

plate_viewport.setColor(leaf=leaf, fillColor='Red') 

Once again we use the setColorO method, but this one is a little different from the one 

used a few statements earlier even though it shares the same name. This setColorO 

method also specifies the color of a Leaf object, but it has a different set of required and 

optional arguments. The required argument leaf is a Leaf object. We use the one created 

with the LeatFromModeiEiemLabelsO method. There are numerous optional arguments 

fillColor, edgeColorFiiiShade, edgeColorWireHide, nodeSymboiColor, 

nodeSymboiType and nodeSymbolSize, all of which are described in the Abaqus 

Scripting Reference Manual. The only one we use is fillColor, which is a String 

specifying the color to be used for the faces of the elements. Needless to say, it is only 

applicable when the render style is filled or shaded. Just like the previously used 

setColorO method, we can use a hexadecimal value or a common color name, in this 

case 'Red'. 

I # Print a message for the user in the message area 
1 print '************************' 

print 'Optimization complete ' 
print 'Multiple viewports have been created~ one for each simulation. \n' 
print 'These may appear one above the other and you will need to move t hem ' + \ I 'around your screen to reveal the ones behind. \n' 

1 
print 'The last viewport to be created (the one on top) highlights in red the' + \ 

' 'elements which exceeded the maximum allowable stress. \n' 

The print statement is used to send messages to the message area. The newline (aka 

carriage return) symbol \o is the equivalent of hitting the Enter key at the end of each 

sentence, causing the next one to begin on a new line. The contents of the print 

statements are quite self-explanatory. 
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13.5 Summary 
After reading through this chapter you should now be able to perfonn an optimization by 
placing the bulk of your script inside of a loop and iterating through it. This is the 
standard procedure when performing optimizations using Python scripts. You also 
perfonned some of the most common file handling (input/output) tasks using the 
generated report files. In the process you were introduced to try-catch blocks for 
catching exceptions. And you learnt how to change the color of interesting elements in 
the viewport, adding to your knowledge of post-processing through a script. 



14 -
Parameterization, Prompt Boxes and 

XY Plots 

> 

One of the most basic reasons for writing a script is that it gives you the ability to 

parameterize your model. This allows you to specii)' quantities in the form of variables 

whose values can be changed at runtime. If one of your dimensions is a variable, you can 

create your model geometry making use of that variable, and you'll then have the ability 

to change your model by changing that variable. 

You already got a taste of this concept in the previous chapter with the plate, where the 

concentrated force was stored in the form of a variable whose value changed at every 

iteration. But this was a relatively simple example. You can in fact have many quantities 

in the form of variables which depend on the other variables. For example, you could 

specii)' the length of a truss member as a variable, and the cross sectional area as a 

variable which is related to the length by some mathematical relation. If you change the 

first variable, your script not only changes the length of the wire feature in the sketcher, it 

also changes the section properties accordingly. Or if you were working with beams you 

could have the script change the profile dimensions to make them some fraction of the 

length. 

We will perform a similar parameterization in this chapter using the truss structure under 

dynamic loading from Chapter 9. In addition we will obtain the length of the beam 

members, as well as the magnitude of the concentrated force, as inputs from the user at 

runtime using prompt boxes. The ability to accept user input through a prompt box is a 

neat feature which allows the analyst to easily define a few variable values and observe 
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the response of the modeL We will demonstrate the use of a prompt box which accepts 
one input. as well as a prompt box that accepts multiple inputs. 

Pleas.e provide the following information 

N;sme the model: jhll?{litttf!it!ff# ~ 
length of trus~ members [ 2 

:=:===::::: j15 Height of truss 

OK 

M;sgnitude of concentrated force (in -Y direction) jtiOOO 

! QK, I 

In addition we will revisit the XY plots created using history outputs, and play around 
with the plot characteristics. We'll change the characteristics and styles of the plot titles, 
axes, legends and so on. Quite often you will find yourself performing the same repetitive 
steps to visualize a result every time you run an analysis, and you can save some time and 
effort by writing these steps as a script. Although not the case in this example, it is quite 
popular to create standalone scripts for post-processing tasks which are only run after the 
analysis has completed. 

14.2 Methodology 
When the analyst runs the script, he or she will be prompted to type in the length of the 
truss members (they are all of equal length) and the height of the truss within a single 
prompt box. The script will be modified or parameterized so the part sketch will scale to 
these dimensions. The truss cross section area, which is a property assigned in the section 
module, will also be recalculated based on these dimensions. The radius of the truss 
members will be 0.05% of the length, and the cross section area will be calculated using 
this radius. 

Recall that the findAtO method is used to find (and select) the truss members in order to 
assign section properties to them. Since the truss dimensions will now change based on 
user input, the locations of these members will also change, hence the arguments of the 
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findAtO method will need to be parameterized as well so they can dynamically update 

with the model geometry. 

The user will also be prompted to enter the magnitude of the concentrated force, and this 

wilJ be applied to the correct node (the one in the center). The history output will be 

requested from the node at the end of the structure. Note that the coordinates of both 

these nodes will depend on the geometry of the truss hence the findAtO method will once 

again be parameterized here. 

14.3 pYthon Sciipt~r:--- ' 
~---""'·-

The following listing is the completed Python script to accomplish this. You can find it in 

the source code accompanying the book in truss_dynamic_parameterized.py. You can 

run it by opening a new model in Abaqus/CAE (File > New Model Database > With 

Standard/Explicit Model) and running it with File> Run Script ... 
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truss_member_length = 2 

try: 
truss_height • float~user_inputs[2]) 

except: 
print '!You did not type in an integer or Tloat. 
truss_height • 1.5 

mdb.models.changeKey(fromName='Model-1', 
trussHodel = ~b.models[model_name] 

# Create the part 

illlport sketch 
import part 

trussSketch • trussModel.Constra:l.ned5ketch(name='2D 'r:r:-uss Sketch', 
trussSketch.Line(point1=(9, 9), point2•(truss_member_len~h~ 9)) 
trussSietch.Line(pointl•(truss_me~r_length, 9), 

point2•(2*truss_~r_length~ 8)) 
trussSketch.Line(point1=(2*truss_member_length, 9), 

point2=(3*truss_member_lengthl e)) 
trussSketch.Line(point1=(9, -truss_height), 

point2• (truss_lelber_length,-truss_height)) 
trussSketch~Line(pointl=(truss_.eaber_length, -~russ_height), 

point2• (2*truss_lllelllber:-_length,-truss_height)). 
trussSketch.Line(point1• (9, -truss_height), . 

point2=(truss_member_length, 9)) 
trussSketch.Line(pointl=(truss_~r_length, 8), 

point2•(2*truss_~r_length~ -truss_height)) 
trussSketc~.L1ne(point1=(2*truss_meMber_le~h, -truss_height), 

point2D(3*truss_.e.ber_lengtfi1 0)) 
trussSketch.Line(pointl=(truss_me.ber_length, 8), 

point2• (truss_memtier_length, -truss_height)) 
trussSketch. Line(pointl• (2*truss_.e.ber_length, 9), 

point2a(2*truss_.alber_length, -truss_height)) 

trussPart • trussHodel~Part(name•'Truss ' , dimenslonality=T:WQ~D_PLANA~, 
typeoiOEFORMABLE_BOOY) . 

trussPart.BaseWire(sketch=trussSketch) 

# - ------------- - ---- -------- ------P----------- - -----------~--------------
'# Create material 

iiiiPOrt ~naterial 

# Create .aterial AISI 1095 Steel by assigning .ass density~ youngs .adulus 
# and poissons ratio 
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import step 

# -- - -- - ---- - -------------------------------- -------- -- - ------ - - ------ ----# c~eate the history output request 

force_point_region • trussAssembly.sets['foree point set'] 
trussModel.histoi\'y()utputRequests.changeKey(fGOIIIName=' H-Output-1', 

toName='Force point output') 
trussModel.historyOUtputRequests['Force point output'] \ 

.setvalues(variables=('UT'J), 
frequency .. l, 
region=force_point_region, 
sectionPoints-=DEFAULli, 

·ll'ebar:aJ:XCLUDE) 

end~int_region = trussAssembly.sets['end point set'] 
tFussModel.HistoryOutputRequest(name• 'EPd point output', 

createStepName='Loading Step•, 
variables• ('UT',), frequencycl, 
region=end_point_region, sectionPoints=DE~AUtT, . 
rebar'=EXCLUDE) . ------------------------------------------------------------------------# ~ply loads 

# Ask user for magnitude of concentrated force 
user_input_2 • getinput(pro~pt = 'Magnitude of concentrated force (iri 
direction) •, default • '6888') 
try: 

force_input • float(user_input_2) 
except: 

print 'lYou did not type 1n an integer or float. AssUIIiog force 
'magnitude of 6999' 

force_input c 6998 

# Apply concentrated force on second node 

# We aleady have the vertex for fOrce from the asseably step so we use that 
trussModel.Concentratedforce(name•'ForcePulse· , cr.eatestepName='loading Step·~ 

1\'egion·~vertex_for_force,), cf~·-force_input~ 
distributionType-uNIFORM, field='', localCsys=None) 
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# End of run job 

import odbAccess 
import visualization 

truss_Odb_Path = 'TrussE~plicitParameter!zedJob.odb' 
odb_ebject • session.openedb(nane=truss_Odb_Path) 

session.viewports['Viewport: l'].setValues(displayedObject*odb_object) 
session.viewports['Viewport: l'].odbDisplay.display \ 

.setValues(plotstate=(DEFORMED# , ____________________________________________________________________ : ___ _ 

# Plot the deformed state of the truss 

t~uss_deformed_viewport = session.Viewport(name='Truss in Deformed State') 
t~uss_deforllled_viewport.setValues(displayedObjecta::odb_object) 
truss_defor.ed_viewport.odbDisplay.display.setValues(plotState=(UNDEFORMED# 

DEFORMED# )) 
truss_deforwed_viewport.odbDisplay.ca..>noptions.setvalues(nodeLabels-oN) 
truss_defoMied_viewport.odbDisplay.comonoptions.setvalues(eleatLabels:CN) 
truss_defonled_viewport.setValues(origin=(8.8# e.e)~ width=258# height=168) 

# -------------------~------------------------------------~-----~--------- ~ 
# Make XV plots of U2 displacement for fOrce point and end point 

t We need to find the variable names fOr the history varia5les 
f Abaqus tends to give them na.es like •spatial displaGeaent: U2 at Node 2 in" 
# NSET FORCE POINT SET• 
# se basically we will search for var.iables with the letters 'U2' in theiR. .. 
#an~ save the variable na.es in an arr.ay ~alled theoutputvariablena.e ·to use .la~er 

keyarray-session.odbData['TrussExplicitPar.ameterizedlob.odb'J \ 

theoutputvariablena.e•El 
for x in keyarray: 

if Ex.f1nd('U2')>-l): 
theoutputvariablename.append(~) 

.historyVariables.keys{) 
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session.xyReportOptions.setValues(totals=ON~ minMaX=ON) 
session.writeXYReport(fileName='end_point_xydata_output.tXt'~ 

xyData=(xydataobject_end_point~ >~ appendMode=OFF) 

xy~data_l m session.xyDataabje€ts['Data for force point~~ 
cur.ve_1 = session.Curve€xyData=xy_data_1) 
xy_data_2 • session.xyDataobjects['Data fOr end point'] . 
curve_2 = session.Curve(xyData•xy_data_2) 

ca.bined_plot • session.XVPlot('COibined Plot') 
co.bined_plot_chart_nane • cOibined_plot.charts.keys{)[e] 
ca.bined_plot_chart = combinedwPlot.charts[combined_plot_£hart_namel 
cOMbined_plot_chart.setValues(curvesToPlot•(curve_l, curve_2} >~ ) 
ca.bined_plot_viewport = session.Viewport(na.e='Combined Plot Viewport') 
COIIbined_plot_viewport.setValtfes(displayedObjeGt=E:o~ined;_j)lot) 

# ---------------- - ---------------------------------------------~------- --
# Modify the chart using the chart options 

# Plot major and .tnor vertical gridlines 
combined_plot_chart • .ajorAxis1GridStyle.setValues(showDTrue) 
~oabined_plot_chart • .ajorAxis1GridStyle. setValues(color='#FF8998') 
ca.bined_plot_chart • .ajorAxis1GridStyle.setValues(style=DASHED) 
ca.bined_plot_chart • .ajorAxis1GridStyle.setValues(thickness=0.5) 
comb1ned_plot~chart.ainorAxis1GridStyle.setValues(show•True} 
combined_plot_chart.ainorAxis1Gr1dStyle.setValues(color='#88FFFF') 
co~ined_plot_chart.MinorAxis1GridStyle.setValues(styleaoofTED) 
cOIIbined_plot_chart.airiorAxis1GridStyle.setValues("thickness=e.2) 

# Plot •ajor and Minor horizontal grldlines 
comb1ned_plot_chart • .ajorAxis2Gr1dStyle.setValues(show•lrue) 
comb1ned_plot_chart • .ajorAxis2GridStyle.setValues(color='#FF0088') 
coMbined_plot_chart • .ajorAxis2Gr1dStyle.setValues(style=DASHED~ 
cOMbined_plot_chart.majOrAx1s2GridStyle.setValues(thickness=e.5) 
coabined_plot_chart.MinorAxis2GridStyle.setValues(show=Jrue) 
cOIIbi~_plot_chart. MinorAxis2GridStyle. setValues ( color= ·.mFf.FF • ) 
cOibined_plot_chart.•inorAxis2G~JdStyle.setValues(styleaDOTTED) 
cOIIIbined_plot_chart.mnorAXis2GridStyle.setValues(thickness=0.2) 

# Add a border to the grid 
cOibined_plot_chart.gridArea.border.setValues(show=True) 
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# Set· t-he frequenc;:y and style of tick marks. dis·played oo tfie )';-axis : 
comtiined_piot_chart.axes2[~] ~setValues{ticklength~2) 
collbined_plot_chart.axes2.£8).tiGkStyle.~setValues(style=SOLID) '=" 
COIIlb.ined!.J)lot_ chart • axes2 [ e] • tidCSty le. setValues'('tlliciCness=l. 2..) 
·c-ined:._plot_chart. axes2{8] ~ Uc;:kSty le. setValues { color:: '#9~ • ) 

• 
• • .,_ > 

t Let Abaqus/CAEassign the def.~ult x-a~is title 
combined_plot_chart.axes1{e].axisData.setValues€useSystemTff le=True) ,. . . ~ •. . " 

# set the v-axis. title · . ·• 
c~1ned_plot_chart.axes2[8].aXisData.setValues(usesystemTitle=False. 

· title=' [)isplacement of JlQc;fe 'Jr 

# · Sei:-"he font style a~ color of the x-axis title 
co~ined_plot_chart.axes1[8]~titleStyle . \ 
• . · . . • setValues(fo~t=.' -*-arial-..edium-r-nortllal:-*-*-188-*-"'-p-•-•-• •) 
c0flbined_pl01i_chart\ axes1(8] • ti tleStyle. ~etValues (calor= '#888888 • ). . . 

# Set the font style aftd ~color- Of the Y-axis title 
combined~lot_chart.axe$~[e].titl~Style \ . 

• .. ~ .~ 1 . · ;setValues(font=.' ..,•-arf:al-~~edium .. r-nomah*-~-~88-*-*-p-*"- :-*.' ) 
cQMUi~ed_plot_~h~rt.axes2£8).titleStyle,setValues(color='#888888') ·.. . ... . . 
#Set the plac~nt of tbe. x-axis (top, bottom or center of ~hart ?) 
cOMbined_plot_~hart.axesl[e].setValues(placenent=MAX_EDGE) 

# Let Abaqus ·CA£ ~ecide the placement of the v-axis 
ca.btn~_plot_chart.~es2[0].setValues{plaG~nt=MIN_MAX_EDGE) 

i# ·set the forut of' ttle x-axis labels to dec;imal wi th precision of 3 sig figs 
' ~Oibined_plot_chart.~esl[e] :axisData :setValues(labelFor.at=DECIMAL) 
ca.bined_plot~cha~.axes1f8].axisData.set~alues(labelNumDigits•3) . . . 

#·:Set the fot'JIS't ·of the V -axis labeis to d~ctmai. with precision of 3 s~g figs · 
. cOib1ned_9~ot_chart.axes~[8].axisData.setValues{labelFormat~OHATIC) 
comb~ned_plot_chart.axes2[8].axisData.setValues(labelNUMDigtt~2) . . ' . . . 
#set ·how· frequently labels are f:llsplayed on th~ x .. axis (1 ... every a.ajor grtdU. e_, 
# 2. • _every seGond .ajor gr!dline etc) 
combined_plot_ch,rt.axes1[8].setvalues(labe1Frequency=l) 

#set ~ frequently labels a~ displayed on the. ~~axis (1 · ~· e~ery ~maj~r gridline~ 
:f! 2 • every second ~~ajor gridline' etc) . · _ : . 
cOIIbined_plot_c.hart •. axes2[e]. setValues (labelFrequency=l) 



# Set the plot 
~9.11b.i:ned~lot. 
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·# Dispfa)t lli.nimum ·arid 111axi!!Wiil. values .on -.the legend ~ 
combined~lqt3ha~ .lege~ .setVal~es( shOwMinHax= rr:ue) . 

. ' .. ~ 'P ( 

. '11' • • . #Set1the 'format to decimal with precision of 3 ~ig figs 
.colilbined_plot-....,c;hart .lege,.if ,setvalues ( numberFormat=DECIMAL) , · .• 
ceombined_plot_chart .legend. setVafues ( nun:Jigits=3 ~ -c. . ' . 

'. . . . ~ . ' . . . 
# Set· the. position ·to ~!ls.et so the legend can be ~ispl~yed over the ·grid 
CQIIb~ned.J)lot_:«;:hart .l~gend ; area·. setValues ( iryset= True) 

'.. '1.. ~·- >. ~..... • . • I. .. • : ' ... . Y . - .. • . 

# Cfioose manual positioning;.,_and position the legen(:l at desired location 
combi'ne~_plot_chart: legend •. area. setvalues( posit.~ori~thod=MANUAL) 
co~ined_plot_chart.legen'i:l.ar:.'t!a.setValues(ori:ginoffset=(0.i;; 9.1)) . .. ' . \ 

~ ., . . - '. . . .... . 
# Gi~e the 'legend a border . 

·comtiin~d_piot_chart.le~e~~-area.~~der.s~tvalues(~how=lrue) ... 
#· Set . the colol' o.f ttle'· ·legenc;l border · . . 

. ~omoinedLPlot_chart.l~gend.area.~Fder.setValu~s(~olor='#8e80fF')· 

• ' Fill . th~ ~egend ~th .~:: .... i~e ~a~kgro~nd s~. the gri~ is. no~ visible through it 
combined_plot_cha~.legend.area.style.setValues((ill=True) 
comb~ned~lot~cha~.legend.area.styl~.setvalues(color='#FFFFFF') ·.• ··. -.. . . -
# Resize the vieWport window · 
combin~_piot_vi~port.setvalues(width=25e.e, height=2ee. e) 

# ---~--------------r-- ------- - --~-----~----------------------------------# ·Change,the plot curve· li~e style~ color. 'thickness etc" uslng the XV Curve options 

# Use .the name assigned to the curve · object as the name of the curve in the legend 
curve_l.setValues(useDefault=True. legendSource=CURVE_NAME)· 

# Create a new name. fOr the name of the ~urve in the legend .. 
curve_2~setValues(useDefault=False, legendlabel='Dlsp~acement of the end point ' ) ' 

# Set the line style and thickness for the forte point cu~ve 
· curve_li.l.ineStyle.setValues{showii:True) 
curve_l.lineStyle.setVall.!es(stylecDASHED) 

•. cur~e"""l .litieStyle. setValues (col or=' #8899FF · ) 
curve_:t.lineStyle.setValues(thickness•9::8) 

# Set the line style and thickness for the end point curve 
cu~ve_2. lineStyle.setV~lues{color='#99908e') 
curve_2. U:neSty le. setValues ( style=SOLID) •· · 
curve_2.11neSty~e.setValues(thickness=9. 5f 

#Show syabols· on ~he . end point curve 
curve..:.2. ~ynibdlStyle • setvalues( sha.r-T~ue) 
cur-ve_2.syiiibolSty~e;setVal:ues(~olor= #80.888~' ) .. , .. 
cur-ve~2. sYIIbolSt le. setvalue's(~~arker=FILL&D_CIR~LE)· · '\ 
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Let's understand how this script works. A large portion of the script is copied from the 
dynamic explicit truss analysis script of Chapter 8 so we'll only discuss the·new parts. 

user_inputs = getlnputs(fields (('Name the .model:·~ 'Truss Structure'), 
( ' Length of truss members', '2')~ 
('Height of truss', '1.5'))~ 

label = 'Please provide the following information', 
dialogTitle = 'Model Parameters') 

# If the user left the model name fi~ld blank we will need to give it a default 
#name . This will also be the case if the user hits 'cancel' because then this 
# field will have None 

'I if user_inputs[e]: 
model_name = user_inputs[e.J . 

i else: 
1 print 
I 

'!You did not ·type in a n~me for the model ' + \ 
'Assuming name - Truss Structure ' 

model_name = 'Truss St~Licture' · 

# If t he user enters a . cha~acter where ~ number (float or integer) is expected, 

I 
# the float() fun·ction· will · ~hrow an error "Val.ueError: invalid literal for 

. #float(): xxxx". This .will also be the· c~se if the user .hits ' cancel' because ____j 



364 Parameterization,.Prompt Boxes and XY Plots 

.--

1

. # then this field will have 'None' 
try: 

1 
truss_member_length = float(user_inputs[l]) 

1 except: I print ' !You did not type in an integer or float. Assuming a length of 2' 

I 
truss_member_length = 2 

try: 

I 
truss_height = float(user_inputs[2]) 

except: 
1 print '!You did not type in an integer or float. Assuming a height of 1.5' I truss height = 1 . 5 

user_inputs = getinputs(fields =(('Name the model:', 'Truss Structure'), 
('Length of truss members', '2'), 
('Height of truss', '1,5')), 

label= 'Please provide the following information', 
dialogTitle = 'Model Parameters') 

The getlnputsO method is used to obtain multiple inputs from a user. It displays a modal 
dialog box with a column of labels and text input fields as wel1 as an 'OK' button and a 
'Cancel ' button. The required argument fields is a sequence of sequence of Strings. Each 
sequence is a pair of Strings specifying the label that appears next to the text field and a 
default value that appears in the text field. If you don't want a default value to appear in 
the text field this second String must be an empty String. The option arguments are label 
and dialogTitle. dialogTitle as the name suggests is a String specifYing the text in the 
title bar of the dialog box. If you don't provide this argument the dialog box will be titled 
"Get Inputs". label is a String specifYing a label to be placed at the top of the dialog box 
above column of labels and text fields. By default this is an empty String so no label is 
displayed. 

Since we have a single variable on the left hand side of the statement, user_inputs wiB 
be a list. We can then refer to the model name, member length and truss height as 
user_inputs[O], user_inputs[l) and user_inputs(2). We could instead have written this 
statement as: 

[model_name, truss_member_length] 
getinputs(fields =(('Name the model:', 'Truss Structure'}, 

('Length of truss members', '2'), 
('Height of truss', '1 .5')) , 

label= 'Please provide the following information', 
dialogTitle = ' Model Parameters' 
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Note that getlnputsO cannot be used if you run the script from the command like with a 
command line option such as noGUI because the GUI must be present to display the 
prompt box. 

if user_inputs[0]: 
model_name = user_inputs[9] 

else: 
print '!You did not type in a name for the model' + \ 

'Assuming name - Truss Structure ' 
model_name = 'Truss Structure' 

We need to make sure the user actually entered a String to name the model. If the user 
leaves the field blank, getlnputsO will return " (an empty String) for that field. Also if 
the user clicks Cancel in the prompt, getlnputsO will return a None object for this field 
(and for the other two as well). If we try to use this empty string " or Null object as our 
model name we will get an error. The if statement helps us catch this. For those of you 
without much programming experience it might look like there is no condition in our if 
statement. You would expect to see 

if user_inputs[e] != '' and user_inputs[e] != None: 

in which either of the two conditions (user_inputs[O] != " and user_ inputs[O] =None) 
evaluate to TRUE. So basically you end up with 

if (TRUE): 

What' s important is not the fact that you used a condition, it's the fact that it resulted in a 
TRUE. In Python, as in most programming languages, any non-zero value or value that is 
not 0, None, or an empty string " is TRUE, and a 0, None or" is FALSE. Therefore if 
user _inputs is not an empty string or a Null object, the statement becomes 

If(TRUE): 

If this is confusing for you, feel free to write the entire condition. 

The model name will be assigned the String entered by the user if the condition is true. 
And if it happens to be a None, then the default of 'Truss Structure' will be the model 
name. 

try: 
truss_member_length = float(user_inputs[l]) 

except: 
print '!You did not type in an integer or float. Assuming a length of 2' 
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truss_member_length = 2 

Everything the user types into the text boxes is stored as a String. For example if the user 
types 4.2 for the height, user_inputs[2] is the String '4.2' . We use foatO to convert it to 
a float. 

However if the user typed in letters of the alphabet or some special characters instead of 
numbers, the floatO method will throw an exception. If we catch this exception we will 
know immediately that the user has not entered a number so we use a try block to catch 
this. This is not the first time you are seeing a try block, but in case you've forgotten, if a 
statement inside a try block throws an exception, the program does not terminate. Instead 
it executes the code inside the except block. Our except block prints out a message in the 
message area (it will be in red because we preceded it with an exclamation point), and 
assigns the truss members a default length. 

try: 
truss_height = float(user_inputs[2]) 

except: 
print '!You did not type in an integer or float. Assuming a height of 1.s· 
truss_height = 1.5 

The procedure is repeated for the truss height. 

14.4.2 Create the model 
The following block creates the model. 

# ------ - -- - --------------------- ----- - ----- - --- - ---- --- - ----- - ------- --- -
# Create the model 

mdb.models.changeKey(fromName='Model-1', toName=model_name) 
trussModel = mdb.models[model name] 

Here we have modified the code that creates the model to use the String value stored in 
the variable model name as the name of our model. 

14.4.3 
The following block creates the part. 

I . ------------------------- - -- ------ - ---------------------- - ------- - ------

# Create the part 
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ri~p-~~t-·~k~t~-h··-·····-······----·---··-····························-·····--···· ·-······-·-···············-······· ·· .. ··-· .. ··"········ .. ······-······-.. ·-·-···--··-···- --- ··----------··--................ -........ -.......................................... _ ..... l 
import part 

trussSketch = trussModel . ConstrainedSketch(name='2D Truss Sketch', sheet5ize=10 .0) 
trussSketch.Line(pointl=(B, B), point2=(truss_member_length, B)) 
trussSketch.Line(pointl=(truss_member_length, 0), 

point2=(2*truss_member_length, e)) 
trussSketch.Line(point1=(2*truss_member_length, e), 

poi nt2=(3*truss_member_length, e)) 
trussSketch.Line(pointl=(e, -truss_height}, li 

point2=(truss_member_length, -truss_height)) 
trussSketch.Line(pointl=(truss_member_length, -truss_height), I 

I 
point2=(2*truss_member_length,-truss_height)) 

trussSketch.Line(poi ntl=(e, -truss_height}, 
! point2=(truss_member_length, a)) 
l trussSketch.Line(pointl=(truss_member_length, a), 
'j point2=(2*truss_member_length, -truss_height )) 

trussSketch . Line(pointl=(2*truss_member_length, -truss_height), 
i point2=(3*truss_member_length, e)) 
I trussSket ch.Line(pointl=(truss_member_length, a), 
I point2=(truss_member_length, -truss_height)) 
! trussSketch. Line(point1=(2*tr uss_member_length, 0), I point2=(2*truss_member_length, -truss_height)) 

,

1 

trussPart = trussModel.Part(name= ' Truss', dimensionality=TWO_D_PLANAR, 1

1 

type=DEFORMABLE_BODY) 
! trussPart.BaseWire(sketch=trussSketch) 
L---- ---------.. 

All of these statements have been suitable modified so that the variable values accepted 
by the getlnputsQ prompt box now form the dimensions of the truss. This is a good 
example of parameterization. Whatever dimensions the user enters in the prompt box are 
used to build the truss accordingly. 

The following block creates the section. 

# -- - ---------- - -- --------------- --- - ------------- - ---- --------- -- --------
# Create a section and essign the truss to it 
i mport section 

# Set the radius to 0.5% of the length 
truss_member_radius = 0.005*truss_member_length 
truss_member_area = 3.14*(truss_member_radius**2) 

t r ussSection = trussModel.TrussSection(name='Truss Section', 
material ='AISI 1005 Steel ', area=truss_member_area) 

edges for section assignment = trussPart.edges \ 
------------------------------~ 
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.findAt(((truss_member_length/2~ 9 . 9~ 9.9), ), ! 

((truss_member_length + truss_member_length/2, e.e, 9.0), ), li 
((2*truss_member_length + truss_member_length/2, e.e, 0.9), ), 
((truss_member_length/2, -truss_height, e.e)~ ), 
((truss_member_length + truss_member_length/2~ -truss_height, 9.9), ), 1 
<<truss_member_length/2, -truss_height/2, e.9}, >~ 

1

1 

((truss_member_length + truss_member_length/2, -truss_height/2, e.e), ), 
<<2*truss_member_length + truss_member_length/2, -truss_heightt2, e.9}, >, ,I 

((truss_member_length, -truss_height/2, 9.9) 1 ) 1 I 

((2*truss_member_length, -truss_height/2, 9.9), )) I 
truss_region = regionToolset.Region (edges=edges_for_section_assignment) ! 
~russPart.SectionAssignment(region=truss region, sectionName='!russ Section') ______ j 

Here you once again see the section creation and assignment block has been 
parameterized and uses variable names instead of hard coded values. All the arguments of 
the edges.findAtO method have been parameterized since the locations of the truss 
members depend on the parameters used when creating the truss. 

14.4.5 Create sets 
The following block creates sets for later use. 

# ---- - -------------------------------------------------------------------
# Create sets 

# create set for load point 
vertex_coords_for_force = (2*truss_member_length, e.e, 9.0) 
vertex_for_force = trusslnstance.vertices.findAt((vertex_coords_for_force,) ) 
trussAssembly.Set(vertices=vertex_for_force, name='force point set') 

# create set for end point 
vertex_coords_for_end = trussinstance.vertices.findAt(((3*truss_member_length, 

0 . e, e.e),)) 
trussAssembly.Set(vertices=vertex_coords_for_end, name='end point set') J 
You see that parameterization required the modification of these statements as we11. The 
locations of the vertices depend on the parameters of the truss. 

14.4.6 R~uest aad use load ma 
The following block creates the loads. 

# -------------- -- -- - -- - ----- -------- ------------- - ----- - -- --- -- - -------- -
# Apply loads 

# Ask user for magnitude of concentrated force 
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r-·-~*··---OOOO-ROOOOOO-------·--·--•••••<•<•--·-----···----······••moo•< <OOOOOOOO-OO-OOOO-OO----······-···----······ ·········· ·-···-··-·-·····-···--······-··-·-···--··---··-·-----·--··········-·-··---···--·-·---------·--·--------~------·--·-·---··--. 

! user_input_2 = getinput(prompt = 'Magnitude of concentrated force (in -Y j 
! direction)', default = '6888') l 
l try: I 
l force_input = float(user_input_2) ! 
! except: i 
1 print '!You did not type in an integer or float. Assuming force ' + \ I 

'magnitude of 6888' ll, 

force_input = 6000 

i # Apply concentrated force on second node I 
l I I # We aleady have the vertex for force from the assembly step so we use that 

I 
trussModel.ConcentratedForce(name='ForcePulse', createStepName='loading Step', I 

region=(vertex_for_force,), cf2=-force_input, 
! ---------··--·······--·----··---·---............. _ .. ________ ~_i. st_~~~~-~-i_O._~_!Y.P..:~~-~!~~~~~ f ~~ld~:_2_!oca~cs ys =:_~_?ne ) ______ I 

The getlnputO method is used to prompt the user for the magnitude of the concentrated 
force. getlnputO serves a purpose similar to getlnputsQ. The difference is that it obtains 

a single input from the user in the dialog box whereas getlnputsO obtains multiple 
inputs. 

getlnputO has one required argument prompt which is the String to be displayed next to 

the text field. lt has one optional argument default which is the default String to place in 
the text field. 

We follow getlnputQ with a try block similar to the ones we used after getlnputsO. 

The variable force_input is then used as an argument for ConcentratedForce(). 

The following block creates the boundary conditions. 

~ # --:~-=-=--::::::.-=-=-~-=-=-~~:-=-=·-:~=----=-~:-==·=-~~=-=-~-:-:-:-:=·=-::-:~---=-=-=-=-=-=-=-=·-------------- .,I 
I # Apply boundary conditions 
I 
I # Pin left end of upper beam 
! vertex_coords_for_first_pin = (0.0, 0.8, 0.0) 
i vertex_for_first_pin = trussinstance.vertices \ 

I 
.findAt((vertex_coords_for_first_pin,)) 

trussModel .DisplacementBC(name= ' Pinl', createStepName='Initial', 
! region=(vertex_for_first_pin,), 
j ul=SET, u2=SET, ur3=UNSET, I amplitude=UNSET, distributionType=UNIFORM) 

I # Pin left end of lower beam _j 
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vertex_coords_for_second_pin = (9.9, -truss_height, e.e) 
vertex_for_second_pin = trussinstance.vertices \ 

.findAt((vertex_coords_for_second_pin,)) 
trussModel.DisplacementBC(name='Pin2', createStepName='lnitial', 

region=(vertex_for_second_pin,), 
ul=SET, u2=SET, ur3=UNSET, 
amplit ude=UNSET, distributi onType=UNIFORM) 

This block now refers to the truss dimension variables instead of hard coded values. 

The following begins the post processing. 

import odbAccess 
import visualization 

#--- --------------------------------------------- ------------------- ------
# Plot the deformed state of the truss 

# - - -- - - ------- - --- -- --------- -------------- - ------- - --- ----- - ----- -- ---- -
# Make XY plots of U2 displacement for force point and end point 

# -- ----- ------------ ----- - - ----------------
# a) XY plot and data output of U2 di splacement for force point 

# --- - - - ------- ----- - -- - ------- - -- -- -- - -----
# b) XY plot of U2 displacement for end point 

The statements that plot the deformed state of the truss, and XY plots of U2 displacement 
for the point of application of force and the end point of the truss, are left unchanged. 
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-
14.4.9 .~~mbined n ntot .,, :· .. '"'~ 

. ~ .r'""":. ~;_. •.• ~ <j,i~~~ ~: 

The following creates a combined U2 displacement plot for the two sets. 

1#-=-=--=-=-=--~~~-=-=-=-=-~~=-=·=-~· =-~-.::-=:-::-_-=-~-=-=-:.-:.-::.-::-:_-::: .. =-=··=-~-~·-.:-~-~-.:-.::-=-=---=-=-~-=-=-~-~-=-=~~-=----·-----
! # Create a combined XV plot of the U2 displacement for force point and end point 
I 
I xy_data_l = session.xyDataObjects['Data for force point'] 
I curve_l = session.Curve(xyData=xy_data_l) 
! xy_data_2 = session.xyDataObjects['Data for end point'] ! curve_2 = session.Curve(xyData=xy_data_2) 
; 

I # Before plotting we make sure the name 'Combined plot' is not already in 

l
l # delete it if it is, because Abaqus does not allow overwriting of plots 
if 'Combined Plot' in session.xyPlots.keys(): 

I 

I 

del session .xyPlots['Combined Plot'] 

combined_plot = session.XYPlot('Combined Plot') 
combined_plot_chart_name = combined_plot.charts.keys()[e] 
combined_plot_chart = combined_plot.charts[combined_plot_chart_name] 
combined_plot_chart.setValues(curvesToPlot=(curve_l, curve_2, ), ) 

use, and 

li combined_plot_viewport = session.Viewport(name='Combined Plot Viewport') 
. combined_plot viewport. setva_lu~s ( displayedObj ect=combined :::p_l_o_t .:....) __________ , 

Here a combined XY plot is created. Notice that the statements are similar to those for 
plotting a single XY plot. The difference is that that in the (cbart).setValuesO method 
the curvesToPlot argument is set to two curves instead of one. 

The following statements use the chart options to modify the chart. 

I # ------ ----------------------------- - ------------ - - - ----- - ---- - - ---------! # Modify the chart using the chart options 
I 
i # Plot major and minor vertical gridlines 
! combined_plot_chart.majorAxislGridStyle. setValues(show=True) I combined_plot_chart.majorAxislGridStyle.setValues(color='#FFeeee') I combined_plot_chart.majorAxislGridStyle.setValues(style=DASHED) 
! combined_plot_chart .majorAxis1GridStyle.setValues (thickness=0.5) I combined_plot_chart.minorAxislGridStyle.setValues(show=True) 
1 combined_plot_chart.minorAXislGridStyle.setValues(color='#eeFFFF') 
1 combined_plot_chart.minorAxislGridStyle.setValues(style=DOTTED) 
I combined_plot_chart.minorAxis1GridStyle.setValues(thickness=0.2) 
~ 
I # Plot major and minor horizontal gridlines I combined_plot_chart .majorAXis2GridStyle.setValues(show=True) 
! combined plot ch~~t. "!~or~is2~~!.~~ty le. setVa~-~-~ ( co~~!~-~££_~ee~~-----.. ---·-·--·-·---.. -
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combined_plot_chart.majorAxis2GridStyle . setValues(style=DASHED) 
combined_plot_chart . majorAxis2GridStyle . setValues(thickness=9. 5) 
combined_plot_chart.minorAxis2GridStyle . setValues(show=True) 
combined_plot_chart.minorAxis2GridStyle.setValues(color='#00FFFF') 
combined_plot_chart.minorAxis2GridStyle.setValues(style=DOTTED) 
combined_plot_chart.minorAxis2GridStyle.setValues(thickness=0.2) 

# Add a border to the grid 
combined_plot_chart.gridArea.border.setValues(show=True) 

# Change the grid display color 
combined_plot_chart .gridArea.style.setValues(color='#FFFC95') 

# Set grid area size to square (set the aspect ratio to 1) 
session.charts['Chart-3'].setValues(aspectRatio=1.9) 

# Set the grid position to auto-align with an alighnment of 'center' 
combined plot chart.gridArea.setValues(positionMethod=AUTOMATIC, alignment=CENTER) 

combined_plot_chart.majorAxislGridStyle.setValues(show=True) 
combined_plot_chart.majorAxis1GridStyle.setValues(color='#FF9889' ) 
combined_plot_chart.majorAxis1GridStyle.setValues(style=DASHED) 
combined_plot_chart.majorAxis1GridStyle . setValues(thickness=9.5) 

XYPiots have 4 LineStyle objects which are used to define the line style to be used for 
drawing XY-Piot objects. These are majorAxislGridStyle, majorAxis2GridStyle, 
minorAxislGridStyle, minorAxis2GridStyle. All of them have a setValuesO method 
which is used here. This setValuesO method has 4 optional arguments. color is a String 
specifYing the color to be used. show is a Boolean specifYing whether the line should be 
shown. style is a SymbolicConstant specifYing the line style with possible values of 
SOLID, DASHED, DOTTED, and DOT_DASH. thickness is a Float specifying the 
line thickness in mm to be used when drawing the lines. 

The 4 statements could have been combined into one statement with all the arguments of 
setValuesO provided together. 

# Add a border to the grid 
combined_plot_chart.gridArea.border.setValues(show=True) 

# Change the grid display color 
combined_plot_chart.gridArea.style.setValues(color='#FFFC95') 

# Set grid area size to square (set the aspect ratio to 1) 
session.charts['Chart-3'].setValues(aspectRatio=l.8) 

# Set the grid position to auto-align with an alighnment of 'center' 
combined_plot_chart.gridArea.setValues(positionMethod=AUTOMATIC, alignment=CENTER) 
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The comments interspersed with the code explain the purpose of each statement. 

# ---- -- --- -------------------------------- ----------- -------- ---- -- -- -- - -
# Modify the axes of the chart using the axis options 

# Set the x-axis to linear (as opposed to log scale) 
combined_plot_chart.axes1[8].axisData.setvalues(scale=LINEAR) 

# Set the Y-axis to linear (as opposed to log scale) 
combined_plot_chart.axes2[a].axisData.setValues(scale=LINEAR) 

#set the scale of the X axis 
combined_plot_chart.axesl[a].axisData.setValues(maxValue=a.el, 

maxAutoCompute=False) 

combined_plot_chart.axesl[e].axisData.setValues(minValue=e, minAutoCompute=False) 

#set the scale of the Y axis 
combined_plot_chart.axes2[8].axisData.setValues(maxAutoCompute=True) 
combined_plot_chart.axes2[8].axisData.setValues(minAutoCompute=True) 

# Set the frequency at which X-axis values are displayed 
combined_plot_chart.axesl[e].axisData.setValues(tickMode=INCREMENT) 

# Set the frequency at which Y-axis values are displayed 
combined_plot_chart.axes2[8).axisData.setValues(tickMode=AUTOCOMPUTE) 

# Set the frequency at which minor vertical gridlines are displayed 
combined_plot_chart.axesl[e] . axisData.setValues(minorTickcount=S) 

# Set the frequency at which minor horizontal gridlines are displayed 
combined_plot_chart.axes2[8].axisData.setValues(minorTickCount=l) 

# Display the X-axis tickmarks on the inner side of the grid 
combined_plot_chart.axesl[e].setValues(tickPlacement=INSIDE) 

# Display the Y-axis tickmarks on the inner side of the grid 
combined_plot_chart.axes2[8).setValues(tickPlacement=OUTSIDE) 

# Set the frequency and style of tick marks displayed on the X-axis 
combined_plot_chart.axesl[e].setValues(tickLength=4) 
combined_plot_chart.axesl[e].tickStyle.setValues(style=SOLID) 
combined_plot_chart.axes1[0].tickStyle.setValues(thickness=1.2) 
combined_plot_chart.axesl[e].tickstyle.setValues(color='#eeeeee·) 

# Set the frequency and style of tick marks displayed on the Y-axis 
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I combined_plot_chart.axes2[0].setvalues(ticklength=2} 
1 combined_plot_chart.axes2[0].tickStyle.setValues(style=SOLID) 
1 combined_plot_chart.axes2[0].tickStyle.setValues(thickness=1.2} 
l combined_plot_chart.axes2[e].tickStyle.setValues(color='#eeeeee') 

# let Abaqus/CAE assign the default X-axis title 
combined_plot_chart.axesl[e].axisData.setValues(useSystemTitle=True) 

# Set the v-axis title 
combined_plot_chart.axes2[9].axisData.setValues(useSystemTitle=False, 

title='Displacement of node') 

# Set the font style and color of the x-axis title 
combined_plot_chart.axesl[B].titlestyle \ 

.setValues(font=' -*-arial-medium-r-normal-*-*-189-*-*-p-*-*-*') 
combined_plot_chart.axes1[9].titleStyle.setValues(color='#eeeeee·) 

# Set the font style and color of the Y-axis title 
combined_plot_chart.axes2(e].titleStyle \ 

. setValues(font='-*-arial-medium-r-normal-*-*-189-*-*-p-*-*-*') 
combined_plot_chart.axes2[0].titleStyle.setValues(color='#eeeeee·) 

# Set the placement of the X-axis (top, bottom or center of chart ?) 
combined_plot_chart.axes1[0].setValues(placement=MAX_EDGE) 

# Let Abaqus CAE decide the placement of the v-axis 
combined_plot_chart.axes2(e).setValues(placement=MIN_MAX_EDGE) 

# Set the format of the x-axis labels to decimal with precision of 3 sig figs 
combined_plot_chart.axes1[e].axisData.setValues(labelFormat=DECIMAL) 
combined_plot_chart.axes1[e].axisData.setValues(labelNumDigits=3} 

# Set the format of the Y-axis labels to decimal with precision of 3 sig figs 
combined_plot_chart.axes2[0].axisData. setValues (labelFormat=AUTOMATIC) 
combined_plot_chart.axes2(0].axisData.setValues(labelNumDigits=2) 

# Set how frequently labels are displayed on the X-axis (1 = every major gridline, 
# 2 = every second major gridline etc) 
combined_plot_chart . axesl[e].setvalues(labelFrequency=l) 

# Set how frequently labels are displayed on the Y-axis (1 every major gridline, 
# 2 = every second major gridline etc) 
combined_plot_chart.axes2(0).setValues(labelFrequency=1) 

# Set the font style and color of the X-axis labels 
combined_plot_chart.axes1[0).labe1Style \ 

.setValues(font='-*- verdana-medium- r-normal-*-*-198-* -*-p-*-*-*') 
combined_plot_chart.axesl[e].labelStyle.setValues(color='#eeeeee·) 

# Set the font style and color of the Y-axis labels 
combined_plot_chart.axes2[9].labe1Style \ 

.setValues(font=' -*-verdana-medium-r-normal-*-*-100-*-*-p-*- *-*') 
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.--------------------------------------------·--------------------·--·-, l combined_plot_chart.axes2(0).labelStyle. setValues(color='#000000') ' 
I I # Set the style and calor of the X-axis line 
i combined_plot_chart.axes1(0).lineStyle. setValues(style=SOLID) I combined_plot_chart.axes1[0].lineStyle.setValues(thickness=0.2) 

I # Set the style and calor of the Y-axis line 
I combined_plot_chart.axes2[0].linestyle.setValues(style=SOLID) 1 

! combined_plot_chart .axes2[e].lineStyle .setValues(thickness=0.2) ! 
,,.,.,..,,_, ,,,,.,.,.,~,,-,.,..,,,.,,,,,.,.,,, ,,,,,,,,,.,,,,.,,, .,,,..,,,.,,.,,.,,.HH'"w"""'"'''-"'''''-'''' ''''""''''''""''''''""'"'' ''''" ''''"'''"''''""'''"'"""'""'''"''' ''"''''''"'"''"' ''''"''''''""""""""-''''''"''''''"""''"~''-"""''-""'''"'"''''''"'''"""'"'"'''''""'"''"' 0" 0"'""""''""''""' ' ' '""''''' " ''''''''"'''''-"''"'1 

The code has been heavily commented. Please read these comments for an explanation. A 

lot of the actions performed here by the script can be reused by you for projects of your 
own. 

14.4.12 Title Options :· · 
The following statements use the title options to modify the plot title. 

j#--=-=-----==~-=-=-=-~-=-=~-~-=-=-::.-·.:-.::-::--::-_-~-:.-=-=-~-==·---------------~-:.-:·~ -----------------

1 

# Create/Modify the chart title using the plot title options 

1 # Set the plot title 
I combined_plot.title.setValues(text='Displacement Vs Time') 
I 
' # Set the plot title font style and calor 

combined_plot .title.style \ 
.setValues(font=' -*-arial-medium-r-normal-*-*-240-*-*- p-*-*-*') 

combined_plot .title.style.setValues(color='#eeseee') 

# Do not inset the plot title I combined_plot.title.area.setValues(inset=False) 

I # Auto-align the plot title at the top-center I 
j combined_plot.title.area.setValues(positionMethod=AUTOMATIC, alignment=TOP_CENTER) ll 

I # Give the plot title a border 
combined_plot.title.area.border.setValues(show=True) j 

11 t the calor of the plot title border 
~n!._d_p~t. title. area. border. ~-~!_~~~ues ( co~~-= '#eeeeee ·) ___I 

This code has also been heavily commented so there is no need for further explanation. 

All the changes you might wish to make to the plot title are demonstrated here and you 

can copy and reuse these statements into scripts of your own. 

To make sure you understand the object structure here 
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combined_plot.title . setValues(text='Displacement Vs Time') 

can be written as 

session.xyPlots[ ' Combined Plot'] . title.setValues(text='Displacement Vs Time') 

# --- ---- -- -- - - - - -- -- - ------ - ------ -------------------- - -- - - ---------- -- - -
# Modify the plot legend using the chart legend options 

# Display the legend 
combined_plot_chart.legend.setValues{show=True) 

# Give the legend a title 
combined_plot_chart . legend.setValues(title='Legend: ' ) 

combined_plot_chart.legend.textStyle \ 
.setValues{font=' -*-verdana-medium- r- normal -*-*-120- *-*-p-*-*-*') 

combined_plot_chart . legend.titleStyle \ 
.setValues(font=' -*-verdana-medium- r -normal-*-*-129-*-*-p-*-*-*') 

combined_plot_chart . legend . textStyle.setValues(color='#FFeeee') 
combined_plot_chart.legend . titleStyle . setValues(color='#FFeeee') 

# Di splay minimum and maximum values on the legend 
combined_plot_chart . legend . setValues(showMinMax=True) 

# Set the format to decimal with precision of 3 sig figs 
combined_plot_chart.legend.setValues(numberFormat=DECIMAL) 
combined_plot_chart . legend. setvalues(numDigits=3) 

# Set the position to inset so the legend can be displayed over the grid 
combined_plot_chart.legend.area.setValues(inset=True) 

# Choose manual positi oning, and position the legend at desired location 
combined_plot_chart.legend.area. setValues(positionMet hod=MANUAL) 
combined_plot_chart . legend.area.setValues(originOffset=(0.2, 9.1)) 

# Give the legend a border 
combined_plot_chart.legend.area.border . setValues (show=True) 

# Set the calor of the legend border 
combined_plot_chart.legend.area . border .setValues(color='#eeeeFF') 

# Fill the legend with a white background so the grid is not visible through it 
combined_plot_chart.legend.area .style. setValues(fill=Tr ue) 
combined plot chart.legend .area. style . setValues(color= '#FFFFFF') 
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The heavily commented code explains itself. Chances are any changes you wish to make 
to the plot legend using a Python script are demonstrated here and you can reuse these 
statements in projects of your own. 

Once again, to make sure you understand the object structure, 

combined_plot_viewport . setValues(width=250.0, height=200.0) 

can be written as 

session.viewports['Combined Plot Viewport'].setValues(width=250 .0, height=200.0) 

The fol1owing statements use the XY Curve options to modify the legend on the plot 

~.:-::-_-=-=-:.~~=-=-=·=-=-=-=-~-~-=-=-.:-~-_:-~~ -- - - ---------------------------------------
1 # Change the plot curve line style, calor, thickness etc using the XV Curve options 
I 

I # Use the name assigned to the curve object as the name of the curve in the legend 
curve_l.setValues(useDefault=True, legendSource=CURVE_NAME) 

I 

I # Create a new name for the name of the curve in the legend 
1 curve_2.setValues(useDefault=False, legendlabel='Displacement of the end point') 
I I # Set the line style and thickness for the force point curve 
i curve_l.lineStyle.setValues(show=True) 
! curve_l.lineStyle.setValues(style=DASHED) 
1. curve_l.lineStyle.setValues(color='#8899FF') 

curve_l.lineStyle.setValues(thickness=8.8) 
I 
i # Set the line style and thickness for the end point curve 

I
. curve_2.lineStyle.setValues(color='#eeeese·) 

curve_2.lineStyle.setValues(style=SOLID) I curve_2. lineStyle.setValues(thickness=0.5) 

! # Show symbols on the end point curve 
! curve_2.symbolStyle.setValues(show=True) I 
I curve_2.symbolStyle.setValues(color='#eaeasa·) 

I curve_2. symbolStyle. setValues(marker=FILLED_CIRCLE) ···----------··-iJ 
! curve_2.symbol5tyle.setValues(size=l.6) 
L------·-·---- ·-----··-·----·····- -····--·-··-···-··-·----··----····-·-·--···---- -·-------·----

The statements are commented and should not require further explanation. They can be 

copied and reused in your own scripts. 
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Just so you're paying attention, 

curve_l .setValues(useDefault=True, legendSource=CURVE_NAME) 

can be written as 

session.curves['Data for force point '].setValues(useDefault=True, 
legendSource=CURVE_NAME) 

14.4.15 Print the plot to an image 
The following statements save the plot as an image file, in this case a .png (Portable 
Network Graphics) 

# ---------------- - ---- -- ----------- - ------- -- - ---------- -- ---------------
# Save the plot by printing it to a png file 

# Set the size of the image 
session.pngOptions.setValues(imageSize=SIZE_ON_SCREEN} 

# Opt not to reduce the image to 256 colors 
session.printoptions.setValues(reduceColors=False) 

# Store the name and path you wish to give the file in a variable 
# If you only specify a name and no path, it will be saved in the Abaqus Work 
directory 
png_name_and_path = 'combined_plot_image' 

# Print the image to a file 
# Note that if the file already exists it will be replaced 
session.printToFile(fileName=png_name_and_path, format=PNG, 

canvasObjects=(combined_plot_viewport, }) 

The comments interspersed with the statements explain the code and you should read 
those. In addition to them I'll point out a couple of useful facts in case you try to 
accomplish a similar task in your own scripts. 

The statement 

session.pngOptions . setValues(imageSize=SIZE_ON_SCREEN) 

sets the size of the png image to be the same as the size of the plot on the users screen 
using the SIZE_ ON_SCREEN SymbolicConstant. If you instead wished to set it to an 
exact size with width and height, you might write it as 

session.pngOptions.setValues(imageSize=(709, 566)) 
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The statement 

png_name_and_path = 'combined_plot_image' 

assigns the name of the to-be png image to the variable png_name_and_path. When 

used in conjunction with the printToFileO method in the next statement, this places the 

png in a file called combined_plot_image.png in the Abaqus Work Directory. lf on the 

other hand you want to give it a specific location on your hard drive, you could give it a 

full path as: 

png_name_and_path=' C:/Users/Gautam/Desktop/combined_plot_image' 

. ..,., .,.,..... ·~ 

'~:, '~· ". ·~ ·i.···:·. ·.~·~~u.~·~ ' ..... "" ........ __ ..._...._....__...,.,.,.......,~-· 
In this chapter you saw a good demonstration of the parameterization procedure. 

Parameterization is the foundation of almost any optimization analysis as it allows you to 

treat quantities as variables and change them easily without having to recreate the model 

manually. In addition you now have a few blocks of script code that can modify all 

aspects of an XY plot, and you can reuse these in your own scripts. 



15 -
Optimization of a Parameterized 

Sandwich Structure 

15.1 Introduction 
This chapter is another example of both parameterization and optimization studies. We 
will conduct an iterative optimization study on a parameterized sandwich structure. A 
sandwich structure consists of a layer of material sandwiched between two other layers 
which may or may not be of the same material. In our sandwich structure the two outer 
layers are solid planks or plates whereas the inner layer is a square honeycomb core. One 
end of the sandwich structure is fixed while the other end is free giving us something 
similar to a cantilever beam. Tie constraints will be used between the sandwich layers to 
hold them together. 

We will write a parameterized script where the dimensions such as length, width, layer 
thicknesses and core cell dimensions will be specified at the start of the script, and the 
entire model will be created on the basis of these. 

The user will provide input using a text file. Here each line of the text file will consist of 
tab separated values of all of the variables. For each line of this input file the script will 
extract the dimensions and perform an analysis. Therefore the bulk of the script will be 
inside a for loop iterating as many times as there are lines in the input file. 

The results of each analysis (the displacement of nodes near the end of the sandwich 
beam) will be printed to an output file along with the input variables as tab separated 
values. The benefit of having such output is that these values can then be imported into a 
program such as Microsoft Excel or Matlab for creating plots and observing trends. 
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The geometry of our sandwich structure is displayed in the figure. 

The following dimensions will be used: 

Top and Bottom Layer 
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The loads and boundary conditions are disp.layed in the next figure. 
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Encastre Boundary 
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"' . ' ~ . . 
You can perform the simulation in Abaqus/CAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. 

1. Rename Model-1 to Sandwich Structure 
a. Right-click on Model-1 in Model Database 
b. Choose Rename .. 
c. Change name to Sandwich Structure 

2. Create the Top Layer 

a. Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Top Layer 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 20 
h. Click OK. You wi.ll enter the sketcher mode. 
1. Use the Create Lines:Rectangle (4 lines) tool to draw the profile of the 

plank 

J. Use the Add Dimension tool to set the width to 0.2 m and the thickness to 
0.03 m. 

k. Click Done to exit the sketcher. The Edit Base Extrusion window ts 
displayed. 

I. Set Depth to 0.8 
m. ClickOK. 

3. Create the Core Layer 

a . Double-click on Parts in Model Database. Create Part window is displayed. 
b. Set Name to Core Layer 
c. Set Modeling Space to 3D 
d. Set Type to Deformable 
e. Set Base Feature Shape to Solid 
f. Set Base Feature Type to Extrusion 
g. Set Approximate Size to 20 
h. Click OK. You will enter Sketcher mode. 
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1. Use the Create Lines: Rectangle (4 lines) tool to draw the profile of the 

plank 
J. Use the Add Dimension tool to set the width to 0.2 m and the thickness to 

0.08 m. 
k. Click Done to exit the sketcher. The Edit Base Extrusion window is 

displayed. 

I. Set Depth to 0.8 
m. Click OK. 

n. Click Create Cut: Extrude tool. 

o. You see the message Select a plane for the extruded cut displayed below 

the viewport 
p. Select the top face of the core layer. 

q. You see the message Select an edge or axis that will appear vertical and 

on the right displayed below the viewport 

r. Select the left edge of the core layer block. You wiJl enter the Sketcher. 

s. Use the Create Lines: Rectangle (4 lines) tool to draw 6 rectangles that will 

be cut out of the core. 
t. Use the Add Dimension tool on each of these rectangles to set the x

dimension to 0.087 m and the y-dimension to 0.12. 

u. Click Done to exit the sketcher. The Edit Cut Extrusion window is 

displayed. 
v. Use the Add Dimension tool to set the width to 0.2 m and the thickness to 

0.08m. 
w. Click Done to exit the sketcher. The Edit Base Extrusion window is 

displayed. 

x. Set Type to Through All. 

y. If Extrude Direction is not through the block (see arrow) then click Flip 

z. Click OK. 

4. Create the Bottom Layer 

n. Double-click on Parts in Model Database. Create Part window is displayed. 

o. Set Name to Bottom Layer 

p. Set Modeling Space to 3D 
q. Set Type to Deformable 

r. Set Base Feature Shape to Solid 

s. Set Base Feature Type to Extrusion 

t. Set Approximate Size to 20 
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u. Click OK. You will enter Sketcher mode. 
v. Use the Create Lines:Rectangle (4 lines) tool to draw the profile of the 

plank 
w. Use the Add Dimension tool to set the width to 0.2 m and the thickness to 

0.03 m. 

x. Click Done to exit the sketcher. The Edit Base Extrusion window is 
displayed. 

y. Set Depth to 0.8 
z. ClickOK. 

5. Create the material 
a. Double-click on Materials in the Model Database. Edit Material window is 

displayed 
b. Set Name to AISI 1005 Steel 
c. Select General> Density. Set Mass Density to 7800 (which is 7.800 glee) 
d. Select Mechanical> Elasticity >Elastic. Set Young's Modulus to 200E9 

(which is 200 GPa) and Poisson's Ratio to 0.29. 
e. ClickOK. 

6. Create 3 sections 
a. Double-click on Sections in the Model Database. Create Section window is 

displayed 
b. Set Name to Top Layer Section 
c. Set Category to Solid 
d. Set Type to Homogeneous 
e. Click Continue ••• The Edit Section window is displayed. 
f. In the Basic tab, set Material to the AISI 1005 Steel which was defined in 

the create material step. 
g. ClickOK. 
h. Again double-click on Sections in the Model ,Database. Create Section 

window is displayed 

I. 

J. 

Set Name to Top Layer Section 
Set Category to Solid 

k. Set Type to Homogeneous 
I. Click Continue •.. The Edit Section window is displayed. 
m. In the Basic tab, set Material to the AISI 1005 Steel which was defined in 

the create material step. 
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n. Repeat steps a thru m to create two more sections Core Layer Section and 

Bottom Layer Section 
o. Click OK. 

7. Assign the sections to the parts 
a. Expand the Parts container in the Model Database. Expand the part Top 

Layer. 
b. Double-click on Section Assignments 
c. You see the message Select the regions to be assigned a section displayed 

below the viewport 
d. Click and drag with the mouse to select the entire top layer. 
e. Click Done. The Edit Section Assignment window is displayed. 
f. Set Section to Top Layer Section. 

g. ClickOK. 
h. Similarly assign Bottom Layer Section to the bottom layer and Core Layer 

Section to the core. 
8. Create the Assembly 

a. Double-click on Assembly in the Model Database. The viewport changes to 

the Assembly Module. 
b. Expand the Assembly container. 
c. Double-click on Instances. The Create Instance window is displayed. 

d. Set Parts to Top Layer 
e. Set Instance Type to Dependent (mesh on part) 
f. Click OK. The top layer is instanced in the assembly. 
g. Again double-click on Instances. The Create Instance window is displayed. 

h. Set Parts to Core Layer 
i. Set Instance Type to Dependent (mesh on part) 
J· Check Auto-offset from other instances 
k. Click OK. The core layer is instanced in the assembly. 
I. Click the Create Constraint: Face to Face tool. You see the message Select 

a planar face or datum plane of the movable instance below the viewport. 

m. Click the bottom face of the top layer. You see the message Select a planar 

face or datum plane of the fiXed instance below the vieport 
n. Click the top face of the core. Arrows appear on the faces and you see the 

message The instance will be moved so that the arrows point in the same 

direction below the viewport. 
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o. Click OK or Flip as required to have the arrows pointing in the same 
direction. You see the prompt Distance from the fixed plane along its 
normal below the viewport. 

p. Set it to 0.0 
q. Similarly use face to face constraints on the other two surfaces to align the 

parts as displayed in the figure. 
r. Again double-click on Instances. The Create Instance window is displayed. 
s. Set Parts to Bottom Layer 
t. Set Instance Type to Dependent (mesh on part) 
u. Check Auto-offset from other instances 
v. Click OK. The bottom layer is instanced in the assembly. 
w. Use the Create Constraint: Face to Face tool 3 more times to align the 

parts as shown in the figure. 
9. Create Sets in the Assembly 

a. Expand the Assembly container. 
b. Double-click on Sets. The Create Set window is displayed. 
c. Set Name to displacement point set 1 
d. Set Type to Geometry 
e. You see the message Select the geometry for the set below the viewport. 

Select the lower left corner of the core cell closest to the free end of the 
structure. 

f. Click Done 
g. Double-click on Sets. The Create Set window is displayed. 
h. Set Name to displacement point set 2 
1. Set Type to Geometry 
J. You see the message Select the geometry for the set below the viewport. 

Select the lower left right corner of the bottom layer. 
k. Click Done 

10. Create Steps 
a. Double-click on Steps in the Model Database. The Create Step window is 

displayed. 
b. Set Name to Apply Load 
c. Set Insert New Step After to Initial 
d. Set Procedure Type to General > Static, General 
e. Click Continue •• The Edit Step window is displayed 
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f. In the Basic tab, set Description to Apply the pressure load on top surface 
of sandwich structure. 

g. ClickOK. 
1 1. Leave Field Output Requests at defaults 
12. Request History Outputs 

a. Expand the History Output Requests container in the Model Database 
b. Right-click on H-Output-1 and choose Rename . .. 
c. Change the name to Displacement output 1 
d. Double-click on Displacement output 1 in the Model Database. The Edit 

History Output Request window is displayed 
e. Set Domain to Set. A new dropdown list appears next to it. 
f. Choose displacement point set 1 from this list 
g. Set Frequency to Every n time increments. 
h. Set n: to 1 
I. 

J. 

Select the desired variables by checking them off in the Output Variables 
list. The variable we want is UT (translations) from the 
Displacement/Velocity/Acceleration group. Uncheck the rest. You will 
notice that the text box above the output variable list displays UT. 
Click OK 

k. We need to create the second history output request. Double-click on 

I. 

History Output Requests in the Model Database. The Create History 
window is displayed 
Set Name to Displacement output 2 

m. Set Step to Apply Load 
n. Click Continue ••• The Edit History Output Request window is displayed 
o. Set Domain to Set. A new dropdown list appears next to it. 
p. Choose displacement point set 2 from this list. 
q. Set Frequency to Every n time increments 
r. Set n: to 1 
s. Select the desired variables by checking them off in the Output Variables 

list. The variable we want is UT (translations) from the 
Displacement/Velocity/ Acceleration group. Uncheck the rest. You will 
notice that the text box above the output variable list displays UT. 

t. Click OK 
1 3. Apply boundary conditions 
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a. Double-click on BCs in the Model Database. The Create Boundary 
Condition window is displayed 

b. Set Name to Fix Top Layer Front 
c. Set Step to Apply Load 
d. Set Category to Mechanical 
e. Set Types for Selected Step to Symmetry/Antisymmetry!Encastre 
f. Click Continue ••. 
g. You see the message Select regions for the boundary condition displayed 

below the viewport 
h. Select the end face of the top layer. 
I. Click Done. The Edit Boundary Condition window is displayed. 
J. Choose ENCASTRE (Ul=U2=U3=URl=UR2=UR3=0). 
k. Click OK. 
I. Similarly create a second boundary condition called Fix Core Layer Front, 

applied during the Apply force step with ENCASTRE. This is applied to the 
end face of the core layer. 

m. Create a third boundary condition called Fix Bottom Layer Front, applied 
during the Make Contact step with ENCASTRE. This is applied to the end 
face of the bottom layer. 

14. Assign Loads 
a. Double-click on Loads in the Model Database. The Create Load window is 

displayed 
b. Set Name to Uniform Applied Pressure 
c. Set Step to Apply Load 
d. Set Category to Mechanical 
e. Set Type for Selected Step to Pressure 
f. Click Continue ••• 

g. You see the message Select surfaces for the load displayed below the 
viewport 

h. Select the top surface of the top layer by clicking on it. 
1. Click Done. The Edit Load window is displayed 

J· Set Distribution to Uniform 
k. Set Magnitude to 10 to apply a 10 N force in downward (negative Y) 

direction 
l. Set Amplitude to Ramp 
m. ClickOK 



15.2 Procedure in GUI 389 

n. You will see the forces displayed with arrows in the viewport on the surface 

IS. Define surfaces 
a. Expand the Assembly container in the Model Database. 

b. Double-click on Surfaces. The Create Surface window is displayed 
c. Set Name to Top Layer Bottom 
d. Click Continue ... You see the message Select the regions for the surface 

displayed below the viewport 
e. Set it to individually with the dropdown menu 
f. Select the bottom surface of the top layer. You might need to use the 

Replace Selected tool in the display group toolbar to display just the top 
layer in order to make its bottom surface visible. For the message Set entities 

to replace at the bottom of the viewport set the drop down item to 
Instances. Once you've selected the surface click Replace All to unhide the 

other part instances. 
g. Similarly assign the surface Bottom Layer Top to the top surface of the 

bottom layer 
h. Similarly assign the surface Core Layer Bottom to the bottom surface of the 

core 
r. Similarly assign the surface Core Layer Top to the top surface of the core 

16. Assign tie constraints 
a. Double click Constraints in the Model Database 
b. Set Name to Tie Constraint 1 
c. Set Type to Tie 
d. Click Continue ••• You see the message Choose the master type displayed 

below the viewport 
e. Click Surface. You see the message Select regions for the master surface 

individual displayed below the viewport 
f. Click the Surfaces •. button at the bottom ri.ght of the viewport. The Region 

Selection window is displayed 
g. Choose Core Layer Top. Check Highlight selections in viewport to make 

sure the correct surface is being selected 
h. Click Continue ••• You see the message Choose the slave type displayed 

below the viewport 
1. Click Surface. You see the message Select regions for the master surface 

individual displayed below the viewport 
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J. Choose Top Layer Bottom. Check Highlight selections in viewport to 
make sure the correct surface is being selected 

k. The Edit Constraint window is displayed. 
I. Leave all the settings at defaults. Click OK. 
m. Repeat these steps to create another tie constraint Tie Constraint 1 with 

Core Layer Top as the master and Bottom Layer Top as the slave. 
17. Create the mesh 

a. Expand the Parts container in the Model Database. 
b. Expand Top Layer 
c. Double-click on Mesh (Empty). The viewport window changes to the Mesh 

module and the tools in the toolbar are now meshing tools. 
d. Using the menu bar click on Mesh > Element Type ... 
e. You see the message Select the regions to be assigned element types 

displayed below the viewport 
f. Click and drag using your mouse to select the entire top layer. 
g. Click Done. The Element Type window is displayed. 
h. Set Element Library to Standard 
1. Set Geometric Order to Linear 
J. Set Family to 3D Stress 
k. Check Reduced Integration 
I. You will notice the message CJD8R: An 8-node linear brick, reduced 

integration, hourglass control 
m. ClickOK 
n. Using the menu bar lick on Seed >Part ... The Global Seeds window is 

displayed 
o. Set Approximate global size to 0.04. Leave everything else at default 

values. 
p. C1ickOK. 
q. You see the message Seeding definition complete displayed below the 

viewport. Click Done. 
r. Using the menu bar click on Mesh >Part 
s. You see the prompt OK to mesh the part? displayed below the viewport 

t. Click Yes 
u. Repeat the same process for Bottom Layer and Core Layer. 

18. Create and submit the job 
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a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 

b. Set Name to SandwichStructureJob 

c. Set Source to Model 

d. Select SandwichStructure (it is the only option displayed) 

e. Click Continue .. The Edit Job window is displayed 

f. Set Description to Run the sandwich structure simulation 

g. Set Job Type to Full Analysis. 

h. Leave all other options at defaults 

1. ClickOK 

J. Expand theJobs container in the Model Database 

k. Right-click on ContactSimulationJob and choose Submit. This will run the 

simulation. You will see the following messages in the message window: 

The job input file " SandwichStructureJob.inp" has been submitted for 

analysis. 

Job SandwichStructureJob: Analysis Input File Processor completed 

successfully 

Job SandwichStructureJob: Abaqus/Standard completed successfully 

Job SandwichStructureJob completed successfully 

20. Plot mises stress and contact pressures 

a. Right-click on SandwichStructureJob (Completed) in the Model Database. 

Choose Results. The viewport changes to the Visualization module. 

b. Expand the SandwichStructure.odb container in the Results tree 

c. Expand the History Output container. 

d. You see two spatial displacement variables U2 for bottom layer instance and 

core instance. 

e. Right-click on each of them and choose Save As.. Save them as 

SandwichXYData-1 and SandwichXYData-2. 

f. Using the menu bar click on Report>XY .•. The Report XY Data window is 

displayed 
g. In the XY Data tab, make sure Select from: is set to All XY data. 

sandwichXYData-1 and sandwichXYData-2 should be displayed in the list. 

However sometimes due to a bug in Abaqus (Abaqus v 6.10 does not appear 

to have this bug) the list may appear empty and needs to be refreshed. To 

remedy this change Select from: to XY plot in current view and then back 

to All XY data. You should now see our XY data sets in the list. 
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h. Click sandwichXYData-1 to make sure it is selected. 
r. Click on the Setup tab. 

J. In the File section, set Name to SandwichXYData.txt m 
C:\SandwichFolder (you will need to create this folder). 

k. Uncheck Append to file. 
I. In the Data section, for Write: check XY data, Columns totals and 

Column min/max 
m. Switch back to XY Data tab 
n. Make sure sandwichXYData-1 is selected. 
o. Click Apply. The file SandwichXYData.txt will be written to your Abaqus 

working directory. 
p. Click sandwichXYData-2 to make sure it is selected. 
q. Click on the Setup tab. 

r. In the File section, once again set Name to the same SandwichXYData.txt. 
s. Check Append to file. 
t. In the Data section, for Write: check XY data, Columns totals and 

Column min/max 
u. Switch back to XY Data tab 
v. Make sure sandwicbXYData-2 is selected. 
w. Click Apply. The file SandwichXYData.txt will be written to your Abaqus 

working directory. 

x. Click Cancel to close the Report XY Data window. 

15.3 Python Script , , 
The following Python script replicates the above procedure for the static analysis of the 
truss. You can find it in the source code accompanying the book in 
sandwich_structure_parameterized_enhanced.py. You can run it by opening a new 
model in Abaqus/CAE (File> New Model database> With Standard/Explicit Model) 
and running it with File> Run Script ••• 
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import sketch 
import part 

# a) Top layer 
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hourglassControi=DEFAULT, 

topl!:ay,er<:ells•t:opL.ayerPart. cells . 
seiectedToplayerCells•toplayerCells.findA~(toplayer_inside_coord,) 
topLayerMeshRegion=(seleetedfoplayerCells,) 
toplayerPart.setElementType(regions~op&ayerMeshRegion, 

topLayerPart.seedPart(size=8.84, 

topLayerPart.generateMesh() 

# 1111111111111111111111111111111111111111111 
# Mesh the bOttOII layer _ 
# We place a point sOIIeWhere inside it based on our. knowledge of the geO.,etry 
bottomLayer_inside_coord=(sandwich_width/2, bottom_layer._thickness/2, · -

sandWich_length/2): 

elemType2 a .esh. Ele.lype(ele.tode=C3D8R, elem~ibrary=STANDARD, 
kinematicSplit=AVERAuE~STRAlN, 
secondO~erAccuracyaOF.F, 
hourglasscontrol=DEFAULT, distortioncontrol=DEFAULT) 

bottomLayerCells•botto.LayerPart.~ells 
selectedBotta.LayerCells•bOtto.LayerCells.findAt(botta.Layer_inside_coord,) 
bottomlayerMeshRegion=(selectedBottomtayetcellls,) 
bottomrayerPart.setEleaentType(regions•bottomLayerMeshRegion,· 

elemTypes=(elemType2,)) 

bottomlayerPart.seedRart(size=8.04, deviationFacto~-a.l) 

bottontl.ayerPart. generateMesh() 

# Mesh the core layer . 
f we place a point SOIIIeWhere inside it based on our knowledge of fhe geomj! 
#This point has already been defined in .the initial ~aiculations section as 
# corelayer_inside_coord 

elemT~pe3 • nesh.ElemJype(elemcode=C3D8R,. elemlibr~ry=STANDARD, 
. kinematicSplit=AVERAGE_STRAIN, 

secondOrderAccuracy.OFF, 
hourglasscontrol=DEFAUkt, distortiorteontrol=DEF~~ 

coreLayerCells-corelayerPart.cells 
selectedCoretayerCel]s•torebayereells.findAt,core~ayer_ins~de_coord~)
corelayenMeshRegion=(selectedCoreLayerCeils,) 
coreLayerPart.setEl~ntType(region~=coreLayerMeshRegion, 

el:emTypes•(el...emType3,).) 

coreLayerPart.seedPart(size=8.84, 

coreLayerPart. gener~eMesh(;) ·. · 



15.3 Python Script 403 



404 Optimization of a Parameterized Sandwich Structure 

theoutputvariablename=[] 

for x in keyarray: 
if (x.find~'U2')>-1): 

theoutputvariablename.agpend(x) 

# You uy enter an entire path if you wish to hav~ tbe .report stored in a 
# particular location. 
# One way to do it is using the foilowing syntax. 

reportxy_na.e_and_path • reportxy_path + reportxy_name + •. txt • 

# Note however that the folder ·~Newfolder' must exist otherwise you will 
# likely get the following error 
# "IOError:C/MyNewFolder: Directory not found" 
I You IIIUst either create the folder in Windows before PUnning the script 
# Or if you wish to create it using Python ca.ands you •ust use the 
# os.~~akedir() or os.ukedirs() function 
# os.makedirs() is preferable because you can create mul.tiple nested 
# di~ectaries in one statent if you wish 
# Note that this function returns an exception if the directory already exists 
# hence it is a good idea to use a try block 

try: 
os.makedirs(reportxy_path) 

except: 
print •otrectory exists hence no need to recreate it. Move on to " + \ 

"next state.ent• 

session.XYDataFromH1s~qry(name•'sandwichXV.Oata~l' 1 odb=sandwich~odb_object1 
outputVariableNa.e=theoutputvariablename(e]) 

sandwich_xydata_object • session.xyDataobjects['sandwichXVData-l'J 
session.xyReportoptions.setvalues(totals-oN1 ·.tnMax-oN) 
session.writexYReport(fileNa.e=reportxy_name_and~ath~ · . 

· xyData•(sandWich_xydata_object~ ) 1 appen~de~FF) 

session.XVDataFroiHistory(name='sandwichXVData-2'> odb=sandwich_odb_object, 
outputVariableNa.e=theoutputvariablename(1]) 

sandwich_xydata_object = session.xyDataobjects['sandwiehXVData-2'] · 
session.xyReportoptions.setValues(totals-oN, minMax=ON) . 
session.writeXYReport(file~=reportxy_name_and_pat~6 . 

xyoata=(sandWich~xydata_object~ ), 

sandwich_odb_object.ciose() 

extracted_line • ' ' . . . . . 
1 Need a boolean variable to state· whether we are read~ng the correct section , 
# of the file · 
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Let's examine this script in detail. 
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from abaqus import * 
from abaqusConstants import * 
import regionToolset 

iterat ion_count = 1 

input_file=open('C : /sandwichstructure_input . txt') 

for line in input_file: 
extracted_line = line 
extracted_list = extracted_line .split() 
sandwich_width = float(extracted_list[e]) 
sandwich_length = float(extracted_list[l]) 
top_layer_thickness = float(extracted_list[2]} 
bottom_layer_thickness = float(extracted_list[3]} 
core_layer_thickness = float(extracted_list[4]) 
no_of_core_cells = int(extracted_list[S]) 
wall_thickness_core_cells = float(extracted_list[6)) 

(REST OF SCRIPT APPEARS HERE ) 

input_file.close() 

The input file might look something like this: 

.QI sancfWichstructurejnput.txt- Notepaei 

0.03 0.08 6 
0.03 0.08 5 
0.025 0. 07 5 

0. 04 A 

0.04 
0.04 I 

L 
f 

The QpenO method is used to access the input file. A for loop extracts each line one by 
one using the statement 'for line in input _file' where each line of the input file gets stored 
in the variable line. The splitO command is used to split up this line at the separators (in 
this case tabs) and store each String (they are Strings even though they look like floats 
because we are reading from a file) in a list. We then assign these to variables using the 
tloatO and intO methods to convert them from Strings to floats or integers. 



15.4 Examining tbe Script 407 

These variables are used to run the parameterized script, and then the next iteration 

begins till all lines of the file have been used. Then the input file is closed using the 
closeO method. 

This block initializes variables and performs some preliminary calculations. 

r-~MM~'M'0'0~00~M~oMOO .. oOO oo o .... ~,oou.o-ou~-·•w•-••- • •-•-••••-••••-••••••••••••••• •o•ooooooo-ooooo ooo•ooooooooMooo•oo••••••••••ooowwo .. o o uoo o • o o oooooooooo o o oo ooooonu•oo•o••• • O • ooooo•••••••••••• ,, ••••••••••-••O•••••<•••- ·--·---------------------- ------•- ••''" .. "''"'''"'''''''''•''''" ....... ,, 

! # - ----- - -------- --- -------- - - -- --------- - ---- -- - - ----- - -- - - - - - - - - - - --
! # Variable initialization (units = metres) 

I 
l reportxy_name 

reportxy_path 
'SandwichXYData' 
'C:/SandwichFolder/' 

# - -- --------------------------------------- ------ -- ---- --------- -- -- -
# Initial calculations 

# We will draw the cells in the core by making square cutouts 
core_layer_cell_cutout_length = (sandwich_length - \ 

((no_of_core_cells + l)*wall_thickness_core_cells)) I no_of_core_cells 

# Point used to find the top surface of the core 
# We will be using the findAt command to find the top surface of the core 
# As an argument we need to pass the coordinates of a point on this surface 
# For an even number of cells, the exact center point of the top surface of 
# the core can be used 
# However for an odd number of cells, this point will lie over one of the holes 
# In that case we'll pick a point offset a little way from it 

if no_of_core_cells % 2 == e: 
corelayer_top_face_point = (sandwich_width/2, core_layer_thickness, 

sandwich_length/2) 
corelayer_bottom_face_point = (sandwich_width/2, e.e, sandwich_length/2) 
corelayer_inside_coord = (sandwich_width/2, core_layer_thickness/2, 

sandwich_length/2) 
else: 

corelayer_top_face_point (sandwich_width/2, 
core_layer_thickness, 
sandwich_length/2 + \ 

core_layer_cell_cutout_length/2 + \ 
j wall_thickness_core_cells/2) 
, corelayer_bottom_face_point = (sandwich_width/2, e.e, 
I sandwich_length/2 + \ 

core_layer_cell_cutout_length/2 + \ 
I wall_thickness_core_cells/2) 

1

1 corelayer_inside_coord (sandwich_width/2, 
core_layer_thickness/2, 
sandwich_length/2 + \ 

core_layer_cell_cutout_length/2 + \ 

l_ ""'•••-•••••-•- oO•-•••---·••--•••"•••••---·--- •••••••-•ooo ooooo_., ,_.,_•-•••-""'''""""""'""'~~!: .. ~=!~~-: .. ~~~-~-~=~~-~~=~-~~-~~-L~) _____________ oOoOO- • - ••-•••- •••""''"'"' __ _J 
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We perform some variable initializations for name of the report and the path it will be 
placed in. We also perform some initial calculations. Since we get the number of core 
cells, the wall thickness of the cells, as well as the length of the sandwich structure from 
the input file, we can calculate the length of each cell in order to cut-extrude them from 
the core layer in the part creation block. 

We will later need to select the top and bottom faces of the core to create surfaces and the 
center of the core to create cells for the mesh using findAtQ. The problem is that the 
center point of the core might be a hole after the part is created if there is an odd number 
of cells in the core. In such a case findAtO will not be able to locate any point at the 
center coordinates. Hence an appropriate algorithm is used depending on whether the 
number of cells is even or odd to find a center point or a point close enough to the center. 
If an odd number of cells are present, the point used will be moved away from the center 
such that it lies on an actual surface or inside an actual solid material. 

This block creates the model 

# - -- --- -- ---- --- - ---- ---- --- - - - --- - ---------------- --- ---- - ----------
# Abaqus statements start here 

session.viewports('Viewport: l'] . setValues(displayedObject=None) 

# - -- --- ---------- --- - ---- ---------------- - -------- -- - -- ----------- - --# Create the model 

# Change the model name with each iteration by adding the iteration count to 
# end of its name 
modelname = 'Sandwich Structure' + repr{iteration_count) 
sandwichModel = mdb.Model{name=modelname) 

The model name has the iteration number appended to it so that at the end of all the 
simulation runs the Abaqus/CAE model tree will contain all the models created. This will 
be useful in case you wish to examine them. The reprO method provided by Python is 
used to convert the integer to a String. 

15.4.4 Create the ,_arts, material, section and assembly, 
The following blocks create the parts, material, and section, and assemble the parts. 

# -- ---------- -- ----- -- -- - ----- --- - --- --------- --- -----
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---------------------------------
# Create the parts 

# -- ---- - ------- --- --------- - --- --------- --------------
# Create material 

# --- - ---------------------------------------------------
# Create solid section and assign the beam to it 

# ------ --- --------------------- -------------------------
# Create the assembly 

All of these blocks are familiar to you. The part creation process is fairly simple using 
PartO and BaseSolidExtrudeQ. For the core the MakeSketchTraosformO method is 
used to transform the surface to a 2D plane on which you can draw the cutouts. 
CutExtrudeO is used to extrude the sketch and cut the rectangular holes out of the core. 

The following block identifies faces and sets for later use. 

----------------------------·--··---------
# ++++++++++11 I 11 I+++++++++++++++++++++++++++ 
# Identify all the faces used to constrain the assembly 

# ++++++++++++++++11 I 11 I+++++++++++++++++++++ 
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# Identify all the faces used for boundary conditions 

# +++++++++++++++++++++++++++++++++++++++++++ 
# Identify all the faces used for loads 

# 1111 Ill I I I I I 11 Ill I 11 I++++++++++++++++++++++ 
# Create a set to measure displacement history output 

# ++++111111 1111111 111111 111111 11 111+1111 Ill I 
# Identify faces used to define Surfaces in the assembly. These will 

later be used for tie constraints. 

A number of faces are identified using the findAtO method. These faces will later be 
used to constrain the assembly, assign loads and boundary conditions, and define surfaces 
in the assembly. The sets identified are the points at which history output infonnation 
will be requested. All the coordinates supplied to the findAtO method are obtained using 
simple fonnulas that factor in the dimensions of the parts. 

The following block assembles the layers together. 

#+++I 11 I 11++++++++++++++++++++++++++++++++++ 
# Assemble the parts using face to face relationships 

# Establish face to face relationships between top layer and core layer 
sandwichAssembly.FaceToFace{movablePlane=topLayer_front_face, 

fixedPlane=coreLayer_front_face, flip=OFF, 
clearance=e.e) 

sandwichAssembly.FaceToFace(movablePlane=topLayer_side_face, 
fixedPlane=coreLayer_side_face, flip=OFF, 
clearance=e.e) 

sandwichAssembly.FaceToFace(movablePlane=topLayer_bottom_face, 
fixedPlane=corelayer_top_face, flip=ON, 
clearance=e.e) 
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;-:a~~~~~~r~::::f;:·~-~::;·i=-~::~~~~~~I:~~:·:~:~:~~-::t~~!~:~~~~-~:~:-:~-~0~~1-~-y~~------------l 
clearance=e.e) 
fixedPlane=coreLayer_front_face, flip=OFF, 11 

sandwichAssembly.FaceToFace(movablePlane=bottomlayer_side_face, I 
fixedPlane=coreLayer_side_face, flip=OFF , 
clearance=e.e) 

sandwichAssembly .FaceToFace(movablePlane=bottomLayer_top_face, 
fixedPlane=coreLayer_bottom_face, flip=ON, ! 

L----------·--··-----------·······--------·--······-··-···············-- ····-·····-~-~~-~-~~-~~-~-~-~__:-~)-···---··-·· ··········-----···--······--------···-------------------·--· ·-·------···-···-··.! 
The FaceToFaceO method is used to geometrically constrain the parts in the assembly. 
FaceToFaceO moves an instance (the movable instance) so that its face is coincident 
with that of the other instance (the fixed instance). lt has 4 required arguments. 
movablePiane is a planar face, datum plane or orphan mesh face on the movable part 
instance whereas fixedPiane is on the fixed part instance. flip is a Boolean specifYing 
whether the normal to the faces are forward a1igned (OFF) or reverse aligned (ON). 
clearance is the distance that should separate the faces once they are constrained. 

The following blocks create the steps, loads and boundary conditions. 

# ------- - -------- - ------------- -- --------------- - ------------ - -------
# Apply boundary conditions 

# ---- - - ------- -- ------ - -- ------- - ---------- - ----- - - - -------- - - --- ----
# Apply loads 

There is nothing new here that you haven't seen in previous examples, these blocks 
create the steps and assign the loads and boundary conditions in the usual manner. 
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15.4.8 Surfaces and Tie constraints 
This block ties the layers together. 

# - --- - --- - - - --- -- ------ - - - ------- - ------ - - - -- -- - -- ------ ---- - --- ---- -
# Define surfaces to use in tie constraints 

sandwichAssembly.Surface(sidelFaces=topLayer_bottom_surface, 
name='Top Layer Bottom') 

sandwichAssembly.Surface(sidelFaces=bottomLayer_top_surface, 
name='Bottom Layer Top') 

sandwichAssembly.Surface(s idelFaces=coreLayer_bottom_surface, 
name='Core Layer Bottom') 

sandwichAssembly.Surface(sidelFaces=coreLayer_top_surface, 
name='Core Layer Top') 

# - -- - - --- ---- -- - ---- --- ------ - ---- - --- - --- --- ---------------- - ------ -
# Create tie constraints 

import interaction 

regionl=sandwichAssembly.surfaces['Core Layer Top') 
region2=sandwichAssembly.surfaces['Top layer Bottom'] 

sandwichModel.Tie(name='Constraint-1 ' , master=regionl, slave=region2, 
adjust=ON, tieRotations=ON, 
constraintEnforcement=SURFACE_TO_SURFACE) 

regionl=sandwichAssembly. surfaces['Core Layer Bottom'] 
region2=sandwichAssembly. surfaces['Bottom layer Top'] 

sandwichModel.Tie(name='Constraint-2', master=regionl, slave=region2, 
adjust=ON, tieRotations=ON, 
constraintEnforcement=SURFACE_TO_SURFACE) L--------------------------------- ------=~~----~-----------------~ 

The surfaceO method has already been explained in section J 2.4. J 2 on page 312. 1t is 
used to define the surfaces which will subsequently be utilized for the tie constraints. 

The surfaces are then assigned to variables named regionl and region2 and supplied as 
parameters to the TieO method which expects Region objects as its parameters. Surface 
objects are a type of Region hence this type of usage is possible. 

The TieQ method creates a Tie object. It requires 3 arguments - name which is a String 
specifYing its repository key, master which is a Region object specifying the master 
surface, and slave which is a Region object specifYing the slave surface. Optional 
arguments supplied here include adjust which is a Boolean specifying whether the initial 
positions of the slave nodes should be adjusted to lie on the master surface, tieRotations 
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which is a Boolean specifying whether rotation degrees of freedom should be tied, 
constraintEnforcement which is a SymbolicConstant specifying the discretization 
method with possible values of SOLVER_DEFAULT, NODE_TO_SURFACE and 
SURFACE_TO_SURFACE, thickness which is a Boolean specifying whether shell 
element thickness is considered, positionTolerance which is a Float specifYing the 
position tolerance 

These blocks mesh the parts and run the analysis. 

# - ----------------- - - - - - --------------------- - ---------- -- --- - -------
# Create the mesh 

# ------ ---------- -- --------------------- -- --- ------- - --------- -- - ----
# Create and run the job 

import job 

# Create the job 
job_name = 'SandwichStructureJob' + repr(iteration_count) 

# Run the job 

# Do not return control till job is finished running 

The mesh generation procedure is quite standard. So is the job creation procedure. The 
only point to note here is that the job name includes the iteration number using the 

Python reprO method to convert the integer to a String. This means all the output 
databases will be stored rather than being overwritten as they have different names. This 
allows the analyst to access any of them for further study if necessary. 

This block creates XY reports from the history output. 
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# ------- - - - - ----- - - --------- ------ ------ ---- - - -- -- - ----------------- -
# Send XV Data for U3 displacement of bottom and top center points to an 
# output file 

import odbAccess 
import visualization 

sandwich_odb_path = job_name + '.odb' 
sandwich_odb_object = session.openOdb(name=sandwich_odb_path) 

# The main session viewport must be set to the odb object using the following 
# line. If not you might receive an error message that states 
# "The current viewport i s not associated with an output database file . 
#Request operation cancelled . · 
session .viewports['Viewport: 1'].setValues(displayedObject=sandwich_odb_object) 

keyarray=session . odbData[sandwich_odb_path].historyVariables.keys() 

theoutputvariablename=(] 

for x in keyarray: 
if (x.find( 'U2')>-1) : 

theoutputvariablename.append(x) 

# You may enter an entire path if you wish to have the report stored in a 
# particular location. 
# One way to do it is using the following syntax. 

reportxy_name_and_path = reportxy_path + reportxy_name + '.txt' 

# Note however that the folder 'MyNewFolder' must exist otherwise you will 
# likely get the following error 
# "IOError:C/MyNewFolder: Directory not found" 
# You must either create the folder in Windows before running the script 
# Or if you wish to create it using Python commands you must use the 
# os.makedir() or os.makedirs() function 
# os .makedirs() is preferable because you can create multiple nested 
# directories in one statent if you wish 
# Note that this function returns an exception if the directory already exists 
# hence it is a good idea to use a try block 

try: 
os.makedirs(reportxy_path) 

except: 
print "Directory exists hence no need to recreate it. Move on to " + \ 

"next statement" 

session.XYDataFromHistory(name='sandwichXYData-1'~ odb=sandwich_odb_object, 
outputVariableName=theoutputvariablename(e]) 

sandwich_xydata_object = session.xyDataObjects['sandwichXYData-1'] 
session.xyReportOptions.setValues (totals=ON, minMax=ON) 
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,-----·····--·······--·---···- ·········-·--····-·----····-······································-···········--···-·-----·--·-·····----------- -------··-----·---------·----·-·----·-····-·-····-·-····-, 
1 session.writeXYReport(fileName; reportxy_name_and_path, ! 
I xyData=(sandwich_xydata_object , ), app~ndMode=OFF) I 
i session.XYDataFromHistory(name='sandwichXYData-2', odb=sandwich_odb_object, j 
j outputVariableName=theoutputvariablename[l]) j 
! sandwich_xydata_object = session.xyDataObjects['sandwichXYData-2'] I 
J session.xyRepor tOptions .setValues(totals=ON, minMax=ON) 
! session.writeXYReport(fileName~reportxy_name_and_path, 1 

i xyData=(sandwich_xydata_object, ), appendMode=ON) 1

1

' 
! 

L sandwich odb ob~e~~2_~-~~~_H________ _! 

These statements write the displacements of the two nodes to XYReports. The procedure 
is similar to the dynamic explicit truss analysis example, section 8.3.7 on page 165. 

# ----- - ----- - -- - ------------- - ------------- - - - --- - --------- - ------- - -
# Read the displacement from the report 

extracted_line ; • ' 
# Need a boolean variable to state whether we are reading the correct section 
# of the file 
file_xydata_section = e 

f=open(reportxy_name_and_path) 
for line in f; 

str;line 
if 'sandwichXYData-2' in str: 

file_xydata_section = 1 
if 'MINIMUM' in str and file_xydata_section == 1: 

extracted_line ; st r 

f.close() 

extracted_list = extracted_line.split() 
max_displacement ; extracted_list[2] 
print "!The displacement of the node at end of beam is " + \ 

repr(-1 * float(max_displacement)) 

The above statements open the XY -reports written earlier and read in the displacement 
from them. 

The XY -report will look something like this (although the actual numbers will vary 
depending on your inputs). 
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!d) SandwichXYData.txt'- Notepad 

File Edit Format Vil!:l;v Help 

X 

0. 
I 1. 

I TOTAL 1. 

I MINIMll-1 0. 
AT X • 

MAXJ:Mll-1 1. 
AT X • 

X 

0. 
1. 

TOTAL 1. 

MINIMll-1 o. I AT X -
MAXIMUM 1. 

AT X • 

sandwi chXYoata-1 

0. 
-25.21791::- 09 

-2S. 2179E- 09 

-25. 2179E-09 
1. 
0. 
0. 

sandwi chXYDat:a- 2 

o. 
- 23. 6031E-09 

- 23.6031£- 09 

-23. 6031E-09 
1. 
0. 
0. l 

l ..:1 

We wish to read the minimum valbe of the displacement of the second node since 
displacement is in the negative Z direction We first need to test for the presence of 
'sandwichXYData-2' in order to make sure the read head has reached the second node, 
and then we look for the word 'MINIMUM'. We extract out this line, split it into a list, 
and the last element in this list is our required number. 

15.4.12 Write to output file 
This block writes the output of each iteration to an output file. 

# ----- ---------- ---------- ------ - -------------- - --- - -------- - - - ------# Write this value as well as inputs to the output file 

file_output = open(reportxy_path + 'sandwichstructure_output.txt', 'a') 
if iteration count == 1: 

file_output.write("Sandwich Structure Iterative Simulation Output" + "\n") file_output.write("Beam width" + "\t" + "Beam length" + "\t" + \ 
"Top Layer" + "\t" + "Bottom Layer" + "\t" + \ 
"Core Layer" + "\t" + "#cells" + "\t" + \ 
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------------- -----·----- ---·---- ---, r---~-~----· 

"wall thickness" + "\t" + "Deflection" + "\n ") 

j 

I 
I 
I 

I 

file_output. write( repr( sandwich_width) + "\ t\ t" + repr ( sandwich_length) 
"\t\t" + repr(top_layer_thickness) + "\t\t" + \ 
repr(bottom_layer_thickness) + "\t\t" + \ 

repr(core_layer_thickness) + "\t\t" + \ 
repr(no_of_core_cells) + "\t" + \ 

repr(wall_thickness_core_cells) + "\t\t" + \ 
repr(-1 * float(max_displacement)) + "\n") 

file_output.close() 

+ \ 

I iteration count = iteration_count + 1 

1 in~t-:::i!!~-=--'=-~-~seQ_·----·-·-----------------··-.. ·-·-··---.... ·------·-·····------------~ 

These statements write all the parameters obtained from the input file as well as the 

displacement obtained from the analysis to an output file. If this is the first time the file is 

being written to (iteration_ count = I), then a title and column titles are added for 

presentation purposes. 

This is what the final output might look like, depending of course on your inputs. 

oefl ect:1on 
1.30281e-08 ' 1 
1 .30173e· 08 
2. 3603le-08 

In this script you parameterized a complex model and ran an optimization on it. You read 

parameters from an input file, and spit out results into an output file. You now have a 

good idea of how parameterization and optimization are carried out using Python scripts. 

The output file can of course be imported into software such as Microsoft Excel or 

Matlab where the trends can be analyzed for optimization purposes. 
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16.1 Introduction 
This chapter is going to introduce you to reading output databases, and gaining useful 
infonnation from them. When you run an analysis in Abaqus, the data you request - the 
field and history outputs- as well as other infonnation, such as the geometry of the part 
instance, is written to the output database (.odb ) file . You might be required to extract 
some specific infonnation from an odb as part of your analysis procedure. A script might 
be a more efficient then manually using the Abaqus/Viewer environment. In addition 
there are some tasks that are impossible to perfonn in the Viewer but possible through a 
script. 

In this example we will experiment with the output database of the static truss analysis 
from Chapter 7 and the explicit dynamic truss analysis of Chapter 8. We will perfonn 4 
tasks. 

I) We will extract the stress field, and display a contour plot of one-half of its value. 
Each of the truss members will therefore appear to have only half of their original 
stress when viewed in AbaqusNiewer. While this may not appear very useful, 
the purpose is to demonstrate how you Can modifY a field by perfonning a 
mathematical operation on it or a linear combination with another field. We will 
use the field output data of the static truss analysis for this. 

2) We will extract infonnation about the part instance used in the analysis, its nodes 
and elements, and find out which element and node experienced the maximum 
stress and displacement respectively. You saw an example of finding which 
element experiences the maximum stress in the plate optimization example 
(Chapter 13), but in that example you obtained this infonnation by reading the 
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report file generated during post-processing. This time you will read the output 
database. You will also use the print command in a manner similar to the printf() 
command from C which allows you to format your printed output. We will use 
the field output data of the static truss analysis for this. 

3) We will find out what regions of the part have history outputs available, what 
these history outputs are, and extract the history output data. You will also see 
how to find out which sets were defined in the model, and how to extract 
information about the history region these sets correspond to. History output 
information wi1 I be examined for both the output databases - the static truss 
analysis and the dynamic explicit truss analysis. 

4) We will extract the material and section properties from the odb. We wil1 also 
extract the entire material and section definitions from the static truss analysis 
odb and put them in a new Abaqus/CAE model for future use using some built-in 
methods provided by Abaqus. 

In the process you will also learn of the various type of print statements, and how to 
format printed output to suit your needs (and also to make your code more readable). In 
addition you will discover the hasattrO and typeQ built-in functions offered by Python. 

Performing these tasks will give you a good insight into working with Abaqus output 
databases using a Python script. 

For the first task, we will read in the stress [S] and displacement [U], both FieldOutput 

objects. We will divide the stresses by 2 to make them half their value, and leave the 
displacements at their present values. We will then create a new viewport window, set the 
primary variable to our new half stresses, and the deformed variable to the unchanged 
displacement, and plot these. We will also turn on element and node labels, so we can see 
the element and node numbers in the viewport to better understand what is going on in 
the next task. 

For the second task, we will use the object model to examine field output values in the 
output database. Output databases consist of a very large amount of information, and this 
information is buried inside the object model at different levels - you have containers 
with information and more containers nested within them with additional information. To 
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find the element with the maximum stress and the node with the maximum displacement, 
we will need to loop through all the elements and nodes examining their stress and 
displacement values respectively. 

For the third task we will once again use the object model, but this time we will examine 
history output information. 

For the fourth task we will use some methods provided by Abaqus to easily extract 
material and section information from an odb. We will create a new model file and place 
this information in it for demonstration purposes. 

16.3 Before we begin- Odb Object Model 
It will help for you to have some knowledge about the object model used in output 
databases before we examine the script. 

An Odb must be opened using an openO method, passing the .odb file as a parameter. It 
will then persist until it is explicitly closed using a closeO command. The openO 
command will differ based on whether you are inside the GUl - AbaqusNiewer & 
Abaqus/CAE - or outside it. 

From within the interactive products you use 

import visualization 
session.openOdb(name='file name with or without full path') 

From outside the interactive products you use 

from odbAccess import * 
Odb_object = openOdb(~file name with or without full path') 

An output database consists of a repository of analysis steps. The name of the step a.k.a. 
its repository key, is the name assigned to the step when building the model (in 
Abaqus/CAE or an input file). So everything within the Odb is accessed by first 

accessing the steps as: 

odb.steps['step name'] 

All the results data in an Odb is divided into two categories - Field Outputs and History 
Outputs. These are the big 'containers' of analysis result information, and they have 

objects and variables nested within them. 
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To access the field outputs, you first access the frame within the step. The frames are the 
increments of the analysis at which output is written to the Odb. The frames are stored as 
an OdbFrameArray object. 

You access the frames using 

odb.steps['step name•] . frames[frame_index] 

Where frame _index is an integer (0, I ,2 ... ) or you can count backwards, such as -1 for 
last frame. 

A fieldOutputs repository lies inside each frame. You access the field outputs within the 
frame as 

Odb.steps['step name'] . frames[frame_index].fieldOutputs[field_output_ key] 

where field_output_ key is the name (or repository key) of the field output such as 'S', 
'U' and 'UT'. 

Each FieldOutput object contains a number of members, such as values which JS a 
FieldValueArray object that represents the field data at that point. 

Odb.steps['step name•].frames[frame_index].fieldOutputs[field_output_key].values 

The FieldValueArray object has its own methods and members such as elementLabel 
and nodeLabel which are integers specifying the element and node labels of the element 
or node for which that field output exists. You would access these using statements of the 
form 

odb . steps['step name'].frames[frame_indexJ.fieldOutputs[field_output_key] 
.values[value_index].elementLabel 

and 

odb. steps['step name'].frames[frame_index].fieldOutputs[field_output_variable_key] 
.values[value_index].elementlabel 

where value _index is an integer index that goes from 0 to the number of field output 
points for that field output variable. 
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The FieldValueArray also has members such as mises and data whose members contain 

the actual field output information. You would access these using statements such as 

odb. steps['step name'].frames[frame_index].fieldOutputs['S'] 
.values[value_index].mises 

for the Mises stress, and 

odb.steps('step name'].frames(frame_index].fieldOutputs['U'] 
.values[value_index].data[l] 

for the displacement in the Y direction. 

Another notable member of the FieldValueArray object is instance which is an 

Odblnstance object specifYing which part the labels belong to. You would access it 

usmg 

odb.steps['step name'] . frames[frame_index].fieldOutputs[field_output_variable] 
. values[value_index].instance 

And you can obtain more information, such as the name and type of the part using 

odb.steps['step name'].frames[frame_index].fieldOutputs[field_output_variable] 
.values[value_index].instance. name 

and 

odb.steps['step name'].frames[frame_index].fieldOutputs[field_output_variable] 
.values[value_index].instance.type 

You can even address the elements and nodes of the part instance from here using 

odb.steps['step name'].frames[frame_index] .fieldOutputs[field_output_variable] 
. values[value_index].instance.elements [element_index] 

and 

odb. steps['step name'].frames[frame_index].fieldOutputs[field_output_variable] 
.values[value_index].nodes[node_index) 

and access their members to get information such as their coordinates. 

On the other hand to access the history outputs you examine the contents of 

history Regions rather than frames from the steps repository. The history outputs for a 
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point or a region exist m the history Regions object. You would refer to it with 
statements of the form 

odb.steps[ 1 step name'].historyRegions[history_region_key] 

All of this should have given you a general idea of the output database object model. 1t 
contains many more members and methods which were not listed here, and the best way 
to discover them is by interrogating the object model (we will talk about interrogation at 
the end ofthe chapter). 

16.~ .. h:~w to run the'~p! - . 
Open a new model in Abaqus/CAE and run the script created for the static truss analysis 
using File > Run Script... The analysis will create an output database file 
'TrussAnalysisJob.odb' and the script will open and display it in the Abaqus/Viewer 
viewport. 

Then then open another new model in Abaqus/CAE and run the script created for the 
dynamic explicit truss analysis using File > Run Script •.• (It will be necessary to open a 
model to run the second script since both the scripts were originally written to be 
standalone and assume the existence of a default model 'Model-1' which they rename). 
The analysis will create an output database file 'TrussExplicitAnalysisJob.odb' and the 
script will open and display it in the Abaqus/Yiewer viewport. 

The reason both these scripts must be run is that they run the analysis and produce the 
output data bases. The Odb exploration script in this example needs to access these output 
database files. 

Once these scripts have been run, the Odb exploration script written in this chapter can be 
run using File > Run Script. either with those models still open in Abaqus/CAE, or in a 
new Abaqus/CAE model. (It does not make a difference since this script only accesses 
the .odb files and does not assume the existence or lack of any model in Abaqus/CAE). 

The following listing is the completed Python script. It is saved as the file truss_odb.py. 
You can run it by opening a new document in Abaqus/CAE (File > New Model 
Database > With Standard/Explicit Model) and running it with File > Run Script ... 
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. 
truss_dynamic~Qdb_Path = ' 
trussDynamtcocftJ "" session. oP.I!riCdb'1~name=•trl~s.s; 

half_odb_stresses • odb_stresses/2 . 
sa.e~odb~displaceaents = l*odb_displacements 

# Otfang.e the defor~~ation: sc::ale factor . . .. 
truss.:_t:lalfstress_ viewport. odllDisplay. cQIIIIIGilOption~. setVallues~ · · 

· defonmationScaling=UNIFORM~ uniforRS~aieFactor=4S) · · 

'.\n\n' . 

. ··················~··············· .. ············· . odb' 
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print • \n\n • -
t ' .~... ' - r,~ 
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print 
print 
print 
print 

print '\n\n 1 
,. 

pl\'int I ...,.,........_""'"' ...... a---==*=====--====· 

.. 
print · 'There is/are Xd history reglon(s) in static truss odb. I -~ .·· • 

X len(trussQdb.steps['Loading Step'].historyR~gions) - . 

·pf'int 

print • In the odb its naM ts 



16.5 Python Script 427 



428 Explore an Output Database 

if z.find('Node') > -1: 

pr;-int 

if z.split('.')[1] == '3': 
correGt_key ,;· z 

fro• odbHaterial iMpOrt • 
from odbSection import • 

print '\n\n' 
print '••••.:-=--===••=e--.:===============================' 
.print 'The first (and only) part instan(e in tHe model is ·%s 

% trussOdb.rootAssembly.instances.keys()[9] 

print 'The first (and only) material in the model is %s 
% truss0db • .aterials.keys()[9] · 

steel_.aterial a truss0db.mater1als.values()[9] . 

H hasattr(steel_material, 'elastic'): 
print 'The material is elastic' 

else: . 
print 'The material is not elastic' 

print 
print 

print 'The first (and o~ly) section in the model is ~s • 
X trussOdb.sections.keys()[e] 

truss section • trussOdb.sections.values()[e] 
if type(truss_section) -= HomogeneousSolidSectionType: 

print 'The section is of type ~geneousSolidSection' 
d~: . 

print 'The section is not of type HomegeneousSolidSection' 
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The following statements import the required modules and open the odb 

I from abaqus import * 
I from abaqusConstants import * 
j import visualization 

1

1 

truss_Odb_Path = 'TrussAnalysisJob.odb' 
trussOdb = session.openOdb(name=truss_Odb_Path) 

i 
! truss_dynamic_Odb_Path = 'TrussExplicitAnalysisJob.odb' 
i trussDynamicOdb = sessi~!:!.:~E_~~Od~{name=truss_dynamic_Odb _P_a_t_h..;_) ___ _ 

You import the visualization module so that you can use the session.openOdbO method 
to open the .odb file. The openOdbO method has been used in a number of previous 
examples, and was first encountered and discussed in the Cantilever Beam, Section 
4.3 .14 on page 89. All we are doing here is opening the .odb file named 
~TrussAnalysisJob.odb' which was created by the static truss analysis as well as the .odb 

file named 'TrussExplicitAnalysisJob.odb' which was created by the dynamic explicit 
truss analysis. 

The following statements perform the first task of displaying half the stresses as a calor 
contour on the truss members 

~=-=·=-=-~-~-~-=-===~-~-=--~-~-~-==·-=-=-~-~-=-~-=·=-=-~··=-~-==·=--~-=--=-=·=-=-=·=-=··=·=-·=-=-~-=-=-=-=-=-~·=-=·=-=-==-~-=-::::-=-=-=-~-----·-·-·--···1 
I # Change stresses on truss members to half their current value 
l # - --- - -- ----- - -- - ------------------------------------------ ---- - ---- - - - - -1 ! 

j odb stresses= trussOdb.steps['Loading Step'].frames[-l] . fieldOutputs['S'] I 
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odb_displacements = trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['U'] 

half_odb_stresses = odb_stresses/2 
same_odb_displacements = l*odb_displacements 

# Plot it in a new viewport window 
truss_halfstress_viewport = session.Viewport(name='Truss with half the stresses'} 
truss_halfstress_viewport.setValues(displayedObject=trussOdb) 

truss_halfstress_viewport.odbDisplay \ 
.setDeformedVariable(field=same_odb_displacements) 

truss_halfstress_viewport.odbDisplay \ 
.setPrimaryVariable(field=half_odb_stresses, 

outputPosition=INTEGRATION_POINT, 
refinement=(INVARIANT, 'Mises')) 

truss_halfstress_viewport.odbDisplay .display \ 
.setValues(plotState=(CONTOURS_ON_DEF, )) 

truss_halfstress_viewport.odbDisplay .commonOptions.setValues(nodeLabels=ON) 
truss_halfstress_viewport.odbDisplay.commonOptions.setValues(elemLabels=ON) 
truss_halfstress_viewport.setValues(origin=(9.9, 9.9), width=259, height=159) 

# Change the deformation scale factor 
truss_halfstress_viewport.odbDisplay.commonOptions \ 

.setValues(deformationScaling=UNIFORM, uniformScaleFac~~~45) _j 
odb_stresses = trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] 

This statement accesses the field output quantity 'S' that was requested when building the 
model. lt assigns the FieldOutput object to a variable odb_stresses which we can work 
with I modify. The analysis step in the static truss analysis was named 'Loading Step', 
hence this is the key in the steps repository. The frame is referred to as frames(-1) 
indicating the last frame in this step. Since this analysis was carried out with an initial 
step time of 1.0 and the total step time was also 1.0, this means that only one increment 
was performed by the Abaqus solver. Therefore there are 2 frames, frame at time 0.0, and 
frame at time 1.0 representing the first increment. Therefore we could use [1] instead of 
[-1] and rewrite the statement as 

odb_stresses = trussOdb.steps('Loading Step'] . frames[l].fieldOutputs['S'] 

Which one you choose is a matter of personal preference. Also you see the field output 
variable referred to with the key'S' because this is the key used by Abaqus to represent 
stress field output requests, and it was used by our truss analysis script to request stress 

outputs. 

odb_displacements = trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['U'] 
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This is similar to the previous statement except that we are requesting and storing the 
field output for U - translations and rotations. 

half_odb_stresses = odb_stresses/2 
same_odb_displacements = l*odb_displacements 

Here the two FieldOutput variables odb_stresses and odb_displacemcnts created in the 
previous two statements are subjected to a basic mathematical operation and assigned to 
new variables. The stresses are halved and assigned to the variable half_odb_stresses. 
This demonstrates a powerful feature - you can create new field data by performing basic 
mathematical operations on existing field data. Here we divide by 2 using the 'I' operator. 
Other operators that can be used are +,- and *,trigonometric functions cosO, sinO, tanO, 
acosO, asinO, atanO, and other commonly used functions such as absQ, expO, logO, 
explOO, loglOQ, powerQ, degreeToRadianO and radianToDegreeQ. 

In fact it is also possible to use linear combinations of two fields to create a third . For 
example you could add the stresses from two different odbs to create a new one as 

new_odb_stresses = odbs_stresses_from_odbl + odb_stresses_from_odb2 

You could do the same with displacements 

new_odb_displacements = odbs_displacements_from_odbl + 
odb_displacements_from_odb2 

However the fields must be of the same time, so stresses and displacements cannot be 
combined as 

new_odb_field = odbs_stresses_from_odbl + odb_displacements_from_odb2 

because stress data exists at integration points (INTEGRATION_POINT) and 
displacement data is nodal (ELEMENT_NODAL) and these cannot be combined. This 
aside from the fact that it would not make sense to combine them anyway. 

You are probably wondering why we multiplied odb_displacements by 1 to create 
same_odb_displacements. Why not write it as follows?: 

same_odb_displacements = odb_displacements 

In fact why not just use the original variable? Well, this is not possible due to the way 
Abaqus works internally. 
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To answer the second question, when we create a new field data from an old one, we are 

only allowed to use all new field data or all old field data in any given viewport window. 

So if you were to plot the new stress data (half the original) in a viewport window, you 

would not be able to plot the old displacement data in t~e same viewport. Hence we must 

create a new field data variable. 

To answer the first question - Abaqus does recognize the original field data as a new one 

by assigning it to a new variable alone, it is only when some sort of mathematical 

operation is carried out on it that it registers this fact. Hence we multiply it by I. 

Why does Abaqus work like this? To be honest, I'm not sure. Maybe the folks who 

develop Abaqus have a reason for this, or maybe this is a quirk or bug that will not exist 

in future versions of Abaqus. However for most of us the important thing is getting the 

job done, and it appears that multiplying by 1, and therefore performing a mathematical 

operation, forces Abaqus to internally create a new FieldOutput object in a different way 

from a simple assignment statement. 

# Plot it in a new viewport window 
truss_halfstress_viewport = session.Viewport(name='Truss with half the stresses') 
truss_halfstress_viewport.setValues(displayedObject=trussOdb) 

truss_halfstress_viewport.odbDisplay \ 
.setDeformedVariable(field=same_odb_displacements) 

truss_halfstress_viewport.odbDisplay \ 
.setPrimaryVariable(field=half_odb_stresses, 

outputPosition=INTEGRATION_POINT, 
refinement=(INVARIANT, 'Mises')) 

truss_halfstress_viewport.odbDisplay.display \ 
.setValues(plotState=(CONTOURS_ON_DEF, )) 

truss_halfstress_viewport.odbOisplay.commonOptions.setValues(nodelabels=ON) 
truss_halfstress_viewport.odbDisplay.commonOptions.setValues(elemLabels=ON) 
truss_halfstress_viewport.setValues(origin=(e.e, 9.9), width=259, height=159) 

Almost all of these statements are similar to the ones used in the static truss analysis 

script, and were explained in section 7.4.15 on page 142. The only new method used here 

is setDeformedVariableO which is similar to setPrimaryVariableO except that it 

specifies the field output variable or FieldOutput object to use when displaying the 

deformed shape. Either the field output variable variableLabel or the FieldOutput 

object field must be provided as an argument. 

# Change the deformation scale factor 
truss_halfstress_viewport.odbDisplay.commonOptions \ 

.setValues(deformationScaling=UNIFORM, uniformScaleFactor=45) 
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You've used odbDisplay.commonOptions.setValuesQ numerous times before, in fact it 

is used in the previous statements as well, the difference here is the use of the parameters 

deformationScaling and uniformScaleFactor to scale the visible displacement in the 
viewport by 45 times its actual value. deformationScaling requires a SymbolicConstant 
which can be AUTO, UNIFORM and NONUNIFORM. uniformScaleFactor is the 

constant factor by which to multiply the deformation when deformationScaling is set to 
UNIFORM. 

I # -- ---------- ------ - -----------------------------------------------------
1 # Display information about the part, elements, nodes and maximum stress and 
I # displacement using the field output data 

# ------------------- - -- - -------------------------------------------------

print 
I print 

I 
print 
print 

'\n\n' 
'************************************************' 
'Some information obtained from the odb' 
'\n\n' 

print 'The number of field output variables requested in the analysis is %d' \ 
% len(trussOdb.steps['Loading Step'].frames[ -l].fieldOutputs) 

I # The field outputs are in the form of dictionaries - key:value pairs 
I field_output_vars = 
1 for j in range(len(trussOdb.steps['Loading Step'].frames[-l].fieldOutputs)): 
! field_output_vars = field_output_vars + trussOdb.steps['Loading Step'] \ 
'I .frames[-l].fieldOutputs . l<eys()[j] + • 

print 'They are %s' % field_output_vars 

I 
I 

print '\n\n' 
print 'Stress field output [S] information is available at %d points. • \ 

% len(trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'].values) 

I # Since we have only one part, all the stress field outputs are available for 
i # this part only 

I 
print 'The name of the part instance for which stress field outputs are • + \ 

'available is %s whose modeling space is %sand is of type %s.' \ 
! % ( trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] \ I .values[0].instance.name, trussOdb.steps['Loading Step'] \ 
1 • fr~~~s[ -1]. field0utputs[~1· va_!_~es[0l_:instance.e_mbe9dedSp~~~----
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trussOdb.steps['Loading Step ' ].frames [-l].fieldOutputs['S') \ 
.values[e].instance.type ) 

print '\n\n' 
print 'The part has %d elements and %d nodes.' \ 

% ( len(trussOdb.steps[ ' Loading Step').frames[-1].field0utputs['S'] \ 
.values[e].instance.elements). 

len(trussOdb. steps[ ' Loading Step'].frames[-l].fieldOutputs['S') \ 
.values[e].instance. nodes) ) 

# Find element with maximum stress 
max stress = e 
for-k in range(len(trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] \ 

.values[e].instance.elements)): #can use e or any other index too 
element_mises_stress = trussOdb.steps['Loading Step'] .frames[-1] \ 

.fieldOutputs['S'].values[k].mises 
if element_mises_stress > max_stress: 

max_stress_element_label = trussOdb.steps['Loading Step'].frames[-1] \ 
.fieldOutputs['S'].values[k].elementlabel 

field_output_stress_object_index = k 
max_stress = element_mises_stress 

print ' \n\n' 
print 'The maximum mises stress is %(maximum stress)E and it is on ' + \ 

'element %(element with maximum stress)d' %{"maximum stress": max_stress. 
"element with maximum stress": max_stress_element_label} 

print 'This element is of type %s' % trussOdb.steps['Loading Step'].frames[-1] \ 
. fieldOutputs['S'].values[field_output_stress_object_index] \ 
.instance.elements[max_stress_element_label - l].type 

print 'It connects node %d and node %d' \ 
% (trussOdb.steps['Loading Step ' ].frames[-1] .field0utputs['S'] \ 

.values[field_output_stress_object_index].instance \ 

.elements[max_stress_element_label - l].connectivity[e]. 
trussOdb.steps['Loading Step'].frames[ -1] . field0utputs[ 'S'] \ 

.values[field_output_stress_object_index].instance \ 

.elements[max_stress_element_label - l] .connectivity[l] ) 

# Find node with maximum displacement in Y direction 
max displacement = e 
for- x in range(len(trussOdb.steps['Loading Step'].frames[-1] \ 

.fieldOutputs['U'] .values[e].instance.nodes)): 
node_y_displacement = abs(trussodb.steps['Loading Step'].frames[-1] \ 

.fieldOutputs['U'].values[x].data[l]) 
if node_y_displacement > max_displacement : 

max_disp_node_label = trussOdb.steps['Loading Step'] . frames[-1] \ 
.fieldOutputs('U'].values[x].nodeLabel 

field_output_disp_object_index = x · 
max_displacement = node_y_displacement 

print '\n\n' 
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, print 'The node with the maximum Y displacement is %d' % max_disp_node_label 

I 
print 'The V component of the displacement is %f' % max_displacement 
print 'The magnitude of the displacement (length of disp vector) is %.5f' \ 

l
i % trussOdb.steps['Loading Step'].frames[-l).fieldOutputs['U'] \ 

.values[field_output_disp_object_index] .magnitude 
1
1 print ' \ n\n ' 
. print '=================================================' 

print '\n\n' 
print '************************************************ ' 
print 'Some info~ation obtained from the odb' 
print '\n\n' 

This is certainly not the first time we're using the print statement to print statements to 
the message area. I should point out however that this is the most basic format of the 
print statement and we will use a couple of others in this section. For the sake of 
convenience I will call this print statement type I. 

Type 1 print statement: print <some String within quotes• 

The '\n' character has special meaning to Python, namely that it forces a carriage return 
the equivalent of hitting the 'Enter' key on the keyboard. Since every print statement 
will print on a new line, it doesn't really make much sense to have a single \n at the end 
of the print statement. However if we use two \o 's then Python will leave a line before 
the next statement. 

print ' The number of field output variables requested in the analysis is %d' \ 
% len(trussOdb.steps[ ' loading Step ' ].frames[-l].fieldOutputs) 

Here we use another form of the print statement. It is more similar to the printf() 
command from C. It allows you to format the output in a particular manner by using the 
modulo (0/o) symbol, which is known as the String formatting or interpolation operator, 
followed by a character. So %d indicates a signed decimal number, 0/of indicates a float 
and so on. The following are the available format specifiers as listed in the Python 
documentation. 

'd' Signed integer decimal. 
'i' Signed integer decimal. 

'o' Signed octal value. 
'u' Obsolete type - it is identical to 'd'. 
'x' Signed hexadecimal (lowercase). 
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'X' Signed hexadecimal (uppercase). 

'e' Floating point exponential format (lowercase ). 

'E' Floating point exponential format {uppercase). 

't' Floating point decimal format. 

'F' Floating point decimal format. 

'g' Floating point format. Uses lowercase exponential format if exponent is less than 

-4 or not less than precision, decimal format otherwise. 

'G' Floating point format. Uses uppercase exponential fonnat if exponent is less than 

-4 or not less than precision, decimal format otherwise. 

'c' Single character (accepts integer or single character String). 

'r' String (converts any Python object using repr()). 

's' String (converts any Python object using str()). 

'%' No argument is converted, results in a '%' character in the result. 

The values that will replace the String format placeholder must be specified after another 

o/o symbol. lf a single value is present, it can be specified as a single non-tuple object as 

is done in this case. This is what I call a type 2 print statement 

Type 2 print statement: print 'String with %x formatting' % varl 

The field data variables exist as key:value pairs for each frame of each step in the output 

database. The lenO command is used to find the number of field output values stored for 

the last frame of the step called ' Loading Step' as 

len(trussOdb. steps['Loading Step'].frames[ -l].fieldOutputs) 

# The field outputs are in the form of dictionaries - key:value pairs 
field_output_vars = '' 
for j in range(len(trussOdb.steps['Loading Step'].frames[-1].fieldOutputs)): 

field_output_vars = field_output_vars + trussOdb.steps['Loading Step'] \ 
.frames[-l].fieldOutputs.keys()[j] + ', 

print 'They are %s' % field_output_vars 

Here we print out the names of the field output variables. As mentioned previously, the 

field data variables exjst in the fieldOutputs repository as key:value pairs. Here we use 

the keysQ method to access them. In addition we attach an index to extract the key at that 

index location as 

trussOdb.steps['Loading Step'] . frames(-l].fieldOutputs.keys()[j] 
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This way we can use a for loop to extract each of the names (or keys) and store them in 
the variable field_output_vars with commas separating them. We later print this variable 
out with a print statement. 

print 'Stress field output [S) information is available at %d points . · \ 
% len(trussOdb.steps['Loading Step'),frames[-l].fieldOutputs['S ' ].values) 

We use the key 'S' to refer to the corresponding value in the fieldOutputs repository. 
fieldOutputs['S'].values gives us a list of values, hence lenO can be used to get the 
number of field output values, which will be the same as the number of points at which 
field output data is available. 

# Since we have only one part, all the stress field outputs are available,~or 
# this part only 
print 'The name of the part instance for which stress field outputs are ' + \ 

'available is %s whose modeling space is %s and is of type %s.' \ 
% ( trussOdb.steps['Loading Step'].frames[-l].fieldOutputs[ ' S'] \ 

.values[9].instance.name, trussOdb.steps['Loading Step']\ 

.frames[-1].fieldOutputs['S'].values[9] . instance .embeddedSpace, 
trussOdb.steps['Loading Step'].frames[-l] .fieldOutputs('S') \ 

.values[9].instance.type ) 

The instance for which the field output is written is accessed with 

trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'].values[e].instance 

Its name, mode ling space and type are accessed using 

trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'].values[e].instance.name 

trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] 
. values [e].instance.embeddedSpace 

and 

trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'].values[e].instance.type 

Notice the difference in the print statement used here. Since there are multiple values 
being passed to the print statement (there are multiple String formatting operators), the 
values or variables themselves have to be in a tuple, i.e. within (). 

Type 3 print statement: print 'String with %x and %y formatting, % (varl, var2) 
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print 'The part has %d elements and %d nodes.' \ 
% ( len(trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] \ 

.values(9].instance.elements), 
len(trussOdb.steps('Loading Step'].frames[-l].fieldOutputs['S'] \ 

.values[e].instance.nodes) ) 

The above statement refers to the nodes and elements of the part instance, and counts 

them using the lenO function to give us the number of elements and nodes in the part. 

Note that we used the index 0 in fieldOutputs('S'].values[O).isntance.nodes. We could 

have used any other index here between 0 and the total number of field outputs. This is 

because we have only one part hence the instance member of all of them refers to the 

same part. 

In fact, we know that the stress field output data occurs on each element, hence the 

number of stress field outputs is the same as the number of elements. So we could instead 

have rewritten 

len{trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] 
. values[e].instance.elements) 

as 

len{trussOdb.steps['Loading Step'].frames[ -l] .fieldOutputs['S'] .values) 

However 1 avoided this to maintain the readability of the code and so as not to confuse 

you. 

fork in range(len(trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] \ 
.values[e].instance.elements)): #can use e or any other index too 

element_mises_stress = trussOdb.steps['Loading Step').frames[-1) \ 
.fieldOutputs['S') . values[k] .mises 

if element_mises_stress > max_stress: 
max_stress_element_label = trussOdb.steps('Loading Step'].frames[-1] \ 

.fieldOutputs['S'].values[k].elementlabel 
field_output_stress_object_index = k 
max_stress = element_mises~stress 

In order to find the maximum stress we iterate through each element of the part and look 

at its Mises stress. The Mises stress is a member of the values FieldValueArray. 

Once the maximum stress has been found, we get the element label using 

trussOdb.steps('Loading Step'].frames[-l].fieldOutputs['S'].values[k].elementlabel 
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because the element label is the same as its index in the elements array. 

We store the iteration counter value for this element m a variable 
field_output_stress_object_index to use in a subsequent statement. 

print 'The maximum mises stress is %{maximum stress)E and it is on ' + \ 
'element %{element with maximum stress)d' %{"maximum stress": max_stress~ 

"element with maximum stress": max_stress_element_label} 

This statement prints out the maximum stress and the element with the maximum stress, 
both of which were found in previous statements. 

Notice that this is another type of print statement. Here the variables/values are expressed 
as dictionaries with key:value pairs. The key is placed in parenthesis after the % and then 
followed by the formatting specifying character. The dictionaries are written with curly 
braces {} separated by commas. I like to ca11 this the type 4 print statement 

Type 4 print statement: print •string with %(keyl)x a.nd %(key2)y formattingJ % 
\ 

{«keY\.1": vall, «key 2": val2} 

\ 
By using keys, it might be easier to read the code, especially if there are a lot of String 
formatting operators within the print statement. More importantly, the variables no longer 
have to be listed in the same order as the String formatting operators since it is the key 
that identifies which value to use. Hence the statement can be written as: 

print 'The maximum mises stress is %(maximum stress)E and it is on • + \ 
'element %(element with maximum stress)d' %{"maximum stress": max_stress, 

"element with maximum stress": max_stress_element_label} 

print 'This element is of type %s' % trussOdb.steps['Loading Step'].frames[-1] \ 
.fieldOutputs['S'].values[field_output_stress_object_index] \ 
.instance.elements[max_stress_element_label - l].type 

We use the variable field_output_stress_object_iodex obtained from the for loop to 
refer to the stress field output which we identified as having the largest Mises stress. We 
refer to the correct element of the instance by subtracting I from 
max_stress_element_label because the element label is always I more than its index in 
the elements list (since lists count from 0 upward). 

Once again I should point out that since all the stress outputs are for the same part, we 
could have used any index for valuesO between 0 and one minus the total number of 
stress field outputs. So the statement could instead have been written as 
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print 'This element is of type %s' % trussOdb. steps['Loading Step'].frames[-1] \ 
.fieldOutputs[ 'S').values[e).instance.elements[max_stress_elemt_label -l).type 

Or 

print 'This element is of type %s' % trussOdb.steps['Loading Step ' ].frames[-1] \ 
.field0utputs['S'].values[9].instance.elements[max_stress_elemt_label -1].type 

However this may be a little confusing when reading code. 

print 'It connects node %d and node %d' \ 
% (trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['S'] \ 

.values[field_output_stress_object_index].instance \ 

. elements[max_stress_element_label - l].connectivity[e], 
trussOdb.steps['Loading Step'].frames[-l] .fieldOutputs['S'] \ 

.values[field_output_stress_object_index].instance \ 

.elements[max_stress_element_label - l].connectivity[l] ) 

The emeoents have a connectivity member which lists the labels of the nodes that the 
element is connected to. Since we are dealing with 20 truss members, each element has 2 
connectivities. 

max_displacement = 9 
for x in range(len(trussOdb.steps['Loading Step'].frames[-1] \ 

.fieldOutputs['U'].values[e] . instance.nodes)): 
node_y_displacement = abs(trussOdb.steps['Loading Step'].frames[-1) \ 

.fieldOutputs['U'].values[x].data[l)) 
if node_y_displacement > max_displacement : 

max_disp_node_label = trussOdb.steps['Loading Step'].frames[-1] \ 
.fieldOutputs['U'].values[x].nodelabel 

field_output_disp_object_index = x 
max_displacement = node_y_displacement 

Similar to the one used for finding the maximum stress, this for loop is used to find the 
maximum displacement and store some information about it to use in subsequent print 
statements. Notice that we are not investigating fieldOutputs('U'] which stores 
information about translations and rotations, and the data member of values[) is referred 
to which stores the X, Y and Z d.isplacements as data[O], data[l] and data[2]. Since we 
are only looking at data(l] as the condition for the for loop, we are actually finding the 
node with the maximum Y -displacement. 

print 'The v component of the displacement is %f' % max_displacement 

This prints the maximum displacement out to the screen. o/of is used to print a float. 

print 'The magnitude of the displacement (length of disp vector) is %.5f' \ 
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% trussOdb.steps['Loading Step'].frames[-l].fieldOutputs['U'] \ 
.values[field_output_disp_object_index].magnitude 

The magnitude of the displacement (not just the Y -component) is also present in the odb 
as the magnitude member of each field output in values[]. 

Notice the String formatting operator %.5f. This means the value to be printed is a float, 
however only print 5 digits after the decimal point and round up if necessary. With only a 
0/of, the stress magnitude is printed with 6 digits after the decimal place, but with it we 
limit it to 5 digits. 

information 

I # ---- -- ---- ----~---- ---------- -------------------- --------- ---- - --- ----- -

I 

# Display history output information for static truss job 
# --------------- ------ -- ---------------------------------- ----- ----------

print 'There is/are %d history region(s) in static truss odb.' \ 
% len(trussOdb.steps['Loading Step'].historyRegions) 

I print 'In the odb its key is : %s' % trussOdb.steps['Loading Step'] \ 
.historyRegions.keys()[e] 

print 'In the odb its name is : %s' % trussOdb.steps['Loading Step'] \ 
.historyRegions.values()[e] . name 

, print 'Its description is 

I 
%s' % trussOdb.steps('Loading Step'] \ 

.historyRegions.values()[e].description 

print 'Its position is %s'% trussOdb.steps['loading Step']\ 
.historyRegions.values()[e].position 

I history_output_vars = • • 

I for y in range(len(trussOdb.steps['loading Step'] \ 
.historyRegions.values()[e].historyOutputs)): 

l history_output_vars = history_output_vars + \ 
i trussOdb.steps['Loading Step']\ 
! .historyRegions.values()(e].historyOutputs.keys()[y] + 

print ' The history outputs available are %s' % history_output_vars 

print 'At time = %f Strain energy (ALLSE) is %f' \ 
% (trussOdb.steps['loading Step').historyRegions.values()[8] \ 

.history0utputs['ALLSE'].data[8](8], 

I 

I 
I 

I 
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trussOdb.steps[ ' Loading Step'].historyRegions.values()(e] \ 
. historyOutputs['ALLSE ' ].data(B](l]) 

print 'At time = %f Strain energy (ALLSE) is %f' \ 
% (trussOdb.steps('Loading Step'].historyRegions.values()[0] \ 

.historyOutputs['ALLSE'].data[l)[B], 
trussOdb.steps['Loading Step'].historyRegions.values()(e] \ 

.historyOutputs['ALLSE'] .data[l)[l]) 

j print '\n\n' 
-------------·--···-·--_J 

print 'There is/are %d history region(s) in static truss odb. ' \ 
% len(trussOdb.steps['Loading Step'].historyRegions) 

trussOdb. steps (·Loading Step·]. historyRegions returns the HistoryRegion objects, of 
which there will be one per history output request. lenO gives us the number of history 
output regions .. 

print 'In the odb its key is %s' % trussOdb.steps['Loading Step'] \ 
.historyRegions.keys()[e] 

trussOdb. steps [ 'Loading Step']. historyRegions. keys() contains the keys of all the 
HistoryRegion objects. We already know (since we created the model ourselves) that 
there is one History Region object, and we refer to the its key with an index of [0]. 

print 'In the odb its name is : %s' % trussOdb.steps['Loading Step'] \ 
.historyRegions.values()[e].name 

We refer to the HistoryRegion objects in the repository using valuesQ. We refer to the 
first one using the index of [0] and we access the name property to get the name which is 
the same as the repository key. 

Since the previous statement informs us that the keyO for this HistoryRegion object is 
'Assembly ASSEMBLY' we can also write this statement as 

print 'In the odb its name is : %s' % trussOdb.steps('Loading Step'] \ 
.historyRegions['Assembly ASSEMBLY'].name 

print 'Its description is : %s' % trussOdb.steps('Loading Step'] \ 
.historyRegions.values()[e].description 

lbe description property of the HistoryOutput object returns an Abaqus supplied 

description for the history output request. 



16.5 Python Script 443 

print 'Its position is : %s' % trussOdb.steps['Loading Step'] \ 
.historyRegions.values()[e].position 

The position property of the HistoryRegion object provides a SymbolicConstant 
specifying the position of the history output. Possible values you will encounter are 
NODAL, INTEGRATION POINT, WHOLE ELEMENT, WHOLE REGION and - - -
WHOLE MODEL. 

history_output_vars = 
for y in range(len(trussOdb.steps['Loading Step'] \ 

.historyRegions.values()[e).historyOutputs)): 
history_output_vars = history_output_vars + \ 

trussOdb.steps['loading Step'] \ 
.historyRegions.values()[9].historyOutputs . keys()[y] + ', ' 

print 'The history outputs available are %s' % history_output_vars 

The for loop iterates over the number of HistoryOutput objects in the bistoryOutputs 
repository. Each History Region object has a number of HistoryOutput objects because 
a number of history output variables are selected for each history output request (such as 
ALLE, LLWK, ETOTAL etc) and these are all requested from the region. For each of 
them this loop extracts the repository key and collects them in a comma separated String 
for printing. 

print 'At time = %f Strain energy (ALLSE) is %f' \ 
% (trussOdb.steps['Loading step'].historyRegions.values()[e] \ 

.historyOutputs['ALLSE'].data[9][9], 
trussOdb.steps['Loading Step'].historyRegions.values()[e] \ 

.historyoutputs['ALLSE'].data[e][l]) 

print 'At time = %f Strain energy (ALLSE) is %f' \ 
% {trussOdb.steps['Loading Step'].historyRegions.values()[e] \ 

.history0utputs['ALLSE'].data[1][9], 
trussOdb.steps['Loading Step'].historyRegions.values()[9] \ 

.historyoutputs['ALLSE'].data[1][1]) 

The strain energy history output variable ALLSE is available in a list of tuples of (time, 

value) using trussOdb.steps['Loading Step'].bistoryRegions.valuesO[O] .historyOut 
puts['ALLSE'].data. In our odb there are two data points or tuples, one at time = 0 and 
the other at time = 1 but in some other analysis where history output requests occur many 
times there will be many more data points. We use the first index of [0] for the first point, 
and second index of [0] or [1] for the time and value respectively at this point. Similarly 
we repeat for the second point. 



444 Explore an Output Database 

If you were to plot the history output for ALSE in AbaqusNiewer, these are the two 
points that give you the plot you see. 

16.5.5 Display bisto output information for dynamic explicit truss analysis 
The following statements query the odb of the dynamic explicit truss analysis for history 
output information 

# ----------------- ------------- --------------------- ----------------- ----
# Display history output information for dynamic explicit truss job 
# ----- -- - - -- ---------------------- - --------------------------------------

1 
print 'There is/are %d history region(s) in dynamic explicit truss odb ' \ 

% len(trussDynamicOdb.steps['Loading Step'] .historyRegions) 

print ' In the odb their keys are %s and %s' \ 
% (trussDynamicOdb. steps[' Loading Step'].historyRegions.keys()(e], 

trussDynamicOdb.steps['Loading Step'].historyRegions.keys()[l]) 

print 'The 2 sets in the model are %s and %s' \ 
% (trussDynamicOdb.rootAssembly.nodeSets.keys()[e), 

trussOynamicOdb.rootAssembly.nodeSets .keys()[l]) 

print 'The label of the node which makes up the set END POINT SET is %d' \ 
% trussDynamicOdb.rootAssembly.nodeSets('END POINT SET'].nodes[e][e].label 

print '\n\n' 

# Figure out which one has node 3 
for z in trussDynamicOdb.steps['Loading Step').historyRegions.keys(): 

if z.find('Node') > -1: 
if z.split(' . ' )[1] == '3': 

correct_key = z 

print 'Here is the history output for U2 data at END POINT SET' 

for m in range(len(trussDynamicOdb.steps['Loading Step') \ 
.historyRegions[correct_key].historyOutputs[ ' U2'].data)): 

time = trussDynamicOdb. steps('Loading Step').historyRegions[correct_key) \ 
. historyOutputs['U2'].data(m][e] 

Ydisp = trussDynamicOdb.steps('Loading Step'].historyRegions[correct_key] \ 
.historyOutputs( ' U2 ' ] .data[m)[l] 

print 'At time = %f Y-displacement = %f' % (time, Ydisp) 

print 'There is/are ~ history region(s) in dynamic explicit truss odb' \ 
% len(trussoynamicOdb.steps['Loading Step'].historyRegions) 
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As was done for the static truss, this statement prints out the number of HistoryRegion 

objects, which is the same as the number of history output requests. 

print 'In the odb their keys are %s and %s' \ 
% (trussDynamicOdb.steps['Loading Step').historyRegions.keys()[e], 

trussoynamicOdb.steps['Loading Step'],historyRegions.keys()[l]) 

Again, similar to the static truss, this statement prints out the names or repository keys of 

the history regions. 

print 'The 2 sets in the model are %s and %s' \ 
% (trussoynamicOdb.rootAssembly.nodeSets.keys()[e], 

trussDynamicOdb.rootAssembly.nodeSets.keys()[l]) 

We wish to display the history output at the end point (END POINT SET). In order to do 

that we need to identifY the label of that node. The node sets in the model are stored in 

the repository trussDynamicOdb.rootAssembly.nodeSets and their keys are accessed 

with the keysQ method. Since we already know there are two sets, we can access them 

with the indices [0] and [1]. lfwe were instead looking for element sets we would access 

them through trussDynamicOdb.rootAssembly.nodeSets 

print 'The label of the node which makes up the set END POINT SET is %d' \ 
% trussDynamicOdb.rootAssembly.nodeSets['END POINT SET'].nodes[9][9].label 

We can use the key 'END POINT SET' to refer to the node in the nodeSets repository. lt 

is an OdbSet object, and has a property called nodes which returns an array of 

OdbMesbNodeArray objects. This OdbSet object has only one element in our case - or 

more precisely one OdbMeshNodeArray object- which we refer to with the index [0]. 

This in turn has one OdbMesbNode object which we refer to with the second index [0]. 

This OdbMesbNode object has a member called label which returns the label of the 

node. In this manner we obtain the label of the node that is END POINT SET. 

# Figure out which one has node 3 
for z in trussDynamicOdb.steps['Loading Step'].historyRegions.keys(): 

if z.find('Node') > -1: 
if z.split('.')[l] == '3': 

correct_key = z 

Now that we know the label of the node for END POINT SET is 3, we search through the 

keys of the HistoryRegion objects looking for a 3. That is because these objects have 

strange names that are assigned by Abaqus such as 'Node TRUSS INST ANCE.2' and 

'Node TRUSS INST ANCE.3' . In this case we already know this is what the key is, but in 
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many situations you may not. Hence you need to do some sort of search within the String 

and find some clue as to whether this is the correct History Region object or not. 

We use the findO method to do this. If the String 'Node' is present in the key (z) then the 

findO method will return its location in the String counting up from 0, and if is not found 

then it will return -I. So we first check to see if this History Region object is a node by 
looking for 'Node' . Once that is confirmed, we then split it where the dot occurs as the 

label is after the dot. We use the splitO method for this, and pass '. ' as the parameter. 
splitO will return a list which will have 2 elements in this case, the String before the dot 

and the String after which is the node label. We use the index [1] to refer to this String. 
We compare it to ' 3' since we know that is the nodelabel because we obtained it from 

the previous statement. I have just gone ahead and hard coded it in here to make it more 

readable for learning purposes but in a real program you would instead write the 

statement as 

if z.split{' . ')[1] == 'trussDynamicOdb.rootAssembly.nodeSets['END POINT SET'] 
.nodes[e][e].label': 

If the key has the number 3 as the label after the dot, then this node is the END POINT 

SET and we can obtain our history data from it. 

for m in range(len(trussDynamicOdb.steps[ ' Loading Step'] \ 
.historyRegions[correct_key].historyOutputs['U2'].data}): 

time= trussDynamicOdb.steps('Loading Step'].historyRegions[correct_key] \ 
.historyOutputs['U2'].data[m][B] 

Ydisp = trussDynamicOdb.steps['Loading Step'].historyRegions[correct_key] \ 
.history0utputs['U2'].data[m][l] 

print 'At time = %f Y-displacement = %f' % (time, Ydisp) 

The History Region object has a member historyOutputs which contains the history 

output variables requested at that point. One of those is ' U2' , the displacement in theY 

direction. The displacement data for U2 can be accessed using its data member. It 
contains a number of tuples, each representing a point on the U2 displacement vs time 

curve. The points are accessed with the loop counter m, the time is the first coordinate 

which is accessed with index [0} and the Y displacement is the second coordinate which 

is accessed with the index [I ] . 

This loop will print out all the U2 displacement versus time values available. 
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<:.:1' lol .... 

following statements extract material and section information from the output 
database 

# ---------------------------------------------- ---- ----- ----- --- - -- ------
# Extract part, material and section informatio from the odb 
# ---------------------------- --------------------------------------- -----

from odbMaterial import * 
from odbSection import * 

print '\n\n' 
print '================================================= 

print 'The first (and only) part instance in the model is %s · \ 
% trussOdb.rootAssembly.instances.keys()[9] 

print 'The first (and only) material in the model is %s • \ 
% trussOdb.materials.keys()[e] 

steel_material = trussOdb.materials.values()(e) 

if hasattr(steel_material, 'elastic'): 
print 'The material is elastic' 

else: 
print 'The material is not elastic' 

print 'Its density is %f' % steel_material.density .table[0][0] 
print 'Its Young\'s modulus is %.2E and its Poisson\'s ratio is %f • \ 

% (steel_material.elastic.table[e][9], steel_material.elastic.table[0][1]) 

print 'The first (and only) section in the model is %s ' \ 
% trussOdb.sections.keys()(9] 

truss_section = trussOdb.sections. values()[e] 
if type(truss_section) == HomogeneousSolidSectionType: 

print 'The section is of type HomogeneousSolidSection' 
else: 

'----'-p.rint '_! he sec.!io~ is ~ot o~ type !:IOm!gene~~SolidSectio~ · 

from odbMaterial import * 
from odbSection import * 

These import statements are required to access material and section information from the 
output database. 

print 'The first (and only) part instance in the model is %s ' \ 
% trussOdb.rootAssembly.instances.keys()[e] 
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trussOdb.rootAssembly.instaoces refers to a repository of Odblnstance objects, or part 
instances in plain English. Here we print out the key of the first part instance. 

print 'The first (and only) material in the model is %s ' \ 
% truss0db.materials.keys()[9] 

trussOdb.materials refers to the repository of Material objects in the model. Here we 
print out the key of the first Material object. 

steel_material = truss0db.materials.values()(9] 

Here we assign the first Material )object to the variable steel_material. The statement 
could also have been written as 

steel_material = trussOdb.materials[trussOdb .materials.keys()[B]] 

Next we use if else statements to test if the material has elastic properties defined 

if hasattr(steel_material, 'elastic'): 
print 'The material is elastic' 

else: 
print 'The material is not elastic' 

hasattrO is a built in Python function. It accepts an object and a String as arguments. If 
the String is the name of one of the objects attributes it returns True, and if not it returns 
False. 

He we test to see if the material has elasticity defined. If the Material object has 
elasticity - Young's modulus and Poisson' s ratio were defined when creating the model, 
it will have a member called elastic. 

print 'Its density is %f' % steel_material.density.table[e][e] 

The density is accessed using the density attribute of the Material object. This in turn 
has an attribute called table which contains a tuple of density versus temperature values. 
We access the first cell of this table. 

print 'Its Young\'s modulus is %.2E and its Poisson\'s ratio is %f ' \ 
% (steel_material.elastic.table[9][9], steel_material.elastic.table[9](1]) 

The Young' s modulus and Poisson' s ratio ofthe material are found in the elastic attribute 
of the Material object, whose presence we tested in the if statement a moment ago. 
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elastic contains a table member with one row and two columns that store the Young' s 
modulus and Poisson' s ratio. 

print 'The first (and only) section in the model is %s ' \ 
% trussOdb.sections .keys()[B] 

trussOdb.sections refers to the Section object repository. We get the name or repository 
key of the first section using .keysQ[O). 

truss_section = trussOdb.sections.values()[B] 

Here we assign the first Section object to the variable truss_section. The statement could 
also have been written as 

print trussOdb.sections[trussOdb.sections.keys ()[e]] 

Next we use if-else statements to test the type of the Section object 

if type(truss_section) == HomogeneousSolidSectionType: 
print 'The section is of type HomogeneousSolidSection' 

else: 
print 'The section is not of type HomegeneousSolidSection' 

typeO is a built in Python function. It accepts an object a parameter and returns a type 
object. 

If you wish to test for a HomogeneousSolidSection, you compare it to 
HomogeoeousSolidSectionType. If you were to test for a BomegeneousSbeliSection, 
you would compare it to HomogeneousSbeiiType. For a TrussSection it would be 
TrussSectionType. And so on. You will know (or you can figure it out) the type of 
object that was created when you created the shell section and only need to add the word 
'Type' at the end of it. 

and section 

--------------------------------------·1 # - - ---------- -- ---- ---- - --- - ----- ----- -- -- - -- - - ----- - -------------- -- ----

1 : ~~~~~=~-~~==~~~~ -~~~-==~~=~~-~=~=~===~~=-~~~~-=~=-~~~- ~~~-~~~==-=~-~ -~~~el L ----- ------
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mdb.Model(name='Model To Extract Odb Info', modelType=STANDARD_EXPLICIT) i 
mdb.models['Model To Extract Odb Info'].materialsFromOdb('TrussAnalysisJob.odb') li 

mdb.models['Model To Extract Odb Info'] .sectionsFromOdb('TrussAnalysisJob.odb') __ 

Abaqus provides a few methods to quickly extract information from an odb and place it 
in a model. This cannot be done from AbaqusNiewer and must be done through a script. 
These methods are beamProfilesFromOdbQ, materialsFromOdbQ, 
ModeiFromOdbFileQ, PartFromOdbQ, and sectionsFromOdbQ. Here you see 2 of 
them being used. 

materialsFromOdbO is a method of the Material object. It creates a Material object 
by reading an output database and places the new material in the materials repository for 
that model. it has one required argument fileName which is a String representing the 
name of the .odb file to read. The String may also be a full path. Note that if a material 
with this name exists in the model it will be overwritten. 

sectionsFromOdbQ is a method of the Section object. It creates a Section object by 
reading an output database and places the new section in the sections repository for that 
model. It too has the same required argument tileName which is a String representing the 
name of the .odb file to read. Again the String may also be a full path. Note that if a 
section with this name exists in the model it will be overwritten. 

lt is because these methods add materials and sections to the materials and sections 
repositories of a model that we needed to first create a new model for this purpose. We 
used the ModeiO method to create the model database. 

In all the previous examples we have not created a new model, but rather changed the key 
of an existing model using the mdb.models.changekeyQ. The ModeiO method creates a 
Model object with the name being the String specified as its required argument. Other 
optional arguments such as description, stefanBoltzmaon and absoluteZero are 
available as well- see the Abaqus Scripting Reference Manual for a full list. 

16.6 Object Model Intel"rogation 
At this point it should be evident that the output database object model runs very deep 
and you need to know exactly where the information you need is nested. For example, to 
find the strain energy of the model at time = 1 of the 'Loading Step' you used the 

statement: 
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trussOdb.steps ['Loading Step'].historyRegions.values ()[0] . 
historyOutputs['ALLSE'] .data[l][l] 

You do not need to memorize this entire path structure. Most times it is best to use print 
statements either within the script, or in the Kernel Command Line Interface in the 
Abaqus/CAE window. And on other occasions you can reuse and modify code you have 
written previously. 

The process of determining the output database model structure and how you can access 
the information you need using it is referred to as object model interrogation. There are 
two methods that are invaluable for doing this - print and prettyPrintQ. 

You've seen the print command already. prettyPrintQ on the other hand prints out a 
formatted version of the object passed to it as an argument. 

We can experiment with this in the Kernel Command Line Interface. Run the script 
created in this chapter and remove the closeQ commands that close the odbs at the end of 
the script, so that we can then experiment with the odbs. 

Use the print statement to find out what information is stored in trussOdb. 

>>> print trussOdb 
({'analysisTitle ': 'Analysis of truss under concentrated loads', 'closed': False, 
'customData' : python object wrapper, 'description' : ' DDB object', 'diagnosticData' : 
'OdbDiagnosticData object', 'isReadOnly': True, 'jobData': 'JobData object', 
'materials': 'Repository object', 'name': 'C:/AbaqusTemp/TrussAnalysisJob.odb', 
'parts': 'Repository object', 'path' : 'C : /AbaqusTemp/TrussAnalysisJob.odb', 
'profiles': 'Repository object', 'readinternalSets': False. 'rootAssembly' : 
'OdbAssembly object', 'sectioncategories' : 'Repository object', 'sections': 
'Repository object', 'sectorDefinition ' : None, 'steps ': 'Repository object', 
'useroata': 'UserData object'}) 

You notice that it prints everything together on the same line which makes it hard to read. 
Try prettyPrintO instead 

>>> prettyPrint(trussOdb) 
({'analysisTitle ': 'Analysis of truss under concentrated loads', 

·closed · : False, 
'customData ': None, 
'description': 'DDB object', 
'diagnosticData' : 'OdbDiagnosticData object ' , 
'isReadOnly' : True, 
'jobData': ' JobData opject' , 
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'materials': 'Repository object·~ 
'name'; 'C:/AbaqusTemp/TrussAnalysisJob.odb'~ 

'parts': 'Repository object', 
'path': 'C:/AbaqusTemp/TrussAnalysisJob.odb', 
'profiles': 'Repository object', 
'readinternalSets': False~ 
'rootAssembly' : 'OdbAssembly object', 
'sectioncategories': 'Repository object·~ 
' sections' : 'Repository object', 
'sectorDefinition': None, 
'steps': 'Repository object', 
'userData': 'UserData object'}) 

prcttyPrintO displays the contents of trussOdb in a much more readable fashion. You 

can now see what members and methods are contained in it. One of these is steps which 

is a Repository object. Let's explore steps. 

>>> prettyPrint(trussOdb.steps) 
{'Loading Step': 'OdbStep object'} 

The steps repository appears to contain one name:value pair. The step is named 'Loading 

Step' which is its repository key. Let's dig deeper 

>>> prettyPrint(trussOdb.steps['Loading Step']) 
({'acousticMass': -1.9, 

'acousticMasscenter': 'tuple object', 
'description' : 'Loads are applied to the truss in this step'~ 
'domain ' : TIME, 
'eliminatedNodalDofs' : 'NodalDofsArray object', 
'frames': 'OdbFrameArray object', 
'historyRegions': 'Repository object', 
'inertiaAboutCenter' : 'tuple object', 
'inertiaAboutOrigin': 'tuple object', 
'loadcases': 'Repository object', 
'mass': -1.9, 
'massCenter': 'tuple object'~ 
'name': 'Loading Step', 
'nlgeom': False, 
'number': 1, 
'previousStepName': ' Initial', 
' procedure': '*STATIC', 
'retainedEigenModes': 'tuple object ' , 
'retainedNodalDofs': 'NodalDofsArray object', 
'timePeriod': 1.9, 
'totalTime': 9.9}) 

Let's explore the bistoryRegions repository object. 
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>>> prettyPrint(trussOdb.steps['Loading Step'].historyRegions) 
{'Assembly ASSEMBLY': 'HistoryRegion object'} 

We see that it has one HistoryRegion object. To look inside it: 

>>> prettyPrint(trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY']) 
({'description': 'Output at assembly ASSEMBLY', 

'historyOutputs': 'Repository object', 
'loadCase': None, 
'name': 'Assembly ASSEMBLY', 
'point': 'HistoryPoint object', 
'position': WHOLE_MODEL}) 

Alternatively we could have typed 

>>> prettyPrint(trussOdb. steps['loadingStep'].historyRegions.values()[e]) 
({'description': 'Output at assembly ASSEMBLY', 

'historyOutputs': 'Repository object ' , 
'loadCase': None, 
'name': 'Assembly ASSEMBLY', 
'point' : 'HistoryPoint object', 
'position': WHOLE_MODEL}) 

To see which history outputs are available we check the historyOutputs repository 

>>> prettyPrint(trussOdb.steps['Loading Step'].historyRegions['Assembly 
ASSEMBLY'].historyOutputs) 
{'ALLAE' : 'HistoryOutput object', 

'ALLCD': 'Historyoutput object', 
'ALLDMD': 'HistoryOutput object', 
'ALLEE ' : ' HistoryOutput object', 
'ALLFD': ' HistoryOutput object', 
'ALLIE': 'Historyoutput object', 
'ALLJD': 'HistoryOutput object', 
'ALLKE': 'HistoryOutput object ' , 
'ALLKL': 'HistoryOutput object', 
'ALLPD': 'HistoryOutput object', 
'ALLQB': 'HistoryOutput object', 
' ALLSD': 'HistoryOutput object', 
' ALLSE': 'HistoryOutput object', 
'ALLVD': 'HistoryOutput object' , 
'ALLWK': 'HistoryOutput object', 
'ETOTAL': 'HistoryOutput object'} 

If we were to access one of these, such as ' ALLSE' 

>>> prettyPrint(trussodb.steps['Loading Step'].historyRegions['Assembly 
ASSEMBLY'].~istoryOutputs['ALLSE']) 
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({'conjugateData ' : None, 
' data' : 'tuple object' , 
'description': 'Strain energy' , 
'name' : 'ALLSE', 
'type' : SCALAR}) 

Let's examine at the data member 

>>> prettyPrint(trussOdb.steps('Loading Step'].historyRegions('Assembly 
ASSEMBLY'] . historyOutputs['ALLSE'].data) 
('tuple object', 'tuple object') 

It has 2 tuples representing the ALLSE data. Let's find out what the second one contains. 

>>> prettyPrint(trussOdb.steps['Loading Step ' ].historyRegions['Assembly 
ASSEMBLY').historyOutputs('ALLSE'] . data[l)) 
(1.9, 65.4211) 

It is giving us (time t2, ALLSE value v2). To access the ALLSE value at time = t2 we 
can write 

>>> prettyPrint(trussOdb. steps['Loading Step'].historyRegions['Assembly 
ASSEMBLY'].history0utputs['ALLSE'].data[1][1]) 
65.4211 

or 

>>> print trussOdb.steps['Loading Step'].historyRegions['Assembly 
ASSEMBLY ' ] . historyOutputs['ALLSE'].data[l][l) 
65.4210891724 

I think you get the picture. By working our way through the object model using 
prettyPrint, we now know exactly where the ALLSE data is stored. This is how you 
would come up with the statement that we used in the script to find the ALLSE data at 
time = I. 

trussOdb.steps['Loading Step'].historyRegions.values()[e]. 
historyOutputs['ALLSE'].data[1][1) 

16.7 More object model interrogation techniqu~ 
--~----._._ ____________ ___ 

You' ve seen how to use prettyPrintO in the previous section with· the one required 
argument which is an Abaqus object. prettyPrintO also has a few optional arguments. 
One of them is maxRecursionDepth, which is an Int specifying the maximum depth to 
navigate and print. You can also set it to the SymbolicConstants UNLIMITED or None. 
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In the case of UNLIMITED you might get a lot of output. None on the other hand will 

resort to the default setting which is the current setting in the extReprOptions object. 

You generally want to keep maxRecursionDepth set to a small number. Personally 
never go beyond 2. This lets you see one level deeper without cluttering up the kernel 
command line interface. 

To compare the difference maxRecursionDepth makes, here is prettyPrintO with 
maxRecursionDepth = 1 

prettyPrint(trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY']) 
({'description': 'Output at assembly ASSEMBLY', 

'historyOutputs': 'Repository object', 
'loadCase': None, 
'name': 'Assembly ASSEMBLY', 
'point': 'HistoryPoint object', 
'position': WHOLE_MODEL}) 

And here it is with maxRecursionDepth = 2 \ 

>>> prettyPrint(trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY'], 
2) 
({'description': 'Output at assembly ASSEMBLY', 

'historyOutputs': {'ALLAE': 'HistoryOutput object', 
'ALLCD': 'HistoryOutput object', 
'ALLDMD': 'HistoryOutput object', 
'ALLEE': 'HistoryOutput object', 
'ALLFD': 'Historyoutput object', 
'ALLIE': 'HistoryOutput object', 
'ALLJD': 'Historyoutput object', 
'ALLKE': 'HistoryOutput object', 
'ALLKL': ' HistoryOutput object', 
'ALLPD' : 'Historyoutput object' , 
'ALLQB': 'HistoryOutput object', 
'ALLSD'; 'HistoryOutput object', 
'ALLSE': 'HistoryOutput object', 
'ALLVD': 'HistoryOutput object', 
'ALLWK': 'Historyoutput object', 
'ETOTAL': 'Historyoutput object'}, 

'loadCase': None, 
'name': 'Assembly ASSEMBLY', 
'point': ({'assembly ' : 'OdbAssembly object', 

'element·: None, 
'face· : None, 
'instance': None, 
'ipNumber': None, 
'node' : None, 
'position': WHOLE_MODEL, 

' \ 
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'region·: None, 
'sectionPoint': None}), 

'position' : WHOLE_MOOEL}) 

Another way to interrogate object attributes is the printPathsO method. This returns 
information similar to print, except in the form of full paths of the attributes rather than 
just the attribute names. Its format is printPaths(object). You can also change the depth 
as you can with prettyPrintO eg. printPaths(object, 2). 

>>> printPaths(trussOdb.steps['Loading Step').historyRegions['Assembly ASSEMBLY')) 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob .odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'] .description 
session.openOdb(r ' C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'] . historyRegions['Assembly ASSEMBLY'].historyoutputs 
session. openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'] . loadCase 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].name 
session .openOdb(r'C:/AbaqusTemp/TrussAnalysisJob. odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].point 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb ' ).steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].position 

If you wish to store the paths as Strings in a variable for further processing, you can 
instead use getPathsQ. 

paths_String = getPaths(trussOdb.steps['Loading Step'].historyRegions['Assembly 
ASSEMBLY ' ]) 

>> > prettyPrint(paths_String) 
session.openOdb(r 'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'] . historyRegions['Assembly ASSEMBLY'].description 
session .openOdb(r'C :/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'] . historyRegions['Assembly ASSEMBLY'].historyoutputs 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb' ).steps('Loading 
Step'] . historyRegions['Assembly ASSEMBLY'].loadCase 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
St ep'].historyRegions['Assembly ASSEMBLY'].name 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions('Assembly ASSEMBLY'] . point 
session .openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps('Loading 
Step'].historyRegions['Assembly ASSEMBLY'].position 

If you are more interested in the types of data, but also want to know the full path, you 

could use printTypesQ 

>>> printTypes(trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY ' ]) 
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str 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].description 
Repository 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].historyOutputs 
None Type 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].loadCase 
str 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].name 
HistoryPoint 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLV'].point 
SymbolicConstant 
session.openOdb(r'C:/AbaqusTemp/TrussAnalysisJob.odb').steps['Loading 
Step'].historyRegions['Assembly ASSEMBLY'].position 

One final way to interrogate object members and methods is to use _members_ and 
_methods_. You type these in as part ofthe statement at the end, and Abaqus tells you 
what your options are 

>>> trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY']. __ members __ 
['description', 'historyOutputs', 'loadCase', 'name', 'point', 'position'] 

_members_ returns the same member attributes as prettyPrintQ. However it does not 
tell you the type of object each of the members is. 

>>> trussOdb.steps['Loading Step'].historyRegions['Assembly ASSEMBLY'] . __ methods __ 
['HistoryOutput', 'getSubset'] 

_methods_ tells you what methods can be used at this point. This is information you 
do not get from prettyPrintQ. 

With so many interrogation options, all of which return similar data, which one you use is 
sometimes a matter of personal preference. This author has a tendency to use print, 
prettyPrintO and _ methods_ almost all of the time but you might prefer printPatbsO 
and printTypesQ. 

You now have a good understanding of how you can access information stored in an 
output database using a Python script. There is a wealth of information available in an 
odb, and all you need to access it is a basic understanding of the output database object 

model. There is no sense in memorizing the entire tree structure which has hundreds of 
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nested repositories, attributes and methods; you should instead use object model 
interrogation with print and prettyPrintO statements to determine how to access the 
information you need. 



17 -
Combine Frames of two Output 

Databases and Create an Animation 

" ~ 

In the previous chapter we explored two output databases to understand the output 
database object model and learn how to obtain useful information from an .odb file. In 
this chapter we will demonstrate how to create a new output database file from scratch. 
To make things interesting we will open two other output databases, extract the required 
information from them, and combine this information from both of them into a new 
output database. 

We will modify the plate bending example from Chapter 10 in order to include the effect 
of plasticity, and increase the loading on it to force it into plastic deformation. We shall 
request Abaqus to write restart information to the .res file during this analysis. We will 
then continue the analysis using the restart file and remove the load from the plate 
allowing it to spring back and recover its elastic deformation (the plastic deformation will 
not be recovered). The two analyses will generate two output databases. However these 
do not overlap, and the first frame of the restart analysis wilJ correspond to the last frame 
of the original analysis. In order to view the results of the original analysis in 
AbaqusNiewer, the first .odb needs to be opened, and for the second analysis 
(springback) the second .odb will need to be opened. 

Our goal is to use a Python script to read both the output databases, extract the nodal 
displacement information, and create a new output database which combines the 
information of both analyses. This allows the analyst to view the entire set of results (that 
you choose to include in the combined odb) in AbaqusNiewer since the frames of both 
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analyses are joined together. We will then create an animation which includes both the 
bending and the springback. 

17.2 Methodology 
We will need to create 3 Python scripts for this example. 

The first script will be a modification of the plate bending script from Chapter 10. We 
will update it to include plastic material properties, and increase the load to cause 
bending stresses that exceed the elastic limit. We will also need to request Abaqus to 
write restart information to the .res file. On running the simulation an output database file 
will be produced. 

Tite second script will replicate the original model, and add a new step to it where the 
load is removed. It will then continue the analysis using this new model. On running this 
simulation a second output database file will be produced. 

The third script will open and read the output databases created by the two analyses, and 
extract the nodal displacement information. It will then create a new output database, and 
in it create the part, instance it, create two steps, and add the displacement field output 
data to these steps from each of the .odb files. It will then open this .odb in 
Abaqus!Viewer, animate the time history and save the animation, which will include both 
the bending and the springback. 

17.3 Procedure in GUI ------You can perform the simulation in Abaqus/CAE by following the steps listed below. You 
can either read through these, or watch the video demonstrating the process on the book 
website. 

1. Open the model created for the elastic plate bending example of Chapter 10. 
2. Rename Plate Bending Model as Plastic Plate Bending Model 

a. Right-click on Plate Bending Model in the Model Database 
b. Choose Rename .. 
c. Change name to Plastic Plate Bending Model 

3. ModifY the material 
a. Expand the Materials container in the Model Tree 

b. Right-click on AISI 1005 Steel 
c. Choose Rename .. 
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d. Change name to Steel 
e. Right-click on AISI 1005 Steel 
f. Choose Edit. The Edit Material window is displayed 
g. Select Mechanical> Elasticity> Elastic. Change Poisson's Ratio to 0.23 
h. Select Mechanical >Piasticity>Piastic. Chang 
t. Right-click in the Data table and choose Read from File. The Read Data 

from ASCII File window is displayed. 
J. Set File to plate_bending_steel_plasticity_data by clicking the Select 

button. 

k. Set Start reading values into table row to 1 
l. Set Start reading values into table column to 1 
m. Set Base Feature Shape to Shell 
n. Set Base Feature Type to Planar 
o. Right-click in the table and choose Create XY Data .... The Create XY 

Data window is displayed. 
p. Set Name to steel stress vs. plastic strain 
q. Set Read X values from column to 2 
r. Set Read Y values from column to 1 
s. Set Approximate Size to 20 
t. Click OK. You will enter Sketcher mode. 
u. Switch to the Visualization module using the Module dropdown menu 
v. Expand the XY Data container in the Results Tree 
w. Double-click on steel stress vs. plastic strain in the Results tree. Aplot of 

the yield stress vs. plastic strain data is displayed 
x. Click the XY Curve Options tool. The Curve Options window is displayed. 
y. Set the Style to dashed using the dropdown menu. 
z. Check Show symbol. 
aa. Change Symbol to another shape using the dropdown menu 
bb. Change Size to Large using the dropdown menu 
cc. Click Dismiss to close the window 

4. Edit the Step 

a. Expand the Steps container in the Model Tree. 
b. Double-click Load Step. The EditStep window is displayed 
c. Switch to the Incrementation tab 
d. Set Increment size to 0.1 

5. Edit Loads 
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a. Expand the Loads container in the Model Tree. 
b. Double-click Concentrated Forces. The Edit Load window is displayed 
c. Change CF3 to -270000.0 to apply a 270000.0 N force in downward 

(negative Y) direction 
d. Click OK 

6. Create and submit the job 
a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 
b. Set Name to Plate.JobPlastic 
c. Set Source to Plastic Plate Bending Model 
d. Select Plastic Plate Bending Model (it is the only option displayed) 
e. Click Continue .. The Edit Job window is displayed 
f. Set Description to Job simulates the plastic bending of a plate 
g. Set Job Type to Full Analysis. 
h. Leave all other options at defaults 
1. Click OK 
j. Expand the Jobs container in the Model Database 
k. Right-click on PlateJobPiastic and choose Submit. 
I. You will see a popup saying History output is not requested in the 

following steps: Load Step. OK to continue with job submission? Click 
Yes. 

m. This will run the simulation. You will see the following messages in the 
message window: 
Error in job PlateJobPiastic: THERE IS NO MATERIAL BY THE 
NAME AISI 1005 STEEL 
Error in job PlateJobPiastic: 90 elements have missing property 
definitions. The elements have been identified in error set 
ErrEiemMissingSection 
Job PlateJobPiastic: Analysis Input File Processor aborted due to 
errors. 
Error in job PlateJobPiastic: Analysis Input File Processor exited with 
an error 
You will also see the word Aborted next to PlateJobPlastic in the Model Tree 

7. Edit Sections 
a. Expand the Sedions container in the Model tree 
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b. Double-click Concentrated Forces. The Edit Load window is displayed. 
You also see a message Section 'Plate Section' contains a reference to 
material 'AISI l 005 Steel', but that material no longer exists 

c. Click Dismiss 
d. Set Material to Steel using the drop down menu 
e. Click OKto close the Edit Section window 

8. Resubmit the job 
a. Right-click on PlateJobPiastic in the Jobs container of the Model tree and 

choose Submit. 
b. You will see a pop up saying Job files already exist for PlateJobPiastic. 

OK to overwrite? Click OK. 
c. You will see a popup saying History output is not requested in the 

following steps: Load Step. OK to continue with job submission? Click 
Yes. 

d. This will run the simulation. You will see the following messages in the 
message window: 
The job input file "PiateJobPlastic.inp" has been submitted for analysis. 
Job PlateJ.obPiastic: Analysis Input File Processor completed 

successfully 
Job PlateJobPiastic: Abaqus/Standard completed successfully 

Job PlateJobPiastic completed successfully 
9. Plot contour and change font of legend, title block and state block 

a. Right-click on PlateJobPiastic (Completed) in the Model Database. Choose 
Results. The viewport changes to the Visualization module. 

b. In the toolbar choose Plot Contours on Deformed Shape tool to plot the 

Mises stress contours on the plate 
c. In the menu bar click on Viewport > Viewport Annotation Options 

d. Switch to the Legend tab 
e. Click Set Font. The Select Font window is displayed. 

f. Set Size to 14 using the dropdown menu 

g. For Apply To check Legend 
h. Click Ok. The font size of the legend is now 14. 
1. Switch to the Title Block tab 

J. Click Set Font. The Select Font window is displayed. 
k. Set Font to Times New Roman using the dropdown menu 

l. Set Size to 14 using the dropdown menu 
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m. For Style check Italic 
n. For Apply To check Title block and State block 
o. Click OK 

I 0. Request Field Outputs 
a. Switch to the Step module using the Module dropdown menu 
b. Using the menu bar click on Output> Restart Requests ... The Edit Restart 

Requests window is displayed. 
c. In the Frequency column, set the frequency to 1 for Load Step 
d. Check Overlay 
e. Click OK 

I I. Resubm it the job 
a. Right-click on PlateJobPiastic in the Jobs container of the Model tree and 

choose Submit. 
b. You will see a pop up saying Job files already exist for PlateJobPiastic. 

OK to overwrite? Click OK. 
c. You will see a popup saying History output is not requested in the 

following steps: Load Step. OK to continue with job submission? Click 
Yes. 

d. This will run the simulation. You will see the following messages in the 
message window: 
The job input file "PlateJobPiastic.inp" has been submitted for analysis. 
Job PlateJobPiastic: Analysis Input File Processor completed 
successfully 
Job PlateJobPiastic: Abaqus/Standard completed successfully 
Job PlateJobPiastic corn pleted successfully 

12. Check the Abaqus work directory- it is C:\Temp by default - for the presence of 
a restart file PlateJobPlastic.res 

13. Copy the model to create a restart model 
a. Right click on Plastic Plate Bending Model in the Model tree. 
b. Choose Copy Model •• The Copy Model dialog box is displayed 
c. Set Copy Plastic Plate Bending Model to: to Plate Springback Model 
d. Click OK. A new model Plate Springback Model is displayed in the Model 

tree 
e. Right click on Plate Springback Model. 
f. Choose Edit Attributes .. The Edit Model Attributes window is displayed 
g. In the Restart tab check Read data from joband type in PlateJobPiastic 



h. Set Step name to Load Step 
i. Click Ok .. 

14. Add a new step 
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a. Double-click on Steps container in the Model Tree. The Create Step window 
is displayed 

b. Set Name to Springback 
c. Set Insert New Step After to Load Step 
d. Set Procedure Type to General> Static, General 
e. Click Continue .. The Edit Step window is displayed 

f. In the Basic tab, set Description to Remove load and allow elastic 
spring back. 

g. Set Time period to 1 

h. Switch to the Incrementation tab 
1. Set Initial Increment size to 0.1 
J. Click OK. 

15. Deactivate the load in the Springback step 

a. Right cJick on Loads in the Model tree. 
b. Choose Manager .. The Load Manager dialog box is displayed 

c. Click Propagated in the Springback step. The word Propagated changes to 
Inactive 

d. Click Deactivate 
e. Click Dismiss. 

16. Create and submit the job 

a. Double-click on Jobs in the Model Database. The Create Job window is 

displayed 

b. Set Name to PlateSpringbackJob 
c. Set Source to Plate Springback Model 
d. Select Plastic Plate Bending Model (it is the only option displayed) 

e. Click Continue .. The Edit Job window is displayed 

f. Set Description to Job allows elastic springback 
g. Set Job Type to Restart. 
h. Leave all other options at defaults 

t. Click OK 
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J. Expand the Jobs container in the Model Database 

k. Right-click on PlateSpringbackJob and choose Submit. 
I. You will see a popup saying History output is not requested in tbe 

following steps: Load Step. OK to continue with job submission? Click 

Yes. 
m. This will run the simulation. You will see the following messages in the 

message window: 
Tbe job input file "PiateJobPlastic.inp" has been submitted for analysis. 
Job PlateSpringbackJob: Analysis Input File Processor completed 
successfully 
Job PlateSpringbackJob: Abaqus/Standard completed successfully 
Job PlateSpringbackJob completed successfully 

16. Plot contour 
a. Right-click on PlateSpringbackJob (Completed) m the Model Tree. 

Choose Results. The viewport changes to the Visualization module. 

b. In the toolbar choose Plot Contours on Deformed Shape tool to plot the 

Mises stress contours on the plate 

c. In the menu bar click on Viewport > Create. A new viewport is created. It 

may be hidden behind the current viewport if you cannot seen 

d. ln the menu bar click on Viewport >Tile Vertically. The two viewports are 

placed side by side. The new viewport has the same contents as the old one. 

e. Click the titlebar ofYiewport 1 to make it the active viewport. 

f. Right click on Output Databases in the Results tree and choose Open 
g. Choose PlateJobPiastic.odb from the Open Database browse window. The 

results of the original analysis are displayed in the viewport. 

h. In the toolbar choose Plot Contours on Deformed Shape tool to plot the 

Mises stress contours on the plate 

1. Click the titlebar of Viewport 2 to make it the active viewport. 

J. Use the ODD dropdown menu (above the viewport) to ensure that the ODB 

is set to PlateSpringbackJob.odb 

k. Again click the titlebar ofYiewport 1 to make it the active viewport. 

f. Click the Frame Selector tool. You see the Frame Selector dialog box 

m. Set the frame to the last frame (frame 14) of the Load step 

n. Close the Frame Selector tool by clicking the red x at the top right corner of 

the dialog box 
o. Again click the titlebar of Viewport 2 to make it the active viewport. 
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p. Click the Frame Selector tool. You see the Frame Selector dialog box 

q. Set the frame to the first frame (frame 0) of the Springback step 
r. Compare the contour plots and the legends. They should be identical. 
s. Click the titlebar ofViewport 1 to make it the active viewport 
t. Change the primary field variable to UT (translations and rotations) U3 using 

the field output toolbar. The displacement contour is displayed on the plate 
u. Click the titlebar ofViewport 2 to make it the active viewport 
v. Change the primary field variable to UT (translations ·and rotations) U3 using 

the field output toolbar. The displacement contour is displayed on the plate 
w. Compare the contour plots and the legends. They should be identical 

The user should open up a new model in Abaqus using File> New Model Database> 
With Standard/Explicit Model and run the first script to simulate plastic bending of the 

plate using using File > Run Script .•. The analysis will create an output database file 
'PlateJobPlastic.odb'. 

The user must then run the second script using File > Run Script •.• The analysis will 
create an output database file 'PlateSpringbackJob.odb'. 

Finally the user should run the third script (again using File> Run Script ... ) which will 
read from both thee output databases and create a new one called 
Plate _plastic_ bending_ and_ springback.odb. 

The fo11owing Python script replicates the above procedure for setting up and analyzing 

plastic bending of the plate and requesting restart data. It is a modified version of the 

script from Chapter 10. You can find it in the source code accompanying the book in 
plate_bending_plastic.py. You can run it by opening a new document in Abaqus/CAE 

(File > New Model database > With Standard/Explicit Model) and running it with 
File > Run Script 
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# Create the .adel 

mdb.models.changeKey(front4ame='Model-1', toName='Plastic Plate Bending Model') 
plateModel • ~b.models['Plastic Plate Bending Model'] 

import sketch 
import part 

# a) Sketch the plate using the rectangle tool 
plateProfileSketch e plateMbdel.ConstrainedSketch(name='Pla~~ ~ketch', 
plateProfileSketch. rectangle(point1=( e. e. e. e~ ~ point2=( s •. a. 3. e)) 

# b) Create a shell named wPlate• using the sketch 
platePart•plateHodel.Part(namea'Plate', di.ens1onality=THREE_D1 

type•DEFORMABLE_BODY) 
platePart.BaseShell(sketch=plateProfileSketch) 

# ------- ---------------------------------- - ----------~ 
# Create material 

illf)Ort material 

# Read plastic properties fro. an external file 
.aterial_file_name m 'plate_bending_steel_plasticity_data.txt' 
stress_data_list • [] 
strain_data_list • [] 

f • open(.aterial_file_na.e) 
for line in f: 

stress_strain_line = line 
. stress_st~ain_l±st · ·stress_strain_line.split() 
stress_data_list.append{stress_stl"ain_Ust[e]) 
strain_data_Ust·.append(stress_striin .... list[l]) 

f.clase() · 

plasticity_curve_list = (] 
for 1 i~ range(len(stress_data_list)): 

plasticity_curve_list.append((float(stress_data_list[i]), 
float(strain_data_llst[i]))) · 

plasticity_curve_tuple • tuple(plasticity_curve_list) 

plateMaterial.Plastic(tab~e~lastlcity_curve_tuple) 
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# - - -----------------
# Create the history output request 

# We don't want any history outputs so lets dele"te ttie ... c: ...... ::. ... <:l.m~ .• 
del! plateModel. history<>utputRequesi:s [ 'H-Outpl:lt -1:' ] · 

# Apply boundary cond~tions - ffx one edge. 

fixed_edge • plateinstan~e.edges . findAt 
fixed_edge_region•region:roolset.Region(edf~es•=f1xe(i-.eltfge·r~; 

plateModel.Displace.entBCGniule• ' FixEdge', createStepName;; 'Ini"tial ··, 
regionsfixed_edge_region, ul=SET, u2=SET, u3=SET, ·url=SET, u~2=SET, ur3=SET, 
ampli tude..uNSET, distrilkrtionrype•UNIFORM, fieldName=' ' , localCs.ys=None) 

# Instead of using the displacenents/~tations boundary condit~on and setting all 
six DOF to zero ·· 
#we could have just used the EnGastre conditio~ with the · foll~wing statement 
# plateModel.EncastreBC(naae='Encaster edge', createstepName='lnitial', · 
region-fixed_edge_region) 

# Create the datum points 
platePart.DatunPointByCoordinate(coords=(8.9, 1.9, 8.91) 
platePart.oatUIPointByCoordinate(coords=(8.9, 2.9, e.9)) 
platePart.DatUMPointByCoordinate(coords• (S.9, 1.9, e.e)) 
platePart.oatUIPointByCoordinate(coords• (5.9, 2.9, 9.9)) 

# Assign the datUM points to variables 
# Abaqus stores the 4 dat• points in platePart. datuns 
# Since their keys .ay or 11ay not start at zero, put the ke)'~ :lrn ·an array sorted in 
asce~ding order · · 
platePart_datuas_keys = platePart.datums.keys() 
platePart_dat18s_keys.sort() 
plate_datu._point_l .;. platePart .datums[platePart_datums_keys [9]] 
plate_datu._point_2 = platePart.datums[platePart_datums~keys[ll] 
p1ate_datu•_point_3 • platePapt.datums[platePa~_datums_keysf2]] 
plate_datum,U)Oint_4 • plate~al"'t .. datums[platePart_datums_k!eys~3].] 

# Select the entire face and partition it using .two poi.nts 
partition_face_pt • (2.5, 1.5, e.e) . 
partition_face • platePart.faces.fin~t((partition_face_pt,)) 
platePart.PartitionFaceByShortestPath(pointl=plate_datu.~int_~, 
point2•plate_datua_point_3, faces.partition_face) . . 

# Now two faces exist, select the one that needs to be partitioned 
partitlon_fac;e_pt • (2.5, 2.9, 9'.8) 
partitlon_.fac.e .. platePart.faces. findAt( (partition_fac~__pt,)) 
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e.e}, >~ 
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# -- --------------- --- ---~~----------~-- ------ -~--~----
# Display deformed state with contours 

import visualization 

plate_vlewport • session.Viewport(name=1 Plate Plastic Bending_Results ·Viewport') 
plate_Odb.,..Path • 1 PlateJobPlastic. odb • . . - -
an_odb_object • sesslon.openodb(name=plate_Odb_Path) 
plate_viewport.setValues(displayedObject=an_odb_object) . 
pl ate_viewport.odbDisplay-.display.setValues(plotState=(CeNf001\s_ON_DEF1 

t Displace.ent U3, the 3-component of displacement 
plate_viewport.odbDisplay.setPrimaryVariable(~ariabl~Label='UT-' 1 
outputPositionaNODAL, ref!nement=(COMPONENT, 1 U3'),) . --- ------ ---------~------ -------------------------- - . 
# Report stresses in descending order 

llllport odbAccess 

I' The main session viewport 111.1st be set to t he odb object ··usi ng the following. l !ne. 
If not you might ~ive ·an-error .essage that states · 
1t •There are no active entities. NO report has been generated. " 
sessi on. viewports[ 'Viewpol'i"t: 1 I ·]. setValues ( dbplayedObje~t=~n_odb_object) 

# Write the field ~eport outputting the M!ses stresses 
session.writeFieldReport(fileHa.e•report_na.e_and~ath, 
sortltetn• 1 S.Hises', odbzan_odb_object, step=8, frae=l, 
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Let's dissect the script and understand how it works. Since most of the script is almost 
identical to the one used in the elastic plate bending example, only the differences will be 
highlighted. 

I mdb.models.changeKey(fromName='Model-1', toName='Plastic Plate Bending Model') ----~ 
1 plateModel = m?b_:.~<?!1el~_(~-~-~ti~- Plate Bending Mod_el'] ___ _j 

The name of the model has been set to 'Plastic Plate Bending Model ' and the subsequent 
statement has been modified accordingly. 

I plateMaterial = plateModel. Mater_ia_l-'('-n_am_e_=_'_St_e_e_1_' -=-) ----------------~ 

The material created in this script is given generic steel properties hence it has been 
named 'Steel ' . 

.----------------------
# Read plastic properties from an external file 
material_file_name = 'plate_bending_steel_plasticity_data.txt' 
stress_data_list = [] 
strain_data_list = [] 

f = open(material_file_name) 
for line in f: 

stress_strain_line = line 
stress_strain_list = stress_strain_line.split() 
stress_data_list.append(stress_strain_list[e)) 
strain_data_list.append(stress_strain_list[l]) 

f.close() 

plasticity_curve_list = [] 
for i in range(len(stress_data_list)): 

plasticity_curve_list.append((float(stress_data_list[i]), 
float(strain_data_list[i]))) 

plasticity_curve_tuple = tuple{plasticity_curve_list} 

plateMaterial.Plastic(table=plasticity_curve_tuple) 

If you were to hardcode the plasticity properties into the program, you would use the 
statement 
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plateMaterial .Plastic(table={(2.8E8, e.e), (3.25E8, 9.025), (3.4SE8, 8.86), (3 . 6E8, 
0.1), (3.8E8, 8.2))) 

What we are instead doing here is reading them in from an external text file 
'plate_bending_steel_plasticity_data.txt'. We need to then put these properties in the 
format ofthe above statement. 

You've encountered the openO command before. The for loop reads in each line of data 
one by one. These are pairs of stress and strain, and Python's splitO command splits them 
at the whitespace between them creating a list with 2 members (stress_strain_list). The 
first member of this list is added to stress_data_list using the appendO method and the 
second member is added to strain_data_list. In a second for loop, one stress and one 
strain from each of these lists is appended to a variable called plasticity curve list - -
giving us a list of tuples. The tupleO method is then used to convert this to a tu pie of 
tuples. Finally the PlasticO method is used to create the plastic material by passing the 
tuple of tu pies to it as table. 

plateSection = plateModel.HomogeneousShellSection(name='Plate Section', 
material='Steel', thicknessType=UNIFORM, thickness=8.1) 

This statement has been updated to use the new material 'Steel'. 

plateModel.StaticStep(name='Load Step', previous='Initial', description='Apply 
concentrated forces in this step', nlgeom=ON, initia1Inc=8.1) 
plateModel.steps['Load Step'].Restart(frequency=l, numberintervals=e, overlay=ON, 
timeMarks=OFF) 

The StaticStepQ method has been modified to include the initiallnc parameter. This sets 
the period of the initial increment. We set it to 0.1, which for a total step time of 1 1s 
10%. 

The RestartO method tells Abaqus to write restart data to the .res file. It creates a 
Restart object which defines a restart request. It has no required arguments, only 
optional ones. frequency is an lnt that specifies which increments the information will be 
written at. We set it to 1 indicating that restart information should be written at every 
increment. numberlntervals is an lnt that specifies the number of intervals during a step 
at which restart information should be written. overlay is a Boolean which specifies 
whether the restart data should overwrite the one written at a previous increment or not. 
timeMarks is a Boolean specifying whether or not exact time marks should be used for 
writing during the analysis. 
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;-plateModel.-Conc~~trated·F-~rce( n-ame=· Concentr-~ted-FOrces' ~-~reat-~tepNa-;;;~= 'L~ad Step:- :·--~· I region=(ver~ices for __ c~~.~e'2trated_fo!"c~.:'..t~ ...... :£.~.:::.~?ee~~...:.~-~-~_i.~tri_~~tionType=UN_IFORM) _ 

We modify the concentrated force to have a magnitude of270,000. 
r;-~-~~~t";-·th.e ... io.b ........ ......................................... _ ...... ··----------·-................ -................................................ -- ____ .. ____________ _ 
! mdb.Job(name='PlateJobPlastic', model='Plastic Plate Bending Model', type=ANALYSIS, I description='Job simulates the plastic bending of a plate') : 

I # run the job 
! mdb.jobs['PlateJobPlastic'].submit(consistencyChecking=OFF) I 
l # do not return control till job is finished running l mdb. jobs [ 'PlateJobPlastic']. ~a_1_· t_F_o_rc_o_m.:...pl_e_t_i __ on_(;..:.) ________________ __. 

These statements have been modified to assign and use a new name for the job. 

i plate_viewport = session.Viewport(name='Plate Plastic Bending Results Viewport') J i plate Odb Path = 'PlateJobPlastic.odb' ~-------=----.... ::-::. ............. - .................................................. _ ........... ----------·--------.. --·-----·-·-------·------------------------------
The name of the viewport and the .odb file have been changed in these statements to gel 
with previous changes. 

I # Displacement U3, the 3-component of displacement 

I
! plate_viewport.odbDisplay.setPrimaryVariable{variableLabel='UT' , . outputPosi~ion=~ODAL, refinemen~=.~(_COM_P_O_NE_N_T.::.., _ · U_3_' .:...),:...:) _____________ ___, 

These statements tell Abaqus to display the translation in the 3-direction on the contour 
plot. 

Script .•• 
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import s~etch 
i:IIIPQH! part 

#: a) Sketch the plate 
platePro~lleSketch = Plilttetlladlelr .. ~or~stl~aliltedSki:!tclt(, 
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import step 

# Create a static gener~l step 
plateHodel.staticStep(name='Load 

description ... 
nlgeo!IPON., 

# -------------------- --------- -------------
# Create_ the field output request 

# Since F-output-1 is applied at the 
# Field outputs • wUl be toe) . 
# we only need to set the required variables 
plateModel. fieldOOtputRequests[ 'output Stresses and Displacements ·] \ : 

·' .setValues(vaPiableS=("~~,'UJ')~ 
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hn•mrt:::.rv ~ondi'tion and setting all 
~, 
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ill!pOrt IIN!Sh 

platePart.generateMesh() 

illlpOrt job· 

' #create the job 
. . 

mdb.Job(na.e•'PlateSpringbacklob'~ 

• oo not return control till job is finished runni~g 
mdb.jobs['PlateSpringbackJob•].waitForcompletion 
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# Change the fonts in the viewport annotation options ·to make the lege~d. titi~ 
I block and stateblocks more readable ' · 

. . . . -
• 

• '· . '\•_ l" -~· plate_viewport • session. viewpor'ts[ 'Plate .Pilastic Bending Rt;!~ul~s Viewpo·rt:•] · ' 
plate~vlewport.viewportAnnotationOptions \ . . · 

.setValues(legendFont='-*-verdana-medi~-r-nonmal-~~*-129-~-•-p-*-*-*') 
plate_ viewport. viewportAnnotationoptions \ . . .. · . . · 

I ' • ~ ~- • . . :0: • setVa[ues(titl!eFont• • -*·-times new roman-illedium-11!-1\ormahlll-*-148-* .::•-p-*;..;t_~ • ~ 
stateFont•' -*-tilles new roman-medium-i-normal-.*-*-148-*-,*-p-*-*'-* •) 

plate_vd.ewport ::: session.viewports[ 'Plate Springba~k. Results·.Y,:i:ewf)9.r.t '] 
plate_ viewport. viewportAnnotationOptions \ · · . ~ · ~ ,,c , · r~- ·· • 

• setValues(legendFont=' -*-verdana-llledium-r-:nol"'llal-*-~-129-*-*-.p.,.~-*-.*') 
plate_vl~rt.viewport:ArinotationOptions \ " · .-· . ·~ 

.setValues(titl~Font=' -*-times . new roman-medium-i-,nor.maJ..r-*-*-3!48-*-*:-p-*.:.*'.!. * •, 
S~a~!!Fo~:- ' -*-ti~S en~. r'OIIIatl_;~JI!E!d}U_!II_:!:;fi~f"'Cll .c. *..:~.:j,48:~*;P.-~·!i• )' :;, ---· . , . 

In a restart analysis the new model remains almost identical to the original one up until 
the point of the restart, although a few changes are allowed such as creating more sets in 
the assembly. Therefore the bulk of this script is a copy of the previous one and only the 
differences will be highlighted .. 

mdb .Model(name='Plate Springback Model', modelType=STANDARD_EXPLICIT) 
plateModel = mdb.models['Plate Springback Model'] 

plateModel.setValues(restartJob='PlateJobPlastic', restartStep='Load Step') 
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Most of the scripts we've written so far begin with renaming the existing default model 
'Model- l' using the changeKeyQ method. In this script however we create a new model 
which is a copy of the original with changes. To create a new model we use the ModeiO 
method. ModeiO creates a Model object. Its only required argument is a String which 
specifies the repository key. Here we name the model ~Plate Springback Model'. One of 
the optional arguments is modeiType which specifies the type of analysis which wiiJ be 
carried out in this model. The possible options are STANDARD_EXPLICIT and CFD. 

The (Model).setValuesO method is then used to indicate which job the restart analysis 
should be continued from. setValuesO modifies an existing model object. 1t has no 
required arguments, but a number of optional ones, of which we use restartJob and 
restartStep. restartJob is a String which is the name of the job that originally generated 
the restart data. restartStep is the name of the step of the model where the restart 
analysis will begin. 

This statement creates a new static step called 'Springback' which foiJows the 'Load 
Step'. It sets the initial increment to 0.1 using the initiallnc parameter which works out 
to 10% since the total time is 1 . 

This statement deactivates the force in our new 'Springback' step. It uses the deactivateO 
method of the Load object, which deactivates the load in the specified step and in all 

subsequent steps. It has one required argument stepName which is a String specifying 
the name of the step in which to deactivate the load. This statement is the equivalent of 

opening the load manager in Abaqus/CAE and deactivating a load in a particular step . 

.---·--··---·--------------·----·--·---·---·--···------·-------·--------- -----------·1 
! mdb.Job(name='PlateSpringbackJob', model='Plate Springback Model', type=RESTART, I description='Job allows elastic springback') I 
I # Run the job I 
1 mdb.jobs['PlateSpringbackJob'].submit(consistencyChecking=OFF) 
I ! 
1 

# Do not return control till job i s finished running ~~ 
mdb.jobs['PlateSpringbackJob'].wait~orCompleti?_n-=(..:...) _________ _ 
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These statements have been modified to give the job a new name 'PlateSpringbackJob' 
and submit this job. 

import visualization I 
session. Viewport(name=' Plate Springb __ a_c_k_R_e_s_ults Viewport ·-~------' plate_viewport 

plate Odb Path 'PlateSpringbackJob.odb' _ _ 

These statements have also been modified to change the name of the viewport and point 
to the output database of the newly created job. 

# - - - - - - - - - - - - - - - - - - - - - - - - - - -- - - - - - - - - --::-.::-=-=~:-=-=-=·~=-=--=--=-~-=-=-=·~-~-:=·~·=-=-:~-.::-.:-:--····-··-·--l 
# Display the first frame of the restart analysis so you can compare it to the 
# last frame of the original analysis (they should be the same) 
# Also offset the viewport to reveal the viewport of the original analysis 
# behind it 

plate_viewport.odbDisplay.setFrame(step='Springback', frame=0) 
plate_viewport.offset(deltaX=Se.e, deltaV=S.e) 

# ---------------------------- - ------ - ------ --- ---------------------------
# The viewport from the original simulation loses its contour plot when the 
# restart script is run because Abaqus closes the output database of that job. 
# Hence redisplay the contour on it so that the last frame of the first analysis 
# is displayed (and can be compared to the first frame of the restart analysis. 

plate_viewport = session.viewports['Plate Plastic Bending Results Viewport'] 
plate_Odb_Path = 'PlateJobPlastic.odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport.setValues(displayedObject=an_odb_object) 
plate_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEF, )) 
plate_viewport.odbDisplay.setPrimaryVariable(variablelabel= 'UT', 

outputPosition=NODAL, refinement=(COMPONENT, 'U3'),) 

# ------ -- -- - -------- - --------- - ------- ------------ ------ --- --------------
# Change the fonts in the viewport annotation options to make the legend, title 
# block and stateblocks more readable 

plate_viewport = session.viewports['Plate Plastic Bending Results Viewport'] 
plate_viewport.viewportAnnotationOptions \ 

. setValues(legendFont='-*-verdana-medium-r-normal-*-*-129-*-*- p-*-*-*') 
plate_viewport.viewportAnnotationOptions \ 

.setValues(titleFont='-*-times new roman-medium-i-normal-*-*-149-*-*- p-*-*-*', 
stateFont=' -*-times new roman-medium-i-normal-*-*-149-*-*- p-*-*-*') 

plate_viewport = session.viewports['Plate Springback Results Viewport'] 
plate_viewport.viewportAnnotationOptions \ 

.setValues(legendFont='-*-verdana-medium- r -normal-*-*-120-*-*-p- *-*-*') 
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;------------------------------------······---···--·····---------················ ··········-.. ······ ........................................................................................................................................ - ·---·-··---·-····-·-···------·--------·-·-----------1 
' plate_viewport .viewportAnnotationOptions \ ! 

. setValues(titleFont='-*-times new roman-medium-i-normal-*-*-140-*-*-p-*-*-*', I 
'------s_tate~~nt= ~ -time~--~~~-_r:~ma_~~-~~-~~~~~-~_or~~l-~.::: .. :.:_!40--~~--p-*-* ~-------· 

plate_viewport.odbDisplay.setFrame(step='Springback', frame=9) 

The setFrameO method is used to specifY the step and the frame of the OdbDisplay 
object It has 2 required arguments step and frame. step is a String specifYing the name 

of the step. frame is an Jnt specifYing which frame in the selected step to display. 

plate_viewport.offset(deltaX=59.9, deltaY=5.9) 

The offsetQ method modifies the X and Y coordinates of the current viewport by 

displacing them a certain distance. The arguments delatX and delta Y are Floats 

specifYing the X and Y offsets of the viewport origin in millimeters. 

# ------------- - ----------------------------------------------------------
# The viewport from the original simulation loses its contour plot when the 
# restart script is run because Abaqus closes the output database of that job. 
# Hence redisplay the contour on it so that the last frame of the first analysis 
# is displayed (and can be compared to the first frame of the restart analysis. 

plate_viewport = session.viewports['Plate Plastic Bending Results Viewport'] 
plate_Odb_Path = 'PlateJobPlastic.odb' 
an_odb_object = session.openOdb(name=plate_Odb_Path) 
plate_viewport.setValues(displayedObject=an_odb_object) 
plate_viewport.odbDisplay.display.setValues(plotState=(CONTOURS_ON_DEF, )) 
plate_viewport.odbDisplay.setPrimaryVariable(variablelabel='UT', 

outputPosition=NODAL, refinement=(COMPONENT, 'U3'),) 

You've seen these methods used on numerous occasions before. The comment at the top 

of this chunk of code explains the reason for this. When the script is run, Abaqus closes 

the output database of the original job. This causes the results of the original analysis 

displayed in the viewport to disappear. All we are doing here is redisplaying it. 

# -------------------- - ------------------------------- - ----------------- --
# Change the fonts in the viewport annotation options to make the legend, title 
# block and stateblocks more readable 

plate_viewport = session.viewports['Plate Plastic Bending Results Viewport'] 
plate_viewport.viewportAnnotationOptions \ 

.setValues(legendFont='-*-verdana-medium-r-normal-*-*-129-*-*-p-*-*-*') 
plate_viewport.viewportAnnotationOptions \ 

.setValues(ti tleFont='-*-times new roman-medium-i-normal-*-*-149-*-*-p-*-*-*', 
stateFont='-*-times new roman-medium-i-normal-*-*-149-*-*-p-*-*-*') 

plate_viewport = session.viewports['Plate Springback Results Viewport'] 
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plate_viewport.viewportAnnotationOptions \ 
.setValues(legendFont='-*-verdana-medium-r-normal-*-*-128-*-*-p-*-*-*') 

plate_viewport.viewportAnnotationOptions \ 
.setValues(titleFont='-*-times new roman-medium-i-normal-*-*-149-*-*-p-*-*-*', 
statefont='-*-times new roman-medium-i-normal-*-*-149-*-*-p-*-*-*') 

The ViewportAnnotationOptions object stores the current settings dictating how 
annotations will be rendered m the viewport. The 
viewportAnnotationOptions.setValuesO method modifies the 
ViewportAnnotationOptions object. It has a number of optional arguments. The ones 
we use are legendFont, titleFont and stateFont. legendFont is a String specifying the 
font to be used in the legend. titleFont is a String specifying the font to be used in the 
title. And stateFont is a String specifying the font to be used in the state block. 

The names of the font used by Abaqus such as '-*-verdana-medium-r-normal-*-*-120-*
*-p-*-*-*' follow a strange and complicated fonnat. In my experience it is best to perform 
these steps in Abaqus/CAE and look at the replay file, or perform them within a macro 
and then look at the Python script generated. This will give you the font String that you 
requtre. 

hon Seript to combine tlie dutput databases 
-------------------------------The following listing is the completed Python script to read the output databases of the 

original and restart analyses, and combine them to produce a new .odb with the results of 
both. Once this .odb has been made, an animation of the plate bending under load and 
then springing back elastically will be written to the hard drive. You can find it in the 
source code accompanying the book in plate_ bending_ od _combine _restart.py. You can 
run it by opening a new model in Abaqus/CAE (File > New Model database > With 
Standard/Explicit Model) and running it with File > Run Script ••. 

class FieldOutputDisplacements: 

def __ init __ (self1 node_label_list, displacement_tuple_list): 
self.field_data_node_labels = node_lab@l_lis~ _ · 
self.field_data_xyz_di:splaceftlel'itS = disp~acemen(_tuple_lf.st 

f~ abaqus import • 
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element_labels_and_coords.append((element_label, 
element_connector_l, 
element_eonnector_2~ 
element_ connector _3, . 

fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step : (] 

element_connector_4)) 

no_of_field_output_ut_values = len(plateOdb.steps[ ' Load Step'].frames[e] \ 
.fieldOutputs['UT'].values) 

no_of_frames = len(plateOdb.steps[ ' Load Step ' ] .frames) 

f i eld_output_frames_load_step = [] 

for pin range(no_of_frames): 

for q in range(no_of_field_output_ut_values}: 
field_label = plateOdb.steps[ ' Load Step'] .frames[p] \ 

.fieldOutputs['UT']'.values[q].nodelabel 
field_data_x = plateOdb. steps['Load Step'].frames[p] \ 

.fieldOutputs[ 'UT'].values[q].data[e] 
field_data_y = plateOdb.steps['Load Step'] . frames[p] \ 

.fieldOutputs['UT'].values[q].data[l] 
field_data_z = plateOdb.steps('Load Step ' ].frames[p] \ 

. fieldOutputs['UT'].values(q].data(2] 

fieldoutput_node_labels_load_step.append(field_label) 
fieldoutput_node_disp_load_step.append((field_data_x, field_data_y, 

field_data_z)) 

field_output_frames_load_step \ 
.append(FieldOutputDisplacements(fieldoutput_node_labels_load_step, 

fieldoutput_node_disp_load_step)) 
fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step = [] 

#Make a list of the step times for frames of 'Load Step ' 
frame_step_times_load_step = [] 
for x in range(len(field_outpot_frames_load_step)): 

frame_step_t imes_load_step.append(plateOdb.steps['Load Step'].frames[x] \ 
.frameValue) 

fieldoutput_node_labels_springback_step ~ ~ ] 
fieldoutput_node_disp_springback_step =[] 
no_of_field_output_ut_values = len(restartOdb. steps[ ' Springback ' ].frames[e] \ 

.fieldOutputs['UT'].values) 
# Thts will be same as no_of_nodes. since translations 'UT' are obtained at the 
#nodes •• 
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r-···-----~---·-··---.,_,..·--·---·----------··----.. -----------

~ ~_of_ frames ~ len ( Ces fartodb: steps [ 'Springbac~ '].frames) 

[ held_~utput_frames_spn~.~~ack_st~p == [] · · 

! for p ~n range( no_o.f ~frames). : ·· I . . .. . .·.-- , ?, .. , · .. . ,.: . :. . . . .. . . . 
l for q , in · range.(n·o...:;f.tt-(:i~~ot,Jtput_ut_values):: . . . 
~ field.:...Irib~L ='·~'~~~artod5·,steps[ ' :;p:ringback' J .fr-~m~sLp] \ 
i .· ' ·~<· · :·"•-: · · '' · ' .. ·· . fieldO~.:~tp'uts~ 'IJT']. values[q]. nodeLabel 

fteld_d~ta x ·:::;.·~ R~st.artOdb~steps~ ··springback ··1 \ · · 
. -= :. ·: .. ' · • frames [p]. fieldOutputs[ 'UT']. values[q]. data[e] 

field_datajj · =·rre$,tartOdb. ~teps [" springback "] \ 
. ' , · . · . frames [ p] . fieldOutputs [ 'UT' ] • values [ q]. data [ 1] 

field_data_z .;.' restartOdb. steps[' Springback'] \ 
. frames[p].field0utputs['UT'].values[q].data[2] 

fieldoutp~t~node~l~bels_springback_step.append(field_label) 
fieldoutput~node_disp~springback_step.append((field_data_x. field_data_y, 

field_data_z)) 

r . . . . . 
~ # Make a list of the step ·times for frames of 'Springback ' step 
1

1 

frame_step_times~spriogback_step = [] 
for x· in range(len.(fiela_:output_frames_springback_step)): 

frame_step_times_springback_step.append(restartOdb.steps['Springback•] \ I . : :: .: ·. ' .. . .frames[x].frameValue) 

l # •••••••••• •••••• ··~·"~~ ..... ~ ............................................ . 

I # .................. *':"*·~~!:~.~~~~·*: ................. ~ ••••••••••••••••••••••••••• 
. # WRITE TO ·NEW OI:JTPUl{.OAT~BASt ~ .obB) ·· · , 

I # ***~***~**.*_*****~**'* .. · -~·~:.·t.**·~~*~·.·······~··*···.·~~*****.******** 
: import os · ~;. ·· · · · 

I if :os.path. exl'sti~·Plat~...p· astii~..:.bending_and_springback~o-db' ): l os. remove( 'l'lateJ>lasfi< _ beoiding_and_springback. odb • ) 

I new_odb· = Odb(; PI~~~- ~=~~ihg . and Spr~n~;b~ck c~bined' ; : an~lysisTitle= I • J 

1 d~scri~tion= ' '. path=' Plate;-plastic_bending_and_springback. odb' ) 
I . . 

f pla(e_part = Part', embeddedSpac~=THREE_D, b ·: . type=DEFORMABLE_BOD_v_> __ _ 
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del element_labels_and_coords 

# Instance the part 

# Create a step 'Load Step' 

load_step • new_odb.Step(na.e ='Load Step', 

# Create fra.es with nodal displacements 
for i in range(len(field-output_fra~~~es_load_stepl} : 

single_fra.e_load_step • load_step.Frame(incrementNumber=i, 
f~ameValue~rame_step~times_load_step£t]~ · 
description=' ') 

. disp_field_load_step a single_frame_load_step.FieldOutput(name='gT', 
desc-ription='Displacements and -trans-' , 
type:VECJ!OR) 

disp_field_load_step.addData(position=NOOAL~ instance=plate_instarice, 
labels-field_output_f~ames_load~step[i].~ield_data_node_1~~ls~ 
data=field_outpirt_frames_load_step( 1] • field_data_xyz_displacements) 

del field_output~fra.es_load_step 
del frame_step_t~s_load_step · 

# treate a step 'Springback' 
sprlngback_step • new_odb.Step(na.e = 

# Create frames with nodal displaceaents 
for 1 in range(len(field_output_frames_springbaelc_step)Y: · · 

single_frame_springback_step • sprinpaclc_step.Frame(inc.rementNumber=i, · . 
frameVal~e~r~_step_times_spriegbac~_step£!],. 
description= • ' ) . · . _ 

disp_field_springback_step • s:l.ngle_frame_.sproingbcu;k_s~~P \ · 
.FieldOutput(naae=·ur·~ 

descripUon~'DisplacetJiellts and tr~:ns', 
type::t'lECT.OR) . . · .. · . · : 

dlsp~field_springback_step.addData(posi~ion~AL, 
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17.8 Examioing,the Scri)Jt 
Let's take a closer look at this script. 

17 .8.1 C'-. Definition. 
This block creates a class. 

# ************************************************************************ 
I # CLASS DEFINITION 
I # ************************************************************************* I 
1 class FieldOutputDisplacements: 

def __ init __ (self, node_label_list, displacement_tuple_list): 
self.field_data_node_labels = node_label_list 
self.field_data_xyz_displacements = displacement_tuple_list 

# ************************************************************************ 

You learnt about classes in Chapter 3, section 3.7. Now you see an example of a class in 
action. We will use instances of this class as a container for nodal displacements. Each 
frame of the analysis (both load step and springback step) will have one instance of this 
class associated with it, containing the node labels and displacements for that frame. 

class FieldOutputDisplacements: 

The class keyword indicates the beginning of a class which we name 
FieldOutputDisplacements. 

def __ init __ (selfJ node_label_list, displacement_tuple_list): 

This class has one function definition, identified by the keyword def. The function is 
called _init__, and in Python any function in a class with the name _init_ is an 
initialization function and will be called the moment an object of that class is created. It is 
similar to a constructor in C, C++, Java, C# and a host of other object oriented language, 
although technically speaking there are some differences (but we won't go into that in 
this book as it is of no consequence to us). 

The first argument in the function definition is self. self is a reference to the instance of 
the object that has called the method. It is similar to the this keyword in C++. Jn Python 
every function (or more accurately every non-static function) in a class must have self as 
its first argument. Strictly speaking you don't have to name it self and could give it 



17.8 Examining the Script 493 

another name, however self is accepted as convention in the Python world and it would 
make your code much less readable to other Python programmers or script writers if you 
used some other name. 

The next 2 arguments node_label_list and displacement_tuple_list are expected to be 
passed to the object when an instance is first created. 

self.field_data_node_labels = node_label_list 
self.field_data_xyz_displacements = displacement_tuple_list 

These statements assign the values passed as the arguments node_label_list and 
displacement_tuple_list to the objects variables field data node labels and 
tield_data_xyz_displacements. Thus every instance of the FieldOutputDisplacemcnt 
will be supplied a list of node labels and a list of x, y and z displacement tuples, and these 
will be stored m the instance' s field data node labels and 
field_data_xyz_displacements variables. Later in the script we will create an instance of 
this FieldOutputDisplacementsO class for each frame of the analysis to store the node 
labels and displacements associated with it. 

The following block obtains information from the output databases. 

I # ************************************************************************ 

I 
# READ EXISTING OUTPUT DATABASE (.ODB) 
# ************************************************************************ 

I plate_Odb_Path = 'PlateJobPlastic.odb' 
i plateOdb = session .openOdb(name=plate_Odb_Path) 

restart_Odb_Path = 'PlateSpringbackJob.odb' 
restartOdb = session.openOdb(name=restart_Odb_Path) 

node_labels_and_coords = [] 
# This will hold node labels and coordinates as 
# [(labell, xcoordl, ycoordl, zcoordl), (label2, xcoord2, ycoord2, zcoord2), ..• ] 
no...:of_nodes = len(plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'] \ 

.values[e].instance.nodes ) 

fori in range(no_of_nodes): 
node_label=plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'] \ 

.values[l].instance.nodes[i].label 
node_x_coord = plateOdb.steps['Load Step'].frames[l] . fieldOutputs[ ' UT ' ] \ 

.values[e].instance.nodes[i] . coordinates[e] 
L---~-~~.=-Y _c_oor~-~-pl~_!~~~-~:.~!_ep~_[_Lo~~-· St ep']. frames [ 1]. fieldOutputs ['UT'] ~--·--------
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.values[e].instance.nodes[i].coordinates[l] 
node_z_coord = plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'] \ 

.values(e).instance. nodes[i].coordinates[2] 

node_labels_and_coords.append((node_label, node_x_coord, node_y_coord, 
node_z_coord)) 

element_labels_and_coords = [] 
# This contains element labels and connectivity 
# (label, connl, conn2, conn3, conn4) 
no_of_elements = len(plateOdb.steps('Load Step'].frames[l} \ 

.fieldOutputs['UT'].values[e].instance.elements) 

for j in range(no_of_elements): 
element_label = plateOdb.steps['Load Step'].frames[e].fieldOutputs['UT'] \ 

.values[e).instance.elements[l].label element_connector_l = plateOdb.steps['Load Step'].frames[e) \ 
.fieldOutputs['UT ' ].values[e].instance.elements[j].connectivity[e] element_connector_2 = plateOdb.steps['Load Step'].frames(e] \ 
. fieldOutputs['UT'].values[e].instance.elements[j].connectivity[lJ 

element_connector_3 = plateOdb.steps['Load Step'].frames[e] \ 
.fieldOutputs('UT'].values[e) . instance.elements[j].connectivity[2] element_connector_4 = plateOdb.steps('Load Step'].frames[e] \ 
.fieldOutputs('UT'].values[e].instance.elements[j].connectivity(3] 

element_labels_and_coords.append((element_label, 
element_connector_l, 
element_connector_2, 
element_connector_3, 
element_connector_4)) 

fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step =[] 
no_of_field_output_ut_values = len(plateOdb.steps['Load Step'].frames[e] \ 

.fieldOutputs['UT'].values) 
no_of_frames = len(plateodb.steps['Load Step ' ].frames) 

field_output_frames_load_step = [] 

for pin range(no_of_frames): 

for q in range(no_of_field_output_ut_values): 
field_label = plateOdb.steps['Load Step'].frames[p] \ 

.fieldOutputs['UT'].values[q].nodeLabel 
field_data_x = plateOdb.steps('Load Step ' ].frames(p] \ 

.fleldOutputs['UT'].values[q] . data[e] 
field_data_y = plateOdb.steps['Load Step'].frames[p] \ 

.fieldOutputs['UT'].values[q].data[l] 



I 

17.8 Examining the Script 495 

fieldoutput_node_labels_load_step.append(field_label) 
fieldoutput_node_disp_load_step.append((field_data_x, field_data_y, 

field_data_z)) 

field_output_frames_load_step \ 
.append(FieldOutputDisplacements(fieldoutput_node_labels_load_step, 

fieldoutput_node_disp_load_step)) 
fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step = [] 

#Make a list of the step times for frames of 'Load Step' 
frame_step_times_load_step = [] 
for x in range(len(field_output_frames_load_step)): 

frame_step_times_load_step.append(plateOdb.steps['Load Step'].frames[x] \ 
.frameValue) 

I fieldoutput_node_labels_springback_step = [] 
I fieldoutput_node_disp_springback_step =[] · 

I 
no_of_field_output_ut_values = len(restartOdb.steps['Springback'].frames[e] \ 

.fieldOutputs['UT'].values) 
, # This will be same as no of nodes since translations 'UT' are obtained at the I # nodes.. - -

! no_of_frames len(restartOdb.steps['Springback'].frames) 
i 

I
' field_output_frames_springback_step = [] 

for pin range(no of frames): I - -
I 

I 

I 

for q in range(no_of_field_output_ut_values): 
field_label = restartOdb.steps['Springback').frames[p] \ 

.fieldOutputs['UT'].values[q].nodeLabel 
field_data_x = restartOdb.steps['Springback'] \ 

.frames[p].fieldOutputs['UT'].values[q].data[e) 
field_data_y = restartOdb.steps['Springback'] \ 

.frames[p].fieldOutputs['UT'].values[q].data[l] 
field_data_z = restartOdb.steps['Springback'] \ 

.frames[p].field0utputs['UT'].values[q].data[2] 

fieldoutput_node_labels_springback_step.append(field_label) 
fieldoutput_node_disp_springback_step.append((field_data_x, field_data_y, 

field_data_z)) 

I field_output_frames_springback_step \ 
i .append(FieldOutputDisplacements(fieldoutput_node_labels_springback_step, 

L fieldoutput_node_disp_springback_step)) 'I 
fieldoutput_node_labels_springback_step = [] 
~..:.~~-~utput_~~~-~=~~-~=~r~.~~-~-~-~=-s_!.:_e._:_J .L______ ---·--------··----· 
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Make a list of the step times for frames of 'Springback' step 
rame_step_times_springback_step = [] 
or x in range(len(field_output_frames_springback_step)): 

frame_step_times_springback_step.append(restartOdb.steps['Springback'] \ 
------------ . frames (_~!rameValue) 

plate_Odb_Path = 'PlateJobPlastic.odb' 
plateOdb = session.openOdb(name=plate_Odb_Path) 

restart_Odb_Path = 'PlateSpringbackJob.odb' 
restartOdb = session.openOdb(name=restart_Odb_Path) 

You once again use the session.openOdbO method which was first encountered and 
explained in the Cantilever Beam example, section 4.3.14 on page 89. Here we open the 
two .odbs created by the original analysis and the restart analysis and assign them to the 
variables 'plateOdb' and 'restartOdb'. 

node_labels_and_coords = [J 
# This will hold node labels and coordinates as 
# ((labell, xcoordl, ycoordl, zcoordl), (label2, xcoord2, ycoord2, zcoord2), ••• ] 
no_of_nodes = len(plateodb.steps['Load Step'].frames[l) .fieldOutputs('UT'] \ 

.values[e].instance.nodes) 

for i in range(no_of_nodes): 
node_label=plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'] \ 

.values[l].instance.nodes[i].label 
node_x_coord = plateOdb.steps['Load Step ' ].frames[l].fieldOutputs['UT'} \ 

.values[e].instance.nodes[i].coordinates[e] 
node_y_coord = plateOdb.steps['Load Step').frames(l].fieldOutputs('UT'] \ 

.values[e].instance.nodes[i].coordinates[l] 
node_z_coord = plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'] \ 

.values[e].instance.nodes[i].coordinates[2] 

node_labels_and_coords.append((node_label, node_x_coord, node_y_coord, 
node_z_coord)) 

In order to reconstruct the plate in a new output database we will need its nodal 
coordinates from this output database. What we need are the node labels, and the x, y and 
z coordinates of the nodes. We will store these in the variable node_labels_and_coords 
as a list of tuples ie [(labell, xcoordl, ycoordl, zcoordl), (label2, xcoord2, ycoord2, 
zcoord2), ... ] 



17.8 Examining tbe Script 497 

The nodes of the part instance can be accessed using plateOdb.stepsi'Load 
Step'].frames(l].fieldOutputs['UT'].values(O].instance.nodes, and we can use the lenO 
method to get the number of nodes in the part. 

We then access the label ofthe i'th node using 

plateOdb.steps['load Step'].frames[l].fieldOutputs[ ' UT'].values[l).instance 
.nodes[i].label 

and the x, y and z coordinates of the i 'th node using 

plateOdb.steps['load Step').frames(l).fieldOutputs['UT').values[B].instance 
.nodes[i].coordinates{e] 

plateOdb.steps['load Step'].frames[l].fieldOutputs['UT'].values[B].instance 
.nodes[i].coordinates[l] 

plateOdb.steps['Load Step'].frames[l].fieldOutputs['UT'].values[B].instance 
.nodes[i].coordinates[2] 

Finally we use the appendO method to append these to the list. 

element_labels_and_coords = [] 
# This contains element labels and connectivity 
# (labelJ connlJ conn2, conn3, conn4) 
no_of_elements = len(plateOdb.steps['Load Step').f~ames[l] \ 

.fieldOutputs['UT'].values[e].instance.elements) 

for j in range(no_of_elements): 
element_label = plateOdb.steps['Load Step'].frames[e].fieldOutputs['UT') \ 

.values[e].instance.elements[l].label 
element_connector_l = plateOdb.steps['Load Step'],frames[e) \ 

.fieldOutputs['UT'].values[B].instance.elements[j].connectivity[9] 
element_connector_2 = plateOdb.steps['Load Step'].frames[9] \ 

.fieldOutputs['UT').values[B].instance.elements[j].connectivity[l] 
element_connector_3 = plateOdb.steps['Load Step'].frames[B] \ 

.field0utputs['UT ' ].values[9].instance.elements[j].connectivity[2] 
element_connector_4 = plateOdb.steps('Load Step'].frames[e) \ 

.field0utputs['UT'].values[9].instance.elements[j].connectivity[3] 

element_labels_and_coords.append((element_label, 
element_connector_l, 
element_connector_2, 
element_connector_3, 
element_connector_4)) 

We repeat a similar process for the elements. The data required for the elements when 
building a new output database is the label and the connectivity of the elements ( 4 
connectors nodes of the rectangular element). 
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We access the label of the j'th element using 

element_label = plateOdb.steps['Load Step'] .frames[e].fieldOutputs('UT']. 
values[e] . instance.elements[l).label 

and the first connector of the j ' th node using 

element_ connector _1 = plateOdb. steps ['Load Step']. frames [0]. fieldOutputs[ 'UT·] 
.values[e].instance.elements[j].connectivity[e] 

Jn the statements 

fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step =[] 

we store the labels of the nodes corresponding to field outputs in 
fieldoutput_node_labels_load_step in the form (/abe/1, labe/2, ... ) and the x, y and z 
displacements for a frame in the load step injieldoutput_node_disp _load_step in the form 
((UT-x_ l , UT-y_l , UT-z_l), (UT-x_2, UT-y_2, UT-z_2), .. .) 

no_of_field_output_ut_values = len(plateOdb.steps['Load Step'].frames[e] \ 
.fieldOutputs['UT'].values) 

The displacement (UT) values can be accessed using plateOdb.steps['Load 
Step'].frames[O).fieldOutputsr'UT').values. The number of values available in the 
output database is obtained by using the lenQ method on it. Since nodal displacement is 
stored for the nodes, this number will be the same as the number of nodes in the part 
instance. 

no_of_frames = len(plateOdb.steps['Load Step'].frames) 

We find the number of frames in the load step for use in a loop. 

field_output_frames_load_step = [] 

This variable will hold a list of FieldOutputDisplacements objects (the class we created 
at the beginning of the script). 

for p in range(no_of_frames): 

for q in range(no_of_field_output_ut_values): 
field_label = plateodb.steps['Load Step'].frames[p] \ 

.fieldOutputs['UT'].values[q].nodeLabel 
field_data_x = plateOdb.steps['Load Step'].frames[p] \ 
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.fieldOutputs['UT'].values[q].data[e] 
field_data_y = plateOdb.steps['load Step'].frames[p] \ 

.fieldOutputs['UT'].values[q].data[l] 
field_data_z = plateOdb.steps['Load Step'].frames[p] \ 

.field0utputs['UT'].values[q].data[2] 

fieldoutput_node_labels_load_step.append(field_label) 
fieldoutput_node_disp_load_step.append((field_data_x, field_data_y~ 

field_data_z)) 

field_output_frames_load_step \ 
.append(FieldOutputDisplacements(fieldoutput_node_labels_load_step~ 

fieldoutput_node_disp_load_step)) 
fieldoutput_node_labels_load_step = [] 
fieldoutput_node_disp_load_step = [] 

The inner loop extracts the node labels and the x, y and z displacements for each fTame. 
These are placed m the variables fieldoutput_node_labels_load_step and 
fieldoutput_ node_ disp _load_ step. 

The outer loop runs through all the frames of the load step. For each frame it uses the 
node labels and data gathered by the inner loop to create a FieldOutputDisplacements 
object which it adds to the variable field_output_frames_load_step. 

# Make a list of the step times for frames of 'load Step' 
frame_step_times_load_step = [] 
for x in range(len(field_output_frames_load_step)) : 

frame_step_times_load_step . append(plateodb.steps['Load Step'] .frames[x] \ 
.frameValue)) 

We need to know the step times of the frames. We obtain these using 
plateOdb.steps['Load Step').frames[x).frameValue where x is the frame number, and 
store them in the variable frame_step_times_load_step for use when constructing the 
new odb. 

fieldoutput_node_labels_springback_step = [] 
fieldoutput_node_disp_springback_step =[] 
no_of_field_output_ut_values = len(restart0db.steps['Springback'].frames[9] \ 

.fieldOutputs('UT'].values) 
# This will be same as no_of_nodes since translations 'UT' are obtained at the 
# nodes •• 

no_of_frames = len(restartOdb.steps['Springback'].frames) 

field_output_frames_springback_step = [] 

for p in range(no_of_frames) : 
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for q in range(no_of_field_output_ut_values): 
field_label = restartOdb.steps('Springback'].frames[p] \ 

.fieldOutputs['UT'].values[q].nodeLabel 
field_data_x = restartOdb.steps['Springback'] \ 

.frames[p].field0utputs('UT'].values[q].data[9] 
field_data_y = restartOdb.steps['Springback'] \ 

.frames[p].fieldOutputs['UT'].values[q] .data[l] 
field_data_z = restartOdb.steps[ ' Springback') \ 

.frames[p].fieldOutputs['UT').values[q].data[2] 

fieldoutput_node_labels_springback_step.append{field_label} 
fieldoutput_node_disp_springback_step.append((field_data_x~ field_data_y~ 

field_data_z)) 

field_output_frames_springback_step \ 
.append(FieldOutputDisplacements(fieldoutput_node_labels_springback_step, 

fieldoutput_node_disp_springback_step)) 
fieldoutput_node_labels_springback_step = [] 
fieldoutput_node_disp_springback_step = [] 

# Make a list of the step times for frames of 'Springback' step 
frame_step_times_springback_step = [] 
for x in range(len(field_output_frames_springback_step)): 

frame_step_times_springback_step.append(restartOdb.steps['Springback'] \ 
.frames[x].frameValue) 

The same task is repeated for the frames of the 'springback' step. The code has just been 
copied and suitable modified. 

This block writes the new output database containing the desired contents of the two 
existing output databases. 

# ************************************************************************ 
#WRITE TO NEW OUTPUT DATABASE (.008) 
# ************************************************************************ 

import os 

if os.path.exists('Plate_plastic_bending_and_springback.odb'): 
os . remove{'Plate_plastic_bending_and_spri ngback.odb') 

new_odb = Odb('Plate Bending and Springback combined', analysisTitle=' ', 
description='', path='Plate_plastic_bending_and_springback.odb') 

plate_part = new_odb.Part(name='Plate Part ' , embeddedSpace=THREE_D, 
type=DEFORMABLE_BODY) 
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~--------···-·· .. -·····-···---···········-·- ·-···--··-······--·-............. __ ,,, ...•.•....• -........ _ ,,_,, .................................................................................. _,, _,,, ....... ________________ , , , .............. --... -----·-··-----·--·--···--·----···-----··-·-··--····----, 
i plate_part.addNodes(nodeData=node_labels_and_coords, nodeSetName='node set") 
I del node_labels_and_coords 
I 
l plate_part.addElements(elementData=element_labels_and_coords, type='S4R', 
I elementSetName='element set') 
i del element labels and coords I - - -
! 
j # Instance the part 

I plate_instance = new_odb.rootAssembly.Instance(name='Plate Instance', 
: object=plate_part) 

# Create a step 'Load Step' 

load_step = new_odb.Step(name 'Load Step', description='', domain=TIME, 
timePeriod=l. e) 

# Create frames with nodal displacements 
for i in range(len(field_output_frames_load_step)); 

single_frame_load_step = load_step.Frame(incrementNumber=i, 
framevalue=frame_step_times_load_step[i], 
description='') 

disp_field_load_step single_frame_load_step.FieldOutput(name='UT ' , 
description='Displacements and trans', 
type=VECTOR) 

disp_field_load_step.addOata(position=NODAL, instance=plate_instance, 
labels=field_output_frames_load_step[i].field_data_node_labels, 
data=field_output_frames_load_step[i].field_data_xyz_displacements) 

:

1

· del field_output_frames_load_step 
del frame_step_times_load_step 

I 

I # Create a step 'Springback' 
1 springback_step = new_odb.Step(name 
i 
i 

'Springback', description=' ', domain= TIME, 
timePeriod=l. B) 

I # Create frames with nodal displacements 
! for i in range(len(field_output_frames_springback_step)) : I single_frame_springback_step = springback_step.Frame(incrementNumber=i, 
i frameValue=frame_step_times_springback_step[i], 
I description='') 

I
. disp_field_springback_step = single_frame_springback_step \ 

.FieldOutput(name='UT', 
1 

description=' Displacements and trans', 
i type=VECTOR) I 

L~~~E_~i~_!~-~-~~~~b~~~--=~!~e.~-.~~-~~-~!~1~~-~~_:tion=NODAL, instance=plate_instan~-~-----·--__1 
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labels=field_output_frames_springback_step[i].field_data_node_labels, 
data=field_output_frames_springback_step[i].field_data_xyz_displacements) 

I del field_output_frames_springback_step 
del frame_step_times_springback_step 

# Make this the default field for visualization 
load_step.setDefaultDeformedField(disp_field_load_step) 

# Save the odb in order to reopen it in abaqus/viewer 

new_odb. save() 
new_odb. close() 

~************************************************************************ 

import os 

if os.path.exists('Plate_plastic_bending_and_springback.odb'): 
os.remove('Plate_plastic_bending_and_springback.odb') 

os.path is a Python module that implements many useful functions on pathnames. One of 
the methods it provides is existsO which accepts a path as its argument and returns True 
if the argument refers to an existing path (and False if it does not). 

os is a Python module that allows a program to use operating system dependent 
functionality. One of the functions it provides is removeO which accepts a path as an 
argument and deJetes the fiJe at that path. Note that on Microsoft Windows, if a file is in 
use this statement will raise an exception. 

new_odb = Odb('Plate Bending and Springback combined ' , analysisTitle='', 
description='', path='Plate_plastic_bending_and_springback.odb') 

An Odb object represents an output database file. Here we use the OdbO method to 
create an Odb object, or more importantly a new .odb file. The only required argument of 
the OdbO method is name which is a String specii)ring the repository key. analysisTitle 
is a String specifYing the title of the output database, description is a String specifying its 
description, and path is a String specifying the path to the new .odb file. We create a new 
output database file with the delightfully creative name 
'Plate_plastic_bending_and_springback.odb' and assign it to the variable new_odb so we 
can refer to it later in the script. 
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plate_part = new_odb.Part(name='Plate Part', embeddedSpace=THREE_D, 
type=DEFORMABLE_BODY) 

The PartO method is used to create a part object. You've used this method in almost 
every script written so far and were first introduced to it in Section 4.3 .3 on page 68. 
However that PartO was a method of the Part object. This one on the other hand is a 
method of OdbPart, and therefore creates an OdbPart object which is similar to the 
kernel Part object in that it contains nodes and elements, however it does not contain 
geometry. The OdbPart object created by it does not have nodes and elements at this 
stage, and can be added Jater. Using this method, we tell Abaqus to create a part in the 
new output database by using the dot notation and our output database variable new_ odb. 
This odb part is assigned to the variable plate _part. 

plate_part.addNodes(nodeData=node_labels_and_coords, nodeSetName='node set') 
del node_labels_and_coords 

addNodesO is a method of the OdbPart object. The addNodesO method adds nodes to 
this OdbPart object. Its required argument is nodeData which is a sequence of tuples 
specifying the node labels and coordinates in the form ((labeJI ,x 1, y 1, z I), (label2, x2, 
y2, z2), ... ) which is exactly how we have formatted our data into the 
node_labels_and_coords variable. It also has an optional argument nodeSetName 
which is a String specifying a name for this node set. Here we use addNodesO to add the 
node data we obtained from the first output database (which will be the same as the node 
data from the second output database since the exact same part was used in the restart 
analysis). 

We then use Python's del keyword to delete the variable and free up some memory. This 
may not be too important for a small .odb file like the one we are using but for 
simulations with very large .odbs you might be keen to free up as much memory as 
possible when you can. 

plate_part.addElements(elementData=element_labels_and_coords, type='S4R', 
elementSetName='element set') 

del element_labels_and_coords 

This time we add element data to the new output database. addEiementsO is also a 
method of the OdbPart object, and adds elements to it. lt has 2 required arguments - the 
first one is elementData which is a sequence of sequences of Ints specifYing the element 
labels and nodal connectivity in the form ((labe/1, cl_J, c1_2, c1_3, c1_4), (labe/2, c2_1, 

c2_2, c2_3, c2_4), .. .) which is precisely how we formatted our element data into the 
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element labels and coords variable. The second required argument is type which is a - - -
String specifying the element type, which in our case we know to be 'S4R' hence we 
hard coded this into the program. However you could extract the element type using the 
script, by picking any random eleent, let's say element 50, using 

prettyPrint(plateOdb.steps('Load Step'].frames(a].fieldOutputs('UT'].values[e] 
.instance.elements[se]) 

We then delete element_labels_and_coords to free up some memory. 

# Instance the part 
plate_instance = new_odb.rootAssembly.Instance(name='Plate Instance', 

object=plate_part) 

The InstanceO method is used to create an instance of a part in an assembly. You've 
used rootAssembly.lnstaoceO in almost all the scripts so far, and it was first 
encountered in Section 4.3.6 on page 74. However that InstanceQ method was from the 
Partlostance object. This lnstanceO method is a method of the Odblostance object and 
is a little different. It copies a Partlnstance object from a specified model and creates a 
new Partlnstance object. It has 2 required arguments, name, which is a String 
specifying the repository key, and objectToCopy, which is the Partlnstance object to be 
copied. We te11 Abaqus to create an instance in the new output database by using the dot 
notation, our output database variable new_odb, and our previously created 
Partlnstance object plate _part. This instance is assigned to the variable plate_instance. 

load_step = new_odb.Step(name = 'load Step' , description='', domain=TIME, 
timePeriod=l.e) 

The StepQ method used here is similar to StaticStepQ, ExplicitDynamicStepO and 
HeatTransferStepO that you have used in previous scripts, except that it creates an 
OdbStep object instead of a Step object. lt has 3 required arguments - name, 
description and domain. name is a String specifYing the repository key, description is a 
String specifying the step description, and domain is a SymbolicConstant specifYing the 
domain of the step with possible values ofTIME, FREQUENCY, ARC_LENGTH, and 
MODAL. timePeriod is an optional argument, and it is a Float specifying the time 
period of the step. lt is required if domain=TIME. 

# Create frames with nodal displacements 
for i in range(len(field_output_frames_load_step)) : 
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single_frame_load_step = load_step.Frame{incrementNumber=i, 
frameValue=frame_step_times_load_step[i], 
description= I I ) 

disp_field_load_step = single_frame_load_step.Field0utput(name= 1 UT', 
description= 1 Displacements and trans~, 
type=VECTOR) 

disp_field_load_step.addData(position=NODAL, instance=plate_instance, 
labels=field_output_frames_load_step[i].field_data_node_labels, 
data=field_output_frames_load_step[i].field_data_xyz_displacements) 

In this for loop, we create a new frames for the OdbStep object using the FrameO 
method. FrameO creates an OdbFrame object. It has 2 required arguments, 
incrementNumber, which is an lnt specifying the frame increment number within the 
step, and frameValue, which is a Float specifying the step time, frequency or mode 
depending on whether you are in the time, frequency or mode domain. Since we are in 
the time domain, frame Value is the step time. description is an optional argument and it 
is a String specifying the contents of the frame. Here we give the frames the same 
number as the loop counter since we are counting over the total number of frames the 
step should have, and for frameValue we use the step times we had col1ected earlier 
when reading in the odb. The FrameO method returns an OdbFrame object which we 
store in the variable single_frame_load_step. 

A FieldOutput object contains field data for a specific output value. The FieldOutputO 
method is used to create a FieldOutput object. FieldOutputO has 3 required arguments 
- name, which is a String specifying the output variable name, description, which is a 
String specifYing the output variable, and type, which is a SyrnbolicConstant specifYing 
the output type with possible values of SCALAR, VECTOR, TENSOR_3D_FULL, 
TENSOR_3D_PLANAR, TENSOR_3D_SURFACE, TENSOR_2D_PLANAR and 
TENSOR_2D_SURFACE. Here we create a field output named 'UT' of type 
VECTOR. 

The addDataO method adds data to a FieldOutput object. It has 4 required arguments -
position, instance, labels and data. position is a SymbolicConstant which specifies the 
position of the output. Since our displacement data is calculated at the nodes, we use 
NODAL. Other possibJe options are INTEGRATION_POINT, ELEMENT_NODAL 
and CENTROID. jnstance is an Odblnstance object which specifies the namespace for 
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the labels. labels is a sequence of lnts which specifies the labels of the nodes (or 
elements) where the values in data are stored. The nodes (or element) labels must be 
sorted in ascending order, and must be in the same order as the values in data. data is a 
sequence of sequences of Floats specil)'ing the data values. 

del field_output_frames_load_step 
del frame_step_times_load_step 

We delete these variables to free up space since they are no longer required. 

# Create a step 'Springback' 
springback_step = new_odb.Step(name = 'Springback', description='', domain=TIME, 

timePeriod=l.9) 

# Create frames with nodal displacements 
for i in range(len(field_output_frames_springback_step)): 

single_frame_springback_step = springback_step.Frame(incrementNumber=i, 
frameValue=frame_step_times_springback_step[i], 
description=' ') 

disp_field_springback_step = single_frame_springback_step \ 
.FieldOutput(name='UT', 

description='Displacements and trans', 
type=VECTOR) 

disp_field_springback_step.addData(position=NODAl, instance=plate_instance, 
labels=field_output_frames_springback_step[i].field_data_node_labels, 
data=field_output_frames_springback_step[i].field_data_xyz_displacements) 

del field_output_frames_springback_step 
del frame_step_times_springback_step 

We repeat the procedure for the 'springback' step. 

# Make this the default field for visualization 
load_step.setDefaultDeformedField(disp_field_load_step) 

The setDefaultDeformedFieldO method is used to set the default defonned field 
variable in the step passed to .it as an argument. When the odb is opened in 
Abaqus/Viewer and the defonned shape is plotted. it is the default deformed variable that 
will be plotted unless the analyst instructs Abaqus to plot another field output. 

new_odb.save() 
new_odb. close() 

The output database is saved using the saveO method, which allows it to later be opened 
again. It is then closed using the closeO method. 
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17~8~4-~-:.c~at~Jhe:anim~tiin .using::the ~w:·out'p~t7database. ' ~ ... ~~ -.. • ~ •• ;wJO~ ... '"-.,:-. ...;:;.~,;: "~' ~ i!: ~ ~-..;,;: 

This block creates the animation using the frames of the new output database. 

~ ************************************************************************ 

1

1: : ~~;~!;.~~.~!~!!~~***************************************************** 
import visualization 
import animation 

I
. plate_Odb_Path = 'Plate_plastic_bending_and_springback.odb' 

odb_object = session.openOdb(name=plate_Odb_Path) 

session.viewports['Viewport: l ' ].setValues(displayedObject=odb_object) session .viewports['Viewport: l'].odbDisplay.display \ 
.setValues(plotState={CONTOURS_ON_DEF, )) session .viewports['Viewport: l'].odbDisplay \ 

.setPrimaryVariable(variableLabel='UT ', 
outputPosition=NODAL, 
refinement=(COMPONENT, 'UT3'),) 

session.animationController.setValues(animationType=TIME_HISTORY, 
viewports=('Viewport: 1', )) session.animationController.play(duration=UNLIMITED) 

session. imageAnimationOptions.setValues(vpDecorations=ON, vpBackground=OFF, 
compass=ON, timeScale=l) session.writeimageAnimation(fileName= 'plate_bend_springback_animation', 

format=AVI , 
--·----.... ·------------------.. ·--------- -:_~~~~ObJ~~!_S._:j_~~-~~~-~~-:~!:_~wpor..!.~l~'!i~~po!:!_:_!::.l~.H ____________ _ 
import visualization 
import animation 

plate_Odb_Path = 'Plate_plastic_bending_and_springback.odb' 
odb_object = session.openOdb(name=plate_Odb_Path) 

session.viewports['Viewport : l'].setValues(displayedObject=odb_object) session.viewports['Viewport: l'].odbOisplay.display \ 
,setValues(plotState=(CONTOURS_ON_DEFJ )) session.viewports['Viewport: l'].odbDisplay \ 

.setPrimaryVariable(variablelabel='UT'J 
outputPosition=NODAL, 
refinement=(COMPONENTJ 'UT3'}J) 

All of these statements should be familiar to you by now except the second import 
statement which is required to use the AnimationController object. 

session.animationController.setvalues(animationType=TIME_HISTORYJ 
viewports=('Viewport: 1', )) 
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The AnimationController object controls the object-based animations in the viewport. 
Jts setValuesO method has two optional arguments - animationType and viewports. 
animationType is a SymbolicConstant specifying the type of movie that should be 
played, with possible values of SCALE_FACTOR, HARMONIC, TIME_IDSTORY 
and the default of NONE. viewports is a sequence of pairs of Strings specifying the 
repository key of the viewport where the animation will be active followed by a layer 
name or the SymbolicConstant ALL. In our case no layer name is specified, hence the 
current layer wi 11 be used. 

session.animationController.play(duration=UNLIMITED) 

The playQ method of the AnimationController object plays the animation. It has one 
optional argument duration which is an lnt specifying how many seconds to play the 
animation, or it can be the SymbolicConstant UNLIMITED (which is the default). 

session.imageAnimationOptions.setValues(vpDecorations=ON~ vpBackground=OFF~ 
compass=ON~ timescale=l) 

The ImageAnimationOptions object stores the values and attributes associated with 
saving viewport animations. Its setValuesO method has a few optional arguments, many 
of which are used here. vpDecorations is a Boo lean specifying whether or not to include 
the viewport border and title. It defaults to ON. Here we choose ON (or leave it at 
default) so that the border and title will be included in the video. vpBackground is a 
Boolean specifYing whether or not to display the viewport background. It defaults to 
OFF. We will set it to off(or leave it at default) so that the animation will be displayed on 
a blank white background. compass is a Boolean specifying whether to include the 
compass in the video. It defaults to OFF, but here we change it to ON. timescale is an Int 
specifying the time scale to apply to the frame rate. We have not specified frameRate 
which is the final optional argument, hence Abaqus wil1 choose a frame rate, and by 
using a timescale of I we leave this framerate unchanged. 

session.writeimageAnimation(fileName='plate_bend_springback_animation', 
format=AVI, 
canvasObjects=(session.viewports['Viewport: 1 ' ]~ )) 

writelmageAnimationO is a method of the session object. It creates an animation file. It 
has 2 required arguments - fileName which is a String specifying the name of the 
animation file to generate (and this can be a full path), and format which is a 
SymbolicConstant specifying the format of the generated file with possible values of 
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A VI, QUICKTIME, VRML and COMPRESSED_ VRML. 1t also has one optional 
argument- canvasObjects- a sequence specifYing the canvas objects to capture. We tell 
it to capture 'Viewport: 1' which is where the animation is displayed. 

17.9-:: ·summary ~- . 
r.,: .. .r. -~~""""'"""'~~ . -......"""""' .......... """' 

In this chapter we extracted data from 2 existing output databases and created a new one 
using this information. You now have a firm understanding of not only how to extract 
information from output databases using a Python script, but also how to construct one 
from scratch. Using this technique you can create output databases that contain only what 
you need - either for further processing tasks or to help you or another analyst visualize 
specific results. 



18 -
Monitor an Analysis Job and Send an 

Email when Complete 

18.1 Introduction 
A single analysis job in Abaqus can take hours or even days to run. Multiple jobs running 
as part of an optimization routing can take a considerable amount of time to execute. Jt is 
possible to write a script that monitors a job and provide updates to the analyst. 

In this example we shall monitor the running of the Cantilever Beam example from 
Chapter 4. We shall detect when the job completes or aborts. We will then log into a 
Gmail account, and send an email to another address informing the analyst that the job 
has either completed running or quit with errors. 

18.2 Methodology 
In our original Cantilever Beam script we submit the job and then wait for it to complete 
using the WaitForCompletionO function . On completion, program control returns to the 
script and subsequent statements, in our case post processing statements, are executed. 

We will no longer use the waitForCompletionO function. Instead we will use the 
addMcssageCallbackO function of the MonitorMgr object provided by Abaqus to 
monitor messages generated by Abaqus during the analysis. Every time a message is 
generated a function jobMonitorCallbackQ,defined by us, will be called, which will 
check the type of the message. Jf the message type is either ABORTED or 
COMPLETED it will call another function postProcessO, also defined by us, to log into 
Gmail's SMTP server and send an email indicating that the job has been completed (or 

aborted). 
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[s:~i~lli6~~··scriP.t""'.,. ... , 
~. " ... ,..,.~.~;,t.;J. ,J'...,,_~~· to' -

The following listing is the completed Python script to accomplish this. You can find it in 

the source code accompanying the book in job_monitor_and_email.py. You can run it 

by opening a new model in Abaqus/CAE (File > New Model database > With 
Standard/Explicit Model) and running it with File > Run Script ... 

l'-'·"'"'a"nc=··· BearnOefl:ettionJob' ~ 
mess·ag~Type=AN*_HESSAGE_liYPE, 
eallb~tk=jobMonitorCallbac~, 

. ,_ userOata=None) 

1 !I") 



~
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/ 

#Specify the email sub)~' sender and' receipi~nt 
msg[ 'Sul)ject'] = s&li!Jfect 
msg('From'] • sen8er 
msg('To'] = recipient . 

# Gmail username (SMTP usern~) 
pail_userna.e • 'atiaquspython' 

# Gnla11 password (SMTP password) 
gmail_password = •xxxxx • 

# IdentifY ourselves to the ESMTP server using EHLd. 
sesslon.ehlo() 

I Call EHLO again 
session.ehlo() 

# Login to the server using SMTP. login() 
session.login(e-ail_userna.e~ g.ail_password) 

#send the email using SMTP.send.ail() · 
session. sendllail ( seni:ler ... [ redpient] ~ msg. as _string()J -: 

1 End the session 
session.close() 

# sendEmailMessage() definition ends here 

t.pert visualization_ 
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# Assign the beam to this section 
beam_region = 'beaaPart.Eells~) 
beamPart.SectionAssignnent(~gion•beam_reg~onJ 

import assembly 

import step 

# Create a static general step 
beaiiiHodell. StaticStep( name'"' ':Apply, toad' J previous'= • I nil, ti:alr' # 

des£~iption='Load is applied during: this step') . 

# --·-----------------------------------------------~---------------------
# Create the field output request 

t change the na.e of field output request 'F-Output-1' :to '.Selected Field Outputs·' 
bea~el.fieldOutputRequests.changeKey(fromName='F-output-~·J . 

toNa.e•'Selected Fi~l~Outputs') 

# since F-OUtput-1 is applied at the 'Apply Load' step by ihffault, ·~elected 
# Field Outputs' will be too 
# we only need to set the requir,ed variables 
beaDIModel. fleldOutputRequests[ 'Selected Field Outputs'.] \; 

.setValues(variables;::('S •, 'E', · 'PEMA.'G' ~ 'U'. 

# Create the history output request 

# we try a slightly different method fi"'OII that used . in field ou~put request 
#create a new history ~utput request called 'Default· History outputs' and assign 
• both the step and the variables 
be~el. HistoryautputRequest ( na~~e•' Default History, outputs •. · 

· createStepName•'Apply Load', variables=PRESELECT) 

# n0111 delete the original history output request 
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6eamPart.generateMesh() 

# --------- ""'! --------- ~------ --- iiii;. ----. .:~---·""''-""- -
# Create alld run the job • 

import job 
from jobMessage import • 

We wilJ examine this script in a different order, rather than the top-down approach we 
usually take. This is because [ have defined the functions at the top of the script rather 
than at the locations where they are actually called. It is necessary for a function to be 
defmed before the interpreter encounters it in the script. 
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Since this script is a modified version of the original Cantilever Beam script with a few 
new functions added, only the new parts of the script will be examined, and you can refer 
back to Chapter 4 for the rest. 

The block that submits the job and calls the job monitor is displayed below: 

r-#·-~·=·==··====-=-=·= =··~=·= ·==--:==-=·=·=··=· =··=··=··=·==· =··~-·=··=·=-=·=··=·=·=·=·=·=·=-~-~-=-=·=·=-=-=·=-=-=·-=-·=-=-=---=-:=-==-=-=-=-=-=~=·--· ········-···----···--··-·····1 
I # Create and run the job 
i 
~ ~~rtj~ I 

I 
from jobMessage import * 

# create the job I mdb.Job(name='BeamDeflectionJob', model='Cantilever Beam', type=ANALYSIS, 
, explicitPrecision=SINGLE, nodalOutputPrecision=SINGLE, 
I description='Job simulates the loaded cantilever beam', 
! parallelizationMethodExplicit=DOMAIN, multiprocessingMode=DEFAULT, 
I numDomains=l, userSubroutine=' ', numCpus=l, memory=Se, 
1 memoryUnits=PERCENTAGE, scratch='·, echoPrint=OFF, modelPrint=OFF, 

contactPrint=OFF, historyPrint=OFF) 

# Monitor the job 
1 monitorManager.addMessageCallback(jobName='BeamDeflectionJob', 

messageType=ANY_MESSAGE_TYPE, 
callback=jobMonitorCallback, userData=None) 

# Run the job 
mdb.jobs['BeamDeflectionJob').submit(consistencyChecking=OFF) 

~-~~~-~~~------------ --- - ------------------------ - ----------- - -- ---
Most of these statements are almost identical to those of the Cantilever Beam example 
with a few modifications. 

from jobMessage import * 

This gives us access to the SymbolicConstants necessary for the addMessageCallbackO 
method. When we call this function, we use ANY_MESSAGE_TYPE as one of the 
arguments. The jobMessage module defines this SymbolicConstant. We could in fact 
have written the statement as 

from jobMessage import ANY_MESSAGE_TYPE 
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But I prefer not be so precise as it only complicates things. 

monitorManager.addMessageCallback(jobName='BeamDeflectionJob', 
' messageType=ANY_MESSAGE_TYPE, 

callback=jobMonitorCallback, userData=None} 

The monitorManager object is used for monitoring a job. It provides a method 
addMessageCallbackQ that tells Abaqus which function to call when a particular 
message is received from the solver. [t has 3 required arguments. 

The first is job Name which needs to be a String corresponding to the name of the job to 
monitor. If you wish to monitor al1 jobs you can use the SymbolicConstant ANY_JOB 
which is available to us from the jobMessage module. 

The second argument is messageType which is a SymbolicConstant specifying which 
type of messages will cause the callback function to be called. The options available here 
are ABORTED, ANY_JOB, ANY_MESSAGE_TYPE, COMPLETED, END_STEP, 
ERROR, HEADING, HEALER_JOB, HEALER_TYPE, INTERRUPTED, 
JTERA TION, JOB_ ABORTED, JOB_ COMPLETED, JOB _INTERRUPTED, 
JOB_SUBMlTTED, MONITOR_DATA, ODB_FILE, ODB_FRAME, 
SIMULATION _ABORTED, SIMULATION_ COMPLETED, 
SIMULATION_ INTERRUPTED, SIMULATION_ SUBMITTED, STARTED, 
STATUS, STEP and WARNING. We use ANY_MESSAGE_TYPE which causes all 
messages to call the callback function. We will then process these messages within the 
call back function itself as this allows us to deal with JOB_ COMPLETED, ABORTED 
and ERROR using just one addMessageCallbackO method. 

The third required argument is callback which is the name of the function to call when 
the specified message type is encountered. By default, this function will be called with 
jobName, message Type, data and userData as its parameters. data is useful if you are 
using MONITOR_DATA to monitor a degree of freedom during the analysis, and will 
contain information about that degree of freedom. userData, which is also an optional 
argument for addMessageCallbackO, is any Python object (or None) that you choose to 
pass to the function. You could choose, for instance, to pass a reference to the Viewport 
so that the callback function can access it. 

Notice that the waitForCompletionO method has been removed from the script. This is 
because we no longer have any statements after the submitO function and are placing all 
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the post processing tasks within another function that the callback function will execute 

one the job has been completed. We have therefore replaced the waitForCompletionO 

method with addMessageCallbackQ. 

,-------···-··-------~-------~--~-----·-·--------.----·····---··--.. -------·--··--·---····-.. ··---···-----------------··-----···---------·----------.. -------------------------------·-.. -·-··---·--·--·-··-····· 
I # -- ---------- - -- -------- --- ---- ---- -- - - - - --- - - - ---- ----- ------ -- - --------
i #Define the callback function jobMonitorCallback() 
I def jobMonitorCallback(jobName, messageType, data, userData) : 

if ((messageType==ABORTED) or (messageType==ERROR)): 
# Send an email 
sendEmailMessage("Bad news - The job has failed") 
# Stop monitoring the job 
monitorManager . removeMessageCallback(jobName= 'BeamDeflectionJob', 

elif (messageType==JOB_COMPLETED): 
# Send an email 

messagelype=ANY_MESSAGE_TYPE, 
callback=jobMonitorCallback, 
userData=None) 

sendEmailMessage("Good news -The job has finished running !! !") 
# Stop monitoring the job 
monitorManager . removeMessageCallback(jobName='BeamDeflectionJob', 

messageType=ANY_MESSAGE_TYPE, 

I 
callback=jobMonitorCallback, 
userData=None) 

, # Call post processing function 
I postProcess() 
~--- -- -----:------ - - ------- - --------- :- --------- - - ----- ------ - --- --------

As stated in the previous section, when addMessageCallbackQ calls the callback 

function - which we have named jobMonitorCallbackO - it passes to it jobName, 

messageType, data and userData as arguments. Hence our function definition includes 

these as the accepted arguments. 

An if-elifb1ock is used to check the message type and act accordingly. IfmessageType is 

ABORTED or ERROR indicating that the job was aborted or exited with an error, the 

function sendEmaiiMessageQ is called with the String "Bad news - The job has failed" 

as its argument. On the other hand if message Type is JOB_ COMPLETED indicating 

that the job completed successfully, sendEmailMessage() is called with the String "Good 

news - The job has finished running ! ! !"as its argument. Also another function we define 

- postProcessQ - is called to execute any post processing tasks such as plotting the 

deformed shape. 
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In both cases the removeMessageCallbackO method is used to put an end to the job 
monitoring. removeMessageCallbackO is the exact opposite of addMessageCallbackO 
and the callback function is no longer called when messages are received from the solver. 
The arguments supplied to it must exactly match the arguments supplied to 
addMessageCallbackQ. 

18.4.3 Derme a functioli 1o t,andl~ post proeessing · 
This block defines the function postProcessO which will handle post processing tasks. 

# ---- ----------- --------------- - - - - - --- - --------------------------- - ---
# Define a function postProcess() to display the deformed shape 
def postProcess( ) : 

# Post Processing 

import visualization 

beam_vi ewport = session.Viewport(name='Beam Results Viewport ' ) 
beam_Odb_Path = 'BeamDeflectionJob.odb' 
an_odb_object = session .openOdb(name=beam_Odb_Path) 
beam_viewport.setValues(displayedObject =an_odb_object) 
beam_viewport.odbDisplay.display . setValues(plotState=(DEFORMED, )) 

# --- - -------- ----- -- -------- --------- - ------- - - -------- - ----- - ---- - - -- - J 
The postProcessO function defined by us contains nothing new -just the post processing 
statements from the original Cantilever Beam example. All we have done is packaged 
these statements inside this function so that it can be called from our callback function 
addMessageCallbackO after the job has completed running successfully. 

This block defines a function that connects to Gmail and sends an email. 

# - ------------ --- --- - ------------------ - -------- - ----- - - --- ------ - - - - ----
# Define a function sendEmailMessage() t o send the email 
def sendEmailMessage(email_message): 

# Import Pythons smtplib in order to send emails . 
# The smtplib. SMTP class encapsulates an SMTP connection and has methods for 
# SMTP and ESMTP operations 
import smtplib 

# Import the email module requi red to send text in MIME format 
from email . mime .text import MIMEText 

sender= ' abaquspython@gmail.com ' 
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:------······--·---··-"''''""-----·-··--·········--.. ----.. ···-·····--·····-.. ··---... -................................................................................................. ~- -----···········-"''''"''''''' __ ,, ...... , ...................... -----~·-··-·-·········-----------------···-··-·· ······-······-----·--·------· ! 

recipient = 'garyofcourse@yahoo.com' 

I 
I 

I 

subject = 'Email sent from Abaqus with Python script' 
contents = email_message 

# Create a text/plain message 
msg = MIMEText(contents) 

# Specify the email subject, sender and receipient 
msg['Subject'] = subject 
msg['From'] =sender 
msg['To'] = recipient 

# This is Googles Outgoing Mail {SMTP) server 
gmail_smtp_server = 'smtp.gmail.com' 

# This is the port used by Gmail server for outgoing mail 
gmail_smtp_port = 587 

# Gmail username (SMTP username) 
gmail_username = 'abaquspython' 

# Gmail password (SMTP password) 
gmail_password = 'xxxxx' 

# Create an SMTP object. The SMTP connect() method is called using the 
# name and port. 
session = smtplib.SMTP(gmail_smtp_server, gmail_smtp_port) 

# Identify ourselves to the ESMTP server using EHLO 
session.ehlo() 

# Put the SMTP connection in Transport Layer Security (TLS) mode using 
# SMTP. starttls() so all SMTP commands that follow will be encrypted 
session . starttls() 

# Call EHLO again 
session.ehlo() 

# Login to the server using SMTP . login() 
session.login(gmail_username, gmail_password) 

# Send the email using SMTP.sendmail() 
session. sendmail(senderJ [recipient], msg.as_string()) 

# End the session 
session. close() 

I # sendEmailMessage() definition ends here 
I # - - -- -- - --- - - -:..::_-=-::=_::.: . .:..:::_:::._-=-::_.::.::_::_:_::..:-...:..::...:.: .::..::..:_:-_::..:.:.:_:_:-_- - - -- - -- - - - - - - - - - - - - - - - - - -
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The sendEmaiiMessageO function contains the Python code required to send an email. 

Since this is not a book on Python, but rather a book on writing Python scripts for 

Abaqus, I do not want to get into advanced Python programming. However I think this is 

a very cool (and also very useful) example of how you can use Python scripts to make 

your life easier. I will limit this section to a very basic explanation of what the above 

code does, and if you ever decide to implement this in one of your scripts just copy and 

paste it in. 

def sendEmailMessage(email_message): 

sendEmailmessageO accepts a String as an argument which will be used as the content 

of the email. 

import smtplib 

SMTP is Simple Mail Transfer Protocol. Python provides smtplib in order to send mail 

from a Python program. The SMTP class in smtplib encapsulates an SMTP connection 

and has functions that can be used for SMTP and ESMTP (extended SMTP) operations. 

# Import the email module required to send text in MIME format 
from email.mime.text import HIMEText 

This statement imports the email module required to send text in Multipurpose Internet 

Mail Extensions (MIME) format. MIME defines the format of the email, and most 

intemet email today is transmitted via SMTP in MJME fonnat. 

sender - 'abaquspython@gmail.com' 
recipient = 'garyofcourse@yahoo.com' 
subject = ' Email sent from Abaqus with Python script' 
contents = email_message 

Here we place the email addresses of the sender and recipient, and the subject of the 

email in variables for later use. The content of the email is obtained from email_message 
which was passed as an argument to sendEmailMessageQ. The sender email address can 

be a Gmail address that you create specifically for sending emails about Abaqus jobs, 

since the email have to be sent from somewhere. The recipient email address will be the 

em ail address of the analyst conducting the study. 

# Create a text/plain message 
msg = MIMEText(contents) 
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The MIMEText class provided by Python is used to create MIME objects. Here we are 
giving it the String contained in the variable contents. When we pass msg to the 
sendmaiiO function, this String will form the body of the email. 

# Specify the email subject~ sender and receipient 
msg('Subject'] = subject 
msg('From'] = sender 
msg['To'] =recipient 

Here we add the subject, sender and recipient to the mimetext object. When the email is 
received by the recipient, the sender, recipient and subject fields will be filled in due to 
these statements. 

# This is Googles Outgoing Mail (SMTP) server 
gmail_smtp_server = 'smtp.gmail.com' 

# This is the port used by Gmail server for outgoing mail 
gmail_smtp_port = 587 

# Gmail username (SMTP username) 
gmail_username = 'abaquspython' 

# Gmail password (SMTP password) 
gmail_password = 'xxx.xx' 

The variable names used here are quite descriptive. 'smtp.gmail.com' is Googles SMTP 
server, and it uses port 587. The usemame and password used here are for an existing 
Gmail account. You'll have to create one of your own and stick the usemame and 
password in here. 

# Create an SMTP object. The SMTP connect() method is called using the 
# name and port. 
session = smtplib.SMTP(gmail_smtp_server, gmail_smtp_port) 

The smtplib.SMTPO method is used to create an SMTP object. It accepts 2 arguments, 
the server name and the server port. It calls the smtplib.connectO method and connects 
to the server. 

# Identify ourselves to the ESMTP server using EHLO 
session.ehlo() 

The ehloO method utilizes the EHLO clause (a more advanced version to BELO) for the 
client to basically say hello to the server and identify itself and the server replies back. 

# Put the SMTP connection in Transport Layer Security {TLS) mode using 
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# SMTP.starttls() so all SMTP commands that follow will be encrypted 
session.starttls() 

starttlsO puts the SMTP connection in Transport Layer Security (TLS) mode. This 
means all further communication will be encrypted making it much safer. 

# Call EHLO again 
session.ehlo{) 

Now that we are in TLS mode we call ebloQ again. 

# Login to the server using SMTP.login() 
session.login(gmail_username, gmail_password} 

The loginO method logs into the server using the supplied usemame and password. It is 
safe to use these here since we have an encrypted connection to the server. 

# Send the email using SMTP.sendmail() 
session.sendmail(sender, [recipient], msg.as_string()) 

The sendmaiiO function sends the email. It accepts 3 arguments, a String for the sender, 
a list of Strings for recipients, and a message. We use the as_StringO method to flatten 
the email into a String. When the as_StringO method is used with a MlME object it 
encodes the text in a format suitable for email. The 'subject', 'from' and 'to' fields of the 
email will be represented appropriately. 

# End the session 
session.close() 

This ends our session with the server. 

In this chapter you were introduced to job monitoring. In the example script we 
monitored the messages ABORTED, ERROR and JOB_ COMPLETED, which are 
only a few of the available message types. If job monitoring is an important topic in your 
work I strongly recommend looking up the other message types and experimenting with 
them. We also learnt how to send an email from a Python script. While this involved 
some advanced Python programming, it not only gave you some reusable code in case 
you wish to have your jobs email you on completion, but it also demonstrated the fact 
that you can harness powerful features of the Python language and are not only limited to 
Abaqus kernel commands. 



PART 3- GUI SCRIPTS 

Up until this point all the scripts you have written have run without much interaction with 
the analyst, with the exception of the prompt boxes of Chapter 14. This is perfectly 
acceptable for most scripts, and possibly all scripts you ever write for Abaqus will be like 
this. However there may be times when you wish to create an interface for your script, 
just so you can type in values or select options at runtime. If you work in an environment 
where other analysts will be using your scripts, a visual interface can save them having to 
modify your scripts directly, and may therefore be beneficial for everyone involved. 
Taking things a step further, if you are in a large organization where individuals without 
much Abaqus experience will be working with your models, you may wish to alter the 
Abaqus/CAE interface itself so as to provide them with a pre-determined workflow and 
limit their exposure to the complexities of Abaqus. 

In Part 3, you will learn how to create simple dialog boxes using the Really Simple GUI 
(RSG), as well as custom interfaces and vertical applications using the Abaqus GUI 
Toolkit. From my personal experience, most individuals working with Python scripts in 
Abaqus are not required to create GUis, therefore most of the following chapters can be 
considered optional for most readers. However it wouldn' t hurt to skim over them, just so 
you get an idea of what is involved. 

The last chapter of the book deals with Plug-ins. These are useful for both kernel and 
GUI scripts, so browse through it even if you skip chapters 19-21. 





19 -
A Really Simple GUI (RSG) for the 

Sandwich Structure Study 

~ '... .;.., J • ' 

In Chapter 15 we wrote a parameterized script to study the deflection of a pressure loaded 
sandwich structure. This script accepted parameters using a specially formatted input file 

and ran a complete analysis for each set of inputs. In this chapter we shall modify that 
script to instead accept inputs/parameters using a dialog box presented to the analyst in 
Abaqus/CAE. To simplify the example and focus on topic at hand, the analysis will only 

accept one set of inputs and run once using these. The dialog box will only be presented 
once at the beginning and there will be no looping. 

The dialog box will be created using a facility known as the Really Simple GUI, 
abbreviated as RSG. RSG a11ows the analyst to quickly create a dialog box with text 
fields, checkboxes, combo boxes (dropdown menus), radio buttons and so on without 
using any complex GUI customization tools. The drawback is that you can only 
customize the appearance of the dialog box you create, not the rest of the Abaqus/CAE 
interface. In addition, the appearance of the dialog box itself cannot change dynamically, 

meaning that you cannot show and hide controls, or display different options based on 
previously selected ones. 

We will modify the script from the sandwich structure analysis. It will be placed inside a 
function using the def keyword. This function will be called by the RSG dialog box when 

the user clicks OK, and the parameters provided to the script will be the values supplied 
by the user using the dialog box controls. Needless to say we will delete the parts of the 
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script that read data from an input file. ln addition the loop itself will be removed since 

the analysis will only be run once. 

The RSG Dialog builder will be used to create the dialog box. It is a WYSIWYG (what 

you see is what you get) interface where you select which controls you would like to 
place on the dialog box from the available options, and the finished product will look 
identical to it. 

-m:-"J:". -~. --~"'+>:r. ~ 

1.9.3 --~ettmg Staneil'witb.R$G ·- · : , " .· _ ·_ .. ~ · _.. . . : 
... , ·• '9'. • ~ ~ ~-~ ~"-" a:.ti.;; -- ...._ . ·"' ' "' 

In Abaqus v6. 10 the RSG Dialog builder can be accessed from Plugins > Abaqus > 
RSG Dialog Builder ... as displayed in the figure. 

I ools I Plug· ins; t:lelp 

~ loolboxes 

Abaqus • Getting Stlrted ... 

Sandwich Plugin GUI Example ... 

Tools " Kernel wmple. .. 

The Really Simple GUJ Dialog Builder appears as shown in the following figure. On the 

left hand side you see a set of tools you can use. Most of these are controls/widgets that 

can be added to the dialog box. As you click on them they will populate the tree in the 
center giving you a hierarchy which can be rearranged using the arrow keys . 
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Dialog Box · 

Tit I e: I Title 

~!"elude sep!rator above OK/C!nc~ buttons 

[E) Color widg&s by layout manager 

@ Show dialog in test mode 

! jsh~w_Dj~logl 
! 

In the right side of the window, where you see a few dialog box options, check ' Show 
dialog in test mode' and click the 'Show Dialog' button. 

A dialog box is displayed. At the moment you haven' t added any controls to it hence all it 

contains is OK and Cancel buttons. 

The RSG comes with a basic 5 minute (or shorter) tutorial. It makes little sense for me to 
rehash what is already covered in this tutorial especially since it is available to everyone. 

You can either run through it in Abaqus, or follow along using the screenshots below. 
These screenshots were taken in Abaqus/CAE Student Edition 6.1 0-2. 

Click on the "Take a 5 minute tour of the GUl builder" tool. 
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a lee a 5 minute tour 
of the GUl builder 

The 'Quick Tour' begins. 

RSG 

,· Oialog Box -
I 

Tltle: E 

~ Include sep. 

' lE! Include Ap~ 

OK button text 

· Introduction ·-

The Really Simple Gui (RSG) module provides 
a simplified interface to a subset of the 
widgets avl!ilable in the Abaqus GUI T ooiKit. 

The RSG Oialog Builde~ provides 11n easy way 
to build dialog boxes without having to write 

1 code. To create a widgets you simply tlick 
on a button in the toolbox and fill in the 
;sssociated fields. 

To get help, place your cursor over any of 
, the buttons or labels in the dialog builder. 



se mdb . models['Model-1' 
g, v. d . c : s.geo~etry . 
s.rectangle(pointl•(-w/2 
p: • db .models('Model-1' 
p .BaseSolidExtrude(sketc 
del ~db.models['Model-1' 
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·· The Kernel ·-·- -·· ·--------···--·--··- ·-··-·-
• 
: You typicafly develop your lcemel command 
; by c.opying lines from an abaqus.rpy file., 
' g10uping them into a function, and 
: modifying them to suit your needs. 
i 
: You associate your kernel command with 
' your dialog box by specifying your module l name and your function name. 

; The arguments to your function are provided 
: by the widgets you add to your dialog box. 

, The diafog box will issue a command to the 
! lcemel in this format 

; moduleName.functionName(keyl:vafl, ... ) 

This window is where we will link the RSG to our Python script. The script itself will 

fonn what is labeled at the module, and the function within the script will be the function 
called when the OK button is clicked in the dialog box. In the above figure, the module is 

'myUtils' and the function is 'createPlate', which means that a function called 
'createPiate()' will be called in a script called 'myUtils.py'. 

r Au~:~~:~-~~~=t-determi:eswh~er a 

I 
widget is laid out vertically or horizontally. 

A parent can be either the dialog bo~ a 
i vertical or horizontal frame (which are I invisible). a group box, or a tab item. 

, All parents, exc:ept the horizontal frame, 
i lay out their children vertically. 
I 
I 
! You can nest frames to produ<:e more 
j complex layouts. 
i 

I 
A group box provides a visible border with 
a title. 

l ____________________ _j 
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--- --===--------

GL] Example 
I 
d~l 
Lo options 

l11yout (continued) 

A t<1b book is a contain~ for tab items. 

A tllb it~ is a parent widget that l11ys out 
its children vertically. The pllrent of a 
tab item must be 11 tl!b book. 

You can n~ other layout widgets, such 
as a group bol(, inside a tab item. 

A verticalaligner is an invisible frame 
that aligns the left edges of the t~tfiefds 
of its children (eith~textfield widgets 
or combo box widgets). 

Moving Widgets 
1 You c<1n rearrange a widget in your 

dialog box by selecting it in the 
! tree and clicking on one of the move 

buttons above the tree. 

' Widgets may be moved up and down only 
, within their layout manager. 

Widgets may be moved left and right 
to change their layout manager. 

Moving widgets up and down tends to change their position in the dialog box. Moving 

widgets left and right allows you to nest them within a layout manager thus allowing 

them to be affected by the layout. 



Hem3 

Item 4 

Item 5 

comman<t sent to kernel: 

myUtil5.creat ePlate (name• 'Plate-1't 
'1\'=3. 5, hs:S. S , riqid=True) 
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Replacing Widgets 

You can replace some widgets with other 
· widgets by clicking MB3 on top of the 
, widget. 

' For example, you may wish to replace a 
horizontal frame with a vertical frame 

· or replace a list with a combo box. 

r- Keywords 

i Keywords associated with string text fields 
! have string values; keywords associated 
; with integer or float text fields have integer I or float values, respectively. 

f Keywords associated with lists or combo 
! boxes have string values. 
t 
i 

i Keywords associated with check or radio 
1 1 buttoM have Boolean values (True or False). 
f 

! An ecample of what a command sent to the 
! kernel might look like is shown to the I~ 
l 
i 

\_ ___ ·---------------··--' 

llsl!~ousll N~~-J I 

You associate keywords with each widget of the dialog box and also define the type of 
data it accepts. Here the text fields for name is given the keyword 'name' and accepts 

Strings. The other two fields are assigned the keywords ' w' and ' h' and accept floats. The 
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checkbox's keyword is 'rigid' and it always returns a Boolean. These keywords and their 
values are passed to the function associated with the dialog box as parameters. 

B f:i) users 
8 ~smith 

8 Cl abaqJs_pUgi1s 

~··· 

Testing 

As you elide on the widget buttons in the 
toolbox, your dialog box will be 
shown and updated automatically. 

If you edit some text in the GUI builder 
• dialog, you must press Enter in that text 

field or elide on another widget in 
order to see your changes. 

In "test mode", when you click OK in your 
: dialog the kernel command is only displayed 
. in the GUI. In "normal mode", the kernel 

command is executed in the kernel. 

If you press Cancel in your dialog, you can 
show it again by clicking the Show Oialog 

· button or by making a change to your dialog. ! 

Saving 

1 An RSG plug-in is saved using the 
simplified RSG set of commands. A st11ndard 

I plug-in is saved using the full Abaqus 
' GUI T oolkit commands so that experts can 

edit the files to add functionality. 

You cannot reload a standard plug-in into 
the RSG Dialog Builder. 

j Your kernel module fife is moved to 
, your plug -in directory the first time you 
j save. Any icon files are copied to the 
1 plug-in directory. 
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at:JdMM 
S riJ Options 

$ [~~~] Vertical Align er 

I H::J Length: 
I 1-o width: 
! I l ~·Cl Depth: 

!" ~ Apply ther ... 
SLj Tab Book 

$ LJ Mechanical 
! L 11J Icon 
[ 
ElcJ Thermal 

L!iij Table 

,- More Help ----., - ·--·----,., ....... _, __ ·-
! 

, You can now get started creating simple 
· dialog boxes. 

For more dl!tailed help, refer to the 
· "RSG Diatog Builder" entry in 

the About dialog, which can be accessed 
' from within Abaqus/CAE by selecting: 

Plug-ins->About Plug-ins ... 

Now that you've run through the 5 minute tutorial and got an idea of how RSG works, 
lefs work through our example. I have already gone ahead and created a GUI dialog box. 

Laying the widgets out onto the canvas is simple enough but you should try it once and 
obtain the same layout that I have here. 

.. 
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Here is what our RSG dialog box will look like: 

,· Dimensions and Materials -·-----·-·-

! 
Top Plate 

Thickness Ll o_.os ___ -J 

Material: 

(() Aluminum @ Steel 

Numb et of cells in core I 6 ~~ 
Thickness of core walls 10.04 

Top, Plate 

·------------- -~ ~~···--

Name of the job I SandwichJob 

~ Write Report and Print Displacement 
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Lets focus on the parameters used to create this. 

1:'. ~E~'r.'Y'~,§·: · ~ ' ,. "-''"f .. 'i3'}6';;'· ,,.,, -,~r<:/''.., · ''··fO'J:c'~'lt:,,. .,. .• " ,,. . 
·- ·x~-:.~·;·"! . !!,:~~. - >;~ {;"c ';~ Jt'"lr .. 

' !J R~lfy Simple GU! Di•log Buildir •• Djilogfile 5andwichPiuginDirectoiyoB.py . "[ID 
GUI f~<ernet l 

[!]]~-! -~ f- ~ " 
I Oialog Box 

e r:;::JlMM$1 .. I Title I Sandwich Stroc.ture I . _ i Q Dimensions ... ! 
@Include separator above OK/Cancel buttons 

LJ ..... I r ·~ Icon 
I ' ' I 

' 
~ ... ! 

1 

8 f~ Verti<al Aligntr i El Include Apply button:j&pJY; ,;rz~J·.j, ·~ I 
n ~ I I rr::J Length 
!-. -' .... I I 

I 
OK button text: I OK I ... ... I D Width 

I U cJ 1 I El~ Tab Book 
--- , GC) TopPiate ' 
A 11 I i 8 !if! Votial Al01• • "' I !El Col or widgets by layout manager -" i I --- }·0 Thickne5s 

I 

' ! ! 
D I ~ l!lJ Show diafog in ti!St mode G7 8 OJ Material I I 

--- I l· ~ Afuminum I !s.!.l.o"!'.O.i~lpgl Ri c; , I I ~ ··~ Sted I 
uu • C) Core 

I I Ill Icon 
~ I :..o Thickness '---- r A Material: I § C3 

I I : 8 :::; Hori1ontal f rame I 

~ IB 
i 

I 
I [ 0 Aluminum 

I 
I 

' I I J @ Sted 
L " Dl I • 1:11 Number of ... I = I ! ' 

~Cl Thickness ... I I 
I . - . ,, ' .. ~ . *'• _.,. •. '"• ' .;.<!<. ~.,.,:;. -~·' ~ I . -· -.. 

Here you see the settings for the plugin. The title ' Sandwich Structure' will appear in the 
title bar of the dia log box. We are including a separator, which is a horizontal bar, above 
the OK and Cancel buttons by checking the option. We have set the OK button text to the 
default of"OK" although you can change it to something else if you prefer. 

If you click the ' Show Dialog' button, you will see the dialog box. 'Show dialog in test 
mode ' is currently checked for testing purposes. This means that when you click O K 
Abaqus will not actually run the script. Instead it will display a message: 
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Abaqo<fCAE 

Th! fcllowin9 commJnd woold be s«~t to tht lctrn~: 

undwichs:truttute~rsg.createSanctw;chStructure(tandwich_length.::0.8, sandwich_w;dth:::.0.2. top._I#)'C1_thickno):0.03. top_tily~~matcri41_name-='sted', cor~l&yer_thlc:knen:.O.OS, 
A c ort_ltyet_m.,terial..name= •Steel~ no_of_co1e_ cdls= 6, wall_thkkneu_ core_< eUs~0-04, bottom_liJYet_thiclcnw:.O.o3, bottom_layer_mattrial_name:. 'Sttti', job_ name::::'Sindwict\Job'. 
V writt:_and_ptint: True) 

To h.lve the com m and ictUJ ity executed in the kernel un)c:t thc 
'Showdi1log in test mode' button in the. Oi1log So)(w\dget pan~. 

Abaqus indicates that it will call the createSandwichStructureO method m the 

Sandwichstructure_rsg.py file with the statement 

Sandwichstructure_rsg.createSandwichStructure(sandwich_length=0.8, 
sandwich_width=0.2, width=0.2, top_layer_thicker=e.e3, 
top_layer_material_name='Steel', core_layer_thickness=e.ea, 
core_layer_material_name='Steel', no_of_core_cells=6, wall_thickness_core_cell=e.04, 
bottom_layer_thickness=0.93, bottom_layer_material_name='Steel', 
job_name='SandwichJob', write_and_print=True). 

All the widgets are placed inside a group box which we have given the title ' Dimensions 

and Materials'. 

!] Really Simpl~ GUJ Dialog Build~i --.Diaiog File: sandwichPiuginDi;e'ctoryOB.py 

j GUI I Kernel I 
---1' .J, -~ ~ # ----
8 D Sandwich S... ~ 

8 0 ltlii.!J!iji.l.tj : 
! : · 1:1 !con 

0 ::::; I : ~ ~~~ Vertical Ahgner 

··• :.-·~ - CJ length ... 
~. I ··D Width 

c::J cJ 8 E) Tab Book 
8 L) Top Plat~ 

A 11 !1 9 ~i~ Vertical Aligner 

Group Box 

Title: I Oim~sions and Materials 

l ayout 

EJ Stret'h widget to width of parent 

EJ Stretch widgg to h~ght of parent 

Lh If the layout settings ar~n·t used properly 
they may obscure other widg~ts. 

An icon widget is used to add the image. The path to the image is specified here . 

.., _ . ... .~. --,:·"- ~ . · ~ ,· ... .._ .• -~ ---x:-~?~ .<: --·~ ... ... _ -~:r· "":~-~- , -.. 
"!] R~ally Simple Gut Dialog Builder·· 'oiatog File: sandwichPiuginDirtctotyOB.py · · 
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We create a vertical align er widget to position the length and width text fields vertically. 

Any items placed inside a vertical aligner are automatically positioned vertically. We will 
not apply any padding to this vertical aligner. 

~;-~."7-:,--::~:·;-::--···::··-~::··-~:--~.;:::;;::--;,~:~---.:~-:--~--i:-;:--~-;;-·:~---~;::J-:i77'T~·:;;:::-;·i:-:---~:~;;;-.-:-· :;-:;:-.. ~:-~~---····; -·--·-;---;--------------~ ---------·----· 
· D .Really Simpl~ GUI Oialog'Build~; :: Di~log' Fil~; ~~~ci.~ichPiuginDiredoryDB.py 

I GUl I Kernel. I ___________________________ _ 
~.J,~~ <P 

~ I rs D. Sandwich s ... 
--~ 8 0 Dimension~,.. 

. ! 1;1 !con 

o ..... $ ~~~l'fllrm!!Jii!!· . ·.-. ra-· -. m:~. 
•·• ~f;;i \ l· CJ length 
... ;-;<.~ I ,, D Width 

U cJ 8 E} T~bBook 
El L) Top Plate 

A 11 l e [:;~ Veltical Aligntr 
l CJ Thickne~s 
S Ci1 Material 

i == . f · I::E Alum mum 

... 

Vertical Align er 

Padding 

Left lo 1 Right lo 
===::::' 

Top: ro - ""] Bottom: E 
_.0: Normally you -nt to use zero padding 

because this widgtt's parent will 
alr!ady include some padding. 

However, there may be times when you 
want, for ex~mple, to ust a ltft p~dding 
value of 20 to indent a group of widgets. 

lextField 

l~ ~~-en~g-th __________ ~ 

Columns: ~-ti~] 

Type: 

Keyword: I sandwich_len~~J 
Default: [o.s :: ] 

The length text field is defined here. The text is set to 'Length' hence the word ' Length' 

will appear next to the text field on the canvas. The number of columns is set to 12 

meaning that 12 characters will be visible in the text field. You can actually type more 

characters, but the whole line will shift left as you type more and you will only be able to 

see 12 characters/digits. This is more than enough room for our purposes. The type is set 

to 'Float' indicating that a float value is expected here and this will be passed to a float 



540 A Really Simple GUI (RSG) for the Sandwich Structure Study 

variable. The keyword sandwich_length is associated with this text field, hence when the 
OK button of the dialog box is pressed the function createSandwichStructure() will be 
passed the parameter sandwich_length=xyz where xyz is the float entered by the user. 
The default is set to 0.8. 

The definition of the width text field is similar. It is assigned the text ' Width' , the 
keyword associated with it is sandwich_width and the default value is 0.2. 

[
D Really Simple GUJ Dialog Builder : . Oialog File: sandwichPluginDirectoryOB.~ 
I GUI I Kern~ I 

Tab Book ~ 1' J.. ~ ~ ~ 

CJ .. ~· · .. 

·~ .. ... ~. 

L.j cJ 
A ;I 
~ e-

P" r. 

.!J • 

8 D Sandwich S. .. 
8 LJ Dimensions ... 
i ;- ;I Icon 
' 
I 8 [:;i~ Vertical Align er 

' I r·D length 
i I LCJ Width 

8EJI!~:B 
$ L) Top Plate 

i 
I I 9 r..:"t Vertical Aligner 

I 1 r::3 Thickness 
I I 

I 
8 01 Material 

; ,..~ Aluminum ! 
l " ~ Steel 

' I 
I e C) Core 

i I ,· ;! Icon 
I 

~ -

) 

=, 

l 
' 

layout 

(] Stretch widget to width of parent 

0 Stretch widget to height of parent 

.&, If the layout settings artn 't us~ properly 
they may obscure other widgtts. 

A tab book widget is used to create a tabbed section. Each of the tabs- Top Plate, Core 
and Bottom Plate will be individual containers nested within the tab book container. 

The Top Plate container will accept settings for the top plate. We give it the title 'Top 
Plate' which appears as the name of the tab in the tab book. 
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!.) Really Simple GUI Dialog Builder • r Oialog File:: ~ndwichPiuginOirectory{)B.py 

I GUI ! K~n~ I 

[6l)l 8 r::iS-;~.;;,ts:::-~~--: 
~ ~LJ Dimensions ... 

Tabrtem 

T v.t I Top Plate ___ __, 

LJ ~···~ I •...• I 
... ·~· . ! . . .. I . ·' ... . ... , ... . 

tJ cJ ~ 
_ I 

' i·· l':il Icon 

~ ~~~ Vertical Align er 
l r D Length 
; L c::i Width 

ea Tab Boolc 

~0 ijt!Wltj 

A vertical aligner is used to position the widgets inside the top plate tab. 

D Really Simple GUI Oialog Builder·· Dialog File sandwichPiuginDire<toryOB.py 

I GU! l Kem d I 

ldLil eo.~; ... :~~ -? ,p 
l _~_§_j eo 01men51ons ... 

· Ilia kon 
8 ~l] Vertic~l AJigner 

[
, CJ l ength 

·D Width 

S E} Tab8ook 
S Q TopPiate 
; B !~I "'ff•· "'m•tll.)l'llli-•hdJm 
· f CJ Thickness 

SOl M~terial 

.. 
r-

llettic~l Aligner 

Padding 

Left [i~:~~~] Right: ~~~-~ 
Top: ~------.... ] Bottom: ro-···---- "I 

:~ Normally you w~nt to use zero padding 
bee~ use thi• widg«'> parent will 
already include some p~dding. 

Howe:v~. there may be timu when you 
wan~ for ecample. to 1ne a left padding 
value of 20 to indent a group of widgds. 

The text field 'Thickness' specifies the thickness of the top plate of the sandwich 
structu re and is assigned the keyword top_layer_thickness . 

.---.,.,--· .. .. ' ---c=-:::;,..,,::--:---:::-"77'---:----;:c,-

D Really Simpl.e GUI Dialog Builder-· Dialog Fill!: sandwichPiuginOirectoryDB.py 

I GU! I Kernel, I 

I l so,s.t:i:~-?-~ -·-: ~=••• ~ ..... ;_~~~-·~-·~_s ___ ~______, 
t;JO 01mens1ons... ~ ' i· ;J Icon Columns:~ 

... ~~ ... ~~ 
LlcJ 
A ;l 

$ ~;( Vertical Aligner 
I f .. CJ Length 

l Lw Width 

GLj Tab8ook 

$0 Top Piate 

' 8 [~i] Vertical Align er :-o lii@ij.\41 
A r:a M•tl'<i•l 

Type: 

Keyword: I top_layer_thickness 

Default lo.o3 
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~; I 
ht ~.g 

Llc:J 
A~ 

Combo Box 

Type: jLs_ti!l_nd_a_rd __ _JB; 
Text: !Material 

Keyword: I top _layer _material_narrl 

Default ! LS_te_ei ___ _J 

A standard combo box named ' Material ' is created here. It is assigned the keyword 

top_layer_material_name. The default value has been set to 'Steel' which is one of the 

combo box items. Notice that the default value has been spelt exactly as the name of the 

combo box item ' Steel'. If you were to type anything other than 'Aiuminum' or ' Steel' in 

the default field, it would be meaningless to Abaqus. 

-~·~;;;.~'"t::-~---:--.-:---------;7-::·.--;-:""--. -. -~-;.--.---.~.-~-.-;~.y--=-~-:;::-~-:~:-·.~- ·.:.-:--:--~-·-:.~----.-:---· 

:!] RtallySimple GUl Dialog Builder~:Oialog File: sandwichPioginOiredoryOB.py . 

j GUI I Kernel I 
,----!~~~----1 List lt~----·· 
1
s 0 ~ndw!Ch S... ,.. T~ t_AI_um_ i_nu_m _____ --J 

1 8 LJ Dimensions... · ! 
r-rr--,-.... --:. I 1 r· .~ Ieo~ . I 

L...:.:.J : .. :; i 8 ~=:J! Vertical Al,gntt , 
... ~~ ' I !·D length · I · 
;.i ~-~ ! !.r::J Width 

L) cJ G c:J Tab Book 
8 () Top Plate A= ---, 

~~ 11 
w- ~- I 
t!:J • I 

I ' •-"it: 1 G '~"11: Vmic~l Align et 

! •·i- t::J Thickn~~ 
8 Cil Material 

L. ~ .M"',.,!ffli ... i,i•:;•,J 
' ~ Steel 

SCJ Core 
1 ! nn "-·-

A combo box item 'Aiuminum ' is added here, followed by one named 'Steel'. 
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!] Really Simpl~ GUI Oialog a'~~~d~; .. ol:l~g ~ie: s~nd;..~hPiug·i~Oir~cto~OS.py 
I GUJ I Kernel I 

Tab Item 

Text: (Core ~ . r:...· lt ·----·-·y· .. - -1 
8 :,::l} Vertical Aligner "' t . ' .. D Thickness f 

8 C'fl Material I 
f" ~ Aluminum j 
· f5 Steel 1.· 

eori!J 
Glf : r· I; Icon 

I . 
I i r-'\ T L.: ... I • .-. ........... 

The second tab is named 'Core' and the user will define the properties of the core here. 

... [~§ 
CJcJ 
Ail 

G 01 MatE<ial i lffi Aluminum 
· f5 Steel 

BL) Core 
. iia ID 

1 
; 0 Thickness 

A Material: 

Icon 

File namt: 

JVii;-ers/G;~ The Gr-;;jbb;qus_plugin~~~dwichPiuginDirectory\~ndwj1 @B t.:~~---·----H·----------·--·-------·-------

The icon widget is used to place an image of the core in the core tab . 

. ·!3-~:ty s;~;;:·~J;b·;:~;-~=i~J:~~-6~~:;~;:~:~~~~ch;;:gf~bi~~~;-~ ,- .... -·---· 
I GUJ I Kernel I 

-t+ f-~.P 
n~-m I G ~- VerticaiAligner 

1 ~ CJ Thicknen I El 91 M~terial . 
[Ei Alun11num 

1 Ei Steel 
lfcJ Core 
' L ;I kon 

I ~o t'!fr"'ffijj .. ~j•.tm•· 
. r A Materia~ 

I 8 ' :::; Horizonhl Frame 
I L t:\ hr .. "'4"'u'"" 

T e:rt Field 

Text 

Columns; I 12 EJI 
Type: 

Keyword: I coce_layer.thidcness 

Default: ro:oa=-~ 

A text field labeled thickness is created and assigned the keyword core_layer_thickness 
and a default value of0.08. 
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• ' • " • ' ~ ' ")< ". • ; ' • ' . • - • :·· • "'i . • 

D Realty Simpie GUJ Di~log Builder·· Dialog File: sandwichPiuginOirecto.y!JB.py 

J GUI I Kernd I 

~ ,..-----'t-8_;-~ .-. ~-ert-ic-~-li-g~-er--,...-, 
~ H:::i Thickness 

8 OJ Material 

.. ~~ 
,., i:?!-.t:f 

uc:J 
A;, 

·· ~ Aluminum 
· ~ Steel 

El L) Core 
i· ~ Icon 
! Ci 1hickntss 

! A ISID 
1 9J ;::; Horizontal Frame 

I 
n! 
Ill 

· label 

[] Use bold font 

A read only text label with the text 'Material' is added to the core tab. 

~-... - <) 

!] Really Simpl~ GUl o·ialog Builder -·- Dralog File: sandwichPiuginDffedoryDB.py • 

I GUl I Kernel I 

~- ~~-~~8-:-:~-~V-~-rti-c~-IA-Iig-:'-er----, 
l~~j 1-D Thickness 

' 

•. , f:C!if 
~~ 

uu 
A~ 

r::J 12.7 

R ~· 

2::.1 • 
~ 

8 r:::B Material 
;. Effi Aluminum 

1 L J!.5 Steel 
I 

GCJ Core 
I . 

i [· Ill Icon 
; f .. D Thicl<ne~s 

I 
! .. A Material: 

~ ~::; Horizontal frame 
i L ® Aluminum 

! L ® Steel 
i 
;· CD Number of ... 

l LD Thickness ... 

B L) Bottom Pia ... 

f .. o Thickness 
!. A M;ot,.ri~l ·, 

Horizontal Frame 

layout 

IEJ Stretch widget to width of parent 

!!] Stretch widget to height of parent 

& If the layout settings aren't used properly 
they may obscure other widgets. 

Padding 

Left: jo 
;:==:::::; 

Top: !o 
'-----' 

Right jo 
Bottom: Ll o _ _ .....J 

. . '0' Normally you want to use zero padding 
because this widget's parent will 
already include some padding. 

However, there may be times when you 
want, for example, to use a left padding 
value of 20 to indent a group ofwidgets. 

A horizontal frame is created in which we will place the radio buttons for the two 

materials. This will make them appear side by side. 
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; !] Really Simple GUI D;;~~~ Builder .: Oi~log Fite/;~~d~~~hPiuginOirectoryDB.py 
I GUJ I Kernel I 

1' ~~ ~ 4> 
n ..----------. 
I:JJ 8 Bl} Vertical Align er "' 

... a ::... 
;~ . . 

-0 Thiclcness 

8 01 Material 
l Effi Aluminum 
· ~ Steel 

BC) Core 

; ~Icon 
>o Thic~ness 
,· A Material: 

£;] ~ ::; Hori.zontal Fr11me 

'!;·· cv tMftlrn 
! · 0 Steel 
! 

Radio Button 

Text !Aruminum r---- -·~ ---· - l Keyword: core_layer_material_nar 

Default: () On ~) Off 

Radio buttons are created for ' Aiuminum, and 'Steel' . Radio buttons allow you to select 
just one out of a set of options. If you select one radio button, the other wi ll get 
deselected. In order to enforce this behavior, both radio buttons must be g iven the same 
keyword core_layer_mater ial_name. If they are given different keywords they wi ll not 
be part of the same radio group and will operate independent ly, meaning that you wi ll be 
able to select both of them at the same time which wi ll be quite meaningless. 

!J Re~~lly Simple GUI Dia.log Buiider -- Dlalog File: s~ndwichPiuginDiredoryOB.py 

j GUI I Kernel I 

~ td 

LJ ... ...... ... !'><"~ 
.-c ... ~~.rnt 

u u 
A = D e 
R; € 

.:i.:J • . 

1' ~ ~ ~ ,p 
8 ~]] Vertical Alignet 

~·0 Thickness 

8 r::::::t Material 
l f· fi5 Aluminum 
l I 

! Lffi Steel 

$(J Core 
i \ Ill Icon i ! .. 

; H~ Thickness i 

I l- A Material: 
! 8·"• I .... .. Horizontal Frame 
i t l- e Aluminum l 

l ' ! 1 i. @ Steel I ; 

I !·· OJ W!jftj.§i .IM i ! 
I '··D Thickness ... 
l 
8c:;') Bottom Pia ... 

A 

r-

' 
~· 

' 
= { 

~ 

Spinner 

Text I Number of cells in core 

Column~ I 6 ~~ 

Type: @ Integer <() Float 

Increment O 

Min value: 1._1 ___ __, 

Max value: 1._1_0 ----' 

Keyword: I no_of_core_cells 

Default 16 ......._ ___ _, 
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A spinner is used to allow the user to select the number of cells in the core. It is given the 

label text 'Number of cells in core~ which wi11 appear next to it in the dialog box. It will 
allow the user to select a value between the specified minimum of 1 and the specified 
maximum which is I 0. The default has been set to 6. The selected value will be passed to 

the parameter no_of_core_cells. 

LJ --·-· 
~ ... ·· · 

~.·: ~ 

ClO 
Ail 

El~ Vertic.aiAiignt!l 

i· C'l Thickness 
801 MawiBI 

l- E!j Aluminum 

l Eii Steel 
S() Core 

J ~ ;llcon 
1 ··CJ Thickness 

j 1- A Materia~ 

I 8 1::: Horizonlll Fram~ 

1 i ~ @ Aluminum 

j I l. @ Steel 

j i· Cl! Number of ... 

I Lo i!@il.!•-{M 
8~ BottomPia ... 

p:J Thickness 

. Text Fi~d ··• · 

: Text: r-1 Th-i-ckn_es_s_o_f c-o,-e -wa-lls--, 

Columns: I l2 ~~ 

. Type: ~~]3 
! Keyword: r-1 w-all-_th_ic_kn_es_s_-cor-e-_c-,~ 

Default: ._io._04 ___ ..J 

A text field is supplied for the user to enter the thickness of the walls of the core cells. 

:j GUI !.Kemd:l 

1 ~ ~ .---.:-----:1'_ 8 __ ~-~-:-.,--:-Aii-g~-e.- ---.. 
,i I ~ CJ Thidcness 

r----""1 ' ~ J:'il Material 
rT::~ ~:·.: · •. I I L c:: L.:J . i. , · lE Aluminum 
.. , ~"l:it i J L(iii3Sted 
·-· ~tl · $dl Core 

GJ (f) I ~ L ;I lc~n 
, i j·Cl Thccknw 

A 11 i t !·· A Material: 

I! I S ~;s; Horil:ontal Frame 

f 

1

. ! [ @ Aluminum 
i 

1
: e $led 

\ r r::D Numbt:r oL .. I ! L.a Thiclcness ... 

l 8 c2J I@IMQM 
j )-D Thickneu 

· Tab Item 

T ex!: J Bottom Plate 

The third tab is named 'Bottom Plate'. 
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"< . . ' >" '"":f ... ~. ".r "'.V\ ; • - ., • • ·~ ~ •. - . ,· '·~':; 

D Really Simple. GUI Dialog Builder-- Dialog File: ~andwlchPiuginOire.CtoryDB.py ' ' 
-···. ,,~'j ' I 

I GUl I Kemel l 

~ ~~ ~ 
1' "' f- ~ ~ - Text Field ------ -·--·--- ·· - ... 

l i B ~~~ Ve.rtical Aligner "' Text !Thickness l ! 
i j·· CJ Thickness 

Columns: I l~EJI i 
i 8 r::!J Material o I . .. ! i ~ Aluminum jr1oat l3 \ L~ 

Type: 
···~ Steel =~ . ! 

,,. ~. BGJ Core. Keyword: I bott.om_layer_thkknes~ u cJ ! i !;l lc;on ..., 
! f Cl Thickness ,0.03 I ! Defauli: 

A = ! f A Mtrterial: 
l ' $ ~::-~ Horizontal Frame. •I 

n ~ I I i ). 0 Aluminum 
i i I 

' r - 0 Steel 
R: C! ' j I 

1- r:tl Number of ... i I 

!:!.:.1 • i I L.Cl Thickness ... 
IJ 

! 
i 

j;i 

! EJC) Bottom Pia ... i 
~ I 

H::1 111~~11 l ! 
~ A ! Mtrterial ! 

r= ......... i 

A text field is supplied for the user to enter the thickness of the bottom layer. 

(I'D ~~;,;:;;~~~~i::i;=~~~:'"ria?o;·F~~=~~P~;ino~~~t:;;!!.'~~""~?· *'J~!f~'_K·~\fr<"''"" ., 

I GUI I Kernel I 

[g] 1' + ~ ~ ~ · Label · .. 

j 
I G ~ Vertical Aligm:r . Text: I Mllt~al I ~ I r r:::l Thidcrless I l!j Use bold font 

I I 8 1.:11 Mattlial 
[] ......... i ' B AI • , r· ... · umtnum 

I I Lffi Steel ... 
~ I . ... 

I BC) Core 

Ll L) I i t 11 Icon :-

' ! ,··Cl Thickness 

11 I 

A I I !- A Material: 
: I 

' ! l El DJ H~rqontlll FrJme .. 
D IS> 

l I t 0 Aluminum i 

! ' 0 Stttl ~ ! 

~ ~ I !. 01 Number of ... ! I 
I I l c Thiclcneu ... £!!.! • "' S (£) Bottom Pia ... 

-, 
: 

~ l·c:l Thickness i 

fill r3 
r A 1111 

I i 8[§ li~ 

I 
,. ; 

~ R rEil Aluminum i 

A text Jabel 'Material' is inserted on the canvas. 
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[J ;::1? 

~ :i; ~ 

(2)(@ 

All 
D~aU 

c: = 

1'J..~-14' c· list ·----·--------·------------- -~-----

I 9 [::Ji Vertica-l Al- ign- er--,.-, 1 Visiblt: roWl=: j 2 !ill 
i
l ;_- 0 Thickn6s : r-1 ------,~ 

.,' Keyword: bottom_layer_material B OS Materilll . -I t ~ Aluminum 
! ~ Steel 

$L:J Core 
I ~ !; Icon 
l !.o Thickn6S 

j j.. A Material: 

1 I? !:~ Horizontal Frame 

' !' ['- 0 Aluminum 
0 Steel l Cl Number qf •.. 

1 
0 Thiclcn65 ... 

8 C) Bottom Pia ... 
[ .. o Thickness 

t· A Material 

8f!illll1 
~- lii!! Aluminum 

i Default ._I St_eel ____ ] 
1 Layout 
I 
J l'tl Struch widget to width of parent 
1 fE] Stretch widget to height of parent 

& If the layout sutings aren't used properly 
they may obscure other widgets. 

A list is used to provide the user with materia] options. The keyword 

bottom_layer_material_name is applied to the list container itself rather than individual 

list items. The default is set to 'Steel' which is one of the list items. Note that the default 
must be a name of one of the list items, in this case 'Alum in urn' or 'Steel' otherwise it 
would be meaningless. 

I GU! j. KernetJ 

,A A. J, ~ --1 h · Li« Item · · 
' b LJ ~· ~--"' ----,.-r!l i 9*1 VtrtiuiA!igner : ~ Text: JAiuminum 
I b] ~CJ Thickness 1 • .._,_-~~~~~~..J 

rT_-::'1:. LiJ ~::;; 

... ~~ ... ~ 
m a 
A!; 
o e 

~ 

§o 
~Em 

8 011 Mattrial ' I 1 

l' ~ Aluminum I 
Sd) Co~fjfj S«tl • ! 

j t!; Icon ~ 
i [ r:::l ThickneJs 
l l A Materia~ 
! 8 ~: ;: Horil:ontal Frame 

! I I· 0 Aluminum 
l!L ®St~d 
I r Cl Numb~ of ... 
1 ~.-.o Thickness ... 
~ (jj Bottom Pta •• 

[·Cl Thitlcnen 

l A Material 

slilii list 
~t= fii@,ii.lil,i 
L eaSt~ 
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List items 'Aluminum' and 'Steel' are added to the list container. 

Ttxt fi~ld -

Tct: [ N!me of the job 

Column!.: [ 18 ~] 

Type ~ 

Keyword: [i?,~;namt 

Oef~olt I S.ndwichlob 

A text field is provided for the user to supply the job name. 

GUI I.Ktrnd :,1 

~jr--:~-.,.;-e~_,.~,..,.....~-~--c~-,A-ri9-~-· -';"""'\ 
L~.-~..J I I I· W Thickness 

! 1 S 01 Material 
CJ :::~ i Hffi Aluminum 

!,i ~ 
~(] 

All 

~ 

m;o 
~!:m 

l 

I 

i L f1l5 StKI 
~L) Core 

! ( ;l Icon 
H:::::i Thickne1$ 
~ A Materia~ 
S U-< Horizontal Fram" 
\ !· ® AIYminYm 
i L 0 Stet! 
I 

. i· CD N1.1mbe< of ... 
j L.o Thickness .,. 
S ct;j Bottom PI~ .•. 

r·r::J Thidmll$S 
i· A M~terial 

I 1 
H~ Afuminum , 

l " = 
I 

elililust , 

:.~ Steel ; 

n I r'; ;ame of-;,... U 
. ~!!.;;;;;;;;;;;;;~ . : ~ 

Check Button ''" · .... ·· .. · · · .. _ .. · .. ""· -

T e<t I Write Rtpelt and Print Oispl~l . 

Keyword: [ wr~and_print 

Default: @ On 0 Off 
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A checkbox allows the user to specifY whether or not the XY report should be written and 
the displacement subsequently printed to the message area . 

. D R~aliy Slmpie GlJl oial~~ a:lfd~~~~D~~69'~,~ ~and~chPfugln~irect~;;DB.~y~
7

"~yif~::'';:;.":( ' .,. ~.~;~': I· ~ ., . 

i 

§Kernel I 

fro• abaqus iaport * 
fro• abaqusConstants iaport • 
import regionToolset 

--

def createSandwichStructure(sandwich_length . sandwich_width. top_layer_thic 
# ------------------------------------------------------------1 Soae initialization (aajority of variables have been defined as p 

reportxy_naae • 'SandwichXYData ' 
reportxy_path • 'C : /SandvichFolder/ ' 

steel_density c 7800 
steel_youngs_aodulus • 200E9 
steel_poissons_ratio • 0 . 29 

aluminua_density • 2770 
aluminua_youngs_aodulus • 73 .1E9 
alu•inu•_poissons_ratio • 0 . 33 

if top_layer_aaterial_naae •• "Alua inu•": 
top_layer_aaterial_aass_density•aluainua_density 
top_layer_•aterial_youngs_aodulus•aluainum_youngs_aodulus 
top_layer_aaterial_poissons_ratio•aluainum_poissons_ratio 

else : 
top_layer_aaterial_aass_densitycsteel_density 
top_layer_aaterial_youngs_aodulus•steel_youngs_aodulus 
top_layer_material_poissons_ratio•steel_poissons_ratio 

( rl --•. ---::cpr,.-~.---.... ·, --.,.,~-..J 

' 

In the Kernel tab, we set the module to 'sandwichstructure_rsg' and the function to 
'createSandwichStructure'. This means our script will be m the file 
sandwicbstructure_rsg.py and wil1 contain a function called 
createSandwicbStructure(). 

We now save the RSG Dialog Box as a plug-in by clicking the 'Save your dialog box as a 
plug-in' button. We shall save it as an RSG plug-in, which means internally Abaqus will 
use RSG commands to construct it. If we were to save it as a standard plug-in, Abaqus 
would use the GUI toolkit commands instead. You will learn about those in the next two 
chapters. We set the location to ' Home directory ' which tells Abaqus to save the plug-in 
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in the default plug-ins folder. On my Windows 7 system this 1s 

C:\users\( username )\abaqus _plugins\. The directory name is the name of the directory in 

which the scripts will be stored - these scripts include the RSG plug-in startup, and RSG 

dialog construction scripts generated by Abaqus, as well as the kernel script written by 

us. The menu button name specified by you will be the name of the plug-in in the Plug

ins menu in Abaqus/CAE. Note that it will only be visible in the Plug-ins menu after you 

restart Abaqus/CAE. 

f SaveAs 

• 

·j @ RSG plug-in e> Standard plug-in f) 
I .. - -- . JOK J ! .- Names 

1 

~..::: _______ _ 

I Directory name: l s,ndwichPiugi,Pirtctory 11 f----------------

;l : Menu button "~:"e: !i;:~dwi~h Plugin ---... -.. -. ) '1· ets by layout manager 

~' location .................. .... . . . .. .. .. . . .. . \ . g in test mod~ 

:·!· ~~ ~~,;~ oc·"~"-• I , . . r 

' ~&"M--<H~O ,,.,J 

C3 

i ~ CJ Thickness I 
I !- A Material: 

! $ £;:: Horizontal Frame I 
I' !' t 0 Aluminum i 

0StW I 
1 j-Cil Numbl!r of... I 
! '--CJ Thickness... ~ i 

i"l~, ~- ~ArS~:,r,:.:.t..'l.(!J,u~;vr.s irJ:"$;¥.:;:t;..:,"B:fJ f · l. . 

When you click OK Abaqus will inform you of which files were saved and where. Since 

we selected 'Home directory' these are saved in the 'abaqus_plugins' folder. 
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~Abaqu~C~--------.---~---,.-.-. -

The following plug-in files were written: 

C:\Users\Gary The Great\abaqus_plugins\SandwichPiuginDirectory\sandwichPiuginDirectoryDB.py 
Q\Users\Gary The Great\abaqus_plugins\SandwichPiugi nOirectory\sandwichPiuginOirectory _plugin.py 
C:\Useu\Gary The Great\abaqus_plugins\SandwichPiuginOirectory\sandwichrtructure_rsg.py 
C:\Users\Gary The Great\abaqus_plugins\SandwichPiuginOirectory\kon.png 
C:\Users\Gary The Great\abaqus_plugins\SandwichPiuginDirectory\sandwich_core.png 
C:\Users\Gary The Great\abaqus_plugins\SandwichPiuginDirectory\sandwich_lengthandwidth.png 

Do not move/rename these files or the plug· in will not work. 

You murt rertutAbaqus to seethe plug-in in the Plug·im menu. 

I Dismiss J 

19~5 . Python Script to·respond to tbe'GUI' d.ialog inputs 
Wh~n the. OK button is pressed: th.e cr~ateS;nd~ichStructureO ~ethod will be ca,lled. 

The following script contains its definition. 

1-'fro;-;baqus impo(.'t * 
! 'from .abaqusconstants 
t impqrt regionTool~e~ 
i ' 

r def c~eateSandwichStructl.lre(sand~ich~length;,' san'dwich_width~ top_l!ayer:_thi.ckness, 
·· · ' .c9re_layer_thl.ckness, ': bottom_):ayer_thicknessJ , · 

. #Some initialization 
# to the function) 

rep~rtxy_name = 
repor,txy.:_path ~= 

; steel density = 7800 
· · ste~'l::Youngs_modulus 

steel_po:i,ssons_;ratlq. 

.. no_of..:,cor~-Ge,)!ls~, wa;u_thic.kness_c? re_cells, . 
top_l!'lyer _material_naine, :bottom_)ayer_mater.ial~name,: , . 
. cpr.e.,,Jayer .... material_name, : job_name, write_and_print): 
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. r·ect__:p(2_x · ;:;re6t"1Pt:...l :...x '+ corf.!_laye~ ~"Ce~l_cut_out_:;{ength · .. ,., , ; . · · 
coreLayerCutoutSketch. rectangle(pointf=(rect_pt_1'""~~ rect_pt_l_y), 

. point2=(rect_pt_:2_x,rect_pt_2J)) 
r.ect_pt_l.,...x "'rect_::_pt_2_x + wa1.1--thickness_core_cellS . 

· corelayerPart.CutExtr~de(sketchPlane=sketc~~core_top~face, 
· • . ... sketchUpEdge=sketcn_core_lef:t_:edge, 

·· ~ ;· .. ~ s~etchPbn'eSilde;=SIDEl, 
. . skettbOrienta\eton,;,LEFT, 

: sketch=toretayerCu~outSketchi . 
flipExtrudeDi.rection=OFF) 

. . 
. #'·create materials for the top, bottom and core plate·;·t,y assigning ·mass ' 
# density, youngs modulus and poissons _ratio ·. 
topplateMaterial = sandwichModel.Material(name='Top Plate Material') 
topPlateMaterial.Density~tabie=((top_layer_material_mass_density, ), 
toQP lateMaterial. EI~·stic (table= ( (top _layer _material_youngs _modulus, 

top~l.ayerimaterial_pol~-~ons_rat_io), 
.. - . , .. 

· coreMaterial = sandwichHodel.Mat~rial-(name='Core Matedi~l') 
coreMaterial ,DenSity(table=((core_layer:_materbl_mass_derisity, ), )) 
coreMaterial.Elastic(table=((core_layer:_materiai_youngs_modulus, 

core_layer_ll!aterial_poissons..:.:ratio), )) 
I • • • 
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# Create a seCtion t o-asslgn to-thebotto-m--lay'e·r-:-·oo:-:-----~-.-:----------------------~ 

bOttomLayerSection ·= ... ~ariawichModel \ · · .. ~~ · . 
· · "Homogeneoussol:idse·ction(n~!lle=.' Bottom Layer sed ion ' , 

;< _. . : · . materfa'f=-'-Bottom Plate Material') 
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e.e) 
bottomlayer_front_face ="= bottomlayerlnstance.faces \ 

.findAt(bottomlayer_front_face_point~) 

bottomLayer_side_face~point = (a.e, bottom_layer_thickness/2, 
· sandwich_lengthi2) 

bottomlayer_side_face = bottomLayerinstarice.faces \ · 
. findAt{bottomlayer _side_face_point,). 

bottomLayer_top_fa~e~o~nt = (sandwich_width/2,bottQm.:._layer...:.ttiickness~ 

bottomlayer_top_face 
s~ndwich_length/2) 

- bottomLa·yerinstance.faces \ 
.findAt(bottorillayer~top_face_point,) 

corelayer_front_face_point = .(sandwich_width/2, core_layer~thickness/2, e . e) 
corelayer~front_face = corelayerlnstance.faces \ 

.findAt(coreLayer_front_face_point,) 

corelayer_side_face_point = (0.0, core_layer_thickness/2, sandwich_length/2} 
coreLayer_side_face corelayerrnstance.faces \ 

.findAt(corelayer _side_face_point,) ' 

core Layer _top_ face = coreLayerinstance. faces·. findAt (core Layer _top_face_point,) 
. •. , : . . . . .. ' . . ' 

corelayel?_bottom_face ·= corelayerinsta·nce.faces ~ 
·• findAt ( ~:orelayer _bottom_face_point.;'}· . 

# +++++111111111111 i 11+-tlllllll+llll 11++ ' ' 

# Identify all the faces used for boundary conditions 

toplaye~_fix_fr>ont_face_point = {sandwich_width/2,' top_:_layer_thickness/2, e.e) 
toplayer_fix_front_face = toplayer!nstance.faces \ 

.findAt((toplayer_fix_front_face_point,}) 
toplayer_fix_front_region = r.egionToolset \ · 

.Region(faces""{toplayer_fix_front_face)) 

bottomlayer_fix_front_~ace_point = (sandwich_width/2,. 
bottom_layer_thic~ness/2, 
9.0) . 

)otto.mLay~r _fix_front_fa~e ·= bottomLayerinstance. faces \ . .. 
· . • findAt((bottomLay.er_:-nx_f.ront.:...face_point,)) . 

bottomlayer _fix...;front_::region ~- regionToolset \ ·. . ,__ ·,;: "' . . . . . 
._Region (faces:;( bottomlayer .:._ f~x-front_ fac_e) )· 

corelayer_fix_front_face_point = (sandwich_width/2, core_layer_thickness/2, · 
~ e.e) 

corelayer_fix_front_face ~ corelayer!nstance.faces \ . . 
.findAt((corelayer_f~x_front_face_point,)) 

corelayer_fix_front_region = regionToolset \ .. 
.Region(faces=(coretayer~fix_front_face)) 

# ++++++++++++++I I I 1'1 I++ 1.1 I I I I I+++++++++ 

; 

I 
i 
l 

I 
I . I 
I 

I 
i 

I 
I 
I 

I 

J 
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·' tQptayer _lq,ad=.top_::f~ce_point = ( ~andWith::_~idth/2, t~~:lJayer _thickness. 
p.-- ' sandwich_length/2)_ 

~oplay~r _load_ top.:.., fat e = toplayerlnstance. faces \ , ... 
. findAt( (toplaye·r _load_top_face_point,)) 

..•• :# .. +++I I I I I I I +++f-i-+++++++++++++++++++++++ . 
· .. i treat e . a set •to ~e~sure displaceineht · history· out~ut '" 

··P ' ~~7~· y. • •• · : \·.:· ~ :1 ~; :H~; .~ ~ : ~ .. ·: ·<·· :: ... ~~i:~.;~t~~f-rtt.:/:r~ ·:<· ·i,_: ... ; .. _; · .-;~:r);:_;.:;,,. . _·! · ·._··. 

'' !.. For the first liis;tor:y point we use.,ooe of the uppe~ · corners of the core \ 
# layer inside one ·of i ·fs holes '. · ·· · . 
ver;-tex_coords_for_displacement_l · = (wall_thickness_core_cells, e.e~ 

, -; · :c - sandwich_length-wall_thickness_core .... cells) 
.·vertex_ for _displace'ment_l -,; coreLayerrnstance.vertices \ · . · 

. _ "'':.:.- . · . . .· .·.HndAt( (vertex_coords...:,for _displacemerft.:.l;)) 
· ·:~andwich,(\sserilbly .;~.e~ '( vertic.~~:;=v~rt~~~Jor:-i.d~splademel'!t.:::.J.; .: · · 

, · . · , . • name= '(:hsplaj:eme'nt; · po1 nt set 1 • ) . .. · 
. . .. y . . 

. ~ _·For. the se~:ond ;history point we use one of the lower corners at the end of 
# the bOttom layer, · 

. ,vertex_coord(_for _displacement_2 = (sandwich_width, e.e_, sandwich_length) 
' yertex_for_displacement_2 = bottomLayerinstance~ver~ices \ -

. • . . , ; -1.-.f~li9At( (vertex_coords_for _displacemel)t_2,)) 
· !1d~ichA'sse~_bly. Set ( vertices,;.,v~rte~~ for2_ displatement_2_, · 

. · ~ ;: ::. · , name;, ~d:l:s plia<::ement point set 2' ). 
'' ... , : ~ .' . . . . !, ,,, 

# i ~ I I I +++++++++++++++++++++++ I I I I I I I+++ 
_ # identify faces us!i!d to (Jefine . Surfaces in the assembly. These will later 
#\_:used f or· tie co!)straint·s . , · 

('s~ndwich_:width/2_, bottom_layer _thickness, 
.· . :. ' .. · ;~. · sandwich_length/2) 
oottomlayer _toj>_s~r'face = bottomlayerinstante. face;s ~ ' . ..• . .· .~ -

· " . . ··::. · · · :; • · .· , · } indAt((bottemLiiyer _top_surface_poi nt,)) · 
• 1 i : ' . --~ l. . ' 
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I 
,. 

/ .. '. 

I 
I 
I 
I 
I' 

I 
I 

regionl=sandwichAssembly.surfaces['Core Layer Top'] 
region2=sandwichAssembly.surfaces['Top Layer Bottom'] . 

sandwichModel. Tie(name='Constraint-1', master=regionl,. slave=region2, 
positionToleranceMethod=COMPUTED~ adjust=ON~ 
tieRotatio.ns.=ON, ·constraintEnforcement=SURFACE_TO_SURFACE, 
th-ickness~) 

· regio.nl=sandwichAssembly. surfaces [ • Core Layer Bottom'] 
' r-egion2=sandwicM,ssembly. surfaces ['Bottom Lay~t '·Top '·· 1.:. 

, .. 
sandwichModel.Tie(name='Constraint-2', master=regionl, ·slave=region2, 
· · positionToleranceMethod=COMPUTED, ~ adjust=ON~ 

.. tieRotations=ON, constraintEnforc~ment=SURFACE_TO_SURFACE, 

thickness=ON) 

# ----------------- - ---- - -------- - -- -------- --- - ----------------- -----
# Create the mesh 

import mesh 

# 11 1111111 Ill I 1111111 I 11 I 11 Ill+++++++++ 

# Mesh the top layer . 
# We place a point somewhere inside it based on our knowledge of the geometry 
toplayer _inside_coord.=(sandwich_w~dth/2, top_layer _:thiG~()ess/2, 

:.· . .. . . sandwich_lengtt)'l2) . 
1 ;. • 

· elemTypel = mesh.ElemType(elemcode=C308R, elemlibrary=STANDARD, 
. . ' kinematicSplit=AVERAGE_STRAIN, . 

secondOrderAccuracy=OFF• hourglassControl=DEFAULT, 
distortionControl=DEFAULT} 

.. 
topLayerCells=topLayerPart.cells 
selectedTopLayercells=topLayerCells.findAt(toplayer_ins~de_coord,} 
toplayerMeshRegion=(selectedToplayerCells,) 
topLayerPart. setElementType( regions=topLayerM.eshRegion,. 

elemTypes=(elemTypel,)) 

toplayerPart.seedPart(size"'e.04, deviationFactor=0.1) , 

~opL:ayerPa.rt. gener.at~~sh () .. , 
. 

. # + .++ I I I I I I I I I I t t I, t I .1 I I 'I I I I +++++++++++++ 

.# Mesh the bottom layer 
#We place a point, ~omewhere . inside it based on our knowledge of the geometry 

- bottomLayer _inside:_c;oord=.(sandwich_width/2, bottom_:layer _thickness/2, 
sandwich_le_n~h/2) · 

elemType2 = mesh. EleniType( el~mCode=C3D8R, e.lemlibrary=STANDARD, 
. kinematfcSpli t=AVERAGE_STRATN; . 

secondOrderAccuracy=OFF, · 
hourglasscontrol=DEFAUL T, :; Clis~O.rtionc·ontrol=DEFAUL T) 



19.5 Python Script to respond to the GUI dialog inputs 563 

! . · .·.·,bottomLayerCells::;bci:t:tomLayerPart .• ;cell.s ,~ . , · 
I . selectedBottomLayer€ells=bottomlayerCells.findAt(bottomlayer_inside_coord,) 
I bottomi..ayerMeshRegion;:(selectedBottomU~yerCells,) ·. · 
I .bottOiplayerPart.setElementType(regions_=:bottomlayerMesbRegion, 
j. .. · · e1eiiiTyp:Eis=(elemType2,) )--

!.: l:: bQtt()m'"ayerPCilrt.s~~dP;art{si~e=0.94, 'deviationFactor:=~·.l) · 
. _ <f~·_, .~ ~~ ~- ~<· :: · = .;:Lif~\U~~~;; ~ r 'i · : : _ _ x ·. :::~-- . . , . • ·-: . • <~ 

. , . ,~ ~bott_o'm~ayerP~rt ... generateMesti() _! ,~ c: :t:: ·__ ,~ ~ · .. 
' : • ; >, • • • : • - . • ~ :-. ..~ ~-

# +H+++++++IIJ. I U+·+i 'llll+++l 1111111 i I 11 
# Mesh the core layer ·· 

: # We· place a point .somewhere inside it based on our knowledge of the geometry 
... :# ·This point has already been defined ih the initial. calculations section as . 
. ··~# ·Gorelayer _inside ... coor.d · 

:.;: , . , ·· ·f . --~::: .. :: ,. :·;::;>>~::~:~-~'i:Y:~: .. ' ,. -.~:- .. . ,.. _ .. ,,., . 
mesh'.ElemType(ele~ode=c:aosR, . eleinLibrary=STANDARD, 

' ~ "' ldoematl.:CS;pJit,;.AVERAGE_ST~AlN, 
secondOrderAccuracy='OFF, holirglassControl=DEFAULT, 
~istortioocpntrol=DEFAULT) · · 

, corelayer.Cells=corelayerPart;. cells .· · .. · :. · : .· · 
· selectedCorelayer.C~l~:~=corelayercen~ ~,findAt (core layer _inside_coord,) . 
' t~reLay;erMeshRegio~~~se·l.~c~~~f!i9reLa~~r9ell~,) . · · .. :.!.: ~· • •• :.· ...•• 
. ~o~?etayerPart.setETementJype'(regions~t:or~'tayerMeshRegi.on, 

' ·· - . elemTyp-es={ elemType3 ~)) 
I 

corelayerPart.seedPart(sized0.04, deviationFactor=0.1) 

. (:OrelayerPart. genera~eMesh.() 

~-----~ 
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. # -: - ::---------
#Send XV· Data 
#' file 
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'19.6 Examining fhe Script .. _...__...._ - .. · 
This script is a modified version of the parameterized sandwich structure script from 
Chapter 15. Since it was already parameterized it is easy to link the user entered values to 
variables that affect the script. We shall only consider the newer bits here. 

I<J.§.~.l F~ncfi.on defin( · . . . . ~ ... ,;·.,;,··;! k ~ •{ - .J.on...- ~~~~ ~A-1'... ~ l..;,;.~.~~t.~ 
All of the processing wi 11 be done by our function createSandwichStructureO · 

f""l1ef-·-;:·r·eates~~"dwic·h-st·r-~ci.J~;·(~~~d"~-ic·t;=iengt"h-~ .. -· -~~-~d~i-c·h=~-iCi-tii·: ···top=·iaye~=t"h'i'~"k~~e·s .. ~·;··------·l 

1 core_layer_thickness, bottom_layer_thickness, i 
1

1 no_of_core_cells, wall_thickness_core_cells, J 

1 top_layer_material_name, bottom_layer_material_name, 1 

1 core layer_material_name, job name, write and print): i 

The function is called by the RSG dialog box when the OK button is pressed. All the 
keywords assigned to widgets are passed to this function along with the data values 
entered by the users, whether they are Strings, Floats, Integers or Boolean. 

Notice that many of the variable assignment statements that were present at the top of the 
script in parameterized sandwich structure example are now missing since all their values 
are obtained as parameters when createSandwichStructureO is called. 

[9.6.2 Miateri81 vari~bl~ assip.Oen~ ..... 
This block deals with assigning material properties to variables. 

steel_density = 7899 
steel_youngs_modulus = 2e0E9 
steel_poissons_ratio = 0.29 

---~ 

I aluminum_density = 277e 
aluminum_youngs_modulus = 73.1E9 
aluminum_poissons_ratio = e.33 

if top_layer_material_name == "Aluminum": 
top_layer_material_mass_density=aluminurn_density 
top_layer_material_youngs_modulus=aluminum_youngs_modulus 
top_layer_material_poissons_ratio=alurninurn_poissons_ratio 

else: 
top_layer_material_mass_density=steel_density 
top_layer_material_youngs_modulus=steel_youngs_modulus 
top_layer_material_poissons_ratio=steel_poissons_ratio 

I 
I 
' 
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if core_layer_material_name == "Aluminum": 
core_layer_materi al_mass_density=aluminum_density 
core_layer_material_youngs_modulus=aluminum_youngs_modulus 
core_layer_material_poissons_ratio=aluminum_poissons_ratio 

else: 
core_layer_material_mass_density=steel_density 
core_layer_material_youngs_modulus=steel_youngs_modulus 
core_layer_material_poissons_ratio=steel_poissons_ratio 

if bottom_layer_material_name == "Aluminum": 
bottom_layer_material_mass_density=aluminum_density 
bottom_layer_material_youngs_modulus=aluminum_youngs_modulus 
bottom_layer_material_poissons_ratio=aluminum_poissons_ratio 

else: 
' bottom_layer_material_mass_density=steel_density 

I 
!.·-·-······················· ......... ;.~;;~:~t;.~;~~;;;_;_~~-;-~~~-~-~;_;~;:~-~-~-~-;;~~-;;i.~~-~~-~;~;:.~~~-~-;···- ... .,., ........................................... ······-··.! 

Recall that the user selects the material of the top layer using a combo box with the 

options 'Steel' and 'Aiuminum ' and the keyword top_layer_material_name. The core 
layer is selected using one of the radio buttons both of which share the same keyword 

core_layer_material_name. The bottom layer is selected using a list with the keyword 

bottom_layer_material_name. In all 3 cases, the variables will either have the String 

"Aluminurn" or "Steel" stored in them depending on the user's choice. The above 

statements then proceed to assign the appropriate material properties to the layers (or to 

variables that will later be assigned to the layers). 

Here we create the materials themselves using the property variables created earlier. 

,-----·-------
# - --- --- - -- ------------------------- ----- - -- -------------------------
# Create material 

import material 

# Create materials for the top, bottom and core plate by assigning mass 
# density, youngs modulus and poissons ratio 
topPlateMaterial = sandwichModel.Material(name='Top Plate Material') 
topPlateMaterial.Density(table=((top_layer_material_mass_density, ), }) 
topPlateMaterial.Elastic(table=((top_layer_material_youngs_modulus, 

top_layer_material _poissons_ratio), }) 

coreMaterial = sandwichModel.Material(name='Core Material') 
coreMaterial.Density(table=((core_layer_material_mass_density, ) , )) 
coreMaterial.Elastic(table=((core_layer_material_youngs_modulus , 

l . core_layer_material_poissons_ratio) , )} 
!.. ______ , ...... ~········-···········-"···· · ······-····--················ ····--········-··· ··-· ····· ·-"'''''"""''''''"''""'''-· ···-·····-··-···-·······"'''''' ''"*"""'' '""'"''''' '' '''' ''''''-''''-··-···---------·--···· ··""'''''"' ..... ~ .. --··-····"'"'"''-····-·-·--·-··----·-···-·--· - -·- -···- ----····i 
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bottomPlateMaterial = sandwichModel.Material(name='Bottom Plate Material') 
bottomPlateMaterial. Density(table=((bottom_layer_material_mass_density, ). )) 
bottomPlateMaterial.Elastic(table=( (bottom_layer_Material_youngs_modulus, 

bottom_layer_material_poissons_ratio), )) I bottomPlateMaterial.Elastic(table=((bottom_layer_material_youngs_modul us, 
L~o_t_t'?m __ layer _material_poissons_:at_~].!..jJ_ ________________________ , 

The block of code that creates the materials has been modified to work with the changes 
to the material variable names, and the fact that each part can be assigned a material 
independent of the others. 

19.6.4 - Create the sectiolls - . . 
...... •.. . ~ 

This block creates the sections. 

# -------------------------------- - ----- -------------- ----------------
# Create solid section and assign the beam to it 

import section 

# Create a section to assign to the top layer 
topLayerSection = sandwichModel \ 

.HomogeneousSolidSection(name='Top Layer Section', 
material='Top Plate Material') 

# Assign the top layer to this section 
top_layer_region = (topLayerPart.cells,) 
topLayerPart.SectionAssignment(region=top_layer_region, 

sectionName='Top Layer Section') 

# Create a section to assign to the bottom layer 
bottomLayerSection = sandwichModel \ 

.HomogeneousSolidSection(name='Bottom Layer Section', 
material='Bottom Plate Material') 

# Assign the bottom layer to this section 
bottom_layer_region = (bottomLayerPart . cells,) 
bottomlayerPart.SectionAssignment(region=bottom_layer_region, 

sectionName='Bottom Layer Section') 

# Create a section to assign to the core layer 
coreLayerSection = sandwichModel \ 

L 
.HomogeneousSolidSection(name='Core Layer Section', 

material='Core Material') 

# Assign the core layer to this section 
core_layer_region = (coreLayerPart.cells,) 
coreLayerPart.SectionAssignment(region=core_layer_region, 

I 
I 
! 

.I 
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sectionName='Core Layer Section') 

We have only modified this block to point to use the new material variables. 

This block looks to see if the checkbox has been checked or not, and if it has it writes an 
XY report and also prints out the displacement. 

r- ·- ··-·····························-··············· .................. ___________ ................................... "··- ............ ------·-·---·-··-- .................... ·- ···-··-········-·······- ·····-·-······--··- ........................................................................ . 

. # ==================================================================== 

i 

I 

# - - ----- - - -- -------- --- -- - -------------------------------------------
# Post processing 
# --------------------------------------------------------------------
# ==================================================================== 

if write_and_print: 

# --------- - --------- - ---------------------------------- - -------- -
# Send XV Data for U3 displacement of bottom and top points to an output 
# file 

import odbAccess 
import visualization 

sandwich_odb_path = job_name + ' .odb' 
sandwich_odb_object = session.openOdb(name=sandwich_odb_path) 

l 

I 

I t__ __ _____ _ 
----.. ·--.. - -·-.. ·--·--.. ·--·----------- --------- - -- --··- ----- --·--·----·' 

The variable write_and_print contains a Boolean value indicating whether the checkbox 
"Write Report and Print Displacement" in the RSG dialog box was checked or not. The if 
condition decides whether or not to run the post processing script based on this. 

In this chapter, you discovered that the RSG is, as its name suggests, "really simple". 

You can rapidly create a dialog box with useful widgets, and hook it up to a kernel script. 
This script needs to have a function that accepts the data from the widgets as inputs. The 

RSG is suitable for a simple GUJ interfaces, and the fact that it gets stored as a Plug-in 
makes it accessible within all instances of Abaqus/CAE. 
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20 -

Create a Custom GUI Application 
Template 

. ~ 

GUJ Customization allows Abaqus users to modify or customize the Abaqus/CAE 
Interface. The analyst can change the look and feel of Abaqus/CAE to a great extent, 
creating his own modules, menus, toolbars, tool buttons and dialog boxes. He can also 
remove existing Abaqus/CAE modules and toolsets. 

This technology has many uses. Think of a company or research institute that, for the 
most part, runs a handful of analyses on a regular basis with minor changes to these. A 
vertical application can be built with much of the repetitive tasks automated with scripts, 
giving the analyst the ability to make only certain allowed changes, and automating the 
rest of the process. This type of automation of in-house processes is of great use to some 
organizations. 

This may be compounded by the fact that a lot of the personnel working on a project are 
not very proficient at using Abaqus, but need to harness its functionality and run 
simulations within a narrow framework. An application can be created which guides 
them through the process step by step, prompting them for inputs and hiding most of 
complexity of the Abaqus interface from them. 

GUI Customization does not require an entire automated application to be built, it can be 
used to create plug-ins which accomplish a single specific task and have a well designed 
interactive interface suited to this. 
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You need to understand the fundamentals of Abaqus GUI development before we attempt 

to write a script. Jt is important that you read the following sections and understand them 
before we get into our GUt example. 

Abaqus extends the functionality of a party open source GUI toolkit called the FOX 
toolkit. FOX is a cross platform C++ based toolkit for creating GUls. If you wish to learn 
more about this toolkit you can visit their website at http://wwwJox-toolkit.org/. 

Abaqus provides a Python interface to the Abaqus/CAE C++ GUI toolkit. This interface, 
or toolkit, is called the Abaqus GUI Toolkit. 

In order to design an Abaqus GUI Application it is very important that you understand 
the GUI infrastructure - the components that constitute the GUI, and how they work 
together. 

1. The top most component is the application object itself. This is an object of type 
AFXApp which you will learn more about in a little bit. 

2. The application consists of a window with the GUI infrastructure. AJI custom 
Abaqus applications have this basic look. The window consists of 
a) a title bar, 

b) a menu bar, 

c) one or more tool bars, 
d) a context bar which consists of the module control and context controls 
e) a tree area which displays the model tree or output database tree 
f) a module toolbox with tool buttons 

g) a canvas area where the parts, assemblies, renderings and so on are displayed 
h) a prompt area below the window 
i) and a message area (which can be switched with the command line interface) 

These are marked in the figure. The main window itself is an object of type 
AFXMainWindow. 
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3. Within the main window you have modules and toolsets. Modules are clearly 

marked in Abaqus/CAE with the word "Module:" and a combo box (drop down 
menu) listing the different modules such as Part, Property, Assembly, Step, 
Visualization and so on. This combo box is visible in the context bar (d) in the 
figure. Modules are of type AFXModuleGui. Tool sets on the other hand are the 
buttons displayed right next to the canvas in the same area as module toolboxes 
(f). However they are different from module toolboxes in that module toolboxes 
change depending on which module you are in whereas toolsets remain there no 
matter which module you are in. Toolsets are of type AFXToolsetGui. 

4. Within the modules you have menus, toolbars and module toolboxes. As you 
switch modules, these change. Menus have panes which are of type 
AFXMenuPane, and within these you have the menu title AFXMenuTitle and 
menu items AFXMenuCommand. Toolbars exist as groups of type 
AFXToolbarGroup and they are made up of toolbar buttons of type 
AFXToolButton. Toolboxes also exist as groups of type AFXToolboxGroup 
and these consist oftoolbox buttons AFXTooiButton similar to toolbars. 

5. The menus, toolbar buttons and toolboxes launch modes. Modes get input from 
the user and issue a command. There are two types of modes - form modes and 
procedure modes. 
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Form modes create a dialog box where the user can type in inputs or select 
options using checkboxes, radio buttons, lists and so on. For example, when you 
click on View> Part Display Options, you see the Part Display Options dialog 
box. You can select your options here and when you click Apply a command is 
issued to the kerneL Form modes do not allow the user to pick anything in the 
viewport. Form modes are of type AFXForm. 
Procedure modes on the other hand prompt users to make selections in the 
viewport and then use this information to execute a kernel command. So for 
example, if you try to define a concentrated force in the loads module, Abaqus 
prompts you to select the nodes on which to apply it and you pick the nodes in 
the viewport window. This is a procedure mode. Procedure modes can have 
multiple steps. They can also be used to launch dialog boxes. Procedure modes 
are of type AFXProcedure. It is also possible for menu items, tool bar buttons or 
toolbox buttons to launch a dialog box that is not associated with a form or 
procedure. This type of dialog will not communicate with the kernel, only with 
the GUI (more on this later). Such a dialog box will be of type AFXDialog. 

6. Form modes launch dialog boxes of type AFXDataDialog. These are different 
from the previously mentioned AFXDialog because AFXDataDialog dialog 

boxes send commands to the kernel for processing. Procedure modes create 
objects of type AFXPickStep and can also launch dialog boxes of type 
AFXDataDialog. 

7. Dialog boxes are made up of layout managers such as AFXVerticaiAiigner 
which creates a vertical layout, and many others which we shall discuss later. 

8. The layout managers contain within them the widgets such as labels (FXLabel), 
text fields (AFXTextField), radio buttons (FXRadioButton) and so on. 

It is important that you understand the above structure and recognize the names of the 
classes. Scripts written to target the Abaqus GUI Toolkit usually span multiple .py files 
and it can get a little confusing to keep track of what goes where if you don't fully 

understand the structure. 

In the previous section we mentioned AFXDialog and AFXDataDialog, and briefly 

spoke of how one (the second one) sends commands to the kernel while the other (the 
first one) does not It is important to understand that when you create a custom Abaqus 

GUI, you have two types of processes running simultaneously - GUI processes and 
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kernel processes. GUI processes execute GUI commands and kernel processes execute 
kernel commands. 

You've already seen kernel commands. All of the scripts written up until this point were 
kernel scripts. They interacted with the Abaqus kernel in order to set up your model, send 
it to the solver, and post process it. To elaborate further, only a kernel script can have a 
statement such as 

mdb.Model(name=My Model, modelType=STANDARD_EXPLICIT) 

or 

myPart = myModel.Part(name='Plate', dimensionality=THREE_D, type = DEFORMABLE_BODY) 

ModeiO and PartO are commands that are executed by the Abaqus kernel. Kernel scripts 
usually have the following import statements at the top 

from abaqus import * 
from abaqusConstants import * 

GUI scripts on the other hand only deal with GUJ processing. They create the GUI, and 
can issue Python commands, but not commands that target the Abaqus kernel. They 
usually have the import statement 

from abaqusGui import * 

at the top. 

GUI and kernel scripts must be kept separate. You cannot have "from abaqus import *" 
and "from abaqusGui import *" in the same script as a script must either be purely GUI 
or purely kernel. 

Since the GUT must eventuaJiy issue commands to the kernel, a link must be established 
between GUI and kernel scripts. This is usually done using a mode. For example, a form 

mode (AFXForm) launches a dialog (AFXDialog) which contains the GUI commands 
necessary to display widgets (checkboxes, text fields, labels etc), and when the OK 
button is pressed in the dialog box the form calls a command in a separate kernel script. 
This way the GUI and kernel scripts are kept separate and one calls the other through the 
use of a mode. Another method is to use send CommandO method. You will see both of 
this demonstrated in the next chapter, but it is essential that you learn these concepts right 
now. 
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In this example we create a basic GUI application. As such it does not execute any kernel 
scripts; it is just a GUl with no real functionality. However it is a complete framework, 
and we will be using it for the example in the next chapter. More importantly, this code 
framework can be reused by you in all GU I scripts you write in the future, as it serves as 
a stable base off which you can build. 

The GUI application is created using a number of scripts. We will examine each of these 
scripts in turn, but first an overview so that you see the bigger picture. 

• customCaeApp.py is the application startup script. It creates the application 
(AFXApp) and calls the main window 

• customCaeMainWindow.py creates the main window (AFXMainWidnow). It 
registers the too1sets and modules that will be part of the application. These 
toolsets and modules include standard ones as well as custom ones made by us. 

• modifiedCanvasToolsetGui.py creates a modified version of the Viewport 
menu which you see when you open Abaqus/CAE. It will adds a few new menu 
items to the Viewport menu, removes others that exist by default, adds a couple 
of horizontal separators in the menu pane, and changes the name of the Viewport 
menu to 'Viewport Modified'. 
When menu items or toolbar buttons are clicked in this modified viewport 
tool set, the form mode, defined in demoForm.py, is called to post the dialog box 

which is defined in demoDB.py 
• customToolboxButtonsGui.py creates a new toolset (AFXToolsetGui). The 

toolset buttons which appear to the left of the canvas (along with module 
tool boxes) will be visible in all modules. 
When buttons in this toolbox are clicked, the form mode defined in 

demoForm.py is called to post the dialog box defined in demoDB.py 

• customModuleGui.py creates a new module (AFXModuleGui) which appears 
in the module combobox as 'Custom Module' . This module has a menu 
(AFXMenuPane) called 'Custom Menu' associated with it, a toolbar 
(AFXToolbarGroup) called 'Arrow Toolbar' and a toolbox group 
(AFXToolboxGroup ). All of these are only visible when the user is in the 
custom module. 
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When most of the menu items. tool bar buttons or tool box buttons are clicked in 
this custom module, the form mode defined in demoForm.py is called to post 
the dialog box defined in demoDB.py. However to change things up, one of the 
menu items instead posts a modeless dialog defined in demoDBwoForm.py 
without calling any form mode. This is to demonstrate how you launch a 
modeless dialog box. 

• demoForm.py creates a form mode (AFXForm) which will post the dialog 
created in demoDB.py and will issue a command when the OK button is clicked 
in that ~ialog. 

• demoDB.py creates the modal dialog box (AFXDataDialog) that will be posted 
by the form mode of demoForm.py 

• demoDBwoForm.py creates a modeless dialog box - one that is posted without 
any form. 

~.6 . Pyt~on. Scr~pt . . . ·' :. t • . 

We shall now look at each of the script files in turn. Remember that these must ~11 exist 
together in the same folder for the application to work. 

·20.().1 · Application:StaJ!.al~ript ;.,! • . .•. 

This script is contained in customCaeApp.py. It is the application startup script - it 
creates the application (AFXApp)- and calls for the creation ofthe main window 
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This script is called a startup script. All applications made using the Abaqus GUI toolkit 
must be launched using a startup script. You are unlikely to make any changes to this 
script in your own applications except to the name of the main window script. 

from abaqusGui import AFXApp 

This statement imports the AFXApp constructor from the abaqusGui module. 
abaqusGui allows you to access the Abaqus GUI Toolkit. 

You could instead have written 

from abaqusGui import * 

The statement 

import sys 

imports the sys module. This module is required to pass arguments to the initO function 
in a subsequent statement. 

from customcaeMainWindow import CustomCaeMainWindow 

This statement imports the main window constructor which we define m the 
CustomCaeMain Window class in the script customCaeMain Window.py 

# Initialize application object 
#In AFXApp, appName and vendorName are displayed if productName is set to'' 
# otherwise productName is displayed. 
app = AFXApp(appName='ABAQUS/CAE', 

vendorName='ABAQUS, Inc.', 
productName='Custom GUI Application', 
majorNumber=l, 
minorNumber=l, 
updateNumber=l, 
prerelease=False) 

app.init(sys.argv) 
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AFXAppO is the constructor for creating an instance of the AFXApp class. Among the 
arguments passed to it appName is the application registry key, vendorName is the 
vendor registry key, productName is the name of the product, majorNumber is the 
version number, minorNumber is the release number, updateNumber (not used here) is 
the update number, and prerelease is a boolean indicating if it is official or prerelease. 
The registry keys appName and vendorName are not actually used by Abaqus in the 
current version (6.1 0), however they may provide capabilities in future versions of the 
software. The title of the main window is created using the remaining arguments. It will 
appear as "productName + "Version"+ major+"."+ minor+ "-"+ update. lfprerelease 
= TRUE then "PRE" will appear before the update number. Note however that if a title is 
supplied to AFXMainWindow (in our example this would be in the file 
customCaeMainWindow.py) that title will override this one. 

initO is used to initialize the application object represented by the AFXApp instance. 

The application object, which is an instance of AFXApp, is responsible for updating the 
GUI, managing the message queue and other related tasks. Its constructor creates the data 
structures needed for the application to function. One application object must be created 
for each application. 

CustomCaeMainWindow(app) 

This statement creates an instance of the mam window which is defined in the 
CustomCaeMainWindow class in customCaeMainWiodow.py. 1t passes the AFXApp 
object to the _init_ method of CustomCaeMainWindow. In plain English this 
statement creates the main window. 

app.create() 

This statement creates the application. More specifically it causes the creation of required 

GU I windows. 

app.run() 

This statement runs the application. The application is displayed and it enters an event 
loop. An event loop is a state in which the application waits for "events", usually actions 
perfonned by a user, and reacts accordingly. 
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20.6.2 .: Main Window, 
This script is contained m customCaeMainWindow.py. It creates the mam window 
(AFXMainWidnow), and registers the toolsets and modules that will be part of the 
application, including the custom ones made by us. 

r;-·;;;·;;;;-;;;·;;·;;**·*****•*"'*-*-;.-;:;;;*-**-**·;·;·~;;;;;·;;-,;·;·;·;;·;·;;.··;·;;;.*-;;;·;;-;;;;;;-;;-;-;;·;-,;;-;;;·;;-,;···-·-·-1 

[ # This scr.ipt defi11es: t he· m~in -~indow of,:the custom Abaqu~/CAE application . 
i # ****t*.*************'***"********~**************************~********************** 
j . . . . ~ ' • 

I from abaqusGui import ·• 
! from sessionGui importi ~ I from quwasGui import . tanvasToolsetGui · . 
J from viewManipGui import ViewManipToolsetGui 
; from ·modifiedCanvasToolsetGui ·import M<J~~fiedCanvasToolsetGui 
I from (WStomToolboxButtonsGui impo~t Cu~toniToolboxButtcinsGui I # D~firl~ the class . ;: ; : : . - . . ~· .'. ' . . . .. 

I class CustomcaeMainWindow.(AFXMainWindow); : I def ._init_(self, · app, windowTitle=' ~): 
1 AFXMainWind.ow.~init_(self, app; windowTitle) 

I 
' ' ~ # Reg.is.te'r too1S~ts , . . 

. . , ... . self. registerToolset( FileToolsetGui(), GUI_IN_MENUBAR I GUI_IN_ TOOL BAR) _ 
·self.registerToolset(ModelToolsetGui(), GUI_IN_MENUBAR) 
self. registerToolset(ViewManipToolsetGu~ (), GUI_IN_MENUBARIGUI_IN_TOOLBAR) 

· .. # The following ·statement would normally be used to register the viewport 
. . : # 111enu in its or,iginai form· · · · ; .. · 
-:# self.~egist~r;foo~set(CanvasTqol_setGui(), GUI_IN_MENUBAR) , 

#. We will inst@a~ rejHace ·the ''<\.~i'ewport menu with ·a ·inodl,fied version of it 
self. register-ToOlset (ModifiedtanV,astoolset~ui,(), GUI:_::IN_MENUBAR) 
• • • • • • ' • ._.. . . • .• ~ • • ~'<.. ;> • • • : ' • 

' ·:· __ :;. 

.<·# Register the custom toolset for adding custom toolbox buttons 
- .: self. registerToqlset ( CustomToolbO_xButtonsGui () , ~UI..:.IN_ TOOL BOX) 

~l ·:# .The followingJ statement ·w~uld nonnal'ly be used to register the help 
:,' 1t :menu/toolset ~ri d.ts original form ·: . . . ·;- - · 
.;#,r~#; s~lf. reg~sterlil~~pTool~et (~~lpTo9:ls~tGtii() ~ , . · : 

.. '# - . . . . . . - "'q;;;;,.·: . · ·. GOI~!t()'iENUBARIGUI_IN_TOOLBAR) 
. ·~: ·# We will : re·pla.ce:'th.is wi th a custom .help tool set with :our own copyright . 

. ,,# info hence we·: convnent this out , · . . . 
. : # Modify Help >"About Abaqus . • • _ dialog to include <;ustom copyright . 

· , # information : - - · 
'.1; . • > 

. customHelpToolsetGui = HelpioolsetG~i() · 
" ·' abaqus-'produc~_l)}~me = getAFXApp( ~ ~getProductName ( )' 

major _version.:;_flo,; ' minqr:-_v~rsiqn::_n~L ;!Jpdate.:._no· ::: \ , .. '- . 
·1}< ~ · ~ · . ~, ~ · · . .. ' ·.: · · · getAFxApp() .getversionNumbers() 

.. : ~ -' ;is~is,_~erel~~se . = . getAF~pp() ;:getPrerelease_,(_,_) --'-~---"----..:___:__ 
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from abaqusGui import • 
from sessionGui import * 
from canvasGui import CanvasToolsetGui 
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from viewManipGui import ViewManipToolsetGui 

The script begins by importing required modules. abaqusGUI allows the script to work 
with the Abaqus GUI Toolkit. It also defines the existing modules and toolsets. 

from modifiedCanvasToolsetGui import ModifiedCanvasToolsetGui 

This statement imports the ModifiedCanvasToolsetGui class from the script 
modifiedCanvasToolsetGui.py. ModifiedCanvasToolsetGui contains our instructions 
on how the canvas toolset (which is the toolset that displays the Viewport menu) should 
be modified in our custom application. We will register it a few statements later. 

from customToolboxButtonsGui import CustomToolboxButtonsGui 

This statement imports the CustomToolboxButtonsGui class from the script 
customToolbox.ButtonsGui.py. CustomToolboxButtonsGui contains our instructions 
on creating custom toolbox buttons that appear just to the left of the viewport. We will 
register it a few statements later. 

class CustomCaeMainWindow(AFXMainWindow): 

Our class CustomCaeMainWindow is derived from AFXMainWindow. This must 
always be done when creating the main window. 

def __ init __ (self, app, windowTitle=''): 

The _ioit_ method can be considered (for the sake of simplification) to be the 
constructor of the class. When CustomCaeMain WindowO IS called m 

customCaeApp.py it is this method that is executed. The _init_ method must register 
toolsets and modules. All modules and toolsets registered within it are "persistent" 
meaning that they are visible the moment the custom GUI application starts, and remain 

visible no matter which module the user switches to. It accepts two arguments, an 
application object (of type AFXApp) and a String that will appear in the title bar. 

AFXMainWindow. __ init __ (self, app, windowTitle) 

Ths statement calls the _init_ method of the base class (AFXMainWindow) which, to 
put things simply, takes care of a lot of stuff required for creating the main window that 
we don't need to know about. 

# Register toolsets 
self.registerToolset(FileToolsetGui(), GUI_IN_MENUBARIGUI_IN_TOOLBAR) 
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self.registerToolset(ModelToolsetGui(), GUI_IN_MENUBAR) 
self.registerToolset(ViewManipToolsetGui{), GUI_IN_MENUBARIGUI_IN_TOOLBAR) 

The registerToolsetO method is used to register persistent toolsets (toolsets that are 
always visible no matter which module you are in). Here the file, model and view 
manipulation toolsets are registered. FileToolsetGui displays the File menu and the File 
toolbar. ModeiToolsetGui displays the Model menu. ViewManipToolset displays the 
View menu. lt is required that every application register viewManipToolsetGui. 

The registerToolsetO method takes care of the actual registering. It is called when 
modules are constructed. Its first argument is the toolset (of type AFXToolsetGui) and 
the second one is a set of location options separated with a 'I ' for creating the toolset 
components. The available options are GUI_IN_NONE (no components), 
GUI_IN_MENUBAR (components in menubar), GUI_IN_TOOLBAR (components in 
toolbar) and GUI_IN_TOOLBOX (components in toolbox). 

self.registerToolset(ModifiedCanvasToolsetGui(), GUI_IN_MENUBAR) 

This statement registers the modified version of the canvas toolset we create in 
modifiedCanvasToolsetGui.py. CanvasToolsetGui displays the Viewport menu. We 
will dissect that script a later in this chapter, but for now just know that it changes the 
title of the Viewport menu to ' Viewport Modified' . Hence the menu bar in our custom 
application will look as shown in the following figure. Notice the menu titled 'Viewport 
Modified ' . 

1111 file .Model View Viewport Modified fart Shcspe featyre Iools Help ~? I 
If you did not wish to modifY this menu as we have done here, you would instead have 
used: 

self.registerToolset(CanvasToolsetGui(), GUI_IN_MENUBAR) 

The statement 

self.registerToolset(CustomroolboxButtonsGui(), GUI_IN_TOOLBOX) 

registers the custom toolset we create in customToolboxButtonsGui.py. We will 
examine this script later in this chapter, for now just know that it will create 5 toolset 
buttons labeled ' A' , ' B', 'C' , ' D' , ' E' that will be displayed in the toolbox to the left of 
the viewport as displayed in the following figure. 
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....--------------------------····---------·-----·-· ·-------- ....... , 
abaqus_product_name = getAFXApp() .getProductName() 
rnajor_version_no~ minor_version_no, update_no = \ l! 

getAFXApp().getVersionNumbers() 
is_this_prerelease = getAFXApp().getPrerelease() 
if is_this_prerelease: 

version = '%s Version %s.%s-PRE%s' % (abaqus_product_name, 
major_version_no, 
minor_version_no, 
update_no) 

else: 
version '%s Version %s.%s-%s' % (abaqus_product_name, 

major_version_no, 
minor_version_no, 
update_no) 

custom_title = 'Custom GUI Framework that you can modify and reuse' 
custom_information 'Python Scripts for Abaqus - Learn by Example ' + \ 

'\n Gautam Puri \n Copyright 2e11' + \ 
'\n Running Abaqus ' +version 

customHelpToolsetGui.setCustomCopyrightStrings(custom_title, 
custom_information) 

custom_icon=afxCreatelcon('icon_bookcover.png') 
customHelpToolsetGui.setCustomLogoicon(custom_icon) l 
self.registerHelpToolset(customHelpToolsetGui, j 

~· - ---------·- ······--· GUI IN_MENUBARIGUI IN T00~-~~~1-----·---------

This block modifies the About Abaqus dialog box displayed through Help > About 

Abaqus ... Normally (if you wished to leave the help menu alone) you would use the 

statement: 

self.registerHelpToolset(HelpToolsetGui(), GUI_IN_MENUBARIGUI_IN_TOOLBAR) 
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However in this example we demonstrate how to modifY the help dialog box with our 
own image and custom copyright information. This block makes the About Abaqus 
dialog box appear as displayed in the following figure: 

l!J About Abaqus 

PYTHON SCRIPTS 
FOR ABAQUS 

... 
Custom GUI Framework that you can modify and reuse ~=',~!''. 

Python Scripts for Abaqus -learn by Example 1 
Gautam Puri 
Copyright 2011 
Running Abaqus Custom GUI AppHcation VersiQn ll·l 

Abaqus/CAEStud~nt Edition 6.10-2 

Build I0:2010_09_2l·15..58A71029l3 
Q Oassault Systemes, 2010 

The Abaqus Software is a product of Dassault Systemes Simulia Corp., 
Providence, RI. USA. 
The Abaqus Software is available only under license from Oassault Systemes 
or its subsidiary and may be used or reproduced only in accordance 
with the terms of such license. 

Abaqus, the3DS logo, S.IMUUA. CATlA, and Unified FEA are trademarks or 
r . fl'fi tnulP.rn11rlc<: nf Ollo;<:~~ult Sw. itc: "" <:icii11r in th 

customHelpToolsetGui = HelpToolsetGui() 

We create customHelpToolsetGui as an instance of the help toolset. 

abaqus_product_name = getAFXApp().getProductName() 
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The getAFXAppO method returns the application object. The application object has a 

number of methods. A few of the commonly used ones are getAFXMainWindowO 

which returns a handle to the main window object, getProductNameO which returns the 

product name, getVersionNumbersO which returns a tuple containing the major version 

number (majorNumber), minor version number (minorNumber) and update number 

(updateNumber), and getPrereleaseO which returns a Boolean (True if the application 

is a. prerelease, False otherwise). 

The getProductNameO method of the application object is used here to get the product 

name. 

~ajor_version_no, minor_version_no, update_no = \ 
getAFXApp().getVersionNumbers() 

Here the getVersionNumbersO method is used to obtain the major, minor and update 

numbers. 

is_this_prerelease = getAFXApp().getPrerelease() 

Here getPrereleaseQ is used to find out if the version of Abaqus is a prerelease version. 

if is_this_prerelease: 
version = '%s Version %s.%s-PRE%s' % (abaqus_product_name, 

major_version_no, 
minor_version_no, 
update_no) 

else: 
version = '%s Version %s.%s-%s' % (abaqus_product_name, 

major_version_no, 
minor_version_no, 
update_no) 

Depending on whether the version is prerelease or not, a String is created with the 

product name, major, minor and update numbers, and the letters 'PRE'. 

custom_title = 'Custom GUI Framework that you can modify and reuse' 
custom_information = 'Python Scripts for Abaqus - Learn by Example • + \ 

'\n Gautam Puri \n Copyright 2911' + \ 
' \n Running Abaqus ' + version 

customHelpToolsetGui.setCustomCopyrightStrings(custom_title, 
custom_information) 
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The setCustomCopyrigbtStringsO method allows you to set the title and the 
information in the About Abaqus dialog box. These strings are provided as arguments to 
the method. 

custom_icon=afxCreateicon('icon_bookcover.png') 

The afxCreatelconO method creates an icon using a provided image file and returns a 
handle to it. The file can be in the following formats - bmp, gif, png and xpm. The 
method automatically determines which of these file formats is being used from the 
extension and does the needful. 

customHelpToolsetGui.setCustomlogoicon(custom_icon) 

The setCustomLogolconO method creates a logo or image using the icon provided as an 
argument and displays it in the About Abaqus dialog box as displayed in the figure. 

self.registerHelpToolset(customHelpToolsetGui, 
GUI_IN_MENUBARIGUI_IN_TOOLBAR) 

We now register our modified help toolset with the registerHelpToolsetO method. Note 
that this is different from registerToolsetO·which we used for all the other toolsets. 

self.registerToolset(AnnotationToolsetGui(), 
GUI_IN_MENUBARIGUI_IN_TOOLBAR) 

self.registerToolset(DatumToolsetGui(), GUI_IN_TOOLBOX) 
self.registerToolset(EditMeshToolsetGui(), GUI_IN_TOOLBOX) 
self.registerToolset(PartitionToolsetGui(), GUI_IN_TOOLBOX) 
self.registerToolset(QueryToolsetGui(), GUI_IN_TOOLBOX) 
self.registerToolset(RepairToolsetGui(), GUI_IN_TOOLBOX) 
self.registerToolset(SelectionToolsetGui(), GUI_IN_TOOLBAR) 
self.registerToolset(TreeToolsetGui(), GUI_IN_TOOLBDXIGUI_IN_MENUBAR) 

These statements register a number of other default toolsets available in Abaqus/CAE. 

# Register the modules. These will appear in the Modules combo box in 
# Abaqus/CAE in the order they are registered here 
self.registerModule('Part', 'Part') 
self.registerModule('Property', 'Property') 
self.registerModule('Assembly', 'Assembly') 
self.registerModule('Step', 'Step') 
self.registerModule('Interaction', 'Interaction') 
self.registerModule('load', ' load') 
self.registerModule('Mesh', 'Mesh') 
self.registerModule('Job', 'Job') 
self.registerModule('Visualization', 'Visualization') 
self.registerModule('Sketch', 'Sketch ' ) 
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The registerModuleO method registers modules. These become available in the Module 
combo box above the viewport. 

# Register our custom module which resides in the script file 
# customModuleGui.py 
self.registerHodule('Custom Module', 'customModuleGui') 

This statement registers the toolset 'Custom Module ' which we create m 
customModuleGui.py and makes it available in the Module combo box. Note that we 
did not use an import statement at the top of the script to import customModuleGui.py 
because register Module will take care of that for us. The Module combo box will now 
appear as shown in the figure. 

Module: Part 

A B Part 
Property 

_c __ -tAssembly 

E F 

Gim 

~ . 
~. 

Step 

~. Sketch 

Custom Module 

fj; 11~-~---

This script 1s contained in modifiedCanvasToolsetGui.py. In it we modify the 
Viewport menu that is normally displayed in Abaqus/CAE. We add a menu item called 

'Custom Menu Item'. When 'Custom Menu' is clicked it will launch a dialog box. This 
dialog box is an instance of DemoDb created by use in demoDB.py. Being a modal 

diaJog box it is launched by a form mode DemoForm which we create in demoForm.py. 
(You will see how it is created when we focus on that script). We also remove the menu 
items Cascade, Tile 1-Jorizontally, Tile Vertically and Delete Current. 

The following figure displays the usual Viewport menu as well as our modified version 
of it - Viewport Modified - for easy comparison. 
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I ViE:wport Modified 

~reate 

Custom Menu Item 

Annotation M~nager ... 

Cteate Annotation ... 

~dit Annotations ... 

Vit!Wport Annotation Qptions ... 

linked Viewports ... 

v l Viewport: 1 
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---·--:Add -:~~ i~~~-~:-~::-menu a~~er -:~-~~~:~t~ it:~---- -----·---1 
# We use ·A_ ~XMOde.; ID,_ACT.IVATE to cause the mQde Demo Form in demoform. PY to l 
# activate,. whic~ causes it to display its form oemoDB which is 
# in .demorie·.py"· -b~ ' · · ~' · · 

. new.:_viewJ)o'r~ ... menu:)~em = ·AFXMEmucomand(self, . 
· viewport~meriu_with_contents, 

•'Custom Menu Item • , 
Non~; . 
Demi>Forl!l(s~~:f)"', 

, -.; '.:. ,_ ' AFXMode.rD..::ACTIVATE) 
cre~te_widget ~:;-getWidget FromText ( viewport_me_nu_witti.:... contents, 
new.:_viewport.::,~ri~_item.linkAfter(create.:.widget) · 

• ' •• ' - ,, -.' ..;,· •\ I ' 

. . . ..... ,_. : '\ 

# Modify ·the:!. nam~ q-rthe -viewport mehu . ·. 
viewport..:.meriu -= -' getWidgetFromText(rnenubar, 
viewport_menu. setText Cviewrmrt Modified • } 

# Remove ·3 -items ' f.rom the Viewport toolbar 
toolpcir =. ~elf .g~tToolbarGroup(.'Viewpor.t ·) 

· . # We f~n( t~e ~idge~~ using their ·names which can be Qbtained by hovering 
#your mouse, ov~r,. them if, CAE. · - . 
# Since tf1e na·m~{th~mse:J,ves are spread ove.r 2 ·u~;~es, we must u~e the 

.• - .. # newlin.e ·character .:'.\n'. in the appropriate places . ,_ 
getWit1getFromr:eXl:~-fQ'qlba~J . 'Cascade\nViewport;s • )'diide(} . · 
-getW:l.dgetFronfl!eiCt(1fool,ba~: · 'Tile Vi'ewports \nHoriiontally ·).hide() 

' • " "> -r,;,.---" '!f" - ~ ' · > .,.., 

· getWidge'tFrom-r:erl("toolbar; 'Tile Viewports\nVertically') .hide() 

from abaqusGui import * 
from sessionGui import CanvasToolsetGui 

These statements give us access to the necessary GUI classes and modules. 

from demoForm import DemoForm 

In our custom viewport menu, we have a menu item that launches a dialog box DcmoDB 

created by us in dcmoDB.py. Being a modal dialog it is launched by a fonn DcmoForm 

which we create in demoForm.py. You will see how it is created when we dissect and 

study that script. In this script we are only importing it and calling it to launch the dialog 

box. For this reason we need to import the Demo Form class from dcmoForm.py. 

class ModifiedCanvasToolsetGui(CanvasToolsetGui): 

We derive our class ModifiedCanvasToolsetGui from CanvasToolsetGui. This is done 

because CanvasToolsetGui provides the standard menu items and basic functionality we 

need, and we only make modifications to this as opposed to creating an entirely custom 

menu (which we will do for Custom Module in customModuleGui.py). 
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def __ init __ (self): 

The _init_O method, which you 've already encountered in the previous section, is 
basically the constructor of the class and is called when an instance of the class is created. 
Just as in the case of the main window, the _init_O method in this class is where we do 
most of our scripting. 

# Construct a modified canvas toolset (viewport menu) 
CanvasToolsetGui. __ init __ (self) 

The statement calls the _init_O method of the base class (CanvasToolsetGui) which 
does whatever is required to create the default Viewport menu and add functionality to it. 

menubar = getAFXApp().getAFXMainWindow().getMenubar() 

getAFXAppQ, which you have seen before, gives us a handle to the application. 
getAFXMainWindowO gives us a handle to the main window. And getMenubbarO 
returns a handle to the entire menu pane. We store this handle in the variable menubar 
for use in the next statement. 

viewport_menu_with_contents = \ 
getWidgetFromText(menubar, 'Viewport').getMenu() 

The getWidgetFromText(parent, text) method always returns the widget whose label or 
tip text matches the text specified as the text argument and is a child of the parent 
widget. In our case the parent widget is the menu and the text is 'Viewport' which is the 
title of the default Viewport menu. The getWidgetFromTextQ toolbar will return a 
handle to the title of our menu, which is a widget of type AFXMenuTitle, and not a 
handle to the entire menu. 

Since we want the entire menu and its contents, we use getMenuQ. The getMenuO 
method returns a handle to the popup menu associated with the widget. And the menu 
associated with our menu title is the one we want. I know this seems like a long winded 
way to do things but that's just how it is. We store the menu in the variable 
viewport _menu_ with_ contents for use in the next few statements. 

getWidgetFromText(viewport_menu_with_contents, 'Cascade').hide() 
getWidgetFromText(viewport_menu_with_contents, 'Tile Horizontally').hide() 
getWidgetFromText(viewport_menu_with_contents, 'Tile Vertically').hide() 
getWidgetFromText(viewport_menu_with_contents, 'Delete Current').hide() 
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In these statements we once again use getWidgetsFromTextQ. This time the viewport 
menu is the parent widget, and we use the text associated with each menu item (which is 
of type AFXMenuCommand) to get a handle to it. 

We then use the bideQ method to hide these so that they will no longer be displayed as 
menu items when the Viewport menu is clicked. These statements will therefore remove 
Cascade, Tile Horizontally, Tile Vertically and Delete Current from the menu. 

# Remove the 2nd horizontal separator 
getSeparator(viewport_menu_with_contents, 2).hide() 

Here we use the getSeparatorO method to obtain a handle to a separator - the horizontal 
lines that appears between some menu items. We wish to remove the horizontal rule 
between Previous and Cascade (or where cascade would have been if we hadn' t hidden 
it in the previous statements). We provide the handle to the Viewport menu as the first 
argument. The second argument identifies which separator we wish to remove, but 
counting them from 1 upward. Since the separator we wish to remove is the second one 
(there is one between Create and Next) we pass '2' as a parameter. 

Once we have a handle to the separator, we use the hideO method to remove it. 

# Add a new item to the menu after the 'Create' item 
# We use AFXMode . ID_ACTIVATE to cause the mode DemoForm in demoForm.py to 
# activate, which causes it to display its form DemoDB which is 
# in demoDB.py 
new_viewport_menu_item = AFXMenuCommand{self, 

viewport_menu_with_contents, 
'Custom Menu Item', 
None, 
Demoform(self), 
AFXMode.ID_ACTIVATE) 

AFXMenuCommandO creates an instance of an enhanced version of the 
FXMenuCommand class. To put things briefly, it creates a menu item. The first 
argument is owner, which refers to the creator of the menu command, the second is p, 
which is the parent widget- in our case the Viewport menu. The third argument is label, 
which is the label for the menu button. The fourth is ic, which is the menu button icon. 
The fifth is tgt, the message target. We set the message target to DemoForm(self) which 
means it will create an instance of the DemoForm class which can launch the modal 
dialog DemoDB associated with it. So when the user clicks this menu item, he will see a 
dialog box. The sixth argument is sel which is the message ID. In our case we send an 
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ID_ACTIVATE message to DcmoForm which causes it to launch DemoDB. Note that 
this statement does not display the new menu item in the menu, it only creates it 
interna lly. 

create_widget = getWidgetFromText(viewport_menu_with_contents, 'Create ' ) 
new_viewport_menu_item.linkAfter(create_widget) 

We use the getWidgetFromTextO method to get a handle to Create so that we can use it 
to position our new menu item in the subsequent statement. linkAfterO is what actually 
displays our menu item in the menu. As its name suggests, it places the menu item after 
the widget specified as its parameter. The opposite of it is linkBeforeQ. 

# Modify the name of the Viewport menu 
viewport_menu = getWidgetFromText(menubar~ ' Viewport ' ) 
viewport_menu.setText( ' Viewport Modified') 

getWidgetFromTcxtO is used again, this t ime only to get a handle on the title of the 
menu rather than the entire menu. setT ex tO is used to change the text of the Viewport 
menu title to ' Viewport Modified ' . 

# Remove 3 items from the Viewport toolbar 
toolbar = self.getToolbarGroup('Viewport') 

This statement is used to get a handle to the Viewport toolbar. You can use this to get a 
handle fo r any of the toolbars by using their name. If you need to know the name of a 
toolbar, look in View > Toolbars in Abaqus/CAE. 

# We find the widgets using their names which can be obtained by hovering 
# your mouse over them in CAE. 
# Since the names themselves are spread over 2 lines, we must use the 
# newline char acter ' \n' in the appropriate places 
getWidgetFromText(toolbar~ 'Cascade\nViewports').hide() 
getWidgetFromText(toolbar, ' Tile Viewports \nHorizontally' ).hide() 
getWidgetFromText(toolbar~ 'Tile Viewports\nVertically') . hide() 

The getWidgetFromTextO function a llows us to grab the toolbar buttons us ing the ir tool 
tips. You can see these too l tips by hovering your mouse over those buttons in 
Abaqus/CAE. Note that newline characters have also been included in the text string to 
make the tooltips span multiple lines. The hidcO method removes these toolbar buttons 
from the too I bar. 
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1~~~~4~_-', ' Cus~om Pcr8!S;~nt tools"et :I .. 
This script is contained in customToolboxButtonsGui.py. In it we create 5 new toolset 
buttons Iabeled 'A', 'B', 'C' , 'E', ' F' that will be displayed in the module tool set area 
except that these will be persistent i.e., visible, no matter which module you are in. This 
is because we registered this toolset in the main window (customCacMainWindow.py) 
as opposed to registering it within a custom module (we will see an example of that in 
customModuleGui.py hence it is a persistent toolset rather than a module toolset which 
would only display when the user is in that module. 

This script demonstrates a very important task in GUI scripts, that of capturing events. 
We will assign unique identifiers- ID_A, ID_B and ID_C - to buttons ' A', ' B' and 'C' . 
We will map these lOs to functions within our custom toolset class using 
FXMAPFUNCO. When any ofthese buttons are clicked, FXMAPFUNCO will map the 
button click to the appropriate function depending on the ID ofthe button clicked. 

To make things a little more interesting, we will store some functionality in a separate 
script mainProgram.py and the functions will call the appropriate method of the other 
script. This will help demonstrate not only how to store functionality in a separate file, 
but also how to create ST A TJ C variables (I wi 11 explain these when we get there). 

As for buttons 'E' and ' F' they will launch the dialog box (DcmoDB in demoDB.py) by 
sending an ID_ACTIVATE instruction to the form (DemoForm in dcmoForm.py)just 
as was done when Custom Menu Item was clicked in our Viewport Modified menu in 
the previous section. 

We will also divide the buttons into 3 toolbox groups which are automatically separated 
by horizontal separators as shown in the figure. 
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print 

_;_ ~'t~.i:!; ... _ _ ~ ~ .-;r~~i;-,; ~~.(,:..-,..~ . .-~~:7 !.~;~.·.c.:.'~~;. :~;~~J ~! 
------------~ 
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Models (1) 

B Model-1 

I- ll, Parts 
~-~ Materials 

!-~ Sections 

t·• Profiles 
~ ~Q • 
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# Print a message to the Abaqus/CAE message area . 
getAFXApp().getAFXMainWindow{) \ 

.writeToMessageArea('Toolbox button c was clicked.'} 

# Call a meethod of MainProgram after creating an instance .

i:; 

mp = MainProgram() I' 

mp.incrementXByS() . Oo0 ~-o ~~-- Ro 0 ... U~ ~ ... . ~ ....... ~000 .......... ~ .............. OOHM-~ ... ' " .... M ........... _____ ..... - .......... - .... .-.. A-0 0o 0 0 .. 0 .. ~ 00 0 0 .. -- ------- 0 ~ 0 0 0 0 0 Oo0o .. Oo0""' '" .... _, 0 ...... " ,,.,_,., __ , 0 ..... 0 MO- -- 000-MOOOOOO ................ "' - O 0 0 O ,.,.,_ O O ·-oOoo! 

from abaqusGui import * 
from sessionGui import CanvasToolsetGui 
from demoForm import DemoForm 
from mainProgram import MainProgram 

Here we import the standard modules and toolsets, as well as others created by us. The 
DemoForm class in demoForm.py is the form mode that launches our dialog box 
DemoDB defined in demoDB.py. We want this dialog box to be launched when 'E' or 
'F' are clicked hence the script needs to be imported here. mainProgram.py on the other 
hand contains functionality which we will use when 'A' , 'B' or 'C' are clicked, hence 
that script too needs to be imported here. 

class CustomToolboxButtonsGui(AFXToolsetGui): 

We derive our class CustomToolboxButtonsGui from AFXToolsetGui. If you recall, in 
the previous section (script modifiedCanvasToolsetGui) we derived our class from 
CanvasToolsetGui because we only wished to modifY the Viewport menu that it 
supplies and retain the rest of the functionality. This time we wish to create entirely new 
functionality (menus/toolboxes/toolbars etc) hence we derive our class directly from 
AFXToolsetGui. 

[ 
ID_A, 
ID_B, 
ID_C, 
ID_LAST 

] = range(AFXToolsetGui.ID_LAST, AFXToolsetGui.ID_LAST+4) 

Let me begin by explaining the syntax used here before we talk about what it does. 

Range(x,y), which you have seen previously returns a list of numbers between x and y 
including x but not including y. For example, range( I ,5) returns [1 ,2,3,4]. Here we are 
using the range function to return a list of numbers and assigning these to a list [ID _A, 
ID_B, ID_C]. 



20.6 Python Script 597 

Moments ago we discussed the ID A, ID B and ID C are identifiers which we will - - -
associate with buttons ' A', 'B' and 'C'. When any of these 3 buttons are pressed the 
FXMAPFUNCO method will be able to tell which button was pressed based on its I 0, 
and will call the appropriate function. 

This requires that each of the buttons in this script (or more technically each widget in the 
target class and its base classes) has a unique identifiers otherwise FXMAPFUNCO will 
not be able to differentiate between them. If we know for a fact exactly how many lOs 
are being used and we wish to manually assign these, we could instead write 

ID_A = 1881 
ID_B = 1882 
ID_C = 1883 

assigning 100 I, 1002 and I 003 as the lOs of the 3 buttons. We would have to be sure that 
these lOs have not already been used in this class or in its base classes. We would also 
have to make sure we do not reuse these same lOs by mistake for any other buttons. 

A much easier way of doing this is to let Abaqus assign the lOs itse lf so that they are all 
unique. We use the variable ID LAST which is defined by Abaqus for the base class 
(AFXToolsctGui) that we derived our class from . The value of ID_LAST is o ne more 
than the last ID used in the base class AFXToolsetGui. Using the range function we 
accomplish what could instead be written as 

ID_A = ID_LAST 
ID_B = ID_LAST+1 
ID_C = ID_LAST+2 

This way ID_A, ID_B and ID_C are unique identities that have not already been used by 
our class CustomToolboxButtonsGui or the base class AFXToolsetGui (or any of its 
base classes). 

While not necessary in our case, for good programming practice we also go ahead and 
define an ID _LAST for our class which works out to 

ID_LAST = IO_LAST+3 

This may not be useful to us in this example, but if we were to derive another class fTom 
the class we have created, and then use ID _LAST in that class as we have done here, 
then Abaqus would use this value of ID _LAST specified by us. Abaqus does not itself 
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update the value ofiD_LAST on its own. This is something to be careful of if you derive 
classes from your own classes. 

print 'ID_A is %i' % ID_A 
print 'ID_B is %i' % ID_B 
print 'ID_C is %i' % ID_C 

For the sake of demonstration we print the values of ID_A, ID_B and ID_C to the 
console. The following figure displays some of what you see when you run the program. 

;:'.llsea•s,Gnt•y The G!•eat'-Desktop'-f'lh.tljU!; Boox Stuff'.cnstonC<teApp).thq6102se cae - cu 
-ton custonCacApp -noStartup 
I D_A is 1 
I D_B i:; 2 

def __ init __ (self): 

As usual we will put the important stuff in the _init_O method which will be called 
when an instance of the class is created. 

print 'CustomToolboxButtonsGui initialization method called.' 

This print statement is for demonstration and debugging purposes. The following figure 
displays part of what you see (thanks to this print statement) when you run the program. 

C:'.Usel's'-G,u•y The G!•c ,\t'.Dcsktop' Ah<t(jllS Book Stuff'-custonCaeAp}l),"\h(t6102 se c,,e -et 
s ton custonCneApp -noStartup 
I D __ A is 1 
I D __ B is 2 
ID __ C is 3 
CustoMToolboxButton:;Gui initiali~ation Method c,,llccl. 

# construct base class. 
AfXToolsetGui. __ init __ (self, 'Test Toolset') 

This statement calls the _init_O method of the base class (AFXToolsetGui) which 
provides the basic functionality to the toolset. 

FXMAPFUNC(self, SEl_COMMAND, self.ID_A, CustomToolboxButtonsGui.onCmdA) 
FXMAPFUNC(self~ SEL_COMMAND, self.ID_B~ CustomToolboxButtonsGui.onCmdB} 
FXMAPFUNC(self, SEl_COMHAND, self.ID_C, CustomToolboxButtonsGui.onCmdC) 

We have already discussed the general working of the script and the FXMAPFUNCQ. 
This is where we actually implement it. 

FXMAPFUNCO takes 4 arguments - self, messageType, which is an integer specifying 
the type of message to send (in this case SEL_ COMMAND), messageld, which is an 
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integer specifying the message ID, and method, which is the function to be called, and 
which must be written in the format classname.methodname. 

Here we have mapped the widget associated with ID_A (which is button 'A') to 
onCmdAQ. Similarly button ' B' calls onCmdBO and 'C' calls onCmdCQ. 
SEL_COMMAND is the most common message type you will encounter (and in fact the 
only one we use in this book) and it indicates that the widget has been clicked or selected 
by the user. 

r·--·--···-----·-;····:r~~ib~;···-b~tt~-~-~------······---···-···-----------····-····--····-······-····· ···-·--· · ·---· ··· ····---·······-- ·------·-----····---· -·-··· ·---····~------·-· ·· 

I toolbox_group_l = AFXToolboxGroup(self) 
1 AFXTool Button(p=toolbox_group_l, label=' A \t Initialize the \ n ' + \ 
i 'static variable x', icon=None, tgt=self, sel=self.ID_A} i AFXToolButton(p=toolbox_group_l, label=' B \t Increment the static ' +\ 
I '\n varible x by 5', icon=None, tgt=self, sel=self.ID_B) 

I 

I 
l 

toolbox_group_2 = AFXToolboxGroup(self) 
AFXToolButton(p=toolbox_group_2, label=' C \t Increment the static ' + \ 

'\n variable x by 5 \n (create an instance) ' , 
icon=None, tgt=self, sel=self.ID_C} 

I
. toolbox_group_3 = AFXToolboxGroup(self) 

I

, AFXToolButton(p=toolbox_group_3, 
label=' E \t Dis play dialog', 
icon=None, 
tgt=DemoForm(self}, 

1

1 sel=AFXMode.ID_ACTIVATE) 

I 

AFXToolButton(p=toolbox_group_3, 
label=' F \t Display dialog', I icon=None, tgt=DemoForm(self), 

! sel=AFXMode.ID ACTIVATE} 
~-------------------------

This block creates all the toolbox buttons. 

toolbox_group_l = AFXToolboxGroup(self) 

AFXToolboxGroup is a class that creates a container for the groups of the toolbox. 
AFXToolboxGroupO is its constructor which we use here to create the first toolbox 
group. It accepts 2 arguments owner and parent. We set owner, which is the creator of 
the toolbox group, to self, which points to our class CustomToolboxButtonsGui. Since 
we don' t speci"fY a parent widget parent will default to None. We store our toolbox 
group in the variable toolbox _group _1. 

AFXToolButton(p=toolbox_group_l, label=' A \t Initialize the \n • + \ 
'static variable x', icon=None, tgt=self, sel=self.ID_A) 
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AFXToolButton(p=toolbox_group_l, label=' B \t Increment the static ' +\ 
'\n varible x by 5', icon=None, tgt=self, sel=self.ID_B} 

The AFXTooiButton class creates buttons for both toolbars and toolboxes. Its 
constructor AFXTooiButtonO takes 6 arguments. p is the parent widget, which in this 
case is the toolbox group we created in the previous statement. label is the label for the 
button. If in the label you use a \t, anything following the \t is a tooltip which appears as 
you hover your mouse over the button. Anything before \t is what appears on the button. 
icon is an icon for the button. In this case we have no icon, but rather text ('A' and '8'). 
For button 'A', as you hover your mouse over it, you will see the message 'Initialize the 
static variable x' and this will be spaced over 2 lines because of our use of \n. tgt is the 
message target which is the object/instance that will handle the message. We set it to self 
because the CustomToolboxButtonsGui will handle the message itself using its 
FXMAPFUNCO method. sel is the message ID which is passed to the message target, 
which in the case of button 'A' is ID A and button ' B' is ID B. - -

toolbox_group_2 = AFXToolboxGroup(self) 
AFXToolButton(p=toolbox_group_2, label=' C \t Increment the static ' + \ 

'\n variable x by 5 \n (create an instance)', 
icon=None, tgt=self, sel=self.ID_C) 

Similarly we put button 'C' in a toolbox group of its own. Abaqus will automatically 
place a horizontal separator between tool box groups I and 2. 

toolbox_group_3 = AFXToolboxGroup(self) 

Similarly we create a third toolbox group for buttons 'E' and 'F'. 

AFXToolButton(p=toolbox_group_3, 
label=' E \t Display dialog·, 
icon=None, 
tgt=DemoForm(self), 
sel=AFXMode.ID_ACTIVATE) 

AFXToolButton(p=toolbox_group_3, 
label=' F \t Display dialog', 
icon=None, tgt=DemoForm(self), 
sel=AFXMode. ID_ACTIVATE) 

Buttons 'E' and 'F' are supposed to launch the dialog box DemoDB defined m 
demoDB.py. In order to do thi_s they need to activate the fonn mode DemoForm in 
demoForm.py. Hence we do · not set the target tgt to self but instead set it to 
DemoForm(selt). In addition we set the message ID sel to AFXMode.ID _ACTIVATE. 
Thus when buttons 'E' and 'F' are clicked, they send a message 
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AFXModel.ID_ACTIVATE to DemoForm. This causes the activateO method of the 
fonn to be called which launches the dialog box. You will learn more about the form, 
dialog box and the activateO method when we reach that section later in this chapter. 

,.---·--~-•-w-~--··-·------------~-----·-----·-·------·--·----~·------------------------------·------ ·· I def onCmdA(self~ sender~ sel, ptr): 

j # Print a message to the command prompt 
l print 'Toolbox button A was clicked' 
! 

L ______ :~l~!~o;~;;_~l_:~;e:;_~;;_!~:~;!"~~l~~ut--~si:~-~~-in~~~n-ce varia~~~----------·-· 
onCmdAO is called when button 'A' is clicked, sending an ID_A message to the 
CustomToolboxButtonsGUI instance, which FXMAPFUNCO maps to onCmdAQ. 
Here we are defining the function itself. Notice that we have defined it inside the 
CustomToolboxButtonsGui class. 

onCmdAO prints a message to the console indicating that 'Toolbox button A was 
clicked'. It then calls the createStaticVarXO method of the MainProgram class 
(defined by us in mainProgram.py) without creating an instance of the class. We will 
look at mainProgram.py more closely in the next section, for now you only need to 
know that it has a class called MainProgram with a method called createStaticVarXQ 
which we are calling here. 

Note that by using the statement MainProgramO.createStaticVarXO we do not create 
an instance of the MainProgram class, we are calling its method directly. This rs 
different from creating an instance which we will do in onCmdCQ. 

I def onCmdB(self~ sender, sel, ptr): 

# Print a message to the command prompt 
print 'Toolbox button B was clicked' 

I 
# Call method of MainProgram using an instance variable 
MainProgram().incrementXByS() 

onCmdBO is called when button ' B' is clicked. It is similar to onCmdAO except that it 
calls the incrementXBySQ method of the MainProgram c1ass. 

,-------d;f··-~-~c-;dc:·E;if:---~;~d-~~ ~--~;i·~---pt ~ >-;·---- ·--·---·-·--····-···--·----·--------------·---------------------·~ 

l
l # Print a message to the command prompt J 

print 'Toolbox button C was clicked' 
·-----· 
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~----

! 
i 
1 
! 

# Print a message to the Abaqus/CAE message area 
getAFXApp().getAFXMainWindow{) \ 

.writeToMessageArea( 'Toolbox button C was clicked . ') 

I # Call a meethod of MainProgram after creating an instance ! mp = MainProgram() L _______ ~P...:..!.~-~rementx~~s () ___________________ ______________ j 

onCmdCO is called when button 'C' is clicked. It is similar to onCmdBO and 
onCmdAQ. However there are a couple of differences. onCmdCO uses the print 
command to print a message to the console, just like onCmdAO and onCmdBO do. As 
you may have noticed, in GUI applications print always prints to the console rather than 
the Abaqus/CAE message area. However onCmdCO also prints a message to the 
Abaqus/CAE message area using the statement 

# Print a message to the Abaqus/CAE message area 
getAFXApp().getAFXMainWindow() \ 

.writeToMessageArea('Toolbox button C was clicked.') 

You've already encountered getAFXAppQ and getAFXMain WindowO which return 
handles to the application and the main window. We use writeToMessagcAreaO to print 
a message to the Abaqus/CAE message area. 

# Call a meethod of MainProgram after creating an instance 
mp = MainProgram() 
mp.incrementXByS() 

The other difference in onCmdCO compared with onCmdAQ or onCmdBO is that we 
assign an instance of the MainProgram class to a variable here named mp. We then call 
the incrementXBy50 method of this instance using the variable name. 

Both methods of calling incrementXBySQ i.e., with and without creating a variable for 
the instance of MainProgramQ, are used to demonstrate two ways of doing things. 

20.6.5 Adding 80ine fui!Ctioaality with a~ 'main~ p~m ~ · 
,;!1 ., - ~ .• ·- ........ ~ ..... ~ "'""" ~ ~ ...... ~- ..,., ... " 

This script is contained in mainProgram.py. In this script we add some very basic 
functionality to our program for demonstration purposes. It contains a class called 
MainProgram. When our custom toolbox buttons 'A', '8' and 'C' are clicked, the 
methods onCmdAQ, onCmdBO and onCmdCQ call corresponding methods of the 
MainProgram class. So indirectly, clicking button 'A' calls createStaticVarXO of the 
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MainProgram class, and clicking button ' B' or 'C' calls incrementXBy50 of the 
MainProgram class. 

createStaticVarXO creates a static variable static_x with the value 0. incrementXBy50 
increases the current value ofstatic_x by 5 and prints it to the console window. 

What is a static variable? In general, static variables are variables that are assigned a 
value once during programs execution, and these variables continue to exist and hold the 
value all the way till the end of the program. The value itself may be modified by the 
program, but the variable itself will continue to exist. One use of static variables is to 
hold, or share, a value across different objects of the same class. 

Let me elaborate further. Let' s assume you have a class myClass. lt has a variable 
myVar. If you create an instance of that class called mylnstancel , this instance will 
have that variable mylnstancel.myVar and you can store a value in it If you create 
another instance of myCiass called mylnstance2, it will have a variable 
mylnstance2.myVar. However this variable will not necessarily have the same value as 
mylnstancel.myVar. Unless ... you make myVar a static variable. Jf myVar is a static 
variable, then mylnstancel.myVar = myinstance2.myVar. Changing the value of 
either of them will also be reflected in the other. 

In languages such as C or C++, static variables are explicitly defined. So in a C++ 
program you would write static int x = 0 and a static integer variable x would be created 
an initialized with the value 0. In this manner you can create a static variable that is local 
or global in scope. Languages such as Pascal and Python on the other hand do not let you 
explicitly create a static variable, but they implicitly make all g lobal variables static. So 
in order to make a variable static in Python we will need to declare it as a global variable. 

In our program we wish to make the variable static_x static so that its value can be 
initialized by pressing button 'A' and the incremented by either 'B' or 'C'. 
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# script as indicated py the import statement ~from. abaqusGUI import • • 
# **********************************************•••·······~········~·········~···· . . ~ - .- ~.. : ; .~ 

I f~m abaqusGui import ~ 

. class MainProgram(): 

# Function to create a static 
# value 9 
def C'l"eateStaticVarX( self),.: 

global static_x 
·static....:x '= 9 · 
print 'The value of x is . ' 

#Display an information_dialog box 

i 
I 
l 
·I 
I 

I 
1 
i 
i 

i 
i 

mainwind~w = getAFXApp( ) . getAFXMainWindow(} ' · 
showAFXInformationDialog(owner=mainwlndow, ,. j 

110ssage•'The v!riable. stati~..:lf has bli~." c":'~tedlf~itiali~eci• i :,!

1 
#Function to incremement the value of variable · 'sta1;ic::_x' 
def incren~entXByS(self): · I 

# We need to make sure 'static_x' exists (~t"!e user-· may not. have clicked I 
# button A, in which case cr-eateStat:i:cVarX() was ,hOt called} 
·try: I 

global static_x , 1 
~ static x = static x ·+ 5 . ! 

. ' print. 7rhe value ;f x ·is · I 
except: . , I 

· # Display an ·error dialog._box ·. · · , i 
mainwindow "' getAfXApp~) .geiAFXMainWindowO ! 
·showAFXErrorDialog(owner""''ainWlndow, 

. .niessage=' First qefine . static_x ~y .. ;cli~king on A') . 
·-"--'-""""-'-· 

from abaqusGui import * 

Since this is a GUI script, it is necessary to include this import statement. In fact in the 
current state of the program it is necessary for this script to be a GUI script because a 
function of a kernel script cannot be called by menu items, toolbar buttons or toolbox 
buttons without using a mode or the sendCommandO method. If you recall, this is 
because of the separation of GUI and kernel scripts discussed at the beginning of this 
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chapter. Realistically the only GUI task this script undertakes is displaying information 
and error dialog boxes (we will look at those in a minute), other than that it increments a 
variable and print its value in the console window. 

class MainProgram(): 

We create a class called Main Program in which to place all the functionality. It is not 
derived from any other class. 

def _ init_(self): l 
print 'MainProgram has been initialized . ' '--------'------=------ -----

Like all classes we've encountered before, the _initi_O method of this class is called 
first as the constructor. Here we do not place any crucial code in this method except a 
print statement indicating that the MainProgram class has been instanced. 

# Function to create a static (global} variable 'static_x ' and assign it the 
# value 0 
def createStaticVarX(self): 

global static_x 
static_x = e 
print 'The value of x is now %d' % static_x 

# Display an information dialog box 
mainWindow = getAFXApp().getAFXMainWindow() 
showAFXInformationDialog(owner=mainWindow, 

message='The variable static x has been created/initialized') 

This method is called when button 'A' is clicked. 

global static_x 

As discussed earlier, in Python there is no way to explicitly declare a static variable. 
However making a variable global in scope makes it behave like a static variable. Hence 
the keyword global is used when declaring the variable. 

static_x = 9 

We then assign it the value 0 to initialize it. 

mainWindow = getAFXApp().getAFXMainWindow() 

This statement obtains a handle to the main window and places it m the variable 
main Window. 
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showAFXInformationDialog(owner=mainWindow> 
message='The variable static_x has been created/initialized') 

The showAFXInformationDialog() is used to display the information dialog shown in 
the figure. Information dialog boxes are used to provide information to the user and have 
the information symbol ('i' symbol in a blue circle). They only contain a Dismiss button. 
Their title bar contains the application name. They are a good way to provide information 
to users in format they are accustomed to. 

showAFXInformationDialogO accepts 4 arguments - owner, message, tgt and sel. 
owner is the window over which to center the dialog box, message is the text String to 
display as the message. tgt and sel are the message target and message ID neither of 
which are supplied here. 

() The variable static_x has been created/initialized 

I Di.smiss.} 

# Function to incremement the value of variable 'static_x' by 5 
def i ncrementXByS( self): I 

#We need to make sure 'static_x' exists ( the user may not have clicked 
# button A, i n which case createStaticVarX() was not called) 
try: 

global static_x 
static_x = static_x + 5 
print 'The value of x is now %d' % static_x 

except : 
# Display an error dialog box 
mainWindow = getAFXApp().getAFXMainWindow() 
showAFXErrorDialog(owner=mainWindow, 

I 

I 

message='First defi ne static_x by clicking on A' ) ~--------------------------~~-------- __ _j 

This method is called when buttons 'B' or 'C' are clicked. Its purpose is to increment the 
value of the variable static_x. Since it is possible the user did not click ' A ' first, static_x 
has not yet been created and initialized, hence trying to increment it will cause an error 
that will crash the program. To prevent this we have used a try-except block, so that the 
program can respond to and recover from such an occurrence. 

try: 
global static_x 
static_x = static_x + 5 
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print 'The value of x is now %d' % static x 

In the try block we attempt to achieve the purpose of this method. The statement global 
static_x is used to tell Python that we are using the previously defined global (and 
therefore also static) variable called static_x. If we left out the keyword global, Python 
would assume we are trying to create a local variable static_x since it is possible to have 
global and local variables with the same name. Needless to say, the local variable would 
not have the value of the global one, making it of no use to us. 

except: 
# Display an error dialog box 
mainWindow = getAFXApp().getAFXMainWindow(} 
showAFXErrorDialog(owner=mainWindow, 

message~ 'First define static_x by clicking on A') 

Ifthe global variable static_x was not assigned a value earlier (by the user clicking ' A' ) 
then the statement static_x = static_x + 5 in the try block will throw an exception, and 
the statements in the except block will be executed. 

The showAFXErrorDialog() method is used to display the error dialog box shown in the 
figure. Error dialog boxes are used to inform the user of an error and they have the error 
symbol (red circle with a diagonal line). Just like information dialogs they only conta in a 
Dismiss button. Their title bar contains the application name. 

showAFXErrorDialogO takes 4 arguments - owner, message, tgt and sel. owner is the 
window over which to center the dialog box, message is the text string to display as the 
message. tgt and sel are the message target and message ID, neither of which are 
supplied here. 

6) First define static_x by clicking on A 

[ Disr:ni~s ] 

-· ,, 

This script is contained in customModuleGui.py. ln this script we create a custom 
module. It will appear in the Module combo box above the viewport in the Abaqus/CAE 
interface. This custom module consists of a menu, a toolbar, and a toolbox. The menu 
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contains a nested menu as well. Most menu items launch a modal dialog box but one of 
them launches a modeless dialog box. The toolbox includes flyout buttons. 

C!:i Materials 
$ S«tions 
• Profiles 
ji Asfembly 
A Steps Cl) 
!f! Field Output Reque:sB 

Histol}' Output Requests ' 

# Class definition 
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ttle mode[ disappears 
the model 'tree was present 
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DemoForm{self), . AFXMode.ID_ACTIVATE). 

.. # Toolbox Flyout buttons . 
toolbox_flyout_group = AFXToolboxGroup(self) · . ' ~·;, 
toolbox_popup = FXPopup(getAFXApp().getAFXHainWindow{)) 

todloox_flyout~icti~~l = afxCreateicon(; icon_ star _red ~·bmp ') 
toolbox_flyout_icon_2 = afxCreateicon('icon_star_green.bmp') 
tool box~ flyput_icon_3 = af.xCreatercon( '.icon_star _orange. bmp ·) . 

:.,... toolbox_f.lyaut_icon_4 = - afxcreatercori(-'ic~n_star_blue~binp'): 
~ 

AFXFlyoutitem(toolbox_popup, '\tflyout .Button Red', . . ·-
:. . tool~x_flYC?Ut_kqn_l, Demafo~{self) , ·•-AFXHbd.e: ID_ACTIVATE) 

AFXFlyoutltem(toolbox_popup, '\tFiyout Butto-n Green', . . 
· toolbox_flyout_icon_2, DemoFonm(self), ' AFXMod~.ID~ACTIVATE} 

AFXFlyoutite~(too~bo~_popup, '\tFlyout . Button-Of'ange', - •· ,. . , 
toolb0x_flyout_icon_3, DemoFonm(self), 'AFXMode.ID~ACTIVATE) 

AFXFlyoutitem(toolbox_pop~p, '\tflyout Button Blue', · · 
. toolbox_flyout_i~on_4.~ DemoFonm('Self)., · AF)(Mqde ~ ID_ACTIVATE): .. 

from abaqusGui import * 

from demoForm import DemoForm 
from demoDBwoForm import DemoDBwoForm 

As usual we begin with import statements. We import the fonn mode DemoForm from 
demoForm.py. We will use this to launch the modal dialog box DemoDB m 
demoDB.py. We also import the modeless dialog box DemoDBwoForm defined m 
demoDBwoForm. This dialog box will be launched directly without using a form. 

class CustomModuleGui(AFXModuleGui): 

We derive our class CustomModuleGui from AFXModuleGui which defines the basic 
module functionality, such as keeping track of the module' s menus, toolbars and toolbox 
icons, and allowing them to be swapped in and out when the user switches into and out of 
the module. 

def __ init __ (self): 

The code for the module will be placed in the _init_O method as expected. 
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print 'CustomModuleGui initialization method called.' 

We print this message for observation and debugging purposes. 

# Construct base class. 
AFXModuleGui. __ init __ (self, 'Custom Module', AFXModuleGui.PART) 

As always we construct the base class. Note that this constructor accepts 3 arguments. 
The first argument is self, as usual. The second one is moduleName, which is the name 
that will be displayed in the module combo box. The third one is displayTypes, which 
specifies what type of object will be displayed in this module. Possible values are 
AFXModuleGui.PART, AFXModuleGui.ASSEMBLY, AFXModuleGui.ODB, 
AFXModuleGui.XY_PLOT and AFXModulcGui.SKETCH. Assuming we wish to 
display a part here, we wilt use AFXModuleGui.P ART. Note that if you wished to 
display an assembly and specified AFXModuleGui.ASSEMBLY, you would be 
required to also import the assembly kernel module to initialize some assembly display 
options. 

# By default when you switch to a custom module the model tree disappears 
# and the region of the Abaqus/CAE window where the model tree was present 
# becomes blank. 
# The following 3 statements prevent this from happening. If you do 
# in fact desire that effect then comment/delete the next 3 lines . 
main_window=getAFXApp() .getAFXMainWindow() 
main_window.appendApplicableModuleForTreeTab('Model', 

self.getModuleName() ) 
main_window.appendVisibleModuleForTreeTab( ' Model ' , self.getModuleName() ) 

In Abaqus/CAE you are used to seeing the model tree or the results tree on the left hand 
side. This is represented by TreeToolsetGui. The tabs (model/results) in this tree are not 
visible by default in custom modules. If you wish to make them visible you must use the 
appendApplicableModuleForTreeTabO method to create the tab applicable to that 
module, and the appendVisibleModuleForTreeTabO method to make it visible. The 
first argument supplied is the tab. In this case we make the Model tab applicable and 
visible in our custom module. Since we have not made the Results tab applicable and 
visible, you will not see the results tab when in the custom module. 

# Create menu bar and add 2 items that post a dialog box using a fonn 
custom_menu = AFXMenuPane(self) 
AFXMenuTitle(self, '&Custom Menu', None, custom_menu) 
AFXMenuCommand(self. custom_menu. 'Custom Item 1 (Fonn)', None, 

DemoForm(self)~ AFXMode.ID_ACTIVATE) 
AFXMenuCommand(self, custom_menu, 'Custom Item 2 (Form)', None, 
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Demoform(self), AFXMode.ID_ACTIVATE) 

A menu is created as an AFXMeouPane object using the AFXMenuPaneO constructor. 
lt has a title which is an AFXMenuTitle object created with the AFXMeouTitleO 
constructor. lt takes 3 parameters - owner, which can be a module or toolset GUJ, label, 
which is the displayed title, ic, which is an icon (in our case None) and popup, which is 
the name of the pull down menu - we shall call it custom_menu and use it when creating 
the menu items. Note the use of the ampersand ' & ' in the label. lt causes the letter it 
precedes to become a keyboard shortcut and underlines it. Since the letter 'c' has been 
made the shortcut, the user can press Alt +Con the keyboard instead of clicking on the 
menu item with the mouse, and the menu will drop open. 

The menu items are AFXMenuCommand objects and are created using the 
AFX.MenuCommaodO constructor which takes 6 parameters. owner is the creator of the 
menu command. The second parameter pis the parent widget, in our case custom_menu, 
which was set as the pulldown in AFXMenuTitleQ. The third is label which is the label 
for the menu button. ic is the menu button icon, which we set to None since we don't 
wish to give it an icon. The last two are tgt and set which are the message target and 
message ID. We set the target to DemoForm(selt) which is the form mode responsible 
for launching the dialogbox DemoDB defined in demoDB.py. We set the message to 
AFX.Mode.ID _ACT IV ATE which will call the activateO method of the form mode. 
You have seen this target and message combination used previously to launch the dialog 
box. 

# Create a submenu within this menubar 
custom_sub_menu = AFXMenuPane(self) 
AFXMenuCascade(self, custom_menu, ' Custom Submenu ' , None, custom_sub_menu) 
AFXMenuCommand(self, custom_sub_menu, 'Custom Item 3 (Form)', None, 

DemoForm(self), AFXMode.ID_ACTIVATE) 
AFXMenuCommand(self, custom_sub_menu, 'Custom Item 3 (Form)', None, 

OemoFonm(self), AFXMode.ID_ACTIVATE) 

We now create a submenu. It too is an AFXMenuPane object created with the 
AFXMenuPaneO constructor. However we then use an AFXMenuCascade object to 
identity it as a menu item with a submenu as opposed to an AFXMenuCommand object. 
This is done using the AFXMenuCascadeO constructor which takes 6 arguments. These 
are owner, p, label, ic and popup, all of which were described a moment ago. This sub 
menu has AFXMenuCommand objects forming its menu items. 
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# Add an item to the menu that posts a dialog box directly without using 
# a form 
dialog_box_without_form = DemoDBwoForm(self) 
dialog_box_without_form.create() 
AFXMenuCommand{self, custom_menu, 'Custom Item 4 {DialogBox)', None, 

dialog_box_without_form, FXWindow.ID_SHOW) 

The last menu item we create has a slightly different function. While the rest of the menu 
and submenu items launch a modal dialog box DemoDB by calling the activateO method 
of its form mode DemoForm, this menu item will launch a modeless dialog box 
DemoDBwoForm direcly without using a fonn mode. 

In order to do this we first create an instance of the DemoDBwoForm class that we 
create in demoDBwoForm.py. We call the createO method associated with it. When 
posting a dialog box using a form or procedure mode, the createO method is called 
automatically by the mode. However since we are launching the dialog box without using 
a mode we must call createO ourselves before we can call showO. 

In order to call showO we send an FXWindow.ID_SHOW message to the dialog box 
when the AFXMenuCommand object (the menu item) is clicked. 

# Toolbar items 
toolbar_group = AFXToolbarGroup(owner=self, title='Arrow Toolbar') 
toolbar_icon_up = afxCreatelcon('icon_arrow_up.bmp') 
toolbar_icon_down = afxCreateicon{'icon_arrow_down.bmp') 
toolbar_icon_left = afxCreatelcon('icon_arrow_left.bmp') 
toolbar_icon_right = afxcreatelcon{'icon_arrow_right.bmp') 
AFXToolButton(toolbar_group, '\tUp Arrow', toolbar_icon_up, 

DemoFo~(self), AFXMode.ID_ACTIVATE) 
AFXToolButton(toolbar_group, '\tDown Arrow', toolbar_icon_down, 

DemoForm(self), AFXMode.ID_ACTIVATE) 
AFXToolButton(toolbar_group, '\tleft Arrow', toolbar_icon_left, 

DemoForm(self), AFXMode.ID_ACTIVATE) 
AFXToolButton(toolbar_group, '\tRight Arrow', toolbar_icon_right, 

Demoform(self), AFXMode.ID_ACTIVATE) 

The AFXToolbarGroup class creates a container to be used for groups in the toolbar. It 
creates vertical separators between toolbar groups. It accepts 3 arguments- owner (the 
creator of the group), name (the toolst name) and title (name that appears in the title bar 
of the menu when it is floating) -two of which are used here. You've previously seen 
afxCreatelconO which creates an icon using a BMP, GIF, PNG or XPM file. Here 4 
icons are created using 4 bitmap images. You've also seen the AFXTooiButton class 
used previously to create a button for the custom tool box in section 20.6.4. 
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# Toolbox button 
toolbox_group = AFXToolboxGroup(self) 
toolbox_icon = afxCreateicon('icon_star_black.bmp') 
AFXToolButton(toolbox_group, '\tThis is a Tool Tip', toolbox_icon, 

Demoform(self), AFXMode . ID_ACTIVATE) 

Here you see a toolbox being created as was done in customToolboxButtonsGui.py 
described in section 20.6.4. One button is added to the toolbox group with a black star 
shaped icon. 

Module: Custom Moo 

# Toolbox Flyout buttons 
toolbox_flyout_group = AFXToolboxGroup(self) 
toolbox_popup = FXPopup(getAFXApp().getAFXMainWindow()) 

toolbox_flyout_icon_l = afxCreateicon('icon_star_red.bmp') 
toolbox_flyout_icon_2 = afxCreateicon('icon_star_green.bmp') 
toolbox_flyout_icon_3 = afxCreateicon('icon_star_orange.bmp') 
toolbox_flyout_icon_4 = afxCreateicon('icon_star_blue.bmp') 

AFXFlyoutltem(toolbox_popup, '\tFlyout Button Red', 
toolbox_flyout_icon_l, DemoForm(self), AFXMode.ID_ACTIVATE) 

AFXFlyoutitem(toolbox_popup, '\tFlyout Button Green', 
toolbox_flyout_icon_2, DemoForm(self), AFXMode.ID_ACTIVATE} 

AFXFlyoutitem(toolbox_popup, '\tflyout Button Orange', 
toolbox_flyout_icon_3, DemoForm(self), AFXMode.ID_ACTIVATE) 

AFXFlyoutitem(toolbox_popup, '\tFlyout Button Blue', 
toolbox_flyout_icon_4, DemoForm(self), AFXMode.ID_ACTIVATE) 

AFXFlyoutButton(toolbox_flyout_group, toolbox_popup) 
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Another toolbox group is created here, except this toolbox group consists of a flyout 
button. When the user keeps his left mouse button pressed over this toolbox button, 3 
other buttons are displayed. On the other hand if the user clicks without holding the 
mouse button down for a certain time duration, it is the same as clicking on the first out 
of the four buttons. Read the above statements and observe the use of AFXFiyoutButton 
widget which creates a flyout popup window and AFXFiyoutltcm widget which creates 
the individual buttons within the flyout. 

* '** ------· 
# Actually create the custom module GUI. 
CustomModuleGui() 

While the classes we define in other scripts are called by Abaqus while drawing the GUI 
or when responding to user activity, our custom module must be explicitly created by us 
otherwise it will not be created at all and will not appear in the module combo box. We 
accomplish this by calling the constructor of the class which contains a ll the instructions. 

Module: Custom Module 

A B 

c 
E F 

* 

Part: 
Property 

* Job • Visualization 

Sketch 
Custom Module 

·20~6. 7 · .For.,l Mode, 
J .. :J ....... I \ ;._ '' - •!<; ...- ·~., .. ~ , """"'· ;.,< J.o, ..._ ._ 

This script is contained in demoForm.py. In this script we create the form mode that 
launches the dialog box (DemoDB in demoDB.py). 
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I # ********************~*~*************~~···········~····················~······. ··· 
# Th_is. script defines a form that will P.OSt .a dialog box (DemoOB in demoDB.py) 

I # *.****~*********'************.*****.~******************************.*******,..*******~* I . \ ; . . .. . . ; . . .. .-· " . . , . . ,._ . :· . -
I from abaqusGui import * ' 
i~port demoDB · 

# Class definition 

I clas~ QemoForm(AFXForm): ·. 

# Construct base class. 
AFXForm. __ init __ (self~ owner) 

# Command to execute when OK is clicked· 
· #we have not created a method to -deai with the user clic~ing OK · hen~e .we 

# shall put in kernalCommandMethod and kernelCommandObject for now 
self.cmd = AFXGuiCommand(self) 'kernalCommandMethod'; 

· · , 'kel"ne:J,CommaildObject: ) 

#-------------------~--------------------------~7-----------------~---
~ A getFirstDialog(} method MUST be ·written for a mode , (a Form mode) ., 
# It should return the .first :dialog IJox of:"tfie mode · 
def getFirstDialog(self): · · 

. # . Reload the dialog· module so .that any ,changes to ttie dial,.og are updated • 
# 
reload(demoDB) . 
retyrn demoDB.Demoi?B(se!tf~ · 

" 

# Get the command string that will 
cmas = self .getCO!IIIIandStr::tng(~L :· . ; ' .· . ''. 

. . 

. '"': 

#Since ~have not actually created Gommands that ~ill execute, _let's . 
# instead wPite thi,~ conlnand .stdng to the message C:<lrea so' we know ,it. · ,, . ••••• - • • •• • ' < • ·: ; ' . .~ •• ~ • · , . '£:.,~ ~ . ' • l . -,.; ' # executed c • • · . • --. ' .• A· 

getAFXApp() • getAFXHainwindow() .-write T oMessageArea ( clilds) . . - , 

seif.deacrttivateHNeede_a(l) 
return TRUE · · 

unless you 

I 
! , I 

I 
1 
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-. -~-..-,...~~---~-. ----...---. ----.... ------------ -·---.... ---·----.... ----------.. - ---
. # wish to change :til·e default behavior 

·· # H~re we wauid )lJ<e ~~it ~tp~print a message: to the , S€r'een before proceeding 
d~f· activate( self):: :':· - . _ ·· · · · · 

priret 'Mode ih;;ts''"been'" activated·' · ·. · 1 · · 

# Now must call · the :base method ·· . 
'.AFXf9rm.ac1;iv~t~{s~l.f'> , J •..• ::.· . l . • _ 

>-=:;...!.:...--'---------~--···---·---·-------'-=----=..:__=~__::£......!:!:._==-=-=.:_~-..:..._.::::..........:..:.::..1 

from abaqusGui import * 
import demoDB 

We need to import demoDb.py which contains the class DemoDB - the dialog box. 

class DemoForm(AFXForm): 

We derive our class DemoForm from AFXForm which defines the basic form mode 
functionality. 

----------------------------------------------------------·------------- - -- 1 #----------------------------------------------------- ------------- --- I 
def _init __ (self, owner): 

# Construct base class. 
AFXForm. __ init __ (self, owner) 

# Command to execute when OK is clicked 
# We have not created a method to deal with the user clicking OK hence we 
# s hall put in kernalCommandMethod and kernelCommandObject for now 
self. cmd = AFXGuiCommand(self, 'kernalCommandMethod', 

'kernelCommandObject') 

The code for the mode is placed in the _init_O method as always. The base c lass is 
constructed to acquire the necessary functionality of a fonn mode before adding our 
customizations. 

The AFXGuiCommand class is used to construct a GUI command that will be executed 
when the OK button is clicked. lt accepts the arguments mode, metbod, objectName 
and registerQuery. mode can be a fonn mode or a procedure mode; we set it to self. 
method is a String specifying the method to execute in the kernel script, objectName is 
the name of the kernel script, and registerQuery is a Boo lean specifying whether or not 
to register a query on the object so that the commands keyword values can be updated 
based on the kernel state. 

In this example we are creating an application framework or an application prototype that 
you can build upon when creating your own GUI programs (which you will do in the next 
chapter). Hence we do not actually have any functionality in this application, and nothing 
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is supposed to happen when the OK button is clicked. So we set method to 
kernaiCommandMethod and object to kerneiCommandObject as placeholders for 
when we actually have methods and scripts to use. 

#------------ -- ----- ------------------------------ ----------- ---------
# A getFirstDialog() method MUST be written for a mode (a Form mode) 

I # Reload the dialog module so that any changes to the dialog are updated. 

# It should return the first dialog box of the mode 
def getFirstDialog(self) : 

I # 
I reload(demoDB) L __ r_e_tu_r_n_ de_m_o_D_B _. D_e __ mo_D_B_;(_s_el_f_;_) ___ . 

As the comment states, every fonn mode must have a getFirstDialogQ method. The 
method must return the first dialog box of the mode. We reload the form using reloadQso 
that any changes to it are updated. The function then returns an instance of the dialog box 
DemoDB. 

! #------------- ------------------- ----- ------------- -------------------I 
I 

I 
i 

I 
I 
I 
' I 
! 

def issueCommands(self) : 

# Get the command string that will be sent to the kernel for processing 
cmds = self.getCommandString() 

# Since we have not actually created commands that will execute, let's 
# instead write this command string to the message area so we know it 
# executed 
getAFXApp().getAFXMainWindow().writeToMessageArea(cmds) 

self.deactivateifNeeded() 
return TRUE 

The issueCommands method constructs the command String and issues it to the kernel. 
It also handles any exceptions thrown. It will deactivate the mode if the user pressed the 
OK button. The issueCommands method calls getCommandStringQ, 
sendCommandStringO and doCustomTaskO. 

getCommandStringO returns a String representing the command associated with the 
mode. By default it includes the required keywords in the order in which they were 
constructed in the mode. sendCommandStringO takes the command String from 
getCommandStringO and sends it to the kernel for processing. This method should not 
be overwritten. doCustomTasksO can be redefined to perform additional tasks after the 
command is processed by the kernel. 
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issueCommandsQ does not usually need to be called since the Abaqus GUJ 
infrastructure will do this automatically. It is only necessary to call it manually if you 
interrupt the processing of the mode. Or, as in our case, if you wish to print the command 
String to the screen for debugging purposes. We obtain the String using 
getCommandStringQ. However we do not call sendCommandStringQ, which we must 
call manually to submit the command to the kernel now that we have modified 
issueCommandsQ. Hence no command will actually be passed when you click OK m 
this example application and therefore nothing happens. 

#---------------------------------------------------------------------
# A mode is usually activated by sending it a message with its ID set 
# to ID_ACTIVATE 
# This message causes activate() to be called 
# Note that it is NOT necessary to define this activate() method unless you 
# wish to change the default behavior 
# Here we would like it to print a message to the screen before proceeding 
def activate(self): 

print 'Mode has been activated' 
# Now must call the base method 
AFXForm.activate(self) 

--- -----·-·--------· -----------
The comments preceding this block summarize what you need to know. activatcO is the 
method called whenever we pass an ID_ACTIVATE message to a dialog box such as 
DemoDB. This entire block of code does not need to be present in our script, since the 
activateO method is called by default. However since we wish to print a message to the 
screen when it is called, we have to define activateQ manually. And since we have done 
that, the base activateQ method must also be manually called usmg 
AFXForm.activate(self). 

·M~I Dlalog'box . 
..,; • - $11: 4 

This script is contained in demoDB.py. In this script we create the dialog box (displayed 
in the figure) that will be posted by a number of menu items and toolbar and toolbox 
buttons. 
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! # demoForm. py) 
! 
I . i # Created. for the book "Python Scripts for Abaqus - Learn by Example" 
: # Author : Gautam Puri 
i # ******************************************************************************** 

I from · abaqusGui import * 
i 
I # Class definition 
I 
1 class DemoDB{AFXDataDialog): 

I 
i 
I 
I 
! 

i 

! 
I 

I 
I 
! 
I· 
I 
I 
! 
i 

I 
1 
j 

I 
I 

l 
i 

I 
i 

#~- - - -------------------------------- - ---~---------- --- ------p~-------def __ init __ (self~ form): 

# DIALOG_ACTIONS_SEPARATOR places a horizontal line/separator between the 
# contents of the dialog box and the OK/CANCEL buttons at the bottom 
# DIALOG_BAILOUT displays a message "Save changes made in the xyzdialog?" 
# if the user clicks cancel after changing some values in the dialog box 
AFXDataDialog. __ init __ (self, 

form, 
'Demo of Dialog Box posted using Form', 
self.OKiself.CANCEL, . 
DIALOG_ACTIONS_SEPARATORIDATADIALOG_BAILOUT) 

.. #---------------------------------------------------------------------
# The show() method is called by default whenever the dialog box is to be 
# displayed. 
# For example in modifiedcanvasToolsetGui. py you have the statement 
# AFXMenuCommand(self, vi ewport_menu_with_contents, 'Custom Menu Item', None, 
# DemoForm(self), AFXMode.ID_ACTIVATE) 
# So whenever the custom menu item is clicked, the activate () method of the 
# mode is called 
# This in turn tries to create the dialog box and the infrastructure calls the 
# create() and show() method of the dialog box . 
# Note that this method does NOT need to be defined here· if we wish to leave 
# the behavior at default 
# Here however we wisn to modify the show method to also print a mess·age to · 
#the screen (aside from opening the· window which it does by default). 
def show(self): 

print · Dialog box .will be displayed '. 
# Now must call the base show{} command 
AFXDataDialog.show(self) 

#---- -------- ;--~------ - --- --- ----------- ----~ - - - -- -------------------# The hide() method is the opposite of show(). It is called by default 
# whenever the dialog box is to be hidden 
# Note that this method does NOT need to be defined here if we wish to leave 
# the behavior at default . 
# :Here however we wish to II)Odify the' hide method ·t o also· print a message to·' 
# the screen (aside from closing the window which -i t does by default). ' 
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def hide(self): . . .· ... 
print ' Dialog 15ox will be -hidden· · 
# Now must call the base hi de() command 

...................... A.F~~-~-~a.o~~-~-?~(·.~~-~-~{~~-~f) ... :; ........... - -- ~ ... . . ..·. ... . .. ·---- . ........ ... . .... . 
from abaqusGui import * 

As usual, this import statement features at the top of the script. 

class oemoDB(AFXDataDialog): 

We derive our c lass DemoDB from AFXDataDialog which defines the basic dialog box 
functionality. A data dialog box is one in which data is collected from the user. If we did 
not wish to collect any information from the user and only wanted to display some 
information, we could instead use the base class AFXDialog from which 
AFXDataDialog is derived. AFXDataDialog is designed to be used with a form mode to 
gather data from the user. lt is also best to use a data dialog in a module or any non
pers istent toolset so that the infrastructure can manage the dialog box when the user 
switches modules. We will implement data collection and keyword usage in the next 
chapter, in this example we merely create an empty data dialog box so you understand the 
fundamentals. 

:---•••••·--·~-~~-·•••••·----•-•••• _,,,,..,,.,,,,,._., • • .,,NOoO·•-•'•"'''''' '''''-'''''-''''''''''''''''"'' >'>>•'' '''"'' " '''"'""'-' ' ' ' '''''-''''''''' ''•'••o•ooo-o•••• ••••--OOo o ·-' ' ' ' '""'''"'''''"'·OMO- ·- •0•0 ~ .,,_ · -#- -- --- ---- --- ------------ ----- ------ -------- --- -- --- ------------ -----def __ init __ (self, form): 

# DIALOG_ACTIONS_SEPARATOR places a horizontal line/separator between the 
# contents of the dialog box and the OK/CANCEL buttons at the bottom 
# DIALOG_BAILOUT displays a message "Save changes made in the xyz dialog?" 
# if the user clicks Cancel after changing some values in the dialog box 
AFXDataDialog. __ i nit __ (self, 

form, 
'Demo of Dialog Box pos ted using Form', 
self.OK!self.CANCEL, i 

: ____ _____ _____________ _E_IALOG_~.£!E9_~=~-EPA~TOR I D~~~IALOG_B~I LO~!) J 
The code for the dialog box, if any, is placed in the _init_ O method. In our case the 
dialog box has no widgets inside it. Note that the _init_Q method of the class has 2 
parameters - self and form. As you are already aware, all methods inside of a c lass have 
self as the first parameter in the method declaration. The second parameter here is form. 
This placeholder will store the form mode. This is because in DemoForm we call the 
dialog box using DemoDB(self) in the getFirstDialogO method. Here self refers to the 
form DemoForm which is calling the constructor of Demo DB. It is this reference to self 
that is passed to form in the constructor of Demo DB. 
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The _init_O method of DemoDB calls the _init_Q method (the constructor) of the 
base class AFXDataDialog. The constructor of AFXDataDialog accepts a number of 
parameters - mode, title, actionButtonlds, opts, x, y, wand h. We set mode to form, 
which, as stated before, refers to the form mode DemoForm that launches DemoDB. 
title is the title of the dialog box which will appear in its title bar. 

actionButtonlds contains the ID's of the action buttons to be created at the bottom of the 
form. self. OK and self. CANCEL create OK and Cancel buttons. You can also have 
other buttons such as APPLY, DISMISS and so on. These action buttons have default 
behavior. For example AFXDataDialog.OK sends an (ID_COMMIT, 
SEL_COMMAND) message to the fonn mode with its button ID before hiding the 
dialog box. AFXDataDialog.CANCEL on the other hand checks for a bailout, and then 
sends an (ID_DEACTIVATE, SEL_COMMAND) message to the form mode with its 
button ID before hiding the dialog box. Other available buttons are Apply, Continue, 
Defaults and x in the title bar - refer to the documentation for more information on these. 

opts provides some additional options- DIALOG_ACTIONS_SEPARATOR places a 
separator between the action buttons and the rest of the dialog box contents. 
DATADIALOG_BAILOUT jumps into action when the Cancel button is clicked- if 
the user has made changes to the contents of the dialog box before hitting Cancel, the 
application will post a standard warning dialog box. You can find other options in the 
documentation. x and y, if specified, are the X and Y coordinates of the origin, and wand 
h if specified are the width and height. 

~-- #- - - -- - --- - -- - - ~-::-=-~~-=-=-::-~--~-=~-~-=-::-::-:.-:-=-=-==-- - --- ---- ·::-:-::-::-=-::-::--=-~-=-=-:-------, 

1 

I 

# The show() method is called by default whenever the dialog box is to be 1 
# displayed. I 
# For example in modifiedCanvasToolsetGui.py you have the statement 1 
# AFXMenuCommand(self, viewport_menu_with_contents, 'Custom Menu Item', None, i 
# DemoForm(self), AFXMode.ID_ACTIVATE) 
# So whenever the custom menu item is clicked, the activate() method of the 
# mode is called 
# This in turn tries to create the dialog box and the infrastructure calls the 
# create() and show() method of the dialog box. 
# Note that this method does NOT need to be defined here if we wish to leave 
# the behavior at default 
# Here however we wish to modify the show method to also print a message to 
#the screen (aside from opening the window which it does by default). 
def show( self): 

print 'Dialog box will be displayed' 
# Now must call the base show() command 
AFXDataDialog.show(self) 
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The comments in the above code describe what is going on. Whenever a dialog box is to 
be displayed, the showO method must be called. So when a form mode or a procedure 
mode launches a dialog box, it is calling the showO method. The infrastructure does this 
behind the scenes so you don't need to call sbowO yourself. In fact you don' t need to 
define a showO method at all in your script. In this example we wish to print a message 
to the screen when showO is called, in order to help you understand how the 
infrastructure works, and for this reason we had to manually define showQ. Since we 
have done this, we now have to make sure that the base showO command is called, hence 
we use AFXDataDialog.show(selt). 

1#=-~-~-~-=-=-=-~-~-~-~-=-~--=-·=·-~· =·==·=··~-~-==-~··=·=-=·=-·=-~--~··=·=~-=-=-=-.::-=-=·~=-:---=-=~-=-==-=-~-=-=-=-=::-:.~-·------· 

I
. #The hide() method is the opposite of show(). It is called by default 

# whenever the dialog box is to be hidden 
· # Note that this method does NOT need to be defined here if we wish to leave 

# the behavior at default 
# Here however we wish to modify the hide method to also print a message to 
#the screen (aside from closing the window which it does by default). 
def hide(self): 

print 'Dialog box will be hidden' 
# Now must call the base hide() command 
AFXDataDialog.hide(self) 

L------- ~-----

The Abaqus GUI infrastructure calls the hideO method of a dialog box when it is 
supposed to close. For example, although the OK and Cancel buttons mean slightly 
different things (and presumably clicking OK will cause something to happen), both 
buttons need to close the dialog box when they are pressed. They both achieve this by 
calling the hideO method. Since the infrastructure takes care of this by default, you do 
not need to call hideQ, nor do you need to define hideO at all in your scripts. The reason 
we define a hideQ method here is so we can print a message to the screen when it is 
called, and therefore demonstrate how the infrastructure is working internally. Since we 
have defined a hideO method, we now need to call the base hideO command manually to 
do the actual hiding using AFXDataDialog.hide(selt). 

2o.6t9~ -~Mod~l~;nii1~.6i1 ·,~·~··~' ""'", 
hi .,._ !fo.: - ; • ~ -~~~ - -

This script is contained in demoDBwoForrn.py. In this script we create the dialog box 
that will be directly posted without the use of a form mode by the last menu item in 
Custom menu (displayed in the Custom mode). 
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Hi World! 

OK J l Cancel ] 

# ******************************·********'**!*************************************** 
I
. # This . script de$C:ribes' a dialog-?ox that .will · b~ pOSted directly· Wi.thout us~ng a 

#form · · , .,. 
l # ***************************************************·***************************** 
I :_ . . . . 

-firom aba~LisG,ui import * , ·, 

# Clas~ . definition 
class DemoDBwoForm(AFXOialog): 

;_ - ~--~ ~ - __ _; _._- ~ ----- __ ._ ---- ~ -~- ~ -------_._-:---- -~- -- .:-:. _---- ---.:;~------
def __ init __ (self, form): 

- \ 

:·Ai=xbialog~ __ init2..._~self~ . 
'Demo of Dialog ~~x posted -without 
AFXDialog.OKIAFXDialog.CANCEL, 
DECOR~RESIZE) 

" 
'Hi World!') 

from abaqusGui import * 

As usual, this import statement features at the top of the script. 

class DemoDBwoForm(AFXDialog): 

We derive our class DemoDBwoForm from AFXDialog which defines the basic dialog 
box functionality. In the previous section, we derived our modal dialog box from 
AFXDataDialog since it needed to gather data from the user (not that we implemented 
keyword usage in this example, but you'll see how that's done in the next chapter). In this 
dialog box on the other hand, let's assume we only wish to display something without 
accepting input from the user. The AFXDialog class suits our needs. 

~--------------

1 :~f-~:::::::::~;::::~~!~~;~-~~-~~~:~~-~~~-~~~~ed-w~thout-F~:~::------



AFXDialog.OKIAFXDialog.CANCEL, 
DECOR_RESIZE) 

. FXLabel(self, 'Hi World!') ·----·---w--w------------·----·--------•-•••••••••••·--••-•••--·•••·-·-·------•-•••-----••••-•• 

20.7 Summary 625 

The code for the dialog box, if any, is placed in the _ init_O method. In our case the 
dialog box has one widgets inside it - a label created using FXLabelQ. Note that the 
_init_O method of the class accepts a number of parameters - owner, title, 
actionButtonlds, opts, x, y, wand h. We've spoken about these parameters in previous 
sections. Here we set owner to self, indicating that the dialog box is not owned by any 
other object. We set the title to ' Demo of Dialog Box posted without Form', hence this 
will appear in the title bar of the dialog box. We wish to have OK and Cancel buttons so 
we provide lOs of AFXDialog.OK and AFXDialog.CANCEL. Aside from OK and 
CANCEL, other possible options are APPLY, CONTINUE, DEFAULTS, DISMISS, 
NO, YES and YES_TO_ALL. If we did not wish to have any action buttons we could 
instead use a 0 here. For option we specify DECOR_RESIZE which makes it possible 
for the user to resize the dialog box. 

We did not define the showO method for this dialog box, but that does not mean it is not 
present. lt exists by default, just as it would have even if we hadn' t created it for 
DemoDB. The infrastructure calls it behind the scenes in order to show the dialog box, 
and it also calls hideO when it is time to close the dialog box. 

'2o. 7:! . s~ .. -~::; ,... t 
· 'fi·r.,..dt. ·.; ~ m ~ 

We created a working GU£ framework in this chapter in order to explain the process of 
writing the scripts, and also to understand the inner workings of the Abaqus GUI 
infrastructure. The application created here does not do anything useful on its own, 
however the basic framework has been created, and it is one you can reuse when creating 
your own GUI applications. In fact we shall reuse it in the next chapter. 



21 -
Custom GUI Application for Beam 

Frame Analysis 

·- . 
In the previous chapter we created a framework that can be reused for any GUI 
application. lt included a persistent toolset, a custom module with menus, toolboxes, 
tool buttons and a tool bar, and other customizations to the standard GUI interface. 
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In this chapter we will create a functional application that demonstrates project 

automation. We will use the beam frame model from Chapter 9. The application will 

create this same beam frame simulation, but prompt the user for inputs along the way. 1t 
will create a custom interface where the user can only perform certain actions, and only 

when prompted to do so, just as you would expect from a vertical application. 

The figure displays our custom GUI application. It will not have a model tree on the left. 

The majority of menus and toolbars are removed leaving only a few barebones items. 
There is a persistent toolset with buttons 'Step 1' thru 'Step 5'. All the modules are 

removed as well leaving only a custom module called 'Beam Module'. This module has a 
module toolset which consists of 5 large buttons (with large icons on them). A custom 
toolbar is available with buttons and small icons. There is also a menu called 'Custom 

menu' with 5 menu items. The persistent toolset, beam module toolset (with the big 

icons), the toolbar, and the custom menu all have 5 buttons/items and provide the exact 
same functionality. 

When 'Step 1' is initiated using any of the buttons or menus, the user is prompted for 

material properties. He can select 'Steel' or 'Aluminum' or define a new material. When 
the user clicks OK, Abaqus proceeds to create the model, beam parts (frame and 

crossbracing) and materials (using the users input). 

i Poi!>son's Ratio 

Alert; You cannot hove a negative density 

When 'Step 2' is initiated, the user is prompted to create the profile of the beam with 

options of 'I', 'Box' and 'Circular'. A number of default values are filled into the fields 

which the user can alter. When the use clicks OK the profiles are created. The application 
also proceeds to create the sections and assembly. 
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[I~~ 
------- -- -- - . -------- - - -

Select a profile 

@ I C) Box B Circular 

· Dimensions -· -

OK 

Frame Members 

1 lo.o75 I 
h ~ 
bl~ 
bl~ 
u~ 
t2~ 
t3 [§] 

L~ncelj 

Cross Bracing 

I ~ 
h ~ 
bl~ 
b2~ 
tl~ 
t2~ 
t3~ 

When 'Step 3' is initiated, the user is prompted to select a cross member, then a second, 
and then two frame members. The user will be able to pick these in the viewport. 

[B ~ Select the first cross m~ber 

The application will then prompt the user to enter loads for each of the members selected. 

~~~1~<~ 
--- - -- - ----

Cross load 1: ID I 
Cross load 2: !1 l 
Frame Load 1: j1 I 
Frame load 2: ! 1 I 

I _QKJ- J j_ ~n£e!J 

On accepting these inputs, the application will create the loads and display the assembly 
with loads in the viewport. 
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'Step 4' asks the user if he wishes to save the model'. 

ffi Are you sure you wish to save this mod er? 

If he clicks Yes he is asked to provide a path at which to save the model. 

rm~--···;r, ~· 
'--~~.!.U:1J _L._ '-----

~-- ~- - -- - - -- - -

!I l l~~es!~:l 
~============~ 

Set a directory (not implemented): I l l~elect~l 

Save the model: 

If he clicks the Select ... button, he will be provided a file selection window 

--------- ---- ---·· -- -------- - . -- - - -- ------~ 

Li~- i X 
~ 

- -- -------

Directory:l@l beamApp liiJ C!J S )!> .t4 cl-rniD ll a rift 0 
-· e:s .. 0 11baqusMacros.pyc 

[) abaqus.rpy.414 0 ABQcaeG.exe.dmp 
D abaqus.rpy.415 [) ABQcael<.exe.dmp 
[) abaqus.rpy.416 0 beamJunctiOn$.py 
[) abllqus.rpy.417 D beamAppConstants.pyc 
D abaqusl.rec D beamCaeApp.py 
0 abaqus_acis.log [) beamCaeApp.pyc 
0 abaqusMacros.py D beamCaeMainWindow.py 

-< k -,..~J!In>"-'Mi ' 
~ 

-
fileNam~ II I L QK ·I 
File Filter. I All files (*.") @j 0 Read·only I ~nee! jl 

The directory selection on the other hand is not actually implemented in this application, 
but is provided to show you how to present the user with a directory selection window if 
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you need to do so in one of your own scripts. If the user clicks Select ... next to ' set a 
directory', he will see the directory selection window. 

.. ~ •_ I ....___ - - ~-- ~ ---- --

D .. 

Qirtctory Name: '-------- -------l l OK 
File Filter. L-[_-_ ________ _ _ --_-_..,HI ~!)eel 

When the OK button is finally clicked, the entire model is saved at the specified file 
location. 

Finally ' Step 5' runs the analysis. 

21.2 Layout Manager.s and.Widgets 
In the custom CAE example of the previous chapter, our dialog boxes were mostly 
empty. This time they will be populated with useful text fields, check boxes, radio 
buttons and combo boxes. All of these are known as widgets. In fact regular buttons, 
toolbar and toolbox buttons, flyout buttons and menu buttons are also widgets, so you 
have in fact used widgets before. Widget is a generic term for GUI controls, and these 
widgets allow a user to interact with the program. 

Layout managers are containers used to arrange widgets in a dialog box. You place the 
widgets within the layout manager, and depending on the type of layout manager those 
widgets will be placed in an ordered manner in the dialog box. For example, a vertical 
alignment layout manager will cause all widgets inside it to be placed one below the 
other. A tab book layout manager on the other hand will allow you to have multiple tabs, 
and different widgets in each tab which will be displayed only when the user is in that 
tab. 
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You'll use layout managers and widgets in the dia1og boxes for 'Step I ' through ' Step 4' 
so you'll have a good understanding of them by the end of the chapter. 

21.3 ,~ Transitjons an(l .Proce~s Updates· 
Transitions allow you to detect changes in the state of widgets. The program can then 
change the GUI state in a dialog box based on the detected activity. For example, in the 
dialog box for ' Step I', the user is presented with 3 material choices - ' AISI 1005 Steel', 
'Aluminum 2024-T3' and 'New' . A transition is added to the application to detect 
whether the user has clicked 'New' or not, and if he has, a number of text fields are 
enabled allowing him to provide a name and material properties for this material. On the 
other hand if 'Steel' or 'Aiuminum' are selected, these material property fields will be 
disabled or grayed out. 

The transition allows the program to detect the change in state of the combo box widget 
and execute the appropriate method to enable or disable the text fields. Transitions do this 
by comparing the value of the keyword associated with the widget with a specified value 
and doing a simple comparison such as EQ (equals), GT (greater than) or LT (less than). 
However sometimes you may need to perform a more complicated comparison, or meet 
some more complex condition that cannot be represented using simple comparisions such 
as EQ, GT and LT. In that case you will need to use process updates. 

The processUpdatesO method is called during every GUI update cycle. You can place 
your own code in this method to test for some condition, and if some condition is met 
then you can execute the relevant methods. Needless to say this should be used with 
caution since it is called at every GUI update, and if you have a lot of time consuming 
code here you can slow your program down considerably. 

We will demonstrate how to use transitions in the dialog box for ' Step I', and 
processUpdatesO in the dialog box for 'Step 2'. 

2t.4 ·~ · Exploritlg t~e script~_-: 
. " 

A number of scripts are associated with this example and must exist together in the same 
folder to make the application work. We shall explore each of these in detail. 

~'J ~"'{·~·• .:.::' - ,";"" · ~··· i · ·~w.• ·' • • 

21.4.1 .. ··Beam· Appliddimi Kernel Script 
' . ... .. -t. - ~ < - ...,;..__;. .. ;); ~ • ... 

This following script is the kernel script responsible for creating the beam model. It is the 
backbone of the application. While the rest of the scripts deal with constructing the GUI 
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and responding to events (and are therefore GUI scripts), this script is called at the end of 
each ' step' and executes the necessary kernel commands to create parts, materials, 
sections and so on. 

The script is contained in beamKernel.py 

r: ·~:·:;::·:::~·:~~~:·:~:~~~~:·~~·~~~~~~::!~~~···:-·**-****-****······.;;;·;;;.-;;·;;;-*~*-***~~1 
! # This script is the heart of the program. It sends commands to the kernel I 
i # to set up the model and run the analysis job ; 
[. # Hence it is a kernel script, it does not participate in ,GUI construction .1 
i 
1 # Created for the book "Python Scripts for Abaqus - Learn by Example" 
i # Author: Gautam Puri 
l # ******************************************************************************** I 

I ' 
j from abaqus import * 
I from abaqusConstants import * 
f import regionToolset 

step_counter = e 
' 
[ dass B~amKernei(): 

f def createModelPartMaterial(self, mat_selected, mat_name, mat_density, I mat_youngs, mat_poissons): 

! global material_name 
i 

r 

I 
I 
t 

# The user may have selected steel or aluminum in which ~ase the rest of 
# the fields will be left blank and· the parameters will have default 
# values 
if mat_selected == 1 : 

material_name = 'AISI 1ees Steel' 
mat_density = 78ee.e 
mat_youngs =' 28.0E9 
mat_poissons ~ 0.3 

elif mat_selected == 2 
material_name = 'Aluminum 2924-T3' 
mat~density ~ 2770.0 
mat:youngs = 73.1E9 
mat_poissons = 9.33 

else: 
material_name = mat_name 

# if you try to provide a youngs modulus and poissons rati o both equal to 
#zero Abaqus throws an error because in .t~e elast ici ty table you've 
#given it a row of zeros . · 
i f mat_youngs==9 and mat_poissons==a : 

print 'Young\s modulus and Poisson~s ratio cant both be, zero' 



21.4 Exploring the scripts 633 

:-··--,--,;-···············:·· -·; ·· ... s·iri~r·~~:-exi·1:· ·-s1:.e"i?:.-·i···~e:···~~:~~t·····t~e· ···gio·b~i·····~-~~~·t·~-~--s-~--t·h-e··-~se·r····~a~---·-----··--
. · # perform·1·St~p 'i again; . " : 'tp; . • . : ·· · · 

return Faise< · · ·. · 

session. vie~por.~~ ~ 'Viewpo~t :·· 1 '• r. setValues ( displayedObject=None) 
# __ ______ _;:., 

# Create the 'model , ... ~· . . . •· ' ~ .· :;.· :: 

mdb.models .:chang.eKey:(frornName;;;•r-todel-i', toName='Beam Frame · ) 
"l' • ' : -;; / 

·- · # Make beamModel- a global var~_able so i t can be accessed by the other 
· # met hods wi thout being passed t o them as an argument 
#This is similar to having a 'static' variable in a language such ·as 
# C++ ie the variable exists without creating an instance of the clas s 
global beamModel , · ; · 

. ~· ·c··•.-.:: 

; . ~- ' \: 

beant-k>del = mdb~ lliod~ls['Beam Frame'] 

# - --- ------- ~;~ ----------------------- - -- ------- - -- - -------------
# Create the P(irts . 

import 
import part 

.#Start with a .·30 Poi nt Deformable Body 
global framePart · 
framePart = beamMdqel. Part(name= ·Frame ' , dimensionaUty=THREE_O,~ 

· .!~~11, . ·"'· i . . . • type=I:>EFORMABLE BODY) 
framePart. Re.fef;ericePoint (point= (e. 9, e. e, 9 . e)) -

' ~ I' ' 

$ :r ' . 

# -- -----~~~ -~--~---- --- - ----- - ------- -- - ------ - -- ---- - -- - ----- - --
. # a) Create on~ s'ide of .. the frcame 

· # Create ot her· da'.tum points by offsetting from the reference point 
.. the_referen,ce~point · = frame~~r.:t :.referen€ePo:iints [ 1] 

... , .. framePart. DatumPeintByOffset(peint=th~_r.eferenGe_point,~ 
·., · -·~"· ~ · · .. t · (1.3 e 0 e 0 9)) . . . ·. , :· ._ . : vec or= • , • , . 

framePart. D~ttimPointByOffset ( poitrt:=t'he_reference_point, 
·~· . • · · · .. vector=( 4 .9,-3 .e,e.e)) 

. framePart. DafuiiiPointByOffset(point=the_reference_point, 
·' · · . vector=(l:.e,e.e,e.e)) 
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# are unordered 
# Sort them to get them in ascending order as abaq.tis assigns keys in · 
# ascending order as a datum point is created 
# Once the points are available a datum plane is created using the 3 · 
#points . . 
framePart_datums_keys = framePart.datums.keys() 
framePart_datums_keys.sort() 
frame_datum_point_l = framePart . datums[framePart_datums_keys[2]] 
frame_datum_point..:_2 = framePart.datums[framePart_datums_keys(l]] 
frame_datum_point~3 = framePart;datums[framePart_datums_keys[e]] 
framePart.DatumPlaneByThreePoints(pointl=frame_datum_point_l, 

point2=frame_datum_point_2, 
. point3=frame_datum_point_:3) 

# ·Create a datum axis 
framePart.oatumAxisByPrincipalAxis(princi~alAxis=YAXIS) 

# The.re are 5 objects in the datums repository, ·3 datum points, a datum 
# planeJ and the datum axis 
# The datum plane will be the one whose key is the second to highest · 
# number · 
# The datum axis will be the one whose ·key is the highest ·number 
framePart_datums_keys = framePart . datums.keys() 
framePart_datums_keys.sort() 
index_of_plane = (len(framePart_datums_keys) - 2) 
index_of_axis =·(len(framePart_datums_keys) - 1) 
frame_datum_plane = \ 

framePart.datums[framePart_datums_keys[index_of_plane]] 
frame_datum_axis = \ · · 

framePart.datums[f.ramePart_datums_keys[index_of_axis]] 

# Create the sketch 
sketch_transfonml = \ 

framePart.MakeSketchTransform(sketchPlane=frame_datum_plane.~~ 
· sketchUpEdge=fra~e_datum_axis, 

sketchPlaneSide=SIDEl. 
. sket.chOrientation=LEFT .~~ 

'origln~(0.e, 0.0, 0.0)) 
= mdb.models[ 'Beam Frame'] \ ... 

• ConstrainedSketch(name='frame sketch 1', 
sheetSize=20, ,. 

· -.~ gridspacing=l/ 
· transform=sketch_transfonml) 

·framePart_sketch. [ine(point1=(1.0~9 .e), .point2,;.(4.~, -3.0}) 
framePart_sketch. Line(point1=(4. 9~ -:-3.0), point2=(6.0';;-'-3 .0)) 

_ framePart_sketch.Line(point1=(6.0J-3.0), paint2=(8.0,-3.0)) 
.framePart_sketch. Line(point1=(8.0, -3.0), point2=(10.0, -3. 0));, 
framePart_sketch •.b~ne.(point1=(10.9~ :-3.0), pQint2=(13.9,0.0) )
.framePart_sketch. Lirte(point1=(13:0.,0.0), point2=(8~0,0.0)) 
frameP!}rt_sketch.line(point1=(8.9,9.0), point2=(6.0,~.e)) 
.framePart sketch.~ine(point1=(6.9,9.e).~~ point2=(1.0,8.0)) 
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t ------f-r~;;;Pa.rt_sketch. Lin~( pointi:;;(··6:·a:·e-:e)";··p-oi~t-2;:(·6·~ e, -3. e) ) 
I · · ·fram~Part_sketc,~. Line,( point;~·( a. e,~.e~;, point2="(s·~ e, - 3 .e)) 
j:· · #: • u~e ··the ske~l~;'t'o c're~t~~~-· Wi~e ', -~' ~, 

, frarilePart. Wire (~'ketchPl~ne~'frame_dat~~-plane, 
.... · s~etchUpEdge,;frame~datum_axis~ sketchPlaneSide=SIDEl, 

· ·- sketchOr:ien.tation=LEFT, sketch=framePart_sketch) 

tr ·:::~- ,-~ - __ __ : .. -:r;;:i.~-. _ -:.;":- ~~ - ~: -..--;_.-: ~ __ :~~ _ ::~ -------·--,---------------
· ' # b)H re.ate ·other·: side_ of: tfie frame·. ·~·:": '~ 

' . . -.,, . . ' . .. . ~ 

# : C~eate a datuniplane by. offsetting ' from existing one 
fr~mePart.DatuniPlaneByOffset(plane=frame_datum_plane, flip=SIDEl, · · ·· · ·· .· · · · · offset=1.5) 
.? r· .... . .. . i\ ., . 
fra~Part_datums_keys = f~amePart . datums . keys_() 
framePart_datums_keys.sort() 
index_of_plane2~ = (len(framePart_datums_keys) - 1) 
:t:rame-::-~_C)tum_l>M~e2_;:=frameP;a'f't:. '-·. · ··. · · :: ; :· · · 

. . . ~·. :_.· ... <'·-~·- .. ·: .:·"''''' :-7~datums['framePart_datums_keys[index_of_plane2]) 
· . . ; :. 

frainePart -.DatumPointByCoordinate( codrds=(l.e., e.e, 1. 5)) 
framePar:t .DatUmPoi·ntByCoor:-dinate( <::oor,ds=(13 .0, e.e, 1.5)) 
fr:am~P.art . Datuml?ointByCoordinate(coorl',ds=( 4. e, -3. e. 1. s)) 

• • • '0. ; • :·~; ~t. ' ' ·:· l ' •. • 

' /1 ; >•- .., ' I ., _ ;< ·t: " ,;j 
0 

t '• ~ 

f_ramePart~Dat~~isByTwoPoint(pointl,;.'(e.e,e.e,l. 5), point2=(e.e, 5.9, 1.5)) 

framePart_datums~keys = framePart.datums.keys() 
framePart_datoms_keys.sort() . 
in~~x-of~axis2,;:~ . ( leii ( fram~P. art_datuin's _keys) -1) 
frame~datuni_::ax.ih ·= · \ · ' ' · 

· · · ... · framePar:t.datums[framePart~datums_keys[index_of_axis2]] 
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r--- framePart_sketch~. Line(pointl={S.e,.e.e), point2=(6 ~·e,e.e)) 
framePart_~ketchi. Line(point1=(6 .a,e.e}, point2=(1.0,0-.0)) 
framePart_sketch2. Line(point1=(6.0,. e .a)_, point2=(6.9,. -3:e)) 

. framePart_sketch2. Line(point1=(8.0;e.e), point2=(8.0, -3.0)) 

# Use the sketch ·to create a -wire 
framePart.Wire(sketchPlane=frame_datum_plane2, 

sketchUpEdge=frame_datum_axis2, sketchPlaneSide=SIDEl, 
sketc~Orientation=CEFT, sketch=framePart_sketch2) 

# ---- ------- --------- - -- --- ~~-------- -- - -- -- - : __ ___ __ __ ____ __ :~--
# Create the cross bracing 

# Start with a 3D Point -Deformable Body -
global crossPart . 

.6 

crossP~rt = beamModel. Part(name='CrossBracing'_, dimensionality=THREE_D, 
type=DEFORMABLE_BODY) 

crossPart. ReferencePoint(point; (0. e, e .e ... e.e)) 

crossPart .DatumPointByCoordiriate(<;oords=(l.0, ·e.e, 0.0)) 
crossPart.DatumPointsycoordinate(coords=(l.e, e . e, 1.5)) 
crossPart.DatumPoint 8yCoordinate(<!oords;(4.0, -3.0, ' 0. 9)} 
crossPart .DatumPointByCoordinate(coords=(4.e, -3.9, 1. 5)) 
crossPart.DatumPointByCoordinate(coords=(6.e, e.0, e.e)) 
crossPart . DatumPointByCoordinate(coords='(6.0, e.e, 1. 5)) 
crossPart.DatumPointByCoordinate(coords;(6.e, -3.9, 9.9)) 
crossPart .DatumPoi'ntByCoordinate(coords=(6.e, -3.9, 1.5)) _ 
crossPart.DatumPointByCoordinate(coords=(S.e, e.e, 0.0)) 
crossPart.DatumPointByCoordinate(coords=(S.e, 0.0, 1.5)) . 

. crossPart.DatumPointByCoordinate(coords=(S.a, -3.0, 0.0}) 
crossPart.DatumPointByCoordinate(coords=(S.e, -3.9, 1.5)) 
crossPart.DatumPointByCoordinate(coords:=(19.0:. -3.9, a.e)) 
crossPart.DatumPointByCoordinate(coords=(10.ej -3.0, 1.5)) 
crossPart.DatumPointByCoordinat~(coords=(13.0, 0.0, 0.0)) 
crossPart.DatumPointByCoordinate(coords=(13.e, 0.0, ~1.5)). 

crossPart_datums_keys = crossPart.datums'. keys() 
crossPart_datums_keys.sort() 

datum ·points = crossPart.datums 
crossPart.WirePolyline(points=( (datum_points[crossPart _datums_keys[9]], 

datum_points[c:rossPart_datums_keys[1}]), 
(datum_points[crossPart_datums_k~ys[2]], 
datum_poi nts[crossPart_datums_keys[3]]), 

(datum_points[crossPart_datums_:keys[4)], 
datum_poiots[crossPart_datums_keys[S)]), 

( datum_pOints~cpossP.art.:_datums_keys [ 6l], 
datum_points[crossPar~_datums_keys[7]])J 

(datum_points[crossPart_datums_keys[aJ], 
datum_points[crossPart~datums_keys['9]]), 
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r~------· .. -·;-_; .. :·- ........................... -·- · ~;·-·· ... ··--···········---····--······ .. :· .. ·· ~:·----· ·--.~ ............. ( .. d~t-~~~-p~i~tsf.c-~~s-sP~·;:t=d~t~;;;s-=-k~ysi1eTJ"·:-·--.. ··--·--
_datum_points[crossPart_datums_keys[l1JJ), 
(datum_points[crossPart_datums_keys(12]], 

. datum_poi nts[crossPart_datums_keys[13]]), 
(datum_points[crossPart_datums_keys[14]], 
dat.um_points[crossPart_datums_keys(lS]])), 

. mergeWire=OFF, meshable=ON) 

# Create material by as·signing mass density, youngs modulus and poissons 
" _ - # ratio . ;: . . . 

· __ peamMateria.l · =-beant-1odel. Materie1i (name=material_name) 

· # If mater-iai~d;n·s~~Y fs 0 (meaning user did not enter a value and it 
# defaulted to 9).; . we will' 'Oat assign a density 

· if mat_density 1=0 : ·. . 
beamMaterial.Density(table~((mat_density, ), )) 

~ beant-1ateriaLElastic(table=((mat_youngs, mat_poissons), )) 

def createProfiles(seH; · cs_prof_ile, cs_l_l, cs_l_2, cs_h_l, cs_h_2, cs_bl_l, 
';/ · . :~;::cs:..::_b1::._2;:,· csZb_?~~~/ cs~b2;_;2, <·s_tl_l, cs_t1_2, cs_t2_1, 
· ss'..;t2:._2, cs~t3 ..... 1;"' cs_t3_2, cs_a_l, cs_a_2, cs_b_l , cs_b_2, 

. ', cs_t_l, · cs_t_2; · cs_r _1, cs_r _2): . ~-- -- ------- - - - ~~-~ -- - ---------- ~ --- - - -- -- - ---------------- ---------
# Create profiles .:_. 

if cs_profile=;,l : . 
beamModel.I~oofi:le(.name='FriuneProfile', l =cs 1 1, h=cs h 1, 

·. ;': ;·>j({:' ~--,. -.· · bi=cS::.;.b~~-=1·, _ .bi;;.cs_bi_l , tl=cs.:..tl_l,-t2=cs_t2_1, 
· ·-. " , -~ t3=C<:S_:t3_~) 

beamModel.~!Prof.i~e('name= · cr ossPr,ofile ·, l=cs_l_2, h=cs_h_2, 
· b1=cs_b1_2.. b2=cs_b2_2, tl.=cs_t1_2, t2=cs_t2_2, 

t3=cs_t3~2) · 
elif cs_profile == 2: • . 

beamModel ~;s.oxProfile( name::;:• frail!eProfile · , b=cs_b_l, a=cs_a_l, 
· .. ·: .. · ,·,;~ 1· ..• : . · · ' uniformThickness=ON, tl=cs_t _l) 
beamModel.;~§xPr:-Ofile(na~=.,'}:rc--qssP\ofile', 1:5=cs_b_2, a=cs_a_2, . 

. . ~,~: · uniformThickness=ON, tl=cs_t_2) 
<;• , 
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e.e, e.e),), 
-s.e, e.e) .. ) .. 

((6.0, -3.0, 0.0),), 
((~e.0, -3.0, 0.e),), 
((13.0, 0.0, e.0)~) .. 

· ((6.0, e.e, e~e1 .. >. 
((1.0, 0.0, 1.5),) .. 
((4:0, -3.0, 1.5),), 

. ((6.0, -3.0, 1.5),), 
((10.0, -3.0, 1.5),), 
((13.0, e.e, I.s) .. ), 
'(6.e, 0.e. 1.5),),) 

condition 
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beamModel.DisplaGementBG(name='FixBottom', creates~epName='Initial', 

import mesh. 

region:bc_region,· ul=SET,· u2=SET, u3=SET, 
url=UNSET, ur2= UNSET~ ur3=uNSET, 
amplitude=UNSET, distributio~Type=UNIFORM, 
fieldNarile=' ',. localGsys~on~? . 

frarne_mesh_regioh .= frame_region 
frame_edges_Tor-_mestii:ng = edges_for_frame_sec'don_aS:sigqment 
frame_mesh_element_type=mesh.ElemType(elemCode=B31,' elemtibrary=STANDARD) 
tramePart.setEl~ntType(regions=frame_mesh_region~ 

· . elemTypes=(frame_mesh_element_type, ) ) 
. fr~.ePart.seedEdgeByNumber(edges~rame_edges_for_meshing~ number=4) 
firaaaePart .generateftesh() . 

import job 

mdb. Job( name=' 8eamfraiileAna.lys1sJob', model=' Beam Fra.e ~ , type=ANAL vsrs, 
explicitPrecision=SINGLE, nodalOUtputPrecision=SlNGLE, . 
description='Bending of loaded beam frame', ~ 
para)lelizatlonMethodExplicit=DOMAIN, multi~rocessingMode=DE~AU~l, 
numDO~in~=l; userSuBroutine='', . nu~pus=~. memory=58, · 
.emoryUnits=PERCENTAGE, ·scratch='', echoP~int~F~ modelPriht=OFF, 
contactPr int!:i:OFF ~ hi:stor,yPri:nt=Q-=F) . :. , · .• . . -; 

• Save the .odel · 
# First check to see if the user chose an actual path t~ save it 
if save fileName la • ' : 

~b:saveAs(pathNa.e-save_fileName) 
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th the read· _only or the directory 
'"'·' '"".:: •:> · .a.c.a.••~ were :included for demonstration 

.... ',J • ~ 
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A number of global variables exist in this script. These variables point to objects in the 

model. They are created inside the methods, but we need to be able to access them from 
other methods as well hence they have been made global in scope. 
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The entire script is interspersed with comments. These are descriptive, and combined 
with the fact that a lot of this script was copied from the beam frame analysis chapter, 
you will easily figure out much of this script. We shall only focus on the new or different 
bits. 

: fr~- abaq~~--i~po~-;-;-----------··---------·-··---·--·--·----·----------·----------------·-····-··-·-----·------------·---------· - -- "j 

I from abaqusConstants import * 
I •---rt regionToolset ~----------··--·----··~----·----------·--·-------··----··----4·---·------------------···-·-··-------·······-.. ·---·-----.. --------------·-----··-··--

The first thing you notice is that there is no "from abaqusGui import *"statement. This is 
because this script is a kernel script, not a GUI script. Instead we have "from abaqus 
import *" which we include in all of our kernel scripts. You are already aware that if you 
include both import statements in the same script Abaqus will throw an error. 

I step_counter = 0 _______ ] 
A variable step_counter is initialized to zero. This variable will keep track of which step 
of the vertical application the user is on. If he tries to execute steps out of sequence, the 
program will detect this immediately and inform him of his mistake. By placing 
step_counter outside of the class we make it a global variable which can be accessed by 
other methods of the script outside of the BeamKerneiO class. 

I class BeamKernel() ;---- J 
All of the functionality copied from the beam frame analysis script of Chapter 9 is 
included in the BeamKernel class with some minor modifications. The script has been 
split up into many functions such as createModeiPartMateriaiQ, createProfilesQ, 
createSectionAssemblyStepsO and so on, which are all part ofthe BeamKernel class. 

def createModelPartMaterial(self. mat_selected. mat_name. mat_density, 
mat_youngs, mat_poissons): 

global material_name 

# The user may have selected steel or aluminum in which case the rest of 
# the fields will be left blank and the parameters will have default 
# values 
if mat_selected == 1 : 

material_name = 'AISI 1905 Steel' 
mat_density = 7800.0 
mat_youngs = 290E9 
mat_poissons = 0.3 

elif mat selected == 2 : 
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material_name = 'Aluminum 2824-13' 
mat_density = 277e.e 
mat_youngs = 73.1E9 
mat_poissons = e.33 

else : 
material_name = mat_name 

# if you try to provide a youngs modulus and poissons ratio both equal to 
# zero Abaqus throws an error because in the elasticity table you've 
# given it a row of zeros 
if mat_youngs==8 and mat_poissons==8 : 

print 'Young\s modulus and Poisson\s ratio cant both be zero' 
! # Since we exit Step 1 we reset the global counter so the user can 

L! __________ # __ p_e_rf_o_r_m_s_t_e_p __ l _a_g_a_i" __________________________________________ _j return False 

The createModelPartMaterialO method accepts a number of arguments which will be 
obtained fi-om the 'Step I ' dialog box of the GUI. These are mat_selected, mat_ name, 
mat_ density, mat_youngs and mat_poissons. mat_ selected can be 1, 2 or 3, 
representing steel, aluminum, and a new user defined material. mat_ name, mat_ density, 
mat_youngs and mat_poissons are the name, density, Young's modulus and Poisson's 
ratio of the material. 

A global variable material_ name is created. It is made global so that it can be accessed 
by other methods in the script such as createSectionAssemblyStepsQ. 

session.viewports['Viewport: l'] .setValues(displayedObject=None) 

# ----- ------ ------------------ - - ------ - ------------------------ - -
# Create the model 

# ------- -- - - ------ - ----- --------------------------------------- --
# Create the parts 

import sketch 
import part 

# - ----- - ------- ---- -------------------- ---- ----------------------
# Create the frame 

# ---- ------------- ------------- - -- -------------------------- ---- -
# a) create one side of the frame 
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,---··---··-··-····--·-··----·····-------····--···········--···········---··--··············-··-············--·············· . ....................................................................................... ............ . ...... - ....... -.- ... -... .......... ··- - ··- -··- '1 
I I 

I 
# ---- - --------------- ----- - -- -- ---- - -- - --- - - ---------- --- ---- ----
# b) Create other side of the frame 

I 
L --------- ---·--------------·---------------------.. ·-----------------·-.. ·------·-·· ...... 

These statements are copied from the beam frame analysis script which was created and 
explained in great detail in Chapter 9. 

I 
# -- - - -- --- - --- ------------- ----------- - - - ----------- ----- - --- ----
# Create material 

import material 
I 

# Create material by assigning mass density, youngs modulus and poissons 
# ratio 
beamMaterial = beamModel.Material(name=material_name) 

# If material density is 9 (meaning user did not enter a value and it 
# defaulted to e), we will not assign a density 
if mat_density !=e : 

beamMaterial.Density(table=((mat_density, ),)) 

beamMaterial.Elastic(table=((mat_youngs, mat_poissons), )) 

return True 
--------·----

These statements are also copied from the beam frame analysis script and modified. The 
only difference is that they check to see if a density value was assigned by the user, and if 
not then no density will be specified when creating the material. The method returns True 
once it is complete. 

---------
def createProfiles(self, cs_profile, cs_l_1, cs_l _2, cs_h_l, cs_h_2, cs_bl_l, 

cs_b1_2, cs_b2_1, cs_b2_2, cs_t1_1, cs_t1_2, cs_t2_1, 
cs_t2_2, cs_t3_1, cs_t3_2, cs_a_l, cs_a_2, cs_b_l, cs_b_2, 
cs_t_l, cs_t_2, cs_r_l, cs_r_2): 

# ---- - - - ---- - - -------- --- -------------- - - - -- - - - - -- --------- -------- - -
# Create profiles 

if cs_profile==l: 
beamModel.IProfile(name='FrameProfile', l =cs_l_l, h=cs_h_l, 

bl=cs_bl_l, b2=cs_b2_1, tl=cs_tl_l, t2=cs_t2_1, 
t3=cs_t3_1) 

beamModel.IProfile(name='CrossProfile', l=cs_l_2, h=cs_h_2, 
bl=cs_b1_2, b2=cs_b2_2, tl=cs_t1_2, t2=cs_t2_2, 
t3=cs_t3_2) 

elif cs profile == 2: 
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beamModel.BoxProfile(name=' FrameProfile' , b=cs_b_l, a=cs_a_l, 
uniformThickness=ON, tl=cs_t _l) 

beamModel.BoxProfile(name='CrossProfile' , b=cs_b_2, a=cs_a_2, 
uniformThickness=ON, tl=cs_t_2) 

else : 
beamModel.CircularProfile(name='FrameProfile', r=cs_r_l) 
beamModel.CircularProfile(name='CrossProfile', r=cs r 2) 

The createProfilesO method creates the profiles. It creates an ' I', 'Box' or 'Circular' 
profile depending on the users choice using the IProfileQ, BoxProfileO and 
CircularProfileO methods provided by the Abaqus Scripting Interface. The method 
accepts a large number of parameters since some of these profiles, especially the '1\ 
require you to define many dimensions. 

I def createSectionAssemblySteps(self): 

I 
I 

I 

# ---- - - ------------------- --- -- ------ -- - ---- --- ---------- - ----- - -
# Create sections and ass ign frame and crosbracing to them 

# ------ ----------- -- --------------------------------------- ------
# Assign beam orientations 

# --- ----- ------------------------------------------------------- -
# Create the assembly 

# ----- --- - ----- --------------------------------------------------
# Create the wire features 

# ----------------------------------
# Assign these wire features/connectors to a set that can be used later 

# --- ----- -- ----------- ------------ - ---------------- ---- ---- ------
# Create a connector section 

# -- --- -- - - -------------------------
# Use constraint equations on the other two nodes 

l 
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------------··----------------·--··-·----·--·-·-----------·-·-------.... ____________ ----· --···- . 

# ----- ----- ---- ------------ --------------------------------------
# Create the step 

import step 

# ----- ---------------------------- - ------ - ---- ---- ---- - -- ---- -- --
# Field output requests 

l # Leave at defaults 

I 
I : ~i:~~~~~~~=~~~:;:~~~;;--------------- ---------- ----- ------------ 1 

I return frameinstance, crosslnstance, frame_region, cross_region, \ I 
L ______ ~ges_for -:::.i.!:.'~':!'e_s!:_ction_as~-~-~n"!ent, edges_ for _cross_section_assignm~~! ...... J 

createSectionAssemblyStepsQ creates the sections, assembles the parts and creates the 
steps of the simulation. 

l
r-------d·;f" .. c-;:~-~'t~'L-~~d~-T~~it·~ -i~~d=~~~~-~i~~-d~d·g·;:t:·--i~-,;;d=c~~;~i~-~"d-;c~g-~2~----------·---· ... --------- · 

load_frameloadedgel, load_frameloadedge2, 

1 
load_crossloadl, load_crossload2, 

i load frameloadl, load frameload2): 

I 
# --- ------- -- --------~----------- ---- -~-- -------------- --- --- - ---

I 
I 

# Apply loads 

beamModel.LineLoad(name=' Crossloadl', createStepName='Apply Loads', 
region=(load_crossloadedgel,), comp2=-load_crossloadl) 

beamModel.LineLoad(name='Crossload2', createStepName='Apply Loads ' , 
region=(load_crossloadedge2,), comp2=-load_crossload2) 

beamModel.LineLoad(name='Frameloadl', createStepName='Apply Loads', 
region=(load_frameloadedgel,), comp2=-load_frameload1) I 

j beamModel.Lineload(name='FrameLoad2', createStepName='Apply Loads', 
1 region=(load_frameloadedge2,), comp2=-load_frameload2) ! 
'--OMO-~•-~HM __________ ,,, __ ,,,, __ ,,_,,, ___ , __ ,,,,, __ ,, ___ , __ , __ ,,,,,_,,_,_,_, ___ , __ ,, _____________ ,_,,,,,_,,, ____ , ____ , ___ , ____ , ___ , ___ ~~--~·--·~·-• --··- ~-- ·----·-----·--••-••-•••--.J 

createLoadsO creates line loads on the 4 beam members selected by the user during 
'Step 3'. 

def createBoundaryMeshJob(self): 
# ------------------------------ --- --- -- -- ------ -------------- ----
# Apply boundary conditions 

# ------------ --- ---- --------- ---------------- ----- - ------- -------
# Create the mesh _______ _j 
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# - - ----------- - -- - -- - -- ---------- --- - - ---------- ---- --------- ----
# Create the job 

createBoundaryMeshJobQ creates the boundary conditions, mesh and analysis job. It 
does not however run the job. 

r··--------- -- --·---·-- ·-- --------------------··----·----
1 def saveModel(self, save_fileName, save_fileReadOnlyBool, save_dirName): ·-·-l 
I # ---- ------------------- --------- ---------- - ------ ---- ------- - --- ' I # Save the model I! 

I 
# First check to see if the user chose an actual path to save it 
if save_fileName ! = '' : i 

! mdb.saveAs(pathName=save_fileName) I 
I I 1 # We wont actually do anything with the read only boolean or the directory 

1

1 # in this example, but the fields were included for demonstration 
# purposes. 

I print 'The filename chosen is: 

if save_fileReadOnlyBool : 
print 'Read Only is ON' 

else: 
print ' Read Only is OFF ' 

• + save_fileName 

print ' The directory chosen is:' + save dirName 

saveModeiO saves the file using mdb.saveAsO. lt obtains the file name from ' Step 4'. 
While it detects the presence of the 'read on' Boo lean indicating whether a file is to be 
treated as read only or not, it does not actually do anything with this information. I only 
wished to demonstrate that it is possible to obtain this information. Feel free to tinker 
with the code to enhance it. 

r·---d-ef -;-~-~~-~~~ =~~ ~~ ~ ---------- -~~----_-_ -~~~~~~~~~--_-_-__ -_-__ -__ -_ ~ ---- ----- --
I # Run the job 

I mdb.jobs ('BeamFrameAnalysisJob']. submit(cons i stencyChecking=OFF) 

do not return control till job i s finished running 
db.jobs['BeamFrameAnalysisJob'].waitForCompletion() 

~---~~-----------------~ 
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ruoJobO submits the model to the solver to run the analysis. 

def callStepl(selected_material,name,density,youngs,poissons): 

global step_counter 

if step_counter !=8 
print '!Error- You must call steps in sequence. The next step '+\ 

'is Step ' + str(step_counter+l) 
else: 

callStepl_successful = \ 
BeamKernel().createModelPartMaterial(selected_material~ name, 

density,youngs,poissons) 

if callStepl_successful: 
step_counter = 1 

else: 

L ..... --------·- -·· ·· ··· ····· ··~!~.P.=~.?~~!e_": .... ~----·~---- ·- - ... - ......................................... ..... ·--······ ----·--·--- ··--·-···- ----------·-··--------- - -- -----

This method is called by SteplForm when the user presses OK in SteplDB (the dialog 
box for 'Step 1 '). The entered values and the options checked by the user are passed to it 

as parameters. The global variable step_counter is examined, and if its value is not zero, 

meaning that other steps have already been executed, it tells the user to follow the steps 
in sequence. If not, it calls the createModelPartMateriaiO method of the Beam Kernel 
class we saw a little earlier, after which it sets step_counter to 1. 

j-CI~-, a11st~-p-i(p-~-~"fii;~1":-·-ij::e~-·-i=2:e;-· ·h=1~8~-~2:a;··-t;1_1=e·, bl_ 2=8, b2 _1=8, 
1 b2_2=8~ t1_1=8~ t1_2=8~ t2_1=8~ t2_2=8, t3_1=8, t3_2=8, a_1=8, 
t a 2=8, b 1=8, b 2=8, t 1=8, t 2=0, r 1=8, r 2=8): I - - - - - - -
~~.· global step_counter 

if step_counter !=1 
print '!Error - You must call steps in sequence. The next step '+ \ 

else: 
'is Step ' + str(step_counter+1) ~~ 

BeamKernel() .createProfiles(profile, 1_1, 1....:2, h_l, h_2, bl_l, b1_2, 1 

b2_1, b2_2, t1_1, t1_2~ t2_1, t2_2, t3_1, I 
t3_2, a_l, a_2~ b_1, b_2, t _l, t _2, r_l, r 2) 

1 

BeamKernel().createSectionAssemblySteps() -
L----step_c9~_~er _:= __ 3 ----

This method is ca11ed by Step2Form when the user presses OK in Step2DB. The values 

input and the options checked by the user are passed to it as parameters. After examining 

the global variable step_counter and ensuring that the step has been executed at the 
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correct point in the sequence it calls the method createProfilesO of the BeamKernel 
class followed by createSectionAssemblyStepsQ. 

I def cal1Step3(crossloadedgel, crossloadedge2, frameloadedgel, frameloadedge2, I crossloadl, crossload2, frameloadl, frameload2): 

l global step_counter 

I 
I 
I 
i 

I 

if step_counter !=2 
print '!Error - You must call steps in sequence. The next step is ' + \ · 

'Step ' + str( step_counter+l) I 
else: j 

frameloadl, frameload2) 
BeamKernel().createBoundaryMeshJob() 

I __ _ 

BeamKernel().createloads(crossloadedgel, crossloadedge2, frameloadedgel, J 
frameloadedge2, crossloadl, crossload2, 

step_counter = 3 ----------------------------------

This method is called by Step3Procedure when the user presses OK in Step3DB. The 
beam members selected by the user in the viewport and the values input in the dialog box 
are passed to it as parameters. After examining the global variable step_counter, and 
ensuring that the step has been executed m sequence, it calls the 
createBoundaryMeshJobO method of the BeamKernel class. 

global step_counter 

if step_counter !=3 
print '!Error - You must call steps in sequence. The next step is ' + \ 

'Step ' + str(step_counter+l) 

I 
I 
I 

else: 
BeamKernel().saveModel(fileName, fileReadOnlyBool, dirName) 
step_counter = 4 

This method is called by Step4Form when the user specifies a location to save the model 
in Step4DB. After examining the global variable step_couoter and ensuring that the step 
has been executed in sequence, it calls the saveModelO method of the BeamKernel 

class. 

~callStepS() : 

Ll ::o:::P::::::::·~:: 
print '!Error - You must call steps in sequence. The next step is ' + \ 

I 



'Step · + str(step_counter+l) 
else: 

BeamKernel().runJob() 
step_counter = 5 

L__ ____ p_r_!~_!~~ly~~~_£~~£~-~!_~~~-! . 
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This method is called by Step5Form when the user initiates StepS. After examining the 
global variable step_ counter and ensuring that the step has been executed in sequence, it 
calls the runJobQ method of the BeamKernel class. Once the analysis is complete it 
prints a message to the message area. 

-~~~~~P~!i].~At#~"P;.i§£,1i -
This script is contained in beamCaeApp.py. lt is the application startup script- it creates 
the application (AFXApp)- and calls for the creation of the main window. 
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This script is a slightly modified version of the custom CAE application startup script 
written in the previous chapter, and should require no further explanation. Refer to 
section 20.6.1 of the previous chapter for information on writing a CAE application 

startup script. 

'2i~43~8eaiD·;A " iicanon:Main~ind.:i · .- :.. · pp · .. · ···. · :l ,;c '""'"~~· ,, · ,.,~~ 
This script is contained in beamCaeMainWindow.py. It creates the mam window 
(AFXMainWidnow), and removes the modules that will not be part of our application 
while registering the one created by us. It also registers our custom tool sets and removes 
the model tree. 
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update_no) 

; · Register our custom· module which resides in the script 
#· file beant10du~eGul~py · 
self. registerMOdule( ! se·am Module··~ 'beallft)duleGui' ) 

This script IS a modified version of the mam window script written m the previous 

chapter and should require no further explanation. All of the standard modules, and most 

of the standard toolsets, have been removed. Hence the application window has very few 

toolbars and even lacks a model tree. Refer to section 20.6.2 of the previous chapter for 

information on registering modules and toolsets . 

. c~stom.PersiStant -iooiRt . ~ .. . . . 

This script is contained in customToolboxButtoosGui.py. In it we create 5 new 

persistent toolset buttons labeled 'Step 1' , ' Step 2' , 'Step 3' , 'Step 4 ' and ' Step 5'. There 

is also a 6th button called 'Help'. 

Some of these buttons launch dialog boxes, others have fDs that map to functions thanks 

to FXMAPFUNCO, using the syntax you leamed in the previous chapter. 
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print 'CustomToolboxButtonsGui 

# Construct base class. 
AFXToolsetGui._intt_(seH, 'Test Toolset ') 

FXMAPFUNC(self, 
EXMAPFUNC(self, 
fXMAPFUNc(self, 
FXMAPFUNC(self, 

SEL_C<M4AND, 
SEL_(CM4AND, 
SEt CCH1AND - " SEl_COfoloiAND, 

self.ID_SAVE, CustomToolboxButtonsGui.onSave} 
sei f .. l!D_RUN" CustomT oolboxButtoi)SGui. on Run) 
self.ID_HELP, £ustom~oo1boxButtonsGui.onHelp) 
self.ID_WARNING, 
CustomToolboxButtonsGui.onWarning) 
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buttonids=AFXDialog.YES I AFXDialog.NO, 
tgt=self, 
sel=self.ID_WARNING) 

def onWarning(self, sender~ sel, ptr): 
if sender.getPressedButtonid() == AFXDialog.ID~CLICKED_YES: 

# Launch Step 4 dialog box 
# To do this we must launch the form mode Step4Form 
# Note that this time we are not launching the form mode (that 
# displays the dialog box) using a GUI button as we have done for 
# Step 1, 2 and 3 
# Instead we are launching it manually here. Hence we will first 
# create a form mode object, and then call the activate() method 
fm = Step4Form(self) 
Step4Form.activate(fm) 

elif sender.getPressedButtonid{) == AFXDialog.ID_CLICKED_NO: 
self.deactivate() 

return True · 

def onRun(self~ sender~ sel, ptr): 
# To issue a kernel command directly from the GUI we can use the 
# sendCommand() method 
# To the sendCommand() method we pass the statements that should be 
# executed 
# We separate multiple statements with a \n as is done here. Note that 
# you cannot leave a space after the \n because that means there is a 
# space in front of the next statement~ and Python being will object to 
# this wrong indentation · 
sendCommand{'beamKernel.callStepS()') 

L---~~----------~--------------~~~~----~------~----------~--~--~ 

This script is very similar to the one written for creating custom toolbox buttons in the 
previous chapter. Let' s focus on the new concepts here, refer to section 20.6.4 for more 
details. 

r------·--·--·- ·-· --------- - ~--·~--------· ---~-------~-----------··------.. ··------·-----. 
1 from abaqusGui import * 
I from sessionGui import CanvasToolsetGui 
I from steplForm import SteplForm 

from step2Form import Step2Form 
from step3Procedure import Step3Procedure 
from step4Form import Step4Form 

class CustomToolboxButtonsGui(AFXToolsetGui): 
--'-----

I 
' 

I 
i 
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Aside from the usual import statements (abaqusGUI and sessionGui), the form and 
procedure modes that will be launched by clicking on the toolbox buttons are also 
imported. The class is derived from AFXToolsetGui as expected. 

~----- ---~~~~;~~--------------- - -------- - ----- -- - - --- -- -- ----- -- ----- - - -

) ID_HELP, 
ID_WARNING, 
ID_LAST 
range(AFXToolsetGui.ID_LAST, AFXToolsetGui . ID_LAST+S) 

def __ init __ (self): 

print 'CustomToolboxButtonsGui initialization method called.· 

# Construct base class. 
AFXToolsetGui. __ init __ (self, 'Test Toolset') 

FXMAPFUNC(self, SEL_COMMANO, self.ID_SAVE, CustomToolboxButtonsGui.onSave) 
FXMAPFUNC(self, SEL_COMMAND, self.ID_RUN, CustomToolboxButtonsGui.onRun) 
FXMAPFUNC(self, SEL_COMMAND, self.ID_HELP, CustomToolboxButtonsGui.onHelp) 
FXMAPFUNC(self, SEL_COMMAND, self.ID_WARNING, 

CustomToolboxButtonsGui.onWarning) 

# Toolbox buttons 
toolbox_group_l = AFXToolboxGroup(self) 
AFXToolButton(toolbox_group_l, 

' Step 1: Material \t Create Model, Part and define ' + \ 

None, SteplForm(self), 
AFXMode.ID_ACTIVATE) 

AFXToolButton(toolbox_group_l, 

'the Material', 

· Step 2: Profile \t Select the profile and create ' + \ 
'Assembly and Steps', 

None, 
Step2Form(self), 
AFXMode.ID_ACTIVATE) 

AFXToolButton(toolbox_group_l, 
' St ep 3: Loads \t Define the loads, and create · + \ 

'boundary conditions, mesh and job', 
None, 
Step3Procedure(self), 
AFXMode.ID_ACTIVATE) 

AFXToolButton(toolbox_group_l, J' · Step 4: Save the Model', 
None, 

self , ·---·-------



I 
i 
i 

I 
I 
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self. ID_SAVE) 
AFXToolButton(toolbox_group_l, 

· Step 5: Run the job', 
None, 
self, 
self.ID_RUN) 

I toolbox_group_2 = AFXToolboxGroup(self) L ______ AFXT:olB~tton(toolbox_gr-~-:=~'--- · Help \t Display help', None, self, 
self. ID_HELP) 

---=--------1 

All this should also look familiar to you from the previous chapter. A number of 'lOs' are 
established which are associated with the buttons for 'Step 4', 'Step 5' and 'Help', and 
are used by FXMAPFUNCO to execute the appropriate method. 'Step 1 ', ' Step2' and 
'Step 3' on the other hand use AFXMode.ID_ACTIVATE to call the activateO method 
of the corresponding form or procedure mode with syntax you've seen before. 

The only ID that does not appear to be assigned to a button here is ID_ WARNING. This 
is in fact used later in the onSaveO method, which launches a warning dialog box, and 
uses this ID to map to the correct function when the user clicks OK. We'll revisit it when 
we get to onSaveO. 

1 # Initialize the necessary module or toolset in the kernel using 
r·······-·-·····--·-------------···--·-·------------ --------- --·-·---·········--------------------------- -------~ 

I 
# getKernelinitializationCommand 
# This method is called by the module manager when a GUI module is loaded for 1' 

I
. # the first time. 

# This method is empty in the base class implementation I 
I # The analyst may write a method that returns the proper command that will I 
. # import the appropriate modules on the kernel side. ' 
.

1

. # Basically this allows you to 'import' a kernel module into the program 
# which you would not otherwise be able to do in this file since it has GUI 

1 # commands 
1 # we need to do this because in steplform.py we use the statement 
! # self.cmd = AFXGuiCommand(self, 'callStepl', 'beamKernel') I # which calls callStepl() in beamKernel .py, hence beamKernel needs to be 
j # defined/imported 
: def getKernelinitializationCommand(self): 
I 
l_ ___ ··--·---~~tu~n 'import beamKernel ' _________ _! 

Quite frankly, the paragraph of comments preceding these two statements describe 
precisely what they accomplish. To make it perfectly clear, the method 
getKernellnitializationCommandO does not need to be defined in a GUI script, which 
is why we didn't use it in the previous chapter. However this time we would like our 
form modes to send actual commands to the kernel script (beamKernel.py) therefore the 
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kernel module needs to be imported. It is not possible to import a kernel module into a 
GUI script (just as it is not possible to have ''from abaqus import *" and ''from 
abaqusGui import *" statements in the same script). getKernellnitializationCommandO 
helps us get around this issue. 

.------~~-~~------·--~ 

! def onHelp(self, sender, sel, ptr): 
------ ·-------··-·---··-----! 

mainWindow = getAFXApp().getAFXMainWindow() 
showAFXInformationDialog(mainWindow, 

'Click on each Step in sequence using the ' + \ 
'buttons in the toolbox . \n' + \ 

'Step 1 : Supply material properties \n' + \ 
'Step 2: Provide profile dimensions \n' + \ 
'Step 3: Define Loading \n' + \ 
'Step 4: Save the model \n' + \ 
'Step 5: Run the Analysis') 

getAFXApp().getAFXMainWindow().writeToMessageArea( 'Script created by ' + \ 
'Gautam Puri, author of Python Scripts ~or Abaqus - learn by Example') 

onHelp() is called when the user clicks the 'Help' toolbox button. It uses 
sbowAFXInformationDialogO to launch an information dialog box. This technique was 
described in the previous chapter in section 20.6.5. 

'.. - -··· - ~ ~~~. "-==.=) ~~~~~ 

0 

----- ------ ·- --- ---~ ·---- --
Click on each Step in sequence using the buttons in the toolbox. 
Step 1 : Supply material properties 
Step 2: Provide profile dimensions 
Step 3: Define Loading 
Step 4: Save the model 
Step 5: Run the Analysis 

--------------------
def onSave(self, sender, sel, ptr): 

# Ask user if he is sure he wishes to save 
warning_owner = getAFXApp().getAFXMainWindow() 
showAFXWarningDialog(owner=warning_owner, 

message='Are you sure you wish to save this model?'j 
buttonids=AFXDialog.YES I AFXDialog.NO, 
tgt=self, 
sel=self.ID_WARNING) 

showAFXWarningDialog() is another type of message dialog available for use in GUI 
scripts. It is used to obtain user assistance in response to some condition. Warning dialog 

I 
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boxes have a warning symbol (yellow triang le with an exclamation point). They can 
contain Yes, No and Cancel buttons. Their title bar contains the application name. 

& Are you sure you wish to save this model? 

sbowAFXWarningDialogO accepts 5 arguments- owner, message, buttonlds, tgt and 
sel. owner is the window over which to center the dialog box, message is the text String 
to display as the message, and buttonlds is a series of ID' s of action area buttons to be 
created (the options are YES, NO and CANCEL). Here we have used YES and NO. 
Note the use of the word AFXDialog preceding YES and NO. tgt and sel are the 
message target and message ID. Here we set the toolset itself as the target, and 
ID WARNING as the messageiD. Recall that we had created a unique identifier, 
ID_ WARNING, near the beginning of the script, and FXMAPFUNCO maps it to the 
onWarningO function. So if the user clicks e ither button, the onWarningO method will 
be executed . 

.... ·- -------- - --·- ·-.. -·----·-----·---------
l def onWarning(self, sender~ sel, ptr): 

if sender.getPressedButtonid( ) == AFXDialog.ID_CliCKED_YES : 
~ l aunch Step 4 dialog box 
# To do thi s we must launch the form mode Step4Form 
# Note that t his time we are not launching the form mode (that 
# displays the dialog box) using a GUI button as we have done for 
# Step 1, 2 and 3 
# Instead we are launching it manually here. Hence we will first 
# create a form mode object, and then call the activate() method 
fm = Step4Form(self) 
Step4Form.activate(fm) 

elif sender.getPressedButtonid() == AFXDialog.ID_CLICKED_NO: 
sel f. deactivate() 

return True 

One of the parameters automatically passed to onWarningO by FXMAPFUNCO (when 
the user c licks Yes in the warning dialog box) is sender, which is the warning dialog box. 
Having a handle to the warning dialog box, we can use one of its methods -

1 
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getPressedButtonldQ. This method allows us to query which button was clicked by the 
user. Since onWarningO is called no matter which button is clicked, we need to 
determine if the user clicked Yes, and if not we must not save the model and should call 
the deactivateQ method. 

If the user clicked Yes we wish to launch the form mode Step4Form which will display 
the dialog box Step4DB. Up until this point whenever we have launched a form mode 
and its dialog, it has been by associating the form mode with a button, and having it 
automatically called using AFXMode.ID _ACTIVATE. This was done for ' Step I ', 
' Step 2' and ' Step 3'. 

However for 'Step 4' we used ID_ WARNING to call onWarningQ. In order to activate 
a form mode from without using a button, we need to call its activateO method manually. 
Hence we create an instance of the form mode class, fm, and call its activatcO method. 

r---·------------------ ·-···---·---------------······--------------·----·-------······----·--·····-·--·-·-----··-·- --
1 def onRun(self, sender, sel, ptr): 

I # To issue a kernel command directly from the GUI we can use the 
, # sendCommand() method 

I # To the sendCommand() method we pass the statements that should be 
, # executed 

#We separate multiple statements with a \n as is done here. Note that 
# you cannot leave a space after the \n because that means there is a 
# space in front of the next statement, and Python being will object to 
# this wrong indentation 

,__ _ _ _ sendCommand( '~~~m~er~~l. ca_~_?.tep_~(L_L _______ _ 

We've already spoken about how GUI and kernel scripts must be kept separate and 
cannot call each other using direct means. One way to make them communicate is to use 
form and procedure modes. This is the most common way, and you' ll see it in practice in 
subsequent sections of this chapter. Another way is to use the sendCommandO function. 
sendCommandO takes three arguments, a String argument (required) specifying the 
command to be executed in the kernel, and two Boolean arguments (optional) 
writeToReplay and writeToJournal, which indicate whether the command should be 
recorded in the replay and joumal files. 

Here we use sendCommandQ to execute beamKernel.caliStep5Q. Note that if you 
wished to execute multiple commands, you would separate them with \n. You will see 
this in later in this chapter as well. 
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·custom Beam Mod~le . .. ' 

This script is contained in beamModuleGui.py. In this script we create a custom module 
for setting up and analyzing the beam frame problem. lt will appear in the Module 
combo box above the viewport in the Abaqus/CAE interface. In fact, since we have not 
registered any other modules in beamCaeMainWindow.py, it is the only module 
available and will be displayed by default. The custom module consists of a menu with 5 
items, a tool bar with 5 buttons, and a tool box with 5 large buttons. All of these share the 
exact same functionality as the persistent tool set with 'Step I' through 'Step 5'. 

# **********************~*!'*******************************!****************~***** 
# Custom Beam Frame Analysis GUI Application 
# This s~ript defines a custam beam frame· ~nalysis module . 

from abaqusGui import * 

# Class definition 

. lD__5AVE, 
lD_RUN, . 

.,l;D_IiELP I 

. ID WARNING 
] ·= range(AFXToolsetGt.ii.·ID_LAST I 

·~ 
#construct base class. 
AFXModuleGui._init_(self1 'C':'stom Module' 1 AFXModu~eGui.PART) 

.. FxHAPFUNC(selfr SEl.:_C<:MW4D, self.ID_SAVEI Beallft)auleGui.onSave) 
FXMAPFUNC (~elf, SEt_€0tfMND, self... I.D -~lJN, · BeaJ~ModuJ..~ui. on Run) 
fXMAPFUNC(self,· SE~_(DMMAN,D, s~lf.ID~HElP, BeamModuleGu~.onHelp) 
FXMAPFUNC( self J SEL~C(i)fftAND, sel!f..,IO _WARNING I Beanf4bch.lleGui. onwarning) 

' . . 
# .-create menu bar and ~dd 2 itetiiS~that post a dialog box using a fonn. ~· 

~~~~~ ... ~ ~-
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l 

! I from abaqusGui import * 

! from step1Form import Step1Form 
i from step2Form import Step2Form 
I from step3Procedure import Step3Procedure 
1 from step4Form import Step4Form 

! # Class definition 
I 
! class BeamModuleGui(AFXModuleGui): 

I 
I 

i 
I 
i 

I 
j 
! 

I 
l 

I 

I 

I 

[ 
ID_SAVE, 
ID_RUN, 
ID_HELP, 
ID_WARNING 

] = range(AFXToolsetGui.IO_LAST, AFXToolsetGui.ID_LAST+4) 

def __ init __ (self): 

print ' BeamModuleGui initialization method called.' 

# Construct base class . 

# Create menu bar and add 2 items that post a dialog box using a form 

# Toolbar items 

# Toolbox buttons 

By this point in the book all of this content should be quite familiar to you. In any case, 
the code is well commented and quite readable. 

-def onHelp(self~ sender~ sel~ ptr): I 
i 
I 
! 



I 

I 
I 
i 

def onSave(self, sender, sel, ptr): 

def onwarning(self, sender, sel, ptr): 

def onRun(self, sender, sel, ptr): 
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L------··----- -· . - -·--·-----------·------·--·---------.. ----·-··---·--·-····--·----------------·-·-· __ .. --·- . I 
These methods are identical to their namesake methods in 
customToolboxButtonsGui.py. You could consider putting the contents of each method 
definition in a separate script, and call the methods from both scripts. But in this case it 
seemed easier to just copy and paste them from customToolboxButtonsGui.py to 
beamModuleGui.py. Also I did not want to complicate this long example by adding one 
more script file. 

,----·---·--·-----------·-·--·---.. ·----·--·-·------.. -·----------------·---·-.. --------------------, 
1 #Actually create the custom module GUI. I I BeamModuleGui() _ _ _____ _ 

Don't forget to create an instance of the class at the end of your script, otherwise your 
custom GUI application will not contain this module. 

121.~6 . :step_ i. R~•~;E~k~:l!n .. 'l i;)~!og ~x . ._ , , .: ~ 
The form is defined in the script steplForm.py and the dialog box in steplDB.py. These 
two scripts together create the dialog box that is displayed when the user clicks on 'Step 
1 '. They associate the fields in the dialog box with variables, and call the appropriate 
kernel command when the user clicks OK in the dialog box. 
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· I:Ji(~tre:_~~~~ ~ 
---- ---·------- ·---

Alert: You cannot have a negative: density 

I _ o~ .I 

The dialog box has a 'Material' combo box widget (AFXComboBox) a.k.a. drop-down 
menu, providing the user with the material options 'AISI 1005 Steel' , 'Aluminum 2024-
TJ' and 'New'. Below the combo-box is a group box layout manager (FXGroupBox). 
This layout manager has within it 4 text fields (AFXTextField) for 'Name', 'Density', 
'Young's Modulus' and 'Poisson's Ratio'. 'Density' also has a check box next to it 
which enables and disables (grays out) the field. The entire group box is disabled unless 
the user selects 'New' from the combo box. Below the group box layout manager is a 
label (FXLabel) which displays a message 'Alert: You cannot have a negative density'). 
This label is disabled except when the user enters a negative value in the density field. 

Two transitions are used - one to detect whether the user has selected 'New' in the 
combo box, and the other to detect whether the density typed by the user in the 'density' 
field is positive or negative. 

Let's first look at steplDB.py 
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# the-behavior at default . 
#Here however we wish to modify the show .method to also· print a ~ssage . to 
# the s~reen (aside ·fro~:~~ opening the window .• which it does by defal;l_lt). 
def show~seif) ~ . ,:·:·: . ! . ! . • ··~ · . >'1 ! I.·· ,<,.. .. \ .J· 

print _ 'Step 1 Dlalog box· will be display~d~ 
# Now must call the ·base show() command 

1 . AFXDataDialog. show{ self) . . .. 

11~:"·. #-~-;~~~ .::." ..... ::::: ---·-:.3 ::."--~'- :_-__ cj _c ~'- ~}~~:~-------.::: ,--
. # The h~de() method "'is the opposite of show(). ·It is c__alled by de'fauit 

l. ·. # ·whenever the dialog box is to be hidden . · ~- :· ... 
· # Note. tiJat this metnod does NOT need to be:·!, def.ined here if we wish to leave : 

I . · • #· the behavior at default ·. · . ·:·s . ..:; ·.:.: - ; :'; · · <f. 
1 

# Here .however· we wi~h to modlfj. :the, hide'":~th~d- to -alsO. print · a ~ssage to' 
l ~· . · # the screen (aside 'from closing 'the window .which it does by default}. 
I def hide·(self): : 
~ print 'Step 1 Dialog box will be hidden• 
[ . · #'~W .~~st call t~e base hi~e{) command· 
1 •• AFXOat!J!>ia~~g·~hide.(seH) · ., ~· :. 

You are already familiar with creating dialog boxes, and much of this script is similar to 
what you saw in section 20.6.8 of the previous chapter. We shall focus on what is new 
here. 

I class SteplDB(AFXDataDialog) : 

I [ 

I 
i 

ro_oensity, 
ID_Negativeoensity, 
ID_NewMaterialComboSelection, 
ID_ExistingMaterialComboSelection I L ] = r ange(AFXToolsetGui ·_!D_LAS~~£XToolsetGui. ID LAST +4) _____ _j 

We create IDs that are associated with the fields of the dialog box. Previously you've 
associated lOs with toolbox buttons, as was done in customToolboxButtonsGui.py and 
beamModuleGui.py. However they can also be associated with transitions. To detect the 
transition of the 'density' field we define two I Os, ID_ Density and ID_ NegativeDeosity. 
To detect if the user selects 'New' from the combo box we have 
ID _NewMaterialComboSelection and ID _ExistingMateriaiComboSelectioo. 

1------#~-~-~-~-~-=-~·=-=-=~~-~-=-=-~-~-.::-::-=-.:-=-::-=-=.-:::-::-.:-~-=-=-=-=-=·~-=-=-.::-::-==-=·~-=-=---~-=-:.-=-=-=-=-=-=-=-.:-~~-=--·--·-----, 
def __ init __ (self, form): i 

I # DIALOG_ACTIONS_SEPARATOR places a horizontal line/separator between the I 
~---····-------;· ~!~~~~~~i~9~i.:~~~l~~~;~~;;_~a~_;:~~-~~-~~~~;-~~-~~~~;~-~---~~~~-= ~;l~~~-~~~-~----J 
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# if the user clicks Cancel after changing some values in the dialog box 
1

1 

AFXDataDialog. __ init __ (self, form, 'Step 1 - Define the material', 
self.OKi self. CANCEL, DIALOG_ACTIONS_SEPARATOR) 

I #Save the form variable for use in the processUpdates() method 
L----·----~~!!:.!.?.~lll __ ~_f._?.:_lll ______ .. ___ . ____ , _______ .. _._, __ ..... -.... ---··------------·---------------·-----.. -------·------· 

The only statement here you haven 't seen before is the last one. form, which is passed to 
the dialog box by the form mode as a reference to itself, is a local variable within the 
_init_O method. We will however need to refer to the form in the processUpdatesO 
method a little further down in the script. We therefore need to make a global variable. 
We refer to it as self.form indicating that this is the form variable of the class Stepl DB, 
and is different from the form variable passed to _init_O which becomes local to that 
method. 

~-- ·-o-k_B_t_n_=-~-e-lf-.-ge_t_A~ti~~-Bu-t-to-n-(s-~i-f-.I-D_-C-LICKED_OK) 

l okBtn . setText('OK') 
~------- ~---------

I 

I 
I 
l 

getActionButtonsO returns the action button with the messageiD specified as a 
parameter (or 0 if it is not found). OK buttons have a message ID of 
ID_CLICKED_OK. So our variable okBtn refers to the OK button of the dialog box. 
The setTextO method can be used to set/change the text that appears on the OK button. 
We set it to 'OK' here. 

ComboBox = AFXComboBox(p=self, ncols=e, nvis=l, text='Material', 
tgt=form.materialselectionKw, sel=0) 

ComboBox.setMaxVisible(3) 
#When creating the combobox items, use the 'sel' argument to assign an 
# integer value to each so that we can use addTransition() whcih requires 
# an integer or a float. 
# In step1Form.py use AFXIntKeyword() and since the combobox items 
# themselves are not integers use 'evalExpression = False' 
ComboBox.appenditem(text='AISI 1eas Steel', sel=l) 
ComboBox.appenditem(text='Aluminum 2823-T3', sel=2) i 

_ __ c?mb9~9x :..~P.pen.~_I..~-~~i!.~~!~~-~~~-:.!_~: .. ~.~?.2.. ... _ ...... ____ ,_ .......... __ .. ________ , __________ ... __ .. __ . ______ . ..1 

A combo box widget is created for selecting the material. AFXComboBox accepts a 
number of parameters_ p is the parent widget, ncols is the number of columns which we 
have set to 0 for auto-sizing, nvis is the number of visible items when the combo box is 
not expanded, text is the label String that appears next to the combo box, tgt and sel are 
the message target and message ID. We set these to form.materialselectionKw and '0' 
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so the variable materialselectionKw in SteplForm gets updated with the option selected 
by the user from the combo box. 

For the combo box items created with the appendltemO method, we specify text, which 
is the text String, and sel, which is a selector. We have assigned selector values of I, 2 
and 3 to the combo box items. This means that if the user selects the first option, 
form.materialselectionKw will hold the integer value 1 and so on. 

r-
! GroupBox = FXGroupBox(p=self, text='New material properties', 
! opts=FRAME_GROOVEjLAYOUT_FILL_X) 
L _______ se~~ . groupbox = G~~-':.f?Box ----------------------- _____ _ _____ ! 

The group box layout manager is a general purpose layout manager which creates a 
labeled border around the collection of widgets placed inside it. lt has many available 
parameters; we use 3 of them here. p is the parent, text is the String that is the label/title 
of the group box, and opts is where you list the various options - we specify 
FRAME_GROOVE for a groove or etched-in border, and LAYOUT_FILL_X which 
causes the group box to stretch or fill the available space in the X direction. 

~- verticalAlig~er = AFXVerti~alAlig-~er(p-.:G-~oupBo;:-~pt~:e~-x=e, - y-;;;-e, w=e; - -1 
h=e. pl=e, pr=e, pt=e, pb=e) ! 

A vertical aligner is another type of layout manager which lays out its children widgets in 
a vertical fashion one under the other. From each of its children widgets it finds the 
maximum width of the first child. It then sets the width of the first children of all its 
children widgets to this same value. This means if you have an AFXTextField widget 
which places a label and a text field on the canvas, the width of all the labels will be the 
same in order to maintain a neat aligned look. 

The parameters accepted by AFXVerticaiAligner are p (parent widget), opts (options), x 
(X coordinate of origin), y (Y coordinate of origin), w (width), h (height), pi (left 
padding), pr (right padding), pt (top padding), pb (bottom padding), hs (horizontal 
spacing) and vs (vertical spacing). 

r-----------~el f.-;~;;~t~tiiel-d = -AFXTextField{ p=Verti.c;]_Aiig~er :-· -----·-- - ----, 
i ncols=12, I labelText= 'Name', 1 
I tgt=form.nameKw, i,! I sel=0) 
1 self.density_textfield = AFXTextField{p=VerticalAligner, I 
L __ ._ -------------~~15~~~~-··-----·--------------_j 
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labelText='Density', 
tgt=form.densityKw, 
sel=e, 
opts=AFXTEXTFIELD_CHECKBUTTON) 

self.youngs_textfield = AFXTextField(p=VerticalAligner, 
ncols=12, 
labelText='Young\'s Modulus', 
tgt=form.youngsKw, 
sel=e) 

self.poissons_textfield = AFXTextField(p=VerticalAligner, 
ncols=l2, 

i labelText='Poisson\'s Ratio', I 

L tgt=form.poissonsKw, \ 

--------·-··---------------------------····---·-······--·-----···-··--···-····--······-·············-·-············-··-····--~~ .. ~~~-~-----··-------··"·""""'""'"""""''"'"""'"'"""'""'""'"'""'"'"'-"'"''''''""''"""'"'"''"'"'"'"""'.1 

4 text fields are created here as children of the vertical aligner layout manager using 
AFXTextFieldQ. It accepts a number of parameters but we've only used a few here. p is 
the parent widget, which we set to the variable VerticalAligner (which refers to our 

vertical aligner). ncols is the number of columns in the text field. labelText is the text 
that appears in the label next to the text field. tgt and sel are the message target and 
message ID. We set the message target to the variable in SteplForm that will hold the 

value of the widget. 

For the text field for density we also specify an option using opts. We set it to 
AFXTEXTFIELD_CHECKBUTTON which places a check button next to the label. If 
the button is checked, the text field is enabled, and if not, it is disabled or grayed out. 

~--- --- -· -- ---·- --------·----·- --- · -. -- .. - .. ........ ....... . - . . .. ..... ... .. ·-.. .. .. . - ----- -- - -- ·-·- --·-- ----·- .... , 
1 self.density_label = FXLabel(self, ! 

L _________ ~~~-~-: -~-~~-~-~!~.~~-~-~~~ .. ~-~~-~~-~~~_()_ .. _· .. :~~-~~ -~ .... ~:-~--~-~~~~~- _ :.~-~-:---~~~~t i ~~--~~-:.:. .. ~~~-·-~ __ ____ J 

FXLabelO creates a text label on the canvas. We set the parent p to self and the text label 

labeiText to an alert. The label is then grayed out using the disableO method. Jt will later 
be enabled when a transition detects the user inputting a negative density in the density 

text field. 

# Need t~--~~~t~--~~mm~-~-d~fr~;;;-ad.dTransition() to required functions ---------·-\ 
FXMAPFUNC(self, SEL_COMMAND, self.ID_Density, SteplDB.onDensity) 
FXMAPFUNC(self, SEL_COMMAND, self.ID_NegativeDensity, 

SteplDB.onNegativeDensity) 
FXMAPFUNC(self, SEL_COMMAND, self.ID_NewMaterialComboSelection, 

1 SteplDB.onNewMaterialComboSelection) I 
i FXMAPFUNC(self, SEL_COMMAND, self.ID_ExistingMaterialComboSelection, \ 
! SteplDB.onExistingMaterialComboSelection) 1

1 
i.----~~···---·-N--N-N ____ _____ _________ ,,, .. _, _______ ,,"'OOM-•MO _____ ,,,NOO<_O., .. --.......... _, _________ ,, ___ _ , ___ ,, ___________________________ ,,_ , _____ _ 
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FXMAPFUNCO maps the !Os used by the transitions to the correct functions. 
,- --· ............ ····-··-·-·"· ···-· . ·-·-- --···· ··-- ........... . - - ··-··---··--·-··-···-----·--·---- .... ____ ... -·----· . ····• ···-·· ---··- ---· --- - --·---------, i # Transitions 

1 l self.addTransition(form.materialselectionKw, I AFXTransition .EQ, 
! 1, I self, 

MKUINT(self.ID_ExistingMaterialComboSelect ion, SEL_COMMAND), 
None) 

self.addTransition(form.materialselectionKw, 
AFXTransition.EQ, 
2, 
self, 
MKUINT(self.ID_ExistingMaterialComboSelection, SEL_COMMAND), 
None) 

self.addTransition(form.materialselect ionKw, 
AFXTransition.EQ, 
3, 
self, 
MKUINT(self.ID_NewMaterialComboSelection, SEL_COMMAND), 
None) 

self.addTransition(form.densityKw, 
AFXTransition.LT, 
e, 
self, 
MKUINT(self.ID_NegativeDensity,SEL_COMMAND), 
None) 

self.addTransition(form.densityKw, 
AFXTransition.EQ, 
a, 
self, 
MKUINT(self . ID_Density,SEl_COMMAND), 
None) 

self.addTransition(form.densityKw, 
AFXTransition.GT, 
e, 
self, 
MKUINT(self.ID_Density,SEL_COMMAND), 
None) _____________ __! 

The addTraositionO method adds the transition detection spoken off earlier to the 
application. It accepts 6 parameters. target is the keyword in the form which holds the 
value of the widget, op is the operator type (such as AFXTransition.EQ), value is the 
reference value that you are comparing with, tgt is the message target, set is the message 
selector which will be made up of a message ID and a message type, and the last 
parameter is ptr - the message data - which we set to None. 
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The first 3 transitions are used to detect the selection of item 1, 2 or 3 in the materials 

combo box. If either 1 ('AISI 1005 Steel') or 2 ('Aiuminum 2024-T3) is selected, 

ID_ExistingMateriaiComboSelection is used, which FXMAPFUNCQ maps to the 
method SteplDB.onExistingMaterialComboSelection. Whereas if 3 ('New') is selected 
ID_NewMaterialComboSelection is used, which FXMAPFUNCO maps to the method 
SteplDB.onNewMateriaiComboSelectionO. For the message selector we use 

SEL_COMMAND since the user selects an item from the combo box. 

The next 3 transitions are used to detect whether the value typed into the density text field 
is positive, negative or zero using AFXTransition.LT, EQ and GT. For the message 

selector we use MKUINTO which is a function to create a selector using an identity and 
a message type. 

onNegativeDensityO is called by a transition using FXMAPFUNCQ when the user 

enters a negative density value in the text field. lt prints a message to the console, and 
enables the alert label on the canvas (which is grayed out by default) using the enableQ 
method. Since the transition repeatedly detects the presence of a negative density as long 

as it is present in the text field, you will see the message being printed to the console 

repeatedly. This has been intentionally done so you can observe the mechanism of 
transitions in action. 

, def onoens i ty(~elt:·-·-se-n.deG·-·-s-;C-Pt~)-·=--·-------------- - - ---------------------------~ 

l print 'Density not negative' l 
I self.density_label.disable() 1

1 ~--------·-----··--·--·-···---·-"----·-·-----------········ ··--·-·----··--------~-··-------------~---·----··----···--···-·-· 

onDensityO is the opposite of onNegativeDensityQ. It is called by a transition using 

FXMAPFUNCO when the density text field has a positive value or zero. lt prints a 

message to the console, and disables the alert label on the canvas if it is currently enabled 

by using the disableO method. Since the transition repeatedly detects the presence of a 
positive or zero density as long as it is present in the text field, you will see the message 

being printed to the console repeatedly. 

,----------·--·---·---------·--··- ··--·-·-----····--····------------------·------·------··-·-···--·- ------·-·----·--------- -- ·-·-·---------------, 
! def onNewMaterialComboSelection(self, sender, sel, ptr): 1 
I print 'Transition - User has opted to define a new material in combo box' i 
I self.groupbox.enable() ! 
I self.name_textfield.enable() i 
. ·---·---·-·-·----··-·---- ·-·-------·-- ·- ·-·- ---·------···-q· ... ·--·--·----·- .. - --·-----· .. -· .... -----·----------·---·- --·------·---... 1 



i 
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r-----------·-~-·- ----------·-------·----··-·----·-··--------·----·----···--·---·-------------·----------·-·--··-----· 
J self. density_textfield. enable() · 

self.youngs_textfield.enable() 
.......... -.......................... ~.~~f. .. :.P.9.!:.~~~~~~~-!.~ .. ~-~!~ .. ·~~-~~~~-~-L ......... -................................................. _ ............................... ________ .. _________ . ___ ................ __ .. ____ , 

onNewMateriaiComboSelectionO is called by a transition using FXMAPFUNCO when 
the user selects 'New' in the material combo box .. It prints a message to the console. lt 
then enables the group box, which means the group box title and border are not grayed 
out, and then enables all of the widgets inside it one by one. This is done using the 
enableO method. Since the transition repeatedly detects the presence of 'New' as long as 
it is selected, you will see the message being printed to the console repeatedly. 

def onExistingMaterialComboSelection(self, sender, sel, ptr): 
print 'Transition - User has selected existing material in combo box' 
# Grey out the title of the groupbox and make all fields uneditable 
# (however those fields do not get greyed out) 
self.groupbox.disable() 
# Grey out the name textfield 
self .name_textfield.disable() 
# Grey out the density textfield 
self.density_textfield.disable() 
# Grey out the Young's modulus textfield 
self.youngs_textfield.disable() 
#Grey out the Poisson's ratio textfield 

L ...... ----------~-~-~-~-:£~~-=~~_11~-=!~~! f ie_l~9 is ~-~~.:._o ________ , __ ---------· ·-----------··-·-· -----·--------__ .......... ____ _.: 
onExistingMateriaiComboSelectionO is called by a transition using FXMAPFUNCO 
when the user selects 'AISI 1005 Steel' or 'Aluminum 2024-T3 ' from the material 
combo box. lt prints a message to the console. lt then disables the group box, which 
means the group box title and border are grayed out, and then disables all of the widgets 
inside it one by one. This is done using the disableO method. Since the transition 
repeatedly detects the presence of the first and second materials as long as they are 
selected, you will see the message being printed to the console repeatedly. 

#----------- ------- --- --------- -- ------------------------ ---- ---- ------
#The show() method is called by default whenever the dialog box i s to be 
# displayed. 
# For example in modifiedCanvasToolsetGui.py you have the statement 
# AFXMenuCommand(self, viewport_menu_with_contents, 'Custom Menu Item', 
# None, DemoForm(self), AFXMode.ID_ACTIVATE) 
# So whenever the custom menu item is clicked, the activate() method of the 
# mode is called, and this in turn calls the show() method of the dialog box . 
# Note that this method does NOT need to be defined here if we wish to leave 
# the behavior at default 

L 
# Here however we wish to modify the show method to also print a message to 
#the screen (aside from opening the window which it does by default). --- __ ___, 



21.4 Exploring the scripts 683 

·----···----d;f··-~-h~~-(~~ii) ~ --·-······ ·· -- -------··· ··--· --·---· ... ·- ------------·-···-··------· -----··-······---···· . --- -· ··- -- - ·- .. --· --···- ·----- - -, 
print 'Step 1 Dialog box will be displayed' ' 
# Now must call the base show() command !I 
AFXDataDialog.show(self) 

#----------------------------- --------- -- ----- ----- -------- -- -------- --
#The hide() method i s the opposite of show() . It is called by default 
# whenever the dialog box is to be hidden 
# Note that this method does NOT need to be defined here if we wish to leave 
# the behavior at default 
# Here however we wish to modify the hide method to also print a message to 
#the screen (aside f rom closing the window which it does by default ) . 
def hide(self): 

print ' Step 1 Dialog box will be hidden' 
# Now must call the base hide() command 
AFXDataDialog.hide( self) 

You learnt about showO and hid eO in the previous chapter. The code has been reused 
here. 

Let's now look steplForm.py, which defines the form associated with the dialog box. 

----· --..,...-------------~--------------1:# _ ••• -~···~············~····~··~********.***************~************************* 
[~# - tusto~ s~am F,rame An'~ly.si~' Gur :/\pplication · · ·· ··· · · · · 
I # This script is the form for. step . 1. It win post the step 1 dialog box 
! # , (Step! in step1DB. py) . . · · -
I # :*********************~*********~************************************************ 
i- ' ' ,: .. .. --
~ ~fro·m ·'abaqu~Gui i:mport , * ~ • I import steplDB · _ ~ . 
I ' 
~ 
! # Class definition 
i . 
I i. . . , - .,. - . ' 

1-. c lass . steptt;orm(AFxFoiiiP.Y: .: ·_: ;_ 
I . . : ~- . -,. ; , -- - '.· ~-·: . . . 
i . ~ ' ' ' 
! 

l• :# · ddnstruct bas~~- ciiass ·/· · 'F. , • • 
._, :AF:x~orin._init;:,'~kself; .ownerf . · 

# cQimland to ~x~cute when,,OK is clicked, 
. s~lf. cmd = AFXGu~Command (self,-· 'ca~lStepl' , 'beamKernel' ) 
: ~ ; .. ~· . :~ ' :· -_;' : . :·: . ;y', . - -' " . -{ +' : •; - :' .-;. ~ • 

#;_for the items'_ in tt11i! c;:ombo box we 'will specify integers 
# · ~rguinent of_ -~ppendrtem() • · . 
# J'his . integer' wiU be:. returned and· stored in 'materialselectionKw' hence · 

, .#~ we. us·e ·AFXIO'tK.e}?.lord _'·~-Os~epd~ ~f> AF . tr.i.ngKeyword which ~ould otherw~se 
· #.':3b~•,'used ~itt\'?',it EoinboiJ6;;-,,ft : \1J•·:· ~ _ _: .. ~·· _ - · 

--~-----------~---· 
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# ·since the choices ~howr{in the.'( 'ombObox do not themselves represent .. 
# ~umerical ya~ues~ · ~;xpr~S:$.io~{ ev<!).uation '!last b~ :q~sab,le~ w1~h ~;;~1 '::L # • evaiExpression = False' - , ' ~ · · · ~ :. ~ · 
self .ma,terialselect~~n~w .~ ~F~Int~~Y~.~d ( cqrnna!ld~~e).f.. cmd;t , · ~;,· ... · · · ·: ~ · ·· • ' . •. name= • selected_material ·, 

i~Req'-'ired= T;RUE #/ ; • .. 
• . de.faultValue=l. · • · 

· . · . · · :, ev,alE~press.j,on=fALSE) · . " . ' ' 't· ·~ __ ;,::') . . "'l.r -· -- . ~- -·· . !.< .,, self. na~~~eKw< = AEXStl)'i:ngK'e~ord ( coll'ri.\md~seif·l:'cnid,o name='-' name' • . 
· isR~quired=T.~UE • . · .defa_ultValue= ~NewO~enMat • ), .. se:lf. density Kw ~- .AF.Xfloat.Keyw~rd ~-~9.nvnand=se1T. cmd, name:: ~densfty ' : ,;, · ;:\ .. . 

. · isRequired::TRUE, ' def.aultValue=e) · 
self. youngsKw ::'_AFXf'lpa~Keyw~rd ( co~;,md=s~Ji~ . cnJl:IJ' nanle= •:y,oungs ' • ·1f:.· 

~ :, . , isReq~ired=-!RUE, :defaul~v~lue=e) · self. poissonsKw .. AFXFloatKeywor.d-4co~a·nd=sEilf. '(!lnd:. ·na)lle= '· poi:ssons''!, 
· ·. · ·· isRequired=TRUE, defaultValue=e) 

~~ ' 
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. .. . . ,-.~~--------·~-------~---~ 

#The sendCommandString() method. is usually -called by default. ' .. 1 

# However sin~e we are defining issueComrnands() we now need to manually 
# call this method·_ ' . · · 
self.sendCommanaS:tr:l.ng(cmdstr) 

We shall focus on what is new in this script. 

Here we define the kernel command that should be called when OK is clicked. 
beamKernel.py is the script, and caiiSteplO is the method in the script that should be 
called. 

----------------
# Material selection is done with a combo box. 
#For the items in the combo box we will specify integers using the ' sel' 
#argument of appenditem(). 
# This integer will be returned and stored in 'materialselectionKw' hence 
# we use AFXIntKeyword instead of AFXStringKeyword which could otherwise 
# be used with a combobox 
# Since the choices shown in the combobox do not themselves represent 
# numerical values, expression evaluation must be disabled with 
# 'evalExpression = False' 
self.materialselectionKw = AFXIntKeyword(command=self.cmd, 

name='selected_material', 
isRequired=TRUE, 
defaultValue=l, 
evalExpression=FALSE) 

self.nameKw = AFXStringKeyword(command=self.cmd, name='name', 
isRequired=TRUE, defaultValue='NewuserMat') 

self.densityKw = AFXFloatKeyword(command=self.cmd, name='density', 
isRequired=TRUE, defaultValue=0) 

self.youngsKw = AFXFloatKeyword(command=self.cmd, name='youngs', 
isRequired=TRUE, defaultValue=0) 

self.poissonsKw = AFXFloatKeyword(command=self.cmd, name='poissons', 

~--·-·-·"'''"''"" '"""""""'"""'""""""'"'"'''"""''"'""-"'"''""''''''""'" "'''"'""''"""'"''"' ''""''"'""''"'''' ~~-~~.9..~.~~-~~-~.!.-~-~~--~---~~.!-~~-~!Y..~-~~~~~_) ____ ,, ................................. . 

materialselectionKw, nameKw, densityKw, youngsKw and poissonsKw are the 
keywords or variables associated with the widgets of the dialog box. These variables 
were set as the target (tgt) of the widgets in the dialog box. All the data the user types, 
and all the options he selects, get stored in the target variables corresponding to each 
widget. 

' { 
I 

' 

. I 

' I 
I 
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We use AFXIntKeywordQ, AFXFioatKeywordO and AFXStringKeywordO 
depending on whether the value will be an In~ a Float or a String. Needless to say, the 
name of the material, nameKw, is a string, while the density densityKw, Young's 
Modulus youngsKw and Poisson's Ratio poissonsKw are floats. The reason the selected 
item of the combo box materialselectionKw is an integer is because we used the sel 
parameter in the appendltemO method while creating the combo box, and set it to l, 2 
and 3 respectively for each of the 3 items. This integer value is what will get stored in 
materialselectionKw. 

AFXIntKeywordO accepts 5 parameters. command is the host command, which in this 
case is set to self.cmd defined earlier. name is the keyword name which must be 
identical to the parameter name in the function definition in the kernel script. isRequired 
is a Boolean stating whether or not the variable is required. By setting it to 'True' we can 
force the application to include this parameter in the command string it sends to the 
kernel, whether or not the user has defined a value for it. defaultValue is the default 
value of the keyword/variable. Note that the default value for the keyword is the default 
text in a text field, or default option selected in a cornbo box widget, and so on. 
evaiExpression indicates whether or not the keyword supports expression evaluation. In 
the case of the material name selection from the combo box, the text in the combo box 
does not represent the numerical values, hence we must turn expression evaluation off. 

AFXFioatKeywordO and AFXStringKeywordO accept similar parameters. If you wish 
to learn more refer to the documentation for details. 

·----·-#-=~-:---------~==:::-::-=-~~~-:.-.:-::-~-::-~-~=·::-:::-:::-::--::-:::-=-=-:::-_-::-:-~-=-~-=-::-::-:-=-:-~:-=-------------l 
# A getFirstDialog() method MUST be written for a mode (a Form mode) .

1 
# It should return the first dialog box of the mode 
def getFirstDialog(self): ! 

# Reload the dialog module so that any changes to the dialog are updated. 
reload(steplDB) 
return steplDB.SteplDB(self) 

#----------- ------------------------------ ----------------------------
# A mode is usually activated by sending it a message with its ID set to 
# ID ACTIVATE 
# This message causes activate() to be called 
# Note that it is NOT necessary to define this activate() method unless you 
# wish to change the default behavior 
# Here we would like it to print a message to the screen before proceeding 
def activate(self) : 

! 
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---·-----···-··----····----·--···--··--··········----·······-···----- ·····- ---· ......... -................ '"'"''''" .................................... ,. ___________ .. . ...................... ---···---·-·· ··--- ··-···-···· -·--·~·--·· - ········---···--·-·--···----· ·-·· ----------------- '1 
print 'Step 1 Mode (form) has been activated' 
# Now must call the base method 
AFXForm.activate(self) 

#---------------------------------------------------------------------- -
# i ssueCommands() is called by default and you do not need to define it 
# We define it here in order to get the command string and print it to the 
# message area to help with debugging 
def i ssuecommands (self): 

# Get the command string that will be sent to the kernel for processing 
cmdstr = self.getCommandString() 

# Write this command string to the message area so we know it executed 
getAFXApp().getAFXMainWindow().writeToMessageArea(cmdstr) 

# The sendCommandString() method is usually called by default. 
#However since we are defining issueCommands() we now need to manually 
# call this method 
self.sendcommandString(cmdstr) 

# Deactivate the form if the user presses the OK button of the dialog box 
self.deactivateifNeeded() 

L_ __ retu.:._n TRUE --···----

getFirstDialogQ, activateO and issueCommandsO were all used in DemoForm in the 
previous chapter. The only difference here is in issueCommandsQ. While in the previous 
chapter DemoDB did not actually do anything, here the statement 

self.sendCommandString{cmdstr) 

is used to send the command to the kernel script. 

cmdstr contains the command string obtained using getCommandStringQ. If ' AISl 
1 005 Steel ' is selected (and therefore no values entered into the text fields), the command 

string looks something like this 

beamKernel . callStepl(selected_material=l, name='NewUserMat', density=0, youngs=0, 
poissons=0) 

Notice that the order of the arguments passed in the function call are exactly the same as 
the order in which the keywords were defined a moment ago. 

I 
I 
I 
I 

I 

! 
1! 

I 
lj 
'i 
1 
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21.4.7 Step 2 Dialog Form and Di~log Box . . 
This form is defined in the script step2Form.py and the dialog box in step2DB.py. 
These two scripts together create the dialog box that is displayed when the user clicks on 
'Step 2'. They associate the fields in the dialog box with variables, and call the 
appropriate kernel command when the user clicks OK in the dialog box. 

The dialog box has a label 'Select a profile'. Below this is a horizontal frame layout 
manager (FXHorizontaiFrame). Within this horizontal frame are 3 radio buttons for ' I', 
' Box' and 'Circular' beam profiles. 

Below this is a group box (FXGroupBox) to hold all of the other widgets in the dialog 
box. Inside this group box a switcher (FXSwitcber) is placed. This switcher will 
"switch" depending on which of the 3 radio buttons are selected. 3 sets of widgets are 
placed inside this switcher. All of them consist of a horizontal frame 
(FXHorizontalFrame) and within this horizontal frame are an icon (FXLabel with 
afxCreatelcon) and two vertical frames (FXVerticaiFrame). These two vertical frames 
consist of a label and text fields so the user can enter dimensions for frame members and 
cross bracing members. 

r Cl ________ · __ :__ ~~-- - - ------ - - -- --- - - - -- ----- -- ---~-1--~ ~ 

Select a profile 
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Let's first examine step2DB.py. 

# ···························~···················································· # Custom seam Frame Analysis GUI Application 
# This scr.ipt defines a dialog box that will be posted by a form (Step2Form in 
# step2Form.py) 

. # ............................................................................... . 

from abaqusGui import * 

# Class definition 

class S~ep2DB{AFXDataDialog): 

# DIALOG_ACTIONS_SEPARATOR places a horizontal line/separator between the 
# contents of the dlalog box and the OK/CANCEL buttons at the bottom 
# DIALOG_BAilOUT displays a message "Save changes made in ~he xyz dialog?" 
# if the user clicks cancel after changing some values in the dialog box . 
AFXDataDialog. ___ init ___ (self, form, 'Step 2- Choose a profile', 

self.OKiself.CANCEL, DIALOG_ACTIONS_SEPARATOR) 

# Save the form variable for use in the processUpdates() method 
self.fona· = form 

okBtn = self.getActionButton(self.ID_CliCKED_OK) 
okBtn.setText('OK') · 

1 = FXLabel(p=self, text='Select a profile', opts;JUSTIFV_LEFT) 

HFrame_l = FXHorizontalfra~~~e(p=~ellf, opts=9, x=9, y=0, w=9, h..e, p1F9, 
pr=B, pt:Q, 'pb=9) 

FXRadioButton(p=HFrame_1, text='I ' , tgt=form.profile_Kw, sel=1) 
FXRadioButton(p=HFrame_l, text='Box', tgt=form.profile_Kw, se1: 2) . 
FXRadioButton(p=HFrame_l, text='Circular'# tgt=form.profile_Kw# sel=3) 

# Groupbox 'Dinensions' to contain all widget 
GroupBox = FXGroupBox(p=self# text='Dimensions', opts=FRAME_GROOVE) ', 

# ~11 contents of this groupbbx are inside a switcher so they can change 
# for I, Box and Circular profiles 
self.groupbox_switcher = FXSwit~her(GroupBox# 8# 8#8#8#8# 8#8,8#8} 

# Switcher contents for I Profile ------------- --~-------------- -
HFra.e = FXHOrizontalFrame(p=self.groupbox_switcher# opts;&, x=e# y=8, 

· w=9, h=9, pl=9~. pr=9, . pt=B# p~=9# hs=38~ vs=e) 



21.4 Exploring tbe scripts 691 



692 Custom GUI Application for Beam Frame Analysis 

# Switcher contents for Circular Profile ---------------- - -------
HFranae • FXHor:lizontal!F,rame(p=self.groupbox_switcher, opts=&, x::e, y=8, 

w-e, h-e~ p1·9~ pr.-8, pt=9, pb=e, hs=38, vs=8) 

tir,cular~rofile_4Gon = afxCreateicon('icon_(i~cular_profi1e.png') 
FXLabel(p=f'IFrame, text .. '', ic=clrcular _profiie_icon) 

VFrame ~ FXVertiGalFra.e(p=HFrame, opts=e, x=e, y~ .. w=e, h=e, pl=e, 
pr=8, pt=8, pb=8) 

FXLa~l(p•VFrame, ·text•'Cross Bracing ) 
vAiigner _cross = AFXVerticalAligner(p ... VFra~~e, opts-&, x-e, y-8, 

pl!=8, pr-=0, pt=8, 
AFXfextFleld(p .. VAJ;igner_cross, ncols-:$:6, labenext='r', · 

.tgt•fonn.:l' _2_Kw, sel=8) 
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Let's focus our attention on the new content here. 

r---·--.-:;F-~ame_l = FXHo~izontalF~a;~(p=s~lf, opts=e, x=e, -y-;:-e,- w=e, h=e, pl:Ei .---~ 
pr=e, pt=e, pb=e) 

FXRadioButton(p=HFrame_l, text='!', tgt=form.profile_Kw, sel=l) 
FXRadioButton(p=HFrame_l, text='Box', tgt=form.profile_Kw, sel=2) 
FXRadioButton(p=HFrame 1, text='Circular', tgt=form.profile Kw, sel=3) 

l 

A horizontal frame FXHorizontaiFrame arranges its contents horizontally, as opposed 
to a vertical frame which you saw earlier. We use it so we can place our radio buttons 
side by side. It accepts a number of arguments. p is the parent, opts is options, x and y 
are the X and Y coordinates, w and b are width and height, pi, pr, pt and pb are the 
padding on al l 4 sides, and hs and vs are the horizontal and vertical spacing between 
widgets inside the horizontal frame. 

FXRadioButtonO is used to create a radio button. It accepts all the same arguments as 
FXHorizontaiFrame, and in addition accepts text, the text displayed next to the radio 
button, and tgt and sel, which are the message target and message ID. Note that we set 
the parent of the radio buttons to HFrame_l which is our horizontal frame. A very 
important point to note is that the target of all 3 radio buttons is the same keyword 
variable. This is why when you select one radio button the other gets unselected. This is 
the behavior you are most likely looking for, since the point of radio buttons is that you 
can only select one of them (if you wish for the user to select multiple options, it makes 
more sense to use checkboxes). 

# All contents of this groupbox are inside a switcher so they can change 
# for I, Box and Circular profiles 
self.groupbox switcher = FXSwitcher(GroupBox, e, e,e,e,e, e,e,e,e) 

A switcher is created using FXSwitcherQ. It swaps children that are located on top of 
each other. You can create a number of children for a switcher and then instruct it to 
display one instead of the others. This helps preserve real-estate since several panels can 
be placed one over another and switched out as needed. In addition it allows you to show 
the user GUI panels based on context, and hide what is not required. This is handy for us 
because we would like a different set of labels and text fields to be displayed depending 
on whether the user wishes to define an ' I' profile, or a 'box' or ' circular' profile. 
FXSwitcher accepts all the same arguments as FXHorizontaiFrame. 

·-
# Switcher contents for I Profile ----- ---------- - --- -------------
HFrame _= FXHoriz_~~!alF~~!!!_e(p=self.groue?Jx_swit_cher, __ ~ets=e, x=e, y=e. 
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·---- --~ ........................ -............... , .. _ ,,, ....... ,_,,, ............. _____________________________________________________________________ ··-·--·---~ 

w=e, h=e, pl=e, pr=e, pt=e, pb=0, hs=30, vs=0) 

# Switcher contents for Box Profile ----------------- - -- ----- -----
HFrame = FXHorizontalFrame(p=self.groupbox_switcher, opts=0, x=e, y=e, 

w=e, h=e, pl=e, pr=e, pt=e, pb=e, hs=30, vs=e) 

# Switcher contents for Circular Profile -------------------------
HFrame = FXHorizontalFrame(p=self.groupbox_switcher, opts=a, x=e, y=e, 

w=e, h=e, pl=e, pr=e, pt=e, pb=a, hs=3B, vs=e) 

!_' ------------- - - -------------"- --·-····- · ·-· -·-··-··- -----·---------- - · ----------- - · · - · - ·------- - - -- - --- - - · ···- · ·---- --·- ··- ··----- ·-----------------------------· -·-

For all 3 profiles, we start by creating a horizontal frame since we wish to have the icon, 
the column for frame member profile dimensions, and the column for cross brace 
member profile dimensions side by side. The important thing to note here is that the 

parent p has been set the switcher. This is what makes the switching possible. The 
horizontal frames for the 3 profiles must all be made children of the switcher in order for 

it to function. You may also notice that hs, which is the horizontal spacing between the 
children of the horizontal frame, has been set to 30 so that they do not stick close to one 
another. 

-
# The processUpdates() method is called during each GUI update cycle 
# We will use it to replace the groupbox contents as the user selects a 
# different profile by changing the switcher 
# While we can use transitions to achieve this same effect, for more complex 
# tasks such as comparing different radiobutton or textfield values 
# processUpdates() offers more control and you can call the appropriate 
# methods based on complex decision logic 
#Since processUpdate() is called at each GUI update cycle, it should not 
# execute any time consuming code 

I def processUpdates(self): 
1 # unlike in the case of transitions, here we must use the getValues() 

L _1£ m:~~!~ f~~m ~~~9-i~!~:;.~~:-~-!~.~!.~~C~~-;;_~;-~:~_, ___ textfi~~~-:~-othe~- widg~~--- -- ·-------· 

I 
I 

d 

l 
I( 

' I 
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self.groupbox_switcher.setCurrent(e) 
elif self.form.profile_Kw.getValue() == 2: 

self . groupbox_switcher.setCurrent (l) 
else: 

i self. gr_oup~_?.~=?.~~~cher:.se~£':C.t~.f"!.~_( 2)_ .. -·. 
·---------~-- ---------·-····---·····--------· ·- -···------····--; 

The processUpdatcsQ method was discussed in section 21.3 of the previous chapter. 
You learned that this method will be called whenever the GUI is redrawn, and ts an 
alternative to transitions which we used in Lhe dialog box for step I. 

Here we use processUpdatesO to find out which radio button is currently selected. 
Recall that the target of all 3 radio buttons was set to profile_Kw, and this variable exists 
in the form for the dialog box (Step2Form in stcp2Form.py). Hence we refer to it using 
the notation self.form.profile_ Kw. Depending on its value we use the setCurrentO 
method of the FXSwitcber to display the correct GUI pane. Each of the 3 
FXHorizontaiFrame layout managers was made a child of the switcher, and they are 
numbered serially (0, I, 2 .. ) by default. 

Let's now look step2Form.py which defines the fonn associated with the dialog box. 

r·~t--**********··*****-********· ************.***•***********;;.*•*******-***********· * ··*--' I # custom Beam Frame Analysis GUI Application j 

! 
# This script is the form for step 2. It will post the step 2 dialog box ; 
# (Step2 in step2DB.py) 

i # ******************************************************************************** 
•

1

i from abaqusGui import * 
import step20B 

I I # Class definition 

I class Step2Form(AFXForm): 

I 
I 

i 

#---------------------------------------------------------------------def __ init __ (self, owner): 

# Construct base class. 
AFXForm. __ init __ (self, owner) 

j #Command to ·execute when OK is clicked t self.cmd = AFXGuiCommand(self, 'cal1Step2', 'beamKernel') . 

! · self.profile_Kw = AFXIntKeyword(command=self.cmd, name='profile', 1
1· 

I isRequired=TRUE, defaultValue=l) 
self.l_l_Kw = AFXFloatKeyword(command=self.cmd, name='l_l', 'I 

1 isRequired=TRUE, defaultValue=0.975) L----·--·--------------~---·· .. ------·------·---·------------'....l 
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r-----·····--·····-~~I.f~i~2=i<~··-;;;··iFxFi~·~ti<.eywor·d-(comm~~-et;;;sei.f··~-c·;nd~---··~a;e;;;·;·i_j-;··:··---·-·-·----------------·· --- ···-
- isRequired=TRUE, defaultValue=0.06) 

self.h_l _Kw = AFXFloatKeyword(command=s elf.cmd, name=.'h_l', 

. . isRequired=TRUE, defaultValue=0.15) 

self.h_2_Kw = AFXFloatKeywor<!(comlllan4=self.cmd, name;:'h_2', 
. • ·· : ~ . · · . '· i s Required:O:TRUE, defaultValue=0.12} 

· self.bl_l_Kw = AFXFloatKeyword(command=self.cmd, name='bl_l', 
·; . is Required= TRUE_, defaultValue=e .12) 

self; b1_2_Kw = AFXF loatkeyword ( commimd='self. cmd, name= 1 b1_2 I , 

isRequired=TRUE, defaultValue=0.11) 

self.b2_1_Kw = AFXFloatKeyword(command=self.cmd., name='b2_1', 
·· ·· · · isRequired= TRUE, defaul tValue=e .12) 

self .b2_2_~w = AFXFloatKeyw_ord ( comrnand=self. cmd, name= I b2_2 •., 

' , ... .. isRequired=TRUE, defaultValue=e. es) 

.self. tl_l_Kw = AFXFloatKeyword(comnland=self.cmd, name='tl_l', 

. isRequired=TRUE, defaultValue=0.02} 

. self. t1_2_Kw = AFXFloatKeyword ( command=sel f. cmd, name=' tl_2' • 
· isRequired=TRUE, defaultValue=0.01) 

self.t2_1_Kw = AFXFloatKeyword(command=se1f.cmd, name='t2_1', 

· . · :· •· . . : · isRequired=TRUE, defaultValue=0.02) 

self.t2_2_Kw = AFXFloatKeyword(command=self.cmd, name='t2_2 ' , 
isRequired=TRUE, defaultValue=0.01) 

self:t3_1_Kw = AFXFloatKeyword(cbnililanCI=self :cmd~ name='t3_1', 
isRequired=TRUE, defaultValue=0 .04) 

self.:t3_2_Kw = AfXFloai:Keyword(comrnand=self.cmd~ name= ' t3_2', 

· · isRequired=TRUE, defaultValue=8.02) 

· self. :a_l_Kw = AFXFloatKeyword ( COIIIIJland=se if. cmcl, name=' a_l • ~ 
· · ··· · · isRequired=TRUE, defaultValue,;e.l4) 

self. a_2_Kw · = AFXFloatKeyword ( commaj'fd=sel f. cmd, name= • a_2', 

.. ,. ·· : · · .isReguired=TRUE, defaul:tValue=e •. ll) 

self~b_l_Kw = AFXi=loatKeywor'd(comriiand=self .cmcl. name=·' b_ l I, 
. isRequired=TRUE, defaultValue=0.1) 

self. b_~:....K~. = AFXFloatK~y~ord.(com!lland:rsel f. c'!ld~ _name=· b_2 ·, 
. ' · · · ·· isRequired=TRUE, defaultValue=0.07) 

: s·elf. t_l_Kw = ,AFXFloatKeyll!or~(corrrnimd=self. cmd, ·name='t_ l I • 

: ::.. · , · :, · <'" 1sRequire~=TRUE., ·defaultValue'7e.e2) 

self. t _2_Kw = AFXFloatKeyword{command=self·. cmd, ·name= 't_2 I, 
,: ,- - ~sRequired=TRUE, defau~tValue=8.8l) 

·~ . ' ••! ·,,, • • • • • ·, ' ~·· • ~J;. 1 ; .. .·. • . . . • 

self. r _l_Kw = AfXFloatKeyword(command=self'. cmd, name= 'r _1', 

. , . . . · · , , .. : : ,i,s~equiredi=lRUE, defaultValue::=e.es) 

. ~elf; r _2_:_K~/ = AF*FloatKeY\.Io"rd(cornmand;,sei;f. cmd; name= '·r _2 ' ~ 
· isRequ~red=TRUE, ~efaultValue=0.83S) 

. . '> 
' .. ! 

# -·- ·- - --- ------ - -.----- - -- __ .:. - -------.- ---- .,..--- ..;.::. - _:._-~- - - --------- - - ----

' # A· getFir stDia:l,og(r.)" inethocfMU~r. 'be ·wr:i;:tten fo"P · a m~de (a Form mode) 

# l:t should return the first di a'log box of the moqe · 
-def get~irstDia'log(~~l f): : < · · ' 

't,:t." : ' i • : f - • ,. . .... • -~ ~;· ~ • . • • :.: ~,~-~ • 

# Reload ·the dl,alog module so that -a~y changes to the dialog are 
-=--~....:._-
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reload(step2DB) ~ 
return step2DB.Step2DB~se~f) 

#-- -- -- ----------~--- ----- --- ----- - ---------------------- - ---- -- -------
#A mode is usually activated by sending _it a message w~th its ID set to 
# ID~CTIVATE 
# This message causes activate() to be called 
# Note that it is NOT necessary to define: this activate() method unless you 
# wish to change the default behavior 
# Here we would like it to print a me~sage to the screen before proceeding 
def activate~self): 

pr,int 'Step 2 MOde (form~ has been activated' 
. #. Now must call the base method 
AFXForm.activate(self) 

#----------------- ---- ----------- ----- --- ~-------------~-------- ------
# do£ustomChecks() is called py default ~ight before issueCommands() when you 
# click OK in a dialog mode ' • . 
# you do not need to define it unless you wish to change the behavior 
# we define it here in order to check the values of some variables (and make 
# sure they are positive and non-zero) 
# The method must return TRUE if no errors were encounte~ed~ if FAL~E is 
# returned then c011111and processing will ,be ter:'minated. 
def dOCustomChec~s(self): 

# If any of the dimensions for the selected profile are e show an error 
# messiage and return FALSE 

if self.profile~Kw.getValueO == 1: 
if self.l_l_Kw.getValue() <=0 or \ 

self.l_2_Kw.getValue() <=0 or \ 
self.h_l_Kw.getvarue() <=0 or \ 
self.h_2_Kw.getvalue() <=0 or \ 
self.b~_l_Kw.getvalue() <=9 or \ 
self.b1~2-~w.getvalue() <=0 or \ 
self.b2: 1_Kw.getValue() <=0 or \ 
self.b2_2_Kw.getValue() <=0 or \ 
self.t1_l_Kw.getValue() <=9 or \ 
self.t1_2_Kw.getValue() <=9 or\ 
se~f.t2_1_~w.getVa~ue() <~8 er~\ 
self.t2_2_Kw.getValue() <=0 or \ 
self.t3_1_Kw.getVa1ue() <=0 or\ 
self.t3_2_Kw.getValue() <=0 : 

return FALSE 

elif self.profile_Kw.getValue() == 2: 
it self.a_l_Kw.getValue() <=0 or \ 
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The only syntax here you haven't seen previously is the doCustomChecksO method. 

When you click OK in a dialog box, doCustomChecksQ is called before 

issueCommandsO so that last minute checks can be made before the keywords are sent 

to the kernel script. doCustomChecksQ is optional which is why we have not used it 

previously. After the checks are performed, it must return True for the program. 
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def doCustomChecks(self): 

# If any of the dimensions for the selected profile are 0 show an error 
# messiage and return FALSE 

if self.profile_Kw.getValue() == 1: 
if self.l_l_Kw.getValue() <=0 or \ 

self.l_2_Kw.getValue() <=0 or \ 
self.h_l_Kw.getValue() <=0 or \ 
self.h_2_Kw.getValue() <=0 or \ 
self.bl_l_Kw.getValue() <=0 or \ 
self.b1_2_Kw.getValue() <=0 or \ 
self.b2_1_Kw.getValue() <=0 or \ 
self.b2_2_Kw.getvalue() <=0 or \ 
self .tl_l_Kw.getValue() <=0 or \ 
self.t1_2_Kw.getValue() <=0 or \ 
self.t2_l_Kw.getValue() <=0 or \ 
self.t2_2_Kw.getValue() <=0 or \ 
self . t3_l_Kw.getValue() <=0 or \ 
self.t3_2_Kw.getValue() <=0 : 

showAFXErrorOialog(self.getCurrentDialog(), 
'Dimensions must be greater than zero 1') 

return FALSE 

eli f self. profile_ Kw .getValue() == 2: 
if self .a_l_Kw .getValue() <=0 or \ 

self.a_2_Kw.getValue() <=0 or \ 
self. b_l_Kw.getValue() <=0 or \ 
self.b_2_Kw.getValue() <=B or \ 
self.t_l_Kw.getValue() <=B or \ 
self.t_2_Kw.getValue() <=B : 

showAFXErrorOialog(self . getCurrentDialog( ), 
'Dimensions must be greater than zero 2') 

return FALSE 

else : # self.profile_Kw == 3 
if self.r_l_Kw.getValue() <=B or \ 

self . r_2_Kw.getValue() <=0 : 

showAFXErrorDialog(self.getCurrentDialog(), 

return FALSE 

# otherwise return TRUE 
return TRUE 

' Dimensions must be greater than zero 3') 

Here we check the value of every dimension variable for the selected profile (we only 
care about the variables associated with the profile that is selected). If any of them is 0 or 
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a negative number, we return False, which will prevent issueCommaodsO from being 
called. In addition we display an error message using showAFXErrorDialogO. 

;:_.t._ '-

The procedure mode is defined in the script step3Procedure.py and the dialog box in 
step3DB.py. These two scripts create a procedure which prompts the user to select two 

cross brace members followed by two frame members, and then displays a dialog box 
where the loads for each of these selected members can be specified. The scripts 

associate the members picked in the viewport with variables, and call the appropriate 

kernel command when the user clicks OK in the dialog box. 

(tJ [8] Select the first cross member 

1

1

1 Cross Load 1: \=-)] ___ ___,! 
Cross Load 2; li -· "] 
Frame Load 1; ~.....11 ______ ] 

Frame loadl: !1 -- ~ 

Let' s briefly examine step3DB.py. 

1 
I 
1 
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# DIALOG_BAILOUT displays a message Hsave changes made in the xyz dialog?• 
# if the user clicks Cancel after changing some values in the dialog box 
AFXDataDialog.~init __ (self, form, 'Step 3 Dialog Box', 

self.OKiself.CANCEL, DIAtOG_ACTIONS_5EPARATOR) 

va = AFXVerticalAligner(self) 
AFXTextField(va, 29, ·cross Load 1:', form.crossload1Kw, 0) 
AFXTextField_(va, 29, 'Cross load 2: ', form.crossload2Kw, 0) 
AFXTextField'('va, 29, 'Frame load 1: •, form.frameloadlKw, 0). 
AFXTextField(va, 29, 'Frame load 2:' ,' form.frameload2Kw, 8) 

#----.- ---- --------------·- ;----------- :: __ ----- ----------- "' - - -------------
# ~he show() method is called by default whenever the dialog box is to be 
# displayed. 
# For example in modifiedCanvasToolsetGui.py you have the statement 
# AFXMenUCommand(self, viewport_menu_with_contents, 'Custom Menu Item', None, 
# Demoform(self$, AFXMode.ID_ACTIVATE) 
# So whenever the custom menu item is clicked, the activate() method of the 
# mode is called, and this in turn calls the show() method of the dialog box. 
# Note that this method does NOJ need to be defined her.e if we wish to leave 
# the behavior at default · 
# Here however we wish to modify the show method to also print a message to 
#the screen (aside from OP,ening the window which it does by default). 
def show(self): 

print 'Step 3 oialog box will be displayed' 
# Now must call the base show() c011111and · 
AFXDataDialog;show(self) 

#--------~----------- - ------------------ - --------------~ ---------------#The hide() method is the opposite of show{). It is called by default 
# whenever the dialog box is to be hidden 
# Note that this method dees NOT ne.ed to be defined tlere if we wish to leave 
# the behavior at default . · 
# Here however we wish to modify the hide method to also print a message to 
#the screen (aside from closing the window which it does by. default). 
def hide( self): ·" · • , · 

print • Step 3 Dialog box will be hidtien '. 

# Now must Gall the base hide() com.and 
AFXDataDialog.hide(self) 

# For soae reason Abaqus (version 6.18) shows a blank viewport at the end 
# ot the procedure. Hence we shall force it to show the assembly agafn. 
sendCoataf'ld( • root_asselilbly,= mdb.models[\ • Beam Frame\']. rootAssembly \n • +\ 

'session.viewportsr\'Viewport= 1\'].setValues(displayedObject=' + \ 
'root_assembly) \n' + \ 

·session.viewports[\'Viewport: 1\'].asselblyDisplay.setValoes' + \ 
'(loads=ON1 bcs~. predefinedFields=ON1 cpnn~ctors=oN) \n' + \ 

'session. vdewports·~\ 'ViewPQr't: l!\ • ] .assetri~lyD~splay·. setv~lues • + \ 
· · • (step=\' Apply Loads:\') \n • + \ 
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This dialog box is very simple compared to the ones created for ' Step I' and 'Step 2'. 

The only statement you might find a little confusing is the use of the sendComrnandO 

method on the second to last line. 

# For some reason Abaqus (version 6.19) shows a blank viewport at the end 
# of the procedure. Hence we shall force it to show the assembly again. 
sendCommand('root_assembly= mdb.models[\'Beam Frame\'].rootAssembly \n' +\ 

'session.viewports[\'Viewport: 1\'].setValues(displayedObject=' + \ 
'root_assembly) \n' + \ 

'session.viewports[\'Viewport: 1\'].assemblyDisplay.setValues' + \ 
'(loads=ON, bcs=ON, predefinedFields=ON, connectors=ON) \n' + \ 

'session.viewports[\'Viewport : 1\'] . assemblyDisplay.setValues' + \ 
'(step=\'Apply Loads\') \n' + \ 

'root_assembly.regenerate()') 

However the comments on the first two lines explain the reasoning behind it quite 

succinctly. 

Now Jet's turn our attention to step3Procedure.py. 
<i 
j 
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self.crossloadedgelKw ~ AFXObjectKeyword(command=self:cmd, 
name='crossloadedgel', 
isRequired=TRUE) 

self.crossloadedge2Kw = AFXObjectKeyword{command=self.cmd, 
name='crossloadedge2', 
isRequi~ed=TRUE) 

self.frameloadedgelKw = AFXObjectKeyword(conmand=self. cmd, 
name='frameloadedgel' , 
isRequired=TRUE) 

self.frameloadedge2Kw = AFXObjectKeyword(command=self.cmd, 
· name='frameloadedge2', 

isRequiredcTRUE} 

self. cross load!Kw = AFXFloatKeyword ( conmand::sel.f. clld, nallle= ' c rossloadl ' , 
isRequired=TRUE, defaultValue = 1) self.crossload2Kw = AFXFloatKeyword(command=self.cmd, name='crossload2', 
isRequired=TRUE, defaultValue = 1) self.frameload1Kw = AFXFloatKeyword(command=self.cmd, name='frameloadl', 
isRequired=TRUE, defaultValue = 1) self.frameload2Kw = AFXFloatKeyword(command=self.cmd, name='frameload2', 
isRequired=T>RUE, defaultValue = 1~ 

#---------------------------------------------------------------------# A getFirstStep() method MUST be written for a .ode (a Procedure mode) def getFir.stStep(self): 
self.stepl = AFXPickStep(self, self.crossloadedgelKw, 

'Select the fi~st cross member', EDGES) 
# Add a refinement to pick only straight edges (we actually only have 
# straight edges in our model so this is more for demonst~ation purposes) 
#self.stepl.setEdgeRefinements(AFXPic~Step.STRAIGHT) 
~turn self.step1 

# --------------------------------------------------------------------# A getNextStep(.) method MUST be writ ten for modes containing mor:-e than one 
# step 
# The previous step is passed to getNextStep() so you can determine where the 
# user is in the sequence of steps ' · 
# The next ~tep in the sequence should be returned by getNextStep(). or 
# 'None' if there are no more steps 
def getNextStep(self, previousstep): 

return self.step2 

return self.step3 
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# To the sendCommand() method we pass the statements that should be 
i # executed · I #We separate multiple statements with a \n as ' is done here. Note 

# that you cannot leave a space after the \n because that means there 
.# is a space-in front of the next · statement, and Python being will 1

1 

# object ·to this wrong indentation 
·sendCommand('root_assembly = ' + \ 

·~db.models[\'Beam Frame\'].rootAssembly \n' + \ 
'session.viewports[\' Viewport : 1\'].setValues(displa' + \ j 

L---~-_;~~:~~~~-----'yed~~ect"ro:sembly) · )J 
Let's examine what is new here. 

#------------- - -- -- -- --- -- -- -- --- -- --- -- ----------------- -- -- - -- -:~~-----------,,. #A getFirstStep() method MUST be written for a mode (a Procedure mode) def getFirstStep(self): 
self.stepl = AFXPickStep(self, self.crossloadedgelKw, I 

'Select the first cross member', EDGES) 
# Add a refinement to pick only straight edges (we actually only have # st raight edges in our model so this is more for demonstration purposes) i #self.stepl.setEdgeRefinements(AFXPickStep.STRAIGHT) 

1 ____ . __ r_e.turn s~l f. step~----- -- ---- --------- ----- --

Just as you have a gctFirstDialogO method in a form mode, you must define a 
getFirstStepO method in a procedure mode. In order to make a user pick something in 
the viewport an AFXPickStepO is used. This method accepts a number of parameters. 
The 4 we have used are owner, keyword, prompt and entitiesToPick (even though the 
parameter names are not explicitly typed here). owner is the procedure that creates the 
step. keyword is the variable associated with what is picked, which can be passed to the 
kernel as part of the AFXGuiCommandO method. prompt is the text string to display in 
the prompt area. entitiesToPick is the type of entity that can/should be picked. Another 
parameter which is not used here but might be useful is numberToPick, which 
determines how many entities may be picked - it defaults to I. 

The use of AFXPickStep here causes the prompt message 'Select the first cross member' 
to be displayed in the prompt area. The user is able to select edges thanks to EDGES 
being set in entitiesToPick. 

r-·· ... ·-- · ·~i· ·-~-::-~-~=-:~~--=-=-=-~~~--=·~-=-=-:·~-~ ·=---= .. =-~-~-~·~ ·=-:·~·~-~---:=~ ~··=-=·= .. ~·-=-=·=-~ ·=·=-=-=·=·=-=-=~ ~-=-·~-:.-=-=·-~-=~-:.-.. ··---------1 1 # A getNextStep() method MUST be written for modes containing more than one ! 

L___ : ~~=~P!'.!~.!:~~~-~~p_!-~ ... P_a..~-~-:9 __ t_~-... ~~!!:'!.:~.!:;...:!:.«:J?.tL~.? .. .Y..~.~.-~~~_9e~e~~ne w~~ re th_~ __ j 
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·----·--·•~•-·----·-- ' •--· • • • • • -• "• ·•• • • • • • • • • • ••• ••••••-•"· •-.-.•- '''' ''''''' "'' ' "''''''''''''''' ' '''''"'''-""""'" '' 

i 
I 

# user is in the sequence of steps 
# The next step in the sequence should be ret urned by getNextStep(), or 
# 'None' if there are no more steps 
def getNextStep(self, previousStep): 

if previousStep == self . stepl: 
self.step2 = AFXPickStep(self, self. crossloadedge2Kw, 

'Select the second cross member·, EDGES ) 
return self . step2 

el if previousStep == self . step2: 
self . step3 = AFXPickStep(self, self.frameloadedgelKw, 

'Select the first f rame member', EDGES ) 
return self. step3 

elif previousStep == self.step3: 
self.step4 = AFXPickStep(self, self .frameloadedge2Kw, 

'Select the second frame member', EDGES) 
return self.step4 

elif previousStep == self.step4: 
db = Step3DB(self) 
self. steps = AFXDialogStep(self, 
return self. st epS 

db, 'Specify loads in dialog box') 

I 

I 
1 else: 

L _ _____ r~.~ Non:_ ___ ·----···----·---··-·-·-.. ------·------·--·- ---·------' 
Since our procedure involves more than one step we must define a getNextStepO 
method. Aside from self this method also receives previousStep which is exactly what 
the name implies. We use this variable to find out what the previous step was, and us ing a 

sequence of if-elif statements we call the subsequent step using AFXPickStepQ. After 4 
pick steps, we call an AFXDialogStepQ. Recall that procedure modes can also be used to 
launch a dialog box (whereas form modes cannot launch pick steps) and 

AFXDialogStepO is the method used to accomplish this. 

AFXDialogStepO accepts 3 parameters- owner, which is the procedure that created the 
step, dialog, which is the dialog box to post, and prompt, which is the text string to 
display. 

Once all the steps are complete we return None indicating that there are no further steps. 
~--W~ .. ~-~·-----M-M-M0M0M-00M---·-~--·--·--OOOOOMOOO __________________ .. ___________________ _ 

: #--------- -- ---------- ------ --- -------- --- - -- -- ----------- ---- ------- -
1 # A mode is usually activated by sending it a message with its ID set t o 

-------1 
I 

! # ID ACTIVATE 
L~2~is me~!ge_C:.~.U.~es ac~_iv~~~-Q_~---~-«:~lle~-·--- __ I 

i ,, 
I . 
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r 
! 

---------------- -
# Note that it is NOT necessary to define this activate() method unless you 
# wish to change the default behavior 

I 

l 
I 

# Here we would like it to print a message to the screen before proceeding def activate(self): 

print 'Step 3 Mode (procedure) has been activated ' 

# We must check to see if a part has been displayed otherwise the user 
# cannot pick anything 
if getDisplayedObjectType() != PART: 

showAFXErrorDialog(getAFXApp().getAFXMainWindow(), 

return 

else: 

'There is no part displayed in the current viewport. ' + \ 
'A part must be di splayed t o continue') 

# The edges must be picked in the assembly module. The viewport 
# currently displays the part module. If the user picks the edges 
# here the Lineload() method called in beamKernel will not function 
# correctly 
# To change the viewport to the assembly module we use the following 
# commands 
# root_assembly = mdb.models['Beam Frame ' ] . rootAssembly 
# session.viewports['Viewport: l'].setValues{displayedObject= 
# root_assembly) 
# However these commands cannot be executed in a GUI script 
# The session object can only be used in a Kernel script 
# To issue a kernel command directly from the GUI we can use the 
# sendCommand() method 
# To the sendCommand() method we pass the statements that should be 
# executed 
# We separate multiple statements with a \n as is done here. Note 
# that you cannot leave a space after the \n because that means there 
# is a space in front of the next statement, and Python being will 
# object to this wrong indentation 
sendCommand('root_assembly = ' + \ 

'mdb.models[\'Beam Frame\'].rootAssembly \n' + \ 
'session.viewports[\'Viewport : 1\'].setValues{displa' + \ 

'yedObject=root_assembly)') 

# Call the base method 
AFXProcedure.activate(self) ---

Just as with fonn modes, activateO is called when a procedure mode begins running. We 
can do a check here to make sure a part is actuaiJy displayed. If not, it probably means the 
user has not completed 'Step I'. lt is not possible to pick any edges if there is no part 
displayed, hence we need to make sure this situation does not occur. We display an error 
using sbowAFXErrorDialogO informing the user that no part is displayed. 
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If on the other hand a part is displayed, we must switch to the assembly module. If you 

were using Abaqus/CAE you would select the edges for the load in the assembly module, 
hence even in this procedure we must switch out of the part module into the assembly 

module. The comments (there ' s an entire paragraph of them) help you understand how 

this is accomplished. 

Finally the base AFXProcedure.activateO method must be called to activate the 
procedure mode. 

,.\ ' 

The form mode is defined in the script step4Form.py and the dialog box in step4DB.py. 

These two scripts create a dialog box which lets the user decide where to save the model. 

The Select ... button next to it opens a file browser. The dialog box also lets you select a 
directory, but this feature is only included for demonstration purposes and is not actually 

implemented in the script. 

Ml!~~.>tll.·<-<*""'~"'h x ···, 
LJI·~~Jt~ll~~:-' '-- ----' 

-----· ~- - - ------ -----

Save the model: j[ JlseJect ... l 
:=:::=========~ 

Set a directory (not implemented): l~ect·1~1 

If the user clicks the first Select ... button he will be provided a file selection window 

I· 
! 
I 

j: 
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Directory: ID beamApp 

QJ .. 
0 abaqus.rpy.414 
0 abaqus.rpy.415 
0 abaqus.rpy.416 
0 abaqus.rpy.417 
0 abaqusl.rec 
0 abaqus_acis.log 
0 abaqusMacros.py 

< L .• m 

0 abaqusMacros.pyc 
0 ABQcaeG.exe.dmp 
0 ABQcaeK.exe.dmp 
0 beam_functions.py 
0 beamAppConstants.pyc 
0 beamCaeApp.py 
0 beamCaeApp.pyc 
0 beamCaeMainWindow.py 

file Name: [ QK 
~================~ File Filter. § _s r_._1__________ Ell 0 R€:ad-only I £ancel 

If the user clicks Select .. . next to 'set a directory ' he will get the directory selection 
window. 

------
Cl~/ 

-------------------- -

Directory: ! D beamApp 8(!;) ~ ~ __. d · (IT] !1 :::: 2 rm LJ 
eJ .. 

I 

Qirectory Name: I 11 QK . I 
File Filter. ,. BL baOCe_l I 

When the OK button is finally clicked, the entire model is saved at the specified file 
location. 
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Let's first take a quick look at stcp4DB.py. 

I # ** ***** ***** *****-***********.***** . ;;-;;;;;;.-;;-;*·;;·;;;;;-;;; ••• ** .-;·;;;;-;;;..,.. ** ** **** I # Custom Beam Frame Analysis· GUI Application 

I 
# ~his ~cript define~ a dialog box that wi~l be posted by a form (Step4Form in 
# step4Fo'm.py) . .. .' · . . , : 

! . ~ ' ' 
1 # Created for the book ·:PYthon Scripts for Abaqus - Learn by Example" 

I
, ## Author: Gautam Puri 

***'"******************.********************************************************** I 

I from ~~~~sGui impo<t • 

1 # Class .definition 

class Step4DB(AFXD.ataDia~og): 

[ 
. ID_FILE~ 

. .. ID_DI.REClORV, , . . 
J ::;:. ·rarge(AFXToolsetGuL ID;_LAS.T • AFXToolsetGui. ID LAST+2) 

' ! .•;,,' • . ~· ·~ . ~ - ' 

#.::~ - -·-- ----------- ---,'- -.-.:. _._. ___ .:_- _.:. ~ ~·.::'-- -- -- ~ ------------------ ---- -----
def. ~init_(self. form): · · 

# DIALOG_ACTIONS_SEPARATOR places a horizo~tal line/separator between the 
# contents of the dialog box and the OK/CANCEL buttons at the bottom 
·# DIALOG_BAILOUT displays a message "Save c::hanges made in the xyz dialog?" 

.· · # ,if the user.cU!=ksj:aricel after, .~l:'a'nging !iOme values in the dialog box 
· ·: ,.,, AFXDataDialog.~ini:t2(self, . formt~·step 4 .:. Save the ·model', 

; ....... , ' . self.OKI~elf.CANCEL, DIALOG_ACTIONS_SEPARATOR) 

self.form = form 

t 
· self. fileDb = None · 

. , self.dirDb = None - .. 

!IL , FX!'1APFUNC(self, SEL_COMMAND~ s~lf;::to.:_FI~E, · Step4DB.onCmdFile) 
lr y ,;i:i;·<fXMAPFUNC (se 1 f j :',Sfl~ C;O~ND'> ~.~lf:; ,~,o .,..DI~ECTORY, Step4DB,. onCmdDirectory) 

I ·- ,- ~--~~· = ~FXVer~ical~·ii~ner(.~elf, LAYQUT~FI_LL_X) 

t 
# File name 

• ·hf .=. FXHorizon~alFrame(va, LAVQU:F_FILL_x, e~e,e,e, e~e.e,e) 
,. · ... f\_FXTextField(hf, .20f •. 'Save the .model:', form.fileNa~Kw, 0 1 LAYOUT_FILL_X) 

· . ~XButton ( hf, 'Sel~ct ~ .. ~ , , None,.: ~.elf, self; ID _FILE) , 

r '.4 . ! -- -/.; . ' ·• . . • 
, , i • ~~~ ; 1':: v l ~~ J: 

0 

I' 
0 

,.. 

0 

0 

t # Directory. name- - . . · ; · . . "' 
< hf = FXHorizontalFrame(va, tAVOUT.:i=hL_x, e~~.e,e, e,e,e,e) _.:1_.._ .... ~---·-" .. l loo,. ..... j o~M-~;/~0 · --- .... · - .. -~.-- ........... -~-- .. ... MO- _, .. _,_, ...... - ........... _ ,_, OOO-•••-·--· - ..... ~ ... ... ...... ...... _ . ......... .. -·--------·-"""'-"'-...... -·-~-
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AFXTextField(hf, 20, 'Set a directory (not implemented) : ', form. dirNameKw, 
9, LAYOUT_FILL_X) FXButton(hf, 'Selec't •• . ', None, self, self. ID_DIRECTORY) 

def onCmdFile(self, ···sender, sel, .ptr }: 

i~ not self.fileDb: 
patterns = 'All files (* . *)\nOutput oatab~se. (*.cae)' 
self.fi!eDb = AFXFileSelectorDialog(owner=self:. title='Select a File', ' pathNameKw,;sel f. form. fileNameKw, · · 

, '· readOnlyKw=self. form. fileReadOnlyBool Kw, 
mode=AFXSELECTF~LE_ANV, 
patterns=patterns, 

. pattern~ndexTgt=self.form.filePatternindexTgt) self.fileOb.setReadOnlyPatterns('*.cae') · · 
self.fileDb.showReadOnly(show=True) 
self. fileDb. createq · . · · 

self. fileDb. showModal() 
. ' 

def oriCmdDirectory( self, ·sender, ptr): 

if' not self.dirDb: . 
self.dirDb = AFXFileSelectorDialog(owner=self , 

' ' title= 'Seiect a Directory•, · 
pathNameKw=self.form.dirNameKw, 
readOnlyKw: Nohe, . 
mode=AF~ELECTFILE_DIRECTORY) 

return 1 

#-_;- - - :-: __ _ ;_ __ - - ---- ~-- -- - -.-- -·-- --- -- _;__;~ ·- --~--- -"-' - - - _:__ ---·- -- - - --- ------
# The showO method is called by default whenever the_ dialog box is to -be ', , # di splayed·. · -. . ~-· · ' : · · : · : • · · 
# For example in modifiedCanvasTo.olsetGui. py you have the statement · 
# AF~nuCon•n<ind(sel:f, viewpor.t_menu_with_contents, •'custom Menu item'··~-· 
# OemoForm(self),, AFXHode.IO_ACTIVATE) . . . . . 

-·~ # 'So whenever the custom 'menu item ·is elicited, t he activirte( r. method of the # mode is called, and th:i;s in turn. ulls the show() .method of the ·di alog box. "' #>Note that th:iJs ,· metHod dqes NOT ·need .to ·bei:deffoed here ::if we: wisli to, leave #- the Dehavior at ·defauit 
,, . # Her.e however we .wish to mOdify the s~ow, _method' to -~lso ::print a message-· t o # the screen. (aside from opening the window which i t ,does by default) . 
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f-~-~~{·~l:ioW.( se if);~~--·---::---_··-:?·=·---~----:~:;:~-;-:-·:-·;~-;-·~-.. ---.~~·----. --:--:-~-. ---~-

1 

"". ~pr;int 'Step 4 Dialog bo~ will J~f'displa:Yed' - -· · 
#Now must call the ·base ·show() command - t 

1

., _A.~~~~taDialog!show(selfh~ .. , 

l 
I 
I . , .1 # , t .tie ; ~e~avlo~ • .at ~e.fiii,u1 L \~~t.~ ;1. . . {;~~" ., :~~ ~.&;\; . : , .: •. " .• , :· · , .• · f·. ""''·~# Here:. however ·we wish to· mo~ify ttie: hide method to atso . print a message to 

i 
· ::· :e~~~i~.~~==~f~1side . f~in cl~~-~."..g t:~~ ; ~in~ow which·_ .it doe~ ·by defau1t). 
· ;. . p~iile ·Step 4 Di·alog; boxFw~·:l\1 · b,~;,.h:id.q~fi; ·: . :· · , .. ~ · · · ;.. ' . · 

. . #' ~·ow . mu~t caii the base bide( f COIIIIIand •: . :- · . . • . 
AFXDataOiaiog.hide(self) , .· . · · · · .. .;:;...;..i.:~---·'"'··--··-.. ~-M-H00--0-;. __ ,,_ol> .. oo<o ... _(_OM. O<M ..... M'"MMo ... OOOOOoffi-MoM O ... .:O .... O .. OoO ......... _ , .. ,, . .... ............ ... ~ ............. ~ .......... .:.: .................. ,,_ ............... .. , . ... __.,,, _____ ~ .. Ioo-·---.. ---·........,..:;,...::=-l 

The new things here are the methods onCmdFileO and ooCmdDirectoryO so let's look 
closely at those. 

def onCmdFile(self, sender, sel, ptr): 

if not self.fileDb: 
patterns= 'All files (*.*)\nOutput Database (*.cae)' 
self.fileDb = AFXFileSelectorDialog(owner=self, title='Select a File', 

pathNameKw=self.form.fileNameKw, 
readOnlyKw=self.form.fileReadOnlyBoolKw, 
mode=AFXSELECTFILE_ANY, 
patterns=patterns, 
patternlndexTgt=self. form. filePatternindexTgt) 

self.fileDb.setReadOnlyPatterns( '*. cae') 
self.fileDb.showReadOnly(show=True) 
self.fileDb.create() 

self.fileDb.showModal() 

return 1 

AFXFileSelector dialog is used to ask the user for a file or directory name. It accepts the 
following arguments: owner is the owner of the browser dialog box, title is the dialog 
box title, pathNameTgt is the path name target i.e., the variable in the path will be 
stored, readOnlyKw is a Boolean specifying if it should be read only or not, mode is the 
file selection mode, patterns is the file filter patterns, and patternlndexTgt is the index 
used to select a file filter pattern when the dialog box is posted. The mode is set to 
AFXSELECTFILE_ANY to display a file selection dialog. Other options are 
AFXSELECTFILE_EXISTING which allows the selection of an existing file only, 
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AFXSELECTFILE_MULTIPLE which allows the selection of multiple existing files, 
AFXSELECTFILE_DIRECTORY (which allows the selection of an existing directory) 
and AFXSELECTFILE_REMOTE_HOST which allows opening of files on a remote 
host. 

The statement self.fileDb checks to make sure the file selector dialog box is not already 
displayed. We set the patterns using the format shown in the variable patterns, 
separating the patterns with newline characters. 

setReadOnlyPattersO sets the patterns that force the display of the read-only checkbox. 
showReadOnlyQ shows the read-only checkbox. Since we have set the pattern to ' *.cae' 
the read-only checkbox will only be shown when the user sets the file filter to 'Output 
database (*.cae)'. We do not actually add any functionality to our program with this 
feature in this example, it has only been included for demonstration purposes. 

The createO method must be called to create the AFXFileSelectorDialog object. The 
showModaiO method must be called to actually display the file selector dialog box. 

~def onCmdDirectory(self, sender, sel, ptr): 

I if not self.dirDb: 
self.dirDb = AFXFileSelectorDialog(owner=self, 

I title= ' Select a Directory', I pathNameKw=self .form.dirNameKw, 

I 
readOnlyKw=None, 
mode=AFXSELECTFILE_DIRECTORY) I self.dirDb.create() 

I self.dirDb.showModal() 

[._ return 1 

The procedure for creating a directory selection dialog box is quite similar to that for a 
file selector dialog box. The only difference is that the mode is set to 
AFXSELECTFILE_DlRECTORY. 

The form mode is in the file step4Form.py. 
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# €reated for the bOo~ ~.Pyth9n 
# Author: Gautam J>ur'~ -: ·· · 

ripts for Abaqus. - Le~rn by ExamP.le" . . . . ' -

# 
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I · ·# Now' m1.1st tall the base.method l :AFXForm.activate(self) 

Once again, you've seen most of these statements and methods used before. The one 
difference is the statement 

self.filePatternindexTgt = AFXIntTarget(9) 

which remembers the pattern that should be selected by default when the file selection 
dialog is displayed. 

~is S~mma:ry <, , 
-· -- ~s: • - ""' • -You've now created a fully functional custom GUI application and have a good 

understanding of the steps involved in scripting one. GUI design is a fairly complicated 
subject and you'll probably spend a lot oftime debugging code, but hopefully the scripts 
from this chapter and the previous one will give you a great starting point for any GUI 
applications you develop. 

Abaqus offers a number of widgets and layout managers aside from the ones used in this 
example so it is recommended that you take a look at the ' Abaqus GUI Toolkit User's 
Manual ' and the 'Abaqus GUI Toolkit Reference Manual ' for further information. 
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Plug-ins 

.1 · -Introduction 
,.,4; _,......,...... ' 1 . . .~~ : '~ ~ . __ ,.··~ ·~ 

Tn this chapter we will talk about creating plug-ins. Plug-ins are scripts available to a user 
in Abaqus/CAE through the Plug-ins menu. They help extend the functionality of 
Abaqus. A plug-in can be a simple kernel script that performs a routine task, the same 
sort of script you could run through File> Run Script ... ln this scenario the advantage is 
that of convenience- the script is easily accessible to everyone who is using Abaqus/CAE 
once it is packaged as a plug-in. On the other hand the plug-in can be a GUI script which 
displays a custom interface prompting the user to input data and select items in the 
viewport. If all you need is a little extra functionality, creating a plug-in requires less 
work than writing an entire custom GUI application. However a plug-in cannot modify or 
remove Abaqus/CAE modules and toolsets the way a custom application can . 

.. 2.2 ~ l\let)l.9~~1ogy . _......,..., __ ,..,:!' ~ -~:.·.~;::~.t. . .. , 

All plug-ins must follow the naming convention * _plugin.py. This helps Abaqus identify 
a script that is a plug-in. A plug-in may consist of more than one script; however the rest 
of the scripts do not need to follow this naming convention. Presumably your* _plugin.py 
script has import statements which will cause the other scripts to be imported as needed. 
Also, it is recommended that you store all these related scripts (and other files such as 
icons) in the same directory unless you wish to mess with the PYTHONPATH variable. 

Abaqus/CAE automatically searches for plug-ins in certain directories while starting up. 
All plug-ins detected are added to the Plug-ins menu. Your plug-ins must be placed in 
one of these key locations. By default Abaqus searches for a folder called 
abaqus_plugios, first in the Abaqus directory (abq_dir\cae\abaqus_plugins\), then the 
home directory (bome_dir\abaqus_plugins\), and finally the current directory 
(cur_ dir\abaqus _plugios\). 
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If a plug-in is a kernel plug-in, Abaqus/CAE sends commands of the form 
module_name.fonction_name to the kernel. If the plug-in is a GUI plug-in, Abaqus/CAE 
sends a command of the type ID_ACTIVATE, SEL_COMMAND to the GUI object 
created for the plug-in. 

2~.3 Learn by E,xam_p~e . . . . _ 
Since kernel and GUI plug-ins operate slightly differently, we're going to create one of 
each. We shall call them ' Material Kernel Plug- in' and 'Material GUI Plug-in '. We won't 
write too much new code, we'll just reuse statements written in previous chapters and 
package them as plug-ins. 

. . ' < ·-;-. ,-.*.:ir.\" 
_· · __ __:__• __ ::~!?!!!:~:~;,' .. l 

)ft Yiew £art ~~pe Fe1t111e Iools I Plu~·ins !:!elp ~? 
Ioolboxes 

Material GUI Plug· in 

2'2.3.1 'Kernel Plug-in E_xample _ ~~... ~ , 
We will use the first script we wrote in this book, the one in Chapter 1, section 1.2. lfyou 
recall, all this script does is create 3 materials. We have placed it inside a function, 
crcateMaterials(), which our plug-in can call. 

We place the contents in materialkernelscript.py. Here is the listing: 
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We now create the plug-in. Here are the contents of ' materialkemel_plugin.py' 

These are the statements required to create a kernel plug-in. The 
registerKerneiMenuButtonQ method registers a kernel plug-in in the Plug-ins menu. 1t 
must be used on a toolset, which we obtain using 
getAFXAppQ.getAFXMainWiodowQ.getPiugioToolsetQ. Its required arguments are 
moduleName, fuoctionName and buttonText. 

buttonText is the text to be displayed as the name of the plug-in in the Plug-ins menu. 
Here we name it 'Material Kernel Plugin'. moduleName is the name of the module to 
import. In our case this is materialkernelscript.py, which contains the actual 
functionality. functionName is the name of the function to execute inside the module 
imported using moduleName. It is for this purpose that we placed all the statements 
inside a function - createMaterialsQ. There are also a number of optional arguments. 
The ones we've used here are author and description. The contents of these are 
displayed in the Plug-ins > About Plug-ins dialog box as displayed in the figure. 
Another optional parameter that might be useful to you (although we haven' t used it here) 
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is applicableModules. The plug-in will only be available in those modules specified in 
this parameter. You must give it a sequence of module names, of which the possible 
values are Part, Property, Assembly, Step, Interaction, Load, Mesh, Job 

' Visualization and Sketch. The default is the SymbolicConstant ALL. 
1:1~ ';;---·- - ------·- - - - --- - -----------~ 1: 

- - ___ , 
, , -- Install~ Plug•ins , . - Dmils 
[ ~ ~--------------~ · IB Toolboxes i Author: G1utam Puri . i I 

I 8 Abaqus i Version: N/A 
• I l- Material GUl Plug-in C T 1 1 , Directory: :\Users\Gary he Great\1baqus_p ugins\MatetiaiKerneiPiugin i f ~ ' 00 Tools ' Help: ~ 

I ,. 
: , Applicable modules: 

I All i 

.... ·---- 'l 
I 

ii 
1
1 

Description: 
1 I; K~;Plug~-i~-~~~-bo-ok:P;thon Sc-;i~ts f;Ab;qus-~--l~~-by Ex·-. -m-ple- · - ---. ! 

l ! 
l; I ,, 

'--~-:::-:-=====-=-=-=-' '. ____ :-_ =·· =:::--:-:::::=~:=---:-::--::::-=-::::-:--::--=--::--::-:::::=::-:-===:lj 

This is all it takes to turn your kernel script into a functional kernel plug-in. 

f22.3.f . G~· Plug-iia Eia~mpte .. :· : ~~~ .. . i 
• i;or:: " ·~ "-- !_,..._ ~ • I . - l.; .. <\ • • ,.., .~·~ We will reuse the material selection dialog box we created for the beam frame custom 

application in the previous chapter. This time it will appear as a standalone add-on rather 
than part of a full-blown custom application. 
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Material @~-l~?~~~el 8] 
New material propertiEs 

Name 

0 Density 

Young·~ Modulus lo 
::::::::::::;;;~ 

Pci~son's Ratio [0;,__;;;'""""".;....;:..-" 

Alert: You cannot ha•n: a negative dens1ty 

We reuse most of the code. materialGuiDB.py defines the dialog box, 
materialGuiForm.py defines the form mode that launches the dialog box, and 
materialscript.py is the associated kernel script. 

The contents of materiaiGuiDB.py are the same as stepiDB.py from the prev1ous 
chapter. 
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The contents of materiaiGuiForm.py are the same as steplForm.py from the previous 
chapter. 
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As for materialscript.py, it is similar to the corresponding function from 
beamKernel.py of the previous chapter. 
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~' - '. ··-~ 
'--'-----'-----------1 

Here is the script that actually creates the plug-in. It is materiaiGui_plugin.py. 

-' # "'*'"'************'********'**'**•****"'**••*"'********"'***"'***•"'************************' I # Material GUI .Pl!Jg-in . - '. _ . . ,, f ,# rh·is . SCl:Ji'iP.t registers the material• GUI plug.:: in ·: · :>' · •. • _ ': ::/' 
I # ·**~****************-******~********·******************"'****~*******************"'*-* .j :'¥rom''~baqus·G~i 'impo~' · get~FXAp~ . . ' + r ~~-. · ;,j 
,t'!:'.o"' .. ~a_t~rialGuiFo~, ,imP9.r:· ~~.t,~~~al~u,iF9rm , , ., :.""! 

I. # Register: the plugin '. ' . . · . I 
1-·toolset ... getAFXApp( >•· ~et~'FXMa!tnwindo~()·.:ge:tP.luginToo;lse-p( ): " , ·i f. tools.et.registerGuiMenuButton(butto~Text..:•Material GUI Plug-in', . I l : · :, - . . · object~aterialGuiFort~~~toolfsetL .. · it · ·.: I Lt '"''[;' · · ···· · 'kernehnitstring=·· import ·-~~!~ialscri:pt') ; -~-~--___1 

1t has many similarities to the kernel plug-in script. First of all it is short and simple. 
These statements will likely be required for any GUI plug-in you create (of course you 
will import some module other than materiaiGuiForm). As for registering the plug-in, 
the function used is only slightly different. [t is registerGuiMenuButtonO, as opposed to 
registerKerneiMenuButtonO which was used for the kernel plug-in. 

The required arguments for registerGuiMenuButtonO are buttonText, which is the 
name to be displayed in the Plug-ins menu, and object, which is the GUI object to which 
a (messageld, SEL_COMMAND) message will be sent. We set this object to our form 
mode. Hence our plug-in launches a dialog box. There are a number of optional 
arguments as well; the one we have used here is kernellnitString. We need to import 
materialscript.py which is the kernel script, however this import statement cannot be 
placed in any of the other scripts because they are GUI scripts (and, as you know very 
well by this point, you cannot mix GUI and kernel scripts). By using kernellnitString 
we can tell Abaqus to import materialscript.py into the plug-in. In other words it serves 
the same function as getKernellnitializationCommandO does in custom applications. 

~2.4~_Suoimaey· . 
~ . . -
Registering a plug-in is quite easy; you use the registerKerneiMenuButtonO and 
registerGuiMenuButtonO methods depending on whether you are registering a kernel 
plug-in or a GUI plug-in. The real work goes into creating the kernel or GUI scripts that 
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make up the plug-in. Once you have those, it's easy to package them into a plug-in for 
future use. 


